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Getting Started with the Quick Start Guide

 
The purpose of this guide is to give the brand-new user an easy path to getting the software
running for the first time. That means using it without any external interfaces, initially and only then
adding radio control. Further interfacing (such as CW, PTT and transmit audio) is covered in later
chapters, along with related operating techniques. I have not tried to address digital modes in this
guide, because while some aspects of program operation are identical, most are different, because
of using MMTTY, MMVARI or a terminal unit to decode the digital transmissions.

Special thanks to Bob, K0RC, for his contributions to this second draft. He sanity-tested the original
by installing N1MM from scratch and uncovered some errors and omissions that are (hopefully)
corrected below.

For starters, I'm assuming that you followed the instructions for downloading the program on the
N1MM website or in the manual , first installing Version 10.0.0 and then updating to the latest
version. I'm also assuming that during the base installation you installed the DLPORTIO port driver
(for 32-bit Windows 2000, NT, XP Vista and Windows 7; it does not work with 64-bit operating
systems, but is only needed for parallel port control functions, and testing of a substitute for that
purpose is underway).

With Version 10.X.X, special precautions for installing on Vista or Windows 7 are no longer
necessary, so long as you install N1MM Logger somewhere other than in Program Files (C:\ is the
default).

Once you have downloaded and installed the program, you're ready to start it for the first time.

 
Once that's out of the way, the very first thing you'll see is the following notice:

 
Click on OK, and after a few seconds (the time required is vastly over-stated) what comes next is

If you have been using N1MM Logger for a while, or if you have downloaded files such as a new
country file (wl_cty.dat), then before you see anything else you may see a warning message.
Don't be alarmed - the program is simply reminding you that the country file loaded into your
current database is less current than the one it found in the program directory. You can fix this
at any time from the Tools menu in the Entry Window.

Country File warning
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what we call the "splash screen."

 
After that, the next dialog that opens automatically is referred to as Station Data:

 
Since you have never run the program before, it is filled in with Tom, N1MM's information. You
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should replace it with your own information, in the same format. This is very important for proper
operation of the program. Later, if you need to change anything, you can re-open this window
through the Config menu.

When you see one of the blue 'Tip:' notes, be sure to pay attention! For example, this one warns
you to be sure your computer is set up for local time, NOT GMT. N1MM Logger will take care of the
conversion for you. Don't worry about the SMTP server address unless you know it off-hand - it is
only useful for bug reporting. When you have completed the form, click OK.

Next comes what looks like an error message:

 
Don't take it seriously - this is related to playback of audio files, something you won't need for a
long time yet. Just OK out.

After that you will see an Entry Window. Let's get a little terminology out of the way first. The top
blue part of this (or any) window is called the Title Bar. Each of the places where you can type
information is called a textbox. The Title Bar displays the current frequency, mode (if one has been
selected), and which radio it is (nominally, Radio A). You will have to enter a mode before you begin
to operate, and a band and/or mode each time you change either. Simply type a frequency in KHz
(3500, 7000, etc.) in the Call-Sign textbox (to the far left) and hit Enter; then type a mode (CW,
USB, LSB) there, hit Enter again, and you're set.

The Entry Window is your main starting place for everything you do with N1MM Logger. The first
row is a standard Windows-style menu, and we'll be using it in a minute. Take a moment and
explore the various drop down menu choices, but don't change anything right now.

Below the menu is a set of entry textboxes. This row is where you log your contest QSOs. The
left-most textbox is the Call-Sign textbox. You always enter the call-sign of the station you are
working into this textbox.
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The rest of the data entry textboxes are titled above them - depending on how you have resized the
window, the titles may not line up perfectly with the entry textboxes, but they are always in the
same sequence as those textboxes. Depending upon the specific contest and the required contest
exchange, the number of textboxes and the titles may be different. The example Entry Window
shown above would be used during the IARU Contest. This contest requires a call sign, sent and
received signal reports, and the IARU Zone be logged for each contact

For now, you can ignore the 'Running' check-box, as well as the rest of the buttons alongside it.
This controls one of the most important features of N1MM Logger - it distinguishes between Run
and Search and Pounce modes, providing different features for each. However, these aren't really
relevant until you get into sending stored CW and phone messages, which are covered in Chapter
4. The rest of the buttons in the Entry Window are related to this, and to other advanced
capabilities.

If you want to save space on your screen, you can reduce the size of the Entry Window, like this.
Just use your mouse to grab the lower right corner or lower edge of the window and drag it upward.

 
There are two more useful features of the Entry Window. The box in the lower left corner, called the
Status Line, provides a lot of useful program status information. For example, if you enter a call
sign, the Status Line will tell you what country it represents. If you have set up the Entry Window
just a little bigger than the minimum, it will also show you the distance and bearing, like this.
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To the right of the Status Line is the progress box, where you can keep track of your QSOs and
multipliers without having another window open, and to its right is a running score.

If you press the backslash (\) key, the program opens a second, almost-identical entry window. The
only difference is that it will have a "B" instead of the "A" in the title bar of the first entry window,
and it may well have a different frequency and/or mode as well. But if you pop up the second Entry
Window by mistake, and want to get rid of it, you simply close it by clicking the big red X.

When you first open the program, it will be in SO2V (Single Operator Two VFOs) mode. The idea is
this - most modern transceivers have two VFOs, or a main VFO and a sub-VFO. There will be
circumstances - during a contest on 40 meter SSB, for example - when you will want to receive on
one frequency and transmit on another, widely-separated one.

For the moment, you should change to SO1V (Single Operator One VFO) mode. Select the Config
menu, and under the dropdown menu, select Configure Ports, Telnet Address, Other.
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That opens this rather intimidating dialog:

 
Ignore everything else, and just select your operating mode, from among the choices "SO1V",
"SO2V" and "SO2R." SO2R stands for Single Operator 2 Radios. Select SO1V to disable this for
now (it prevents the program from opening the second entry window any time you press the "\"
key). Now OK out.

In the row below the entry fields in the Entry Window are two colored dots - the green dot denotes
which Entry window (if you are using two VFOs, or have more than one radio) has the Entry or
Receive Focus. The window with the Entry Focus is where information will be entered if you type it,
and also the radio (or VFO) which will transmit any Function Key you press on the keyboard. The
blinking Windows cursor denotes the same thing, and so does the change in color of the title bar
and frame of the entry window. The red dot denotes the Transmit Focus, which frankly is not very
useful, because it denotes the radio (or VFO) that transmitted the last message. More on this whole
2-radio/2-VFO business later.
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A word about fonts. Windows defaults to a sans-serif font that does not distinguish well between
"oh" and zero. If you click on View in the menu row, you'll see "Set Font" as one of the options.
Click on that and you'll be given a list of available fonts, like this:

 
I have chosen Monaco for my font, even though it is normally used by Macs, because it gives a
good clear 0/O and l/1 distinction. In addition Monaco bold is a little bit bigger than the unbolded
type-face in a given size, which helps legibility in some windows. You can make similar choices in
the Log and Check windows, by right-clicking them to get the appropriate sub-menu. You may have
to play around a bit with the window size and font characteristics (Bold/Regular, or point size) to fit
everything in the exchange field - this is particularly true of the signal reports "59" and "599".
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You can download a large set of slash-zero fonts (as they are usually called) here .

Now, we're ready to set up a contest. Note that the first database the program creates is named
ham.mdb by default - you can have as many databases as you want, and name them what you
want. I'm using ham.mdb, but my program directory is named MM Beta (for historical reasons).
Some people prefer to create a database for every contest, while others create one for a period of
time, like every year. If you want to create a database, for example "2007.mdb", just click Files to
drop down the menu, and then click on "New Database".

 
That will open a standard file creation dialog in your program directory
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Name your new database and click Save. You'll be switched to the new database and ready to go.

Back to the Files menu again. This time click "New Log in Database: C:\Program Files\N1MM
Logger\ham.mdb" A new dialog opens.
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The first thing to do is to click on the down button of the Log Type field. That will open a list of
abbreviated contest names, as I already have done above. You can use your mouse to scroll
through the list, or type the first letter of the contest to jump to the right general area. Once you
have found the contest you want and highlighted it, click back in the original field and the
drop-down list will close.
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The program fills in today's date as the start date for that instance of the contest,. You may want to
change it to the actual start date of the contest, though this is not mandatory. This is a good idea
for calculations of total contest time and to keep track in case you have logs for many different
instances of the same contest name, such as QSO parties. Since I'm just illustrating here, the date
is today.

Next, fill in the information in the next few fields, denoting the class and category you intend to
enter in the contest. In each case, you have drop-down lists available. "Overlay category" refers to
contests like WPX, which have both regular classes and categories like Rookie or "Tri-bander plus
wires". In most cases, "N", for not applicable, is the answer you want there.

Next comes the most important part of this dialog, the Sent Exchange field.

 
For many contests, the program guesses what you will want - for example, in this case, since the
CQWW contest uses CQ zones, it has already picked zone 5 for me. Note the "Omit RST" warning.
If the contest you choose has serial numbers, like WPX or the NA Sprint, then you need to put
"001" at the start of the Sent Exchange field, followed by a single space if there is more to the
exchange. Hence, for WPX, my Sent Exchange would read 001. An important exception is the
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ARRL Sweepstakes. The serial number is "assumed" for this contest only, so my Sent Exchange for
SS would read B 54 WV. More information on the Sent Exchange is in the Supported
Contestssection of the manual.

Once you have filled in the Sent Exchange, you're done for now. Just Click OK and hit Enter. Now
you're almost ready to operate in the contest, but first it's time to open a few more windows. Go
back to the Menu line in the Entry Window, and Click "Window". A sub-menu will open, like this:

 
To begin with, click on the "Log" window. That will open a Log window on the screen, like this:

 
First, you should notice that the title bar of the Log Window gives the current date and exact time,
the name of the contest, and the database in use. As you log QSOs, they will appear in the log. I
have logged one above just to indicate how it looks. The most recent last QSO is highlighted. You'll
note that each column has a fixed label - these labels do not change. CQWW is a 2-multiplier
contest, so the log shows columns for "Mult" which is the country, and "Mult2" which is the CQ
Zone. The "yes" in each simply means that it is the first of that multiplier on that band.
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If you click on any column heading, the entire log is sorted by that attribute - for example, if you
click on the Mult heading, the log will be sorted so that all of your first QSOs with a given kind of
multiplier (in this case, a new country) will be moved up to the front. Click on TS (for timestamp) to
switch back to the normal log order.

A further nice touch - if you click a second time on the column heading, for example the "Call", the
sort order switches from Ascending to Descending, so that all your "Z" QSOs come first, and your
"As" last. Same goes for the TS (TimeStamp) heading - normally, you'll want to leave the Log
Window in TS ascending, so that each QSO you log appears immediately at the bottom of the list.

The Log window has two "panes" the one above the dark-grey line is the normal log, while the one
below the line is to show you previous QSOs with a station, each time you type its call into the Entry
Window. You can resize the entire log window, or move the separator to make the previous QSO
pane bigger.

This makes it very easy to see, quickly, all the information about previous QSOs, for that special
someone who drops by and asks, "What was the serial number you gave me yesterday?"

Like all windows in N1MM Logger, the Log window is resizable, as are the individual log columns -
to resize the whole window, use your mouse to drag the lower right corner, and to resize a column
grab the between-column divider and drag it right or left. You can move any window around the
screen by dragging its title bar. Also, as I mentioned above, you can change the font in the Log
window by right-clicking in the window, and choosing your font as you did for the Entry window.

OK, another important window - the Check window. You open it the same way as you did the Log
window., and set the font the same way (with a right-click menu choice).

This window is used to display the results of checking a call-sign against your log and also against
a master list of calls, variously called the master.dta or Super Check Partial file. One is provided
when you install the program, and the process of updating is covered in the Entrywindow section of
the manual.
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First things first, though. When you type a call-sign in the Entry Window, the Check window
displays whether a match was found or not. If the match is in your current log, it is shown in the first
line of the window, like this:

Note the program warns you that you have already worked that station, and can't do so again on
the current band (or maybe in the entire contest, like SS). Also note that two lines below are two
possible matches from the master database.

Had the station you copied been W1AWB, when you entered the Check window would change to
reflect that, as follows:

Note that the station's call appears in blue, meaning that to work the station would not be a new
multiplier, but would be a valid non-dupe QSO. This color coding is consistent throughout the
program. Because it appears in the second row, you know that it is from the database and not from
your log (if for example, you had worked him on another band, the call would appear on the first
line, in blue).

OK, that's probably enough about the Check window for now. These are really the only windows
you need to operate your first contest with N1MM Logger. Now let's sit down and operate.

For the purpose of this guide, we'll assume that you're operating in the CQWW SSB contest. In that
case, the Entry Window will look like this:

 
I'm assuming that you're going to operate phone to start, so I have typed in USB in the call-sign
field, and hit Enter. I have left the default frequency (20M phone) in place, but if I wanted to show
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another band, I need only type a frequency (in KHz) in that band (like 21200, for example) in the
call-sign field and hit Enter to change bands.

When I've done these things, I then type a call-sign in the call-sign field. Even before I look at the
Check window, I see that the call sign is fcolor-coded green. This means that it is both a new
contact and a double multiplier (in this case, both the new country of Martinique and the new Zone
8). The beam heading is displayed below, as are the country, its zone and continent (which affects
points per QSO). If I have already worked Zone 8 on this band, then the call sign will be
color-coded red, signifying just a new country. If both the country and zone had been worked
before, but the station has not, then the color code will be blue. If it is a dupe, the call sign will be
coded grey, and the warning "Dupe!" appears to the right of the entry fields.

So, you call him, and he answers. At this point, just hit Space to fill in the expected signal reports
and move the cursor to the Zone field. N1MM Logger uses the Space bar as a "smart tab." The idea
is that it will skip fields you are unlikely to want to change and move immediately to the one you
may need to. Note, too, that the Zone is highlighted. This means that if you need to change it
ÃƒÂ¢Ã¢â€šÂ¬Ã¢â‚¬Å“ for example, if FM5BH really was in Zone 9 (he isn't) - you would just type "9"
and the "8" would be replaced.

 
Ok, but suppose he's a wise-guy and gives you a "57" report instead. No problem - you just use the
Tab key twice, and the cursor will be on the second digit of the received signal report, ready for you
to type over. The Tab and Shift+Tab work just as you'd expect in Windows, moving forward or
backward one field. Here's how it looks:
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If you need to correct the call-sign, use the Space bar to get you quickly there and edit as
necessary. Then, once everything is as you want it (and the QSO is done), all you do is hit Enter,
and the QSO will be logged.

One thing that trips everyone up at least once is that the program checks to make sure that you
have entered everything, and that everything is correctly formatted. For example, if you accidentally
fat-finger the zone number, like "89", the program won't let you enter the QSO. This can be
disconcerting at first - you get an error message in the status line, like this:

 
If the program has blocked you from logging the QSO, just use the Space bar to move to the
appropriate field, correct it, and hit Enter to log. If you absolutely can't figure out what the correction
should be (for instance, with an ARRL section in Sweepstakes), you can hit Ctrl+Alt+Enter to
bypass the exchange checking and log the QSO "as is." Just in case you want to put a note in the
log, when you do this a note window opens. Type whatever note you want and Hit Enter, or just hit
Enter to skip it and get back to the contest.

Suppose you miscopied a call sign, or he didn't really come back to your call, so you now have a
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mistake in your log. If you need to delete the QSO altogether, just hit Ctrl+D. The program will ask
you if you really want to move the QSO to a Deleted QSOs file. Just hit Enter to do so, or type N for
No.

If you need to edit the QSO, hit Ctrl+Q, and put the program in QuickEdit mode.

 
You'll notice the words QuickEdit above the call-sign field, and that the background of all of the
entry fields is now blue. You can move through the fields as before and make your corrections.
Then hit Enter and the QSO will be corrected in the log, or else hit Esc to get back to normal
logging mode and cancel any changes. Be careful not to leave the program in QuickEdit mode for
your next QSO, or you'll screw up two QSOs at once!

As you log more QSOs, you'll note that the call-sign of your last previous QSO will appear in the
space right above the call-sign field. This area, called the Call-Frame, will be very important once
you have interfaced the program with your radio, but for the moment it is just a reminder of who that
last guy was.

 
So, you've logged a bunch of QSOs, the contest is over, and it's time to send in your log. Almost all
contests these days accept Cabrillo-format logs, and that's what N1MM Logger usually provides
(check contest rules for any exceptions). To export your log in Cabrillo format, go to the File Menu in
the entry window and select "Export Cabrillo to file."

Remember, each time you change bands, you need to enter the frequency of that band in the
call-sign field, and, if you change modes, enter that there too. For example, if you switch to 40M
CW, you would need to enter 7000 and then enter CW (separately) before you begin logging
QSOs on that band.

Remember
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The program will first check to be sure you have the Sent Exchange you want:

 
If it's OK, then click OK or Enter. Next you will see a standard Windows "Save-as" dialog. By
default, the program goes to the program directory, but I usually change that to Desktop for
convenience:
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You can name the Cabrillo file as anything you want (Call sign.log is suggested), and then click
Save and your Cabrillo file is automatically produced and saved.

Next, and this is important, open your Cabrillo file in Notepad and check to be sure that the
information in the header is in accordance with the instructions for the contest. N1MM Logger tries
to keep up with Cabrillo file format changes, but nobody's perfect, so save yourself some hassle
and double-check. Contest categories seem to be a particularly tricky area. You also need to be
very sure that you specified the Sent Exchange correctly during contest setup - one common
mistake is to put the signal report in as part of the exchange.
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Okay - that pretty well wraps up the first chapter. Don't hesitate to use the Google Help facility
(Search Help Using Google (Internet) ) to look up more information on any of these topics. It works
tremendously well for looking up more details on any of the windows, or exploring any other aspect
of the program. In the next chapter, you may need this capability a lot, because so much of
interfacing is specific to a particular radio, and you really need more detail than I can provide here.

 

Basic Radio Control Interfacing

Regardless of whether you want to operate phone, CW or digital modes, the most useful and
important interface is the one between your computer, N1MM Logger and your radio. Fortunately,
most radios now incorporate a serial port to enable them to swap information and commands with
the computer.

A first step is to look up your transceiver in the manual section titled Supported Radios. Assuming
you find your radio there, look for any specific settings or peculiarities that need to be addressed
and make a note of them.

Many modern laptops and a growing number of desktop computers lack both RS-232 serial ports
and an LPT parallel port, having replaced both with one or more USB ports. If your radio has a
standard RS-232 serial port, once you have purchased a USB-to-serial converter and installed the
drivers for it, MM can work with your radio just fine. If your radio uses either Icom's CI-V standard or
another non-RS-232 serial port, you'll need an appropriate converter cable to get from either USB or
RS-232 to your radio.

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

23 of 680 2/2/2011 4:54 PM



Once you have the hardware hooked up between your computer and your radio, start N1MM Logger
and open the Config menu in the Entry window. Choose Configure Ports > Telnet Address, Other.
Ignore all the other stuff for now.

 
That brings up the following, rather intimidating dialog. Don't worry, we'll walk you through the part
you need now.
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You may want to select SO1V if this is your first experience with N1MM. SO1V allows N1MM to
control VFO A in your transceiver. If you are an experienced contester and understand how to
operator in split mode (for example, working DX on 40 meter sideband) you may want to select
SO2V. It allows N1MM to simultaneously control both VFO A and VFO B in your transceiver. If you
are an advanced contester, whose station is configured with TWO transceivers (one for running
contacts and the other for searching for new multipliers), then you will want to select SO2R.

Now identify which port you have physically connected between your computer and the radio (or in
the case of USB, the virtual serial port it has created). Click the drop-down arrow under Radio, and
select your specific radio model. For this example, I've assumed COM3 and a Yaesu radio. Virtually
all Kenwood models use the one common radio configuration, while Yaesu and Icom radios are
generally designated by the specific model number - refer to the manual under "Supported Radios"
for more information. Icom radios require a Radio Address (Hex Code) - see the manual for more
information.

Now click the "Set" button next to the port you have chosen.
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That will bring up this dialog, with connection details. Normally, N1MM Logger chooses the
parameters in the first two rows for you, and does a good job. You might want to verify them with
your radio manual, just in case. Radio/VFO number should be 1, so that your main VFO will be
displayed in the main (first) entry window. The rest of the stuff on this dialog is not important right
now, so just click OK to get back to the previous dialog, and then OK again to return to the Entry
Window.

If all is well (you did turn your radio on, right?), when that big multi-tabbed dialog closes and the
Entry Window reappears, the title bar of the Entry Window will display the radio's frequency and
mode. It's magic. The "+0.00" simply means that RIT is turned on, but set to zero (no offset)

 
Now that you have radio control, you can do a lot of neat things, but one of the most basic is that
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you will never again have to worry about accidentally logging QSOs on the wrong band or mode.

With an interfaced radio, you will find it useful to open a Bandmap window. Click Window, then
select Bandmap, and the Bandmap corresponding to your entry window will be displayed.

In the example at left, I have filled the bandmap with spots from a packet cluster, just to illustrate
how spots are displayed. The stuff in the top bar is pretty self-explanatory. The SH/DX button, when
mouse-clicked, sends that request to the cluster (which you don't know how to set up yet). The
button labeled Wide toggles filters in your radio, though you may have to set it up first (the process
is explained in the manual). In any case, clicking on it switches TO the filter mode shown. The red
RIT means that RIT is on, and the number left of it is the amount of offset. The black XIT means
that XIT is not selected. Turn on XIT and you'll see it turn red.
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The color-coding of spots in the Bandmap is the same as in the Entry Window, so each of those red
calls represents a new multiplier in the contest. If you want, you can mouse over a spot, and the
program will tell you more about it. The Ã¢â‚¬Å“635 min tells you how long ago the spot was
posted. Generally, you won't want to keep spots displayed that long, and a little later I'll explain
how to clear spots after a certain amount of time has elapsed.

In a busy contest, certain parts of the band can get pretty crowded with spots. Pressing the numeric
keypad + key will zoom the bandmap in and spread the spots out, like this:

 
Pressing the numeric keypad - key will have the opposite effect. You can also zoom the bandmap
using the scroll wheel on your mouse, if it has one.

Another useful thing about the bandmap. If you single -click on a spot, your radio will automatically
be sent to that spot. If, instead, you click on the frequency scale (anywhere within the width of the
frequency hash marks), the radio will go to that frequency. There are also keyboard shortcuts that
will move your radio from spot to spot up and down the band. More on this later.
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When you single-click on a spot, something else useful happens - Ã¢â‚¬Å“ the call sign of that
station is copied to the Call-Frame of the Entry Window, like this. This is done this way so that if you
discover that the station on that frequency isn't OK1XJ after all, you can just type in the correct call.
This does happen now and then with packet spots.

However, let's assume it's OK. In that case, all you have to do is call the station, get him to answer
you, and hit Space. Here's what happens - the call sign is pulled down into the Call-sign field, and
the QSO is all set for logging, once you complete the exchange.

 
Another good thing can happen on the band-map when you complete a QSO and tune off the
frequency - the spot's color code turns to grey, so that you know at a glance that you have worked
the station already, and won't waste time when you come back to that frequency again.
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To turn on this feature, click Config, and then, in the dropdown menu, click on the two items
checked (see below). You need them both because grey spots are regarded as non-workable, and
they will disappear unless Show non-workable spots is checked. If you don't work a station, and
tune off his frequency, his call sign will appear in the appropriate color to denote whether he's a
new multiplier or simply a valid QSO; either way you know to go back and work him later, if he's still
there.

 
By the way, even if you never plan to use packet spots, the Bandmap is a very useful window. As
you S&P your way up and down the band, each station you've worked will be marked with a grey
self-spot, so you can skip by them the next time even if you have no packet spots.
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You may be wondering how to move quickly up and down the bandmap, hitting only the workable
spots, or those that represent multipliers. This might be a good time to introduce another very
useful section of the Manual. N1MM Logger makes extensive use of "hot-keys" to largely or entirely
eliminate the use of the mouse during contest operations. There is a very useful section in the
manual titled "Key Assignments" which explains each and every such key combination. For
example, under "Active Radio/Bandmap Key Assignments" it lists:

Jump to Spots Note: If you are operating single mode, your mode won't change when jumping
between spots.

Ctrl+Down Arrow - Get next spot higher in frequency.
Ctrl+Up Arrow - Get next spot lower in frequency.
Alt+Ctrl+Down Arrow - Get next spot higher in frequency that is a multiplier.
Alt+Ctrl+Up Arrow - Get next spot lower in frequency that is a multiplier

Try these and see - with a full bandmap and these keystrokes, it is easy to work 100+ search and
pounce QSOs per hour, something that used to be regarded as impossible.

As we're finishing up this introduction to the Bandmap, it might be a good idea to offer another
general hint when you're exploring the program. Be sure to right-click on each new window (other
than the Entry Window), to see what options involving that window might be available to you. Each
of these options is explained in the section of the manual dealing with that window.

If you do this with the Bandmap, you'll see this right-click menu:
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Of the choices here, Packet Spot Timeout is perhaps the most useful. Click there and set the
timeout interval in minutes - Ã¢â‚¬Å“ both self-spots and spots from packet will disappear after
however many minutes you choose.

 
The Reset Radios command is also useful in case, for some reason, you lose control of your radio.
Click it, and the program resets the connection.
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Again, if you go to the manual, you'll find much more exhaustive discussion of each menu option,
but that's enough for us right now.

So really, that's all you need to operate contests with N1MM Logger controlling your radio - the
Entry Window, the Check Window, the Log Window and the Bandmap. Of course, there are a zillion
more capabilities you'll want to explore, beginning with the capability for sending stored messages,
but I have to stop somewhere, at least for now.

Interfacing for Phone, CW and PTT

Of course, controlling your radio through a serial port isn't the only way to interface N1MM Logger
and your radio - in fact, long before there were computer-controllable radios, the pioneering logging
software authors developed several standards for CW and PTT interfacing, using either serial or
LPT (printer) ports.

I'm going to start, though, with a discussion of phone interfacing, on the theory that this will be of
most interest to new users. What I mean here is setting the program up so that you can store voice
messages and play them back through your radio, to save your voice during phone contests.

Phone Interfacing

 
There are two levels to this - the physical interface and the software setup. Physically, you will need
to connect your microphone to the Microphone In jack on your sound card, and provide an interface
between your sound card's Line Out jack and the microphone jack on your rig. This can be as
simple as a 10:1 voltage divider (the Line Out signal level is much higher than your radio's
microphone jack is designed for) and isolation transformers (to avoid feeding AC hum into the
sensitive microphone jack on either your sound card or your rig). You can also use any of the
commercial interfaces (RigBlasters, for example) designed for digital modes using AFSK.

Here's a simple schematic
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Now, on to the software setup, which is where most people seem to have trouble. The following
discussion is cribbed almost verbatim from audio trouble-shooting notes by Dave Robbins, K1TTT. If
any mistakes have crept in, blame me, not him.

To begin with, make sure you close Windows Media Player, RealPlayer, Audacity, or any other
sound playback/recording program you may have open. Start N1MM Logger and open the
Configure|Ports, Other tab.
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Now select the Audio tab. As shown here, select option 1 "zero or single sound card" from the
drop-down list. Select "default" in the first "select device" list:

 
Now OK out to save that setting, and close N1MM Logger.

Plug your microphone directly into the microphone jack on your sound card. Plug your headset
directly into its speaker output. Open the Windows Volume Control. It should come up with a set of
sliders, like this:
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Set all the sliders to mid range, and un-mute everything. You may have to go into
Options|Properties to check the box to let you see the microphone volume control and those for
other sound sources.

In Options|Properties, now , click the 'Recording' radio button, and make sure the microphone is
checked on the list of controls:

 
Now OK out. Make sure the Microphone slider is at mid-range and that there is a check in the
Select box. If you are using a typical ham microphone, such as a Heil, and you have the
"Advanced" button, click on it and select Mic Boost if that option is available, because it provides a
20 dB preamp.
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Now, when you talk in the microphone, you should be able to hear yourself in the headset. If you
can't, then something is wrong with your settings, hardware or drivers. Try playing existing .wav files
using the Windows Control Panel's Sounds option. Recheck volume and mute settings, check that
the microphone is plugged into the right jack, try a different microphone, try a different headset. Get
your 8 year old kid to help. DO NOT PASS THIS POINT UNTIL YOU CAN HEAR YOURSELF!

Now open Windows Sound Recorder, which is usually found in the Accessories category in your
program list. DO NOT open Audacity, any of the audio tools that came with your sound card, or
your other favorite tool. Some of them play with the mixer settings and we don't want that now that
they are set.

 
Click the Record button in Windows Sound Recorder, and speak a few words into the microphone.
You should see the green trace deflect in time with your voice. Now press Stop. Press the Play
button and you should hear what you just said. If you don't there is something wrong with your
hardware or drivers. Check recording control settings, adjust volume, make sure the microphone is
selected as the recording source, and get that 8 year old back to help again! DO NOT PASS THIS
POINT UNTIL YOU CAN RECORD AND PLAY. If Windows Sound Recorder doesn't work, then
N1MM likely won't work and since N1MM is much more complicated it is harder to troubleshoot.

Now close the Windows Sound Recorder and start N1MM Logger. Put your radio in SSB mode, and
make sure that the Entry Window's title bar specifies either USB or LSB (if you don't have a radio
connected, type the appropriate mode in the callsign box and hit Enter.
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Right-click on any of the message buttons in the entry window. That will bring up this table:

 
The filenames in the table are the default filenames that are put into the table when you first install
MM. Depending on how long ago you first loaded MM, the ones above may not be the same ones
you see.

The easiest way to visualize this is that rows 1-12 represent the 12 function keys in "Run" mode,
while rows 13-24 represent the 12 function keys in S&P ("Search and Pounce") mode. We'll get into
why there are two sets of function key definitions in a little while. But for the moment, let's
concentrate on programming the Run F1 function key. If you click in the first box under Button
Caption, you'll notice that the "pencil" icon moves to that row, and that the cursor will be in the box.
Now you can edit the button caption to whatever you want it to be. Then hit Tab, and the cursor
moves to the .WAV File column. In the example above, I'm assuming that you have a \WAV
subdirectory in the N1MM program directory, and that you want to name your CQ file as I have.

One last thing - if your SSB function keys have something in the 13th row (S&P F1), temporarily
use the Edit function to delete that row, because it will just confuse things right now.

All right - now OK out, and the definition is saved.

 
Now watch the bottom of the Entry Window and press Ctrl+Shift+F1. You should see:

Unless you have something in both boxes in each row, the cursor will not move on to the next
row. You'll note that it looks like F5 violates that rule, but it really doesn't, because there is a
single empty space in that row, which I put there to meet the requirement.

Notice
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If you speak into the microphone at this point, whatever you say will be recorded in the file CQ.WAV.
Press Ctrl+Shift+F1 again to stop the recording, and look for this report in the same place:

 
Now press F1. You should hear what you just recorded in the speaker. If you don't, look for an error
message in the status bar. The most common problem affecting playback is that you recorded the
file with a different program, using a compression or other parameters that are not supported by
N1MM Logger. Another common one is to be looking for a filename that is different than the one
that appears in the key definition table. For both these reasons, we suggest using the Ctrl+Shift+Fx
process to record within N1MM Logger, at least until you get truly comfortable with audio files.

Now that you've got things working, you need to program at least the first few function keys. It's
best to follow the order in the example above, at least for F1-F8, because a little later, when we talk
about ESM (Enter Sends Messages) mode, the order is important.

OK, so now you have everything you need to play "canned" audio messages on the air. If you're
content to use VOX to switch your transmitter, and you're not interested in CW, then you can jump
ahead at this point to Chapter 4 (Using Stored Messages). However, you may want to have N1MM
Logger control your radio's push-to-talk (PTT function). One good reason might be to ease wear
and tear on the relay in your amplifier by having it switch on before your transceiver starts sending it
RF. For this we need a PTT interface.
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CW and PTT Interfacing

 
First, let's set it up in N1MM Logger. Begin by opening the Config menu to the Ports, other dialog:
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Your dialog will show COM ports 1-8 and LPT ports 1-3, regardless of which ports are actually (or
virtually) there. For this example, let's choose COM1 as our CW/PTT port. Put a check in the
CW/PTT box and you'll notice that the Set button is no longer greyed. Click on it, and open the
dialog for that port.

 
You can configure the DTR pin as either CW or PTT. Click the down arrow and you'll see the list of
possibilities:
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Highlight the one you want, depending on your interface. Now do the same with the RTS pin:

 
You'll note that the choices are different. This is because commercial interfaces generally do not
use RTS for CW, while many default to RTS for PTT. If you are building your own . Just make sure
you plug the correct one into the key jack.

 
Set the Radio/VFO Nr to 1. The PTT Delay setting is to protect the relays in an amplifier by making
sure that the T/R relay is closed before the program starts sending CW. The default value of 30 Ms.
is fine even if you don't have an amplifier.

Unless you know that you have your COM1 at a non-standard memory address, assume that N1MM
knows best and accept the default address it suggests. If it is a USB virtual port, this setting doesn't
matter anyway.

OK, now to interface to the rig. The very simplest interface imaginable will work just fine for either
the CW or PTT functions with any modern radio; again, there are many commercial options, but
here's the Radio Shack parts solution:
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CW Messages

 
From the Tools menu, select Change CW/SSB/Digital Message Buttons, and then Change CW
Buttons.

 
Now this dialog appears:
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Again, depending on when you downloaded N1MM Logger, your table may have various messages
already in it. No matter - just click on Edit and delete rows until you get all the way back to the
empty table above.

As you discovered with voice messages, the database table editor is a little quirky, so let's walk
through the process for F1. Click in the first box under "Button Caption", next to the cute little
drawing of a pencil. Type a caption, for example F1, and hit Tab. Instead of jumping to the next box,
the program highlights what you just entered, to give you a chance to change it. Hit Tab again and
the cursor finally moves to the first box under "CW Message". Now type a message that you want to
send frequently, such as a CQ, like this:

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

44 of 680 2/2/2011 4:54 PM



 
OK, what's that asterisk (*)? This is the first and one of the most useful Macros. It denotes your
callsign. There are two types of macros, text macros and action macros - text macros substitute a
string of text for the macro, while action macros perform some program action. Both are often used
in combination with regular text in a message, as shown here - when you press the function key or
click the on-screen F1 button, the program will send CQ TEST N4ZR N4ZR TEST (substituting my
call for the asterisk).

There's a table of the various sorts of Macros in the chapter by that name in the manual, but for
now let's go on. Hit [Tab} twice again, and this happens:
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The "pencil" icon has moved to the second row, and your cursor is there. Conventionally, F2 is used
for your contest exchange, so let's fill one in:

 
{EXCH} is a text macro that substitutes whatever you put in the Sent Exchange part of your contest
setup. Say, for example, we were setting up for a contest where the exchange is signal report, your
name and your state. When I set up the contest, I put PETE WV in the Sent Exchange. Now when I
press or click F2, the program will send 5NN PETE WV.

A couple of fine points - you might think of putting the 5NN in your sent exchange - after all,
everyone's 599, right? Well, don't, because it will screw up your Cabrillo log. Just resign yourself to
putting 5NN (or 599, if you insist) anywhere you want it sent. Also, most macros are in the form of
{WORD}, where "word" is the macro. The curly brackets are necessary so that the program knows
it's time to substitute something or take some action.

Two messages will do for right now, so OK out, and get back to the Entry window.
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From now on, if you want to change the content of any message buttons, there's a shortcut - just
right-click in the area of the buttons, and the table we just left will reappear.

OK - you've hooked up your interface, so now you're ready to send some canned CW. As I said
above, you can either hit the function key F1, or click on the F1 button. Either way, the program will
switch your radio from Receive to Transmit (assuming you have PTT connected - you can also use
VOX or break-in, of course) send the message, and then go back to Receive again.

There are two easy ways to adjust the speed of your CW - either click the up and down arrows next
to the CW speed box (where it says "30" in the picture above), or press [Page Up] or [Page Down],
to increase or decrease speed in 2 word per minute increments. If you hit the wrong key or button,
no problem - hit the [Esc] key to stop sending immediately.

If you want to send CW manually, the easiest way is to
parallel a keyer with the computer CW at the transceiver's key
jack. Alternatively, hit [Ctrl + K], and a CW window appears:

Type the CW you want, and hit Enter when you're done. As soon as you begin typing, the program
begins sending; you can type ahead, and the program will finish sending the CW before the
window closes.

Using Stored Messages in Contests

 

Now the real fun begins. You have interfaced your radio to the program, so MM knows what band
and mode you're using. You can send "canned" voice messages to your radio, as well as CW, and
you can control its PTT.

So now it's time to put all these bells and whistles to work. There are several ways to do this,
depending on how much you want to automate the process. The details are the same for either
phone or CW messages, so let's look at the possibilities.

First, let's reopen the voice message table, by right-clicking on the message buttons while in USB
or LSB.
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If you don't already have all of these messages, use the Ctrl+Shift+Fx process to record them, and
then OK out.

Now open the CW message table.

 
You need to load CW messages corresponding to the phone list above For Function keys 1-8.
Here's what it should look like when you finish.
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There are 4 main ways you can use the stored messages, listed here in ascending order of speed
and convenience.

1. One key at a time - press a function key when you want to send the associated message. Use
the Space bar to move your cursor. When you have everything filled in, press Enter, and the QSO
will be logged. Done this way, a typical Run (CQ) QSO would look like this:

F1 (CQ)1.
Station answers - copy call in callsign box2.
Say his callsign (phone) or press F5 to send it (CW)3.
Press F2 to send the exchange (either a stored voice message or CW)4.
Press <Space> to move the cursor to the exchange field5.
Type in the received exchange6.
Press F3 to send your acknowledgment7.
Press <Enter> to log the QSO8.

 
2. Semi-CT Style - Enter the callsign of the station calling you. Press the Ins key to send his call
and your exchange (CW), or speak his call and then press Ins. Once you have copied his
exchange, press F3 (TU) and <Enter> to Log. If you are calling other stations (Search and Pounce,
or S&P), you would first press F4 to send your call, and when the station responds follow the
sequence as above.

3. Early N1MM style - Enter the callsign of the station calling you. Press the ; key to send his call
and your exchange. Copy his exchange and press the ' key (right next to it on US keyboards). The
program sends the F3 (TU) message and logs the QSO. In S&P, you would hit F4 first, then " ; ",
and then " ' ".

This saves some keystrokes, but there's an easier way. A decade ago, N6TR developed the idea of
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making TR Log "modal." By that, he meant that the program would behave differently depending on
whether you were in Run or S&P mode. Making this distinction let him massively simplify and
shorten the sequence of keystrokes required to complete a QSO.

4. Enter Sends Messages - N1MM Logger has now evolved N6TR's invention into what is called
Enter Sends Messages, or ESM for short.

More on ESM (Enter Sends Messages)

The first step is to turn it on. Open the Config menu in the Entry Window, and select ESM

 
Now close the menu and enter any call in the entry window. We're assuming that you are doing
S&P.
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What's different? Take a look at the F4 button. The highlight means that if you press Enter at this
point, the F4 message will be sent (which is what you want - your call). Press <Enter>, your call is
sent, but the cursor remains in the callsign field, and F4 is still highlighted. If he doesn't answer the
first time, just press <Enter> again. If he answers you, hit <Space>, and look!

 
The cursor has moved to the Exchange box, and now F2 is highlighted. That means that the next
time you hit <Enter>, the program sends F2 and logs the QSO.

So instead of an 8 step process to work an S&P QSO, you have either 3 or 4:

Enter the callsign1.
Press <Enter>2.
(optional) If he doesn't answer, press <Enter> when it's time to call him again; if he does,
press <Space> and copy his exchange

3.

Press <Enter> again to send your exchange to him and log the QSO.4.

 
But suppose you're Running (Calling CQ)? The first thing to do is tell the program. You do that by
checking the box next to the word "Running", either with your mouse or by hitting <Alt>+U. Now
your Entry Window looks a bit different:
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Note the highlight is now on F1, because the first thing in most Run QSOs is a CQ. Press <Enter>
and the program will send F1.

Now someone answers. Type in his callsign and the window changes.

 
You're starting to get the hang of this - the highlights mean that when you hit <Enter> the program
will send F5 followed by F2 (on CW - on phone you would speak the callsign and then press
<Enter> to send your exchange).

Once you have done that, the window changes again.
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Now the highlights tell you that you have copied a legitimate exchange (in this case the program
has supplied it from the callsign, and that the next <Enter> will send your F3 message and log the
QSO.

So, type a callsign, hit <Enter> 3 times, and you've logged a QSO. Pretty slick!

Now suppose you're like me and you fat-finger copying the exchange, so that you have nonsense in
the Exchange box, like this. In that case, the program reminds you:

 
If you hit <Enter> with an incorrect exchange, the program will send the F8 message and request a
repeat. Alternatively, if you see your mistake and correct it, the screen changes again to show the
"F3 and Log It" highlights. Just press <Enter>, the program sends the F3 message, logs the QSO,
and you're done.

Once you've used ESM, I predict you'll never go back to the old way again.
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Two further refinements, and then this chapter is done. Open the Config menu again, and then
open the "Configure Ports, Telnet Address, Other" sub-menu. Click on the Function Keys tab:

In the left-hand column, note that I have checked "Send Corrected Call." This neat feature, in Run
mode, keeps track of whether you have changed the callsign in the callsign box. For example, say
you only copied "DL6A" at first, and filled in the rest later. Eventually, you copy DL6ABC, and when
you press <Enter> to send the F3 (TU message), on CW the program sends "DL6ABC TU ..." On
phone, you'll need to supply the correction.

In the right-hand column, the third checkbox is cumbersomely titled "ESM only sends your call once
in S&P, then ready to copy received exchange." In shorthand, we call this the "Big Gun switch." If
you nearly always get stations you call the first time, you can save a keystroke by having the cursor
advance automatically to the exchange box after the first time you call. If you often need to call
again, don't check it. If you have checked it, and need to call a station more than once, you just
press F4, regardless of where the cursor is.

 

 

N1MM Logger Manual

Don't change the "key mappings" (below the red type) unless you absolutely know what you're
doing - it can make a horrible hash out of ESM.

Caution
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7.3 Troubleshooting

Overview and Installation

Table of Contents:

1 Quick Tour
2 Overview
3 Features
4 PC Requirements
5 Installation
6 Setting up the Program
7 Basic Functions
8 Advanced Functions
9 Two Monitor Support

 

 

Idea & overall design: Tom Wagner N1MM
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Overall programming: Tom Wagner N1MM

Programming: Rick Ellison N2AMG

Terry Gerdes AB5K

Documentation/Help: Thomas Tinge PA1M

Testing and proposals: Members Yahoo groups Thanks!!!

 

Copyright 1998-2006, Tom Wagner (N1MM), Rick Ellison (N2AMG), Thomas Tinge (PA1M), Terry
Gerdes (AB5K)

CRC32 portion of this program Copyright (C) 2001 DI Management Services Pty Ltd.
DLPORTIO is copyright 1996, Scientific Software Tools, Inc.

 

Quick Tour (a must read!)

or

(and no, Tom wasn't drinking when he wrote this, many years ago. It's been updated to the current
state of the program, but the jokes are all his)

Ten Easy Steps to Successful Logging

Quick Tour (a must read!)
Step 1. Setup
Step 2. Adjust Window Positions
Step 3. Connect the Sound Card and the CW interface
Step 4. Entering a Call
Step 5. Using the Space Bar to Tab
Step 6. Using the Tab Key
Step 7. Bandmaps, Spots and Other Cool Stuff
Step 8. Spots are Fun
Step 9. Actually Logging Contacts
Step 10. The Exciting Finale
Step 11. CW and WAV Recordings
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Step 1. Setup

Get your radio, packet and telnet connections set up (Config > Configure Ports, Telnet address,
other). You really won't be impressed without the radio connected. The program really shines when
you have a spotting connection (packet or Telnet).

Step 2. Adjust Window Positions

Adjust the window positions as desired by opening every window separately from the 'Window'
menu.

Step 3. Connect the Sound Card and the CW interface

Connect your sound card to the radio so that you can play wave files or record contacts. Connect
your CW interface to the parallel, serial or USB port for CW keying. See the Interfacing section for
possibilities.

Step 4. Entering a Call
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OK, now we are ready to log. By default, you should be in the DX (General) log - look at the Log
Window caption.

 
So you want to log a qso? Type in the callsign field of the Entry Window part or all of the call of the
station you want to log. Let's say you type 'N1M'. Notice that the Check window shows calls with N1
in it, later N1M.... This will happen with any call or partial call that is 2 or more characters long.

 
Use the mouse and click on N1MM in the Check window. Notice that N1MM will be transferred to
the Entry Window callsign field. Hit
Space once. Defaults will be set for fields that can have defaults (in this case the RST fields) and
the cursor will be placed in the next field to be filled in — the name field.
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Step 5. Using the Space Bar to Tab

Ok, that's cool, lets try it another way. Click on the Wipe button to clear the Entry Window fields.
Your cursor will be positioned on the callsign field again. This time Type 'N1MM' and press
**SPACE**. Notice that the RST fields are again filled automatically and you are positioned to the
next field to be filled in. Enter 'Tom' and press SPACE. In this case, you will not tab to the next field,
since space is a legitimate character in a name. This is atypical behavior. Most contest fields do not
allow any spaces in them, so the space bar will jump from field to field. You'll like this, dammit!
Really, I think you will like it - particularly in contests.

Step 6. Using the Tab Key

So if SPACE tabs, what does Tab do? It tabs as well! But it doesn't tab like space. The Tab
character (and Shift+Tab) behave like they do in most programs. They jump from field to field,
without trying to be smart. So if you need to change the RST, you'll use the Tab key to get there.

Step 7. Bandmaps, Spots and Other Cool Stuff

 
Ok now the really cool part. We need to get some spots onto the bandmaps. If you have set up a
radio, and you have selected SO2V in the Configurer, you should have two bandmaps, and they
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should be displaying the frequencies of your A and B VFOs at the top. So how do we get spots on
there? We need to connect to packet or Telnet, of course. If you have an Internet connection, try
Telnet, if a packet connection, well I guess you'll try packet. To pick, click on the appropriate tab in
the Packet/Telnet Window. To connect to packet, just type a command in the one-line text box at the
top, like "C K1TTT" and press enter. Just do your usual stuff. Then type sh/dx/100 (we want a lot of
spots) if it's a weekend, otherwise just type sh/dx/30 (Why the difference? The logger won't show
old spots - the default is 60 minutes).

To use Telnet, you must choose a Telnet server. The easiest way to do this is to select the Telnet tab
in the Packet/Telnet Window, then choose one from the drop-down list. Type your call in the input
line at the top, or click the button with your call on it. Answer any questions the node asks you, and
then, if it's a weekend, type sh/dx/100 (we want a lot of spots), otherwise just type sh/dx/30. (Why
the difference? The logger won't show old spots - the default is 60 minutes.

Step 8. Spots are Fun

Spots should start appearing. Don't be afraid, there is no leopard. (Get it, spots?) Enough dumb
jokes. Anyway, that's what people always tell me. So, what can we do with the spots? Lots of stuff.
First note that each spot (except US and VE spots and spots from your own country) has its beam
heading next to it. (Well it has the beam heading from my house, too bad if it isn't the beam
heading from your house. If you really want to fix that, go to the station dialog in Config/Change
Your Station Data - you'll need to enter your latitude and longitude. If you don't know your latitude
and longitude, tough - this isn't geography class, kid.)

Are we ever going to get to the good stuff? Sigh. OK. You have spots in your bandmaps. Try
SINGLE clicking on one. Notice how the radio tunes to the frequency of the spot? Also notice that
the call appears in the frame around the callsign textbox in the Entry Window. Now press that
magic space bar again. The spot jumps into the call textbox! Let's try this another way. Click on the
Wipe button (or press Ctrl+W). Now tune the radio to a frequency within 300 Hz of another spot.
Notice that the call again appears in the frame, and again the space bar will enter the call into the
call textbox.

Ok, try Wiping again (either way). Now double click on a spot. Notice that again, you jump to the
frequency of the spot, but this time the call is entered in the callsign field and the default fields are
filled in, and you are ready to copy the next empty field (in this case name).

Wipe just one more time. Let's try jumping around the spots without using the mouse. Your cursor
should be in the callsign field. If it isn't put it there. Now press Ctrl+Up arrow or Ctrl+Down arrow.
You should jump from spot to spot on the same band. Pick one of the spots where you can hear the
station. Use the up and down arrow keys (no Ctrl this time) to tune the station in. Each press of the
key will go jump 100 Hz on SSB and 20 Hz on CW (configurable). You're smiling, aren't you? There
is a lot more. Go look here for more keyboard tricks: Key Assignments and Key Assignments
Short List

Step 9. Actually Logging Contacts
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We need to shift attention to actually logging contacts. Enter a call in the call textbox, press Space
and then type a name, well any name except 'Arthur' in the name textbox. (I'm sorry, I really cannot
be responsible if you type Arthur.) You typed Arthur, and nothing happened, didn't you? Now you're
angry. Here's a quarter.... Ok. Back on task. You have enough to log a contact now. Press Enter,
and notice that the contact will appear in the Log Window.

Now the fun part. Enter the same callsign again and press Space. Looky, looky! The usual stuff
happens, but two more things happen as well. The first contact shows up in the lower part of the
Log Window, and the name from the first contact appears in the name field. If you were logging a
contest, like ARRL DX, the power would be filled in from the first contact. If the first contact was on
the same band as this contact, then the word "DUPE" in BIG RED LETTERS would appear. I was
going to put the word "Dope", but then I thought that no one would want to use the program.
Really, you should probably work the dope, I mean dupe, since you might not be in his log. It's
actually easier to just work him than explain "You're a dupe, dope!"

Ok, press Enter and log the dupe. You don't agree with me about logging dupes? Then
RIGHT-click on the Log Window entry for the dupe, and choose delete contact. No, I'm not going to
tell you what to do with the dialog box that pops up. I trust you. I feel like we are already friends.

Step 10. The Exciting Finale

Now for the exciting finale, if I called it the boring finale, you wouldn't read it now, would you? It is
kind of boring, but I really couldn't trust you to get this far, now could I? This step is about all the
wonderful things you can change about this program. If I tried to explain them all, you wouldn't read
it, so here is just a little bit.

Look at the View menu in the Entry Window. Here you can look at your current log (or any past log
that you open) in a lot of different ways, including a really flexible Statistics function. The Tools
menu lets you rescore the contest, download various files from the Internet (like master.dta and .cty
files, for example), and a lot of other useful things. The Config menu lets you change all the
exciting Configuration options that we all know and love by now.

Step 11. CW and WAV Recordings

"Hey wait," you say, "You said there were 10 easy steps - what's this number 11 business?" There is
a very simple answer. I lied. I wanted to write only 10, but I forgot to tell you about the CW and SSB
buttons. They are preset at the factory (ok, at my house), to be very useful to only me. Try them
anyway. If you have a CW interface, the CW buttons will send pretty damn good CW, even when
you are doing other things like moving windows around. You had better appreciate this, because it
was very hard to code, and I am very proud of it.

The same buttons are used in SSB to send WAV files. While this seems much harder, it was
actually quite easy, but it's ok if you are impressed. I don't care, so long as you are impressed. You
don't need to hook up your radio to enjoy this wonderful feature, just hook some speakers to your
sound card and listen to my melodious voice call CQ as you click on the CQ button. In a real
contest, however, you'll want to hook up the output of the sound card to your microphone input
through a Radio Shack audio transformer and resistor setup. The high impedance side (with a 100k
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series resistor) goes to the microphone input, the low impedance side goes to the sound card
speaker out. Of course you'll need to adjust the levels using the software that comes with your
operating system or sound card. See the interface section for more info.

This thing will record QSOs as well, but I'll let you find that in the Manual.

I hope you have enjoyed this quick tour as much as I have enjoyed writing it. And for the second
time, no, I was not drinking when I wrote this.

1. N1MM Logger Discussion Groups

These groups discuss features, bugs, and ideas for the N1MM Free Contest Logger.

General group: Messages dealing with general program issues (including CW and SSB
contest) will be posted to the General Group
Digital group: Messages dealing solely with digital mode issues (including digital contests) will
be posted to the Digital Group

 
In general messages should not be cross-posted, either by users or by the development team. This
is important, both to get the benefit of the subdivision and to encourage users to subscribe to both.
Users are asked please to separate digital and general/non-digital issues into individual messages
and post them in the right places — on the receiving side, all e-mail software has tools to sort e-mail
into folders by origin, so nothing should get lost.

The development team will continue to track both forums and respond on the one that seems
appropriate.

So if your interest is primarily digital, for example, you may want to subscribe to the general group
in one of the digest formats available. If it is primarily non-digital, then you might do the same thing,
in reverse.

General program issues Digital program issues

(including CW and SSB contests) (including digital contests)

Post
message

N1MMLogger@yahoogroups.com N1MMLogger-Digital@yahoogroups.com

Subscribe N1MMLogger-
subscribe@yahoogroups.com

N1MMLogger-Digital-
subscribe@yahoogroups.com

Unsubscribe N1MMLogger-
unsubscribe@yahoogroups.com

N1MMLogger-Digital-
unsubscribe@yahoogroups.com

Digital operators are well advised to subscribe to the general Yahoo group and the digital Yahoo
group, even if not interested in CW or SSB, because general things about the program that
affect them (font changes in various windows, for example), are likely to be discussed there
rather than in both lists.

Digital Operators
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List owner N1MMLogger-
owner@yahoogroups.com

N1MMLogger-Digital-
owner@yahoogroups.com

 
Everybody is allowed to read the messages from the support groups. To send messages you have
to join the group. Your first post must be approved by the moderator. This prevents spammers from
using the list. Over 3000 users have already joined.

 

N1MM Logger Features

 

General

All major and many minor HF Contests are supported
Including General DX logging, DXpedition, DXSatellite and VHF DX.

SSB, CW and Digital support
Multi-user support
Rover support for QSO parties and other contests which support this.
VHF and up contesting

Transverter support (SHF bands supported up to 10, 24, 47, 76, 142 and 241 GHz).
Dxpedition mode (Stay in Run or S&P)

 

Key features

ESM- Enter Send Message Mode - just press the Enter key to make a qso.
Uses sound card for DVK but also DVK interface for W9XT and other DVK interfaces.
Automatic CW generation (LPT and via USB to serial converter).
Rotator control (Using N1MM Rotor, LP-Rotor or ARSWIN).
Grayline program
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Two VFO support when using one radio, with one VFO per Bandmap.
SO2R/SO2V support including $5 SO2R supporting SO2R with just sound cards.
Telnet and packet support - spots from both automatically update the bandmaps.
Winkey support (Serial CW keyer by K1EL).
Automatic beam heading and sunrise/sunset calculations.
Contact recording to wav files. Right-click on log entry to play back.

Record level indicator for recording QSOs.
Spot all S&P calls locally (QSYing wipes the call and spots QSO in bandmap).

Digital support

All major and most smaller RTTY and Digital contests
AFSK and FSK with use of soundcards and terminal units (DXP-38, PK-232, Kam, etc.)
Interfaces with MMTTY, MMVARI, and Fldigi
SO1V, SO2V and SO2R
Up to 4 parallel RX decoding windows using either MMTTY or a TU, all interacting with the
Entry Window
Multiplier/Dupe color coding of calls on the fly in any RX window
Ability to find calls in Master.dta file in long strings of text in the RX windows (e.g., in
ASDFGHJKLN1MMAS#$%WERT, N1MM would be highlighted)
Multiple call Grab window that displays last 7 callsigns received in the RX window.
Point and click capture of callsigns and exchanges to Entry Window
Ability to complete entire QSO with mouse and never leave the RX window (With ESM turned
on)
Up to 24 additional macro buttons
Ability to stack incoming calls and work them off the stack by using a TU/Now macro

 

Windows

Entry Window, Log, ((Packet/Telnet)), Score Summary,Info, Available Mults and Qs and the
Digital Interfaces
Multiplier window.
Call check function , including N+1 matching
Dual graphical bandmaps click to tune radio to the spot selected. The bandmap can be
zoomed in or out depending on number of spots shown.
Available Window keeps track of needed spots and mults on each band for easy band-change
decisions. **Color-coded buttons indicate on which bands the current contact is needed.
The program retains the size and position of windows as specified by the user.
Click on packet spot in Packet/Telnet window, Bandmap or Available window to tune to that
frequency/mode.

 

Advanced features
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SO2R including Dueling CQ and selectable advanced SO2R modes
Serial number server for SO2R and multi-user modes - coordinates serial numbers between
radios.
S&P callsign stacking.
Multi user support with automatic resync on reconnect.
Rotator control
Antenna mapping.

Radio support

Radio interface to support radios from Kenwood, many Yaesu (for example: FT-1000,
FT-1000MP, FT-990, FT-920 and more), Icom, Tentec Orion and Elecraft.

 

Hardware Support

LPT port functionality to control antenna switches, radio selection, and PTT (95/98/ME/NT
/2000/XP).
Support for microHAM and OTRSP SO2R protocols.

 

Import/Export features

Cabrillo export support.
ADIF import/export support.
Transaction log, which keeps all QSOs to facilitate recovery of log.
Statistical reports.

 
Many more..

PC Requirements

 

Minimum Hardware Requirements

The logging program has been designed to work within the minimum configuration required by
various versions of Windows - each of which differs with regard to the minimum processor model,
CPU speed and RAM. You may encounter performance problems when running minimum
configurations and operating CW or RTTY modes, when receiving a high volume of cluster spots, or
when your PC is simultaneously running several other applications. It has not been and won't be a
priority to make N1MM Logger run on clunkers.
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The recommended minimum graphical resolution is 1024 by 768, with many hams running higher
resolutions and dual screens. Although N1MM Logger will operate at 800 by 600, you will be unable
to fit all of the windows on the screen.
Radio control, CW keying and PTT can be done through a free serial or parallel port, or through
Winkey (highly recommended). For PTT with MMTTY an extra serial port is needed.

USB-to-serial converters and USB interface devices are supported through virtual serial ports
provided by their associated driver software. SO2R "boxes" may be controlled through a hardware
LPT port under 32-bit operating systems; alternatively, the MicroHam USB SO2R Control Protocol
and the K1XM Open Two Radio Support Protocol are both supported, for use with devices that
accommodate them. USB-to-LPT converters cannot be used for either SO2R control or CW/PTT
functions.

For more information see the Interfacing section.

Supported Operating Systems

Windows NT
Windows 2000
Windows XP
Windows Vista 32/64
Windows 7 32/64

 
Linux and other Operating Systems will not be supported.

Installing and Upgrading N1MM Logger

In this Section...

Installing and Upgrading N1MM Logger
1. First-Time Installation Instructions
2. Using the Program the First Time
3. Subsequent Install Instructions / Upgrading to a New Program Version
4. Uninstalling the Program

1. First-Time Installation Instructions

 

Not your first time?
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These instructions apply both for first-time users and for users who are jumping from one base
version to another. That is, if you previously installed Version 9.x.x (or earlier) and want now to
update to Version 10.x.x, then you need to go through this process with the Version 10 Base
Install before you install the latest and greatest. In particular, this is needed to update the files
used for recording and playback of .wav files.

By design, version 10's default installation location is C:\N1MM Logger. If you are installing the
program under Windows Vista or Windows 7, and wish to place it in the Program Files directory,
you will need to take some special steps. This is because these operating systems do not
approve of writing to the Program Files directory, which is how N1MM Logger works. You have
three choices:

 

Run the Base Install, the N1MM Logger program itself and any subsequent upgrades the
first time as Administrator. If you have not set up individual user accounts on your computer
(if you do not have to log in as a particular user) then both operating systems default to
running as Administrator. If you have individual user accounts, then you will need to
right-click on the program icon, and select "Run as Administrator." After you have done this
once for each upgrade, it is not required in normal operation.
Log in to Windows as Administrator whenever you install or run N1MM Logger. If your PC
has USER or OWNER Icons upon startup and NO ADMINISTRATOR Icon, you need to
enable the ADMINISTRATOR account in order to run the N1MM Logger program.

Open the command prompt with Administrative privileges by opening the Start Menu,
and typing cmd in the search box, and then press Ctrl+Shift+Enter or click the Start
orb, All Programs, Accessories, right-click Command Prompt and select Run as
administrator. Type the following in the command prompt and press Enter: net user
administrator /active:yes . Restart your computer and login as Administrator. Note: You
might want to set a password for the administrator's account for at least a little
protection.

Disable the operating system feature that normally prevents writing to the program folder.
This is called User Access Control (UAC), and disabling it is not recommended.

Installing under Vista or Windows 7

Installing on 64-bit systems
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Download the Base Install here. Run the Base Installer

 

If you are installing on a 64-bit computer, and you are planning to use the machine's LPT port
for CW or control functions, then you will need to replace the standard DLPortio driver with a
64-bit equivalent. The following explanation was provided by W4TV, and is reproduced here
intact except for very minor editorial changes. Thanks, Joe!

 
Making It Work ...

1) Download the binary distribution of InpOut32 here:

2) DO NOT allow the N1MM base installer to install DlPortIO (it will by default, unless you
uncheck the box (see below). If DlPortIO has been installed, go into both Windows/System32
and Windows/SysWOW64 and delete any copy of DlPortIO.dll found there.

3) DO NOT use "InstallDriver.exe" from the "InpOutBinaries_1500.zip" package.

4) Extract only Win32\inpout32.dll from the distribution package and copy it to your computer's
Windows\SysWOW64 directory. Rename it as DlPortIO.dll

5) Reboot after copying the DLL to Windows\SysWOW64 (may not be necessary)

Full = Base
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Next, you will be asked to agree to a straightforward, freeware license.

 
Next, you will be given a choice of files to install, which looks like this.

Wherever you see the terms Base Install or Base Installer and Full Install or Full Installer
anywhere in this manual, they are referring to the same things. With Version 10.0.0, for the first
time the Base Install will not run by itself, but rather must be immediately updated to a later
incremenetal version (such as 10.2.5, for example). For that reason some felt it was no longer
correct to call it a "Full" Install. That led to the term being changed in some places but not yet in
others. Please bear with us!
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Unless you have a good reason not to, just go ahead and leave everything checked. If you plan to
use parallel port(s) for CW, PTT, or SO2R control, and you are running a 32-bit operating system,
be sure to install the DLPORTIO port driver. If you are running a 64-bit computer, refer back to the
note above and don't install DLPORTIO

In the next screen, note that the default location for installation of the program is C:\N1MM Logger.
This is new, and was done in order to work around operating system restrictions that caused
problems for users with Vista or Windows 7. If you have previously installed N1MM Logger, for
instance in C:\Program Files, the default location will not be used; instead, the last previous
program directory will appear here.
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When you click Install, the Full Installer will

Install all needed files on your computer to run N1MM logger
Update your system files where needed

 
You will find that certain parts of the Full Installer installation routine take quite a long time. The
installation program has not failed, so just let it run to completion. Subsequent updates are orders
of magnitude faster.

 

 

When running the Full Installer your computer may report that certain system files are already
installed on your system and are newer than the ones you are trying to install. It asks if you
want to replace a newer, existing file with an older file in the Full Installer. Select 'No'. You do
not want to overwrite newer system files.

Do Not Overwrite Newer System Files
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After the installation process is complete, if you have opted to install DLPORTIO, you will be invited
to install it as a separate process. just follow the on-screen instructions.

The first time you try to run the Full Install version of the program, you will be prompted to update to
the latest version.

 

Click the button at the bottom of the window to go to the web page, and download the latest version
you find there. Run the version installer, and follow its simple steps to get fully up to date. Each
update will take literally 2 minutes to install.

If you are installing N1MM Logger on a computer that does not have internet access, you will need
to download the latest version from a computer that has internet access. This procedure is
described in the section "Subsequent Install Instructions / Upgrading to a New Program Version".
After downloading the latest version, copy and install it on the non-internet computer.

For version 9 and before, the default installation location was in C:\Program Files\N1MM Logger.
Because this caused inconvenience for users of Vista and Windows 7, beginning with Version
10, the default location is C:\N1MM Logger.

 

If you are making a first-time installation of the Version 10 Base Install, the installer will
automatically choose this location. Thereafter, the update installer should point to the same
place. However, some experienced users have chosen to continue to install to Program Files,
and a few of them have reported that the update installer insists on pointing to C:\ regardless.
As you can imagine, putting the Base Install in one place and updates in another can cause all
sorts of problems. It's worth a double-check.

Where is the program installed?
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2. Using the Program the First Time

The first thing to do after starting the program is setting up the station information
This can be done in the 'Change Your Station data' dialog
The first time the program starts automatically with this dialog
This dialog can also be found under >Config >Change Your Station Data

After that configure the radio and packet and/or telnet connection
Choose >Config >Configure ports, Telnet Address, Other

The packet buttons and main window function buttons can be changed
See the Config menu

Alt+H is help
Space is the preferred Tab character (see Help)
Read the Quick Start Guide
Read the Manual, particularly the following key sections.

Quick Tour
Setting up the Program
Entry Window
Key Assignments
Basic Functions
Key Assignments Short List

This one should be printed and placed near the radio

 

3. Subsequent Install Instructions / Upgrading to a New Program Version

 

An e-mail will be send out periodically to announce new versions (updates) of the program to the
Yahoo reflector members.

Download only the N1MM-newexeVx.x.xxx upgrade file (Example: N1MM-newexeV9.12.0.exe
is the first update of December 2009). Use the link contained in the announcement e-mail to
the Yahoo group, or open this web page  and select the update you want

This file contains the latest .exes and other necessary files
Run this file and let it copy all the program files into the N1MM Logger program
directory, replacing any old versions.
When a new cty.dat file is added to the program directory, import it by selecting >Tools
>Import country list from downloaded file
The version number Vx.x.x is also shown in the description of the file

The Base Install for each year is named: N1MM-Fullinstaller.exe. The update files will be
named: N1MM-newexe with a suffix that denotes the date. The annual release of the Full
Installer will be given this name and replace the previous one.

File Naming Conventions
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Only the most recent update file is necessary, not all updates in between...

 

4. Uninstalling the Program

 
If you are thinking of uninstalling and reinstalling the program in order to fix a problem you have
encountered, you should know that this is rarely the solution. Try looking at the Troubleshooting
section before you do that.

However ... if you want to uninstall N1MM Logger entirely, including any registry entries, the best
way is to navigate to the program directory and find the program cleverly titled UninstallN1MM.exe.
Run the uninstaller and follow any prompts you see.

Setting up the Program

In this Section...

Setting up the Program
1. Setup Station Information
2. Setup Radio Control
3. Setup Packet/Telnet
4. Setup PTT-ing the Rig/Sending CW
5. Setup WAV Files (SSB)
6. Sending Messages in CW
7. Setup 'Sent Exchange'
8. Setup the Exchanges
9. Setup Function Keys for Enter Sends Message (ESM) mode
10. Command Line Parameters

When you want to use the program you need to know how to connect the radio(s), packet or Telnet
etc. to the program. Also the Exchanges need to be set up for the contest. Below some information
how this could be done. In addition to reading this chapter also read Basic Functions, the Key
Assignments and the Quick Tour for basic program information.

Many of us are used to always being "one version behind" in our software use, in order to avoid
bugs that may have been introduced in the latest version. But because N1MM Logger is
updated so frequently (typically, at least 50 updates per year), the opposite is true. You are
always encouraged to use the latest version — in general, bug reports and feature requests
should always be made after checking to make sure the latest version does not already include
the bug fix or feature that you want.

Update philosophy

The Configurer
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1. Setup Station Information

The Configurer information in >Change Your Station Data is self-explanatory. Make sure that you
enter your call as the station call sign. Many of the fields in this dialog are used in creating contest
entries, so do update them with their correct values. Like calculating beam headings, distances,
sending a bug report via e-mail etc.

2. Setup Radio Control

The program really shines when a radio is connected so that is what we have to do.

Check if the radio is supported by the program in the Supported Radios chapter.
So it is supported

It is connected right (cable from radio to a serial port from the computer)
Sometimes a serial interface is needed, see the manual of the radio and the
Interfacing chapter

Go to the Configurer and fill in the information under the >Hardware tab
Select the serial port the radio is connected to and choose the radio behind it
Select the 'Set' button and choose the right setting. (baudrate, databits etc)

These can be found in the manual of the radio
There is also some information in the Supported Radios chapter

Press OK , select VFO A and the frequency from the radio should appear in bandmap A

 

3. Setup Packet/Telnet

We need spots to fill the bandmap so the next thing to do is connect to a DX cluster. This can be
done under Configurer >Hardware for telnet and packet. For Telnet an Internet connection is
required. The Telnet cluster can also be selected under Configurer >Hardware.

Go to Configurer >Hardware
Select at the bottom a Telnet Cluster. AB5K is the default cluster and should work fine
Close the Configurer, and open >Window >Packet/Telnet >Telnet in the Packet Window

Cluster commands can be given here, the information from the cluster is shown in the
window
See the Packet window for commands, info etc
Connecting to a Telnet cluster is usually done by sending your callsign
When everything works fine, spots should appear in the bandmap

You will read the term The Configurer throughout this document. What is this beast? The
Configurer is the uber-configuration dialog reached by selecting >Config >Configure Ports,
Telnet Address, Other
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The hardware tab in the configurer is also the place to select the right parameters for setting up a
packet TNC.

The TNC should be connected to a serial port from the computer
The TNC could be checked with Hyperterminal to see if it responds fine

Go to Configurer >Hardware
Select the serial port the TNC is connected to and select the < Packet > box
Press the < Set > button and choose the right settings (baudrate, databits etc) for this serial
port
Close the Configurer, and open >Window >Packet/Telnet >Telnet in the Packet Window

Cluster and TNC commands can be given here, the information from TNC and cluster is
shown in the window
See the Packet window for commands, info, how to connect a cluster using a TNC with
TAPR/TF or WA8DED software etc
When everything works fine, spots should appear in the bandmap

 

4. Setup PTT-ing the Rig/Sending CW

Sending CW and PTT-ing the radio can be done three different ways.

Using the Parallel port
Add an interface to the parallel port, this can be a simple one transistor circuit (for each
pin one) but also a bought interface. More on this in the Interfacing chapter. Pin 16 is
used for PTT and pin 17 for CW. These are fixed values and cannot be changed
Go to Configurer >Hardware

Select behind the LPT port to use the "CW/Other" selection box.
Select the 'Set' button and choose the right settings (CW-speed, PTT-delay and
the CW/Other port address).
The CW/Other Port Address should be the same as used in you Windows
configuration.
Select the correct Radio/VFO setting (1, 2 or Both)
Press < OK >

PTT and CW should work now.
Using the Serial port

Add an interface to the serial port, this can be a simple one transistor circuit (for each pin
one) but also a bought interface . More on this in the interfacing chapter. Mostly the RTS
is used for PTT and DTR for CW
Go to the Configurer and select the hardware tab.

Select behind the serial port to use the "CW/Other" selection box.
Select the 'Set' button and choose the right settings (CW-speed, PTT-delay and
the CW/Other port address).
Select the pin to use to PTT and CW.
The CW/Other Port Address should be the same as used in you Windows
configuration.
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Select the correct Radio/VFO setting (1, 2 or Both)
When Winkey is used also select this setting. The baudrate etc. for Winkey is fixed
and set by the program.
Press < OK >

PTT and CW should work now
Using a USB port

PTT via a USB port can not be done direct, a USB-to-serial converter is needed
Not every Serial-to-USB can change the status of the RTS (and DTR) pins . So check
before you buy
When this device is setup in Windows select the serial port used by it
Follow the steps for a serial port to set up for PTT-ing

 

5. Setup WAV Files (SSB)

The sound (wav) files which have to be made have some standard texts, some are contest
dependent. There are two kind of sound files used by the program.

Files used by the function keys
Sound files used to send the callsign or numbers (in number contests)

by sending single sound files for each letter and number
Or by sending the full callsign or numbers when found in the wav directory

 

6. Sending Messages in CW

You need to do two things:

Set the message properly in >Config >Change Packet/CW/SSB/Digital Message Buttons
>Change CW Buttons. The first 12 rows are the run messages for F1 - F12. The second 12
rows are the S&P messages for F1 - F12. If you have less than 9 messages, the S&P
messages will just repeat the Run messages
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Make sure that the Configurer >Function Keys has each button set to its correct meaning. For
example, if F1 is your CQ key as set in the messages (#1 above), then make sure that the
"CQ Key" box is set to F1

 
To send the serial number in any message, put the character # as part of the CW message in CW
buttons above. There is a list of other characters which can be used to substitute. The macros and
some examples can be found on the Macros page
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7. Setup 'Sent Exchange'

What you put in the >File >Open Log in Database >Contest tab "Sent Exchange" field of the
contest setup is what goes in the cabrillo log. It is also what will be sent if you use the {EXCH}
macro (don't). For the sent exchange, simply program F2 by typing in exactly what you want sent
(For example, 5NN 4 or whatever your zone is for CQWW CW) on the F-key setup window.

8. Setup the Exchanges

By Jamie, WW3S

I'm assuming you want to set up for a RTTY contest.
Go to the Configurer >Function Keys

If you plan to use Enter Sends Message swap F5 and F3
'End of Qso Key' to F5
'His call' to F3

Now go to >Config >Change Packet/CW/SSB/Digital Message Buttons >Change CW
Buttons

The buttons/messages are displayed in order starting with F1
Change the F4 key to read &WW3S in the one column and WW3S in the other.
The & just tells the button what caption to display

Now change the F2 to read 599-599 and your CQ zone.
Mine reads 599-599 PA PA 05 05 BK.

 
Starting to make sense? Whatever you change here is what will be sent.

If you use Enter Sends Message (ESM) the corresponding F-key also needs to be set in
Configurer >Function Keys tab

These keys need to match or ESM will not work!
Set your F3 key for however you want your ''End of qso' to be sent

Mine reads TU QRZ DE WW3S WW3S TEST
F1 reads CQ CQWW TEST DE WW3S WW3S TEST.

These all get changed in change digital buttons. BTW, the same logic applies in CW contests

9. Setup Function Keys for Enter Sends Message (ESM) mode

Below is an example of a possible ESM setup from Jose, CT1AOZ.

Setup the Function Keys in Configurer >Function Keys tab

Default Function Keys

F1 CQ key F5 His Call Key F9

F2 Exchange key F6 QSO B4 Key F10
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F3 End of QSO Key F7 F11

F4 My Call Key F8 Again Key F12

 
Enable all check box options except Monitor via PC speaker (but you may if you want to. NB only
when using Windows 95, 98 or ME).

Now set the macros in >Config >Change Packet/CW/SSB/Digital Message Buttons >Change CW
Buttons. The same settings are used for the SSB and the RTTY buttons.

Running mode S&P mode

Button
Caption

CW message / .WAV file /Text to
Send

Button
Caption

CW message / .WAV file /Text to
Send

F1 CQ CQ CQ ** F1 QSY PSE QSY QRL *

F2 Exch <<< ENN >>># F2 Exch <<< ENN >>>#

F3 TU TU * F3 TU *

F4 My * F4 My *

F5 His ! F5 His !

F6 QSOB4 ! QSOB4 TU * QRZ F6 QSOB4 ! QSOB4 DE *

F7 His/TU ! TU F7 Corr ! TU

F8 Again ! AGN PSE * F8 Again ! AGN PSE *

F9 F9

F10 F10

F11 F11

F12 F12

 
Jose writes: Try this and I'm sure you will be happy with the performance of the program and the
Enter Sends Message mode...

10. Command Line Parameters

The program has a command line parameter to select the used 'N1MM logger.ini' file.
Example: "C:\Program Files\N1MM Logger\N1MM Logger.exe" SO2R.ini

Basic Functions

In this Section...

Basic Functions
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1. Help
2. Going Through the Entry Window Fields
3. Resizing Windows
4. Select New Contest
5. Delete Contest
6. Select Country file
7. Select Master.dta file
8. Changing Frequency
9. Changing Band
10. Changing Mode
11. Changing Operator
12. Setting CW Speed
13. Split Operation

13.1. Setting Spit Frequencies Manually
13.2. Setting Split Frequencies Automatically by Packet Spots
13.3. Resetting to non-split mode
13.4. Split Operation Key Assignments

14. Running Mode
15. Search and Pounce Mode (S&P)

15.1. How to check if you are in Running mode or in S&P mode?
16. CQ Key
17. Set up the Sent exchange message(s)
18. Function Key Conventions
19. Set Up N1MM to Record and Playback Voice Recordings (recording on the fly)

19.1. Playing WAV Files
19.2. Recording WAV Files
19.3. Soundcard Control in Configurer

20. Quick Edit
21. Meaning of Colors
22. Multipliers and QSOs
23. Connecting to a Telnet Cluster
24. How to Save the Log
25. Function Key Macros
26. Save and Restore Window Positions
27. Editing Lookup Tables
28. Backup and Restore

28.1. Method 1: Full backup/restore on same computer - backup and restore
the whole N1MM logger subdirectory
28.2. Method 2: Partial backup/restore on same computer - make a partial
backup and restore.
28.3. Installing on a Different Computer

29. Basic Functions for RTTY

When using the program there are some standard routines like changing frequency, band and
mode. Next to reading this chapter also read the Key Assignments, Setting up the Program,
Entry Window and the Quick Tour to have basic program information. There are also some
features which will be explained in this chapter like 'Running' mode, Search and Pounce' mode and
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'Enter Sends message' mode etc. Operating tips and tricks can be found in the Tips and Tricks
chapter.

1. Help

Almost every window has a Help function. To get to the help, right click on a window and select
'Help', or click on the Help button. The Entry window help can be accessed from the Help menu at
the top, or by pressing Alt+H. Also note that the Key Assignments help can be accessed directly
from the Help menu on the Entry Window. Note that you can print any help topic from the help
system by clicking the Print button. Most of the help files displayed will be for window in which you
select the help. This makes it easier to find the topic you are interested in.
Searching through the Help can be done most easily using the Find function using the PDF version
of the Help file.
There is a very useful facility on the Help menu if your computer is connected to the Internet called
'Searching Help using Google', you can search the latest version of the manual on the website
using Google. This will give by far the quickest results and will include the most recent changes to
the Help/Manual.

2. Going Through the Entry Window Fields

Space is preferred, rather than the Tab key, for advancing through fields in the Entry window.
Space avoids fields (like RST) that don't normally need to be changed and prefills other fields.
Spacebar operation is described in detail in the Key Assignments portion of the help. Using the
Tab and Shift+Tab keys moves the cursor to rarely used fields.

3. Resizing Windows

Logger's windows can be located where ever the user chooses and most can be made any size.
The Bandmap has a minimum width. The new dimensions and positions of the windows are stored
when the program is closed. Closing the Entry window will close the application. All QSOs are
saved permanently to the hard drive as they are logged.

4. Select New Contest

To select a new contest go to the Contest selection dialog ( >File >Open Log in Database ). On the
upper left of the screen a contest can be selected by clicking on it. Fill in the details for your specific
situation. Which contests are supported can be found in the chapter Supported Contests. Check
the website for the latest rules and check the contest setup information in chapter Contest Setup
Instructions.

The preferred procedure is to start with a new database for each major contest where you expect
very large logs or you're running on very slow PCs.

5. Delete Contest
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Go to the Contest selection dialog ( >File >Open Log in Database ) and highlight the contest in the
Contest pane. Then press < Delete >.

6. Select Country file

Selecting a new country file requires not only downloading a country file to your PC but also
importing it into the current database. If a new database is selected you may have to import the
latest country file in the new selected database again! The country file is stored per each database.

Download the latest country file under >Tools >Download latest country file (wl_cty.dat)
(Internet)

Choose the file named wl_cty.dat because it has extra country info
Import this country file by selecting >Tools >Import country list from downloaded file

Until you perform the import, the new country file is not being used by N1MM

 

7. Select Master.dta file

Selecting a new master.dta file with many regular contest callsigns requires that you download the
new file to your PC. No importing is needed but you have to select which master.dta file wil be used
for each contest.

Download a master.dta file for the selected contest under >Tools >Download Latest Check
Partial file (Master.DTA) (Internet)

N1MM Logger supports the CT-format master.dta file
Select which master.dta file to use under >File >Open Log in Database >Associated Files tab

Press the < Change > button beside 'Master.DTA filename' to select the appropriate file

 

8. Changing Frequency

Changing frequency can be done in many ways. Here is a short list with some alternatives

Just turn the dial or change band on your radio, the program will follow if connected
Enter a frequency in the Entry window < Callsign > field. For example, 14200,5 will jump to
14.200,5 MHz. The mode will be changed when needed following the bandmap rules
(depending on the Configurer >Mode Control >Settings tab)
Enter an offset in the Entry window < Callsign > field. For example, if current frequency =
14200 Enter +3, frequency will jump to 14.203 MHz
Enter an offset from the beginning of the MHz in the Entry window < Callsign > field. For
Example: Current frequency = 14200 Enter 123 and the frequency will jump to 14.123 MHz

Placing a/ in front of the frequency or offset will set the second VFO (B). For example,
/12200,5 /+3 /123

Click on a spot in one of the bandmap windows
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Click on a spot in the Packet/Telnet window
In the Log window, right click and select 'Jump to this frequency' to go to the logged QRG
Click on one of the callsigns in the last multipliers below the 'Available Mult's and Qs' window
Push one of the buttons in the 'Available Mult's and Qs' window to change band
Enter an offset in the Entry window < Callsign > field to go 'split'. See the Split Operation
section of this chapter
Use one of the many keys below to change frequency, band or vfo/radio. Go look in the Key
Assignments section to read what they all do!

 

Ctrl+Alt+Down Arrow Ctrl+Shift+Page Down Ctrl+Down
Arrow

Ctrl+Alt+Q Ctrl+Left Alt+Q

Ctrl+Alt+Up Arrow Ctrl+Shift+Page Up Ctrl+Page Up Page Up Ctrl+Right Alt+F8

Ctrl+Shift+Up Arrow Ctrl+Shift+Down Arrow Ctrl+Page
Down

Page Dn Alt+F10 Alt+F11

Ctrl+Shift+Alt+Up
Arrow

Ctrl+Shift+Alt+Down
Arrow

Ctrl+Up Arrow Shift+Alt+Q Alt+F11 Up
Arrow

Need any more?

 
When no radio is attached and PgUp/PgDn is pressed nothing will happen. I.e. if the frequency is
inaccurate, don't allow the operator to move out of band by inadvertently pressing PgUp/PgDn.

When a frequency is chosen outside an amateur band a warning dialog will be shown when trying
to enter information. This could happen making a typo when entering the frequency or when no
radio is connected, so a kind of "radio is not working" message.

9. Changing Band

Below some of the possibilities how to change band.

Change the band on your radio, the program will follow if connected
Ctrl+PgUp - Go up one band. WARC bands are being skipped while logging for a contest
Ctrl+PgDn - Go down one band. WARC bands are being skipped when logging a contest
Enter a frequency in the Entry window 'callsign' field on another band. FOr example: 14200,5
will jump to 14.200,5 MHz
Push one of the band buttons in the 'Available Mult's and Qs' window to change band
Click on one of the callsigns in the last multipliers below the 'Available Mult's and Qs' window

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

85 of 680 2/2/2011 4:54 PM



on another band
Click on a spot in the Packet/Telnet window on another band

 

10. Changing Mode

 

Change the mode on your radio, the program will follow if connected
Change the mode in the top part of the Bandmaps windows by clicking on the mode 'field'
Change the mode by typing CW, LSB, USB, RTTY, AM, FM, PSK or SSTV in the 'Entry
window' callsign field

When a radio is connected it could become a problem to enter PSK, RTTY or SSTV
because most transceivers do not have these modes as a selectable mode on the radio.
Mostly LSB should be chosen on the radio. To have the program log the right mode you
have to go to >Config >Config Ports, Telnet Address, Other >Mode Control tab. Under
'Mode recorded in log' check 'Always:' and also select PSK31 (for example). See also
note below

 

11. Changing Operator

Ctrl+O changes the callsign of the operator. If you are multi-user, you will be prompted for the
operator at startup. The default is the callsign in the station information dialog. A callsign is
required to be entered
Entering "OPON" in the callsign field will also prompt for an operator callsign

 

12. Setting CW Speed

How the mode will be controlled on the radio and how contacts will be logged needs to be set in
Configurer >Mode Control

Setting Mode Control
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Setting CW speed can be done using the Entry window speed control (only shown when CW is
selected) for each radio or VFO. Use PgUP and PgDn or click on the arrows beside the speed box
to change CW speed.

13. Split Operation

Split operation is when you transmit on another frequency then you receive. This is being used
when stations have huge pileups like some DXpedition's or the bandplan does not allow people
making contact on the same frequency. An example is 40 meter SSB between Europe and the USA.
In Europe the highest SSB frequency is 7.1 MHz while US stations may not go that low in
frequency.
Split operation can be recognized in the bandmaps and in the Entry window. In the bandmaps the
big blue marker will indicate your receive frequency. A red marker will indicate your transmit
frequency. The frequency set will become the transmit frequency! Normally only one frequency is
shown in the top portion of the bandmap, when working split the transmit frequency is added and
shown just below the receive frequency. In the Entry window in big gray letters Split will be shown.

The entered split frequency is validated if it is within band limits before setting the VFO. If not a
message is shown in the Entry Window statusbar and the split will not be set.

Cliicking on the receive frequency in the top part of the bandmap will toggle split operation.

 

13.1. Setting Spit Frequencies Manually

Set in the Split dialog with Alt+F7 or type directly into the Callsign textbox in the Entry Window
entering it with Ctrl+Enter. Decimal points and commas are allowed in split frequencies in the
callsign pane. Which one to use depends on the selected preferences in Windows. The split

When you are working split and you are in 'Running' mode moving around will not change
'Running' mode into 'Search and Pounce' mode

Split in Running Mode
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frequency has to be entered or an offset from the current frequency for the active radio/vfo.

Enter Split Frequency or
Enter offset from band bottom (the full MHz) or
Enter offset from current frequency as +5, +4, 3, 6, -2, -5 etc.
For examples
[+]

 

13.2. Setting Split Frequencies Automatically by Packet Spots

When a station is selected in the bandmap it can happen that the program puts the radio into split
automatically. This station has been entered on the packet cluster including a split offset frequency
which will be used by the program.

13.3. Resetting to non-split mode

Resetting to non-split mode is done by moving to another frequency or band. There are many ways
to do this an some are mentioned below.

Click on a spot/frequency in the Bandmap
Click on a spot in the Packet/Telnet window
Click on a band button in the Available Mult's & Q's
Press Ctrl+PgUp or Ctrl+PgDn
Click on the transmit frequency in the top part of the bandmap just below the receive
frequency
Click on the receive frequency in the top part of the bandmap

 

13.4. Split Operation Key Assignments

 
Alt+F7 - Set split frequency or offset from current frequency for the active radio. When hitting Enter
or click OK with nothing on the line split will be cleared. Press ESC or click Cancel to exit.

Icom radios can't report VFO B without being set to VFO B. The program polls VFO A, but not
VFO B. You can only set VFO B from the computer. To set split, press Alt+F7 and enter +3 or
215 or 7215. You can also enter those from the call textbox by pressing Ctrl+Enter. Only turn
Split on/off from the keyboard/program and not on the radio so it stays in sync with the
program.

Split with Icom Radios
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Alt+S - When your rig is in the split mode, Alt+S will reset the receive frequency back to your
transmit frequency, but the split mode is preserved. Application: Many operators will run a pileup
with the rig in split mode. With a radio which has VFO A/B they use the 2nd VFO as an RIT. This is
done since many RIT knobs are small or hard to get at, while some find it more natural to use the
main VFO to tune in a caller rather than use the RIT. By running split, you can use the main knob
to tune in the caller, while your TX frequency doesn't change. The Alt+S acts like an
ÃƒÂ¢Ã¢â€šÂ¬Ãiâ€œRIT clearÃƒÂ¢Ã¢â€šÂ¬Ã‚Â  when you are running split. Operates on VFO-A
only! With a Main/Sub radios like the Icom 756/7800 series you can not RX on SUB without
receiving on both VFOÃƒÂ¢Ã¢â€šÂ¬Ã¢â€žÂ¢s. In this case put RX on Main and TX on SUB for
Alt+S to work.

ÃƒÂ¢Ã¢â€šÂ¬Ãiâ€œReset RX freq when running split" is an associated feature to the Alt+S
function (found in the CONFIG menu). When invoked, the program will automatically do an Alt+S
as you log each QSO. This gives you an automated ÃƒÂ¢Ã¢â€šÂ¬Ãiâ€œRIT
clearÃƒÂ¢Ã¢â€šÂ¬Ã‚Â  after every QSO when you are running split. The exact logging sequence
when you hit the Enter key is: move RX frequency to TX frequency, log QSO, and then send the TU
message. For additional background, see the Alt+S feature

Ctrl+S - When not in split mode it will first put the radio in split mode after that Ctrl+S will toggle the
RX frequency between the split RX frequency and the RX/TX frequency while maintaining split
mode. Application: This was designed primarily to help SSB operators run on 40 or 80m, where split
operation is widely used. For example, "CQ CQ de N1MM listening on this frequency (7183) and
7068". Use the Ctrl+S key to toggle between 7183 and 7068 to check for both USA or DX callers.

Ctrl+Alt+S - Toggle Split mode on the radio. 'Split' will be shown in the Entry window.

Ctrl+Enter - Entering a frequency or offset in the callsign field and entered with Ctrl+Enter will set a
split frequency.

Toggle split operation - Click on the receive frequency in the top part of the bandmap and it will
toggle split operation.

When in split please check out the @ macro (which will voice the receive frequency).

 

14. Running Mode

Running mode means that you are calling CQ and stations are coming back to you. The frequency
you are on is 'fixed' and you are not searching for stations. The program marks this frequency with

Don't click on spots in the packet window. Click on spots in the bandmap or available window.
Then look at the bandmap or the Entrywindow title bar to see if you are going to transmit
out-of-band. I presume we are talking about 40 or 80 meters. If you SINGLE-click on a spot, and
don't see split indication, then wait for the station to announce their frequency. If they say
"listening 214.5" type 214.5 in the callsign and press control enter. You are ready to call them.
Good typists can do this and call them by the time they finish their CQ.

A Split Example
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the text CQ-frequency in the Bandmap window and the 'Running' indicator is marked on the 'Entry
Window'. A part of this feature is that 'Running' mode has it's own set of Function keys. They will be
automatically placed under the keys F1 to F12. There is also a set of function keys for Search and
Pounce' mode, these function keys will swap to Shift+F1 until Shift+F12 so they are still available.

The "Running" switch is automatically marked when:

The operator clicks on CQ-frequency in the Bandmap window
The frequency of the radio is in tuning range of your CQ-frequency (on that band)
Pressing Shift+Function key when in Search and Pounce mode (this can be changed on the
Function Keys tab from the Configurer dialog
CQ-key (as set in Configurer) is pressed

 
When leaving the 'Running' frequency the indicator on the 'Entry Window' will be unmarked and the
Function keys will be swapped for F1 to F12 in the 'Search and Pounce' keys.

When moving away from the 'Running' frequency the program will place you automatically in
Search and Pounce mode. Going back to the 'Running' frequency will automatically select
'Running' mode (the 'Running' indicator is selected again). Clicking on 'CQ-frequency' in the
bandmap will also place the program in 'Running' mode. An exception is when working split i.e.
transmit on one VFO and receive on the other. Moving around will not change 'Running' mode into
Search and Pounce mode.

There is only one CQ-Frequency per band. If swapping VFOs, it is possible to swap between
'Running' and Search & Pounce mode.
Often used keys in Running mode (CW)

Insert or ; - Sends His Call key followed by the Exchange key
' - Sends TU message and enter in log
F4 - Sends my call

 

15. Search and Pounce Mode (S&P)

'Search and Pounce' mode (S&P) is the opposite of 'Running' mode. The program is always in one
or in the other. S&P mode means searching for stations on the bands and not calling CQ. The
frequency used is not 'fixed'. The 'Running' indicator is not marked on the 'Entry Window'. The
function keys under F1 until F12 are the keys programmed for Search and Pounce' mode, the
'Running' mode function keys are swapped to Shift+F1 until Shift+F12 so they are still available.

 
When pressing Shift, the labels will change (when made different) and the text from the "Running"

If "Running" is checked, the Run messages are shown on the Function Keys. Otherwise, the
Search and Pounce messages are shown on the Function Keys.

Function Keys Change for Run vs S&P
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keys become the text from the "Search & Pounce" keys and vice versa. SHIFT REVERSES THE
MEANING OF THE ABOVE RULE.

When in Search and Pounce mode, to call CQ, the CQ-key as configured is used, usually F1. No
need to press Shift+F1. Pressing F1 will send CQ and place the program in Run mode. From that
point on F1 will call CQ (in Running mode). If you want to sent CQ without shifting to Run mode,
use the S&P CQ macro to stay in S&P mode.

When entering a call in the S&P mode and the call is a dupe, changing frequency (QSY) will
automatically enter the dupe callsign into the band map and clear the Entry Window..

 

15.1. How to check if you are in Running mode or in S&P mode?

* Running checkbox checked/unchecked.
* Textboxes are white in running, yellow in S&P and blue in quickedit.
* The green ball shows "Ru" for running, "SP" for S&P.
* You can put different labels on the textboxes for Running & S&P.
* "CQ-Frequency" will show on the callframe if you are Running.
* "CQ-Frequency" appears next to the frequency arrow on the bandmap when going into Running
mode.

Another possibilitiy is to is give F1 Running and F1 S&P a more meaningful name. So in the F1 title
put the caption "F1 - RUN", and in the F1 for S&P (F13..) put the caption "F1 - S/P". This way the
first macro location will tell which set of macros are enabled. Because F1 is always the CQ key
(when defined) there is no need for CQ in the title to make that clear.

16. CQ Key

The program uses the CQ Key as defined in Configurer >Function Key tab. This means that when
F1 is pushed it will send a CQ as defined in the CQ-key (most often F1). This happens both when
in Run and in S&P mode. N.B. So when pressing F1 in S&P mode would give CQ and change to
Run mode. When using F1 in S&P mode to call a station (so the content of the S&P F1 key holds
your own callsign) and you want to stay in S&P then use the {S&P} macro to not change to Run
mode and stay in S&P mode.

* In cases where users desire more than one CQ F-key, include the new {CQ} macro which
identifies the F-key as an additional CQ F-key
* Use the {S&P} macro to stay in S&P mode

When a frequency is busy it can be marked with Mark (Alt+M). This could be used when the
station on that frequency is not in the contest, may not be worked in the contest or seldom says
his callsign to have the frequency marked in the bandmap. Press Alt+M, and move on. That
frequency is busy, so you won't want to stop there again.

Tip
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17. Set up the Sent exchange message(s)

Every contest has it's own specific exchange. The sent exchange could be fixed (CQWW - zone), a
serial number (001 etc.) a combination and sometimes very exotic.
What to set up in the 'Sent exchange' can be found in the manual in the chapter Setup Contests.
Sometimes some creativity is needed to get it all working and more than one solution is often
possible. For some contest a special sent exchange macro has been added (like TIME2 for some
digital contests).

Below an example how to set up a serial number exchange followed by a fixed exchange (in the
same exchange). Example 599 023 40 (serial number 023 and zone 40).

There's more than one way to do this. In your exchange message (usually F2), you can use 599
{EXCH}, which will send what you have entered into the "Sent exchange" box (001 will be converted
into a serial number and the rest will be sent literally), OR you can instead program F2 to include
the individual elements of the exchange, e.g. 599 # # 04 (e.g. if you wanted to send the serial
number twice and the zone only once).

Some things to watch for:

1. The {EXCH} macro does not include the 599, so you need to program that into your exchange
message(s). The "Sent exchange" box is used to generate the Cabrillo file regardless of whether
you use the {EXCH} macro. Therefore you can't put the 599 in the "Sent exchange" box because
that will screw up your Cabrillo file. In stead of hard coding 599 in the exchange message(s) also
the macro {SENTRST} or {SENTRSTCUT} could be used.

2. If you like to send a slightly different message when S&Ping than when you are running, then
you will need to program the Run F2 (2nd message in the list) and the S&P F2 (14th message in
the list) with separate messages. For example, you might program the Run F2 with: {TX} 599 # # 04
{RX} and the S&P F2 with: {TX}{ENTER} ! TU 599 # # # 04 {RX}
Note that in Run mode, the exchange is actually sent as F5 and F2 in succession; F5 normally
contains the other station's call sign (!) and F2 normally contains just the exchange. In S&P mode,
the exchange is sent only as F2, so if you want your S&P exchange to include the other station's
call sign (some people do, some don't) you have to include a ! in the S&P message.

3. If you want to always send three-digit serial numbers, go to >Config >Configure Port, Telnet
Address, Other >Function Keys and check the box "Send leading zeros in serial numbers (e.g.
TT7)"

18. Function Key Conventions

There is a function key "convention" used by N1MM logger and most other logging programs. That
is: F1=CQ, F2=exchange, F3=TU/QSL/QRZ, F4=your call and F5=his call. ESM is built around this
convention.
If you are already using ESM on CW it probably is wise to stay with the same keystroke pattern
when you are on SSB. For example:
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ESM mode: S&P - CW or SSB ESM mode: Run - CW or SSB

1. <enter> sends F4, your call 1. <enter> sends F1, "CQ"

2. <enter> sends F2, your exchange and logs
the QSO

2. type call, <enter> sends F5(his
call)+F2(exchange)

*NOTE* - for SSB, put a single blank space in the F5 message - speak the callsign instead -
because of the blank, N1MM will skip F5 and send the F2 message

3. type his exchange, <enter> sends F3
(QSL/QRZ/TU) and logs QSO

3. type his exchange, <enter> sends F3
(QSL/QRZ/TU) and logs QSO

 
"...This whole business of hitting F1 automatically (and unwantedly) putting you in Run mode
seems extremely awkward..." - When you understand that F1 is almost universally the "CQ" key in
contest logging programs, it becomes very logical. And by definition, when you are "CQing" you are
"Running". In other words, if you don't want to be in the "Run" mode, don't call "CQ" (don't hit F1!)
"...is it possible to have DIFFERENT macros in CW? There I do need "agn" and "hiscall" whereas in
phone I don't..."

Macros are MODE-specific, not CONTEST-specific. So, yes, you must have different macros on CW
and SSB. However, just because you might use 8 or 9 F-keys on CW doesn't mean you have to use
8 or 9 on SSB. Use only what you need for that particular mode (and contest).

73, Ted W4NZ

19. Set Up N1MM to Record and Playback Voice Recordings (recording on the fly)

The usual way is to route your microphone through the sound card to the radio. Most sound cards
support this, as well as a selectable 20 dB pre-amp for Heil and similar mikes.
To set up the program to record and playback voice recordings do the step below:

Plug your microphone into the sound card mic input1.
Plug your headset into the sound card speaker output2.
Select default devices on the Configurer Audio setup Tab3.
Open the windows volume control on the playback controls, set mic audio so you can hear
yourself talking through the sound card.

4.

Change the windows volume control to select the recording controls.
Select the microphone as the recording source.1.

5.

In N1MM logger make sure you are set for SSB, and in Run mode, and have a file name in the
F1 key definition

6.

Do Ctrl+Shift+F1, immediately say something, like a short CQ, then immediately do
Ctrl+Shift+F1 again. The bottom status line of the entry window should have said 'recording
started' then 'recording saved'

7.

Press F1 and the recording should play back in your headset8.
Adjust audio level on the volume control so when you record it has the same volume as the
mic audio when you aren't recording

9.
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OK, now you are on your own. the program records and plays back through the sound card. Now
you have to figure out how to get that audio to and from your radio via your rigblaster, some other
adapter, and whatever plugs on your radio that you choose to use. but the program is set up and
working at this point.

19.1. Playing WAV Files

The program can play wav files in SSB for giving CQ, sending default reports etc. For this to work
wav files have to be made with the text to send. These wav files could be placed anywere on your
disk but easy would be to use the wav\ directory under the program directory. To call a wav file edit
the SSB function keys as in the examples below. It is also possible to send a callsign by sending
it's letters and numbers. NB. The full file path is needed before the wav file.

Use the SSB function keys to send wav files. For example:

Play CQ: C:\Program Files\N1MM logger\wav\cq.wav
Play default exchange: C:\Program Files\N1MM logger\wav\5905.wav
Play the callsign entered in the callsign entry field will be send by the soundcard: !

This example uses the macro: ! (Send his call)
Play the serial number to sent from Entry window by the soundcard: #
Don't play call from station in callsign field: Use a single space (mostly used in F5)
Possible are strings like: ##!C:\Program Files\N1MM logger\wav\{operator}\thanks.wav

With or without leading zeros specified
Only one wav file can be played per string and only at the end of the string

 
Some examples using the macro {OPERATOR}, let each operator have his own wav files. You can
specify wav files like: wav\{OPERATOR}\cq.wav As you change operators in a multi operator
contest, the wav files will change as well. You will have to name them consistently. Note that wav
directory syntax indicates a subdirectory under the Install directory. You can also fully qualify, like:
"C:\wavfiles\cq.wav". {OPERATOR} is a string substitution only implemented for SSB buttons.

Play CQ with operators voice: C:\Program Files\N1MM logger\wav\{OPERATOR}\cq.wav
Play call with operators voice: {OPERATOR}\! (The wave file should be put it in the directory
set in the Files tab for the letters directory in the Configurer)
Play default exchange with operators voice: C:\Program Files\N1MM logger\wav\{OPERATOR}
\5905.wav

 
It is possible to play more .wav files right after the other by separating the wav files with a comma.
For example: C:\Program Files\N1MM logger\wav\{operator}\blank.wav,C:\Program Files\N1MM
logger\wav\{operator}\number.wav#

More examples can be found in the Macros chapter under {OPERATOR} macro examples and in
the Sweepstakes contest setup.

For those with problems with wav files playing from the Function keys... Make sure that under the
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tab 'Contest' in the >File >Open Log in Database >Mode Category has been set to SSB (or Mixed)
and not set to CW. Check out the Audio tab in the Configurer.
When in split please check out the @ macro (which will voice the receive frequency).

19.2. Recording WAV Files

The first thing to try is to plug the microphone (mic) directly into the sound card. Then open the
sound playback control panel, make sure the mic channel is displayed and see if you can get the
mic to come out the speakers. Once you do that then plug the mic into the rigblaster and the
rigblaster into the mic input on the sound card and make sure it still comes out. Then go from the
sound card to the rigblaster and make sure you can hear it in the speakers connected to the
rigblaster, then go from the rigblaster to the mic on the radio. That all verifies the audio paths. Note
that none of this uses the logger yet.

Now change the volume control to show the recording controls. Make sure the mic input is
displayed and select it as the recording source. Open the windows 'sound recorder'. Yes, I know it
is a dumb program, but its main advantage is that it is simple. Try to record using the sound
recorder and then play it back, the trace should show if audio is getting into the recording.

Now you are ready to try the logger. Watch the status line on the bottom of the entry window when
pressing Ctrl+Shift+Fx, make sure it says that recording is started and then that the file is saved.
Pressing the same keys again (Ctrl+Shift+Fx) to stop recording. Note the confirmation start/saved
messages on the status line at the bottom of the Call Entry window.

If the above steps verified the audio paths then the only thing left is to make sure the PTT keys the
radio when you send the file. Note, that you can key manually or turn on the VOX just to make sure
that the audio is getting to the rig even if the PTT doesn't work.

N1MM logger only supports standard PCM format files. Some editors use ADPCM instead and you
have to convert them to standard PCM to have them played.
More info on recording in the chapter Before the contest.

 

19.3. Soundcard Control in Configurer

Record with N1MM logger because it will put the file in the same place it expects to play them
from, and it records only with the formats that it can also play back.

If the soundcard is a Realtek HD, you won't be able to do on-the-fly recording with N1MM
Logger. You'll need to use an external application, such as Windows Sound Recorder or
Audacity.

Use N1MM Logger to Record Your WAV Files

Realtek HD Soundcards
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The soundcard has to be set up when playing wav files. This is done in >Config >Configure Port,
Telnet Address, Other >Audio tab. Check out the settings for it in the Configurer chapter.

When play SSB wav files, the play volume can be adjusted by the Windows play control sliders.

20. Quick Edit

Do you ever log a contact with a mistake in the callsign? Want to bring it back, so you can change
it? You can do it with "Edit last contact (Ctrl+Y)", but that dialog is complicated and not the right tool
for the heat of a contest.

There is an alternative called "Quick Edit" (Ctrl+Q). Quick edit will return the last entered qso to the
entry window to allow you to change it. Pressing enter will log the changes, ESC will abandon
them. The Entry window text boxes change to blue to let you know you are in quick edit.

Was the mistake three QSOs ago? Then just press Ctrl+Q three times to get to it. The same rules
about saving/abandoning apply here as well.

 

21. Meaning of Colors

The meaning of the colors is where possible consistent across all windows. The table below will
give the meaning per window.

 

22. Multipliers and QSOs

The program shows at many place if a callsign is a multiplier, a qso or a dupe. Please study the
table with the meaning of colors above.

The most common problem occurs when no sound is heard when playing wav files. Check for a
non existing wav file and the correct path in the program. Always check the wav file in a media
player so see if it can be heard from the speakers!

There is no check to ensure that the Quick Edit entered contents are valid like is done when a
QSO is entered normally. So check thoroughly what you type.

Common Soundcard Problems

Quick Edit 'Feature

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

96 of 680 2/2/2011 4:54 PM



The windows
Entry Window

Callsign in callsign field : the color of the entered call will tell Qso, Dupe or
Multiplier(s)
Callsign on the call-frame: the color of the entered call will tell Qso, Dupe or
Multiplier(s)

Available Mults and Qs window - the button colors will tell Qso, Dupe or Multiplier(s)
Check window - the callsign colors will tell Qso or Dupe status

Mul: - multiplier on this band
Q: - qso on this band

Example: Mul: 15 20 Q: 160 80 40 10 - multiplier on 15 and 20 meter and a
qso on the other bands

Bandmap - the callsign colors will tell Qso, Dupe or Multiplier(s)
The colors

Blue: QSO
Red: Single Multiplier Example: CQWW - qso is either zone or country multiplier (one
multiplier)
Green: Double or better Multiplier Example: CQWW - qso is a zone and a country
multiplier (two multipliers)
Gray: Dupe

 

23. Connecting to a Telnet Cluster

Select the tab: Telnet in the packet window.
Select a telnet cluster from the list in the upper right corner

This list can be changed in Configurer at >Config >Configure Ports, Telnet Address,
Other >Hardware tab, Select < Edit > next to Telnet Cluster

Click the button marked with your callsign, on the far lower right, or type your callsign in the
left field at the top of the telnet tab. Do not click the CONN button, that's solely for RF packet

 

24. How to Save the Log

Well, there isn't a 'save' function because it is not necessary. Every change you make to the
database is stored 'on the fly', hence the absence of a 'save log' function. The ham.mdb file (default
name) on your hard disk is the database where every contest is stored, along with lots of other
information used by the program. Also there is no need to make a new file for each contest. Each
new contest is stored in one and the same file. Just go to >File >New Log in Database and pick one
out of the list, and you're all set to go. After a couple of years, there are dozens of contests in the
database, for a total of a couple of thousand QSOs.

Now, you can make new databases, as many as you want. You can have separate databases for
separate calls, separate contests etc. Most users however, only need 1 database. You can copy it to
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backup etc. Just be sure what you're doing when messing with files...

25. Function Key Macros

You can't skip function key numbers. It is the position of the macro, not the number you identify it
with.

The first 12 macros are RUN macros. If you then only fill in 7 S&P macros then 8 thru 12 will be the
same macros as the ones you filled in for RUN. So in your example if you set up your {WIPE} macro
for F11 in RUN and your S&P F11 was blank then the {WIPE} F11 key would work in both RUN and
S&P.

If you want to fill in a blank macro enter the function key comma and a space. You have to put the
space as you cannot create a blank macro.

If you want to go from S&P to RUN is a single keystroke then set the first S&P macro to CQ (without
F1 in the description) and put the
command QRL? in the macro (Pete's trick). CQ,QRL? So hitting F1 would send QRL? and put you
in RUN and start your auto CQ if turned on.

26. Save and Restore Window Positions

Save and Restore window positions is under >Tools >Save Window Positions' and >Tools >Restore
Window Positions

For example:
New operator PA1M: Hit Ctrl+O and enter: PA1M and after this he presses 'Save Window Positions'
in the Tools menu. The window positions for PA1M are now saved.
Next operator comes in and does the same for his call.
PA1M is again the operator and wants his window positions back: PA1M does Ctrl+O and enters:
PA1M and after that selects 'Restore Window Positions'. The window positions will immediately
change to the saved positions. PA1M has his window positions back!

 

27. Editing Lookup Tables

Lookup tables are used widely throughout the program. Example tables are the function keys,
telnet stations, exchange abbreviations etc. These tables can be updated by the user and mostly
lines can be added at the bottom of the list or deleted where needed.

Instead of inserting your callsign, enter the mode - RTTY, CW, or SSB. This will save / restore
window positions based on your preferences for each mode. This obviously won't work in a
Multi-op environment but very usable in the single operator multi mode shack.

Substituting Mode for Callsign
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To Delete a row, click on the row "handle" - the gray arrowhead - the 'pensil' will move to it and
the row will be selected, press Delete
To Insert/Add a row, click on the icon with the 'star', a new row will be added. A row can only
be added if all columns are filled

The column values will automatically be assigned a space so directly adding a new row
is possible

To edit an entry select the field to update and enter the new information.

 

28. Backup and Restore

Information used by the program is partly stored in the database, partly in ini files and in some
additional subdirectories. Examples are the WAV files (for the function keys) but also in the Letters
directory. So when making a backup not only backup the MDB files but also some text files / or
sub-directories. The best solution is to backup and restore the whole N1MM logger subdirectory.
Backup/restore proposal 2 is a partial backup/restore.

28.1. Method 1: Full backup/restore on same computer - backup and restore the whole
N1MM logger subdirectory

Backup the whole N1MM logger subdirectory
Restore the data is more or less the other way around. Restore the whole N1MM logger
subdirectory

 

28.2. Method 2: Partial backup/restore on same computer - make a partial backup and
restore.

Storing all these settings (exported text files, wav files etc) next to all databases (mdb files) on a
diskette, CD/RW or USB-pen in case of a computer crash would not be a bad idea 

Backup all database (*.mdb) files
In the database files are all contests with QSOs but also the function keys content,
Station information etc. Compress the database to get them small
N1MM Logger.ini

Windows Settings, radio settings, port settings, RTTY settings etc. i.e. everything
in Configurer but also last contest used are are stored in the N1MM Logger.ini file

Wav files
Which can be used by the program (SSB mode). They are in the WAV directory (for
the function keys) and and in the Letters directory (sending callsigns etc)
Recorded QSOs are stored in subdirectories under the N1MM logger program
directory (and can become very big)
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More?

* Restoring on the same computer - Restoring the data is more or less the other way around.
o Restore All database (*.mdb) files
+ Restore the database file(s) back in the program directory (which is the default place but not
necessary).
o N1MM Logger.ini
+ Copy the saved file in the Program directory.
o Wav files
+ Create the directories WAV and Letters directory and other directories needed.
+ Copy the wav files in them.
o More?

 

28.3. Installing on a Different Computer

 
With a new / different computer you first have to perform a Full Install to get all dll , ocx files etc.
copied and registered. After that you may overwrite/add all *.mdb files, settings etc. in the N1MM
logger program directory by copying and importing settings. See the restore procedure above.

You have to watch out if the settings like serial ports, directory structure, screen resolution etc. are
different on the second computer. This could/will give trouble.

Copy, zip, cd/rw etc.

Compressing the database files for backup/restore with a program like WinZip really helps, these
databases (but also Word files, Excel files etc.) compress a lot, mostly down to 10-25 percent of it's
original size. This means that a 4 MB database fits easily on a diskette.

The database can be also compressed with File/Copy and compact database. This is not a zip
compression. It recovers space from deleted rows. Most database engines do not recover deleted
rows until a reorganization is done. They just mark them deleted. This is not the same compression
as mentioned above when using zip compression. When doing a compact database the database
can still be used afterwards by the program. Using zip compression is only for backup/restore
purposes.

It is wise to make a regular backup of the whole N1MM logger subdirectory including all
subdirectories to a CD recordable. Copying it to another hard disk (in the same computer but better
on another computer when you have a network) is also a good idea.

29. Basic Functions for RTTY

Backup / Restore will not move the program to a new computer. You must always start with a
Full Install on a new or different computer

Backup and Restore is not a Copy Function

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

100 of 680 2/2/2011 4:54 PM



Here are 4 RTTY Operating tips from Rick, N2AMG

Use your mouse to grab everything just click on the call sign and it will get passed on to the
entry window and click on the exchange it will get sent to the exchange field. Or use the Insert
key to grab a call from the grab window and send your call that saves time also

1.

 

When you click on a callsign do you still need to press the space bar to advance things? You
don't! Go to >Window >Digital Interface, then in the digital screen select >Setup >Settings
>Send space after callsign click. Turn that setting on and you will be all set. Also select
>Setup >'Rt click= Return NOT Menu'

1.

 

Try turning on >Setup >Rt click= Return NOT Menu. What this does is makes the right click
of the mouse button while the mouse pointer is in the RX window act like the ENTER key and
will step thru the ESM keys without hitting the keyboard. Your hand never leaves the mouse
for the whole Q

1.

 

Hover mode: Let's you grab the callsign just by pointing your mouse on the callsign, no
click... this way. It's faster then to click right to reply. Hover mode can be found in the Digital
window >Setup >'Turn Hover Mode On/Off'

1.

 

Advanced Functions

In this Section...

Advanced Functions
1. Mobile/Rover Support

1.1. How Mobile/Rover Works
2. Call History Lookup

2.1. The Call History Text File
2.1.1. Menu options

3. Spot Filtering
4. Transmit on same band with two radios
5. Big Gun versus Little Pistol switch

5.1. So you are a big station
5.2. So you are a little pistol

6. Staying in Run Mode (great for Dxpeditions) or in S&P mode
7. Auto Send
8. Enter Sends Messages (ESM) Mode

8.1. Basic ESM Functionality
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8.2. How to Prevent the Cursor from Moving to the Next Exchange Field
8.3. How to Skip Sending the Callsign or Exchange Field (SSB)?

9. QSYing Wipes the Call & Spots QSO in Bandmap
10. Single Operator Call Stacking

10.1. Additional SOCALLSTACK Information
10.2. Digital Call Stacking
10.3. How to Tell Visually Which Call Will be Put in Next

11. Call Stacking (same or different bands) - Multi-User Mode
12. Serial Number Server
13. Contest Reporting Application
14. Starting a Contest with a Number Other Than 001
15. Single Operator 2 Radios (SO2R)
16. Footswitch Support

In the 'Basic Functions' section the more standard routines like changing frequency, band and
mode can be found. In this section the more advanced features are addressed. Not needed for
everybody but nice when you think you need them

1. Mobile/Rover Support

N1MM logger supports Rover operation in at least the ARRL VHF contests and all QSO parties. For
this to work the "Rover" category has be selected and the "RoverQTH" set. This gives a mobile/rover
in a QSO party/VHF contest a quick, easy way of changing counties and re-programming F-key
messages in one step. You will also have a complete, composite log. No cutting and pasting
Cabrillo files anymore.

1.1. How Mobile/Rover Works

First, set File > Open Log in Database > Contest tab > Mode Category = "Rover"

Your initial or subsequent RoverQTH can be set

in the Station Data window. This box will automatically update when you use any of the other
methods of setting RoverQTH
by right clicking on the county or grid in the Multiplier window
by typing CTRL+H
or by typing ROVERQTH in the Entry Window callsign box and hitting Enter. This pops up a
window for you to input the county designator, typically 3 or 4 characters, and then hit Enter
again. This sets or resets the current RoverQTH, which is displayed in the top border of the
Entry window, beside the frequency display.

 
The {ROVERQTH} macro, when placed in your F-key messages will always send the current county
designator or RoverQTH. If, for example, your F2 key is defined as "5NN{ROVERQTH}", then the
"RoverQTH" column in the log window will reflect your current QTH for each QSO..
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RoverQTH can be 10 characters long but most Cabrillo output is five or six characters long.

When a new ROVERQTH is set in the Entry window, the program checks with the list of accepted
county designators for the current QSO party or contest. If for some reason an unlisted county
designator is required, it can be entered in Config > Change Your Station Data

 

2. Call History Lookup

 

Please note - this section is work in progress, and WILL be changing repeatedly in the
coming weeks

 
As far as we can tell, the idea of storing information about a station from past contests, for recall
during the current running, began with N6TR's TRLog, which used an extension of the Super check
Partial master.dta file to capture and display a variety of information, such as name, Sweepstakes
check, and ARRL section or state.

Since its early days, N1MM Logger has used Call History text files to store contest-specific
information. To use Call History Lookup, you must load the text file into the current database and
enable the Lookup (on the pull-down Config menu).

 
When a callsign is typed into the Entry window and the Space bar is pressed (or Enter, in the ESM
case), the database table is searched and if the callsign is found, the associated call history is
displayed. If the information is relevant to the current contest, it is pre-filled in the appropriate
exchange field in the Entry window. Otherwise, it is displayed as text in the "beam heading" line of
the Entry window. Here are two examples:

Beginning with Version 10.8.3, the Call History Lookup function is much improved. This is a very
good reason to update, if you haven't done so already. The following user instructions assume
that you are running 10.8.3 or later.

There can be only one call history table actually present in a given database at a time, and it
remains active regardless of the contest unless replaced with another or unless you turn off the
lookup function.

Big Improvements in Version 10.8.3

Only One Call History Table at a Time
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In VHF contests, the grid square from the Call History table is used to calculate the beam heading
reported in the Bandmap.

2.1. The Call History Text File

 
The first few lines of the text file (shown below in bold type) are comments, denoted by the #
character at the start of each line. None of these lines are required, but they are a helpful reminder
when you are working with a text file. They are automatically added when exporting a Call History
file.

#Comment lines do not have to be removed for import.

#Field names and size: Call(15), Name(20), Loc1(6), Loc2(6), Sect(8), State(8), CK(#),
Birthdate(date), Exch1(12), Misc(15), LastUpdateNote(Optional,40)

#Current contest: YOHFDX

The next line gives the order in which fields in the text file are read into the database. Surrounding
the word "Order" with two "!!" characters tells the program to treat it as an instruction, not as data
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!!Order!!, Call, Name, Loc1, Loc2, Sect, State, CK, BirthDate, Exch1, Misc, LastUpdateNote

Finally, we get down to the data.

N2YO,,,,,,,1900-01-01,364,,Log update no change

As you can see, each comma denotes a field. Successive commas mean empty fields. In this case,
we have the Call, a whole flock of empty fields, the default Birthdate (provided by the program, for
technical reasons), and then Exch1, which is the number N2YO gave me in the contest.

As you can imagine, making sure you have the right number of commas between actual data in the
text file can be a problem. Fortunately, the !!Order!! command offers a simple solution. For
example, you create a text file that looks like this:

!!Order!!, Call, Name, CK, Sect

N4ZR, Pete ,54 ,WV

N3OC, Brian, 67, MDC

When you load it into the current database, the data will be put in their proper places in the Call
History table, and when you operate in Sweepstakes, for example, with Call History Lookup
enabled, the program will pre-fill the check and section in the Exchange field, and will display the
name and all the other data in the Bearing line of the Exchange Window. This redundancy is
deliberate, because if you set out to edit the Exchange and then realize that the pre-filled data were
correct, they are there for ready reference.

What this change has done is to make it much easier to generate Call History text files for loading
into N1MM. For example, you could generate a file that contains calls, names, checks and sections
for everyone you worked last year in Sweepstakes, and by writing the correct !!Order!! line, like this:

!!Order!!,Call,Name,CK, Sect

you can make sure the information loads into the correct places in the database. The only thing you
have to be careful about is to use the database field names exactly as shown above. For example,
you must use Sect, not sect or sec or Sec, and CK, not Check.

2.1.1. Menu options

 

>Config >Call History Lookup
Check to enable Call History Lookup.

 

>File >Import >Import Call History
Select the file to be imported. All information in the Call History table in the database is
erased, and the imported information substituted.
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>Tools >Update Call History with Current Log
Update the Call History table with the QSOs from the current log. Callsigns and contact
data will be added, when new, or updated when already in the Call History table. Note
that nothing is erased from the table other than data associated with a callsign in the
log, and then only when different.

 
For the 2 grid fields the behavior is a bit different. When both grid fields are filled and a new grid
has been logged, the second grid (oldest) will be removed, and replaced by the contents of the first
field. The new grid will be added to the first position. The same change in position will happen when
only the first grid is filled and a new grid has to be added from the log. A 4 digit grid will be
overwritten by a 6 digit grid when the first 4 characters are the same. move to VHF section

>File >Export >Export Call History
Exports the information in the Call History table. It is very important, particularly if you
have changed the Call History table, to re-export the data as a Call History text file.
Otherwise, any changes will be lost. You are given the opportunity to rename the text file
so that, for example, a 2008 SS file can be renamed 2009 SS, to indicate that it has
been updated.

 
You can import any Call History file that you formerly used, without the need for the !!Order!!
directive. When you export a Call History text file, the program fills in the commas that are
necessary to fit the default order, as well as -1 for each empty CK and 1900-01-01 for each empty
Birthdate. This is necessary to ensure compatibility with your old Call History files.

3. Spot Filtering

 
There are three levels of spot filtering available. The first of these is at the DX cluster node, using
whatever filtering capabilities are built into the node. Because N1MM Logger stops processing telnet
messages when CW is being sent, users who are connected to a very high volume node, such as
the Reverse Beacon Network's Telnet node, may find it advantageous to block some of the less
useful spots (for US users, you might not want spots from VK, for example).

The second level of spot filtering is accessible from the right-click menu of the Packet/Telnet
window, and decides which spots received from the cluster node should be forwarded to the
Bandmap and the Available window. If too many spots are forwarded, depending on how fast your
computer is, you may encounter brief delays in execution of commands (such as sending of CW
messages) while the program catches up,. See the section on the Packet and Telnet window for
specifics.

The third level of filtering is set in the right-click menu of the Available Mults and Qs window, and it
only governs which spots are shown in that window's lower pane. For example, if you decide only to
list CW spots, the bandmaps will continue to display all spots, and the top pane of the Available
window will continue to display overall spot numbers for each band, but the lower pane's list of
spots will contain only CW spots. You can quickly switch back and forth between showing all spots,
just those on the current band, only CW or SSB or digital spots, or any other band/mode
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combination.

 

4. Transmit on same band with two radios

In some contests (like IARU contest) it is allowed to transmit on CW/SSB at the same time on the
same band. To set this up make sure that Operator Category is set to Multi-Multi and Mode
Category to Mixed. Both can call CQ at the same time without blocking each other. Also Config >
Multi User Tools > Force Other Station to Stop Transmitting when I Transmit should not be checked!

Interlock method works fine with packet delays up to 400 ms. If two operators push F1 at the same
time both stations will begin transmitting but in less then 100 ms they both will check if any other
station transmits on the same band/mode and if this is the case station with higher number will stop
transmitting and display a message to the operator "Another station is already sending". Obviously
the higher the packet delay is, the longer both stations will be transmitting at the same time but in
reality it is never longer then 100-200 ms (PTT delay should be subtracted). And this only happens
when there are two or more stations on the same band/mode (Run and Mult stations) and two
operators managed to hit F1 (or any other Fx button) at the same time.

5. Big Gun versus Little Pistol switch

One of the settings in Configurer >Function Keys tab is 'ESM only sends your call once in S&P,
then ready to copy received exchange'. When selected and in Enter Sends Message mode, the
cursor moves to the Exchange field when there is something in the Callsign field and Enter is
pressed and does not keep the cursor in the callsign field. If you don't usually get a station on the
first call then deselect this option.

5.1. So you are a big station

* Stations normally come back to you on the first call
* In >Configurer >Function Keys tab, check 'ESM only sends your call once in S&P, then ready to
copy received exchange'.

5.2. So you are a little pistol

* You have to call mostly several times to get through to being answered
* In >Configurer >Function Keys tab, uncheck 'ESM only sends your call once in S&P, then ready
to copy received exchange'.

Big Gun Tip
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6. Staying in Run Mode (great for Dxpeditions) or in S&P mode

During DXpeditions it could be very useful to stay in Run mode all the time and not jump
inadvertently to S&P mode. Or stay in S&P mode if you choose. This behavior can be toggled using
the Alt+F11 key. The following message will be given in the statusbar when DXpedition mode i.e.
S&P mode is disabled "Run/S&P auto-toggle disabled" = Dxpedition mode. Back to normal show
the message 'S&P and Run Mode enabled'.

7. Auto Send

Autosend ( Ctrl+Shift+M ) will start sending the callsign before you have finished copying a full
callsign. i.e. starting after a certain number of characters has been typed AFTER the last number in
the callsign. The minimum threshold is 1. Zero will turn off the feature. Only when in RUN mode.

The rules are:

Find the first letter in the call1.
Find the last number after the first letter2.
Find the Nth letter after step 23.

 
For example: Threshold set to 2

W4WYP would start sending at Y
S57AD would start sending at D
KH6/WA4WYP would start sending at Y (using the "/" rule as well)
WA4WYP/4 would start at Y (/4 will not be looked at)

WYP, WWYP and WAWYP do not meet the criteria for autosend to begin.
Prefixes like KH6/ are ignored and do not themselves trigger the autosend threshold.

8. Enter Sends Messages (ESM) Mode

Setting the option "Enter Sends Messages" in the Config dialog will enable a mode that allows you
to make entire QSOs without using the function keys. ESM works for both running and S&P mode,
but the messages are different for each mode. To set ESM, go to Config, and check Enter Sends
Messages (ESM mode), or use the shortcut Ctrl+M.

One little trick to use with the Big Gun switch on is to program my call in F8 instead of "again".
This way, when you don't get the guy on the first call, hit Enter again to repeatedly send my call
until he answers (and the cursor is always in the right place when he does answer). 73 de Ted
W4NZ
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8.1. Basic ESM Functionality

When running, pressing Enter with the callsign textbox empty will send CQ. If someone answers
you, type in his callsign. Hit Enter again, and the program will send the exchange. After entering
the other stations info, hitting Enter again will send the end of QSO message (TU/QRZ) and
automatically log the contact. See the chart below for a detailed list of what is sent at various states
of the QSO.

Here's a typical scenario where N1MM is calling CQ in the CQ WW CW Contest:

Hit Enter - sends CQ N1MM
PA1M calls in - type "PA1M"
Hit Enter - sends "PA1M 5NN T5", note that PA1M's zone is filled in for you.
PA1M sends "599 14" (zone matches what program filled in)
Hit Enter - logs QSO & sends "TU de N1MM"

That's 3 keystrokes + typing PA1M's callsign. Slick!

On the other end, the S&P station (PA1M) can also use ESM. During the same QSO:

You hear N1MM calling CQ - type "N1MM"
Hit Enter - sends "PA1M", note that N1MM's zone is filled in for you
N1MM sends "PA1M 5NN T5" (zone matches what program filled in)
Hit Enter - sends "599 14"
N1MM sends "TU de N1MM", completing the QSO and logging it

 
Once again, that's 3 keystrokes + typing N1MM's callsign. In some other contests, like CQ WPX,
you will also have to type in the exchange, but in any contest ESM cuts the effort required to
complete a QSO to a minimum.

Keeping track of which ESM "state" you are in can be confusing when things get hectic. To help you
understand which state you are in, the function keys on the Entry Window will change color (aqua
blue) to alert you which message will be sent next. The goal here is that it should always be
obvious what will happen next.

There will be times when you get out of sync, or where you need to send something different than
what the next Enter will send. Don't panic. Just press the correct function key(s) (F2, F4, etc as
needed). If you finished out the QSO with the F-keys, just hit Alt+Enter, which will log the QSO
without sending anything, and you are ready for the next QSO (and ESM is reset to the beginning
state).
The cursor is kept in the callsign if you have entered a callsign that does:

not have a prefix and at least one characters suffix
prefix is a letter followed by a number
prefix is a letter followed by a number, letter, number combo.

When ESM is on, the Space bar is used only when you need intelligent tabbing mostly between the
callsign and the exchange field for instance to correct a call.
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When the copy is solid, and no copying mistakes are made, ESM will just send the basic messages
in the previous example. Depending on what information is in the Call window and Exchange
window and what state the QSO is in, different messages can be sent. The chart below outlines the
possible combinations of information in the Entry window, and what will be sent in each situation.

Running mode S&P mode

Callsign field Exchange field Enter sends Enter sends

Empty Empty CQ (F1) My Call (F4)

New Call (1st time) Empty or invalid His Call + Exch (F5 +
F2)

My Call (F4)

New Call (repeat) Empty or invalid Again? (F8) My Call (F4)

New Call Valid (before sending
exchange)

His Call + Exch (F5 +
F2)

Exchange (F2) +
Log It

New Call Valid (after sending
exchange)

End QSO + Log (F3 +
Log It)

Send Nothing +
Log It

Duplicate Call Empty or invalid QSO B4 (F6) nothing

Duplicate Call Valid (before sending
exchange)

QSO B4 (F6) Exchange (F2) +
Log It

Duplicate Call Valid (after sending
exchange)

End QSO + Log (F3 +
Log It)

nothing

Dupe (1st time), Work Dupes
unchecked

Empty or invalid His Call + Exch (F5 +
F2)

QSO B4 (F6)

Dupe (repeat), Work Dupes
unchecked

Empty or invalid Again? (F8) QSO B4 (F6)

Dupe, Work Dupes checked Valid (before sending
exchange)

His Call + Exch (F5 +
F2)

Exchange (F2) +
Log It

Dupe, Work Dupes checked Valid (after sending
exchange)

End QSO + Log (F3 +
Log It)

Send Nothing

 

 
When a dupe callsign is in the callframe, the call is put in the call textbox and highlighted.

If a CQ is being sent, typing a character in the callsign field while in ESM will stop sending a
CQ message being transmitted (this can be set in >Configurer >Function Keys >ESM only
sends your call once in S&P, then ready to copy received exchange

When in ESM and in S&P, If the cursor is not in the call textbox and the Exchange is not
finished, the program will send " Again? (F8)"}

Interrupting a CQ

Again? (F8)
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The actual messages sent by each of those function keys (e.g. CQ Key, Exchange Key, My Call
Key, etc.) are set in the configuration dialog ('Config | Change Packet/CW/SSB Digital Message
Buttons'). There are 24 messages that can be set: the first 12 messages are for Running mode, and
the second 12 for S&P mode. Each mode (CW, SSB, Digital) can have a separate set of messages,
which are saved by the program. If the program is sending the wrong message, check here first! In
the middle of the contest, you can also change the messages for the current mode by right-clicking
on (one of) the message buttons in the Entry window.

8.2. How to Prevent the Cursor from Moving to the Next Exchange Field

In ESM mode when running and trying to send a partial call entered in the callsign field, the cursor
jumps to the report field before you can finish typing the call...

Solution 1 - When you press Enter in ESM mode while running, the cursor will be placed
highlighting the ?. If you type a letter, say "J", the ? will be changed, and you will have G4UJS in
the callsign. Whenever you press the space bar, and the cursor is placed in the callsign, the ? will
be highlighted, ready to be replaced without typing Del or Backspace.

8.3. How to Skip Sending the Callsign or Exchange Field (SSB)?

To avoid PTT when setting up ESM on SSB without sending a callsign or exchange put in SSB a
single space or the path to Empty.wav as the wav file for the callsign and/or the exchange buttons.
The program will not assert PTT and immediately simulate the space bar being pressed.

9. QSYing Wipes the Call & Spots QSO in Bandmap

If you set >Config >QSYing Wipes the Call & Spots QSO in Bandmap, it will spot stations in the
bandmap which you haven't worked yet or don't want to work all. These stations are not spotted on
packet/telnet but only locally. Any call greater or equal to 3 characters that you don't work but have
entered in the callsign field will be automatically spotted in the bandmaps when you turn the VFO
to another frequency. This way you can place stations on the bandmap which you can't work direct
(big pileup?) so want to store them somewhere. Also useful when you want to add stations to the
bandmap who you don't want to (or may not) work but like to have the callsign in the bandmap so
when searching for stations you know who is on that frequency so you can turn on.

When you are Running with ESM enabled and while entering you place a ? in the callsign field
the cursor will not move to the exchange field but stay in the callsign field highlighting the ?

The next button to be sent when pressing Enter shows in turquoise. If you don't like what ESM
will send, you may choose another.

Entering ? as a Callsign

Watch that Turquoise Button
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All bandmap features work on these 'spotted' stations so they are easy accessible if needed. Self
spotted stations are easy recognized because they are shown in bold. This feature is also very
useful in a M/S or M/M environment. Often there is a MULT station that is tuning the bands, but may
not want to post the spot until the QSO has been worked by their own RUNNING station. (I do not
wish to get into an ethics discussion, but this is done quite often) This feature allows the MULT
station to build a band map full of calls for the RUNNING station to work when it gets a chance.

That means you can do the following:

Tune to 21200.
Enter VU2PTT.
Tune off.
VU2PTT is "spotted" at 21200, and the Entry Window is cleared.
Tune to 21208.
Enter G4UJS.
Tune off.
G4UJS is "spotted" at 21208, and the Entry Window is cleared.
Repeat as long as desired.
Go back and work all of them using Ctrl+Up and Ctrl+Dn to navigate.

 

10. Single Operator Call Stacking

Macros and keystrokes used for call stacking are {SOCALLSTACK}, {STACKANOTHER},
CTRL+ALT+G, {LOGTHENPOP}, and ALT+D. The first three are used to place calls onto the stack
and the last two are used to take calls off the stack. The macros only operate in RUN mode and
stacked callsigns appear in the Bandmap on your RUN frequency. SOCallstacking is functional in
CW, phone, and digital modes and is compatible with manual key operation or ESM. It can also be
used in SO1V, SO2V and SO2R modes and in multi-station environments.

{SOCALLSTACK} or {STACKANOTHER} or CTRL+ALT+G
The operator can stack a full callsign or a partial callsign that may include a "?" and it will be
highlighted when that callsign is removed from the stack. The operation of the {SOCALLSTACK}
and {STACKANOTHER} macros differ slightly.

{STACKANOTHER} or the keystroke short cut, CTRL+ALT+G, simply pushes callsigns onto the
stack and clears the Entry Window callsign box.

{SOCALLSTACK} functions as a single level stack macro. The first execution of {SOCALLSTACK},
stacks the first callsign and clears the Entry Window callsign line. When a second callsign is
entered and {SOCALLSTACK} is executed again, the two callsigns are exchanged. If the callsign
window is empty when {SOCALLSTACK} is executed, the callsign is removed from the stack and
placed into the callsign Entry Window.

There is also a >Config >Spot all S&P QSOs option. It has a number of rules, but will spot
everything you WORK on packet, if it has not already been spotted on the same frequency.

Spot All S&P QSOs
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{LOGTHENPOP}, ALT+D
The stacked callsigns can be removed from the stack with several methods. Logging the current
call, unstacking the next callsign with {LOGTHENPOP} or manually removing the stacked callsign
with the keystroke ALT+D. The ALT+D keystroke is useful if a callsign appears on the stack via a
telnet spot. The next callsign on the stack is displayed on the callframe when the CQ-Literal is not
present. Pressing Space will move a stacked call from the Callframe to the callsign box and remove
it from Bandmap.

ESM Automation
The Configurer, Function Key tab, Next Call Key is used to select the function key that contains the
{LOGTHENPOP} macro along with the message string for ESM automation. If a Next Call Key has
been specified, then when Enter is pressed to finish a QSO and there is another call sign on the
callsign stack, the Next Call Key will be sent instead of the TU(F3) Key. The last option in the drop
down menu for the Next Call Key allows the ESM SOCallstacking automation to be disabled.

SOCALLSTACK ESM Example
Program F9 key to: {STACKANOTHER} or {SOCALLSTACK}
Program F10 key to: {LOGTHENPOP}TU NW {F5} {F2}
The appropriate SSB wave file can be inserted into the F10 message in place of the " TU NW"
letters above.

For example: {LOGTHENPOP}C:\Program Files\N1MM logger\wav\{operator}\TnxNow.wav {F5} {F2}

Set >Config >Function Key tab >"Next Call Key" to F10

Select RUN mode and turn ESM on. For this example two stations are calling, N2IC and K3CT
Type K3CT, press F9, type N2IC and press Enter
Copy N2IC's report and press Enter. This will log N2IC, send the TU, unstack K3CT, and send the
exchange

SOCALLSTACK Non-ESM Example
Program the function keys as listed above.
Select RUN mode.
Type K3CT, press F9, type N2IC and press the exchange key programmed in Configurer, usually
";". This key is programmed to F5 & F2.

Copy N2IC's report and press F10. This will log N2IC, unstack K3CT, and send the exchange

If multiple callsigns are stacked, ESM will continue to unstack the callsigns. The same is true in
non-ESM mode as F10 is pressed. Should a logging error occur such as a bad call, the sequence
will be interrupted until the error is corrected. When no calls remain on the stack, the TU message
is sent. If there are multiple callsigns on the stack, the order that they are removed or exchanged
with {SOCALLSTACK} depends on the internal sorting order and not the order they were stacked.

10.1. Additional SOCALLSTACK Information

It is important that the contest callsign is entered in the Config, Station Information window. That
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way, the station callsign will not appear in the Bandmap via a telnet spot and the SOCALLSTACK
code will not place the station callsign or the Busy literal (ALT+M) into the callsign box.

If a callsign appears on the callsign stack via a telnet spot that you want to remove, use the ALT+D
keystroke to remove it without popping it off the stack.

SOCallstacking does overlap slightly with multi-operator call stacking. Multi-operator call stacking is
the program feature that allows a second operator to listen to the run radio and send calls to the
run operatorÃƒÂ¢Ã¢â€šÂ¬Ã¢â€žÂ¢s Entry Window.

10.2. Digital Call Stacking

To turn this off or on there is a menu selection in the Setup dropdown menu in the Digital Interface.

With it turned off everything operates the way it is before Call Stacking was added.
Only works in RUN Mode and only with a valid callsign.
Single Click on Call in Digital RX window or Alt+G when grabbing a call
If there is no callsign in the call box of Entry Window it will function just like it normally does
by placing the callsign in the call box.
If there is a call already in the call box then clicking on another call orhitting ALT+G to use the
grab window will move the call that is currentlythere up to the bandmap and call frame of the
entry window and place thecurrently clicked or grabbed call into the call box.

 
The usage here is if a two stations call you can then stack one call and work the other. Then
instead of hitting enter if in ESM to send F3 or LOG. You would then hit the F-Key that contains :
{TX}{ENTER}! {LOGTHENPOP} TU NW {F5}{F2}{RX}

Alt+Single Click on Call in Digital RX window or Ctrl+Alt+G when grabbing a call. This will take the
clicked on callsign and place it directly to the stack in the bandmap. Any number of calls can be
placed here for working one after another.

The usage is 3 or 4 stations call you at the same time do a single click or Alt+G on the first call to
place it in Entry window. Then do and ALT+Click or Ctrl+Alt+G (to pull from grab window) to place
the others on the stack. Then use the F-key that contains: {TX}{ENTER}! {LOGTHENPOP} TU NW
{F5}{F2}{RX} to work them all in a row until the last call is off the stack then you would use F3 or hit
enter in ESM to log the final one.

{LOGTHENPOP} will not function if CQ-Frequency is in the Call Frame.

Double Click on Call in Digital RX window: The function of the Double click does not change and
will over ride whatever callsign is in the Entrywindow Call Box with the clicked on callsign.

Macro Substitution: {LOGTHENGRAB} This will log the current contact and Grab the top callsign
that is in the grab window of the DI. Will only work in Run Mode Digital use of macro Substitution:
{STACKANOTHER} This acts just as Ctrl+Alt+G for the grab window but allows it to be called by a
macro. If you hit the F-key that contains {TX}{ENTER}! {LOGTHENPOP} TU NW {F5}{F2}{RX} while
there are no calls stacked it will send your TU key.
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10.3. How to Tell Visually Which Call Will be Put in Next

If "CQ Frequency" is on the call frame, then look at the Bandmap.

The {LOGTHENPOP} calls the {SOCALLSTACK} routine. {SOCALLSTACK} will remove the
CQ-Literal ("CQ Frequency") and take the next callsign listed on the Bandmap's run frequency.
There are cases where the CQ-Literal string will replace the callsign on the call frame. The stacked
callsign isn't lost, look at the Bandmap.

The same is true when you are spotted. Your callsign will appear in the call frame but the routine
will not pop it into the callsign box. If you find that it does, you don't have "your callsign" entered
into Station Data window. When you use {LOGTHENPOP}or {SOCALLSTACK} they remove the
station callsign and discard the callsign, then grab the next call on the stack.

If you have {SOCALLSTACK} programmed to an F-key, pressing it once at any time will exchange
the current callsign with the next callsign on the stack. If there is no callsign on the stack, then it
stacks the call and gives you an empty callsign window to enter one. Pressing the F-key again will
reverse them again.

11. Call Stacking (same or different bands) - Multi-User Mode

 
A callsign can be stacked from one radio to another when in 'Multi-User Mode'. It does not matter
if the target station is on a different band or the same band. A second operator can stack a call
on your PC, and he could find stations and stack them for you to work.

To indicate which station you want to stack for, right click on it's "cue-ball" in the info window,
and select the option "Target for call stacking"
A maximum of one callsign can be stacked. If the stack is empty another one may be stacked
After the target station pops the call into the entry window callsign area, the partner station
needs to manually wipe his entry line before entering another call. It doesn't automatically
clear

 
Stacking within same band but not on the same frequency - Use the bandmap by tuning off a
station whose callsign you copied.

Additional functionality when on the same CQ frequency (within tuning tolerance) then you will see
the other station keystrokes in your callframe and vice-versa.

12. Serial Number Server

N1MM logger supports a single sequence of serial numbers for SO2R, MS, M2 and MM.

The serial number is reserved in

S&P mode when the cursor leaves the callsign field or the Exchange key (F2 default) is sent
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Either through spacing, tabbing, or hitting Enter in ESM or pressing the Exchange key
This is needed so you can enter calls to check for dupes while not reserving a serial
number

RUN mode as soon as you enter a letter in the call-sign field
This because on SSB people frequently talk before they type, and they need to see the
serial number displayed earlier. A serial number is not assigned in S&P mode until the
space bar is pressed, so you can do dupe and check multipliers without committing a
serial number to it, by entering it in the callsign field without pressing Enter or Space

 
In SO2R and SO2V, typing Alt+W (wipe) after a serial number has been reserved or wipe through
QSY will "un-reserve" that number.

Because of the way the serial number server works, there are a few cautions:

Serial numbers issued by the second radio may be out of time sequence with those issued by
the main one. This occurs because certain program actions cause a serial number to be
reserved for the use of a station, and if that station does not use that number until after the
other station has made several QSOs, when the log is viewed in chronological order the serial
number will appear to be out of order. I don't think there is anything to be done about this
For similar reasons, depending on operator actions at one or the other station, such as
shutting down the program while a number is reserved, there may be some gaps (numbers
not issued) when reviewing the final log
The most important aspects of serial numbering are that the serial sent to a station be
correctly logged, and that there be no duplicate serial numbers sent; N1MM logger seems to
meet both these criteria
Sometimes it's possible a number will be skipped when given out but not used (example:
QSO not made after all or deleted). Contest committees do accept this behavior!
The maximum sent number to give is 32767. The maximum receive number is 99999

 

 
Addendum by Steve, N2IC&&&
Let me say a few words about the way serial numbers are "reserved" in N1MM Logger. For the sake
of this discussion, I'll assume that ESM is being used.

When you enter a callsign in the Entry Window, and hit the Enter or Space key, a serial number is
reserved and locked-in to that QSO. If it turns out that the QSO is not completed and logged, that
serial number is "lost", and will be not used for a subsequent QSO.

This gets to be especially interesting with SO2R and SO2V. Let's say you are running on Radio 1,
and search-and-pouncing on Radio 2. You enter a call on Radio 2, and hit the Enter key, reserving

Most sponsors are more interested in serial number accuracy than in serial number time order.
If you think about it, it is impossible to guarantee the order of serial numbers in a two radio
situation. This assumes that you always log the time when the QSO is added to the log, which
is the right time from a rules point of view. i.e. end of contact.

What Do Sponsors Look For?
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a serial number on Radio 2. You get beaten out on Radio 2, and go back to running stations on
Radio 1, advancing the serial number beyond the number reserved on Radio 2. A few minutes pass,
and you finally work the station on Radio 2. Your log now appears to have non-sequential serial
numbers. If you never work that station on Radio 2, the reserved serial number on Radio 2 is lost,
and will not be used for any subsequent QSO.

I can't speak for all contest sponsors, but for Sweepstakes and CW/SSB WPX, this is not an issue.
There is no problem for these log adjudicators if your serial numbers are out-of-sequence, or if
there are missing serial numbers in your log. Your log will be correctly processed. In addition, the
N1MM Logger Summary window reports the correct number of successfully completed QSO's.

In summary, stop fretting about out-of-sequence or missing serial numbers. The software is working
as designed 

13. Contest Reporting Application

The Contest Reporting Application (Realtime score reporting) can be started by checking "Start
Contest Reporting Application" on the Other tab of the configurer. With this application you can
show your contest efforts in real time during a contest to the world. Next to this contest reporting
application a website is needed where everyone can see the scores. This application does
automatically upload your scores from the current selected contest to the configured website. These
websites are published on the several reflectors.

When the application has been started the dialog below will be shown.

 

In the middle a countdown counter in seconds will be shown which can be set in the Setup (see
below). When the counter reaches 0 your score will be sent to the configured website.
The status field next to it will give status information (like error messages). A small button to right of
status field shows response from last upload and creates a file with sent and received data for
debugging problems. Version information is shown in the middle of the dialog.

Stop Send / Send Score - Stop the sending of scores to the configured website.
Get Scores - Clicking this button will open the configured website in your browser so you can
view your and other stations scores.

Note that this will keep reporting everything until you uncheck it. Doesn't matter if you are
testing, or operating in a contest. It will be reported. So either close it or click "Stop Send" if you
don't want that.

Stop Score Reporting
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Setup - will open the Setup dialog below.

 
Note that the score will be send to the website for the first time at program startup.

 

The setup dialog configures the realtime scoring application.

Score Post Time (min) - Set the timer how often your score will be uploaded to the
configured website. The possible times to set are: 2, 5, 10,15,30 and 60 minutes. Also a
manual mode possibility can be selected. To send the score the 'Send Score' button has to be
pressed.
Score Posting URL - The url of the website to post your scores to.
Score Reading URL - The url where the scores are displayed.
Listening IP - Shows the IP address on which N1MM logger is running. By default this is the
same computer as where the real time scoring application is running on. This setting is set by
N1MM logger.
Listening Port - Shows the port from which N1MM logger will send the information to the real
time scoring program. This setting is set by N1MM logger.

 

Defaults - Fill the dialog with default values.
Cancel - Cancel the entered values and close the dialog.
OK - Save the values and close the dialog.

 
During major contests several real time score reporting web sites will be up and running. An
example website from Gerry, W1VE below.
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By Gerry, W1VE:

Through the encouragement of many, I decided to take on the project of creating a usable web
portal for realtime score reporting. The result is now ready.You can view the portal at:
http://live.getscores.org

The scoring upload to the site is based on work by Bruce, WA7BMN, with his Contest XML schema,
and scoring trials last year by Tom, N1MM and the N1MM logger.

The latest version of N1MM fully supports score posting. If any other contest software vendor
supports the HTTP POST method of score reporting, it is immediately compatible with
getscores.org. Additionally, getscores.org supports a SOAP-based Web Service API. The success
of the site will depend on participation and the support of software vendors. There are links on the
live.getscores.org site for FAQs.

The viewing site supports many filters, so that you can look at only what you want to look at. Filter
by Class, Power, CQ Zone, IARU Zone, State/Prov and lots more. Your filter preferences are saved
as a cookie by your browser for up to 7 days. The page automatically refreshes every 60 seconds
with score information.

the website will support many contests as listed on the site.
The window is by Score with the highest score first within the operating class, Power Class and
mode. The general idea here is not to look at everything: apply a filter and you'll get a more
representative view of you are looking for.

A scoring period is a rolling window of 72 hours. If you post for a particular contest during the 72
hour period, any time you post an update, you will simply update your score for that contest. This
way, if there are two supported contests over a weekend, you can submit to both. The unique key is
the name of the contest and the callsign.

By the way, I want everyone to know that getscores.org is not an "N1MM" effort. In fact, I want to
ensure it is not. I'm sure that Tom would agree. We must get as many of the contest authors to
participate, otherwise, this type of site is useless. We need to see lots of scores, not just those from
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the N1MM logger. That said, BIG KUDOS to K1TTT and N1MM for getting the posting software in
great shape quickly, and to all of you users for testing — that's a great way to get the site in good
shape for CQWW.

If you have any questions or suggestions about the site, please send them to me at the email
addresses provided on the site, or via gerry@w1ve.com.

The ethics
Tom, N1MM: I don't see any issue with reporting your score. You are not "spotting" yourself, there is
not a frequency specified other than the bands you have operated on.

14. Starting a Contest with a Number Other Than 001

Some contests which have more parts/sessions there is the need to start a next session with the
next number given in the previous part. So how not to start with 001?

There are two workarounds:

Start second part as a separate contest and make the first QSO with number 001 and log it,
then correct (Ctrl+Y) to proper sent number

1.

Start second part as a separate contest, enter fake QSO, open QSO in EDIT window, change
SENT number from 001 to last number you sent in the previous part of the contest, save
changes, et voila, it's done. When a couple of real contacts have been entered, delete the
fake QSO

2.

 

15. Single Operator 2 Radios (SO2R)

Single Operator 2 Radioa (SO2R) is an operating technique that when done properly, can add
many extra QSOs and multipliers to your log. This is accomplished by increasing your efficiency
during "dead" time, specifically when you are sending on one radio. Efficiency is increased by
listening on a 2nd receiver while you are transmitting on the 1st radio. On the 2nd radio you are
scanning the bands for needed QSOs and multipliers. If you find a new station to work on the 2nd
radio, you leave it staged on the 2nd Entry Window until you get a free moment to work this station.
Even adding a few QSOs an hour will greatly boost your score.

A complete chapter has been devoted to SO2R.

16. Footswitch Support

Footswitch support has been added for multiple distributed stations.

In IARU contest headquarter station is allowed to use multiple stations located within one IARU
zone but the rule of one signal per band/mode still in effect. So there are often 2 (one running
station and another looking for multiplier) or more stations on the same band and same mode and
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they should keep only one TX signal on this band at any time. Now you can hook up a footswitch to
the LPT port 15 (LPT port should be enabled even though the only purpose for it will be to have a
footswitch, no any special check box to turn footswitch feature on/off). If the station is not in
multi-multi operator category the footswitch will directly control PTT just like Alt+T. If it is a
multi-multi station (connected to other stations on LAN or via the Internet in Multi User mode) it will
be blocking TX of any other station from the group on the same band (and mode if mode category
is "Mixed").

Yes, for now a quite exotic feature.

Two Monitor Support

Original by Joe Natale, K1JN, with major revisions (so don't blame him)

General Two Monitor Operation

 
Using two monitors is easy and once you have used two you won't want to go back to using one
The operating system (Windows XP or later) takes care of everything. Just think of the two monitors
as one, whether side by side or top and bottom. You only need one mouse and keyboard. The
mouse will move quite smoothly between the two screens. To jump from a program on one monitor
to one on the other, just click a window of the program you want to use. All of the Windows setting
and commands are available to both monitors and can be different for each.

Two Monitor Setup

Install hardware - Many new computers already have two video outputs on the video card. In
that case adding an extra card with a video output is not needed

Shut down Windows
Open the case
Install a second video card (when needed)
Attach a monitor

Any card/monitor will do, they don't have to be same as the one already installed, I
used a Windows 95 era ATI Rage video card and an old Gateway 2000
CrystalScan monitor

Close the case
Software

Start the computer and reboot
Windows should find the new card and monitor and install the software

You will get a message on the 2nd monitor that says if you can read this, you can
extend your desktop onto this monitor

You do that by right clicking on the desktop and click on properties. Click on the settings
tab. There will be icons for two monitors. Click on the one numbered 2 and check the
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box that says extend my Windows desktop onto this monitor
Drag the monitor icons to set which is left and which is right

The second monitor is actually an extension of your desktop, it will have the same
wallpaper and color scheme. If you move the mouse cursor off the right edge of
the left monitor, it shows up on the right monitor. The screen saver runs on the
main monitor, but not the 2nd one here

 
As far as the windows sticking, it varies by program. Luckily, in the case of N1MM Logger, they
stick!
Example Setup

The picture below is a setup example from K1JN during the CQ WPX CW contest.
The left monitor is a 17" set to 1024 x 768 resolution, the right monitor is a 15" set to 800 x 600
resolution.

Left screen windows Right screen windows

Both Bandmaps Packet/telnet window

Log window Info window

Entry window Available mult's and Q's window

Check partial window Score Summary window

 

Contest Setup and Configuration

 

Table of Contents:

1 Station
2 Configurer
3 Start a New Contest Log or Open an Existing Contest Log

 

Station Dialog

Select Config >Change Your Station Data
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Your Station Dialog window will be similar to this one.

 
The information in this dialog is self-explanatory. Be aware that in order for the logger to calculate
accurate beam headings, you will need to put your longitude and latitude into the appropriate fields.
Also make sure that you enter your call as the station call sign. Many of the fields in this dialog are
used when creating contests or during contests, so have them updated with the correct values.

ARRL Section entered and the State field are used in some contests and QSO parties to
determine if you are in or outside a state or province
Latitude and Longitude are used to calculate the distance and bearing to another
station/country (for HF contests)
For VHF contests (having VHF in the contest name) the Grid Square field (4 or 6 digit) in the
Station dialog is used as your bearing and not the entered Latitude and Longitude
Contents of the Latitude and Longitude fields update when the Grid Square field is changed
and vice versa
Club normally has to be spelled out completely, so not YCCC but Yankee Clipper Contest
Club (the dialog above is just a bad example!) to have it accepted (and counted) by the
contest committee
E-mail address and SMTP server address are used for sending a bug report via e-mail. Your
e-mail address and SMTP server address can be found in your e-mail program

 
Help - Show the help file for this window.
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Configurer Dialog

In this Section...

Configurer Dialog
1. Configurer >Hardware tab

1.1. Hardware setup
1.2. Set button examples
1.3. Other Information
1.4. Windows NT/2000/XP (32 bit OS)

2. Configurer >Telnet Cluster tab
3. Configurer >Files Tab

3.1. Files Field Descriptions
4. Configurer >Function Keys Tab

4.1. Function Keys Field Descriptions
4.2. Remapping Function Keys

5. Configurer >Digital Modes Tab
5.1. Digital Modes Field Descriptions

6. Configurer >Other Tab
6.1. Other Tab Field descriptions

7. Configurer >Winkey Tab
7.1. Winkey Field Descriptions
7.2. How to Set Up Winkey in N1MM Logger

8. Configurer >Mode Control Tab
8.1. Mode Control Field Descriptions

9. Configurer >Antennas Tab
10. Configurer >Audio Tab

The Configurer is our name for the tabbed dialog that appears when you click Config on the Entry
Window top menu, and then choose Configure Ports, Telnet Addresses, Other. The Configurer has
many tabs with program settings influencing all aspects of the behavior of the program. Be careful
in setting up items on the different tabs, to be sure that you understand that the option you are
choosing is what you want.

All settings are remembered by the program in "N1MM Logger.ini". Function key definitions, telnet
clusters, call history, and country information are not saved in the .ini file, but in the database that
was in use when you loaded them. That means, for example, that function key definitions loaded or
modified when you are using one database will only appear in that database. You will need to
export them from that database and load them into another database before they would show up
there. The "N1MM Logger.ini" file contains the name of the .mdb file you were last using, which the
program will load when it is started, as well as the name of the current contest and other recently-
opened contests.

If you have not unchecked "Hide extensions for known file types" in Windows Explorer Options, you
will not see "N1MM Logger.ini". You will see "N1MM Logger" with a Type of "Configuration Settings".
Also, do not be confused by the file "N1MM Logger.ini.init". This is used by the program during
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installation. You should not modify this file, because if you ever have to delete your .ini file and start
over (to resolve a configuration problem, for example), it provides the basis for starting a new one

 

1. Configurer >Hardware tab

 
The Hardware tab is used to set up your radios, packet interfaces, telnet connections, CW/PTT
/digital ports and the interfaces to other devices, such as SO2R controllers, multi-purpose
interfaces, and keyers, if they require serial or parallel ports. Set the values appropriate to your
station. If you do not have one of the items listed connected to a port, make sure the port selection
is 'None' and the check boxes are not checked for that port.

You can invoke an ini file whose name is different from N1MM Logger.ini by using the file name
as a command-line argument when the program is started.

 
For example, suppose you wanted to be able to choose between two separate configurations,
one for SO2R and one for SO1V, perhaps using different radios and with different settings. You
could create two new copies of your N1MM Logger.ini file in the N1MM Logger program folder
and rename them to, for example, SO2R.ini and SO1V.ini.

Create two desktop shortcuts for N1MM Logger by right-clicking in an unused area of the screen
and selecting New > Shortcut. Use the Browse button to find your N1MM Logger program folder
and click on the N1MM Logger.exe file. You will notice that the file name appears in the location
box within quotation marks, e.g.
"C:\Program Files\N1MM logger\N1MM Logger.exe" . Click just to the right of this file name
within the box after the closing " , press the space bar once and add the name of one of your
new ini files, e.g. SO2R.ini
"C:\Program Files\N1MM logger\N1MM Logger.exe" SO2R.ini
Note that if the name of your new ini file contains a space, such as "RTTY SO2R.ini", you will
need to enclose the file name in quotation marks as well, e.g. "C:\Program Files\N1MM
logger\N1MM Logger.exe" "RTTY SO2R.ini"
Click Next, choose a name for the shortcut, e.g. N1MM Logger SO2R, and click Finish. Repeat
this procedure for other specific shortcuts.

Each of these shortcuts will now start up the Logger using the ini file named in the shortcut.
Any configuration changes you make will be stored in the named ini file, thus enabling you to
save different configurations in the two files and to choose which configuration to use by starting
the program from the appropriate desktop icon.

Multiple ini files

Why only 8 COM ports?
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Here is how to have Device Manager show any "phantom" ports...

Click Start1.
Click Run2.
Type cmd.exe in the textbox and click OK3.
Type set devmgr_show_nonpresent_devices=1 and hit ENTER4.
Type cd\windows\system32 and hit ENTER5.
Type start devmgmt.msc and hit ENTER6.
When the device manager opens, click the View menu7.
Click Show Hidden Devices8.
Click on the + sign next to the Ports to see the full list of Com ports being used9.
Highlight the port you wish to delete and then press delete10.

 
Accept when asked to do so and continue with any more that you wish
to delete.

Here's what the Device Manager looks like before you delete the phantom ports:

One of the first things people notice when they begin setting up N1MM Logger is that there are
only COM ports 1-8 available. This is a limitation of some of the components used in the
programming, and cannot be changed at this point without a prohibitive amount of effort.

 
In helping people who say "but my lower-numbered COM ports are all committed to other
things", we have found that it often turns out that some of these ports, though seemingly in use,
are in fact relics of the past. As an example, COM3 used to be the standard port for built-in
modems, and even though those modems have largely gone the way of the dinosaur, many
computers still show COM 3 as committed to that use.

If you are familiar with the use of Device Manager, you can always set up several hardware
profiles, including one for ham radio that deletes the devices that are getting in your way
(printers and so on). That way, you are only a reboot away from being ready to go for radio or
being back in everyday mode.

Sometimes, though, ports will not seem to be committed, but when you try to create virtual
serial ports (with a USB-to-serial adapter, for example) Windows will inexplicably skip some
lower number ports. Ron Rossi, KK1L, has contributed the following note about how to track
down and eliminate these phantoms. Be aware that it involves a little beyond the basic
user-level skills, so ask for expert local help if you're not comfortable with what he suggests.

Often there are ports assigned which no longer have devices connected to them. These are
called "phantom ports". These can be discovered and removed. It may then be possible to move
ports around to accommodate the program.
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If you want, you can right-click on any of the shaded ports and examine their properties. Each one
will show up as a "device no longer connected to this computer."

1.1. Hardware setup
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The program supports 8 serial ports (COM1 - COM8) and 3 parallel ports (LPT1 - LPT3).
Set up each port depending on what equipment is connected and enter the appropriate information.

Radio - The radio used and controlled by the program using radio control (CAT control).
Select 'None' if no radio is connected to this port for this purpose
Digital - Means this port is used for digital communication (MMTTY/MMVARI engine or TNC)

Use this to indicate the port that is used for a TU or TNC that is being used for RTTY
Use it also to indicate the port that will be used for PTT in digital modes

Exception: if you do PTT on the radio control port or from a Winkey, do not check
the Digital box for that port

Packet - This port is used for packet radio (TNC) if selected. Do not select if no TNC is
connected for packet radio
CW/Other - This port is used for CW, PTT, footswitch, DVK or an SO2R controller. This
selection may be made in combination with a Radio, Digital or Packet selection provided the
uses are compatible (e.g. Winkey and radio control cannot use the same serial port, because
both use serial communications)
Details - The Set button in this column can be used to open a window with a set of controls
depending on what is selected in the preceding columns (Radio, Digital, Packet, CW/Other).
To the right of the details column is a summary of the detailed settings. See below for details
SO1V - Single Operator 1 VFO i.e. one radio and one VFO used

In SO1V mode, the backslash, Pause, Ctrl+Right-arrow, grave accent(`) and Ctrl+Alt+K
keys are disabled to prevent opening the second Entry window. If the second Entry
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window and/or Bandmap window were open, they will be closed when exiting the
Configurer after selecting SO1V

SO2V - Single Operator 2 VFO i.e. one radio and two/both VFO used
Permits using two separate entry windows, one for each VFO

SO2R - Single Operator 2 Radio (2 radios used by one operator)
Permits using two separate entry windows, one for each radio

 

1.2. Set button examples
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COM7 details shown when Radio selected (serial port)
COM5 details shown when CW/Other selected for Winkey (serial port)
COM3 details shown when Digital selected (serial port)
LPT1 details shown when CW/Other selected (parallel port)

 
There are many more possible combinations than the pictures above are showing.

Speed - The speed of the serial port to radio/if-interface link (check the manual of your
radio/TNC)
Parity - The parity used (check the manual of your radio/TNC)
Data Bits - The number of data bits used (check the manual of your radio/TNC)
Stop Bits - The number of stop bits used (check the manual of your radio/TNC)
DTR - The following selections can be made (pin 4 on DB9 connector):

PTT - used for keying the radio
CW - used for sending CW to the radio
Always on - DTR is always 'high'
Always off - DTR is always 'low'
Handshake - DTR is used for handshaking

RTS - The following selections can be made (pin 7 on DB9 connector):
PTT - used for keying the radio
Always on - RTS is always 'high'
Always off - RTS is always 'low'
Handshake - RTS is used for handshaking

 

 

Icom Addr (hex) - The address for the radio used, enter without the H i.e. 26 not 26H. (This
field is only shown when Icom is the selected radio)
Radio Nr - The radio controlled from this port

In SO1V (one radio, one VFO used) Radio Nr = 1
In SO2V (one radio, two VFOs) Radio Nr = 1
In SO2R select the radio (1 or 2) connected to or controlled by this port

If one LPT "CW/Other port" is set up as Radio=Both, and another LPT "CW/Other
port" is set up as Radio=2, route band data for second radio to second port
When using CW/Other with an external SO2R controller the lowest numbered
(first) LPT port must be assigned RADIO=BOTH (toggles pin 14)

I.e. When using LPT-2 and LPT-3 then LPT-2 must have Radio=Both
Dig Wnd Nr - Set this to indicate which Digital Interface window uses this port for PTT and/or

If you are having trouble getting your radio working... Windows 98 used to enforce handshake if
the port were set for it even if the application did not request it. Go into the Windows Control
Panel, select the serial port, advanced settings and mark the port for XON/XOFF or "NONE"
handshaking. That should allow receive data from the radio to pass without handshake lines
connected and pulled high.

Windows 98 Users
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FSK keying (only shown when Digital is checked)
If only one DI window is used, select 1
If two DI windows are used, select the DI window number this port will be used for
If the port is being used for FSK keying, you will also have to configure it in the MMTTY
Setup window

PTT Delay (mSec) - The time between keying the radio and starting to send CW, a wav file or
transmit a digital mode (only shown when PTT or Winkey selected)
Radio PTT via command - Select when using a software command via the control link to the
radio to key PTT.

 
When checked, the radio will be set to transmit 40 milliseconds (default) before beginning the
message, this is configurable using 'PTT delay (mSec)'

Allow ext. interrupts - Allow external interrupts from this port (serial port - DSR pin 6; parallel
port - pin 15), e.g. from a footswitch. An interrupt on this line will bring focus to the Entry
window and stop a CQ in progress
Winkey - Select when using a Winkey keyer. Speed, Parity, Data bits, Stop bits or Handshake
settings do not have to be adjusted; they are fixed and set by the program. Settings for the
keyer can be done on the Winkey tab in the Configurer. If you select Winkey, DO NOT set
DTR to CW.

Not possible if the port is used for radio control, digital or SO2R control (incompatible
uses)
Note: Only one Winkey is supported, but a single Winkey can key two radios

Two Radio Protocol - Support for the MK2R or other SO2R controller from microHAM (using
control protocol on COM port). USB-only SO2R (no LPT port required) with the MK2R/MK2R+.
Protocol used may be either the MK2R proprietary protocol or OTRSP (Open Two Radio
Switching Protocol)

Disabled when selection for CW/Other is turned off or when a radio is selected
OTRSP forces the port speed etc. to 9600,N,8,1
More info in chapter Supported Hardware under MK2R

CW/Other Port Addr - specify port address for serial and parallel ports
Note: For real ports, the address here should be the same as used for this port in
Windows
For USB-to-serial adapters, the address here can be ignored
When both RTS and DTR are set to PTT they will both be keyed for PTT with the set
PTT delay
Packet uses as handshaking RTS + XON/XOFF
When using a self-powered interface set the handshaking to always on (DTR), always
on (RTS) to supply power to the interface

 

Do not select PTT via DTR or RTS in addition to Radio PTT via Command. Whether on
the same port or another, doing so can result in conflicts that may cause PTT
lockups or other malfunctions. If these occur, a first troubleshooting step is to verify that
you do not have more than one PTT method checked.

Use only one PTT Method at a Time
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DVK - DVK interface for MK2R, W9XT & other DVK's. Also recording is supported by the
program

When DVK is selected, the Antenna selection via the LPT port is disabled
Note: The DVK pins and the antenna pins on the LPT port overlap
When using an external DVK, all of the Run and S&P SSB function keys should be set
to empty.wav and not left blank
microHAM MK2R: if DVK is checked, N1MM Logger will use the DVK in Router instead of
its own DVK support

FootSwitch mode - Pin 6 on the serial ports and pin 15 on parallel ports. The combo box
options are:

None - No footswitch
ESM Enter - Pressing Footswitch will cause the same action as pressing Enter key in
ESM mode
Typing Focus - Pressing Footswitch will switch typing focus
Switch Radios - Pressing Footswitch will switch the radios (in SO2R)
Normal - Pressing the footswitch it will behave if it was connected to the PTT of the
active transmitter and is automatically connected to the proper (active) radio.When the
footswitch is released the focus will be set to main Entry window
F1 - Pressing Footswitch will cause the same action as pressing functionkey F1
F2 - Pressing Footswitch will cause the same action as pressing functionkey F2
F3 - Pressing Footswitch will cause the same action as pressing functionkey F3
F4 - Pressing Footswitch will cause the same action as pressing functionkey F4
F11 - Pressing Footswitch will cause the same action as pressing functionkey F11
F12 - Pressing Footswitch will cause the same action as pressing functionkey F12
Band lockout - Implemented mostly for multi user stations to block second signal on
the same band/mode. It may be useful for single user as well. This mode should allow
you to control PTT for both radios (in case of SO2R) in different modes (SSB/CW). The
advantage of using it (compared to the foot switch directly connected to the radio) is - it
stops AutoCQ and Dueling CQ's

 
It is possible to hook up a footswitch to a serial or parallel port. This should help users with only one
or no serial ports (when a USB to serial adapter is used) to get the footswitch connected to the
computer. A pull up resistor is needed between DSR input (pin 6 on both DB9 and DB25) and +12
VDC and for the parallel port, between pin 15 and +12 VDC. Multiple footswitches (one per parallel
or serial port) can be used where different settings may be used for each one.

With N1MM, SO2R and LPT CW, the LOWEST number port must have the CW output for
BOTH radios if it is used with a conventional LPT SO2R box (DXD, KK1L, N6BV, etc.) or
microHAM MK2R/MK2R+ in LPT (Classic auto control) mode, The LPT with CW, PTT and the
TX/RX/Split controls must be connected to the SO2R controller. If N1MM is configured for CW
on TWO LPT ports (first port: Radio=1, second port Radio=2) then CW will be present only on
the port representing the radio with transmit focus.

LPT Port Numbers
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1.3. Other Information

 
It is possible to have the PTT on the same serial port as the radio with interfaces that support this
(e.g. with a keying circuit connected between RTS and the radio's PTT input).

If the type of CW/Other port chosen is LPT1, LPT2 or LPT3, additional information will be present
on the parallel port. See Radio Interfacing for more detailed info.

1.4. Windows NT/2000/XP (32 bit OS)

 
Under 32 bit Windows operating systems, using the parallel and the serial ports requires a special
dll which will be installed using the program: Port95nt.exe. A link to this file can be found in the
Installation chapter.

2. Configurer >Telnet Cluster tab

 

Telnet Cluster - The default telnet cluster to connect in the Telnet Window
Ctrl+D - delete a row in the table or use right click menu

Edit button - Change Telnet Cluster List
File

Import... - Import a text file with Packet/Telnet cluster nodes into the program
Export... - Export the the Packet/Telnet cluster nodes to a text file

 

3. Configurer >Files Tab
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The files Tab is used to set the path to the Buckmaster callsign database if present, and to wav files
used for SSB message macros.

3.1. Files Field Descriptions

 

Callsign database path - Used to identify the directory of the Buckmaster callsign database
to be used by the logging program. Be sure to include a trailing '\' in the directory name. Make
sure that the path to the CD is set correctly. You can set the path to the Buckmaster database
here and type in the full path to the Buckmaster database on your CD. For example: If your
CD-ROM is mapped to the 'E' drive, the full path is: E:\HAM0\

Don't forget the back-slash '\' at the end of the path! Also, make sure to copy the
HAMCAL32.DLL from the CD to the program directory where N1MM Logger is installed.
On older CDs, this file is located in the \API\WINDOWS directory. It may be located
elsewhere on newer CDs

Recorded wav file path - The full path where the recorded wav files should be placed on
your harddisk. In this path the directory with the contest name will be created
Letters file path - The full path to the letters directory. Example: C:\program Files\N1MM
Logger\wav\{operator}\ This provides the ability to have a separate letters file for each
operator. The decimal point (.) should be specified as Point.wav
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4. Configurer >Function Keys Tab

 

 
Function keys for each message are set here.

4.1. Function Keys Field Descriptions

 

Monitor via PC speaker (Win98/ME only) - The CW sent by the program plays via the PC
speaker (only for Windows 95, 98, ME, disabled for NT/2000/XP machines)
Send Corrected Call (Before End of QSO Msg) - Send Corrected Call (Before End of QSO
Message) - If the callsign is corrected after answering a call, then the corrected call will be
sent before the End of QSO message (as configured by the End of QSO Key). E.g. 'PA1M TU
DE N1MM' instead of 'TU DE N1MM'
Send Partial Calls - Only CW. When sending a partial corrected call only the corrected part
will be send (prefix or suffix). If not checked the whole call will be sent
Work Dupes when Running - Work dupes is for ESM in Run mode and don't send the QSO
B4 Key. All it does is determine what is sent when a dupe calls you AND YOU PRESS
ENTER. Normally you do want to work dupes. See the chapter Off topic for a discussion
Use Contest Word Spacing for CW - The box is defaulted ON for "Use Contest Spacing for
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CW". This setting changes the spacing between words in your CW, where "N1MM 599 5" is 3
words. Default is 6 bits for "contest spacing". When box is not checked, 7 bits between words
is used, which is "normal spacing"
Send Cut Numbers - Ctl+G is cut number mode toggle. This is a toggle function and the new
status is shown on the bottom left of the entry window. The cut number style can be set at the
bottom of this dialog. The characters that can be entered into a serial number field are: A, N,
T, O, E, S, U, W, G, and D. Some contests do not use a serial number field due to length or
because the exchange can contain characters. In these contests the conversion from letters to
numbers will not function
Send leading zeros in serial numbers - Send leading zeros to make into 3 digit number. In
CW: Select leading T with the Cut Number Style selector. RTTY: In RTTY zeros will be added,
so 1 will become 001
Stop Sending CQ when Callsign changed - Typing a character in the callsign field will stop
a (repeated) CQ
ESM only sends your call once in S&P, then ready to copy received exchange - This is
many times called the "Big Gun versus Little Pistol switch" . When selected and in Enter
Sends Message mode the cursor moves to the Exchange field when there is something in the
Callsign field and Enter is pressed (so it does not keep the cursor in the callsign field). If you
don't usually get a station on the first call then deselect this option
String to use on CW between his call key and exchange key (default is one space) - Just
as it says. Example ' ur '
Keycode of Ins Key Substitute - Enter the number for the Ins Key substitute as mapped
below in this configurer dialog. Defaults to 186, the ; character. The program can
automatically enter the keycode in this field . Place the cursor in the keycode field and press
the key you want to substitute, it will put the correct keycode in. 186 is an extended key code.
Not all keyboards map keys the same way. Note that you can't use a Shift, Ctrl, Alt etc. key. I
would not advise using a key like Numeric + that is already in use. It may or may not work. In
this case Numeric +, does NOT work
Keycode of TU/Log Key Substitute - Enter the number for the TU/Log Key substitute as
mapped below in this configurer dialog. Defaults to 222, the ' character. The program can
automatically enter the keycode in this field . Place the cursor in the keycode field and press
the key you want to substitute, it will put the correct keycode in. 222 is an extended key code.
Not all keyboards map keys the same way. Note that you can't use a Shift, Ctrl, Alt etc. key. I
would not advise using a key like Numeric + that is already in use. It may or may not work.
This particular case (Numeric +) does NOT work
Cut Number Style - the following cut number styles can be chosen:

T1234567890 (leading T) - leading 0 will be replaced with a T. So 007 will become TT7
and 030 will become T30
O1234567890 (leading O) - leading 0 will be replaced with a O. So 007 will become OO7
and 030 will become O30
T123456789T (all T) - all zeros will be replaced with a T. So 007 will become TT7 and
030 will become T3T
O123456789O (all O) - all zeros will be replaced with a O. So 007 will become OO7 and
030 will become O3O
T12345678NT (TN) - all zeros will be replaced with a T, all nines with a N. So 097 will
become TN7 and 090 will become TNT
T12345678NT (ON) - all zeros will be replaced with a O, all nines with an O. So 097 will
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become ON7 and 090 will become ONO
TA2345678NT (TAN) - all zeros will be replaced with a T, all nines with a N, all ones with
an A So 091 will become TNA and 190 will become ANT
TA234E678NT (TAEN) - all zeros will be replaced with a T, all nines with a N, all ones
with an A, all fives with an E So 091 will become TNA and 1590 will become AENT
TAU34E67DNT - the zero, one, two, five, eight, nine s will be replaced with a T, A, U, E,
D, N or T

 

4.2. Remapping Function Keys

Select which function keys to send messages. Each type of message has a combo box for you to
set the appropriate function key. If the program is sending the wrong message check here first. The
only restriction is that a key must mean the same thing in Running and in S&P. Function keys do
not have to be unique for a selected message. There is little reason to do so although if you want it
can be done. For the following messages a function key can be selected

CQ Key - defaults to F1
Exchange Key - defaults to F2
End of QSO Key - defaults to F3
His Call Key - defaults to F5
My Call Key - defaults to F4
QSO B4 Key - defaults to F6
Again Key - defaults to F8 (can be disabled)
Next Call Key - defaults to Disabled

 

ESM
Mode

Work
dupes
when
running

Mode QSO B4
Key

Again
Key

Action Result action

On don't work
dupes

Run Disabled F-key DUPE callsign
entered

Send AGN message when
Enter pressed

On don't work
dupes

Run Disabled Disabled DUPE callsign
entered

Send the EXCH when Enter
is pressed, station will be
worked and logged with
Enter, Enter

On don't work
dupes

S&P Disabled F-key DUPE callsign
entered

Pressing Enter does nothing,
no blue buttons in the Entry
window

On don't work
dupes

S&P Disabled Disabled DUPE callsign
entered

Pressing Enter does nothing,
no blue buttons in the Entry
window
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On work dupes Run - Disabled DUPE callsign
entered. Mistake
with received QSO
data

Send EXCH when Enter is
pressed

On don't work
dupes

Run - Disabled Mistake with
received QSO
data

Send EXCH when Enter is
pressed

On - S&P - Disabled Mistake with
received QSO
data

Send EXCH when Enter is
pressed. After the user
corrects the entry, it will log
and not send anything

5. Configurer >Digital Modes Tab

 

The Digital modes tab is used to set up the interfacing to external Controllers (TNCs), or for PTT
control using MMTTY/MMVARI for sound card digital modes.

In SO1V mode, there is only one Digital Interface window, DI-1. In SO2V and SO2R modes, there
are two Digital Interface windows, DI-1 and DI-2. Each DI window is associated with one of the two
Entry windows. Each DI window is opened from the Window > Digital Interface menu item in the
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corresponding Entry window. The Digital Modes tab in the Configurer is used to configure both
Digital Interface windows.

5.1. Digital Modes Field Descriptions

 

Digital Interface 1 / 2
TU type

None
Other: like the KAM, PK232, PTC and any other external TNC
Soundcard: when using MMTTY or MMVARI soundcard software

Port, Speed, Parity, Data Bits, Stop Bits, Flow Control - Have to be set if 'CW/Other'
has been chosen as well

DI-1 MMTTY Mode | DI-2 MMTTY mode
When using MMTTY, select whether AFSK or FSK is being used
If AFSK is selected the serial port (if any) with a check in the Digital check box and with
Dig Wnd Nr corresponding to the DI window number will get passed to MMTTY when the
DI window is opened, so that MMTTY can use it for PTT control.
If FSK is selected the serial port will not get passed to MMTTY. The serial port for FSK
has to be set in the MMTTY Setup. This is necessary in order to allow for the possibility
of using EXTFSK in MMTTY. More information in the MMTTY support chapter

DI-1 MMTTY Path | DI-2 MMTTY Path
The path to the MMTTY engine goes here including the file name of the program
It's not necessary that MMTTY be in the same directory as N1MM logger
Via the 'Select' buttons the path and file name can be selected
It is possible to select two instances of MMTTY in two separate folders. You must do this
if you want the MMTTY settings in the two instances to be different (e.g. left vs. right
channel, different sound cards, etc.)

DI-1 Fldigi Path | DI-2 Fldigi Path
The path to the Fldigi engine goes here including the file name of the program
Via the 'Select' buttons the path and file name can be selected

DI-1 MMVARI RTTY Mode | DI-2 MMVARI RTTY Mode
When using MMVARI for RTTY, select whether AFSK or FSK is being used
If AFSK is selected the serial port (if any) with a check in the Digital check box and with
Dig Wnd Nr corresponding to the DI window number will get passed to MMVARI when
the DI window is opened, so that MMVARI can use it for PTT control
If FSK is selected, the port to be used for PTT control is defined in a separate setup
window

DI-1 MMVARI FSKPort | DI-2 MMVARI FSKPort
Choose FSK8250 if you are using a true serial port or a device that can simulate a serial
port and handle 5-bit codes at 45.45 baud (this does not include most USB-to-serial
adapters, but it does include some commercial interfaces designed to support FSK
RTTY)

When MMVARI is opened for FSK RTTY, a small window labelled FSK8250/16550
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1.03 will open, or appear on the Windows Task bar. In this window you select the
COM port number and the signal line to be used for PTT (RTS or DTR). FSK
keying will be done on the TxD line. If this is a USB device that simulates a serial
port, check Limiting speed. You can use the _ box at the top right to minimize this
window after completing the setup

Choose EXTFSK if you are using a regular USB-to-serial adapter
When MMVARI is opened for FSK RTTY, a small window labelled EXTFSK 1.05a
will open, or appear on the Windows Task bar. In this window you select the COM
port number and the signal lines to be used for FSK keying (normally TxD) and
PTT (RTS or DTR). You can use the _ box at the top right to minimize this window
after completing the setup

6. Configurer >Other Tab

 

The Other tab is used to set up default values and select special modes and functions.

6.1. Other Tab Field descriptions

 

Packet Spot Time (min) - Indicates how long (in minutes) spots are kept in the bandmaps.
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The default is 60 minutes, any integer may be specified
Repeat time in millisecs - Specify the repeat interval (CW or SoundBlaster) in the Entry
window (Auto-CQ). The default value is 1.8 seconds. Enter a value in seconds or milliseconds.
The maximum value is 32767. This is the same as Ctrl+R or 'Config | Set CQ repeat time' in
the Entry Window
Default # Spots in SH/DX/# - The number of returned spots by the SH/DX command in the
bandmap window. The default value is 30 spots. The number of returned spots for the SH/DX
command in the Packet / Telnet window is not affected by this value and has to be changed in
the Entry window under 'Config menu | Edit Packet/Telnet Buttons'
SSB Tuning Tolerance (Hz) - SSB mode: Clicking on or next to a station in the bandmap
window will put the call on the callsign frame (if the callsign field is empty) of the Entry
window. This value gives the maximum frequency distance to the call on the bandmap when it
will be put on the callsign frame. The value has to be between 0 and 20000 (20 kHz). The
default value is 300
CW Tuning Tolerance (Hz) - CW mode: Clicking on or next to a station in the bandmap
window will put the call in the callsign frame (if the callsign field is empty) of the Entry
window. This value gives the maximum frequency distance to the call on the bandmap when it
will be put on the callsign frame. The value has to be between 0 and 20000 (20 kHz). The
default value is 300
RTTY Tuning Tolerance (Hz) - RTTY mode: Clicking on or next to a station in the bandmap
window will put the call on the callsign frame (if the callsign field is empty) of the Entry
window. This value gives the maximum frequency distance to the call on the bandmap when it
will be put on the callsign frame. The value has to be between 0 and 20000 (20 kHz). The
default value is 300
CW Weight - Adjusts the CW weight (between 30-70% limits). The default value is 50. Thie
weight command not only works for serial or lpt CW but also for Winkey
SSB Up/Down Arrow Incr (kHz) - This value gives the frequency jump amount in SSB by the
up/down arrow keys. NB. Never make it smaller than the smallest step your radio can make in
SSB. Older Icom rigs are known to have a smallest step of 100 Hz which is quite big. When
the step is made smaller than the minimum step size the Up/Down Arrows don't seem to work.
Also controls the amount of each frequency change when tuning the RIT on radios that
support doing so from the computer.
CW Up/Down Arrow Incr (kHz) - This value gives the frequency jump amount in CW and
digital modes by the up/down arrow keys. NB. Never make it smaller than the smallest step
your radio can make in CW. Most rigs have a smallest step in the order of 10 Hz. When the
step is made smaller than the minimum step size the Up/Down Arrows don't seem to work.
Also controls the amount of each frequency change when tuning the RIT on radios that
support doing so from the computer.
PgUp/PgDn Incr (kHz) - This value gives the frequency jump amount for the {PGUP} {PGDN}
macros (Note: the PgUp and PgDn keys are not used for this; the {PGUP} and {PGDN}
macros must be used in function key macros. These macro names are holdovers from early
versions of the program)
Primary CW speed Step - The primary speed step is used with PgUp/PgDn button or the
speed adjust in the Entry Window
Secondary CW speed Step -The secondary speed step is used when Shift+PgUp/PgDn is
pressed. Alt+PgUp/PgDn adjusts the CW speed of the inactive radio/VFO in SO2R/SO2V
mode
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Clear populated exchange on callsign change - When selected (default is Off), if the
callsign in the Entry window is changed by the operator, this option clears the contents of
exchange fields in the Entry window that were populated (filled in) from a CallHistory file, from
previous QSOs in the contest, or from a Telnet spot. Does not affect exchange data that have
been manually filled in.
Keep log of all QSOs to facilitate recovery of log - This is the transaction back-up log file.
This journaling back-up text file has all QSOs from the contest in it. So if the database for
some reason would become corrupt it is possible to import this file in a new database and go
on with the contest

When this option is selected the transaction log is created for each contest you log to
The file is closed after each transaction and reopened to force the data to be written to
disk
To keep things simple and foolproof, you are not allowed to change the name of the
transaction log

The name is used to make sure you are loading it properly, and to prevent mixing
logs of two contests
Example name: 'ham.mdb - CQWWCW - 2005-09-19.TRN' i.e.: Used database
name - contest name - date log created

When importing you MUST import the transaction log into an NEW (empty) database
Why? To prevent a user recovering from a database problem making the problem
worse. This will prevent any issues from duplicate contacts and a number of other
problems
Use 'File, Import, Recover QSOs from a Transaction Log' to import the transaction
log file

As you load the transaction log, a new transaction log is automatically made with the
transactions in the first log. Thus you should never have to merge logs. You always use
the last one

Start Contest Reporting Application - Start the contest reporting application. With this
application you can show your contest efforts in real time during a contest to the world. Next
to this application a website is needed where everyone can see the score. This application
does automatically upload scores from the current selected contest to the configured website
Mute mic on supported radios - Mute the microphone during transmit. Normally used to
enter audio via an other radio input then the microphone. Default is to not mute

Tentec Orion: If "Mute" is checked, it causes the Orion's mic input to be muted and the
Aux input to un-mute during voice keyer events
Supported radios are: Tentec Orion and Elecraft K3

Format for DXSpider Cluster - This will send the right SH/DX message for DXSpider clusters
from the button in the top of the bandmaps (Example: SH/DX/30 on 20). Also SH/QRZ will be
sent instead of SH/BUCK. Only select this when connecting a DXSpider cluster. Connect the
cluster and send: SH/VER A DX-spider cluster will say something like: DX Spider Cluster. The
'normal' setting is not selecting this option
Auto-Completion Mode - Auto-completion of callsigns. It works like Internet Explorer's
address bar. If you type in a partial callsign, the program will attempt to match it with a call
that you have already logged or is uniquely identified in the check window. If it matches, the
rest of the call will be added to the callsign textbox and highlighted. You can then either
accept the call as displayed, or keep typing. If you keep typing, the highlighted portion will be
replaced by what you type
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Use Reverse CW - When selecting CW send a command to the radio to use Reverse CW

 

7. Configurer >Winkey Tab

 

The Winkey tab is used to control functions of the K1EL Winkey keyer chip. Winkey is designed by
K1EL and G3WGV. It is only active when the Winkey box has been checked on a serial port,
and that port (whether real or virtual), has been connected either to a stand-alone keyer or to
a device that embeds the Winkey chip, such as various MicroHAM products and RigExpert.
Consult your unit's manual along with the Winkey chip manual for more information on these
settings.

Winkey is fed ASCII characters from N1MM Logger (via COM or USB Ports), and converts the ASCII
to timed CW. For more info see the links page and the Supported Hardware page. The pot speed
range is from a minimum of 10 wpm to a maximum of 55 wpm. Winkey can also be used to control
PTT. Winkey PTT can be used on modes other than CW. Note: This only works for Winkey versions
10, and 21 and greater.

 

7.1. Winkey Field Descriptions
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Keying Mode - Select the keying mode. Choices are: Iambic A, Iambic B, Ultimatic and
Semi-Automatic. The default is Iambic-B
Autospace - Select when the autospace feature should be used. When using the paddles to
send, if a pause of longer than one 'dit' time is detected, THREE dit times of pause will be
inserted before the next character. See the manual for more information
Pot is wired with two leads - Select when the potentiometer on the board is wired only with
two instead of three wires. Under normal operation, leave unchecked. Unless you've built the
keyer yourself, or your keyer vendor recommends this, leave unchecked
Pin 5 Function - Select the function of pin 5. Unless your keyer's manual tells you otherwise,
the default of PTT is likely what you want here. Other choices include PTT, Sidetone, 2nd CW
(second output) or None. The Winkey manual is also a good reference. The choices are:

PTT (default)
Sidetone
2nd CW (second output)
None

Sidetone Frequency - Select the sidetone frequency. The default sidetone frequency is 469
Hz
Reverse Paddles - Reverse the left and right paddle
Ignore Winkey Speed Pot - Ignore the setting of the Winkey potentiometer
Lead Time - Set the lead time value in 10ms Increments (up to 2.55 seconds). This value
reflects the amount of time that the Winkey PTT will be asserted BEFORE keying commences

If when sending CW you are missing the first dot or dash, or if paddle-sent CW doesn't
seem responsive (again, missing the first character) set this to at least 10 mSec
NOTE that this field denotes 10 mSec intervals — '1' in this box means 10 mSec
IF Pin 5 function is set to PTT, set this value to at least 1 (10 mSec)

Tail Time - Sets the tail time in 10 mSec Increments (up to 2.55 SECONDS). This value
reflects the amount of time that the Winkey PTT line will be held after keying stops. Tail Time =
1 results in a tail time of one dit time (v2.2; 10 msec in earlier versions of Winkey), Tail Time =
2 adds 10 msec to that, Tail Time = 3 adds another 10 msec, and so on. If Tail Time is set to
zero, then Hang Time is used instead
First Character Extension - Sets the extension time in 10 mSec steps (up to 2.55 seconds).
Normally ONLY used with older, slower-keying rigs at speeds above 25 wpm, this setting will
add time to the first element sent to help with the lack of T/R speed of those rigs. This value is
usually set by experimentation. See the Winkey manual for more information on setting this
value
Keying Compensation - Normally only used with high speed (>30 wpm) QSK operation.
Adds time (in 1 mSec increments) to both dashes and dots to adjust for rig switching delays
(however slight). See the Winkey manual for more information
Hang Time - Provides a CW-Speed dependent means of holding PTT after CW sending is
finished. Hang Time can be used to set a CW-speed dependent delay of 1, 1.33, 1.67 or 2
letterspaces (not dit spaces). Tail Time must be set to zero to use Hang Time
Winkey 2

Sidetone - Gives a sidetone when sending CW (when using paddle and computer
input)
Paddle only sidetone - Gives a sidetone only when sending by paddle
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Use 2nd output - Use the second output from the Winkey 2

 

 

 

7.2. How to Set Up Winkey in N1MM Logger

Identify the port to control it. Check " CW/Other" on that port. Click Set. Check Winkey. Now go to
'Config|Configure ports, CW/Other', and on the Winkey tab, make the relevant choices. The only
subtlety is that if you are using Winkey's PTT you need to set a lead-time value of other than zero,
and a tail time or hang time value as desired (e.g. sufficient to make Winkey hold in between
characters of hand-sent CW). That's it.

8. Configurer >Mode Control Tab

 

The CW sending speed can be changed to any value by typing over the provided field in the
Main Entry window. Using the scroll bars on the CW speed entry field, or using the speed
control connected to the Winkey chip changes the speed in 2 wpm steps.

 

Setting the speed using the speed control pot changes BOTH the paddle speed and the N1MM
sending speed. Setting the speed using the entry window changes both the paddle sending
speed and N1MM sending speed but ONLY UNTIL the next time the speed pot is adjusted, i.e.
the absolute position of the speed pot then overrides any changes made in the entry window.

CW weight for Winkey can be set up on the Other tab using the same 30-70% limits.

Setting CW Speed in Winkey

Setting CW Weight in Winkey
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The mode control tab determines how the mode will be controlled on the connected radio,
whether the program sets the mode when changing frequency or not, and what mode it changes
it to. This dialog also gives you control over how contacts will be logged.

8.1. Mode Control Field Descriptions

 

Mode recorded in log - Set how to determine the mode that will be entered in the log
Use radio mode (default) - use the mode received from the radio

In digital modes, the mode in the log will be RTTY if using the MMTTY engine or a
TNC
When using the MMVARI engine, the mode will be as selected in the MMVARI
window

Follow band plan - use the mode the internal bandplan gives for this frequency
Use contest mode or bandplan - if the contest is a single mode, use that mode. If
mixed, use the bandplan (as above)
Use contest or radio mode - if the contest is a single mode, use that mode. If mixed,
use the mode from the radio (as above)
Always: - always log the mode selected here (CW, SSB, RTTY, PSK31, PSK63,
PSK125)

Mode sent to radio - Select how to determine the mode sent to the radio
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This applies only for digital modes. See the note below for details

 

9. Configurer >Antennas Tab

 

Every radio seems to have a different range of choices and names for digital modes. Some
radios have no modes specialized for digital modes, some have only one digital mode for FSK
RTTY (for sound-card digital modes, you use USB or LSB), some add to this a separate mode
intended for sound-card digital modes like AFSK RTTY and PSK31, and some radios have three
separate digital modes for FSK RTTY, AFSK RTTY, and other sound-card digital modes like
PSK31. There may also be two versions of each of these, one "normal" and one "reverse"
(opposite sideband). Every manufacturer uses different names for these specialized modes.

 
For simplicity, N1MM Logger has its own radio-independent terminology. The Logger uses
RTTY for the radio mode normally used for FSK RTTY (which is usually but not always called
FSK or RTTY on the radio). If the radio has a mode that is designated for AFSK RTTY, the
Logger calls it AFSK. AFSK-R is the "reverse" of this AFSK mode, i.e. on the upper sideband
instead of LSB. If there is a mode intended for sound card data modes that is different from the
AFSK-R mode, it will be called PSK in the Logger. Not all radios have all of these modes, so not
all choices will necessarily be available, depending on what radio(s) is/are configured.

The translation between the mode name used on the radio and the mode name used in N1MM
Logger is described at Click here to see the table

For RTTY, if you are using FSK, you should normally select RTTY. If you are using AFSK, you
should normally select AFSK or LSB/USB, depending on whether your radio offers a specialized
AFSK mode or not.

For PSK, the choice would normally be one of: PSK (if available), AFSK-R (on some radios), or
USB.

Digital Mode Selection
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The Antennas tab gives control over which antenna should be automatically selected when
selecting a new band. The parallel port is being used to give the needed code to an external
Top-Ten type device box. The code to send to the box is setup in this dialog. To replicate the default
Top-Ten behavior see the example setup in the Interfacing chapter.

When you press Alt+F9, you will toggle through all the antennas FOR THAT BAND. If there is only
one, then no toggling will occur. When you change bands, the antenna switch will be changed to
the antenna with the lowest code for that band. The selected antenna will show in the status pane.
Commas are not allowed as separator if that's the decimal separator (in Windows).

Code - The code which will be presented on the LPT port
Each code represents ONE ANTENNA not a band
Code is binary code on the parallel port using the pins 9, 8, 7 and 2

Antenna - Free text to describe the antenna, give a meaningful name here
Bands - The bands on which this antenna should be used

Use bands in MHz e.g. 1.8, 3.5, 7 etc.
Bands should be separated by a comma for multi band antennas
An antenna may be used on any number of bands

Rotor Port(s) - setup the serial port used with N1MM rotor
Has to be set up to the ports used in N1MM Rotor
More than one port can be selected (separate using comma). Great when turning a
stack with more rotators

Offset - This offset is added to the rotor position to determine the antenna position. This is
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useful for antennas that are mounted at 90 degrees for pattern interference reasons, or for
antennas that have simply turned some in the wind over the winter. The offset can also be
entered for the selected rotor in the rotor program
Bidirect - Set to 1 if the antenna can be set bidirectional (0 = not bidirectional, 1 =
bidirectional) (e.g. Steppir)
Start UDP port for Rotor Program - Set the UDP which is used in communication between
the Rotor program and N1MM logger. Defaults to UDP port 12040 and has to be set up the
same in both programs to work
Start Rotor Program - Start rotor program automatically by N1MM Logger main program. You
will need to stop it manually

 

10. Configurer >Audio Tab

 
For the Two Sound Card SO2R ($5 SO2R) check the SO2R chapter.

When DVK is selected on the used LPT port, the antenna selection on the pins is not working
because the DVK pins and the antenna pins do overlap.

LPT Port Conflict
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Select at the top of the page the configuration to use. (example picture how to connect can be
found in the SO2R chapter.)

1 - Single Card - One radio, No Sound Card SO2R

One radio and one sound card to play wav files and record new messages and mute the
microphone when playing wav files
Only the top part of the dialog above (Tx Sound Card and QSO recording) has to be set up.
Bottom part is deselected

 
2 - Single Card - Two radio, No Sound Card SO2R

Not SO2R but two radios and one sound card to play wav files and record both radios
Only the top part of the dialog above (Tx Sound Card and QSO recording) has to be set up.
Bottom part is deselected

 
3 - Single Card - Two radio, Sound Card SO2R, CW Only

SO2R with one sound card for CW only
The drawback here is that no switching of the headphones is done
You will have to wire a cable to the cd or aux input of a sound card in order to make use of this
feature
You'll need to define your radios as SO2R in the Hardware tab
Both the top and bottom part of the dialog above (Tx Sound Card and QSO recording + Rx
Sound Card) have to be set up

The TX Radio Input Port in the top part of the dialog is deselected

 
4 - Dual Cards - Two radio, Sound Card SO2R

Full SO2R with audio switching where two soundcards are needed
Switching of the headphones is done
You will have to wire a cable to the cd or aux input of a sound card in order to make use of this
feature
You'll need to define your radios as SO2R in the Hardware tab
Both the top and bottom part of the dialog above (Tx Sound Card and QSO recording + Rx
Sound Card) have to be set up

The TX Radio Input Port in the top part of the dialog is deselected

 

 

Tx Sound Card and QSO Recording Setup - It is best to choose the default card for the Tx

The Configurer lets you pick parameters that your sound card may not support... usually 16 bit,
11025 Hz/sec is safe for all cards.

Not All Sound Cards are Created Equal
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Sound card. This is because the CD input is not used for Tx and can be used normally. If you
do use the default card for Rx, try connecting one of the radio inputs to an unused input like
'Aux'

Select Device - Select the soundcard to use for sending Wav files (DVK) and recording
QSOs
Select Input Line - Select the Input line for recording. If your microphone is connected
to the soundcard this will be the 'Mic input'
Select Line to Mute - Select the line to mute when playing wav files. This is also mostly
the Mic input
Recording Bits - Select 8, 16 or 24 bit recording. NB Your soundcard should support
this or an Error 4 will appear when starting to record

Select 8 bits or 16 bits and it will probably always work and make the smallest files
(and good enough quality recordings)

Recording Sample Rate - Select the sample rate to record. The lower the rate the
smaller the files but less quality recording

Selecting 11025 is a good starting point
Radio Input Port - Select the Radio Input Port which receives the audio from the radio.
Mostly Line In. Only when configuration 1 or 2 selected, otherwise grayed out
Max Recording Length (secs) - This is the maximum recording length of a wav file,
when the recording is longer the first part will be discarded so always the last 30
seconds (in this example) will be recorded
Recording channels - Select the number of channels to record, 1 or 2

 
The output for Wave files from the computer to the radio/radios is always the 'Speaker Out' from the
soundcard.

Rx Sound Card Setup (used for SO2R Headphone Switching) - Two line-level inputs are
required for SO2R. With almost all cards, you will have to use one of the internal inputs like
'CD' or 'Aux'. You will need to make a custom stereo cable. This part can only be selected with
configuration 3 or 4, otherwise grayed out

Device - Select the (second) soundcard to use
Left Radio Input Port - Select the Left Radio Input Port which receives the audio from
the radio. Mostly Line In, CD or Aux

Must be different from Right Radio Input Port
Right Radio Input Port - Select the Right Radio Input Port which receives the audio
from the radio. Mostly Line In, CD or Aux

Must be different from Left Radio Input Port

 

Start a New Contest Log or Open an Existing Contest Log

In this Section...

Start a New Contest Log or Open an Existing Contest Log
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1. Start a new contest log
2. Open an Existing Contest Log
3. Contest Specific Information

3.1. Contest Tab
3.2. Tab: Associated Files

 

Before starting your first contest, you should understand how N1MM Logger stores contests and
contacts. The two keys terms are Databases and Logs. As an analogy, think of your PC's hard
disk as a large room containing computer stuff. Into this room, N1MM Logger places File
Cabinets (Databases) and within those File cabinets, N1MM Logger adds individual Folders
(Logs). For each contest that you operate, you will add a new Log to hold the contacts for that
contest. Your large room with computer stuff can hold as many File Cabinets (Databases) and
as many Folders (Logs) as you want - until, of course, your hard drive is full.

 
Continuing our File Cabinet and Folder analogy, there are many methods by which you can
arrange your file cabinets (Databases). Here are three examples:

1. DATABASE PER CONTEST TYPE - Some hams prefer to create a Database for each major
contest type. Your \N1MM Logger directory would contain databases (>File >New Database)
named CQ WW. MDB, ARRL DX.MDB, ARRL 160.MDB and CQ WPX.MDB. When setting up
each contest, you >File >Open the Database corresponding to the contest to be operated, then
>File >New Log (folder) for that particular contest. So, one of these databases would contain
CW, Phone, and RTTY logs from 2007, 2008, and 2009... for that particular contest. You might
want to add a database like MISCELLANEOUS.MDB for the smaller contests or contests that
you only plan to operate a couple of times.

2. DATABASE PER CALENDAR YEAR - Some hams create a new Database each year. At the
beginning of each year, you would >File >New Database a database named K8UT 2008.MDB,
K8UT 2009.MDB or K8UT 2010.MDB. In each database would be the Logs (folders) for every
contest you operate during that year. When setting up each contest, you would >File >Open
Database for the correct year, then >File >New Log (folder) for that particular contest. So, this
database would contain all contests (CQ WW, ARRL DX, CQ WPX...) worked during that year.

3. DATABASE PER EACH CONTEST - Some hams create a new Database each time they
operate a contest. Your \N1MM Logger directory would contain lots of databases - one for each
contest that you operate. When setting up each contest, you would >File >New Database, and
then within that database you would >File >New Log. Although some hams may find this the
easiest method to understand, managing all of those files after many years may become a
problem.

These aren't your only Database/Log options, but perhaps one of them matches the way your
brain works. How about organizing your logs by mode: CW.MDB, PHONE.MDB, DIGITAL.MDB?
N1MM Logger can do any of these - choose the method that provides the easiest way for you to
create new logs before the contest and find your old logs after the contest.

Databases versus Logs
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1. Start a new contest log

To start a new contest select >File >New Log in Database.

Initially, you'll see the name of the contest last used by the program. Click the downward-
pointing arrow to the right of the current contest name (called the "handle") to drop down the
list of all supported contests.

*

You can search alphabetically by pressing the first letter of a contest's short name, and then
scrolling to find the right one.

 
A list of supported contests can be found in the Supported Contests chapter. Check the contest
website for the latest rules and check the contest setup information in the Contest Setup
Instructions chapter.

Do not enter the signal report as part of the exchange on this setup page.

Sent Exchange
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2. Open an Existing Contest Log

To open an existing contest log in the currently selected database. Select >File >Open Log in
Database

In the top part of the dialog the currently available contest logs can be selected by clicking on
the down arrow to the right of the textbox. Note that the textbox is captioned "Select Existing
Log"
Contest specific changes can be made in the Contest and Associated Files tabs. More
information in the paragraph below

To delete a contest, click on the contest in the contest pane, as shown above, so it is selected.
Then press Delete.
For example, the CQWWSSB in the picture above is selected and can be deleted by pressing the
Delete key.

3. Contest Specific Information

Default entry category information will be used on new contests to that of the currently open
contest.
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3.1. Contest Tab

Operator Category: Make a choice for your situation. Choices are:
SINGLE-OP
SINGLE-OP-ASSISTED
MULTI-ONE

In CQWW contests, a prompt is issued asking whether this station is a Run or a
Mult station

MULTI-TWO
An identifier is needed for Station 1 and Station 2 that must be specified when
setting up initially. Each time the program is loaded or contest changed the
program asks to set Station 1 or 2

MULTI-MULTI
SCHOOL-CLUB
CHECKLOG
SINGLE-OP-PORTABLE
ROVER

when going Rover or Mobile and use different QTHs select this for additional
functionality

MULTI-UNLIMITED
MULTI-LIMITED

Band Category: Make a choice for your situation. Choices are:
ALL
160M
80M
40M
20M
15M
10M
LIMITED
CHECKLOG

Power Category: Make a choice for your situation. Choices are:
HIGH
LOW
QRP
MEDIUM

Mode Category: Make a choice for your situation. Choices are:
CW
SSB
RTTY
PSK
MIXED - the Available Mults and Qs window will show one column each for CW and
SSB. The number of band/mode buttons may be limited by the contest rules. For
instance, in a mixed mode contest that has mults once per band and a dupe type of
Each Band (mode independent), there is no need to display more than one column of
mode buttons.
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MIXED+DIG = CW & SSB & Digital (defined by the contest) Could be RTTY & PSK or
RTTY
DIGITAL = no CW & SSB, just RTTY & PSK, or RTTY (defined by the contest)

 

Overlay Category: Used in relatively few contests. Choices are:
N/A (default)
ROOKIE
BAND-LIMITED
TB-WIRES (tri-bander and wires)
OVER-50
HQ
NOVICE-TECH
EXPERT - The EXPERT overlay category in contests where it exists must be selected for
the 5 minute band change counter to be inactive for SINGLE-OP stations

 
In CQ WPX CW and CQ WPX SSB, category overlay may be any combination of ROOKIE,
BAND-LIMITED, TB-WIRES. In STEW-PERRY,category overlay may be OVER-50. In IARU-HF,
category overlay may be HQ. In PACC category overlay may be NOVICE-TECH.

Sent Exchange: Contest-dependent, mostly a number, zone, state etc
without the RS(T)__

 

 

Operators: Enter here all the operators' callsigns. Clicking the button 'Update Ops from Log'
will do this for you (most useful after the contest..).

Update Ops from Log - Clicking this button will transfer all operators from the contest
log to the operators field.

 

Soapbox comments: Your comments on the contest, results, propagation etc. This text is
cleared when selecting a new contest.

 

Section Lists
Selection list: State for Log Type QSOPARTY

Do not put a signal report in the sent exchange. It will cause incorrect Cabrillo output. Typically,
the program will warn you if you make this mistake.

No RST in the Exchange
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*** These selection buttons are only shown when the contest has a selection list (like QSO parties).

In the example above the QSO party for the state CA (California) has been
selected which has 2 contacts/qso's in it.

Button: Import Section List: Importing the contest section file for the selected contest.
This section list is used to determine multipliers (States, Provinces etc.) for the
contest which will be shown in the Multiplier window.
The name of the list is hardcoded and will be shown while importing the file.
Example name: IOTA.SEC

Button: Edit Section List: Edit the contest section table for the selected contest.
This is used to edit the section table in the current database. It does NOT edit the
section text file. If you want to export your section file after editing, use the File
menu accessed from the upper left corner of the Edit Section List dialog.

Button: Show Rules (Internet access required): Goes to the contest sponsor's website
where the rules can be found. A frequent source of problems is when some contest
sponsors change the relevant page within the website or even the whole website every
year, which will make the link fail. Please contact us to update this entry when this
happens.

 

3.2. Tab: Associated Files
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Master.DTA Filename: Shows the selected master.dta file for this specific contest-specific
(not contest instance-specific)

For example, all QSO Parties will use the same master.dta filename
Defaults to master.dta

Use the Change button if you wish to select a file other than the basic master.dta
for use in this contest.

 

 
For each of the following Associated Files, the Change and Clear buttons have the same function -
the Change button allows you to select or change the file to be used, wherever you have stored it.
The Clear button lets you clear the filename if you don't wish to load one.

In addition to these files, be sure always to load the most recent CTY.DAT file before entering a
contest. This is a 2-step process. Download the most recent country file from the Internet using
>Tools >Download latest country file (wl_cty.dat) (Internet). Then import it into the current
database using >Tools >Import country list from downloaded file. The program will warn you if
you open a database whose CTY table is less recent than the wl_cty.dat file in your N1MM
Logger program directory.

Update Your CTY.DAT File Before Each Contest
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SSB Function Key Filename - Select the SSB function keys to use with this contest.
CW Function Key Filename - Select the CW function keys to use with this contest.
Digital Function Key Filename - Select the Digital Interface function keys to use with this
contest from the Entry Window (not the extra keys that can be set up in the Digital Interface).
Call History Filename - Select a call history file to be loaded for use with this contest. This is
entirely optional. See the manual section on Call history Lookup for details. If you want to use
a Call History file, don't forget to turn on Call History Lookup on the Config menu.

 

Windows

Table of Contents:

1 Entry
2 Log
3 Bandmap
4 Packet and Telnet
5 Check
6 Available Mults and Qs
7 Edit Contact
8 Info
9 Score
10 Mults by Band
11 Statistics
12 Visual Dupesheet

 

Entry Window

In this Section...

Entry Window
1. Button Assignments
2. Callsign/Exchange Editing Features
3. Other Info
4. Status Bar Information
5. Callsign Colors
6. The Red and Green dots (LEDs)
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10. Other Keys
11. File Menu Selections
12. Edit Menu Selections
13. View Menu Selections
14. Tools Menu Selections
15. Config Menu Selections

15.1. Configure Ports, Telnet Address, Other - Also called Configurer.
15.2. Change Your Station Data
15.3. Change Sub Bands
15.4. Clear INI file settings
15.5. Find all windows (move to within 800 *600)
15.6. Enter Sends Messages (ESM mode)
15.7. AutoSend Threshold - Ctrl+Shift+M
15.8. Spot all S&P QSOs
15.9. QSYing wipes the call & spots QSO in bandmap
15.10. Do not run on CQ-frequency
15.11. Show non-workable spots
15.12. Reset Rx freq when running split
15.13. Dual Rx always on
15.14. CQ Repeat - Alt+R
15.15. Set CQ repeat time - Ctrl+R
15.16. Call History Lookup
15.17. Record QSOs
15.18. Change Packet/CW/SSB/Digital Message Buttons - Alt+K
15.19. Multi-User Mode
15.20. Change Exchange Abbreviations
15.21. SO2R
15.22. WAE - Special commands for the WAE DX contest only

16. Window Menu Selections
17. Help Menu Selections

Your entry window will be similar to this one.

 
There are two ways to move from field to field.

Tab or Shift+Tab will move through the fields one by one in the standard sequence.
The Spacebar will jump from field to field in the Entry Window, filling in defaults where
appropriate and skipping those fields that are unlikely to change.
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1. Button Assignments

(hotkeys in parentheses)

Wipe (Alt+W)- Wipe Out Entry Fields. Clear information about the current contact
(alternatively, Ctrl+W).
Log It (Enter) - Write this contact to the database. Disabled when in Quick Edit mode.
Edit - Pops up the full Edit window to edit the last contact. Use Ctrl+Q (Quick Edit) as a
convenient alternative.
Mark (Alt+M) - Mark the current frequency in the Bandmap as being in use. Used when you
don't want to take time to enter the call of the station using the frequency.
Store (Alt+O) - Spots the callsign you have entered in the callsign field on the Bandmap,
where it will be shown in bold because it is self spotted. The Config menu option "QSYing
wipes the call and spots QSO in Bandmap" is an easier way to do this, whether you have
worked a station or not.
Spot it (Alt+P) - Spot the contact on the current Packet/Telnet connection.
Buck - Display information on the current call using the Buckmaster callsign database. Note:
hamcal32.dll must be in the start-up and the callsign database must also be set up properly
in the Files Tab from the Configurer. If hamcall32.dll is not found it will use www.qrz.com to
find the call.
F1 through F12 - Send the associated CW/Digital text or .wav file. Right click on the buttons
to change labels and actions (or go into the menu). Running mode has 12 function keys and
also S&P mode has 12 function keys. When Running the S&P keys can be found under
Shift+Function key. See below for more info about the files send and the status of the
Running indicator.
Shift+F1 through Shift+F12 - Send the associated CW/Digital text or .wav file from the
opposite mode. So when the program is in Run mode pressing Shift will show the labels (and
send the associated info) from S&P mode and vice versa. Each mode has 12 function keys.
When Running the S&P keys can be found under Shift+Functionkey.
Esc - Stop sending. Also stops playback of recorded contacts.
Running Alt+U - Toggles "Running' box". When running is checked, the behavior of Enter
Sends Messages mode changes appropriately. Additionally contacts are logged as being part
of a run.
CW speed - The CW speed in wpm can be set using the textbox with speed & up/down
buttons (only visible when CW mode is selected). Also Page Up and Page Down can be used
to change the CW speed. The CW speed is limited to 98 wpm...

 

Because it generally reduces the number of keystrokes required to log a contact, the Spacebar
is the preferred way of navigating the fields of the Entry Window.

Tip
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2. Callsign/Exchange Editing Features

Space Bar - moves cursor to the position the last position the cursor was in prior to leaving the
Callsign or Exchange fields.
Tab - Move to the next field.
Shift+Tab - move to the previous field.
Home - moves cursor to beginning of the field it's in.
End - moves cursor to end of the field it's in.
Question mark (?) - Sends a ?, and will cause the ? to be highlighted when you reenter the
field. E.g. N?MM will send what is typed, but automatically highlight the ? so you can replace
it. A double ?, as in DL?K?A will highlight all text in between and including the ? marks. The
first keystroke entered will replace all three characters.
Left/Right Arrow - moves cursor to left or right one position within the field it's in.
Backspace - delete character to the left.
Delete - delete character to the right.
Shift+Home - will highlight from the cursor insertion point to the home (beginning) of the
textbox.
Shift+End - will highlight from the cursor insertion point to the end of the textbox.
Shift+arrow key - will highlight as you press the keys. When you type the first character, it
will delete the highlighted character.

 

 

3. Other Info

Running Alt+U - Mark this contact as being part of a run (versus S&P).

"Running" is automatically checked:

When you click on CQ-frequency in the Bandmap window
When you are in tuning range of your CQ-frequency (on that band)
When you pressing F1(= default CQ-key) (and no S&P macro has been added to Search and
Pounce F1 key.
When clicking on the green dot when it shows SP (Search & Pounce)

 

4. Status Bar Information

 

Check out the chapter Key Assignments for all available key assignments by the program.

Note
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Left pane - Information
After entering a callsign - Country, Zone, Continent
Otherwise - Messages (like error messages, results from commands etc.)

Middle pane - QSOs /multipliers (/zone) depending on the selected contest
Right pane - Current score

 

5. Callsign Colors

There are two places where a callsign can be shown in the Entry Window , in the Callsign field and
in the Call-frame.

Red Single Multiplier Example: CQWW - qso is either zone or country multiplier (one
multipliers)

Green Double or better Multiplier Example: CQWW - qso is a zone and a country multiplier (two
multipliers)

Blue New contact

Gray Dupe contact or an unworkable station in a non-workable country. This means that you
don't need this station because he is a dupe or you are not even 'allowed' to work him in
this contest according the contest rules.

 

6. The Red and Green dots (LEDs)

 
On the Entry Window below the left end of the Callsign textbox you will see either a green or a red
dot (LED), or both. The LEDs are visual aids that help you keep track of what is happening on each
VFO/radio when operating SO2V or SO2R. This is part of N1MM's continuing philosophy of letting
the operator easily know what's happening at any given time.

Green dot/LED - This VFO/radio has Entry focus in SO2V or SO2R modes - also known elsewhere
in this manual as RX (Receive) focus or Keyboard focus. This means that any information entered
by keyboard goes in that window, including function keys. Depending on your SO2R switching
setup, it may also denote which radio you are hearing in your headphones.

Inside the green dot (or in that location if the green dot is in the other Entry Window) you will
see either Ru or SP (Run/S&P). Ru means the Entry Window (and the VFO or radio that it
controls) is in Running mode, and SP means it is in Search&Pounce mode.

Clicking on the green LED toggles between running mode (Ru) and S&P mode (SP)
Entry focus can also be toggled between the VFOs/radios by

using a mouse to click on a free space in one of the two Entry Windows
pressing the \ key (backslash)

To move both Transmit and Entry focus
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press Ctrl+Left-Arrow / Ctrl+Right-Arrow to move both foci to the left or right VFO/radio
press the Pause key - if the green and red LEDs are in different Entry Windows, the first
press will bring them together in the window that has the Entry focus. Subsequent
presses will toggle both LEDs between the two Entry Windows.

 
Red dot/LED - This VFO/radio has Transmit (TX) focus

Transmit (TX) focus can be changed between the VFOs/radios by pressing the Alt+F10 key or
by pressing the Pause key (see above)
To move both Transmit and Entry focus, pressing Ctrl+Left-Arrow / Ctrl+Right-Arrow will move
both foci to the left or right VFO/radio, or use the Pause key, as explained above.
When transmitting the TX focus can not be changed
When the VFO/radio has TX focus, the LED is dark red. When that VFO/radio is transmitting,
the LED changes to bright red
Inside the red dot the R (Repeat) designator is shown when Repeat mode (for CQ-ing) is
active
Inside the red dot the D (Dueling CQ) designator is shown when Dueling CQ is active

 

7. The Entry Windows

 
The program has two Entry windows. When using both bandmaps/both VFOs, both Entry
windows are needed to make QSOs on both VFOs!

The standard Entry window, which is always open, is being used to transmit on VFO-A (SO2V) or
the left radio (SO2R).
The second Entry window is being used to transmit on VFO-B (SO2V) or the right radio (SO2R).
The second Entry window can be opened by entering a backslash \ in the first Entry window.

If two Entry windows take up too much space, position the second Entry window over the first Entry
window. "\" will toggle you from one to the other (typing focus) or use Ctrl+right/left to move transmit
and typing focus. The Entry window can be resized if the two needed Entry windows take to much
screen space.

Most SO2R operators get the most efficiency while CQ-ing on 1 radio, and S&Ping on the other.
The Entry Window examples below reflect a typical setup: The left VFO-A is now assigned to

When using function keys to transmit either CW or stored voice messages, the message will be
sent on the radio or VFO that has the Entry focus, not the one that has the Transmit focus.
When you press the function key, the red LED denoting Transmit focus first switches to the
Entry window that has the Entry (Keyboard) focus, and then the message is transmitted. On the
other hand, when using either manual CW or phone, messages will be sent on the radio or VFO
that has the red LED, so if you grab the microphone or paddle, that's what you'll get. After a
while, it becomes second nature - we promise!

Important note
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running, and the right VFO (B) is assigned to S&P.

 
All of the features that are available to the single radio operator also work in SO2R/SO2V. For
example, when tuning the band with the S&P VFO, spots that are in the bandmap are automatically
inserted into each call frame (above callsign entry window) when you tune across the frequency of
the spot. Hitting the space bar will pull the callsign from the call frame into the QSO field. Then if a
station calls you on the run radio, toggling back and forth between Entry Windows with the \ key or
Ctrl Left/Right arrows will keep the information in each Entry Window until the respective stations
are logged, wiped clean via Alt+W or Ctrl+W, or you QSY and the callsign is entered into the
bandmap (if "QSYing wipes the call && spots QSO in bandmap" is selected). Most people who are
comfortable with Logger tend to use the reduced size Entry Windows in the examples above. All of
the vital information an operator needs is displayed in the smaller window.

The second Entry window will be opened when a call is clicked in the second bandmap and it is not
open.

More SO2R info can be found in the SO2R chapter.

 

8. Other Features

 

When a callsign is entered info about the country (bearing, distance etc.) is shown just above
the status bar. Additional information from the call history lookup file may also be displayed
(e.g. name, state, section, gird square, etc.). When calculating the bearing, if call history

In SO2V (one radio - two VFOs = 'normal' operation) QSOs made on VFO-A have to be entered
in the standard (first) Entry window. Making a QSO on VFO-B (so transmitting on VFO-B) has to
be done by using the second (VFO) Entry window. So when using both bandmaps, both Entry
windows are needed to make QSOs on both VFOs. When a call from VFO-B is entered in the
first Entry window you will transmit on the wrong VFO. Select the correct Entry window!

Tip
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lookup is off the coordinates of the state that is the closest to the middle of the call-area is
used. If call history lookup is on, the section or state from the call history is used. For VHF
contests (having VHF in the contest name) the Grid Square field in the Station dialog is used
as your bearing and not the entered Latitude and Longitude. If a beacons file is used, the grid
square from the beacons file will be shown just above the status bar when the beacon call
sign is entered.
When a callsign is entered and the station is a dupe moving to another frequency will
automatically clear the callsign field (and place the station on the bandmap)
If in the callsign typed there is a question mark (you didn't get the complete call the first
time), the cursor highlights the ?, so that when you type, it will replace it. When in Enter
Sends Message (ESM) mode a ? in the callsign field Enter doesn't move focus to the
Exchange field but highlights the question mark. A callsign with a question mark in it can not
be logged!
Clicking on the Exchange pane will have the same effect as pressing Space when the cursor
is in the callsign field.
When both bandmaps are closed the frequency and mode are shown on the Entry window
title bar before the contest name.
When tuning the band and a station on the bandmap is within tuning range, this call will be
placed on the Entry window callsign frame. When the callsign field is empty, pressing the
space bar will copy the callsign from the Entry window callsign frame to the callsign field. Also
clicking on the callsign in the callsign frame will place the this callsign into the callsign field,
replacing anything that was previously there. The tuning range can be set in the configurer
(Other tab).
Set Frequency in callsign field - The frequency from the first VFO (A) can be set by entering
a frequency or offset into the callsign field. Decimal points and comma's are allowed in (split)
frequencies in the callsign pane. Placing a / in front of the frequency or offset will set the
second VFO (B). Also Split frequencies can be set here, see the chapter Basic Functions for
frequency change and split frequency examples.
Set Mode in callsign field - The mode can be set by typing CW, USB, LSB, SSB, RTTY, AM,
FM, PSK or SSTV into the callsign field. If the contest mode is mixed or a digital mode, typing
RTTY or PSK in the entry field will open the Digital Interface window and open the serial ports
for which the Digital check box has been checked in the Configurer. If the contest mode is not
mixed or digital, typing RTTY or PSK will result in an error message; if you really want to open
the DI window in this situation, for example to use Fldigi as a CW decoder, use the Windows >
Digital Interface menu item. When the DI window is open and a non-digital mode is entered in
the callsign field, the Digital port(s) is/are closed so it/they can be used for CW, PTT, etc.
Ctrl+P - Spot the station entered in the callsign field as a spot to the active cluster connection,
either packet or telnet. You will be prompted for a comment. If no station is entered in the
callsign field, the last logged station this session will be spotted. Macros are accepted in the
comment sent.
Ctrl+O - Change the callsign of the operator. If you are multi-user, you will be prompted for
the operator at the first call logged. The default is the callsign in the station information dialog.
Entering "OPON" in the callsign field will also prompt for an operator callsign.
Auto-call completion - As you are typing a callsign in the callsign field, if a unique match to
your log or to the check window call occurs, the remaining characters in the call are added to
what you have already typed. They will be highlighted, so that if you continue to type, you will
replace the characters automatically added.
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Auto-CQ - Alt+R toggles the CQ button to send CQ once or repeat. The on/off on the status
bar signals whether the next CQ will go into repeat mode. The only way to stop the repeat
(mid stream), and to get completely out of it, is to hit Escape.

Ctrl+R sets the period of repeat in seconds or milliseconds.
Alt+R turns repeat mode on or off.

If repeat mode is on, CQ will always repeat
CQ needs to be the first two letters of the text sent by the function key for
CW or anywhere in the name of the wav file name for SSB or text for all
Digital modes.
CQ needs to be the first two letters of the caption of the function key for CW
and SSB or anywhere in the caption of the function key for Digital modes.

If repeat mode is off, CQ will not repeat.
A 'R' will be shown in the red status 'led' when repeat mode is on.

The repeat timer for CW and SSB is for the interval from when you stop sending CQ
until CQ resumes.

When using an External DVK there is no stop sending indication and CQ will not
repeat.

When using a radio with internal voice message memories, the repeat timer can be used
together with a CAT macro in the Ã¢â‚¬Å“CQÃ¢â‚¬Â  function key. Note: The repeat timer
in this case starts when the radio command is sent to the radio. Users that use this
function to trigger radio voice keyers must assign the radio command to abort the
message to a separate function key.

Ctrl+Shift+Fx - Record SSB message for the assigned function key. Pressing Ctrl+Shift+Fx
again stops the recording. Fx can be F1 to F12.
Ctrl+Alt+Fx - Record external DVK memory 1 to 4. Fx can be F1 to F4. An external DVK has
to be connected and configured on a LPT port.

When using an external DVK, all of the Run and S&P SSB function keys should be set
to empty.wav and not left blank.

Enter sends messages - the so called 'Enter mode' or 'ESM' mode. An entire normal contact
(CQ & S&P) can be handled with the Enter key. More information is given in the chapter Basic
Functions
Automatically Spot all S&P QSOs - Spot the contact automatically when you log it (only
when in S&P mode).
"Quick Edit" (Ctrl+Q/Ctrl+A). - Quickly edit the QSOs worked before in the log.

Ctrl+Q - moves back one QSO
Ctrl+A - moves forward one QSO.
Enter - logs the changes made and brings you back in normal logging mode.
Escape - discards the changes made and brings you back in normal logging mode.
If the text boxes in the Entry window are colored blue, you are in Quick Edit mode, also
"QuickEdit" will be shown in as the callframe caption when re-editing QSOs. Quick Edit
starts editing with the highlighted contact and you can move forward or back from there.
There is no check if the entered contents is valid as is done when the QSO is entered

normally. So check thoroughly what you type.

The program will display a warning if it suspects that the computer time is wrong (by checking
local time & time zone).
Call Stacking - This command is used for callsign stacking and only available in 'Multi-User
Mode'. It is described in the Advanced Functions section.
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Using both VFOs when 'Running' - When using the main VFO to transmit and the other to
receive (split mode) after each logged QSO the RX frequency will be made equal to the TX
(main VFO) frequency. It's there to let you use the main frequency control as an RIT. It resets
after every RUNNING QSO.
Automatic antenna selection can be used. Antennas have to be set on the Antenna tab from
the Configurer dialog and can be controlled using an external box on the parallel port. When
you press Alt+F9, you will toggle through all the antennas FOR THAT BAND. If there is only
one, then no toggling will occur. When you change bands, the antenna switch will be
changed to the antenna with the lowest code for that band. The selected antenna will show in
the status pane.
Alt+' (Alt+single quote) toggle between the wide and narrow filter for the selected mode (SSB,
CW and Digital modes). This hot key will work whether you have changed your filter codes or
not. Filter codes can be set in the the bandmap right click menu.
Pause - swap radios and match keyboard to radio.
Update timestamp qso - Updating the timestamp from a qso can be done from within the
Entry window using the callsign field. Entries starting with "T" and four numeric digits will
update the current row time in the log.
A warning message will be shown if user tunes away before logging a qso in the Entry window
with a correct entered exchange.
Exchange field validation:

CQ Zone only allow numbers, tab, space, backspace

Section only allow letters/numbers

Exchange only allow letters/numbers

Grid only allow letters/numbers

Power only allow letters/numbers

 

K1TTT's call checking function has been implemented. When a callsign is entered it is
checked against a pattern file to see if the callsign entered is a possible callsign. A warning
will be given in the Check window when this is not true. The checking in done using a set of
rules in the file CALLSIGN.PAT. Note that the call checking function only works for HF (no
WARC) and only for CW and SSB. More information in the chapter Call Checking.
When a SH/DX command is entered in the callsign field it is passed to the packet window for
processing.
Show windows when radio frequency changed - This function will bring the program on
top when the radio frequency is changed.

This only happens when there is another program on top of N1MM logger like your
Internet browser, e-mail client etc.
A radio is attached (to get the frequency change from).
When N1MM logger is minimized nothing will happen.
This function is standard behavior and is always enabled.

 

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

168 of 680 2/2/2011 4:54 PM



TOUR command. A very few contests allow for multiple sessions in which you can work the
same station in every session for QSO credit. You can enter TOUR into the Entry window in
place of a call sign to reset dupe checking at any time before or during the contest. This
command has 2 parameters that are entered into the Sent RST field, separated by a forward
slash "/". The first parameter is the time when the current session begins (GMT) and the
second parameter is the duration of the session. The format for both parameters is hhmm. For
example, 1200/30 means the session starts at 1200Z and has a duration of 30 minutes. The
minimum value for the duration parameter is 10 (10 minutes). If the TOUR command is
entered without any parameters, the current values of the start time and duration will be
displayed. The default values are 0000/00.

At the beginning of each session the start time and duration will be displayed in the
status field at the bottom of the Entry Window. After the first QSO has been logged
during the new session you should see the Multiplier window reset and dupes will be
reset for this new session as well.
Most of the contests supported by the Logger do not need this command but some
(mostly Russian and Ukrainian) have it built into the contest module and do not require it
entered manually.
If you are planning on using TOUR command with other contests, keep in mind that
settings for it will be lost when the logger is restarted. If the Snt (sent RST) field is not
displayed in the Entry window, you will not be able to use this command.

9. Function Keys

9.1. General

 
The program has 24 possible programmed messages assigned to the function keys. There are two
sets of messages, Run messages and Search and Pounce messages. The first twelve messages
you enter are presumed to be Run messages F1 to F12, the second twelve, Search and Pounce
messages F1 to F12.

The function keys can be redefined by right-clicking on the function key/message button array in
the Entry window

The function keys can be stacked. This means you can press several function keys behind each
other which will all be sent in full in the selected order. For example, you could press F4 to re-send
your call (if you think the other station did not get it right) and immediately press F2 to send the
exchange. The program will send the two messages seamlessly.

When hovering with the mouse over a function key button the text to sent is shown.

9.2. Running mode and S&P mode
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If "Running" is checked, you will see the Run messages, if not, you'll see the Search and Pounce
messages on the function keys. SHIFT REVERSES THE MEANING OF THE ABOVE RULE.
When you press Shift, the labels will change (if you made them different) and the text from the
"Running" keys become the text from the "Search & Pounce" keys and vice versa.

Running mode is determined by whether you are on a CQ-Frequency or when the 'Running'
indicator is marked. There is one CQ-Frequency per band. Swapping VFOs may possible swap
between Running mode and Search & Pounce mode. Running mode is based on the TX frequency.

Moving away from the frequency on which you were in Running mode will place you automatically
in Search and Pounce mode. Going back to the Running frequency will put you back in Running
mode (the 'Running' indicator is marked again), clicking on the 'CQ-frequency' in the bandmap also
will place the program in Running mode again. An exception is when you are working split i.e.
transmit on one VFO and receive on the other. Moving around will not change Running mode into
Search and Pounce mode.

Default Function keys

F1 CQ Key F5 His Call Key F9 ---

F2 Exchange key F6 QSO B4 Key F10 ---

F3 End of QSO Key F7 - F11 -

F4 My Call Key F8 Again Key F12 ---

 
The above mentioned function key assignments are the defaults. The function keys can be
remapped in the 'Configurer' dialog.

Just put 24 messages (for CW/Digital) or 24 wave files for SSB in order. They will map to F1-F12
(first 12 are for Run mode) and Shift+F1-F12 (second 12 are for S&P mode). Keys not programmed
in S&P mode take the value of that key from Running mode (if programmed). This means that when
the F5 key in S&P mode isn't programmed, the F5 key from Running mode will be shown (and
used) by that function key in S&P mode. If you want you can come close to CT compatibility.

Therefore the text sent by and shown on the function keys depend on the Running mode
indicator!

More info about Running and S&P mode can be found in the {{Basic Functions}} chapter.

Note that when in Search and Pounce mode, to call CQ, the CQ-key as configured is used i.e
mostly F1. No need to press Shift+F1. That will place the program in Run mode and will press F1;
from that point on F1 will call CQ (in Running mode). If you sent CQ, don't you want to be in Run
mode? If not use the {S&P} macro to stay in S&P mode.

There may not be any 'holes' in the function key lines with skipped function keys. ALL
preceding function keys must at least have a line in the table Example: You'd like to have a
different S&P F3 key than the Run F3 key. First you have to add the 12 Run lines in the table,
after that the S&P lines for F1 + F2 +F3 which you liked to change for S&P. So at least 15
lines in total have to be in the function key table (12 run + 3 S&P).
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10. Other Keys

 

Key Send
function
key(s)

Action(s)

Insert His Call and
Exchange
Keys

Send His Call followed by the Exchange

; His Call and
Exchange
Keys

Send His Call Followed by the Exchange

Alt+Enter N/A Sends the End of QSO message and logs the contact

. End of QSO
Key

Sends the End of QSO message and logs the contact

Ctrl+Alt+Enter N/A Logs a normally invalid QSO (invalid exchange, etc.). Prompts for a
comment. When no comment is entered Forced QSO is added to
the comment field. The receive frequency is reset to the transmit
frequency. Use View>Notes to correct later

 

Background: The ; and ' keys were added to make touch typing much easier for those who use the
Insert and + keys for working and logging QSOs. It is impossible to touch type and easily hit these
very often used keys. If you have ever operated at a multi-multi event with many different keyboard
layouts (QWERTZ, QWERTY, German, Dutch etc.) you will have noticed that each keyboard layout

The text F1 (etc.) in the left column is only text and has no intelligence/meaning for the
program. You could remove it and change it to any text you like, which will show on the
Function key in the Entry window. The order of lines determines what the key will do.
Examples: line 5 is Run F5 , line 11 is Run F11, line 17 is S&P F5 (17-12=5) etc.

Alt + F11 - Run box behavior: The behavior of the running indicator (run box) can be
manipulated using the Alt+F11 toggle. Normally when you are on your CQ-frequency you will
be in Run mode. Changing frequency will toggle the run box into S&P mode. With Alt+F11
this behavior can be changed and the program will stay in the Run mode or S&P mode
regardless to which frequency the VFO is tuned. A message is given in the Entry window
status bar what the new value is. When on a DXpedition this behavior can be very useful.
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has these keys in different places. Using keys like ; and ' helps standardize often used keystrokes.
the keys to use can be set in the Configurer under the Function keys tab.

11. File Menu Selections

 

New log in database - Create a new contest log within the current database. More info
((Open/New Contest Dialog|here))
Open log in database - Open an existing log within the current database. More info
((Open/New Contest Dialog|here))

 

New Database - Create a new log database. Change the proposed name (new.mdb) into a
meaningful name for the use or contents of this new database. From now on this database
will be opened by default at startup of the program. Use Open Database to select another
Database which will become the default database to open. Many contests can be stored
within one database. Always use a separate database for testing new versions of the program
and make regular backups of the N1MM logger directory with all it's contents but with at least
the database files ( *.mdb) with 'real' contest QSOs.

A database is a single Access 2000 database file. It has an extension of .mdb. In each database
are held zero or more general or contest logs. For the time being, only one contest or general
log within a database may be viewed or edited at a time.

Note
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Open Database - Open an existing log database. A selection can be made from databases
already created. Many contests can be stored within one database.

Copy (and Compact) Database - Copy the database to a new database file, and compress
the data at the same time. Change the proposed name (new.mdb) into a meaningful name.
This function can be used to reduce the size of the database after importing a new CTY.DAT
file or after deleting contests. The original database is not changed, nor does the program
start using the new database, unless Open Database is subsequently used to open the new
database.

Note: Copying a database also compresses it. If you have deleted contests from your database, you
may want to copy it to reduce the space it takes up. Deleted contests and contacts are definitely
gone after this action!

Copy This Contest to Another Database - Copy the key/button information and QSOs from
the current contest to another database. The database should exist, if not create it first with
'New database'.
Repairing a corrupted database (Internet) - This is a link to the Microsoft Web site on how to
fix a corrupted Access databases. A program to fix can be downloaded there (Jetcomp.exe).
This file can also be download from the N1MM website under the menu item 'Other files'.
Generate Cabrillo File - New with Version 10.12.3, replacing Export - Cabrillo File. One fewer
step to producing the Cabrillo format text file that most contests now require of entrants
submitting electronic logs.

 
Once created, the Cabrillo file can be edited using Notepad or any text editor. Make sure that the
Station information 'Config > Change Your Station Data') and overall contest information (File >
Open Log in Database ) is correct before creating this file. Be sure to enter the correct Sent
Exchange, or else your Cabrillo file will be wrong. For Multi-op stations select the correct Operator
Category in the contest setup window. This generates the correct numbers for each station; in Multi-
single, the station number field (the last digit in each line) identifies the Mult and Run station.

It is a good idea to rescore the contest before submitting and check to be sure that the header of
the Cabrillo file is correct before submitting the log. Some contest organizers use non-standard
operator categories (i.e. not in the official Cabrillo specification); in these contests you will have to
edit the category by hand to make it agree with the organizer's requirements.

All setup information like station info, telnet clusters, function key information etc. is stored in
the current database. When creating a new database this information is copied to the new one.
Changes are always stored in the current open database. So when opening an old database all
the stored information has to be checked if still valid and changed where needed. This can be
facilitated by using the export and import functions for packet/telnet buttons and function keys.
Just export the files, change databases, and re-import them.

Warning

Digital Mode Designators

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

173 of 680 2/2/2011 4:54 PM



 

Import
Import ADIF from file... - Load the data from an ADIF file into the current database.
ADIF is being used to import into and export from many contest and logging programs. It
is not possible to import a contest if the contest ID doesn't match the current contest. So
the exported and imported contest have to be the same. If not look in the FAQ section
what to do.
Import Call History... - Some contests use exchanges which are very often the same
the next contest you work a station. This table in the log database can be used by some
of the contests to show information in one of the exchange fields or fill a macro when a
callsign is entered. This information can be Name (RTTY friends file), Grid square, age,
etc. For more information see the Before the Contest chapter and for vhf the VHF and
Up Contesting chapter (VHFREG1 is a VHF contest which uses this table to fill the grid
square). When importing a new file with information the contents of the CallHist table will
be deleted first. So export first if you want to keep the content!
Import State and Province abbreviations... - Import the state and province
abbreviations used in many contest modules (QSO parties). Only needed to import
when changes have been made to the file StatesAndProvinces.sec or internal in the
program (CallAreas). When a state or province does not show up correctly in Logger this
menu item is a good try to resolve the problem. Do a rescore after executing this menu
item when QSOs have already been logged.
Import Packet/Telnet Buttons from file... - Import the contents of the Packet/Telnet
buttons file (*.mc). This way a separate set of Packet/Telnet Buttons can be created for
different Packet/Telnet nodes which may have different commands.
Import Telnet Clusters... - Import the contents of a telnet cluster file (*.txt) into the
program. This way you can import a small file with telnet clusters suited for your
location/situation. The 2 items in the file (name and Telnet cluster address) are
separated by a comma. A port number may be added using a : after the telnet cluster
address where needed (the default is 7300). Example:
GB7UJS,gb7ujs.shacknet.nu:7373 or K1TTT.NET,K1TTT.NET
__Import Function Keys - Import the contents of a saved function keys file (*.mc). This
file can be edited with a text editor like Notepad before importing. Note that for each
mode, only one set of function key definitions can be loaded in a database at one time.
However, the Associated Files tab of the Define Contest dialog provides the ability to
associate a definition file with each contest, so that it will be loaded automatically when
that contest is started.

SSB Function Keys...- import SSB function keys.
CW Function Keys... - import CW function keys.

Note: The Cabrillo standard only supports one mode designator for digital modes: RY. In some
digital or mixed-mode contests, PSK and RTTY may be considered separate modes, and the
contest organizers may specify additional non-standard designators such as PK. The Logger's
Cabrillo mode export string for PSK is "PK" unless the contest considers RTTY and PSK to be a
single digital mode. When this occurs the mode export string is "RY". Because the use of these
mode designators is non-standard, you should always check with the organizer's file
specification and if necessary, edit the Cabrillo file to meet the organizer's requirements.
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Digital Function Keys... - import the Digital Interface function keys (not the extra
keys from the Digital Interface).
Recover QSOs from a Transaction Log... - Import the created transaction log file.
This file is created when on the 'Other' tab in the Configurer the option 'Keep log of
all QSOs to facilitate recovery of log' has been selected. More info in the
Configurer chapter.

 

Export

Export ADIF to file
Export ADIF to file... - Create an ADIF file. This file can be used to import into a
logging program or contest program (like this one). Deleted QSOs are not
exported, select the 'DELETEDQS' contest to export these.
Export ADIF to file by date... - Create an ADIF file from the selected contest from
the date set. The first time the default date from which QSOs will be exported is
1900-01-01 (yyyy-mm-dd). The second time the default date and time will be
shown by the program and will be the moment you last exported with this option.
The date/time can be changed if necessary, i.e. when opening another (older)
database. This function is especially useful when you liked to export the generated
ADIF file into a (general) logging program to do award tracking etc. Deleted QSOs
are not exported, select the 'DELETEDQS' contest to export these.

 

 

Export ADIF to file by date from ALL contests... - Create an ADIF file from all QSOs
in all contests when the current contest is DX. Otherwise, it exports only from the contest
you are logging in. The first time the default date from which QSOs will be exported is
1900-01-01 (yyyy-mm-dd). The second time the default date and time will be shown by
the program and will be the moment you last exported with this option. The date/time
can be changed if necessary, i.e. when opening another (older) database. This function
is especially useful when you want to export the generated ADIF file into a (general)
logging program to do award tracking etc. Deleted QSOs are not exported, select the

When the "Save File" window prompts for a filename the default is callsign.txt. If your contest
call sign was N1MM/P, put something like "N1MM_P.txt" The / and many other characters are a
no go in the Windows OS.

Filename Tip
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'DELETEDQS' contest to export these.

 

 

Export ADIF to file by Multi-User Station Number - Create an ADIF file from all
QSOs from one station in a Multi User environment when you are currently logging
DX. Otherwise, it exports only from the contest you are logging in. A station
number has to be given after which a filename can be given for the ADIF file to
generate.

 
Note: When using ADIF export and the contest name contains "RTTY" or "JARTS" the export mode
is set to "RTTY" even when the log file shows otherwise (i.e. LSB).

Export to File (Generic)
Export to File (Generic), order by QSO Time (normal)... - Creates a generic file
named callsign.txt from the contest log ordered by time (and not by band). In some
cases this is the file needed by the contest manager. This file can also be used to
import into a spreadsheet or database program or your logging program if it can't
import ADIF format. The exported file can be edited with a text editor like Notepad.
Export to File (Generic), order by Band... - Creates a generic file named
callsign.txt from the contest log ordered by band, per band ordered by time. In
some cases this is the file needed by the contest manager (like in VHF and up
contests).

Export EDI to file by band... - Create an EDI (REG1TEST) file which is a regular file
format used for VHF contests in Europe. A separate file will be created for each band
with QSOs made on it.
Print Score Summary to File... - Print a summary sheet to a file with the default name
Callsign.SUM Example: N1MM.SUM The number of contacts printed on the Summary
sheet is without dupe contacts. The exported file can be edited with a text editor like
Notepad.
Export Call History... - Exports the information in the Call History database table. This
table can only be filled or revised by using Import Call History. Do your editing on the
Call History text file before import.
Export Packet/Telnet Buttons to file... - Export the contents of the Packet/Telnet
buttons to file (*.mc). Exported Packet/Telnet buttons can be imported using the menu
item 'File | Import Packet/Telnet Buttons from file...'. The exported file can be edited with
a text editor like Notepad.
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Export Telnet Clusters... - Export the telnet clusters (*.txt) in the program. This way you
can export the current entries and update it for your own location/situation. Exported
Telnet clusters can be imported using the menu item 'File | Import Telnet Clusters...'. The
default name for the exported file will be 'Clusters.txt'.
Export Function Keys to file - Export the contents of the function keys to file (*.mc).
Exported function key settings can be imported using the menu item 'File | Import
Function Keys to file...'. This way for every contest a separate set of function keys could
be created. The exported file can be edited with a text editor like Notepad.

SSB Function Keys... - Export the SSB function keys.
CW Function Keys... - Export the CW function keys.
Digital Function Keys... - Export the Digital Interface function keys (not the extra
keys from the Digital Interface).

Recently used contests/databases - The most recently used contest/databases will be shown
here with a maximum of nine.

 

Exit Alt+F4 - Quit the program. If two Entry windows are open the program will not exit. If
unlogged contacts are in the Entry window you will be prompted with the dialog below.

 

 
(

12. Edit Menu Selections

 

Wipe Out Entry Fields Ctrl+W - Clear information from the current contact (equal to Alt+W).

 

Edit Last Contact Ctrl+Y - Open a dialog to allow all fields for the last contact to be modified.
Add a Note to Last/Current Contact Ctrl+N - Add a note to your the current contact in the
Entry window or the last QSO logged when no callsign is shown in the Entry window.
Edit Current Contact - Open a dialog to allow all fields for the current contact to be modified.
Double clicking in the Log window on a contact will open the same dialog.
Quick Edit Previous Contacts (Back) Ctrl+Q - Quickly edit the QSOs worked before in the
log. Ctrl+Q moves back one QSO, Ctrl+A moves forward one QSO. If the text boxes in the
Entry window are colored blue, you are in Quick Edit mode. To exit, press enter to save
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changes or Escape to abandon changes.
Quick Edit Previous Contacts (Forward) Ctrl+A- Quickly edit the QSOs worked before in
the log. Ctrl+Q moves back one QSO, Ctrl+A moves forward one QSO. If the text boxes in the
Entry window are colored blue, you are in Quick Edit mode. To exit, press enter to save
changes or Escape to abandon changes.
Increase Received NR by 1 Ctrl+U - Increase the number in the exchange field by 1. You will
find this useful during serial number contests when you are in a pileup and you need to keep
incrementing the DX station's serial number because you can't get him in the log...

 

Find/Find Again Ctrl+F - Find the callsign entered in the callsign field in the log. Pressing
Ctrl+F again will find the next instance.

 

13. View Menu Selections

 

Max Rates - View 1 minute, 10 minutes and 60 minutes highest rates for the contest. The
content shown can be saved as a text file by clicking on the Save button or by right clicking to
the clipboard using the menu item: Copy text to Clipboard.

 

Off Times - Show off times. Shown is the start and end of the period and the minutes off time,
if the operator is known it will be shown. Also the total off time is given in minutes and
days/hours/minutes. If a contest does not have an off period it is set at 30 minutes. The
content shown can be saved as a text file by clicking the Save button or by right clicking to the
clipboard using the menu item: Copy text to Clipboard. Off times uses time of first (last)
logged QSO as the start (end) of on time. Any time between start (end) of contest and first
(last) logged QSO is counted as off time. A warning will be displayed for pre-contest QSOs
that cause the report to be incorrect.
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Runs - Shows all runs. These are the periods between band changes and includes off times.
The content shown can be saved as a text file by clicking the Save button or by right clicking
to the clipboard using the menu item: Copy text to Clipboard.

 

Suspect Calls - Show suspect calls using the K1TTT's call checking function. A window will
open with the results. The content shown can be saved as a text file by clicking the Save
button or by right clicking to the clipboard using the menu item: Copy text to Clipboard.

 

 

Suspect Zones - Show suspect zones. Zones in the USA and Canada are omitted. The first
zone is the zone from this contest, the second zone is the zone from the cty.dat file loaded. A
window will open with the results. The content shown can be saved as a text file by clicking
the Save button or by right clicking to the clipboard using the menu item: Copy text to
Clipboard.

 

 

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

179 of 680 2/2/2011 4:54 PM



Varying Zones - Show varying zones. The first zone is the zone from this contest, the second
zone is the zone from any other contest in this database or this contest. A window will open
with the results. The content shown can be saved as a text file by clicking the Save button.

 

 

Passed QSOs -The number of passed qsos per operator. Showing band, number of passed
qsos and multipliers.
Cross Check Exchanges - Will create a report of inconsistent exchanges, Grid Squares not
in the call history and distances >= 700 km in VHF contests. Great to find typos after the
contest.
Unique calls not in Master.dta - Will create a report of unique calls which are not found in
the master.dta file in the N1MM logger program directory.

 

 

Notes - Open a window and display all contacts with notes. Great feature to check operator
notes when checking the log after the contest. The content shown can be saved as a text file
by clicking the Save button or by right clicking to the clipboard using the menu item: Copy text
to Clipboard.
Statistics - Show statistics for the selected contest. Many choices available. See chapter
'Statistics' for more detail. When, possibly during a contest, you check the statistics and a
station comes back, just start typing. The statisctics window will go to the background and
every typed characters will go to the Entry Window. A Print to File output can be import in the
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Import Goals in the Info Window.

 

Show Last 10 Spots - Show the last 10 spots for the call in the callsign field. If the callsign
field is empty the callsign on the callsign field frame will be used, if any. A Packet or Telnet
session with a DX cluster should be present because a query will be send to that cluster.
Show Buck/Packet - Show the Buckmaster information for the call in the callsign field. If the
callsign field is empty the callsign on the callsign field frame will be used, if any. A Packet or
Telnet session with a DX cluster should be present because a query will be send to that
cluster.
Show Station - Show the station information for the call in the callsign field. If the callsign
field is empty the callsign on the callsign field frame will be used, if any. A Packet or Telnet
session with a DX cluster should be present because a query will be send to that cluster.
Show QSL/Packet - Show the QSL information for the call in the callsign field. If the callsign
field is empty the callsign on the callsign field frame will be used, if any. A Packet or Telnet
session with a DX cluster should be present because a query will be send to that cluster.
Show Sunrise/Sunset - Show the Sunrise/Sunset information for the call in the callsign field.
If the callsign field is empty the callsign on the callsign field frame will be used, if any. The
information shown is also available in the Info Window. A Packet or Telnet session with a DX
cluster should be present because a query will be send to that cluster.
SH/DX Current Call or Spot - Shows DX information from the current call in the callsign field
or spot. If the callsign field is empty the callsign on the callsign field frame will be used, if any.
A Packet or Telnet session with a DX cluster should be present because a query will be send
to that cluster.

 

Show QRZ (Internet) - Show the information that QRZ.com has for this call using your
browser. An Internet connection should be present.
Show Google (Internet) - Show the information that Google.com has for this call using your
browser. An Internet connection should be present.
Show Buck (Local) - Show the Buckmaster database information for this call. This requires
installation of Buckmaster database software and Buckmaster database on the local
computer.

 

Set Font - Change the font of the Entry window text boxes and callframe text. The callframe
text is the same type but not size as the textboxes. If Arial is the choosen font,the callframe
remains however MS Sans Serif. A nice slashed font is Monaco.

 

All 'Show' items below can only be used when valid callsign information is entered in the
callsign field or the callsign frame.

Note
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14. Tools Menu Selections

 

Rescore Current Contest - Rescore the current contest. This is required before submitting a
log if CTY.DAT has been changed (if applicable) or if contacts have been modified or deleted
during the contest. It may be run at any time but is rather slow.
Rescore last N Hours - Rescore the last N hours for the current contest. It may be run at any
time but is rather slow.
Download Latest Check Partial file (Master.DTA)(Internet) - This item will open your web
browser to the web page where to download the latest version of the check partial file. Select
the file to download and copy the file in the program directory(NB. N1MM logger supports the
CT format master.dta file). Select the file to use in the tab 'Associated Files' under 'File | Open
Log in Database' dialog. The calls in these database master files appear in the Check window
after entering at least two letters of the callsign field.
Tune (CW mode) Ctrl+T - Switches the radio into CW mode and using the CW keying
interface, key the transmitter. The PTT line will also activate and the radio has to be in semi- or
full-break-in mode (vox) to transmit. To stop the tuning signal, press the Esc key or Ctrl+T
again. After the tuning signal ends and PTT is released, the radio will return to the original
mode.

 

Download latest country file (wl_cty.dat)(Internet) - This item will open your web browser to
the web page where to download the latest wl_cty.dat file. After downloading the new country
file it has to be imported in the program by selecting 'Tools>Import country list from
downloaded file' which is the next menu item.
Import country list from downloaded file- Load a new copy of the country file into the log
database. Mostly this file is called wl_cty.dat but may have any name. Just select the right file
when importing and select Open". To check which file you are using go into 'Help - About
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N1MM logger Vx.x.xx and look at the bottom line which tells you the current country file
(mostly cty.dat or wl_cty.dat), check the date and time if it matches the file. Duplicate entries
are ignored during the import so the first instance will be added.

Add call to country - Specify a country for the callsign in the callsign field in the Entry
Window. If no callsign entered this menu item will be grayed out. This is a quick way during
the heat of a contest to add a country. Added callsigns to countries are valid until you do a
new 'Import country list from downloaded file'. Making changes permanent means changing
the imported country file (wl_cty.dat) and importing the changed country file. This feature is
for getting stations accepted by the program from countries when otherwise rejected by the
program due to a faulty country file. When using the right country the program will accept the
station and calculate the right (well at least a more accurate) score (points and multipliers).
Tune to beacon for this band - This will change mode to CW/CW-R and tune to the NCDXF
beacons on bands 10, 15 and 20 meters and displays the station transmitting and the power
steps in the status bar of the focus window. Also the Short Path and Long Path bearings are
shown. See: http://www.ncdxf.org/Beacon/BeaconSchedule.html
Update Call History with Current Log - Update the call history file selected with the qsos
from the current log file. Contacts will be added when new or updated when already in the call
history file. For the 2 grid fields the behavior is a bit different. When both grid fields are filled
and a new third grid has been logged, the second grid (oldest) will be removed, and replaced
by the contents of the first field. The new grid will be added to the first position. The same
change in position will happen when only the first grid is filled and a new grid has to be added
from the log. A 4 digit grid will be overwritten by a 6 digit grid when the first 4 characters are
the same.

 

Turn Rotor Alt+J - Turn rotor to bearing for the callsign in the Entry window or to the callsign
in the callframe (when callsign field is empty).

The statusbar will show the bearing it will turn to. Example: Turning Rotor to 123°
Alt+L will turn the beam to the proper bearing for long path

Stop Rotor Ctrl+Alt+J - Stop turning the rotator.
Packet Window Tools - Opens the menu for the Packet Window, from the Entry window, so
you don't need to look at the Packet Window
Program Execution Logging (debugging only)

Trace facility. Exports to a selectable file (*.trc). Tracing has been added to all program
areas. If you experience problems (like a serious delay) please turn on tracing for the
window/dialog giving (performance) problems. Send the recorded trace file to the
programmers so they can figure out the problem/delay is in the program.

Disable
All
.... one entry per program window/dialog (Available window, Bandmap window
etc.)

Save Window Positions - Save the current window positions to the .ini file.
NB. window positions are automatically being saved when the program is closed.

Always load the most current WL_CTY.DAT file before entering a contest from the Internet.

Note
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Window positions are saved per operator. Use Ctrl+O to select Operator and press 'Save
Window Positions'.

 

Restore Window Positions - Restore from the .ini file the most recent saved window
positions. The screen will update immediately

Window positions are restored per operator (when saved first by the operator). Use
Ctrl+O to select Operator and press 'Restore Window Positions'. The windows will
change to their new positions immediately. This enables easy reconfiguration of the
screen when changing operators at a multi-op.

 

15. Config Menu Selections

 

15.1. Configure Ports, Telnet Address, Other - Also called Configurer.

This a very important dialog which can change the program's behavior. This menu opens the
configuration dialog to modify setup options.

15.2. Change Your Station Data

Modify overall Station information - name, call, address, state, latitude, longitude, etc. The callsign
entered here is very important for most contests, It determines what country you are in, which may
in turn affect the required exchange, scoring, which stations may be worked for contest credit, etc.

15.3. Change Sub Bands

These are the band edges which are used when you invoke the use of a bandplan in the Configurer
dialog's Mode Control tab. The Sub Bands are disabled in the default setting, which is Follow Radio
Mode, because this option often causes operator confusion if it is set by mistake.

You may want to set up a bandplan as an aid to the operator. For example, in Europe, you might
want to set the lower band edge on 40 SSB at 7040 to help you conform to the IARU Region 1
bandplan. In that case, you need to add the frequencies (in kHz) that are used for the specific

More info about rotator control can be found in the chapter {{Supported Hardware}} under
'Rotator control'

Note

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

184 of 680 2/2/2011 4:54 PM



mode to the bandplan for that mode.

If you click or tune to an area designated for a given mode on the bandmap and you are following a
bandplan, then the program and attached radio will change modes appropriately. It is assumed that
digital segments are the smallest, SSB, next, and CW the largest, and that they may overlap. For
that reason, the program checks the digital sub-band list first, then SSB and finally CW.

CW Sub Bands - See example below. The band 7000 to 7040 is set as CW in Europe by the
IARU bandplan. The frequencies above 7040 are automatically set to SSB if no digital sub
bands are set.
SSB Sub Bands - the sub bands for SSB , if nothing is set this is the default mode.
Digital Sub Bands - the sub bands for the digital modes

 

15.4. Clear INI file settings

Option to clear out the 'N1MM logger.ini' file. Could be used when having Configurer troubles.
Radio, port etc. settings will be lost when using this item.

15.5. Find all windows (move to within 800 *600)

Option to force all windows onto primary 800 x 600 screen. Great when coming from a higher
resolution screen or a two monitor setup and windows are 'missing on the screen'.
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15.6. Enter Sends Messages (ESM mode)

Ctrl+M - A mode of operation frst introduced by N6TR in TRLog, and much improved in N1MM
Logger. The program anticipates the needed sequence of messages to complete a QSO in either
Run or Search & Pounce mode, and sends each one in turn by simply hitting Enter. See ESM for
further details.

15.7. AutoSend Threshold - Ctrl+Shift+M

Start sending the callsign after a certain number of characters typed AFTER the last number in the
callsign. The minimum threshold is 1. 0 will turn off the feature. Only when in RUN mode, not in
S&P. More info in the chapter Advanced Functions.

15.8. Spot all S&P QSOs

Spot the contact when you log it. This feature is turned off EVERY time you exit the program. This is
to prevent accidental spotting of test QSOs or casual rag chew QSOs.
If this option is checked, a contact is automatically spotted when:

You complete the QSO in S&P mode and
the spot is not already on your bandmap

15.9. QSYing wipes the call & spots QSO in bandmap

Very useful for S&P. If you enter a station's call in the entry window, and then tune off for any
reason (he doesn't answer your call, or...) the call is shown bold in the bandmap. The setting of this
feature remains as it was across program restarts.
Example: Tune to 21200, Enter VU2PTT, Tune off, VU2PTT is "spotted" on your bandmap at 21200.
Repeat as long as desired. Go back and work all of them using Ctrl+Up and Ctrl+Dn to navigate.

15.10. Do not run on CQ-frequency

When selected and you QSY back to an old Run frequency, the mode stays in S&P. F1 and Alt+Q
continue to switch to Run mode. This is most useful in Sprint-like contests, where you QSY
frequently and want to avoid unexpected switches to Run mode

15.11. Show non-workable spots
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This allows non-workable spots and logged contacts to be hidden. . If you hide spots, you will likely
never utilize the program to its full advantage, especially S&P. If you don't know why I am saying
this, then don't hide spots.

15.12. Reset Rx freq when running split

When using the main VFO to transmit and the other to receive (split mode) after each logged QSO
the RX frequency will be made equal to the TX (main VFO) frequency. It resets after every
RUNNING QSO. Using a radio with VFOs A and B, this feature is ithere to let you use the main
frequency control as an RIT. With Main/Sub radios like the Icom 756/7800 series you can not RX on
SUB without receiving on both VFOs. In this case put RX on Main and TX on SUB for Alt+S to work.

15.13. Dual Rx always on

Yaesu FT-1000 series, Icom IC-756 series, IC-781 ,IC-775 and IC-7800, Elecraft K3 with subRX only:
Selects the mode for Dual Receive toggle (Alt+F12).

When selected -
Yaesu FT-1000 series: The sub receiver will be left on (blinking green RX led)
Icom IC-756 series, IC-781 ,IC-775 and IC-7800 only: Dual watch is not turned off when
you switch from SUB to Main with Ctrl+Left Arrow or PAUSE
Elecraft K3: The sub receiver will be left on
Not selected - The sub receiver will switched off (RX led off)

15.14. CQ Repeat - Alt+R

Toggle for repeat CQing.go into repeat mode. With Winkey, beginning to enter a call-sign in the
Entry Window terminates the CQ, but the program remains in CQ repeat mode. The function is
automatically turned off when no longer on the CQ-frequency and the mode changed to S&P
mode.

15.15. Set CQ repeat time - Ctrl+R

Specify the repeat interval (CW or SSB with sound card) in seconds. The default value is 1.8
seconds.

15.16. Call History Lookup

When selected, a callsign entered in the entry Window is checked against a Call History file. For
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further details see Call history Lookup

15.17. Record QSOs

Record current contacts when in CW or SSB; disabled for other modes. The path set in 'Configurer',
tab: Files is being used. More info can be found in the chapter Tips and Tricks.

15.18. Change Packet/CW/SSB/Digital Message Buttons - Alt+K

 
Change the contents of the Packet/CW/SSB/Digital message buttons (Elsewhere called Function
Key definitions). The maximum length of text in each Packet, CW, SSB and RTTY button is 255
characters. Alt+K will access the relevant list of definitions, depending on the mode you are in, or
you can right-click in the button area to get there . The first 12 rows are for Run mode definitions
(F1-F12), and the second 12 are for S&P mode. (also F1-F12). The row-to-key association is fixed
— that is, the third row in the table is Run F3, and the 14th is S&P F2. Empty rows must have
something in them - it can be a single space, for example.

If you wish, you can supply a single set of definitions (12 rows), and the program will use it for both
Run and S&P mode. Alternatively, you can supply S&P F1 and F2, for example, and leave the
remainder empty - the program will substitute only the first two S&P definitions when in S&P mode

Also note that if you use a "&" character in a button caption, such as "S&P Exchange", you need to
double it (S&&P) to avoid problems with a reserved Windows function.

Change CW Buttons - Change the contents of the CW buttons.
Change SSB Buttons - Change the contents of the SSB buttons (.wav files). Please use the
file chooser buttons to the right of each row.
Change Digital Buttons - Change the contents of the Digital buttons.

15.19. Multi-User Mode

Start the networked mode of N1MM logger (Multiple computers connected to each other).

Multi-User Tools - Menu with Multi User stations tools. For more detailed info see the chapter
on Multi-User Support.
Edit Station Computer Names - Associate the computer numbers (starting with 0 for the
master station) with their IP-addresses for use in Multi-User mode..
Change Operator - Ctrl+O - Change the callsign of the operator. If you are multi-user, you
will be prompted for the operator at startup. The default is the callsign in the station
information dialog. Entering "OPON" in the callsign field will also prompt for an operator
callsign.
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15.20. Change Exchange Abbreviations

N1MM Logger recognizes a number of alternative forms for the standard abbreviations used in
Cabrillo logs to denote multipliers. The tables accessed from these relate the alternative and
standard forms. Here is an example:

This table is edited the same way as the function key definitions tables, but since it is unlikely that
you would ever need more than one table, any changes are saved in the database and cannot be
exported. If you use multiple databases, you will need to make the same changes in each. Note that
the right column is the official abbreviations. normally, you should not edit this column unless the
contest sponsor changes its official abbreviations. The left column, on the other hand, can be
changed at will, so long as each left column entry is associated with a right-column official
abbreviation. The the example, for example, YT NT and VY1 are both equated to the official
abbreviation NWT.

Change ARRL Section Abbreviations - Change table of ARRL Section abbreviations.
Change QSO Party Abbreviations - Change the table of county abbreviations for a given
QSO Party. you must have previously selected a particular QSO Party in the contest Setup
dialog. Again, be extremely cautious in changing the right-hand column unless you are sure
that the QSO party sponsor has made a change.

 

15.21. SO2R
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More info about Single Operator Two Radio operation of the program can be found in the chapter
SO2R

Dueling CQ's - Ctrl+B - SO2R feature that alternates sending CQ on each radio in turn,
listening on one while transmitting on the other. Supported for both CW and SSB.

Changing either radio in frequency more than 200 Hz will terminate Dueling CQ.
Set Dueling CQ Repeat Time - Adjusts time after CQ ends on one radio before it starts on
the other. In seconds.
Advanced SO2R - Ctrl+Shift+I - toggle 'Advanced SO2R' mode. See Advanced SO2R
Advanced SO2R Delay Time - Ctrl+Shift+N - Adjustable delay for Advanced SO2R.
Focus on Other Radio - Ctrl+Shift+K - FocusOther, See FocusOther
FocusOther Always Swap - Focus always switches to the other radio when one radio is
transmitting, and always switches back to the original radio when transmission is completed.
Toggle CTRLFx Macro - Ctrl+Shift+L - When enabled and present in one of the function key
definitions, the {CTRLFx} macro executes Fx (Function key definition x) on the opposite radio.
An example is TU{CTRLF1} in Radio 2's F3 slot, which sends TU and then sends the other
radio's F1, used to get quickly back to the Run radio and call CQ after finishing an S&P QSO
on Radio 2.
TX Lockout (Digital) - Select a lockout option. Also MIXED mode category is supported i.e.
blocks second TRX on the same band and mode. This doesn't prevent RX overload. For
digital modes only.

Multi-TX - This is the default setting. Start CQ on radio A, next a CQ on radio B, both
are active. (no lockout)
First one wins - Start CQ on radio A, pause, Start CQ on radio B. The radio B CQ is
ignored since radio A is already active, so if you press a F-key for the second radio while
radio1 is transmitting, the radio B F-key is ignored.
Last one wins - Start CQ on radio A (CQ starts), pause, Start CQ on radio B. The CQ
on radio A will aborted and the CQ on radio B will start so if you press a F-key for the
second radio while radio A is transmitting, the radio A transmission is interrupted and
radio B transmits.

Toggle SO2R Mode (Soundcard) - Ctrl+I - Used only with soundcard-based SO2R also
called "$5 SO2R"

15.22. WAE - Special commands for the WAE DX contest only

Toggle WAE QTC mode - Ctrl+Z - Toggle the WAE QTC mode between QSO and
sending/receiving QTCs. See Contest Setup Instructions .
WAE Received QTC Confirmation - Enter the WAE confirmation string or .WAV file

 

16. Window Menu Selections
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Available Mult's and Q's - Display the Available Mult's and Q's window. More info in the
Available Mults and Qs Window chapter
Bandmap Ctrl+B - Display the Bandmap window. In SO2R/SO2V each Entry window has its
own Bandmap window. More info in the Bandmap Window chapter
Check - Display the Check window. More info in the Check Partial Window chapter
CW Key Ctrl+K - Display the CW Key window. Pressing Ctrl+K again or Enter will close the
window but will continue sending the message. Pressing Escape will stop sending the
message. The windows is multiline (for pasting in text) and can be resized. The font type and
size is the same as used in the Entry Window

 

 

Digital Interface - Displays the Digital (RTTY/MMTTY/PSK) Interface window. In SO2R/SO2V
each Entry window has its own Digital Interface window (DI1 and DI2 respectively). More info
in the Digital modes chapters
Entry Window - Display the Entry Window
Gray Line - Open the optional to install Gray line program (only for Windows NT, 2000, XP or
newer). More info in the Gray Line chapter
Info - Display the Info window. More info in the Info Window chapter
Log Ctrl+L - Display the Log window (toggles between open and minimized). More info in the
Log Window chapter
Multipliers by Band - Display the multipliers by band window. More info in the Multipliers by
Band Dialog chapter
Packet - Display the Packet/Telnet window. More info in the Packet Window chapter
Score Reporting - Start the realtime score reporting application. More info in the Advanced
Functions chapter under Contest Reporting Application
Score Summary - Display the score summary window. More info in the Score Summary
Dialog chapter
Visible Dupesheet - Display the Visible Dupesheet window. More info in the Visible
Dupesheet chapter

 
Ctrl+Tab toggles between the Entry window and Packet windows. If other windows are added that
have text boxes, then they will be accessed in a round-robin basis via Ctrl+Tab.

17. Help Menu Selections

 

Help Alt+H - Show this help file. Note that pressing Alt+H in any window will show the help
specific to that window. You have to download the help file separately from the N1MM
homepage and copy the file into the directory that contains the Logger program. The Windows
Help file and Manual are maintained separately from the program and follow it as close as
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possible. So when checking for a new program version also check if a new version of the
Help/Manual is present. The revision number and revision date are shown on the first page of
the Help/Manual.
Search Help using Google (Internet) - Search help using Google on the Internet.
Key Assignments Help - Show this Key Assignments chapter of the help file.
Manual - Show the PDF version of the help file, this version can easily be printed. You have to
download the manual separately from the N1MM homepage and copy the file into the
directory that contains the Logger program. At that point, clicking on Help->Manual should
launch the Adobe Acrobat Reader and display the Manual.

 

Contest rules for this contest (Internet) - Go to the web site from the contest sponsor on the
Internet where the rules can be found.
ARRL Contest Calendar Page(Internet) - Go to ARRL contest calendar site on the Internet.

 

N1MM Logger Home Page(Internet) - Go to the N1MM logger Home page.
Download Help (English version) (Internet) - Download the Help file from the N1MM logger
Home page.
Yahoo Discussion Group (Internet) - Go to the Yahoo Discussion Group page on the
Internet.
Report Bugs/Request Features/Request Support(Internet) - Go to the N1MM logger web
site to report bugs or request features.
Email Problem Report(Internet) - Send a problem report by E-mail to Tom, N1MM. The
Report gives detailed info about the problem and some program (configuration information)
and computer information (speed, processor etc.). To send a report some questions must be
answered.

Long description of the problem
Enter your smtp server name. (Only first time)

Just check your e-mail program and look for the name of the outgoing e-mail
server that you use. Use that name for the smtp server name. Example:
smtp.freeler.nl

 

View Revision History (Internet) - Shows the revision history from the program on the
Internet.
View Revision History (last downloaded) - Shows the last downloaded revision history on
the harddisk. This avoids the need for an Internet connection.
View Error Log - View the latest 'Errorlog.txt' file generated by the program. The program
creates and updates the contents of this file when the program generates an error. This could
be used to help pinpointing a problem in the program.

 

Report Score to 3830 (Internet) - Go to the 3830 score reporting site on the Internet.

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

192 of 680 2/2/2011 4:54 PM



 

About N1MM logger Vx.x.xxx - Show the About Dialog. See Tom, N1MM's tower with a
Cushcraft X9 at the top!

 

Log

 
Your Log window will be similar to this one.

 

The top grid is the log
The bottom grid shows the contacts in yellow that match the partial or full call entered in the
Entry window. It is sorted by band, call, date & time.
The separator bar is set at a percentage of window size. When shrinking the window, both
sections get smaller. After resizing the window, decide how much space to allocate to dupes
by setting the separator bar.
The upper pane gives date and time (in UTC) and the selected contest.
When a Multi operator mode (Multi-One, Multi-Two, Multi-Multi) is selected:

The operator name is shown in the log window
The radio number is shown in the log window
Group edits are not allowed while in multi-user mode.
Editing a qso is only allowed from the station who did make the qso, not from other
stations.
A column will be added to the log window with Run1Run2

 
The relative sizes of the grids can be adjusted by clicking and dragging the gray bar between the

grids. The adjusted window size and the column width are saved by the program.
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In a serial number contest the serial numbers in the log window will be displayed without any
leading zeros even when zeros are entered before the number (like 001). When printing the leading
zeros will be added again and printed.

Keyboard Assignments

 

Enter - Edit the contact which is selected.
Delete (Ctrl+D) - Delete the contact which is selected.

 

Mouse Assignments

 

Left mouse button click
Single click on column title - Change log sort order using the selected column.
Second click on a column will sort descending.
Double click on a contact - Quick Edit the contact.

Right mouse button click
Right-click on a contact - Displays a menu:

Quick Edit Contact - Quickly edit the current contact using the Entry window
fields. Ctrl+Q moves back one qso, Ctrl+A moves forward one qso. If the textboxes
background in the Entry window are colored blue, you are in Quick Edit mode. To
exit, press enter to save changes or Escape to abandon changes. Quick Edit starts
editing with the highlighted contact and you can move forward or back from there.
Enter logs the changes made and Escape discards the changes bringing you back
in normal logging mode.
Edit Contact - Edit the contact.
Delete Contact (Ctrl+D) - Remove the contact from the log.
Play Contact - This selection will be gray, if there is no .WAV recording file for this
contact. If it is not gray, the selection can be chosen and the contact audio will play
on your default sound player. (Make sure you don't have the sound card hooked
up at that moment to your microphone!)
Jump to this frequency - Jump to the frequency logged with this contact
Graph Q rates up to this entry - For a historical display of rates from an existing
log with QSOs in it, the procedure is to decide the point at which you want to
examine your rate in the preceding 30 or 60 minutes. Highlight that point in the log
window, and then right-click. Look for the option "Graph Q rates up to this entry"
and click OK. That will open a new window, on which you can right-click for the
same options as in the real-time window.

 

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

194 of 680 2/2/2011 4:54 PM



 

Menu items:
The period

30 minutes / 60 minutes
The number of bars to show

6, 10, 15, 20
Raw QSO count
Hourly rate (Q's/hr)
10 min moving avg
20 min moving avg
30 min moving avg

 

www.qrz.com - Ask information about this station using www.qrz.com (name, address
etc.). An Internet session should be available.
Change All Contact Timestamps by a Fixed Amount -this will fix a log where all QSOs
are off by a common amount of time

Put mouse over log window and right click
Select 'Change All Contest Timestamps by a Fixed Amount'
Dialog box will open, and enter offset time (+ or -) in minutes
The date will automatically adjust if the offset rolls a QSO into a different day. The
time is entered in minutes, and can be a negative time to go backwards. (You
might need a calculator to determine the offset in minutes if your date was off by
many days, months, or years)
NOTE: While you can easily adjust for a mistake by doing another offset, it is
advisable that you backup your log before making any changes.

Change Operator - Change operator callsign for this contact (Multi-user). The default is
the station callsign. When selecting several rows, the change will be applied to all rows.
This operation is not reversible. See example picture.
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Change Mode - Change the mode for this contact. When selecting several rows, the
change will be applied to all rows. This operation is not reversible. See example picture
above.
Change Rx Tx Frequency (and band) - Change the RX and TX frequency for this
contact. When selecting several rows, the change will be applied to all rows. This
operation is not reversible. See example picture above.
Change Station Number - Change the station number for this contact (Multi-user). The
Master station always has number 0. When selecting several rows, the change will be
applied to all rows. This operation is not reversible. See example picture above.
Find all contacts with a station - Search a call (station) in the logged contacts from this
contest.
Set Start Interpolation Time Row - Set the start row and time from where the time
interpolation has to begin. An example how to use can be found in the chapter 'After the
contest'.
Set Stop Interpolation Time Row - Set the stop row and time from where the time
interpolation has to stop. This menu item is only highlighted when a start time has been
entered. An example how to use can be found in the chapter 'After the contest'.
Rescore from this point on - Rescore the contest starting with this logged contact till the
end of the log.
Delete custom column widths - Delete the custom column widths and go back to the
default column widths as set per contest (by the programmer).
Show Mode - Select or deselect showing the mode behind all other columns in the log
window.
Show Date - Select or deselect showing the date in front of the time (first column log
window).
Select All - Select all QSOs in the log (for copy and paste actions)
Copy

Copy Generic Print String - Copy generic print string to clipboard
Copy ADIF String - Copy ADIF string to clipboard

Set Font - Set the font for the Log window, a selection window will appear.
Help - Show the help file for this window.

 

Bandmap

In this Section...
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Bandmap
1. One radio scenario
2. Two radio scenario
3. Other
4. Colors of the incoming spots:
5. Keyboard Assignments
6. Button Assignments
7. Mouse Assignments
8. Example bandmap usage

Your Bandmap window will be similar to these.

 
The Bandmap Window represents a VFO or a radio. There are three scenarios: one radio with 1
VFO displayed (SO1V); one radio with 2 VFOs displayed (SO2V); or two radios with one VFO
shown for each radio (SO2R). The bandmap is made zoomable to the complete band size.

 

1. One radio scenario

 
With one radio in SO1V mode, only one bandmap can be displayed. With one radio in SO2V mode,
two bandmaps may be displayed,m one for each Entry window. Each bandmap holds one VFO.
Typically, VFO-A will be on the left and VFO-B will be on the right. If you want to change VFOs, just
use the mouse to click on one of the spots in the bandmap or use the Ctrl+left & Ctrl+right arrow
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keys to change VFOs. The radio information box at the top of the bandmap will change colors as
you change VFOs. The selected Bandmap or Entry window will have a blue top.

2. Two radio scenario

 
With two radios the operation is exactly the same, except that each bandmap represents one of the
radios. It is best if one orients the bandmaps in the same position as the radios, left-right or
top-bottom. This will make operation more intuitive.

3. Other

 

It is well worth your time to quickly review the Mouse Assignments below in order to become
familiar with the functions that the Bandmap provides.
Also important! The usefulness of the Bandmap is greatly enhanced by reading the Key
Assignments
The text CQ-Frequency will be shown on the bandmap when running stations. It is
automatically marked when you press the CQ-button (mostly the F1-key).

When a spot is less than three minutes old NEW will be placed behind the call and bearing in the
bandmap. When the station works split the receive frequency (QSX frequency) will be shown
behind the bearing after the spot is three minutes old, there is not enough room to give both NEW
and the QSX frequency. Splits are shown as 3 digits on HF. The bearing to a station is shown only
for stations outside your own country with exceptions for USA and Canada. When calculating the
bearing the section or state from the callhistory is being used otherwise the coordinates of the state
that is the closest to the middle of the callarea is used.

On the title bar of the bandmap you can see what type of radio is connected. It will show
Manual - A when no radio is connected or as an example Kenwood VFO A when a Kenwood
radio is connected. It will show a B for the other bandmap/VFO.
Normally only one frequency is shown in the top portion of the bandmap. This is the receive
and transmit frequency. When working split the transmit frequency is added and shown just
below the receive frequency in a smaller font.
Busted spots (calls with "BUST" in the comment) are not shown on the bandmaps (when
coming in via packet/telnet).
When both bandmaps are closed the frequency and mode is shown on the title bar of the
Entry window before the contest name.
During busy contests the default zoom is too dense. Use the right-click menu to zoom or use
the numeric pad +/- keys.
New calls will show up first in the bandmap, ahead of old calls on the same frequency.
A zone only multiplier will be shown in red (except "non-workables"). The exception means
that in CQWW, your own country will show as gray, even if it is a multiplier.
Country of unknown callsign (like TX5A in 2006) will be made equal to the prefix to force it to
be a new country.

Better a broken callsign then missing a multiplier.. If it is a broken callsign the user can
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delete the spot.
A sunrise/sunset indicator (Ãƒâ€šÃ‚Â¤) is shown for spots from stations where applicable.
CW Skimmer spots are marked with "#" in spotter's callsign as skimmer spot in the bandmaps
(see picture at right above). If spotter's callsign contains your (Station dialog) callsign, then
the spots are marked with a "!".

 

4. Colors of the incoming spots:

 

Blue: QSO
Red: Single Multiplier Example: CQWW - QSO is either zone or country multiplier (one
multiplier)
Green: Double or better Multiplier Example: CQWW - QSO is a zone and a country multiplier
(two multipliers)
Gray: Dupe
Bold - This is a self spotted call ('Stored' or by using the feature 'QSYing wipes the call &
spots QSO in bandmap') and is not coming from the cluster.

 

5. Keyboard Assignments

 

Mouse wheel - Zoom in or out the bandmap which has KEYBOARD focus.
Numeric keypad + key - Zoom In to show less spots from the bandmap which has
KEYBOARD focus.
Numeric keypad - key - Zoom out to show more spots from the bandmap which has
KEYBOARD focus.
Shift - Numeric keypad + key - Zoom In to show less spots from the bandmap which does
NOT have KEYBOARD focus.
Shift - Numeric keypad - key - Zoom out to show more spots from the bandmap which does
NOT have KEYBOARD focus.

 
Jump to Spots on active radio/VFO

Ctrl+Down Arrow - Jump to next spot higher in frequency.
Ctrl+Up Arrow - Jump to next spot lower in frequency.
Ctrl+Alt+Down Arrow - Jump to next spot higher in frequency that is a multiplier.
Ctrl+Alt+Up Arrow - Jump to next spot lower in frequency that is a multiplier.

 
Jump to Spots on non active radio/VFO
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Ctrl+Shift+Down Arrow - Jump to next spot higher in frequency on the inactive radio/VFO. This
will skip over CQ-Frequency when radios/VFOs are on the same band. Proper keystroke
operation is radio dependent. Disabled for SO1V.
Ctrl+Shift+Up Arrow - Jump to next spot lower in frequency on the inactive radio/VFO. This will
skip over CQ-Frequency when radios/VFOs are on the same band. Proper keystroke operation
is radio dependent. Disabled for SO1V.
Shift+Ctrl+Alt+Down Arrow - Jump to next spot higher in frequency on the inactive radio/VFO
that is a multiplier. If you are operating single mode, your mode won't change when jumping
between spots. Disabled for SO1V.
Shift+Ctrl+Alt+Up Arrow - Jump to next spot lower in frequency on the inactive radio/VFO that
is a multiplier. If you are operating single mode, your mode won't change when jumping
between spots. Disabled for SO1V.
Shift+Alt+Q - Jumps to your last CQ frequency on the inactive VFO/radio. Disabled for SO1V.

 

6. Button Assignments

 

Narrow/Wide - Toggle the radio filters from Wide to Narrow, or vice versa. The label indicates
the current state. The label is not shown for some radios (like FT-817) and manual radios.
CW/USB/LSB/RTTY/PSK/AFSK/AM/FM - Click this label to toggle from USB/LSB (band
sensitive) via RTTY to CW/PSK/AFSK/AM/FM (radio dependent).
RIT Offset (-0.08) - Click this label to clear the RIT offset.
RIT - Click this label to toggle the RIT on and off.
XIT - Click this label to toggle the XIT on and off.

 

7. Mouse Assignments

 
Left-click menu

Click on frequency - Jump with the active VFO/radio to that frequency.
Shift+Click on frequency (SO2R only) in Inactive Bandmap - Program the non active radio
without changing window focus. Allows you to be active and sending on one radio and change
the frequency on the non active radio without changing Entry window focus.
Shift+Click on bandmap callsign (SO2R only) in Inactive Bandmap - Same as Shift+Click on
Frequency with the addition that the callsign is placed on the non active radio's callsign frame.
Click on call - Jump to that frequency and place the call on the Entry window callsign frame.
When the callsign field is empty, giving space will copy the callsign from the Entry window
callsign frame to the callsign field. Also clicking on the callsign in the callsign frame will place
the call into the callsign field, replacing anything that was previously there.
Double-Click call - Jump to that frequency, place call into Entry window callsign field,
replacing anything that was previously there. Spots with 'Busy' in the call will be ignored
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(placed in the bandmap when using Alt+M).
Click dial ticks - Jump to that frequency.
Click frequency label - Jump to that frequency.
Right Click call - Display the right-click menu for the selected call (see Right-Click menu
below).

The selected call will be shown italic and underlined when right-clicking on it
Right Click anywhere else - Display the right-click menu with some options grayed out which
are call related.

 

Right-click Menu Options

If you right click in the Bandmap Window the right-click menu will appear. In the left-hand
illustration, the menu is shown as it appears when you click on the window, not on a particular spot.
The right-hand illustration shows how the menu looks if you right-click on a specific spot.
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Remove Selected Spot - equivalent to Alt+D with the spot callsign in the call-frame.
Blacklist callsign - if you click on this option, then subsequent spots of that station will not be
displayed on the Bandmap or in the Available window. Used to get rid of busted spots that
recur often, such as LW3LPL. To edit the list of blacklisted spots, or to remove a call from the
list, use the Right-click menu in the Packet/Telnet window.
Blacklist all spots from spotter - designed in particular for use when an RBN station is feeding
spots that are badly off-frequency (due to I/Q image problems) or otherwise defective. Could
also be used for the occasional harasser on traditional DX clusters. Again, the blacklist can be
edited from the Packet/Telnet window.
Zoom In (Numeric Pad + or Ctrl+Scroll wheel if using a mouse.) - Show a wider frequency
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range on the Bandmap that has entry/RX focus.
Zoom Out (Numeric Pad - or Ctrl+Scroll wheel) - Show a narrower frequency range on the
Bandmap that has entry/RX focus.

 

Go to Bottom of Band - Go to the bottom of this SSB/CW subband.
Go to Top of Band - Go to the top of this SSB/CW subband.
Remove Spots, This Band Only, Leave Self Spots
Remove Spots, This Band Only
Remove Spots, ALL BANDS, Leave Self Spots
Remove Spots, ALL BANDS
Show Last 10 Spots - click this option (which is gray unless a callsign has been clicked on)
and the cluster will be asked for the last 10 spots of that station. These are displayed in the
Packet/Telnet window.
Show Buck/Packet - requiests address information from the DX cluster
Show Station - sends the SH/STA [callsign] command to the DX cluster
Show QSL/Packet - sends the SH/QSL [callsign] command to the DX cluster
Show Sunrise/Sunset - sends the SH/SUN [callsign] command to the DX cluster
Show Buck/Internet - opens QRZ.COM in your default browser for manual entry of the
callsign.
Show Buck Local - opens a call-sign database installed on the same computer as N1MM
Loggerl
Set transceiver offset frequency - This is for transverter supporting transverters. The
transverter offset is saved when the program closes and read again when opened. Remember
to enter the frequency of the transceiver and not that of the transverter when going into split
mode (Alt+F7). Information how to fill in this table (which frequencies to enter and how to
calculate the IF frequency) can be found in the chapter 'VHF and Up contesting'.

 

 

Set transceiver timeout time - Timeout value for each radio (default is 10 seconds). Entering a
value of zero will disable the timeout. Entering a negative number will set the time out value to
10 seconds. Entering a number that is too large for the program variable will set the timeout to
the program maximum. The positive minimum is 5 seconds.
Set transceiver filter codes - You will be prompted for the wide or narrow string to set the

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

203 of 680 2/2/2011 4:54 PM



filters. For Kenwood, it's pretty easy. You just look up in your manual the string you want and
enter it. For other radios, like FT-1000MP, its harder. You must enter a series of space-
delimited codes in DECIMAL. Therefore, when an FT-1000MP filter code of 0 0 0 0 8C is
required, you must enter 0 0 0 0 140 (8C hex).

To reset to the default values in the program enter a space and press the OK button. It is possible
to use {CR} in the filter codes which will be replaced with the return character. These selection are
disabled when manual radio is selected (i.e. no radio selected).

CW Wide
CW Narrow
SSB Wide
SSB Narrow
Digi Wide
Digi Narrow

Bring to foreground when made active - This brings the active bandmap to the foreground.
When not having enough real estate on the monitor screen it is possible to place both
bandmaps on top of each other. The active bandmap will be shown hiding the non-active
bandmap.`
Reset Radios - Allow manual reset all attached radios. When contact with a radio is lost the
dialog below will appear. Select 'Retry' to restore the connection with all attached radios or
Right-Click on the bandmap and choose "Reset Radios" to restart the connection.

 

 

Packet Spot Timeout - Indicates how long (in minutes) spots are kept in the Bandmaps. The
default is 60 minutes, any integer may be specified. For use with the Reverse Beacon Network
(RBN), a very short timeout (10-15 minutes) is recommended to avoid overloading the program
with the spot volume.
Why don't I see spots? (Show packet filters) - Click and a window will open showing the
current spot settings in effect.
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Help - Show the help file for this window.

 
Note icon

When a command is sent to the packet window, it is sent to whichever connection is active.
Note icon

When the connected cluster is a DXSpider cluster, select on Tab: Other in the Configurer 'Format
for DX Spider cluster'.

Hovering with the mouse over a spot

Hovering with the mouse over a spot in the Bandmap gives the following info about the spotted
station:

Exact frequency sent by spotter.
Callsign of spotter.
The time in minutes since the station was placed on the DX cluster network.
Comments sent with the spot.
The 'standard' country prefix from the spotted station

 
Hovering with the mouse over RX arrow
Hovering with the mouse over the RX arrow shows the frequency.

8. Example bandmap usage

 
by Tom, N1MM

In Search & Pounce (S&P) the callframe will show you each spotted station as you come within
"tuning tolerance" (user settable) of that station. I'm terrible at remembering whether I worked a
station and on what frequency. With worked stations in the bandmap, the program will tell you that
they are not workable again. You can tune by them more quickly. The same feature is useful in
contests with unworkable stations.
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In a contest like CQ WPX, with (basically) no value multipliers, here is how I use the bandmap.
Whenever I can't get a run going I start S&P on a band with a lot of unworked stations (use the
available window). I use Ctrl+Up and Ctrl+Down arrow to go to the next station. If that station is at
the beginning of a QSO, I move to the next one. If the QSO is near the end, I wait and work the
station. Then I move on. If I reach the top of the band, I start coming back down the band, working
the ones I missed on the way up. If there is no station at a frequency, that's my new running
frequency!

In contests with valuable multipliers, you should use Ctrl+Alt up/down to get the multipliers first,
then go back and get the QSOs.

If the rate drops fairly low, sweep the band using your VFO. That is where the old calls in the
bandmap come in useful. If you copy a call, but it seems like it is going to take a long time to work
him, tune to the next guy. If you have "QSYing wipes the call & spots QSO in bandmap" turned on,
the call will be spotted in bold, so you can Ctrl+Up/Ctrl+Down to him later.
Remember: if a call is in the callframe, space will load it into the call textbox.

If all this seems very unfamiliar, you haven't read the Key Assignments help (and/or the Key
Assignments Shortlist).
Reading that single item is your single best time investment in using this program.

Spots and the time shown

When you hover with the mouse over a spot in the bandmap, it will show the relative age of a spot
in minutes. The time shown here depends on the spot format. There are two formats for spots. One
is for current spots, one is for SH/DX spots. Some clusters allow to show old spots in the current
spot format. The program handles the two types of spots differently.

Current spots go into the bandmap with the computer's local (converted to UTC) time. This is
to remove variations in cluster times and order the spots into the time they were received.
Old spots are logged with the originating cluster's time with the provision that it cannot be
later than the current local (UTC) time.

 
With AR-Cluster you can display old spots with SH/DX or SH/FDX. It is recommended to use
SH/DX, as it will be recognized as an old spot. Other cluster software may have similar capabilities.

Red lines indicating US license frequencies

On the bandmap there are red lines to indicate extra, advanced and general portions of each band.
Since US hams can operate only in their section and the sections of lower class licenses, it is in
your interest to operate some in the higher portions of each band. Otherwise there are some US
hams you will not ever be able to work.

The lines can be found on:

SSB: 3775, 3850, 7225, 14175, 14225, 21225 and 21300.
CW: 3525, 7025, 14025 and 21025.
No lines on 160 and 10 meters.
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Packet and Telnet

In this Section...

Packet and Telnet
1. Colors used
2. Initial Button Assignments
3. Keyboard Assignments
4. Mouse Assignments
5. Right Click Menu

5.1. Packet Filters
6. Special keys:
7. Macro keys
8. How to add/edit/delete a Telnet cluster
9. How to setup and connect a Telnet cluster
10. How to setup and connect to a Packet cluster using a TNC
11. Auto connecting to a cluster
12. Spotting stations
13. Multi-User setup
14. Computers on a LAN
15. Packet via the soundcard
16. Supported Packet clusters:
17. CW Skimmer and the Reverse Beacon Network (RBN)

Your Packet/Telnet window will be similar to this one, with Packet and Telnet tabs. The former is
used only when connecting to an RF packet cluster node. Unless specifically differentiated,
references in this manual to packet also apply to Telnet. For example, "Packet Filters" and "Packet
Spot Timeout" also apply to Telnet.
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The button values can be changed by right clicking on them or going into the menu: 'Config >
Change Packet/CW/SSB/Digital Message Buttons > Change Packet/Telnet Buttons'.
Connect and other messages are shown in the bottom pane from the Entry window. Status info for
Telnet is given in the Telnet window title. Focus is set to the Entry window when one of the 12
buttons is clicked.

All incoming DX spots are placed on the bandmaps. Also the spots requested with commands like
SH/DX etc. Split information given in the spot comment will be recognized. When such a spot is
selected the transceiver will go into split mode (if applicable). The program recognizes: UP, U,
DOWN, DN, D and the word QSX. Examples: QSX 3.838, QSX 4, UP 5, DOWN 2, U 5, D4, U4,
DN4, UP4, DOWN4, QSX7144 etc.
Where possible mode, state/section, grid etc. are extracted from comments on incoming spots. Grid
square from spot comment is used to calculate bearing reported in Bandmap, Available window,
Info window and Entry window.

When telnet is selected a Telnet DX-cluster can be chosen from the top of this window. By clicking
the 'Close Port' button the current connection will be closed. A telnet cluster can be updated in the
configurer dialog (Tab: Hardware).

Packet/Telnet has a nine minute stay-alive function which sends a CR every nine minutes (not
configurable). The timer is restarted when you send a message to the cluster.

1. Colors used

 

Blue - 'Normal' incoming spots
Red - (Talk) Messages
Magenta - WWV messages
Black - All other messages like cluster welcome messages, SH/DX responses, messages sent
to the cluster, prompts etc.

 

2. Initial Button Assignments

 
Below are the default button assignments for the Packet/Telnet buttons. A maximum of 12 buttons
are available for packet and Telnet. Adding more lines in the edit window will not lead to more
buttons (12 is a fixed value). The contents and texts shown on the buttons can be changed to
anything you like.

Button
text

Command Description Packet Telnet

BYE BYE Log off cluster OK OK
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CONN C PE1M-7 Connect to the (non telnet) packet cluster. Example: C
PE1M-7 You have to set your cluster's call under 'Tools
>Change Packet Buttons'.

Connect -

DI/N DI/N Show new messages (CLX needs the full: directory/new) OK OK

SH/DX SH/DX/30 Show last DX spots OK OK

USERS SH/U Show cluster users OK OK

WWV SH/WWV Show WWV spots OK OK

10M SH/DX/30
10

Show last 10M spots OK OK

15M SH/DX/30
15

Show last 15M spots OK OK

20M SH/DX/30
20

Show last 20M spots OK OK

40M SH/DX/30
40

Show last 40M spots OK OK

80M SH/DX/30
80

Show last 80M spots OK OK

PA1M {MYCALL} Connect to the Telnet DX cluster by sending your call to
the Telnet cluster. Most Telnet clusters expect your
callsign as the first text received. The callsign used with
the macro {MYCALL} is taken from the station information
dialog

- Connect

 

Close Port - Close the current Telnet connection.

 

3. Keyboard Assignments

 

Ctrl+C - Sends Ctrl+C to the TNC which is used by TAPR TNC's.
Ctrl+Z - Sends Ctrl+Z to the TNC which is used by TAPR TNC's.
Shift+Escape - Places an Escape character on the command line which is send to the TNC
after pressing Enter. The Escape character is being used by WA8DED/ TF firmware TNC's.

The Packet/Telnet window must be active and the cursor must be on the command line.
N.B. The Escape key (without the Shift key) makes the Entry Window active.

4. Mouse Assignments
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Left mouse button
Single click - Tune the active radio to the frequency of the spot.
Shift+click - Tune the inactive radio to the frequency of the spot.
Double click - The spot under the cursor will be placed in the callsign field in the Entry
window and gets focus.
Ctrl+Single click - Tune the non-active radio to the frequency of the spot and make it
active.

 

Right mouse button - Displays a menu - see below

 

5. Right Click Menu

 

Why don't I see spots? (Show packet filters) - A window will open showing the current
spot settings in effect.
Configure Ports, Telnet Address, Other - Displays the 'Configurer' dialog.
Edit Telnet Cluster List - Displays the 'Change Packet Cluster List' dialog. Here you can

If you click on a spot that has a QSX (listening) frequency given, your radio is under program
control, and your radio can accept split commands, then the required QSX will be set.

Split operation
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add, edit or delete telnet cluster sites.
Change Packet/Telnet Buttons - Change the label and contents of the packet/telnet
buttons. Note that the use of '&' in the Button Caption will cause the following lettered
key to become a "Alt+Hotkey."
Close Port - Close the packet or Telnet connection (depends on the selected Tab)
Specify Comment for All Spots - Enter the text you want appended to every spot. Lasts
for the session only. Exit clears it. Example: PACC
Auto logon - Automatically connect to a cluster when the program starts. When running
Telnet, auto logon will send the right-most button (which by default contains the
{MYCALL} macro). When running packet, auto logon will press the second button: "C
call". When running both, only the one that was in focus the last time before closing the
program will be re-started.
Packet Spot Timeout - Indicates how long (in minutes) spots are kept in the Bandmaps.
The default is 60 minutes, but any integer may be specified.
Remove Packet Spots, Leave Self Spots - Remove all spots coming in via packet or
Telnet but leave all self spots in the Bandmap.
Remove all spots - Remove all spots from the Bandmaps. This means that also all
information on the Available Mults and Q's window is cleared.

5.1. Packet Filters

 

Allow HF - When selected all spots on the HF bands ( < 30 MHz) are passed to the
Bandmaps. See note below.
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Allow WARC - When selected all spots are passed to the Bandmaps from the WARC bands.
See also note below.
Allow VHF - When selected all spots on the VHF bands (> 30 MHz) are passed to the
Bandmaps. See note below.
Allow spots from my country only - When selected only spots originated from your own
country will be shown in the Bandmaps and Available window. See note below.
Allow spots from my continent only - When selected only spots originated from your own
continent will be shown in the Bandmaps and Available window. See note below.
Allow only spots from specified call areas - When selected only spots originated from specified
call areas will be shown in the Bandmaps and Available window. See note below. The spots
can be specified at the next menu item. A call area is the country prefix + the first number in
the call. Example: Call: WB1KK Call area: K1 (K + 1)

Enter call areas) - Call area filter for the menu item above. Enter list of call areas to pass
separated by spaces. Example: K1 K2 K3 K4 and select the OK button. To clear the list
enter only a space and press the OK button.

Allow spots for this contest's mode(s) only - Only allow spots where the mode is equal to the
mode set in the contest setup.

When the mode is mixed the selection will be anything "not digi".
Filter Blacklisted Packet Spot Calls - Used to block spots of specific calls from being added to
the bandmap. Could be used to filter out persistent busted spots.
Edit Packet Spot Blacklist - Just what it sounds like, for adding to or deleting from the list of
blacklisted spot callsigns
Filter Spots from Blacklisted Spotters - For use any time you do not want to receive spots from
a particular spotter. For example, if an RBN station's receiver were to be severely off
calibration, you could opt to block spots from that station rather than chase phantoms all
weekend.
Edit Spotter Blacklist - Again, just what it sounds like. Add or delete spotters whose spots you
wish to be blocked.
Change Subbands for mode filter - These are the definable band edges. The frequencies
added (in kHz) are used for the specific mode. Note that no band edges are defined for
Digital. What you will want to do for digital is add say 7060 7090 for band edges. That range
will show as magenta in the Bandmap. If you click in that area and you are following the band
plan , then the mode will change appropriately. Make sure you have the desired mode control
defined in the config dialog ('Config | Configure Ports, Telnet Address, Others | Tab: Mode
Control | Follow band plan (default)'). The bandplan is computed as follows: Is it Digital? If
not, is it CW? If not then is it SSB.

Note: The default US bandplan is used by the program. Non-US stations have to make changes to
that bandplan. An example is 40 meters for Europe where the CW part of the band is mostly much
smaller.

Change CW Bands - The band 7000 to 7035 is set as CW (Europe), the frequencies
above are automatically set to SSB if no digital sub bands are set.
Change SSB Bands - The sub bands for SSB , if nothing is set this is the default mode.
Change Digital Bands - The sub bands for the digital modes

Set Font - Change the font of the Packet/Telnett text boxes. Fixed fonts (like Fixedsys,
Courier, Anadale Mono which has slashed zeros etc.) are recommended, so that columns will
line up.
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Copy - Mark a part of the Packet/Telnet window with the left button, then right-click and
choose copy. The selection will disappear before you choose copy, but that doesn't matter.
You can then paste the selected area into Word or Notepad or whatever you like.
Help - Show the help file for this window.

 
Note: Allow spots and Allow HF/VHF/WARC filter settings.
These settings have nothing to do with what shows in the Packet/Telnet window. They are not
commands to the DX cluster, instead telling the program whether to use the spots in the Bandmaps
and the Available window.
Clear spots will take all the spots that appear in those two windows and delete them. It does
nothing to the Packet/Telnet window. The spots shown in the Packet/Telnet window itself will not be
filtered; you would have to do that at the cluster node. Learn your cluster's filtering commands. This
is the best way to accomplish what you want.

6. Special keys:

 

Ctrl+key - Holding the Ctrl key while clicking in the packet window will jump the non-active
radio to that frequency and make it active

 

7. Macro keys

 
Macro key substitution is supported by the buttons in the Packet window and also in the comments
send with a spot (using Shift+F9).
The macros which can be used and some examples can be found on the macros page.

In the substitutions you can include things like {CTRL-M}. There is also a {WAIT} macro that waits 5
seconds and macros for {GRIDSQUARE}, {MODE}, {ZONE} and {QTH}.

So if you needed to press CTRL+M, then wait for a prompt, then C PE1M-7 then enter your callsign,
you could change the button to send:

{CTRL-M}{WAIT}C PE1M-7{WAIT}PA1M

Enter is sent automatically after each command. This may cause a problem with some systems.

8. How to add/edit/delete a Telnet cluster

There are three places where you can get to the 'Change Telnet Cluster List' dialog. Select one of
them.

Right click in the "Packet /Telnet window" and select 'Edit Telnet Cluster List' or
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Select 'Config | Change Telnet Cluster List or
Select 'Config | Configure Ports, Telnet Address, Others | Hardware tab' and click on the 'Edit'
button.

 
The 'Change Telnet Cluster List' dialog will appear. You can go to the bottom of the list and add
what you want. Look at the already entered Telnet clusters to see what to enter. To delete a row,
click on the row "handle" - the gray arrowhead - and press the 'Delete' button on your keyboard. To
edit an entry select the field to update and enter the new information.

9. How to setup and connect a Telnet cluster

 
1. Add the Telnet address to 'Config | Change Telnet Cluster List'.
NB. Use gb7ujs.shacknet.nu as a model for how to specify a port other than 23.
2. Click on the Telnet tab in the Packet/Telnet window.
3. Choose the address to use from the drop-down box left from the button "Close Port".
4. To connect, click on the F12 button with your callsign in it.
*This presumes that the cluster you are using is looking for your callsign as the first thing to be sent
(which it usually is).
5. Now you should be connected to the cluster.

10. How to setup and connect to a Packet cluster using a TNC

 
1. Click on the Packet tab in the Packet/Telnet window.
2. Set up the connect string for your local packet cluster under the F2 (Conn) button.
3. Click on the F2 button (Conn).
4. Now you xhould be connected to the cluster.
*In general, setting up the connect string and the possible use of intermediate relay nodes to reach
the cluster causes most problems..

11. Auto connecting to a cluster

 

Set up your packet or Telnet to the cluster, to connect as explained above
Right click in the Packet/Telnet window text area and select Auto Logon in the men:
From now on the program will connect to the selected cluster automatically when the program
starts
Auto Logon works only at program startup.

Button 1 or button 12 is sent to the cluster, depending on whether you are using packet
or Telnet.

There is a "stay-alive" timer that sends a CR every 9 minutes.
If the connection drops spontaneously, you will have to re-connect manually.
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12. Spotting stations

 
Spotting stations has to be done from the Entry window. The station entered in the callsign field will
be spotted. If the callsign field is empty the last qso made will be spotted.

Alt+P spots stations.
Ctrl+P spots with a comment.
Spot all S&P QSOs under 'Config'.

 
The frequency from the spotted station is rounded to one decimal place by the program.

13. Multi-User setup

 
When running in Multi-user mode (more computers connected in a network) only the Master station
has to be connected to the DX-cluster. The master station will send all information from the cluster
to all connected computers and also send info received from the connected computers running
N1MM logger to the DX-cluster.

14. Computers on a LAN

 
It is possible to connect to Telnet hosts when the Internet connection is on a LAN via proxy server or
router. First try to access the Telnet cluster via the Telnet program in Windows, if this works it
should also work from within N1MM logger. It does not matter if the proxy is in software or hardware.
Port 23 (=telnet) should be open.

15. Packet via the soundcard

 
Many hams use AGWPE for packet using the soundcard. N1MM logger is not able to direct use this
package but there are ways using additional software to get N1MM logger and AGWPE work
together. Basically you telnet from inside N1MM to either of these applications. They are in turn
linked to AGWPE. Links to these programs can be found in the links section.

TelMgr by LU7DID
Telnet interface by IZ4AFW

 

16. Supported Packet clusters:

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

215 of 680 2/2/2011 4:54 PM



 

AR-Cluster by AB5K
Clusse by OH7LZB (not fully supported, only incoming spots)

To make Clusse more compatible give the command SET/PCMODE YES (typed in
uppercase).
Only incoming spots will be decoded by N1MM logger (not the response to the List
command)
The List command (SH/DX) has a different format and will not be decoded.

CLX by DJ0ZY and DL6RAI
DX-spider by G1TLH

DX-spider uses a different SH/DX format, check in 'Configurer / Other' the setting
'Format for DX-spider support'. This will send the right SH/DX message from the button
in the top of the bandmaps.

DXnet by F5MZN (Unknown if fully supported but it probably is)
PacketCluster by AK1A
Wincluster Lite by KH2D
More?

 

17. CW Skimmer and the Reverse Beacon Network (RBN)

 
CW Skimmer version 1.1 and up has a built in Telnet server which allows N1MM Logger to receive
spots from it. Add an entry to your Telnet list with the address: 127.0.0.1:7300 if you are running
Skimmer on the same machine as N1MM Logger. If running on a different PC on the same network,
use that machine's internal IP address in the same format.

The Reverse Beacon Network's Telnet server (telnet.reversebeacon.net:7000) makes all of the
RBN's Telnet spots available to the program. Because of the huge volume of spots on a major
contest weekend - at least ten times as many as the conventional cluster network - we highly
recommend that you use the Telnet server's filtering capabilities to manage the quantity actually
sent to you. The server uses the DXSpider software, which has very flexible filtering capabilities. It
will be helpful to use a short Packet Spot Timeout (set on the right-click menu of either Bandmap) -
15 minutes should be more than adequate, because CW Skimmer re-spots stations that remain on
the same frequency every 10-12 minutes.

Skimmer spots can be merged with spots from conventional DX clusters using software such as
WintelnetX, freeware by K1TTT. In that case, Skimmer spots are distinguished from regular spots
by the addition of unique markers. In the Bandmaps, Skimmer or RBN spots are identified with "#"
after the callsign and bearing; spots from your own Skimmer, identified by the callsign set in your
Station Data), are marked with "!"

Check
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In this Section...

Check
1. Features
2. Colors of the callsigns
3. Keyboard Assignments
4. Mouse Assignments:
5. Wildcard search

1. Features

 

The Check window displays all the callsigns from the MASTER.DTA file and worked calls from
the current log, which match the input in the callsign field of the Entry window.
The Check window is not cleared until a character is typed in the callsign field in the Entry
window, so clearing the callsign field won't clear the Check window.
All callsigns are shown in upper case.
In order for the Check window to be active, there must be a valid master.dta file in the
program file directory. A variety of such files may be downloaded from this site . For
example, master.dta files are available comprising only US and Canadian callsigns. The
master.dta file used for a given contest is selected on the Associated Files tab of the Contest
set-up window.

 
The title bar shows Mul: or Q: followed by the band.

2X: - This station would be a Double Multiplier on this band (this country and zone)
Mul: - This station would be a Multiplier on this band (country, section, etc.)
Q: - This station would be a new QSO on this band
Example: Mul: 15 20 Q: 160 80 40 10 - This station would be a new Multiplier on 15 and 20
meters, or just a new QSO on 160, 80, 40 and 10

Note: For the title bar to operate correctly, the "Available Mults and Q's" window must be
open.

The Check window is divided into two areas:

Upper area: callsigns found in this contest log
QSOs made in this contest

Lower area: callsigns found in the selected master.dta file
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When the program is started
and no callsign is entered the
Check window will show the
date, time and length of the
MASTER.DTA file.

When the master.dta file for the
selected contest is not found or
missing a warning will be given,
Use 'Download latest Check
partial file (Master.DTA)
(Internet)' under 'Tools' to
download the file from the
Internet

 

When there are no matches
found Unique will be shown in
big red letters

When the station entered is a
dupe it will be shown in black
and the text Dupe! will be added
in red

 

On this window's right-click menu, shown above, there is the option to select "Show N+1 calls." If
this option is checked, callsigns will be shown that are one letter or number different from the
callsign entered in the Entry Window, as in this example. This can be very helpful when listening
under difficult conditions where you are not sure of the callsign.

When a callsign entered matches a call in the log, the callsign in the Check partial window will
be set to bold and 12 point font (PA1M below).
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Entering PA1M in the callsign field will give PA1M, PA1MR, PA1MV and all others with PA1M in
the callsign (picture below left). When N+1 is selected also all callsigns with one character
difference will be shown (picture below right).

 

N+1 not selected PA1M entered in Entry window N+1 selected

No QSOs match the entered call
in the log so the window starts
with a blank line. When a
callsign matches the master.dta
file or the log it will be set to
bold and 12 point font
(Example: PA1M)

When N+1 selected,PA1K is
found in the log and many more
callsigns differing by only one
character are found in the
master.dta file. The differing
character is shown bold

 

2. Colors of the callsigns

 

Blue New contact on this band

Black Dupe contact or a station in a non-workable location.
This means that you don't need this station because he is a dupe or you are not allowed to
work him by the contest rules.

 

3. Keyboard Assignments

 

Alt+Y - will "yank" the first call from the Check window into the callsign field of the Entry
Window that has the entry focus.

 

4. Mouse Assignments:
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Left mouse key clicking on a callsign in the listbox
Click on call - Enter the call into the callsign field on the Entry window replacing
whatever was there.

When clicking on a call with spaces, only the first token will be loaded as callsign
Right mouse key clicking, a menu will appear

Show N+1 Calls - show all callsigns with one character difference from the callsign
entered in the Entry window callsign field. The different character will be shown bold.
Set Font - Set the font for the Check Partial window, a selection window will appear.
Help - Show the help file for this window.

 

5. Wildcard search

 
If one or more characters are not known a ? may be used in the callsign field in the Entry Window.
It needs two sequential characters like N?MM or N1? to find the call. So M?M will not work!

Searching for leading wildcards is also implemented. I.e. ?1M matches KN1M as well as N1MM.
N+1 will do this automatically for one ? im place of each expected character in the call.The use of
two question-marks is also allowed, for example ??1M

Examples:

PA?M will match PA1M, PA7MM etc.
P?1M will match PA1M, PG1M, PF1MO etc.
P?3 will match no callsigns because there are no two sequential characters
?1M will match N1MM, KN1M, PA1M etc.

 

Available Mults and Qs

 

In this Section...

Quick Tour (a must read!)
Step 1. Setup
Step 2. Adjust Window Positions
Step 3. Connect the Sound Card and the CW interface
Step 4. Entering a Call
Step 5. Using the Space Bar to Tab

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

220 of 680 2/2/2011 4:54 PM



Step 6. Using the Tab Key
Step 7. Bandmaps, Spots and Other Cool Stuff
Step 8. Spots are Fun
Step 9. Actually Logging Contacts
Step 10. The Exciting Finale
Step 11. CW and WAV Recordings

Installing and Upgrading N1MM Logger
1. First-Time Installation Instructions
2. Using the Program the First Time
3. Subsequent Install Instructions / Upgrading to a New Program Version
4. Uninstalling the Program

Setting up the Program
1. Setup Station Information
2. Setup Radio Control
3. Setup Packet/Telnet
4. Setup PTT-ing the Rig/Sending CW
5. Setup WAV Files (SSB)
6. Sending Messages in CW
7. Setup 'Sent Exchange'
8. Setup the Exchanges
9. Setup Function Keys for Enter Sends Message (ESM) mode
10. Command Line Parameters

Basic Functions
1. Help
2. Going Through the Entry Window Fields
3. Resizing Windows
4. Select New Contest
5. Delete Contest
6. Select Country file
7. Select Master.dta file
8. Changing Frequency
9. Changing Band
10. Changing Mode
11. Changing Operator
12. Setting CW Speed
13. Split Operation

13.1. Setting Spit Frequencies Manually
13.2. Setting Split Frequencies Automatically by Packet Spots
13.3. Resetting to non-split mode
13.4. Split Operation Key Assignments

14. Running Mode
15. Search and Pounce Mode (S&P)

15.1. How to check if you are in Running mode or in S&P mode?
16. CQ Key
17. Set up the Sent exchange message(s)
18. Function Key Conventions
19. Set Up N1MM to Record and Playback Voice Recordings (recording on the fly)
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19.1. Playing WAV Files
19.2. Recording WAV Files
19.3. Soundcard Control in Configurer

20. Quick Edit
21. Meaning of Colors
22. Multipliers and QSOs
23. Connecting to a Telnet Cluster
24. How to Save the Log
25. Function Key Macros
26. Save and Restore Window Positions
27. Editing Lookup Tables
28. Backup and Restore

28.1. Method 1: Full backup/restore on same computer - backup and restore
the whole N1MM logger subdirectory
28.2. Method 2: Partial backup/restore on same computer - make a partial
backup and restore.
28.3. Installing on a Different Computer

29. Basic Functions for RTTY
Advanced Functions

1. Mobile/Rover Support
1.1. How Mobile/Rover Works

2. Call History Lookup
2.1. The Call History Text File

2.1.1. Menu options
3. Spot Filtering
4. Transmit on same band with two radios
5. Big Gun versus Little Pistol switch

5.1. So you are a big station
5.2. So you are a little pistol

6. Staying in Run Mode (great for Dxpeditions) or in S&P mode
7. Auto Send
8. Enter Sends Messages (ESM) Mode

8.1. Basic ESM Functionality
8.2. How to Prevent the Cursor from Moving to the Next Exchange Field
8.3. How to Skip Sending the Callsign or Exchange Field (SSB)?

9. QSYing Wipes the Call & Spots QSO in Bandmap
10. Single Operator Call Stacking

10.1. Additional SOCALLSTACK Information
10.2. Digital Call Stacking
10.3. How to Tell Visually Which Call Will be Put in Next

11. Call Stacking (same or different bands) - Multi-User Mode
12. Serial Number Server
13. Contest Reporting Application
14. Starting a Contest with a Number Other Than 001
15. Single Operator 2 Radios (SO2R)
16. Footswitch Support

Configurer Dialog
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1. Configurer >Hardware tab
1.1. Hardware setup
1.2. Set button examples
1.3. Other Information
1.4. Windows NT/2000/XP (32 bit OS)

2. Configurer >Telnet Cluster tab
3. Configurer >Files Tab

3.1. Files Field Descriptions
4. Configurer >Function Keys Tab

4.1. Function Keys Field Descriptions
4.2. Remapping Function Keys

5. Configurer >Digital Modes Tab
5.1. Digital Modes Field Descriptions

6. Configurer >Other Tab
6.1. Other Tab Field descriptions

7. Configurer >Winkey Tab
7.1. Winkey Field Descriptions
7.2. How to Set Up Winkey in N1MM Logger

8. Configurer >Mode Control Tab
8.1. Mode Control Field Descriptions

9. Configurer >Antennas Tab
10. Configurer >Audio Tab

Start a New Contest Log or Open an Existing Contest Log
1. Start a new contest log
2. Open an Existing Contest Log
3. Contest Specific Information

3.1. Contest Tab
3.2. Tab: Associated Files

Entry Window
1. Button Assignments
2. Callsign/Exchange Editing Features
3. Other Info
4. Status Bar Information
5. Callsign Colors
6. The Red and Green dots (LEDs)
7. The Entry Windows
8. Other Features
9. Function Keys

9.1. General
9.2. Running mode and S&P mode

10. Other Keys
11. File Menu Selections
12. Edit Menu Selections
13. View Menu Selections
14. Tools Menu Selections
15. Config Menu Selections

15.1. Configure Ports, Telnet Address, Other - Also called Configurer.
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15.2. Change Your Station Data
15.3. Change Sub Bands
15.4. Clear INI file settings
15.5. Find all windows (move to within 800 *600)
15.6. Enter Sends Messages (ESM mode)
15.7. AutoSend Threshold - Ctrl+Shift+M
15.8. Spot all S&P QSOs
15.9. QSYing wipes the call & spots QSO in bandmap
15.10. Do not run on CQ-frequency
15.11. Show non-workable spots
15.12. Reset Rx freq when running split
15.13. Dual Rx always on
15.14. CQ Repeat - Alt+R
15.15. Set CQ repeat time - Ctrl+R
15.16. Call History Lookup
15.17. Record QSOs
15.18. Change Packet/CW/SSB/Digital Message Buttons - Alt+K
15.19. Multi-User Mode
15.20. Change Exchange Abbreviations
15.21. SO2R
15.22. WAE - Special commands for the WAE DX contest only

16. Window Menu Selections
17. Help Menu Selections

Bandmap
1. One radio scenario
2. Two radio scenario
3. Other
4. Colors of the incoming spots:
5. Keyboard Assignments
6. Button Assignments
7. Mouse Assignments
8. Example bandmap usage

Packet and Telnet
1. Colors used
2. Initial Button Assignments
3. Keyboard Assignments
4. Mouse Assignments
5. Right Click Menu

5.1. Packet Filters
6. Special keys:
7. Macro keys
8. How to add/edit/delete a Telnet cluster
9. How to setup and connect a Telnet cluster
10. How to setup and connect to a Packet cluster using a TNC
11. Auto connecting to a cluster
12. Spotting stations
13. Multi-User setup
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14. Computers on a LAN
15. Packet via the soundcard
16. Supported Packet clusters:
17. CW Skimmer and the Reverse Beacon Network (RBN)

Check
1. Features
2. Colors of the callsigns
3. Keyboard Assignments
4. Mouse Assignments:
5. Wildcard search
Available Mults and Qs

1. The Header
2. The Band Buttons
3. Spot List Box
4. Band button Assignments
5. Band button background colors
6. Mouse Assignments
7. Right-Click menu
8. Multi-mode contests

The Available Mults and Qs window for single-mode contests is similar to this example (beginning
with release 9.12.5).
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This window consists of three parts, the header, the band buttons and at the bottom the multiplier
list box.

1. The Header

 
The header shows the number of Available Multipliers and QSO's. (Example 4 Mults 12 Qs), and
also reports on some of the right-click menu items that may affect what happens when you click on
a spot. See below for specifics.

You will note that this window does not appear to have the entry focus except when you have right-
clicked to access the context menu to change the window's settings. This is as designed, because
keyboard/mouse click focus should normally be on the Entry Window. Nonetheless, mouse clicks
on band buttons and individual spots will be acted upon, as outlined below.

2. The Band Buttons

 

The top part of this window indicates the number of multipliers (left column) and potential contacts
(right column) available on each band. The two numbers in the right column reflect the number of
workable (non-dupe) QSOs available, and the total number - the latter is useful to determine
relative band opening quality in a contest, like Sweepstakes, where late in the contest you may
have worked most of the active stations. For example, the right column might display "2/47",
indicating a wide-open band but with only two stations you have not already worked.

Red numbers indicate the band with the largest number of contacts (QSOs) available. The WARC
bands only appear when DX (the default general logging contest) is the active contest. A VHF
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version will appear when a VHF contest is selected.

For a contest such as FD that allows HF and VHF, the lack of band buttons for VHF+ means (i)
there will be no available spot totals displayed for the VHF+ bands; and (ii) there is no single click to
QSY to VHF. You must either type in a frequency or QSY the radio manually to get to a VHF+ band.
Even though the HF button set is shown, VHF spots that are workable in a particular contest will
still appear in the lower pane of the available window (and on the band map); like other spots, those
VHF+ spots are clickable to QSY (assuming radio support).

 
Each of the band buttons changes color when a callsign is entered in the callsign field or, in the
case of contests where the multiplier cannot be determined from the callsign, when the exchange is
copied. The color (green, red, blue or none) denotes whether that station is needed on that band as
a double multiplier (green), a single multiplier (red), a valid non-duplicate QSO (blue) or not needed
(none). The intention is to let you know whether you need that current station's multiplier on other
bands, so that you can move him if you wish.

The active band's button text is shown in bold.

3. Spot List Box

 
The list box (the lower section of the window) shows spots received via Packet or Telnet. There are 4
columns: Call, Frequency, Bearing (Dir), and Time (TS) in the format "mm-dd hhmm". Clicking on
the selected column title will sort the column, clicking again will reverse the sort order. An indicator
of split spots (a "Ã‚Â±") appears next to frequency. Spots coming from a local Skimmer are shown
with a (!) to the right of the bearing, and those from a non-local Skimmer with (#).A sunrise/sunset
indicator (a "Ã‚Â¤") is shown to the right of the bearing for spots where applicable, as an aid to
determining which spots may either be "perishable" or particularly suited to a gray-line QSO.

The color codes described are applied to each call listed; however, duplicate QSOs are not
displayed.

4. Band button Assignments

 

Left click on band button - Set the left radio or VFO-A to the first spot on the band specified.
Right click on band button - Set the right radio or VFO-B to the first spot on the band
specified.

Note: When both Entry windows are open on the same band (in SO2V), then clicking on
a call will bring this call to the window without transmit focus. Select the correct
radio/VFO by right or left clicking the band button. You should not be able to select the
same band on both radios in SO2R, unless you deliberately do it on the radios' front
panels. For obvious reasons, this is not a good idea,
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5. Band button background colors

 

Blue: Available QSO
Red: Single Multiplier. Example: CQWW - QSO is either zone or country multiplier (one
multiplier)
Green: Double or better Multiplier. Example: CQWW - QSO is a zone and a country multiplier
(two multipliers)
Gray: Dupe

 

6. Mouse Assignments

 

Left mouse key clicking on a callsign in the list box
SO1V

Single Left click - Always send the spot to VFO-A.
Shift + Single Left click - No action.

SO2V + set for "Basic VFO Selection" (set in the Right-Click menu explained below)
The selection Basic VFO Selection" or "Advanced VFO Selection" can be set/seen
in the right click menu.
When set for "Advanced VFO Selection" the window title tells you the setting of
this option.

Single Left click - Send the spot to VFO-A.
Shift + Single Left click - Send the spot to VFO-B.

SO2V + set for "Advanced SO2V VFO Selection" (set in the Right-Click menu explained
below)

Single Left click
If both VFO's are not on the spot band, send the spot to the Active VFO. The
spot VFO Entry Window and Bandmap wil be made active.
If either VFO is on the spot band, use the VFO which is on the spot band
checking the active VFO first. The spot VFO Entry Window and Bandmap wil
be made active.

Shift + Single Left click - reverse the VFO selection determined above.
SO2R + set for "SO2R Focus Follows Spot" (set in the Right-Click menu explained
below)

The radio that the spot is sent to will be made active if "SO2R Focus Follows Spot"
is checked. If the option is un-checked, the window focus will not change.
Single Left click
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If both radios are not on the spot band, send the spot to the inactive radio.
If either radio is on the spot band, send the spot to that radio.

Shift + Single Left click - Reverse the VFO selection determined above if the
selection will not place both radios on the same band.

Double click - Go to the frequency with the active VFO. The callsign on which you have
clicked is placed in the callsign field in the Entry window overwriting anything that was in
there!

Left mouse button clicking on column title
Toggle the sort order of the spot list between ascending and descending based on the
column selected (Call, Frequency, Bearing (Dir), Time (TS).

7. Right-Click menu

 
The following screen-shot shows the right-click menu effective with version 10.8.0

 
If you right click in the Available Window these menu items will appear. Not all menu items are
always selectable.

Delete Spot - Delete selected spot from the list of spots. This option is only selectable when
you right-click on a call-sign in the lower list box.
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Advanced SO2V VFO Selection (radio dependent) - Determines the SO2V single left click
behavior on a spot in the bandmap. See the details above. The option is grayed out when
SO2V isn't selected and the window title tells you the setting of this option. Added because
not all radios will work with the Advanced setting.

 

Enable right click QSY on spot - When checked a right click on a spot will cause the inactive
radio or VFO to be programmed without changing the Entry window focus. If a split spot is
selected in SO2V mode, the TX frequency will not be programmed because it will change a
potential RUN frequency. When this occurs, a message is printed at the bottom of the Entry
window. Right clicking on a spot in SO2R mode that would place both radios on the same
band is ignored. This option needs to be unchecked to allow spots to be deleted or the rotor
to be turned from the Available window. This option is grayed out, not available in SO1V
mode.
SO2R Focus Follows Spot - Determines the SO2R single left click behavior on a spot in the
bandmap. See the details above. The option is grayed out when SO2R isn't selected and the
window title tells you the setting of this option.
Turn Rotor - Turn rotator to bearing for selected callsign

 
The remaining options operate at all times. Note that none of the following options affect the
contents of the bandmap(s). Only the list of calls in the Available window will change.

Show Q's_Mults - toggle between showing all spots or just multipliers
1 - Show Focus Radio/VFO - Show only spots on the band of the VFO or Radio which has
entry focus.
2 - Show Non-Focus Radio/VFO - Show only spots on the band of the the VFO or Radio
which does not have entry focus.
3 - Show Both Radios/VFOs - Show spots on the bands of both VFOs or Radios.
4 - Show All Bands - Show spots on all bands.
160 - Show only 160 meter spots.
80 - Show only 80 meter spots.
40 - Show 40 meter spots.
20 - Show only 20 meter spots.
15 - Show only 15 meter spots.
10 - Show only 10 meter spots.

 
Beginning with version 10.8.0, this menu permits setting of spot filters by mode. The options are:

All Modes
CW Mode
SSB Mode
RTTY Mode
PSK Mode
Contest Mode Category
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Only one of these options can be selected at a time. The first three are self-explanatory. Since
many spots The program distinguishes between RTTY and PSK spots based on the Comments
field in the spot - BPSK, PSK31, or any other word containing "PSK". If "Contest Mode Category" is
selected, the program will only display spots in the Available window that conform to the Contest
Mode Category selected in the Select Log Type dialog (also called the Contest Setup dialog).

.

 

Help - Shows this section of the manual from the web site. Internet required

 

Hovering with the mouse over a spot in the list will show a tooltip with more info about the spot
(frequency, spotter, time, comments)

8. Multi-mode contests

 
Beginning with version 10.7.2, this window will display one column of band buttons for each mode
in multi-mode contests. Operation is otherwise similar to that in single-mode contests. If the
contest's rules specify that multipliers only count once per band, the colors of both modes' buttons

There are three levels of spot filtering available. The first of these is at the DX cluster node,
using whatever filtering capabilities are built into the node. Because N1MM Logger stops
processing telnet messages when CW is being sent, users who are connected to a very high
volume node, such as the Reverse Beacon Network's Telnet node, may find it advantageous to
block some of the less useful spots (for US users, you might not want spots from VK, for
example).

 
The second level of spot filtering is accessible from the right-click menu of the Packet/Telnet
window, and decides which spots received from the cluster node should be forwarded to the
Bandmap and the Available window. If too many spots are forwarded, depending on how fast
your computer is, you may encounter brief delays in execution of commands (such as sending
of CW messages) while the program catches up, so it is probably a good idea to use some
filtering at one or both of these levels.

The third level of filtering is in the Available window, and it only governs which spots are shown
in the window's lower pane. For example, if you decide only to list CW spots, the bandmaps will
continue to display all spots, and the top pane of the Available window will continue to display
overall spot numbers for each band, but the lower pane's list of spots will contain only CW
spots. You can quickly switch back and forth between showing all spots, just those on the
current band, only CW or SSB or digital spots, or any other band/mode combination.

Filtering notes
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for that band will change in unison; if multipliers count once per band and mode, then the band
button colors will show the status, as described below, on each band/mode combination.

 

 

Edit Contact

 
Your Edit Contact Dialog will be similar to this one.
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This screen gives the possibility to update contacts after they have been logged.
The fields 'Country Prefix', 'Mult 1' and 'Mult 2' can't be updated because they are recalculated after
each contact update.

In this Section...

Edit Contact
1. Button Assignments
2. How to permanently delete a contact?
3. How to recover a deleted QSO?
4. Why move and not delete?

The following modes are allowed to be entered in the 'Mode' field:

CW, CW-R, LSB, USB, RTTY, rtty-L, rtty-U, RTTY-R, AM, FM, PSK31, PKT, PAC2, GTOR, FSK31,
PSK31, PSK63, PSK125,
MT63, DIGI, BPSK, bpsk, SSTV, mfsk-L, mfsk-U, MFSK, MFSK8, MFSK16, HFSK, MTTY, THRB,
ASCI, HELL, Q15, PCW.

To what country the program assigns a contact doesn't really matter, except for the *claimed* score.
The assigned country does not appear in Cabrillo. You are not penalized for an incorrect claimed
score.

The main reason for tracking down these things is for better information about what countries are
needed during the contest.
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When a contact has been updated and you are moving on to the next/previous qso with the up or
down arrow keys the following screen will be shown.

 

Yes - Save the changes made and move on to the next or previous qso in the log.
No - Don't save the changes made and move on to the next or previous qso in the log.
Cancel - Go back to the qso which has been changed but not saved.

 

 

1. Button Assignments

 

Update - Update the log entry and exit the dialog returning to the last qso in the log.
Delete - Removes a log entry from the current selected contest and exits the dialog returning
to the last qso in the log.

When pressing the deleted button in a contest the following message will appear:
Yes, will move the qso to the DELETEDQS 'contest'
No, will cancel deleting the qso.

 

When the program doesn't allow you to log a contact the way you want it, log it as the program
expects it and edit the contact in this screen.

 

Example: A KG4 station calls and gives a state as exchange, this KG4 is in the USA. The
program expects this KG4 to be in Guantanamo Bay and doesn't allow entering a state but
wants a number. Enter a number which the program expects and edit the contact in this screen.
Of course you have to update CTY.DAT to add the KG4 station so this won't happen again. See
the Tips and Tricks section how to do this. Make a note using Ctrl+N so you can update the qso
later.

Updating the timestamp from a qso can be done from within the Entry window callsign field.
Entries starting with "T" and four numeric digits will update the current row time in the log.
Check out the chapter 'After the contest' for more information.

Tip
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When using multi-user mode it is only possible to delete a qso made on the station
which made the qso.

Message: "You may not delete contacts logged by another station while in
Multi-User mode. Ask station #radionumber to delete it. Delete not performed!"

Help - Show the help file for this window.
Exit - Exit this dialog without updating the log entry.
Up Arrow - Go to the next entry towards the beginning of the log. Updated log entries can be
saved.
Down Arrow - Go to the next entry towards the end of the log. Updated log entries can be
saved.

 

2. How to permanently delete a contact?

 

Delete one QSO
Select a qso to delete in the log window

When pressing the deleted button the following message appears:
Yes, will delete the qso permanently from the DELETEDQS 'contest'
No, will cancel deleting the qso

It is not possible to select more than one qso and delete them. Deleting has to be
done per qso.

 

 

Delete all QSOs
Select the DELETEDQS 'contest'

File, Open Log in database, Select the DELETEDQS 'contest' in the 'Select
Existing Log' dialog.

Delete the "DELETEDQS" contest by pressing the 'Delete' key. It will reappear with no
QSOs.

A confirmation will be asked.
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3. How to recover a deleted QSO?

 
This is not easily done. A possibility is to export the 'DELETEDQS' contest. Then import it into the
contest from which it was deleted (ADIF). Before or after exporting you have to remove all the QSOs
which you don't want to have imported. Always backup everything first.

Open the DELETEDQS contest in the database.
Left click on the contact you want to restore, then right click, select 'Copy/ADIF String'.
Open the contest you want to paste it into.
Right click in the log window and select 'Paste contacts'.

 

4. Why move and not delete?

 
A deleted contact in a contest is not permanently deleted but moved to the 'contest' DELETEDQS.
This way a qso can be recovered when accidentally deleted. Permanently deleting the 'deleted'
QSOs can be done in the 'DELETEDQS' contest. The technical reason to put the QSOs in another
contest is that Access does not free space until you compact. It doesn't do any good to delete a
qso, so why not just move it?

Info

 
Your Info window will be similar to this one.
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The info window can be found in the Entry Window dialog under the menu 'Window | Info'.

In this Section...

Info
1. General
2. Mouse Assignments
3. Rate information section
4. Buttons
5. Real Time graphical rate display
6. Setting a goal for the contest
7. Setting the QSO numbers
8. Multi-User information

8.1. General
8.2. Mouse Assignments

1. General

 
The following information currently appears in this window:

Own callsign and Sent Exchange (statusbar)
The next QSO number will be shown on the title bar if it is a serial number contest.
Example: Exch: 59 002
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*

Callframe spot (line 1) - Info from spot from bandmap
CountryInfo (line 2 & 3) - CallCountry, Zone, Continent, Bearing (short path), Distance (miles
& km), Bearing (long path)

From the station in the call window, or if nothing is there, the call in the call frame.
If there is nothing in either, it shows the last info that was displayed there.

Sunrise/Sunset(line 4) - Sunrise/sunset times, Local time
Local time is not shown for K, VE, UA and VK because of the multiple time zones in
these countries.

*

Messages (line 5) - Packet spot information, packet talk messages (appear in red)
WWV Messages (line 6) - WWV statistics
Rates Section

Rates (left)- Rate information /goal information (colors) / band change information
The band change information and the band timer are hidden when Single operator
or Multi-multi are selected.
Real Time graphical rate display
Import and setting Goals button

Graph (middle) - shows graphical information regarding qso count, hourly rates or
moving averages per 30 or 60 minutes.
Record level indicator (middle) - for recording QSOs. For this indicator to show 'Record
QSOs' under the 'Tools' menu must be on.
Info section (right)

Callsign of the operator in lower right corner (bold). Set with Ctrl+O.
Band change counter (contest and section dependant)
band timer (contest and section dependant)

 

Band Chgs - Band change counter (only shown in certain contests and Operator Category
dependant )

10 min band timer - 10 minute band timer. Counts down after band change.
The band change timer does not start until the first band change of the contest.
The band change counter has a "stop light" (red/yellow/green) colored background.

Mult-Run indicator - Shows MULT or RUN when Multi-One or 1 or 2 when Multi-Two selected
Shown only when Multi-User and Operator Category = Multi-One
Multiplier or Run station can be toggled with key combination Ctrl+Alt+M

 

Multi-User Section - Multi user information (more information below)
Only shown when Multi-User Mode is selected.

 

Messages Section
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Computer name, IP-address and port info when in multi-user.
Winkey version info
Messages between stations have a big font so that multis would easily see messages to
each other.
Pass frequencies > 100000 kHz will be shown without decimals.
When you are being spotted on a cluster this will be shown in the message area
including spotter and comment. Nice to know ;-)
More..

 

2. Mouse Assignments

 

Right-click in most parts of the window - Clicking on an item will select or deselect showing
the selected information. Someparts have a menu of it's own.

Callframe spot - Show country and spot info from the station on the callsign field frame
NOT the callsign in the entry window but in the callframe above the callsign field!

CountryInfo - Show country info from the station in callsign field
Sunrise/Sunset - Show Sunrise/sunset times, Local time from the station in the callsign
field.
Messages - Show packet talk messages
WWV Messages - Show the WWV messages
Rates Section - Show the rates section
Multi-User Section - Show the multi-user section
Help - Show the help file for this window
Clear Message Window - Clears the message part of the Info window

 
When Multi-User Mode is selected, clicking on a red or green icon in the Multi-user part of the
window will give an extra menu. See the Multi-User information below.

3. Rate information section

 
The rate information is shown on the middle part of the info window. Dupe QSOs are included in
the count. A zero rate will be shown as a blank.
Shown is the following information.

Left part
Top of rates frame - QSOs per multiplier info ( x mult = y.y Q's)
Last 10 Q's - Rate last 10 QSOs (QSOs per hour)
Last 100 Q's- Rate last 100 QSOs (QSOs per hour)
Since hh:mm - Rate one hour back in GMT (QSOs per hour)
Since hh:00 - Number of QSOs since the start of the current clock hour
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Middle part
Real Time raphical rate display (middle) - see information below.
Record level indicator (middle) - for recording QSOs. For this indicator to show 'Record
QSOs' under the 'Tools' menu must be on.

 

Right part
Band Chgs - Number of band changes since beginning of the contest for multi-single
operators.

Resets to 0 at top of hour and is free.
Counts band changes for each computer only if in Multi-Two
Band changes are not counted if the worked station on the other band is a
multiplier

xx min band timer - Count down timer from xx minutes to 0 which starts after the first
logged qso after a band change.

NB There is one band change counter and it works for the Run station. The
multiplier station will have to keep track of changes manually.

 
Background colors rate information

The background colors change depending on the goal you have set for this contest.

Red - < 50% of goal
Yellow - < 51-99% of goal
Green - 100+% of goal

 

4. Buttons

 

Import Goals - Use this button to import hourly rates from the current contest to be used as
goal. If the contest you want as a goal is not the current contest, open it, then set the goal.
Import Goals will import a text file created by Print to File in View, Statistics.
Goal = - Manually edit the hourly rate goals to be used in this contest. Hours should be from
0-23. If an hour is missing the next lower hour will be used.

 

5. Real Time graphical rate display

 
The purpose of the graph is to provide tactical data to a contester or team lead, to allow quick
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decisions on band changes, antenna selection, etc.

As such, the intention is to visualize small changes in ==relative== Q rates over short periods.
There is no scale information on the graph for getting a sense of raw numbers (assumption
being that the numeric rates on the Info window are better at providing exact numbers). For
current data, the graph does show the current hour's goal as a black line, again to provide an
at-a-glance sense of how things are progressing.
Some values are selectable (via right-click) for graphing.

The period shown can be either 30 or 60 minutes.
The graph can have 6, 10, 15, or 20 bars.
Each bar can represent the raw Q count for that timeslice, the hourly rate, or a
moving average over the last 10, 20, or 30 minutes.

The bars show rates for just this station. In the case of a single SO2R station, the bars show
radios 1 and 2 in different colors, stacked, to show each radio's overall contribution. For multi
operations, the rates of other stations are not displayed, nor are the contributions of other
operators at this station displayed differently.
Since the graph is intended to be updated in (almost) real-time, the feature set is intentionally
minimal. The code draws the graphs one line at a time - this yields very dull graphics, but
does not require any additional DLL files or controls, and runs well for me on an older, slower
PC.
The real-time graphical rate display has options accessible by right-clicking on the graph area.
This display will not show anything until you start making QSOs in your current log.
The horizontal line is the goal value marking line.

 

6. Setting a goal for the contest

 
Most people want to make each year more QSOs than the year before. So for most of us that is our
goal!

It's always nice to know what number of QSOs you had last year so you can see where your weak
spots are. If this information is not available or you think these numbers are wrong (to low?) set your
own! You can set the number of QSOs you want to make on an hourly basis and the program will
show them on the 'Goal = ' button.

If you have the contest from last year available you can import the number of QSOs and adjust
afterwards if necessary.

The only difference importing QSOs from a previous contest is what database you have loaded in
N1MM logger during setup of the goal numbers. If you have the previous contest (from last year)
loaded the program will calculate the QSOs per hour and display them. These numbers can be
updated to set a new (higher) goal.

7. Setting the QSO numbers
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You can set the number of QSOs per hour.

 

Select button 'Import Goals' on the Info window. Selects the bands to import using a previous
contest log or a text file.

Import Bands
Select bands to import for the selected contest

Choices are: All, 160m, 80m, 40m, 20m, 15m and 10m
Log - Import from a previous contest Log

Load or have loaded the previous contest (mostly from last year) in the program.
Use 'Choose a File' and select in the database the contest you want.
Select a contest in the selected database using 'Select Contest'.
Another type of contest is allowed to get some figures and hours imported.
Have an empty contest loaded or make a new contest with 'File, Open Log in
Database'.

Text File - import goal from a text file
Text file can be either a whitespace delimited file (.txt) or a comma separated file
(.csv).

User selects which file type in the Choose a File dialog box.
Contents of the text file are: 1st field/column is the day/hour as dhh, 2nd
field/column is the all band houtly rate.
For importing goals by band, 1st field/column is the day/hour as dhh and the
subsequent fields/columns are the hourly rate on 160, 80, 40, 20, 15 & 10.

Select button 'Goal ' on the Info window. A screen will appear where you can enter the QSOs
to make per hour. If you have not imported a contest the dialog will be empty otherwise it will
be pre-filled.

Goals need to be in the form of dhh, where d is 1, 2 or 3, and hh is from 0-23.
The hh is the Z time for the first, second or third *calendar* day of the contest. d is the
calendar day number starting with 1. ARRL Sweepstakes starts on Saturday at 2100z, so
the first hour goal would be for 121. The last hour starts at 0200z on Monday, so the
goal would be set for 302. With the other change made, these rates can be extracted
from other contests in other databases, avoiding the necessity of first loading the
contest, extracting the goals and then reloading the current contest. Now you can just
choose the database and contest to use for your goals.
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The goals can also be set manually, using the scheme above. Note that goals hold for
the hour they are set, and each subsequent hour until a new goal is set.
Example below: 112 means day 1 and 12 UTC. The last line is day 2 and 09 UTC.

 

 

 

8. Multi-User information

8.1. General

 
In the bottom part of the Info window all information needed during contesting is displayed. See the
picture below.

 

Green or Red station icon
Green means connected
Red means not connected, and the other computer is being actively polled. Users may
experience delays and stutters in this state.
Blue means not connected, and the other computer is not being actively polled. The
connection will be automatically reestablished when the other computer becomes

The goal is set per database and not per contest in the database, so it is not possible to set
different goals for more contests in one database. For some, another reason to use a separate
database for each (major) contest.

Tip
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reachable. Users will not experience delays and stutters in this state.
Light Red means that the program has not been able to contact the other machine for a
while.

This is a transient state, and the program will try to solve this problem, if it returns
to green, then everything is ok.
At startup it is not an issue. If during a contest, with lots of RF, this might mean
you have RF in your network cables.

Right clicking on these icons brings up a menu
Station

Name from the station as entered under 'Config / Edit Station Computer names'
Pass frequency

Frequency where the station likes to receive it's passed stations.
Pass frequencies > 100000 kHz will be shown without decimals.

Run
Selected means running
Not selected means he is Searching & Pouncing

Operator
Who is operating the station
This call will change to red while transmitting

Last 10
Rate information from the station over last 10 QSOs

Last 100
Rate information from the station over last 100 QSOs

Current Freq
Operating frequency
Mode indication like CW, SB, FM (only when in Mixed mode)

*

8.2. Mouse Assignments

 

Right-click on the red or green station icon - opens a menu window.

 

Call for Help - On the selected station the following message will be shown: "Station x needs
assistance". This way an operator can call for assistance without leaving the chair by sending
a message to another (operating) position. The file "Assist.wav" from the program directory will
be played on the target station.
Help - Show the help file for this window.
Send Message - Send a message to this station. The message will be shown in the Info
window from the selected station and appears in red.
Target for Call stacking - The stacked callsign will be put on the 'stack' for this station. See the
Entry Window for more information about call stacking.
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Pass current/last QSO - Pass the current qso in the Entry window or the last qso when the
Entry window is empty to this station.
Show Status - Show status of all connections. See image below (no connection set up here).

 

 

Close Connection - Close the network connection from this station.
Open Connection - Open the network connection from this station (only selectable when dot is
red).
Prevent Automatic Reconnect Attempts - Prevent automatic reconnect attempts every 30
seconds by the program.

 

Score

Here are three examples of the Score window, which is formatted automatically when you select a
contest.

CQWWSSB PACC VHFREG1

 

In this Section...

Score
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1. Mouse Assignments:

The Score Summary dialog displays the score for the current contest with the points that have been
achieved by band (as a single band entry). Totals for points, multipliers and score are shown. The
dialog can be found under the Window menu item. The scores are updated when contacts are
added/deleted.

The first and last example pictures above are single mode contests (SSB), the example in the
middle is a mixed mode contest and where necessary the modes will be shown by band. The points
are shown in the caption of the dialog.

1. Mouse Assignments:

 

Right mouse click, a menu will appear
Copy all - Copy all info to the Windows clipboard.
Print to file - Print the score summary to a file.
Help - Show the help file for this window.

 
Note:The number of contacts shown on screen and printed on the summary sheet are after duping.

Multipliers by Band

Your Mults by Band Dialog window will be similar to these.
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In this Section...

Multipliers by Band
1. Keyboard Assignments
2. Mouse Assignments
3. Radio Button Assignments
4. Colors

This dialog gives a band by band breakdown of worked and wanted countries/zones/sections
(contest dependent) per continent when Country is selected. Each continent has it's own Tab, the
last Tab gives a total for all bands. In the title bar the number of worked and the total of possible
countries/zones/sections is shown. The Multipliers by Band dialog can be found under the
Multipliers item under Windows. A scroll bar at the bottom is added for convenience.

The blocks shown can be bands or modes depending on the contest. The number of shown blocks
depends on the selected contest and selected mode (CW, SSB, Mixed).

In most contests all multipliers are shown (like countries, sections etc.). There are a few contest with
many possible multipliers to much to fit in the multiplier window. In that case (like IOTA contest) ony
the multipliers worked are shown (and when starting the contest the Sect or Other tab shows an
empty dialog and every new multiplier will add a line in the dialog.

If unknown sections are logged they will be shown under the callarea "UNK".

The number of blocks shown per band depends on the 'Mode category' which can be found
on the tab 'Contest' under 'File>Open Log in Database dialog.

CW, SSB, RTTY - will give one block per band
MIXED - will give two blocks per band

white = CW, gray = SSB
The bands shown depend on:

The selected contest, each contest has its own default which mostly will be the 6 HF
bands.
The setting of the band filter box in the Multiplier by Band dialog.

A combination of the Band filter box and the Mode filter box gives many possibilities.
Mode filter Auto means that it uses the 'Mode category' which can be found on the tab
'Contest' under 'File | Open Log in Database dialo'.

Examples:
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Bandfilter: Auto Mode filter: Auto
default per contest, mostly the 6 major HF bands (160 80 40 20 15 10)

Used in all major contests like CQWW, ARRL DX etc
Single mode contests (CW or SSB)

2 blocks - possible CW and SSB (mixed mode contests)
Used in contests like ARRL 10 meter etc.
White = CW, Gray = SSB
Mixed is selected

 

Bandfilter: HF+WARC Mode filter: SSB
9 blocks - all 9 HF bands (160 80 40 30 20 17 15 12 10)

 

used in contests like DX etc.

 

Bandfilter: HF+WARC Mode filter: Mixed
18 blocks - 2 blocks per band for all 9 HF bands (160 80 40 30 20 17 15 12 10)
used in contests like DX etc.

 

Grid square overview
Shown when a VHF or up contest is selected
Clicking on a grid will center the window on that grid
The own station gridsquare will be shown in white/dark green

 

1. Keyboard Assignments

 

Ctrl+J - Toggle through the Countries, Zones, Sections & Other windows
When the Multiplier window is not open, it will be opened.

Ctrl+Shift+J - Opens or minimizes the Multiplier-by-band window
Ctrl+Alt+J - Toggles through continents.

 

2. Mouse Assignments
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Left-click on multiplier/abbreviation

Click on the abbreviations and it will populate the Entry Window exchange filed with the
correct syntax. It will overwrite the current exchange so be careful!
It will only work for contests where Exchange1 is used for the county or section, which is
many contests, but not all.

Right-click in the window - a menu will appear
Show Zones/Countries :

Countries selected: Shows the zone for a selected country.
Zones selected: Shows the countries in the selected zone.

Show Calls Worked - Shows all calls worked in this country or zone, or in this county
(QSO parties only).
Set Grid center - Shows a dialog in which you can enter the desired grid square (4
digits long) on which to center the grid square view (grid square contests only).
Help - Show the help file for this window.

 

3. Radio Button Assignments

 

Country - Show the countries worked for the band chosen.
ZN - Show the zones worked for the band chosen.
Sect - Show the sections or states worked for the band chosen.
Other - Show the other possible multipliers worked for the band chosen.

in VHF contests a Grid square overview will be shown.
Auto - Band filter

Auto - Shows the bands for the selected contest (mostly the major 6 HF bands)
HF - shows all 6 major HF bands
VHF - shows all VHF and up bands (50 MHz and up)
HF + WARC - shows all HF bands
All separate bands - 1.8, 3.5, 7 .... up to 241 GHz

Auto - Mode filter
Auto - Shows the mode as selected for the chosen contest (CW, SSB, Mixed, Digi)

one block per band when a single mode is selected
two blocks per band when Mixed is chosen as 'Mode category' which can be found
on the tab 'Contest' under 'File | Open Log in Database' dialog'.

CW - shows only CW contacts (one block per band)
SSB - shows only SSB contacts (one block per band)
Dig - shows only Digital contacts (one block per band)
Rev -when not in a single mode contest this button selects the other mode (SSB versus
CW) (one block per band)

Reset - Resets the two filters to Auto
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4. Colors

 

White - You need this one, work 'em.
(light) Red - Worked country, zone, section or grid square.

 

Statistics

 
Statistics can be found under View > Statistics in the Entry Window.

 

In this Section...

Statistics
1. General
2. Button Assignments
3. File Menu
4. Example statistics

1. General

 
The statistics window has the possibility to select almost all database fields from a contest in the
row or column side of the statistics table. Many different statistics can be made this way. The
database fields to select from are tabulated below.

Fields Row Column Remarks

Band Y Y

Operator Y Y compare operators, only useful when running Multi-operator

Hour Y N

RadioNr Y Y only useful when using more than one radio

Mode Y Y useful in mixed contests

During a contest, if you are checking Statistics and a station comes back, just start typing. The
statistics window will go to the background and every typed characters will go to the Entry
window.

Tip
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CountryPrefix Y N worked number of stations per country or mode

Zone Y Y

Section Y Y used in many domestic or local contests - may equate to province,
oblast, ARRL section, etc., depending on the contest

CK Y N 2 digit number used in Sweepstakes, formally denoting the year first
licensed

Prec Y Y "Precedence" used in Sweepstakes to denote class of entry

Points Y Y

Mult1 Y Y multiplier, or first multiplier in contests with more than one

Mult2 Y Y Second multiplier in contests with more than one

Mult3 Y Y Third multiplier where applicable

WPXPrefix Y N prefix as determined by WPX rules

GridSquare Y Y 4-character of grid square

Run1Run2 Y Y useful when doing SO2R

MiscText Y N Contest specific information

ContactType Y Y Blank = qso, "D" = dupe, "N" = non-workable station

Day Y Y first or second day of the contest

Mult & Band Y Y

Exchange1 Y Y Use in some contests (like WAE to show QTCs)

 

 

2. Button Assignments

 

Row - Select a row field.
Column - Select a column field.
Refresh - Refresh the contents of the table. The statistics are not automatically updated when
a contact is logged/changed/deleted.

The statistics window is refreshed when changing contests.

 

Old contests may not have valid values in fields that have been added since the contact was
logged. The number of contacts shown on screen and printed on the summary sheet are
without dupe contacts.

Note
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3. File Menu

 

Print - Print the statistics table to a printer. Font can be set by user.
Print to File - Print the statistics table to a file.

 

4. Example statistics

 
Here are some examples|

Row Column Usage Description

CountryPrefix Band Always QSOs per country per band

Hour Operator Multi User QSOs per hour per operator

Band Operator Multi User QSOs per band per operator

GridSquare Band Grid contests QSOs per gridsquare per band

Band Exchange1 WAE and some other Show RQTC & SQTC info

 

 

Visual Dupesheet
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Example Visual Dupesheet

 
The Visual Dupesheet is a quick way to determine if a station is a dupe without having to enter the
callsign in the program. The calls already worked will be indexed much like a paper dupesheet that
is organized by callarea and suffix. The Visual Dupesheet is especially useful for short, high speed
contests like the NA Sprint. It is closely patterned on the Visual Dupesheet used by TR Log.

Each VFO/Radio/Bandmap has its own Visual Dupesheet. The VFO/Radio A sheet displays all
of the contacts for the band VFO/Radio A is on. VFO/Radio B does the same for whatever
your VFO B/Radio is set to even if you don't (or cannot) use VFO B.
The columns signify call areas. If a call area exceeds the number of calls that will fit it will
overlap into an adjacent column with some dash lines to differentiate.
Each call area is sorted by suffix.
To see the dupe sheet for any band, set your radio to that band.
To check for a dupe, first look for the call area column, then look up the suffix, then the prefix.
If you don't want both windows open, close one, position the other where you want it and then
use Tool > Save Window Positions. The next time you start the program only one window will
open.
Unless you can copy RTTY in your head, you do not need the Visual Dupesheet for RTTY
contests. Obviously RTTY calls will tell you they are dupes or not as soon as they print.
The Visual Dupesheet can hold a maximum of 800 stations per band. Going above this limit
will give a warning . Depending on computer speed and configuration, users may experience
noticeable delays when using the Visible Dupe Sheet with logs containing more than 300
calls. Performance with 600 callsigns is acceptable with a 2.6 GHz computer running only
Logger.
Right-clicking on the gray area at the right of the Visual Dupesheet allows selection of a small
or large font size.
There are no menus in this dialog.

 
What is the usefulness of the Visual Dupesheet?
By Steve, N2IC

First, let me say what this feature is not: It is NOT intended to be a step towards paper (or
electronic) dupe sheet submission. A paper dupe sheet is an obsolete artifact of the pre-computer
logging era.

Now, I'll be perfectly honest about the utility of the Visual Dupesheet. I have been a user of TRLog
for many years, as well as a fan of the NA Sprint contest. To do very well in an extremely fast-paced
contest, like the NA Sprint, you have to minimize the amount of non-productive time. Any time you
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are not actually making a QSO is non-productive time. As you tune around a band, looking for new
stations to work, you need a really fast way to determine if a station that you hear is a dupe. The
fastest way to do this is to use only your brain. Some contesters have an amazing ability to keep
their dupesheet completely "in their head". For the rest of us, we typically reach for the keyboard
and type the call into the entry window. As soon as you do this, N1MM Logger instantly tells you
whether it's a dupe. Excellent. However, some of the NA Sprint operators who use TRLog have
found an even faster way to check for a dupe - using TRLog's Visual Dupesheet feature. As you
tune the band, you keep your eyes focused on the Visual Dupesheet. It becomes second nature to
scan the Visual Dupesheet. When you hear a non-dupe that you want to call, you don't even have
to enter the call in the Entry Window, yet. Just hit the Enter key. If he/she comes back to you, you
now have time to enter his/her call and exchange.

Obviously, in a contest where you work many, many stations on each band, this feature won't work
- it takes too long to scan the Visual Dupesheet when it is crowded with calls. However, this is not
the case with the NA Sprint. The winners work no more than 150 stations per band, making the
Visual Dupesheet an ideal way to dupe check.

 

Digital Modes

 

Table of Contents:

1 General RTTY and PSK Information
2 Digital Overview and Features
3 Digital Setup
4 Digital - MMTTY for RTTY support
5 Digital - MMVARI for PSK and other modes
6 Digital - Fldigi for Sound Card Modes
7 Digital - External TNC Support

 

General RTTY and PSK Information

In this Section...

General RTTY and PSK Information
1. RTTY Information

1.1. Common RTTY Frequencies
1.2. General RTTY Information

2. PSK Information
2.1. General PSK info
2.2. Common PSK and Digital Frequencies
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Digital mode contesting is growing rapidly. N1MM Logger supports digital mode contesting, not only
RTTY but also other digital modes, with a flexible interface.

1. RTTY Information

 
This section contains some general information about operating in RTTY that is not directly related
to N1MM Logger. If you are new to digital mode contesting in general and RTTY in particular, this
information may be helpful. If you are an old-timer at RTTY, you can probably skip this section.

Before the spread of personal computers, RTTY was the most prevalent digital mode (other than
CW, that is!), and was done using surplus teletype equipment - mechanical teleprinters. This
equipment posed severe constraints on the RTTY mode that are still evident today. Despite these
constraints, RTTY has proven to be quite well-adapted to contesting, and it is still by far the most
common digital contesting mode.

More recently, these mechanical teleprinters have been replaced by other devices. The first of these
terminal units were self-contained microprocessor devices (modems) that converted the 5-bit
Baudot code used in RTTY into ASCII characters to be sent to a terminal (keyboard and CRT
display). The most popular of these units were multi-mode TNCs (Terminal Net Controllers) that
supported RTTY in addition to packet radio and other digital modes. TNCs are still in use today, and
N1MM Logger supports the use of TNCs for RTTY.

However, with the advent of the ubiquitous sound card-equipped PC, it became possible to perform
the modulation and demodulation directly in a personal computer, and the majority of RTTY today is
done using a sound card in a PC. N1MM Logger, of course, also supports this method of
modulating and demodulating RTTY and other digital modes, using a sound-card based
digital-mode "engine".

An RTTY signal is a single carrier (like CW), but instead of being modulated on and off like CW, the
transmitted power is kept constant, and modulation is imposed by changing the frequency by a
preset amount; in amateur usage, the historical practice is to use a "shift" of 170 Hz. That is, RTTY
is modulated using frequency-shift keying (FSK). The frequency shifting can be done either at RF,
in radios which support this method, or at audio frequencies.

The first method (usually called FSK) requires an on-off keying signal to be applied to a keying
input to the radio. This keying is very similar to CW keying, except that instead of turning the carrier
on and off as in CW, closing the key input shifts the transmitter's frequency. FSK therefore requires
an on-off keying interface between the computer and the radio, and the radio must have the internal
circuitry required to perform the frequency shifting. Radios that support this FSK mode usually have
other features that assist RTTY operators, such as specialized filtering.

The second method, using audio tones fed into an SSB transmitter which converts the tones to RF
in exactly the same way that SSB converts audio voice frequencies to RF, is called Audio
Frequency Shift Keying (AFSK). AFSK can be used with any SSB transmitter. Because the
optimum filtering and other settings for RTTY operation are different from those for voice
communication, some transceivers offer special AFSK or digital-mode modes, but fundamentally
these are the same as SSB.
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Digital modes are harder on transmitting equipment than CW and SSB because of the higher duty
cycle (sustained periods of full-power transmitting). As a result, it is important not to overstress the
transmitter. It is also important to take steps to avoid transmitting extraneous noises or spurious
signals.

Here are some tips for RTTY setup and operation:

Hardware interfacing:

Unless your radio has a USB Codec built in (e.g. IC7200 and 7600), in order to receive RTTY
you will need to connect the audio output from your radio to the input of the sound card being
used with your computer, or if you are using a TNC or TU, to its audio input (see the manual
for your TNC/TU for details)
To transmit:

For AFSK, you need to connect the audio output from your sound card or TNC/TU to an
audio input on your radio (exception: radios with a built-in USB Codec), either directly or
via a sound card interface
For FSK, you need a keying circuit from a serial port to your radio's FSK keying input. If
you are using a USB-to-serial adapter, you will probably need to use the EXTFSK
plug-in in MMTTY
For either AFSK or FSK, you need some way to control PTT (TX/RX switching). If you
use PTT control from N1MM Logger in other modes, the same method can be used in
digital modes. Alternatively, you can control PTT from a serial port with a keying circuit.
In FSK, the same port can be used for PTT and FSK

 
On the radio make sure:

Audio processing is off
Speech processing is off
Hi boost is off (Kenwood radios)

If the radio does not have an RTTY-specific mode, it should be in LSB mode
RTTY-specific modes may also be called FSK, AFSK, LSB-D, PKT-LSB, ...

The most often used speed is 45.45 Baud (60 words/min)
Some contests use 75 Baud (100 wpm)

The standard shift is 170 Hz
Some TNCs use 200 Hz shift

When using a TNC set 'Mark' to 2125 Hz and 'Space' to 2295 Hz
Don't overrun your finals from the transceiver and/or amplifier

50 percent duty cycle is mostly ok, but some transmitters may require reduced power in
digital modes
See the Interfacing chapter for url's and tips on interfacing

The BAUDOT character-set does not have all ASCII characters so some special characters
such as (~ * _ @ # =)? can not be printed/transmitted
During contests narrow filters are normally used (250 - 500 Hz)
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1.1. Common RTTY Frequencies

Contests USA (kHz) USA (kHz) Europe/Africa (kHz) Japan (kHz)

Common Common DX frequency Common Common

1800 - 1810/1835 - 1845 1800 - 1810 1838 - 1843 1838 - 1843

3570 - 3600 3580 - 3600 3590 3580 - 3620 3520 - 3530

7025 - 7100 7025-7050/7080 - 7100 7040 7035 - 7045 7025 - 7040

10120 - 10150 10140 - 10150

14060 - 14120 14080 - 14100 14080 - 14100

18100 - 18110 18100 - 18110

21060 - 21150 21080 - 21100 21080 - 21120

24910 - 24930 24920 - 24930

28060 - 28150 28080 - 28100 28050 - 28150

 

1.2. General RTTY Information

 
There are two aspects of RTTY which are often confusing to newcomers to the mode.

The first of these is the "polarity" of the signal. In FSK, there are two frequencies, conventionally
called "mark" and "space". In amateur RTTY, the mark frequency is the higher of the two RF
frequencies. Someone who is transmitting with the opposite polarity is said to be transmitting
"upside down". His signal will be gibberish at the receiving station, unless the operator there inverts
his receive polarity. When first setting up for RTTY, if you appear to be unable to decode any
signals you receive, try inverting your receive polarity (in MMTTY, use the "Rev" button; in MMVARI,
switch between RTTY-L and RTTY-U settings).

In FSK, getting the polarity right involves arranging things so that the switching conventions (does
closing the keying input result in mark or space?) match between the radio and the computer.
Unfortunately, the switching conventions are not universal. Fortunately, almost all radios affected by
this have a menu item in the radio to reverse the keying polarity. Once this option is set correctly,
the radio's transmit RTTY polarity will be correct from then on. On receive, most if not all radios in
FSK mode receive RTTY on the lower sideband. If software is used to demodulate the received
signal, it must be set so that the lower of the two audio tones is converted to mark and the upper
tone to space. This is the default configuration in software that supports FSK keying (like the
MMTTY engine used in N1MM Logger). Note that in FSK, the transmit and receive polarities are
determined independently, i.e. it is possible to receive correctly and yet to transmit upside down.

In AFSK, getting the polarity right involves coordination between the choice of audio frequencies
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generated in the sound card and the choice of sideband on the radio. The most common
combination is to use lower sideband on the radio, combined with an audio tone pair in which the
mark tone is the lower of the two audio frequencies (e.g. the most common pair is mark = 2125 Hz,
space = 2295 Hz). The use of the lower sideband inverts these tones at RF to match the standard
amateur convention. Software that uses the opposite convention (mark tone higher than space) is
used with the radio in upper sideband. Fortunately, once the receive polarity is correct in AFSK, the
transmit polarity will also be automatically correct.

The second sometimes puzzling aspect is related to the RTTY character set. The digital code used
in RTTY predates the ASCII code used by modern computers. Instead of 8 bits, which allows for
256 different characters, the Baudot or Murray code used in RTTY has only 5 bits. This 5-bit code
only has enough different characters for 26 letters plus 6 control codes, so to get numbers and
punctuation the text has to be preceded with a special "FIGS" character (one of the 6 control codes)
to get a second set of 26 characters (10 numbers plus 16 punctuation marks). FIGS is "sticky", so
there is another special "LTRS" character to switch back to the letters case.

Just like any other character, these FIGS and LTRS characters can be damaged by noise, QRM,
QSB, etc., and if they are, the received info is displayed wrongly until the next LTRS or FIGS
character (or in some situations, the next space character) comes along and sets things right.
Sometimes the opposite happens - a text character is converted by noise into a FIGS or LTRS code,
with similar results.

The most common problem that results is numbers being printed as letters, so with a bit of
experience, many RTTY operators will get used to interpreting TOO as 599 and UE as 73. Serial
numbers are slightly more difficult; PQW in the input data is most likely 012, and so on. You can
see which letter corresponds to which number by comparing the top (QWERTY) row of letters on
the keyboard with the numbers immediately above and to the left. Letters can also be printed as
numbers and punctuation; for example, CQ TEST when converted to FIGS case becomes :1 53'5 .

Various software has different ways of helping out with this. When you run MMTTY stand-alone, if
you right click on a "word" (delimited by spaces), the entire word changes to the opposite case. So,
for example, VE4AEO is changed to ;3R-39 and vice versa. N1MM's digital window has a box titled
Letters/Figs for opposite-case display, that shows text that the mouse "hovers" over (no click
necessary) in the opposite case. This requires you to move the mouse over the text that you want to
convert; the unconverted text is displayed in the MouseOver box.

Unshift on Space
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2. PSK Information

 

2.1. General PSK info

There is a common feature called Unshift on Space (UOS or USOS) whose purpose is to deal
with the lost {FIGS}/{LTRS} problem. It was designed for normal text, where the majority of
information is alphabetic.

 
MMTTY has two UOS options. One of these is a button on the MMTTY main window that affects
what you see in the receive window; the other is a setup option (under the Tx tab in the MMTTY
setup) that affects what you transmit.

The receive option in the main window simply changes the receive window's case back to
{LTRS} at the beginning of every new "word", i.e. after a space, unless of course the new "word"
starts with {FIGS}. This takes no extra time, but improves reliability of receipt of alphabetic text.

The transmit option, on the other hand, actually transmits extra {FIGS} characters at the
beginning of every numeric "word" to try to ensure greater reliability. It does not transmit an
extra "LTRS" at the beginning of every alphabetic word, because using UOS on receive is a
more efficient way to achieve the same end result.

When you are ragchewing, you should always use UOS on both receive and transmit. UOS
assumes that the majority of "words" are alphabetic, which is true of normal text.

During contests, the receive UOS option is still helpful, especially when the exchange includes
letters, and it does not cost anything. The N1MM Logger DI window's "Letters/Figs" line can be
used to deal with those cases where receive UOS converts an intended numeric field to letters.

The transmit UOS option achieves greater reliability of numeric exchanges at the cost of some
extra {FIGS} characters. If you are concerned about the slight speed penalty it imposes, you
can leave transmit UOS on and use dashes ("-") instead of spaces between all-numeric fields,
e.g. 599-123-123 . The downside of using dashes in this way is that if the initial {FIGS} character
is lost, the entire exchange will be in the wrong case, e.g. TOOAQWEAQWE. Sending spaces
with transmit UOS on costs two extra {FIGS} characters but is more reliable (our example with
an initial lost {FIGS} character becomes TOO 123 123). On the other hand, turning transmit
UOS off results in 599 QWE QWE in any receiver using UOS, even with no errors at all. A
compromise among all of these possibilities is to turn transmit UOS on and use a hybrid
exchange: 599-123 123 (a dash instead of a space after the signal report, but spaces after that).
A single {FIGS}/{LTRS} error will not prevent at least one copy of the exchange from being
decoded correctly regardless of whether the receiving station is using UOS or not.
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PSK31 (and its higher-speed versions, PSK63 and PSK125) is an example of a "sound-card digital
mode", i.e. a digital mode that was made possible by the use of sound cards in PCs. The advent of
sound cards in PCs made these sound-card modes available for anyone to use with a minimum of
expense. All that is needed is an SSB transceiver, an audio interface (which can be as simple as
patch cables, or can include isolation and attenuation controls) and a means of controlling PTT.

Conventionally, sound-card digital modes are communicated using USB, regardless of the band.
Many PSK31 users set their radio's dial to a standard frequency (14070.0 kHz is the most common)
and then look for signals anywhere within their SSB filter bandwidth (e.g. from 250 Hz to 2750 Hz or
so, which would correspond to transmitted frequencies from 14070.25 kHz to 14072.75 kHz). PSK31
signals are narrow-band, so there can be many different PSK31 signals simultaneously copyable
within the available frequency range without changing the radio's dial setting. Tuning is often done
simply by clicking on the desired signal in the waterfall display.

PSK31 is short for "Phase Shift Keying, 31.25 baud". There are also higher-speed versions, PSK63
(62.5 baud - seen fairly often) and PSK125 (125 baud - rare). Actually, in addition to using phase
shift keying for modulation, PSK31 also uses amplitude modulation ("waveform shaping") to
minimize the bandwidth occupied by a signal. As a result, PSK31 places great requirements on the
linearity of the equipment used, from the sound card generating the signal to the transmitter, and
also the receiver. The peak power of a PSK31 signal can be approximately twice as high as the
average power. If a transmitter is operated near its power handling capacity, it can clip these peaks,
resulting in "splatter", which shows up on the waterfall as extra "tracks" in addition to the two main
modulation tracks that are normally visible. To avoid having this happen, the audio levels in the
sound card and in the transmitter's input audio stages must be controlled to avoid reaching power
levels that would result in clipping. In most transmitters, this is equivalent to keeping the power
below the level that would result in ALC action, and often this means powers below approximately
half the transmitter's maximum power rating.

Standard PSK31 (sometimes also called binary phase shift keying, or BPSK31) is sideband-
independent. There is a rarely-used variation called QPSK31 (or QPSK63 for the 62.5 baud speed)
that uses four phases instead of two (quadrature phase shift keying). This allows for some error
correction while still delivering the same text speed. QPSK31 is sideband-dependent, i.e. the
transmitting and receiving station must both be using the same sideband in their radios (by
convention, upper sideband).

PSK31 works well even at low powers. In fact, once the transmitted power is sufficiently high to give
an acceptable level of copy, there is no advantage to be gained by increasing power further. Unlike
analog modes, where increasing power may make your signal louder relative to QRM and therefore
easier to copy, increasing the power in PSK31 does not improve your signal's readability. It can
even degrade copy by overloading the other station's receiver and creating splatter within the
receiver. More importantly, a very strong signal will affect the AGC in every receiver that picks it up,
causing the receiver gain to decrease and making copy of signals on other frequencies more
difficult. For this reason, high-power operation is unpopular in PSK31.

When you plan to run PSK:

Keep your macros short.
PSK is about 1/3 slower than RTTY; you can really impact your rates with wordy macros
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Use lower case letters wherever possible
PSK is a varicode mode. That means that characters contain a variable number of bits,
unlike ASCII characters that have a fixed number of bits. Most lower-case PSK
characters have fewer bits in them than their upper-case equivalents, so lower-case (in
general) transmits faster

 
On the radio make sure:

Audio processing is off
Speech processing is off
Hi boost is off (Kenwood radios)

Radio should be in USB mode
Some radios have modes designed for digital sound card modes, e.g. PSK, DATA A

Transmitter linearity is extremely important in PSK
Keep power below 1/2 the transmitter rating to avoid clipping peaks
Avoid any visible ALC action (except in radios with ALC designed for PSK, e.g. Elecraft
K3)
See the Interfacing section of this help for url's and tips on interfacing

Using lower case letters instead of all caps will increase speed and reduce TX time
Only 100 Hz is needed as channel separation
Example filter usage:

Available 2.4 kHz / 250 Hz /100 Hz filter bandwidths
2.4 kHz is used for monitoring the PSK area of band when in search and pounce mode
250 Hz and 100 Hz filter bandwidths are used when in run mode

 

2.2. Common PSK and Digital Frequencies

PSK31 activity generally starts from the bottom edge of the IARU RTTY bandplan, expanding
upwards as activity increases.

Band Digital Frequencies (kHz) PSK Frequency (kHz) Remarks

160 meter 1800 - 1810 / 1838 - 1843 1807 / 1838 1807 in Region 2

80 meter 3575 - 3585 3580

40 meter 7030 - 7040 / 7060 - 7085 7035 / 7080 7080 in Region 2

30 meter 10130 - 10145 10142 WARC, no contesting

20 meter 14065 - 14090 14070

17 meter 18100 - 18110 18100 WARC, no contesting

15 meter 21060 - 21090 21080

12 meter 24920 - 24930 24920 WARC, no contesting

10 meter 28110 - 28125 28120
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Digital Overview and Features

In this Section...

Digital Overview and Features
1. Digital Overview
2. Making QSOs

2.1. Make a Digital Mode Transmission
2.2. Digital Need to Know

3. Tips for Making QSOs
3.1. Using Hover Mode
3.2. The Rate Improver - Right Click = Return NOT Menu

4. Do You Have... (what to check when it does not work)
4.1. Insert Key Assignments
4.2. Configuring the Entry Window Function Keys
4.3. Macro Keys

5. Name Lookup
6. Output RX Data to a Text File
7. Single Operator 2 Radios (SO2R)
8. Additional Receive-Only Windows for RTTY

The digital part of the N1MM logger program is designed, coded and maintained by Rick Ellison,
N2AMG.

1. Digital Overview

 
N1MM Logger supports a variety of methods to decode and transmit digital modes, including an
external TNC/TU; the MMTTY engine for RTTY (sound card on receive, either sound card AFSK or
FSK keying on transmit); the MMVARI engine for RTTY (AFSK or FSK, starting with Logger version
10.9.5), PSK31, PSK63, PSK125 (both BPSK and QPSK), and MFSK16; or the Fldigi engine for a
broad range of sound-card digital modes including AFSK RTTY, PSK and many more. Regardless
of which of these engines is used, the digital data streams pass to and from the engine via the
Digital Interface (DI) window. At least one DI window must be open to operate the Logger in digital
modes. Depending on your hardware configuration and operating mode, you may have either one
(SO1V, SO2V) or two (SO2V, SO2R) DI windows open. Both DI windows have full receive and
transmit capabilities. It is also possible to supplement the two DI windows with up to four additional
receive-only windows. The user can interact with the DI windows using either the keyboard or the
mouse as the primary control interface. There is a wide variety of options available to customize the
operation of the digital interface.

The remainder of this section describes the operation of the DI windows, including basic operation
as well as advanced features that can help make operation easier and more efficient. The next
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section describes how to set up N1MM Logger and the DI Window for digital modes regardless of
which type of digital engine is used. Engine-specific details are described in separate sections for
each of the supported engines (MMTTY, MMVARI, Fldigi and external TNCs).

 

2. Making QSOs

 
This section explains:

How to make a Digital mode transmission
Keyboard, Insert key and Mouse Assignments
Function keys
Macros

 

2.1. Make a Digital Mode Transmission

 

Select 'Window | Digital Interface' and the Digital Interface will open. The Digital Interface
window can be positioned and resized on your monitor as desired
If an external TNC is used only the Digital Interface window is opened. When one of the sound
card interfaces is chosen an extra window will appear: MMTTY, MMVARI or FLDIGI depending
on which interface is selected in the DI window's Interface menu
Left clicking on a call will grab the callsign. Right clicking on the RX and TX windows will show
a menu (depends on a menu setting)
Pressing Insert will Grab the highlighted call and sends Hiscall followed by the Exchange
button
Double clicking on a callsign in the callsign box from the Digital Interface sends that call to the
Entry window
A callsign is automatically highlighted if recognized by the program. Call signs are always
recognized when they are both preceded and followed by a space. There is also an option to
recognize call signs buried in garbage (without a leading or trailing space), provided that call
sign is in the MASTER.DTA file

 

2.2. Digital Need to Know

Check out the Digital Modes part of the Frequently Asked Questions (FAQ) of this Wiki.

Problems?
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If the callsign in the callsign field in the Entry window is equal to the callsign in the received
text, the call in the Entry window does not get placed into the call list.

Pressing Ctrl while single clicking on a call will force the call into the Entry window
Click in the Entry window input field you want data to go to and then hold down the Ctrl key
while clicking on that data. It will paste to the field you clicked into
"-" separators between exchange elements are removed automatically
CQ Repeat time starts

when using a sound card engine, from when the sending stops
when using an external TNC, from when the message begins, as there is no way to tell
when the TNC finishes sending

During transmit, callsigns are not grabbed from the receive window
Linefeed characters (LF) in incoming text are replaced with Carriage Return (CR) characters

 

 

3. Tips for Making QSOs

 
Callsigns and exchanges are displayed in the Digital Interface (DI) window. This information can be
transferred to the Entry window's Callsign field and exchange fields with the mouse, or it can be
typed in manually the same as you would do in CW and SSB. Call signs recognized in the input
stream are also placed in the Grab window, and can be transferred from there to the Entry window
using the Grab button, the {GRAB} macro or Alt+G on the keyboard.

Focus is automatically returned back to the Entry window when clicking a callsign in the
Receive window

To get auto-CQ to work correctly with a TNC set your repeat time to at least 9 or 10 seconds. It
may need to be longer if you have a longer CQ macro. This will stop the TNC buffer from
receiving the next string before it finishes sending the last one.

It is best to add the command that your TNC uses to clear the transmit buffer to the end of your
Abort Macro. If not, the transmit buffer still holds the remaining characters that were left in the
sent string and will get sent the next time the TNC sends.

When using a TNC turn off Config >Function Keys >Stop Sending CQ when Callsign changed.
If not every time you stop an auto-CQ and you type a callsign in the box it will send the abort
string to the TNC.

Staying Focus'ed

Auto-CQ with a TNC

Clear the TNC Transmit Buffer

Stop Sending CQ

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

264 of 680 2/2/2011 4:54 PM



3.1. Using Hover Mode

Hover Mode places the callsign in the callsign field in the Entry Window when you hold the
mouse over a valid callsign. If you use this in combination with the 'Right click = Return NOT
menu' option, you hover over the call then right click to plant the call and send your call; when
the station comes back to you you click on the exchange to place it in the Entry Window.
Right clicking again sends TU and logs the Q. Right click, left click,right click and you're
done...

Note: Your own call is excluded from being picked up.
Hover mode is used in conjunction with the menu selection 'Rt Click = Return NOT
menu' which will will send a Return when right clicking in the DI RX window instead of
displaying a pop up menu

 

3.2. The Rate Improver - Right Click = Return NOT Menu

 
Select from the settings menu in the Digital window "Right Click = Return NOT menu". This setting
could improve your rate greatly as your hand never leaves the mouse except for the occasional
difficult exchange. Making a qso:

While in Run mode
Right click in the DI's RX window to sends CQ
When a station replies left click on the call
Right click sends your exchange
As he sends his exchange left click on it
Right click again to send TU and log the call
Right click again starts CQ (and you're back at the first bullet)

In S&P it does the same thing as hitting Enter to advance thru the ESM mode

 
Right click takes the place of hitting Enter for ESM. Most of the time while in the contest I have one
hand on the mouse and the other hand I have one finger resting on the space between the Esc and
F1 keys. With that finger I can hit Esc if I have started a CQ and someone has started coming back
to me. 73 Rick N2AMG

4. Do You Have... (what to check when it does not work)

 
Below are the most common mistakes made setting up or using N1MM logger in RTTY mode.

Add {TX} and {RX} to each of the F Keys
Set up Mode Control in the Configurer
Select the DI type in the Configurer under the Tab: Digital Modes
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When MMTTY selected: Set up the path to MMTTY in the Configurer under the Tab: Digital
Modes
Set up the Dig Wnd Nr in the Configurer under Hardware for Digital ports

 

4.1. Insert Key Assignments

Mode Enter Sends Message
(ESM mode)

Ins key or ; does the following:

RUN and
S&P

OFF 1. Grab Callsign from call list if callsign field empty
otherwise use call in callsign field

2. Prefills Exchange Boxes

3. NO DUPE: Sends F5 (Hiscall) + F2 (Exchange) or DUPE:
Sends Nothing

4. Places cursor in next exchange field (Example: Sect)

RUN ON 1. Grab Callsign from call list if callsign field empty
otherwise use call in callsign field

2. Prefills Exchange Boxes

3. NO DUPE: Sends F5 (Hiscall) + F2 (Exchange) or

3. DUPE

— WorkDupes checked: Sends F5 (Hiscall) + F2
(Exchange)

— WorkDupes not checked:Sends F6(Dupe)

4. Places cursor in next exchange field (Example: Sect)

5. Highlights F8 button

S&P ON 1. Grab Callsign from call list if callsign field empty
otherwise use call in callsign field.

2. Prefills Exchange Boxes

3. NO DUPE: Sends F4 (Mycall) or

3. DUPE

— WorkDupes checked: Sends F5 (Hiscall) + F2
(Exchange)

— WorkDupes not checked:Sends F6(Dupe)

4. Once exchange entered INSERT sends F5-F2

** Pressing INSERT again will continue to send F5-F2

5. Places cursor in next exchange field (Example: Sect)
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4.2. Configuring the Entry Window Function Keys

The Entry window function keys support 'Running' mode and 'Search & Pounce' mode.
The function keys use the same macros for PSK and RTTY.
The function keys can be changed under: 'Config | Change Packet/CW/SSB/Digital Message
Buttons | Change Digital Buttons'.
Below example button definitions:

 

4.3. Macro Keys

There are 8, 16 or 24 extra macro keys possible on the RTTY interface
A right click on the macro buttons brings up the Digital setup dialog where the macros can be
configured
These extra function keys support all the macros but don't support 'Running' mode and
'Search & Pounce' mode
Include in your macros the control keys needed to turn on the TNC and switch to RX...
Macro key substitution is supported by the buttons in the RTTY window and the function keys
on the Entry window

The macros which can be used and some examples can be found in the macros reference section

There are several additional macros for an External TNC. Please check the Digital - External TNC
support chapter. Also please check the rules for macros when using MMTTY and MMVARI.

5. Name Lookup
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The program has the possibility to lookup the name from a station entered in the Callsign field. For
this to happen the following has to be done.

Import a callsign versus name text file
The famous 'Friend.ini' file used in the WF1B program can be directly imported
Also a text file using the format for Call History import can be used

Callsign <comma> Name. For example: N1MM,Tom
Select >Config >Call History Lookup
Use the {NAME} macro to have the name sent

Note: The name is looked up in the Call History table with the cursor in the callsign field
and pressing the Spacebar!

 
Example how to import the Friend.ini file from the WF1B program.

Select >File >Import >Import Call History
Select your 'Friend.ini' file by changing 'Files of type:' to 'All Files (*.*)'. Otherwise only text
files will be shown!
Select the 'Open' button. The callsigns with names from the text file will be imported
NB. Importing info in this table will delete all previous content. There is no merge option! So if
there is information in it and you only want to add info, first export this info (Select >File >
Export >Export Call History) and merge the data outside the program with a Text editor like
Notepad. After this import the new merged file 'Friend.ini' file
The program will show in the bottom pane of the Entry Window status information during
importing and afterwards the number of imported callsigns

 

6. Output RX Data to a Text File

 
Sending your RX data to a text file can be done in N1MM logger and in MMTTY.

N1MM Logger: Right click in the RX window and select >Output to Text File (this choice is not
available if you have selected the 'Right Click = Return NOT menu' option)
MMTTY: Doing this in MMTTY is a bit tricky. Go to the directory where MMTTY has been
installed and load MMTTY in standalone mode. Click on File/Log RX and close the program.
From now on every time you start MMTTY either via the logger or in standalone mode an
output text file will be created and all your info will be stored in this text file. In the directory
where MMTTY is located files will be created that have names like 031103.txt. MMTTY creates
a new file for each day. These files are a real safety feature as you can go back through them
for any info you missed or lost during a crash.

 

7. Single Operator 2 Radios (SO2R)

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

268 of 680 2/2/2011 4:54 PM



 
N1MM Logger also supports SO2R for RTTY. You can use any combination of either 2 MMTTY
windows, 2 TNC windows or a combination of MMTTY and a TNC for SO2R operation. Info about
MMTTY soundcard setup and SO2R can be found in the N1MM logger Help file in the SO2R
chapter.

8. Additional Receive-Only Windows for RTTY

 
N1MM Logger supports up to four additional receive-only windows for RTTY. The purpose of these
windows is to allow simultaneous use of more than one decoding algorithm on the same audio
input. While it is possible, by using wide bandwidth filters, to use the additional windows to decode
different signals from the one in the main DI windows, the normal use of the additional windows is
to decode the same signal as the one in the main window, but using a different decoding method to
improve the overall ability to decode signals in difficult situations.

These receive-only windows can be distributed in any way between the two DI windows. These
receive-only windows normally use additional copies of MMTTY, configured with different "profiles"
(e.g. multipath, fluttered, different detection algorithms), or they can be used with additional TNCs
or TUs. You can use any of the possible digital interface engines in the main DI window (MMTTY,
MMVARI, Fldigi or a TNC/TU), but regardless of which engine is used in the main window, the
additional receive-only windows can only use MMTTY or a hardware decoder.

The receive-only windows are invoked from the DI window's Setup > Open Add. Rx Window (4
Avail.) menu item - the number in the menu item indicates how many of these windows are unused
and still available. The first time one of these windows is opened, its Setup window will be
displayed.
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The setup information that must be entered includes the engine type (MMTTY, TNC or Dxp38), the
path to the copy of MMTTY for that window (if used), and/or the COM port information for a TNC (if
used).

After the setup information has been entered, the window should be closed and re-opened, and
then it will be available for use.

 

Digital Setup

In this Section...

Digital Setup
1. Setup Overview

1.1. Downloading and Installing MMTTY
1.2. Downloading and Installing Fldigi
1.3. Setting Up the Configurer

2. The Digital Interface - Window
2.1. Callsign coloring
2.2. Mouse Assignments
2.3. Keyboard Assignments

3. The Digital Interface - Menu Selections
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3.1. Selection: Soundcard as Interface
3.2. Selection: OTHER

4. The Digital Interface - Setup
4.1. Tab: General/MMTTY Setup
4.2. Tab: MMVARI Setup
4.3. Tab: Macro Setup
4.4. Tab: WAE RTTY Configuration

1. Setup Overview

 
Setting up an interface involves configuring the Logger for the selected interface. Configuring has to
be done within N1MM logger in a few places, including the Configurer as well as the Digital
Interface window. If you are using MMTTY for FSK RTTY, you will also have to perform some
configuration from within MMTTY. If you use Fldigi, there is some configuration that must be done
from within Fldigi.

Before you can use MMTTY, you will have to download and install it. Likewise, before you can use
Fldigi, you will have to download and install it. This process is described in the next two
sub-sections. You do not need to download or install any additional files or programs to use
MMVARI or a TU/TNC.

A brief note about hardware connections for sound card digital modes (using MMTTY, MMVARI or
Fldigi). These depend on the radio, the sound card and the interface (if any) in use, and it is
impossible to cover all of the possibilities in detail, but the following general comments apply.

First, you must have some means of connecting the radio's audio output to the sound card's input.
The ideal connection would be from a fixed-level ("line out") output on the radio to a "line in" input
on the sound card. If your radio has one receiver, this will probably use the left channel of the
sound card; with dual receivers, the second receiver may use the right channel. If your sound card
does not have a line level input, you may need to use a microphone input, and in this case you may
need an attenuator to reduce the line level output from the radio to the lower level needed for the
microphone level input on the sound card.

To transmit, there must be some means to convey modulation from the computer to the radio. For
FSK RTTY, this is an on-off keying signal, which is normally generated by a serial port connected to
the radio's FSK keying input through a simple keying circuit. This serial port cannot be the same
port that is used for radio control or for a Winkey or other serial device. If it is a USB-to-serial
adapter, you will probably need to use MMTTY's EXTFSK plugin. If you are using MMVARI for RTTY
using FSK keying, select the appropriate plugin (FSK8250 for true serial ports, EXTFSK for USB-to-
serial adapters) in the Configurer under the Digital Modes tab).

For AFSK RTTY and for all other sound card digital modes (e.g. PSK31), there must be a
connection from the sound card's output ("line out", or speaker or headphone output) to the radio's
audio input. If the only audio input on the radio is a microphone input, you may need attenuation to
reduce the level to avoid overdriving the transmitter.

You also need some means to control TX/RX switching (PTT). The most common method is to use
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hardware PTT control from a serial or parallel port via a simple keying circuit. Hardware PTT can be
controlled either from the digital "engine" (MMTTY, MMVARI or Fldigi), or from N1MM Logger itself.
To use serial port PTT from the digital engine, you must use a different port from the one that is
used by the Logger for radio control. If you have a serial port set up for FSK keying, you can use a
control line (RTS or DTR) on this same port for PTT control from the digital engine. If PTT is
controlled from a digital engine rather than from the Logger, you should check the Digital box for
that serial port in the Configurer and make sure to indicate the appropriate Dig Wnd Nr (1 for DI1, 2
for DI2).

If you do not have a separate serial or parallel port available for PTT in digital modes, you can
control PTT directly from the Logger. For example, if your radio control interface supports PTT using
RTS or DTR on the radio control serial port, you can configure the Logger to use this method. If no
method of hardware PTT control is available and if your radio supports PTT via radio command, you
can use software PTT control from the Logger. Warning: Using both software and hardware PTT
control at the same time can cause problems; do not use both methods in parallel.

As an alternative to hardware and software PTT control, you may be able to use VOX. This does not
work with all radios, it cannot be used for FSK RTTY, and setting of audio levels and VOX triggering
levels can be tricky, but some users have found this to be the simplest method of PTT control, since
it does not require any additional hardware connections.

1.1. Downloading and Installing MMTTY

 
MMTTY is not installed as part of the installation of N1MM Logger. It must be downloaded and
installed separately. It is possible to use N1MM Logger in RTTY without using MMTTY (e.g. by only
using an external TNC, or AFSK RTTY from MMVARI). If you intend never to use MMTTY, you can
skip the rest of this section. However, most RTTY users will probably want to have the ability to use
MMTTY, at least as an option. In particular, if you would like to make use of the additional RX
windows for "diversity decode", you will most likely need to install MMTTY (unless you have several
TUs/TNCs you can use for the purpose).

If you do not have a copy of MMTTY, then before continuing with the digital setup it is
recommended that you download a copy of the MMTTY installer from the MM HamSoft website at
http://mmhamsoft.amateur-radio.ca/  . You can find a copy of the full installer for the current
version of MMTTY at that website. This file is a self-extracting executable, similar to the N1MM
Logger installer. Download the file to a temporary folder and then execute it. It is recommended that
you install MMTTY in its own program folder and not in the N1MM Logger program folder. By
default, the installer will install MMTTY to C:\Program Files\MMTTY\ .

If you already have a copy of MMTTY installed on your computer, you can use that copy from N1MM
Logger. However, if you also use MMTTY stand-alone, it is possible that you may want (or need) to
have a different setup for stand-alone use than with N1MM Logger (e.g. if you use the radio control
port from within MMTTY stand-alone; this is not possible when MMTTY is used with the Logger). If
you need a different setup with the Logger than the one you use stand-alone, then you should
create a separate folder for each copy (for example, you can create a sub-folder inside either the
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N1MM Logger program folder or the MMTTY program folder for the second copy of MMTTY). You
need to copy only the MMTTY.exe and UserProfile.ini files from the main MMTTY folder into the
additional folder. MMTTY will create a separate copy of MMTTY.ini when it is run.

If you plan to use two copies of MMTTY in SO2V or SO2R mode, one for each received audio
stream, you will need to create two copies in separate folders with different configurations. In SO2V,
one of these copies can be configured to use the left channel and the other copy to use the right
channel of a single sound card. In SO2R, you can either use a stereo sound card as in SO2V, or
you can use two separate sound cards, one for each radio.

If you want to use MMTTY for diversity decoding in additional RX windows, you will need to create
another separate sub-folder for each additional RX window. For example, you can create
sub-folders called DI1, DI2, DI1RX1, DI1RX2, DI2RX1 and DI2RX2 so that you can run up to six
copies of MMTTY simultaneously; one for each main DI window, plus up to 4 additional RX windows
(two additional windows for each DI window). Into each of these windows, you need only copy the
MMTTY.exe and UserPara.ini files from the main MMTTY program folder created when you first
installed it. Each copy will then be configured to use the appropriate sound card and channel. The
"Additional RX" copies use the same sound card and channel as the parent copy in the main DI
window, but they can be configured to use different decoding algorithms or profiles to give you
"diversity decoding", i.e. two or three different decoding methods used on the same receive audio.

Note for users of Windows Vista and Windows 7: User Account Control (UAC) in these versions of
Windows prevents user programs from writing configuration information into the Program Files path.
Even if programs are run with Administrator privileges, UAC may interfere with the ability to use
separate configuration files for separate copies of the same program. Therefore, it is suggested that
the folders for the extra copies of MMTTY used in the two DI windows and the four RX windows
should not be in the Program Files path. It is suggested that you create a new folder outside the
Program Files path, such as C:\Ham Radio\MMTTY, and then place the individual sub-folders for
the separate copies of MMTTY within that folder.

Once MMTTY has been downloaded and installed, you can proceed to use the Configurer to set up
N1MM Logger to use it.

1.2. Downloading and Installing Fldigi

 
FLdigi is not installed as part of the installation of N1MM Logger. It must be downloaded and
installed separately. It is possible to use N1MM Logger in RTTY and PSK contests without using
Fldigi. Fldigi supports a wide range of other digital modes, but most of these are rarely used for
contesting. If you intend never to use Fldigi, you can skip the rest of this section.

If you do not have a copy of Fldigi, then before continuing with the digital setup it is recommended
that you download a copy of the Fldigi installer from the W1HKJ website at http://www.w1hkj.com/

 . You can find a copy of the full installer for the current version of Fldigi at that website. This file
is a self-extracting executable, similar to the N1MM Logger installer. Download the file to a
temporary folder and then execute it. It is recommended that you install Fldigi in its own program
folder and not in the N1MM Logger program folder. By default, the installer will install Fldigi to
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C:\Program Files\Fldigi-x.xx.xx\, where x.xx.xx is the Fldigi version number.

Note that Fldigi cannot be configured to use a single channel of a stereo sound card; Fldigi always
uses its sound card in mono mode on receive. If you want to use Fldigi in a two-receiver
configuration, either SO2V or SO2R, you will have to use two separate sound cards. You will also
need to install two separate copies of Fldigi in separate folders, one for each DI window, in order to
be able to configure each one for a separate sound card. It is suggested that you do a full install for
each copy, but do not create Start menu or Desktop shortcuts for the second copy. As with MMTTY,
users of Windows Vista and Windows 7 may find it necessary to install one or both of these copies
outside the Program Files path.

You do not need to install separate copies of Fldigi for additional RX windows, because this feature
is not implemented for Fldigi or MMVARI engines, only for MMTTY and hardware TUs/TNCs.

1.3. Setting Up the Configurer

 
There are three tabs in the Configurer that need to be set up when configuring N1MM Logger for
digital modes. The first is the Hardware tab, where serial ports used for digital modes are set up.

The Digital box in the main Configurer window indicates to the Logger that this port is used
for digital mode control.

Use this to indicate a port that is used for an external TNC

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

274 of 680 2/2/2011 4:54 PM



Use this to indicate a port that is used for FSK keying with MMTTY
A port that is used for FSK must also be configured inside the MMTTY setup. This
includes ports used with EXTFSK
It is possible to use a port in the range COM9-COM16 for FSK with MMTTY. In this
case, there is no Digital box to be checked; the port must be configured entirely
within MMTTY

Use the Digital box to indicate a port that is used for PTT in AFSK RTTY or other digital
modes with MMTTY, MMVARI or Fldigi

Exception: If PTT is done from a radio control port or from a Winkey, do not check
the Digital box for that port
It is possible to share a port for both serial port CW keying (e.g. on DTR) and for
PTT and FSK using MMTTY for RTTY (e.g. on RTS and TxD of the same port). In
this case, check both Digital and CW/Other for that port. When in CW mode, the
settings in the DTR and RTS boxes will determine how the port is used; in RTTY, it
will be the settings in MMTTY that determine how the port is used

 

In the Set window for each of these serial ports, the radio and the DI window associated with the
port is configured.

The Radio Nr box indicates which radio this digital interface is for in SO2R mode; in SO2V
and SO1V, Radio Nr is always = 1
The Dig Wnd Nr indicates whether this port is used for DI1 or DI2. This applies to SO2V and
SO2R; in SO1V, Dig Wnd Nr is always = 1

You must choose a Dig Wnd Nr for each port that has the Digital box checked;
otherwise the program will not assign the port to a DI window!

 
The next tab to be set up is the Digital Modes tab.
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MMTTY (if used)
Digital Interface 1/2 (left part of window)

TU Type: Soundcard
DI-1/2 MMTTY Setup (upper right part of window)

MMTTY Mode: Select AFSK or FSK
MMTTY Path: Select path to MMTTY.EXE

The path does not need to be in the N1MM Logger program directory
The paths for the two DI windows do not need to be the same

 

 

MMVARI (if used)
Digital Interface 1/2 (left part of window)

TU Type: Soundcard
DI-1/2 MMVARI Setup (bottom part of window)

MMVARI RTTY Mode: Select AFSK or FSK

You can use MMTTY with both receivers in a two-receiver setup with a single sound card. You
will need to install two copies of MMTTY in two separate program folders in order to allow one
copy to be configured to use the left channel of the sound card and the other copy to be
configured to use the right channel of the sound card.

SO2V/SO2R in MMTTY
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FSKPort: (FSK only)
Choose FSK8250 if you are using a true serial port or a device that can
simulate a serial port and handle 5-bit codes at low speeds (this does not
include most USB-to-serial adapters, but it does include some commercial
interfaces designed to support FSK RTTY as well as some multi-port USB-to-
serial adapters)

When MMVARI is opened for FSK RTTY, a small window labelled
MMVARIFSK1 1.04 will open, or appear on the Windows Task bar. In
this window you select the COM port number and the signal line to be
used for PTT (RTS or DTR). FSK keying will be done on the TxD line. If
this is a USB device that simulates a serial port, check Limiting speed.
You can use the _ box at the top right to minimize this window after
completing the setup
FSK8250 supports all of the RTTY speeds supported by MMVARI and
the selected COM port or device

Choose EXTFSK if you are using a regular USB-to-serial adapter
When MMVARI is opened for FSK RTTY, a small window labelled
EXTFSK 1.06 will open, or appear on the Windows Task bar. In this
window you select the COM port number and the signal lines to be
used for FSK keying (normally TxD) and PTT (RTS or DTR). You can
use the _ box at the top right to minimize this window after completing
the setup
The only RTTY speed supported by EXTFSK is 45.45 baud

 

 

Fldigi (if used)
Digital Interface 1/2 (left part of window)

TU Type: Soundcard
DI-1/2 Fldigi Setup (lower right part of window)

Fldigi Path: Select path to fldigi.exe
The paths for the two DI windows do not need to be the same

 

You can use MMVARI with both receivers in a two-receiver setup with a single sound card. In the
DI Window's Digital Setup dialog box under the MMVARI Setup tab, simply configure the DI1
SoundCard to use the left channel and the DI2 SoundCard to use the right channel.

SO2V/SO2R in MMVARI

SO2V/SO2R Limitation in Fldigi
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External TNC (if used)
Digital Interface 1/2 (left part of window)

TU Type: Other
Set other parameters appropriately for the TNC in use (Example settings: 9600, 8,
N, 1, Xon-Xoff)

 
The third tab to be set up is the Mode Control tab, which determines what mode the radio will be set
to use in RTTY and PSK.

There is a basic limitation in the Fldigi engine which can make it harder to use in dual-receiver
situations (SO2R and SO2V). Fldigi always receives in mono mode. If you are using a stereo
sound card to decode two receivers, with one receiver in the left channel and the other receiver
in the right channel, Fldigi will combine the two receivers in its waterfall. It doesn't matter
whether Fldigi is the interface engine in DI1 or DI2, it will see the audio from both receivers.

 

Therefore, if you want to use Fldigi with both receivers in a two-receiver setup, you will need to
use two separate sound cards for the two receivers. You will also need to install two copies of
Fldigi in two separate program folders in order to allow a different sound card to be configured
in each copy.
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The available choices in the list boxes under Mode sent to radio will depend on the particular radio
type. For FSK RTTY, the correct choice will normally be RTTY. For AFSK RTTY, depending on the
radio the appropriate choice might be AFSK or LSB/USB. For PSK and other sound card modes,
the radio mode would be PSK (if available), AFSK-R (on some radios) or USB on most radios. For
more information, see the Configurer page under the Config >Mode Control tab.

2. The Digital Interface - Window

 
The Digital Interface window is nearly the same regardless of which type of interface (MMTTY,
MMVARI, FLDIGI or TNC) is being used. Its appearance (foreground and background font colors)
can be customized using the Settings > Setup menu item.

The Digital Interface is opened from the Entry window's Window > Digital Interface menu item. If
you are using two entry windows (SO2V/SO2R), each entry window has a separate DI window
associated with it - DI1 with the VFO A/Radio 1 Entry window, and DI2 with the VFO B/Radio 2 Entry
window. Each DI window is opened from its corresponding Entry window's menu bar.

The Digital Interface caption displays either the offset frequency (radio's dial frequency +/- audio
frequency) or the radio's dial frequency, depending on what you have chosen in the Digital Setup.

TX - Indicator to show which window has transmit focus (useful when using two sessions like
SO2R)
Letters/Figs - Shows the text under the mouse in reverse case (letters/figures switched)
MouseOver - Shows the text under the mouse; this is the text that would be selected by a
mouse click
Top RX window - This is the receive window. This is the window used for making QSOs.
There are 2 ways of placing a callsign into the callsign window of the Logger. You can single
click on a callsign and it will transfer over to the main logging window, or, whenever a callsign
is detected in the RX window it will be sent to the callsign grab window for easy movement to
the logging window by clicking the Grab button. By clicking on the colored bar on the left you
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can pause input to the receive window to scroll back through the (last 2000 lines of) text using
the scroll bars. When the window is paused the color of the bar will turn Yellow. To turn input
to the window back on click in the bar again and everything that was to be printed to the
window will now enter the window. When the receive window is paused it is possible to select
and copy text in the window.
Bottom TX window - This is the transmit window, a free form typing window. If you click on
the TX button the cursor will be placed into this window and what ever is typed will be sent.
The size is static and doesn't change size (2 lines). For TNC users: when not transmitting,
anything typed in the TX Window will be sent to the TNC. Used to change settings etc.
Callsign Textbox and Grab - When a callsign is encountered in one of the receive windows it
will be placed in this textbox and when you press the Grab button it will transfer the callsign
over to the main Entry window. The grab callsign window holds the last 10 callsigns seen in
the RX window. The most current one is at the top and is highlighted. Dupe callsigns will not
be shown in the grab window. The Sort Order in the grab window can be selected by right-
clicking; you can choose either Last In First Out or First In First Out as the sort order

Macro buttons - These buttons on the Digital Interface are (max.) 24 extra macro buttons for
preprogrammed messages. Configuring these macro buttons is done in the Digital Interface
window under 'Setup | Settings' or by right clicking on them which brings up the Digital setup
dialog. The macro buttons widths dynamically adjust in relation to the width of interface
Clr RX - Clear the receive window (also possible using the right click menu)
Align (MMTTY and Fldigi only) - This is used to move the signal that you are copying into the
pass band of your filters. Set the frequency in the setup area. For example, if your filters are
centred on 2210 Hz, RTTY signals close to the 2125/2295 Hz pair will be copied well, but
signals at higher or lower frequencies may not make it through the filters. If you click on such
a signal to decode it, it may not decode very well. After clicking on the signal, if you click on
the Align button your transceiver will be retuned to line the signal up on the configured
frequency. This is essential in FSK where the transmit frequencies are fixed in the radio, and
useful also in AFSK if you want to use narrow filters

Note that when you are using the MMVARI interface engine, the Align button appears on
the MMVARI window instead of on the Digital Interface window

TX - Start the RTTY transmission, the transceiver is keyed. Will be colored Red when
transmitting
RX - Stop the RTTY transmission - the transceiver changes back to receive. Will be colored
Green when in receive
AFC (MMTTY only) - Can be used to turn MMTTY's AFC on or off (colored background means
AFC is on)
HAM (MMTTY only) - Restore the MMTTY frequency and shift settings to the HAM default
Lock (Fldigi only) - Locks the transmit frequency at the current location. If you move the
receive frequency, e.g. by clicking elsewhere in the waterfall, the transmit frequency does not
change. Used for operating split
Rev (Fldigi only) - In sideband-sensitive modes like RTTY, reverses the tones (e.g. opposite
sideband)

If the callsign in the callsign field in the Entry window is the same as the callsign in the received
text, the call in the Entry window does not get placed into the grab call list.

Callsign not added to grab List
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Grab - Transfer the selected callsign in the Callsign textbox to the callsign field on the main
logger window. Once the callsign is filled, whatever you click on next will fill the next box to
have info entered in. When the Digital Interface is in transmit, calls are not added to the Grab
window
CLR - Clear the Grab list

 

2.1. Callsign coloring

 
When a callsign is recognized in the receive input stream the callsign will be colored and brought to
the Grab window. Valid callsigns that are separated by spaces are always recognized, and
optionally the Search routine can be used to search for known call signs from the Master.dta file in
garbage text strings. When the search in garbage text is enabled and two calls are found in the
same string, only the last one gets highlighted. Also, if the call sign being copied contains a shorter
call sign that is in the Master.dta file, using the search in garbage feature may result in the shorter
call sign being recognized instead of the longer one. The highlighted calls in text strings are
clickable.

If the "Use Generic Routines" option is chosen in the Digital Setup, anything that looks like a
callsign will be highlighted with a color that indicates its multiplier status using the same colors as
in the Bandmap and Entry window. If the "Use Master.dta File" option is chosen, only call signs in
the Master.dta file will be colored according to the multiplier status; callsigns that are not in the
Master.dta file will be given a different highlight color to indicate that they were not found in
Master.dta. Regardless of which option is chosen, any callsign that passes the check routines will
be placed in the Grab window.

2.2. Mouse Assignments

Left mouse key clicking
Single clicking on a callsign grabs it and places it in the Callsign field on the Entry
Window dialog
Single clicking on Exchange info etc. grabs it and places it in the Exchange field on the
Entry Window dialog

NB. The callsign field must be filled first!
Double clicking on a callsign grabs it and overrides the current information in the
Callsign field on the Entry Window dialog
Ctrl+Single clicking - will force what ever you are clicking to be sent to Entry window.
(Must click first in Entry window where you want to place the new data)
Shift+Single clicking - will cause the moused over text to be Letter/Figs converted on
the fly while sending to Entry Window (only in RTTY Mode)
Alt+Single clicking - if Digital Call Stacking is enabled, will transfer the call sign being
clicked on to the Bandmap call stack (see Single Operator Call Stacking for more
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information)
Right mouse key clicking on RX window

Will give a menu only when the menu item 'RT Click = Return NOT menu' is NOT
selected!

Clear RX - Clear the receive window. This receive buffer can contain a maximum of
10,000 characters
Output to Text File - Output the received text to a text file named RTTY1.txt
Help - Show the help file for this window

Right mouse key clicking on TX window
Will give a menu only when the menu item 'RT Click = Return NOT menu' is NOT
selected!

Clear TX - Clear the transmit window
Paste - Place the TX text in the Paste buffer

Right mouse key clicking in GRAB window
Gives a menu:

Clear List - Clear the entire grab window
Clear Selected Call - Clear the selected call in the grab window

 

2.3. Keyboard Assignments

Alt+T - Toggle TX/RX, when in TX the cursor will be set to the TX window of the active
interface
Ctrl+K - Toggle TX/RX, and displays the CW/Digital Keyboard window to send manual
information using the keyboard
Alt+G - Grab most recent callsign from callsign textbox. Upon grabbing that callsign gets
deleted from the grab list
Ctrl+Left/Right arrows - When 2 radios are configured and 2 digital windows are open (SO2V
or SO2R), pressing Ctrl+Left arrow or Ctrl+Right arrow will swap from one active Digital
Interface to the other. Digital Interface 1 will follow VFO A/Radio 1, Digital Interface 2 will
follow VFO B/Radio 2

 

3. The Digital Interface - Menu Selections

The digital interface has a menu at the top which is also a little different per type of interface
selected. As the differences are minimal, the menu items for all interfaces can be found below.

3.1. Selection: Soundcard as Interface

Setup

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

282 of 680 2/2/2011 4:54 PM



Settings - Setting up the Digital Interface, see the paragraph 'Setting up the Digital
Interface' below
Turn AutoTRXUPdate On/Off

If your radio's dial displays the actual transmitted frequency (i.e. the Mark
frequency in FSK RTTY), you would turn this option off
If your radio's dial displays the suppressed carrier frequency (e.g. SSB mode), you
would turn this option on. This causes the program to add (USB) or subtract (LSB)
the audio frequency from the digital engine to/from the radio's dial frequency so
that the frequency that appears in the Entry window, the Bandmap, the log and
spotted to the DX cluster is the actual transmitted frequency, not the suppressed
carrier frequency

Bring to Foreground when made Active - Bring the Digital Interface and Engine to the
foreground when its Entry window has focus

This adds ability to stack Digital Interfaces and Engines and have the correct one
on top when the associated Entry window has focus

SoundCard
Receive Mixer - Shows the Record control mixer dialog from the Windows
operating system. Only for Windows versions XP and earlier
Transmit Mixer - Shows the Play control mixer dialog from the Windows operating
system. Only for Windows versions XP and earlier

These menu items are not available when using the Fldigi engine
Setup MMTTY - The MMTTY setup is shown. This menu item is only visible when
MMTTY is selected
AFC On/Off with CQ - If set then the AFC will turn on with CQ message or TU
messages
NET On/Off with Run Change - Option to turn Net function on in S&P and off in
Running mode
Turn Hover Mode On/Off - With hover mode when you hold the mouse over a valid call
sign it places the callsign in callsign field in the Entry Window without having to click on
it

Where this works in use with 'Right click send Enter' is you hover over the call then
right click to plant the call and send your call when the station comes back to you
you click on the exchange to place it in Entry Window. Right click again send TU
and logs the Q. Right click, left click,right click and you're done...
Note: Your own call is excluded from being picked up
Hover mode is used in conjunction with the menu selection 'Rt Click= Return NOT
menu'

RT Click = Return NOT menu - When selected right clicking in the DI RX window will
send a Return instead of displaying a pop up menu

Check the menu item Hover mode for additional information
Send Text File - Send a text file. A file section dialog will open
Enable Digital Call Stacking - Used together with the {LOGTHENPOP} macro. See
Single Operator Call Stacking for more information
Open Add. RX Window (4 Avail.) - This allows you to open an auxiliary RX window for
diversity decoding of the same RTTY signal, e.g. by using a TNC in the main DI window
and MMTTY in the auxiliary window, or by using a different copy of MMTTY with a
different decoding algorithm to decode the same audio input
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There are up to 4 such windows available. They can be called up from either DI1 or
DI2

Interface
MMTTY - Select MMTTY or Other (TNC) as the interface

Requires MMTTY to be installed and the DI-1/2 path(s) to MMTTY to be set up in
the Configurer

MMVARI - Select MMVARI as the interface
No other installation required - the MMVARI engine is installed during the N1MM
Logger install

Fldigi - Select Fldigi as the interface
Requires Fldigi to be installed and the DI-1/2 path(s) to Fldigi to be set up in the
Configurer

Help - Shows help file

 

3.2. Selection: OTHER

Setup
Settings - Setting up the Digital Interface, see chapter below (Setting up the Digital
Interface)
Load TNC Settings File - Ability to load the TNC settings file named 'SETTINGS.TXT' to
the TNC. An example file which can be used for the PK-232 can be found on the website
when selecting 'Other Files'

Mode
RTTY - Select RTTY as mode
PSK - Select PSK as mode
Help - Shows help file

 

4. The Digital Interface - Setup

This setup dialog is for both MMTTY and MMVARI, this means that some settings are only for
MMVARI, MMTTY or both. When selecting 'Setup | Settings' in the Digital Interface window a dialog
like the one below will shown. Any changes made in the setup form must be saved by clicking the
Save Configuration Button located on the bottom of the form. Any changes made and saved will be
changed as soon as the setup area closes.

4.1. Tab: General/MMTTY Setup

This interface has general setup information for ANY type of interface (Soundcard of external TNC)
and some specific settings for MMTTY, MMVARI and Fldigi.
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Display Radio Freq and not Exact Freq in DI Caption
Check this option if you are using a radio mode that displays the actual transmitted
frequency rather than the suppressed carrier frequency (e.g. FSK RTTY)
Note that this setup option only affects the frequency that is displayed in the DI window.
To change the frequency that is sent to the Entry window and recorded in the log, see
the DI window's Setup > Turn AutoTRXOffset On/Off menu item

Add Callsign to Bandmap on Alt+G - (MMTTY and PSK) Option to send callsign from
station in callsign field (Alt+O) when doing a grab (Alt+G)
Remove Excess Linefeeds from RX Window - Ability to strip excess linefeeds from RX
Window
Send Space on Using Grab - Setting for sending space after grabbing call from grab window
(MMTTY) Send HamDefault on Run to S&P change - (MMTTY only) Ability to have Ham
Default(MMTTY) sent when going from Run to S&P to reset Mark Frequency. Select to enable
(MMTTY-MMVARI) Turn AFC Off when switching to S&P - (MMTTY and PSK) Ability to
Turn AFC Off when going from Run to S&P. Select to enable. Many people when in Running
mode will leave the Net Off and turn on AFC to find people coming back to them a little off
frequency. So to turn the AFC back off when you go to S&P (without forgetting) this setting
comes in handy
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Do Not add Dupes to Grab Window - Setting for adding dupes to Grab window or Not
Send Space on Using Grab - when doing a grab from the grab window it will also send a
space press command to Entry window to advance the cursor
If QSY Wipes call is checked Clear Grab Window on QSY - If QSY Wipes and Spot call is
checked then Clear the Grab window on wipe of callsign.
QSY will clear Grab Window - Changing frequency will clear the Grab window
Clear Grab Window On CQ - sending CQ will clear the Grab window

 

Callsign Validity Routines
Use Generic Routines - the generic routines will highlight anything that passes the
check routines (and probably will look like a callsign)
Use master.dta File - when selected only the callsigns in the master.dta file will be
highlighted

Highlight Color for non-Master.dta calls will be shown in the shown color.
Use Search routine to find Master.dta in Garbage Text - ability to turn off checking for
callsigns in garbage text in digital modes
Highlight Foreground Text - call sign text will be in the highlight color on the normal
background
Highlight Background of Text - background color surrounding call sign will be
changed to the highlight color

 

Digital Interface Window Colors
The RTTY receive and transmit window background colors, RX text color and own
callsign color in RX window can be changed here

 

Digital Interface RX Window Font Selection - Change the font and character size for the RX
channels. Press the 'Set Font' button to get a selection window

You must close the Digital Window and reopen it so the changes can take effect

 

MMTTY Window Settings
Normal - The normal size MMTTY window is shown, including waterfall/spectrum, menu
bar and control buttons
Small - The small size MMTTY window is shown, i.e. waterfall/spectrum display only
Control Menu's - Shows waterfall/spectrum plus menu bar
Control Button's - Shows waterfall/spectrum plus control buttons
Give MMTTY Help Starting - Turn MMTTY kick-starts off and on

 

Having trouble getting MMTTY to start?

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

286 of 680 2/2/2011 4:54 PM



 

Preferred RTTY Interface - Select the preferred RTTY interface. Choices are: MMTTY,
MMVARI, TNC or Fldigi

 

Preferred PSK Interface - Select the preferred interface for PSK (and other sound card
modes). Choices are MMVARI and Fldigi

 

On Top Settings
MMTTY always on Top - MMTTY is always in front of all other N1MM logger windows. A
restart of N1MM logger is needed to activate this function. Minimizing the N1MM logger
program will not minimize the MMTTY engine
MMVARI always on Top - MMVARI is always in front of all other N1MM logger windows.
A restart of N1MM logger is needed to activate this function. Minimizing the N1MM logger
program will not minimize the MMVARI engine
Fldigi always on Top - Fldigi is always in front of all other N1MM logger windows. A
restart of N1MM logger is needed to activate this function. Minimizing the N1MM logger
program will not minimize the Fldigi engine

 

Shift Frequency Compensation - for radios which use/need Shift Frequency Compensation
Enabled - Select to enable Shift Frequency Compensation
Offset Frequency - the frequency offset

 

Alignment Frequency - frequency used by the Align button = preferred audio frequency
MMTTY - RTTY alignment frequency. This is the Mark frequency
MMVARI - Alignment frequencies for MMVARI

RTTY - RTTY alignment frequency in MMVARI
NB Add 85 to place Mark Frequency on desired frequency. Example: For
2125 Mark, enter 2210

Other - alignment frequency for other modes than RTTY
FLdigi - Alignment frequencies for Fldigi

RTTY - RTTY alignment frequency in Fldigi
NB Add 85 to place Mark Frequency on desired frequency. Example: For
2125 Mark, enter 2210

Other - alignment frequency for other modes than RTTY

If you are having trouble getting MMTTY to initialize when the DI window starts up, here are
some things to try: First, upgrade to the latest version of MMTTY. Several cases of failure to
start have been solved by updating to version 1.68A. Next, if that doesn't work, try checking the
Give MMTTY Help Starting check box. If this box is already checked, try unchecking it.
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Save Configuration - Save the made configuration changes. If the changes made should not
be saved select the X in the upper right corner to close the window

 

4.2. Tab: MMVARI Setup

MMVARI Engine
Waterfall/Spectrum/Misc Color palette - The colors that make up the color palette can
be changed to represent whatever colors you would like. The colors go from the weakest
signal on the left to the strongest signal on the right. There is a color palette setting for
the Waterfall, Spectrum and for Miscellaneous colors. The Default button changes the
colors back to the default colors
Squelch Level - This level represents the noise level where you would like the interface
to start copying signals. 0 indicates an open squelch and everything will be decoded
High Pass Filter - Select 'Use High Pass Filter' to use the internal high pass filter for
RX. Although this is unnecessary with most soundcards, it sometimes is effective for
eliminating hum in the input audio
Spectrum Lower Frq - the lower frequency to display when the Spectrum view or
Waterfall is active
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Spectrum Upper Frq - the upper frequency to display when the Spectrum view or
Waterfall is active
CW ID

Enable - If this check box is checked (Enabled) the interface will send the string
entered in the field (Enter CWID String) in CW after every transmission. A * will be
substituted by SK, + by AR and = by BT

AFC Search Range - This is how far in Hz the interface will track a drifting signal i.e the
frequency sweeping width (+/-Hz) for the AFC

Sense Level - specifies the S/N level (dB) for the wide AFC. When the search
range is less than or equal to 50 Hz, the wide AFC does not function. The sense
level is applied to all the RX channels

Use TNC Software for control - When selected N1MM logger will release the serial port
for the TNC so the soundboard in the TNC can have control. When using an external
TNC the internal soundboard can be used
Digital Output Level - specifies the digital output level in the range of 0 to 32767. The
default value is 16384

 

DI1/DI2 MMVARI Soundcard
MMVARI Soundcard #

Input Soundcard# - Select the input soundcard to be used when there is more
than one soundcard in your computer (maximum 4)
Input Channel - Select the input channel. Mono, Left channel or Right channel
Output Soundcard# - Select the output soundcard to be used when there is more
than one soundcard in your computer (maximum 4)

FIFO
RX - specifies the depth of the RX FIFO. Valid values are 4 to 32
TX - specifies the depth of the TX FIFO. Valid values are 4 to 32

Clock - Soundcard Clock adjustment
RX - specifies the tuning parameters of the RX clock adjustment function
TX Offset - the offset of the TX frequency compared to the RX frequency
Graphical Adjustment - Graphical RX clock adjustment

The computer clock itself is not very accurate (+- 100 ppm); that is why to use
WWV or another precision source to calibrate the soundcard
1. Tune to WWV or another Time Mark; adjust so tick is on 1000 Hz in
Spectrum of MMVARI
2. Wait for line to appear in display and adjust Clock Freq so line appears
straight and not at an angle
3. Click button to save new frequency when line is straight up and down

 

MFSK (MFSK only)
Handling Center Frequency - When selected the center frequency is used for the
carrier frequency. When not selected the base tone frequency is used for the carrier
frequency
Use Metric Level Squelch - Select to use the metric level for the squelch. When not
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selected the S/N level is used for the squelch
# of MMVARI channels - Number of MMVARI channels to use. Choices are 1, 2, 3 or 4

Note that if this is set to 1, you have the option to select the Multi-Channel Rx menu item
in the MMVARI menu bar, but when it is set to 2, 3 or 4 this option is not available

Save Configuration - Save the made configuration changes. If the changes made should not
be saved select the cross in the upper right corner to close the window

 

4.3. Tab: Macro Setup

Digital Macro Set Select Interface Type and Window Number to begin - Update the macros
definitions and button texts

Select an interface (TNC or soundcard DI) from the drop down menu. Choices are:
MMVARI - macros for the MMVARI interface
MMTTY,Fldigi - macros for the MMTTY and Fldigi interfaces
Other - macros for the TNC
Dxp38 - macros for a DXP38

Click on the macro button which has to be updated
Type the macro text in the field 'Macro Text'
Type the button text in the field 'Macro Caption'
Click on the 'Save Macro' button when satisfied
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The selected macro caption text will be shown on the button
Available macros are shown in the box 'Available Macros'. First select a macro button to
see them all
The Macro buttons below (for TNC use only) have to be configured as TX/RX buttons.
Enter what control codes are needed to turn on and off your TNC

Only visible when Other is selected

RX - Receive macro, this will become the contents of the macro {RX}
TX - Transmit macro, this will become the contents of the macro {TX}
ESC - Abort macro, used when pressing the Escape key

Load Macros - Load saved macros from a saved file (*.mc) to the selected Digital Macro Set
Save Macros - Save macros from the Digital Macro Set to a file (*.mc)
# of Macros - Select the number of macro buttons. You can select 0, 8, 16 or 24
Macro Setup

Macro Text - Area where to create the macro text for the selected macro
Macro Caption - Macro caption from the button
Available Macros - Shows the available macros. Clicking on a macro will transfer it to
the macro text area
Save Macro - Save the created macro

Save Configuration - Save the made configuration changes. If the changes made should not
be saved select the cross in the upper right corner to close the window

 

4.4. Tab: WAE RTTY Configuration

This menu item will only show when the WAE RTTY contest has been selected and the information
in this tab is only valid for the WAE RTTY contest.
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RQTC - Under RQTC are the 4 messages to send when receiving a QTC
SQTC - Under SQTC are the 4 messages to send when sending a QTC
Default Number of QTC to Send - maximum of 10 QTC's
When sending request for single QTC do what?

Clear all data for that QTC
Clear only Bad Data
Do nothing just send request

Save Configuration - save the made configuration changes. If the changes made should not
be saved select the cross in the upper right corner to close the window

 

Digital - MMTTY for RTTY support

In this Section...

Digital - MMTTY for RTTY support
1. MMTTY Windows
2. Download, Configure and Test MMTTY

2.1. Download MMTTY
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2.2. Configure MMTTY
2.2.1. FSK KEYING

2.2.1.1. Using the RIGblaster Interface for FSK with N1MM/MMTTY
Combination

2.2.2. AFSK KEYING
3. Testing MMTTY
4. Dual Receiver/Dual Radio Setup
5. Using MMTTY

5.1. How to Tune RTTY
5.2. When Should I Use AFC
5.3. When Should I Use the NET Option: NET On/Off with Run Change
5.4. Why to Use "Auto Update TRX Offset w/Mark Freq."
5.5. Using MMTTY for 75 baud RTTY

The MMTTY soundcard interface is based on the MMVARI engine by Makoto Mori, JE3HHT.

1. MMTTY Windows

When using MMTTY two windows will open.

the Digital Interface window
is similar for MMTTY, MMVARI, Fldigi and external Interfaces (TNCs or TUs). More
information about external interfaces in the chapter 'Digital - External TNC Support'

the MMTTY engine window -
there are four versions which can be selected in the Digital Interface menu under
Settings.

Small version MMTTY engine window

 

Normal, or Large version MMTTY engine window

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

293 of 680 2/2/2011 4:54 PM



 

Control Menus - small window plus the menu bar (View, Option, Setup)

 

Control Buttons - large window minus the menu bar

2. Download, Configure and Test MMTTY

 

2.1. Download MMTTY

Download the current release of MMTTY (see Links chapter for URL)
At least version 1.64 is needed; version 1.68A is recommended

Run the setup program and install this to your computer (preferable) in its own directory
Don't install in the N1MM logger directory when using a MMTTY version from before July
7 2002. When uninstalling MMTTY all files in the install directory will be deleted and with
that also N1MM logger. MMTTY version 1.64 uses a new installer and does not have this
problem anymore

The NewExe contains the file XMMT.ocx needed for MMTTY version 1.64 or higher and should
be in the N1MM Logger directory after an update.

 

2.2. Configure MMTTY

 

2.2.1. FSK KEYING

1. Select >Config >Ports, Telnet Address, Other >Digital Modes tab
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Select Soundcard as your Interface type
Select for the selected Digital Interface as MMTTY, Mode FSK
Select the path to your MMTTY directory (for DI-2 if you are configuring for the second DI
window)

Select the 'Hardware' tab
Place a check mark under the Digital column beside the port that you are using for the
digital port
Click on the Set button and set the Dig Wnd Nr to 1 (or 2 if you are configuring for DI-2)

 
2. Save and exit

If MMTTY is already loaded you will probably get an error message about not being able to
open port xxxx

 
3. Open the Digital Interface window (under the Window menu)

Select the Interface > MMTTY menu item in the DI window
Select: Option > Setup in the MMTTY window, or use the DI window's Setup > Setup MMTTY
menu item

Select the TX tab and under PTT, set the serial port that you will be using for FSK
keying and data; this should be the same port that you checked the Digital box for in the
Configurer

If you are using a USB-to-serial adapter, or a control line other than TxD to do FSK
keying, you will have to select EXTFSK as the serial port and configure the port
and signal line information in the EXTFSK window

Select the Misc tab and check COM-TxD(FSK) for the Tx Port
If you are using a USB device to do FSK keying, click on the USB Port button and
set the option to C. Limiting Speed

Select the Sound Card tab (in MMTTY version 1.66G) and choose the correct sound
card for Reception (the Transmission sound card is not used in FSK)
Close the Setup dialog
Close the 'Digital Interface' to have the Logger and MMTTY save the settings

 

2.2.1.1. Using the RIGblaster Interface for FSK with N1MM/MMTTY Combination

 
The default for FSK via MMTTY is TXD. You'll need to change the jumpers when using a Rigblaster.
Also, make sure you get MMTTY working as a standalone first. Then you should just be able to
specify MMTTY (select Soundcard) in the Digital Interface config in N1MM and it should take off. If
you are lucky enough to have a radio where PTT is asserted via radio control ( Kenwood is one)
then leave the PTT unchecked in the port setup and checked in the PTT via rig control portion.

2.2.2. AFSK KEYING
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1. Open the Configurer (Configure Ports, Telnet Address, Other in the Config menu).

Select the Digital Modes tab
Select Soundcard as your Interface type.
Select for the selected Digital Interface as MMTTY, Mode AFSK
Select the path to your MMTTY directory (for DI-2 if you are configuring for the second DI
window)

Select the 'Hardware' tab
Place a check mark under the Digital column beside the port that you are using for the
digital port
Click on the Set button and set the Dig Wnd Nr to 1 (or 2 if you are configuring for DI-2)

 
2. Save and exit.

3. Open the Digital Interface window (under the Window menu)

Select the Interface > MMTTY menu item in the DI window
Select: Option > Setup in the MMTTY window, or use the DI window's Setup > Setup MMTTY
menu item

Select the TX tab and under PTT, set the serial port that you will be using for PTT; this
should be the same port that you checked the Digital box for in the Configurer
Select the Misc tab and check Sound for the Tx Port
Select the Sound Card tab (in MMTTY version 1.66G) and choose the correct sound
card for both Reception and Transmission
Close the Setup dialog
Close the 'Digital Interface' to have the Logger and MMTTY save the settings

3. Testing MMTTY

MMTTY is also a stand alone application. So testing can be done outside N1MM logger.

4. Dual Receiver/Dual Radio Setup

 
In a dual-receiver setup (SO2R or SO2V), you may wish to be able to copy two separate RTTY
signals (e.g. on two separate bands) simultaneously. To do this, you would open two Entry windows
(VFO A/Radio 1 and VFO B/Radio 2) and open the Digital Interface window from each Entry
window. You can then run MMTTY from each of these DI windows.

The two audio streams from the two receivers can either be decoded by two separate sound cards,
or in a single stereo (two-channel) sound card using the left and right channels for the two
receivers. In either of these situations, the two copies of MMTTY must have different configurations.
In the case of a dual radio setup, if you are using FSK on both radios and/or if MMTTY is used to
control PTT on both radios, each copy of MMTTY would also have to have access to its own serial
port for PTT & FSK. This is also true in SO2V setups in order to enable transmitting from either
VFO.
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These serial ports are configured in two places: in the Logger's Configurer and in MMTTY. In the
Configurer, you indicate which serial ports are used with check marks in the Digital column (Note: in
order to check two Digital mode ports in the Configurer, you must be in SO2V or SO2R mode). You
must also click on the Set button for each port in the Configurer and set the Dig Wnd Nr to 1 or 2,
to indicate which of the two DI windows that serial port will be associated with. You must also set up
each copy of MMTTY to use its respective serial port by choosing the relevant serial port in the PTT
& FSK Port box under the TX tab in the MMTTY Setup window.

In order to support separate configurations for the two copies of MMTTY, each copy must be
located in a separate folder. You can either use the main MMTTY program folder for one copy and a
separate subfolder for the other copy, or you can create two subfolders for use by the Logger,
leaving the copy in the main MMTTY program folder for stand-alone use. These subfolders must
each contain, at a minimum, a copy of the MMTTY.exe file and the UserPara.ini file from the main
MMTTY program folder. A copy of MMTTY.ini will be created the first time MMTTY is run from the
folder. Other files from the main MMTTY program folder may also be copied to the subfolders, but
they are not used.

The Logger's DI windows have an additional RX window feature as well. Up to four additional
RX-only windows can be invoked from the Setup menus in the two DI windows. These additional
windows can be distributed in any way between the two DI windows. They can use either hardware
decoders or MMTTY, but the most common use is for separate copies of MMTTY using different
decoding algorithms or profiles. Because they are receive-only, these windows do not need access
to serial ports and are not configured in the Configurer. However, to be fully useful they do need to
have separate setups from the main copy of MMTTY (e.g. to use a different decoding algorithm or
profile). Therefore, if you wish to use these additional RX-only windows with MMTTY, you will need
to create additional folders. one for each additional window, containing copies of the MMTTY.exe
and UserPara.ini files. These additional folders do not have to be created at the time you first install
MMTTY; you don't need to do this until you are ready to use the additional RX windows.

5. Using MMTTY

The macros for the Interface using MMTTY are different from the way they work with the TNC .
What ever you put in the macro will get transmitted. There is a macro keyword needed to turn
TX ON {TX} or TX OFF {RX}.
There is no special abort macro needed for use with MMTTY just using the ESC key will stop
transmitting.
The TX and RX buttons are for the free form typing in the TX window.
When MMTTY loads it loads the last used settings when the Interface was closed.

 

5.1. How to Tune RTTY

 

Use the VFO on your radio and dial in the peaks to match the 2 yellow lines on the spectrum
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Click view and the X-Y scope to see a crossed-ellipses tuning display
If the X-Y display seems to rotate in the wrong direction, open the MMTTY Option >
Setup window (or the DI's Setup > Setup MMTTY menu item), select the Font/Window
tab and check (or uncheck) the Reverse rotation button

Make sure you click the "HAM" button for proper shift etc.
The default values for the HAM setting can be changed under the Demodulator tab in
the MMTTY Option > Setup window

It's better to set AFC off when you are in a crowded section of the band and manually tune the
signals; if you leave AFC on, nearby strong signals may pull the tuning away from the signal
you want to copy
Also in crowded sections it can be helpful to use the built-in notch and bandpass filters
If you are using AFSK, normally you would use LSB on the radio

If you use USB, make sure you click the "Rev." button in MMTTY
If you are using FSK, you need to be aware that NET does not work, and that tuning in a
received signal by clicking in the waterfall or by allowing AFC to tune in the signal will result in
your receive frequency being different from the transmit frequency. The "HAM" button will
restore the correct audio frequency in your receive decoder but without retuning the radio. The
"Align" button in the DI window can be used to retune your radio so that the received signal is
lined up with your radio's transmit frequency

 
Periodically you may get a lost sound indication in the MMTTY window and the program may quit
responding to RTTY.

This should never happen but if it does, try increasing the priority with which MMTTY runs
from its default "high" to "highest". This is one step below the maximum "critical". This setting
is in MMTTY under Options, Setup MMTTY and the MISC tab..... Another effect this has is to
make the transition from RX-TX-RX smoother.

 

5.2. When Should I Use AFC

Use AFC (automatic frequency control) when MMTTY should automatically track the incoming
RTTY signal.
With AFC and NET turned on, MMTTY will track the incoming signal and also keep your
transmitter frequency locked to the received signal when using AFSK.

 
When MMTTY is set to transmit FSK, AFC will work on receive only. When in "Running" mode, you
want to keep your TX frequency stable, but with RX AFC set on you can pick up stations who reply
a bit off your frequency and copy the exchange without losing your TX spot. Just don't let the AFC
spread get too far from where you're transmitting.

A nice option to use is: AFC On/Off with CQ - If set then the AFC will turn on with CQ
message or TU messages. This way when Running the AFC is on and during S&P the AFC is
off. Check it.
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5.3. When Should I Use the NET Option: NET On/Off with Run Change

 
NET only operates in AFSK. If you are using FSK, your transmit frequency is fixed by your
transmitter, and the NET software feature does not work.

When in 'Search and Pounce' mode the program will check the NET option so that once you
tune a signal in, you will transmit on the same frequency you are receving him on (Warning:
this doesn't work in FSK)
When in 'Running' mode the program will uncheck the NET option, which allows your receive
decoder to follow an off-frequency caller while still leaving your transmit frequency unchanged

5.4. Why to Use "Auto Update TRX Offset w/Mark Freq."

 
If you are using FSK RTTY, most radios display the actual mark frequency on the tuning dial. A few
even do this in AFSK RTTY. If your radio is like this, you don't need to use this option. The DI
window title bar will display an offset frequency (radio dial (+/-) audio), but if this option is turned off
the offset frequency will not be logged and you can ignore it.

If you are using AFSK RTTY, especially with the radio in LSB or USB mode, as well as when you
are doing a sound card digital mode like PSK (using MMVARI or Fldigi), the radio probably displays
the suppressed carrier frequency on its dial. This is different from the mark frequency. If you are
using the default mark frequency of 2125 Hz, the radio's dial display will be 2125 Hz too high (LSB)
or too low (USB) as compared with the actual mark frequency. By checking this option, N1MM
Logger will perform the correction automatically and display the actual mark frequency in the Entry
window and the Bandmap window, as well as in the DI window title bar.

5.5. Using MMTTY for 75 baud RTTY

 
There are some RTTY contests that specify 75 baud (100 wpm) RTTY instead of the usual 45.45
baud (60 wpm) speed. MMTTY can be used for 75 baud RTTY, but there are a few quirks:

In the MMTTY Setup window, select the Decode tab, and at the top of the window, for
BaudRate select 75
The MMTTY HAM Default button cannot be used in 75 baud RTTY; if you press HAM, the
speed will be reset to 45.45 baud. Besides not pressing the HAM button in the MMTTY
window, there are a couple of other setup items you need to take care of:

In the DI Setup window, under the General/MMTTY Setup tab, make sure the following
item is NOT checked:
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(MMTTY)Send HamDefault on Run to S&P Change (if you forget to uncheck this
item, you will be switched back to 45.45 baud every time you switch from Run to
S&P)

If you are using FSK with a true serial port or with an interface that supports FSK without
using EXTFSK (e.g. a microHAM microKeyer), turn AFC off in the MMTTY window, and
make sure the following item in the DI Setup window is NOT checked:

(MMTTY - MMVARI)Turn AFC On/Off on Run Change (if you forget to uncheck
this item, AFC will pull your receive frequency off your transmit frequency and you
will be unable to use the HAM button to correct the situation)
In the DI Window's Setup menu, UNcheck AFC On/Off with CQ (same reason)

If you use EXTFSK for FSK keying (e.g. via a standard USB-to-serial adapter), you will
not be able to use this combination for 75 baud. EXTFSK does not support 75 baud.
Instead, you must reconfigure for AFSK
If you are using AFSK and like to use AFC, you may continue to do so, provided you are
careful to ensure that your transmit and receive frequencies stay together. The HAM
button is not available to re-align your transmit and receive frequencies. Therefore if you
are using AFC, you should have NET on as well, to keep your transmit and receive
frequencies together. (Note: NET does not work in FSK)

After the 75 baud contest is over, press the HAM button in the MMTTY window to restore the
45.45 baud speed. You can also restore any of the configuration options you changed for 75
baud in order to restore normal functioning

 

Digital - MMVARI for PSK and Other Modes

In this Section...

Digital - MMVARI for PSK and Other Modes
1. The MMVARI Interface

1.1. The MMVARI Interface Window
1.2. The Waterfall or Spectrum Window
1.3. Macros

2. Setting Up the Digital Interface
3. MMVARI Example: Make a PSK Transmission
4. MMVARI - Other

1. The MMVARI Interface

The MMVARI soundcard interface is based on the MMVARI engine by Makoto Mori, JE3HHT.

Supported are all modes from the MMVARI engine including bpsk (e.g. PSK31 and PSK63), qpsk-L
(LSB), qpsk-U (USB - e.g. QPSK63), also RTTY-L (LSB), RTTY-U (USB), MFSK-L (LSB) and
MFSK-U (USB) as well as non-standard modes GMSK (HF), FSK (V/UHF), FSK-W (V/UHF,
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satellite).

 
The MMVARI engine does not have to be installed separately, it is included in the N1MM logger
program program/update files and is the default digital engine when loading the digital window for
the first time.

1.1. The MMVARI Interface Window

The Digital Interface window when using the MMVARI engine is broken into several areas which will
be covered from the top down.

TX - Indicator to show which DI window the transmit is going to take place from (useful when
using two DI windows for SO2R/SO2V)
Letters/Figs - Shows the text under the mouse in the other case (FIGS/LTRS - RTTY only)
MouseOver - Shows the text which would be selected where the mouse is positioned over

 

In Logger versions before 10.9.5, MMVARI supported RTTY using AFSK keying only. As of
version 10.9.5, MMVARI is now capable of using FSK keying for RTTY (selected from the
Configurer under the Digital Modes tab). Note, however, that the "FSK" mode in the MMVARI
mode box is an entirely different mode - it is not FSK RTTY.

RTTY
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Receive Windows - The MMVARI engine supports from 1 to 4 receive windows. The number
of receive windows is selected from the DI window's Setup > Settings menu item in the Digital
Settings window under the MMVARI Setup tab at the lower right corner (# of MMVARI
Channels). All of these windows operate in the same manner and you are able to grab
callsigns from any of them and place them into the Entry window. Note that when the # of
MMVARI Channels is set to 1, a different method of multiple RX channels becomes available
(see The Waterfall or Spectrum Window below)

 
There is a colored pane on the left side of each receive window. By clicking on the colored pane you
can pause input to the receive window to scroll back through the (last 2000 lines of) text using the
scroll bars. When the window is paused the color of the pane will turn Yellow. To turn input to the
window back on click in the pane again and everything that was to be printed to the window will
now enter the window. When the receive window is paused it is possible to copy text in the window.

If you click on a callsign using your mouse it will be put into the callsign field in the Entry window.
Also, whenever a callsign is printed to any of the receive windows followed by a space it will be sent
to the callsign grab window for easy movement to the logging window by clicking the Grab button.

You can select any exchange info by single clicking on the sent info. This info will be transfered
over to the logger Entry window item by item after the callsign is filled in.

The top receive pane is the window used for making QSOs. Selecting another frequency for this
window is done by left clicking in the Waterfall or Spectrum window. Changing the frequency of the
other three receive windows is done by moving the numbered marker above the waterfall to the
desired location. You can also use the Swap buttons in the lower part of the Waterfall window to
exchange the selected window with the top receive window.

Transmit window - This is a free form typing window. If you click on the TX button the cursor
will be placed into this window and whatever is typed will be sent. The size of this window is
fixed at 2 lines
Callsign Textbox and Grab - When a callsign is encountered in one of the receive windows
(followed by a space) it will be placed in this textbox and when you press the Grab button it
will transfer the callsign over to the main logger window. The grab callsign window holds the
last 10 callsigns seen in the RX window. The most current one is at the top and is highlighted.
A right click in this box brings up a menu to clear list or selected callsign. Dupe callsigns will
not be shown in the grab window

 
Note: If the callsign in the callsign field in the Entry window is the same as the callsign in the
received text, the call in the Entry window does not get placed into the call list.

Clr RX - Clear all receive windows
TX - Places the interface into transmit, the transceiver is keyed, and places the cursor into the
TX window for input. See the Radio Interfacing section for Parallel and Serial port info on
configuring for hardware PTT
RX - This will place the interface back into receive mode after all the characters in the transmit
buffer have been sent. To abort transmit immediately without waiting for remaining characters
to be sent, press the Esc key
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Macro buttons - These buttons on the Digital Interface are up to 24 extra Macros for
preprogrammed messages. Configuring these macros is done in the Digital Interface window
under 'Setup, Settings' or by right clicking on them which brings up the Digital Setup window.
The macro buttons widths dynamically adjusts in relation to the width of the DI window
Grab - Transfer the selected callsign in the callsign text box to the callsign field on the main
logger window. The cursor advances to the exchange box ready to accept the exchange when
you click on it
CLR - Clears the grab window

 

1.2. The Waterfall or Spectrum Window

The MMVARI digital engine window - This window uses the MMVARI control from Makoto Mori,
JE3HHT. Across the top the title bar shows either the offset frequency (radio (+/-) audio) or the
radio's dial frequency, depending on a setup option. As you tune your radio this will update and the
numbers will change.

The screen shot here shows the window with four receive channels selected in the Digital Setup.
There are cursors corresponding to each of the receive windows. The inverted triangle cursor, filled
in in light blue, is for the main receive window. If NET is on, this is also your transmit frequency. If
NET is off, there will be another inverted triangle filled in in dark blue indicating your transmit
frequency. If you have more than one receive window enabled, a cursor with a number in it (1, 2, ...)
corresponds to each additional receive window. To change frequency for the main receive window
you can place your mouse pointer over a signal trace and click with your left mouse button. To
change frequency for one of the other receive windows, you can click on the numbered cursor and
drag it to the desired location in the waterfall.

TX Frequency and NET in FSK RTTY
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Buttons above the waterfall
TX - Start the transmission, the transceiver is keyed and places the cursor into the TX
window for input. See the Radio Interfacing section for Parallel and Serial port info for
TX/RX switching (PTT)
RX - Stops the transmission, the transceiver changes back to receive after all the
characters in the transmit buffer have been sent. To abort immediately, press the Esc
key
AFC - Turns AFC on or off. Selected (white) means AFC on (Note: This button is greyed
out and disabled when the Multi-Channel RX browser feature is enabled)
NET - Turns NET on or off. Selected (white) means NET on. When NET is on the TX
frequency follows the RX frequency (this function is inoperative in FSK RTTY)
Align - This is used to move the signal under the receive indicator to the Alignment
Frequency set up in the Digital Setup window. This can be used in most sound card
modes to center the received signal in your filter bandpass, and in FSK RTTY it is used
to align the received signal with your transmitter's signal

 
Example: Suppose the center of the filter pass band is 2200 Hz. When clicking on a signal at about
1400 Hz the signal may be difficult to copy unless you are using wide filters. To move the signal to
the center of your filter bandpass, click Align and the rig shifts and the spectrum frequency shifts
and places the station on the frequency that was initialized in the Digital Setup window in the
Alignment Frequency area. This allows you to narrow your filter bandwidth around the selected
signal. If you are using FSK keying for RTTY and if your receive frequency is not exactly on the
center frequency of your radio's mark/space tone pair (e.g. 2210 Hz for the standard 2125/2295
"high" tone pair), then you can use the Align button to retune your radio so your receive and
transmit frequencies will be aligned correctly.

Mode selection - Select the mode to use by clicking on this button. The Speed
selections are mode dependent. Selections are:

GMSK - MBCS experiment (HF) - Possible speed selections: 31.25, 62.5, 125, 250
not used for contests

FSK - MBCS experiment (V/UHF) - Possible speed selections: 31.25, 62.5, 125,
250

not used for contests
Do not confuse this mode with FSK RTTY - MMVARI's "FSK" mode is not
FSK RTTY. Starting with Logger version 10.9.5, MMVARI does support FSK
RTTY, but this can only be selected from the Configurer, not from the
MMVARI window

FSK-W - MBCS experiment (V/UHF, satellite) - Possible speed selections: 31.25,
62.5, 125, 250

not used for contests

Note that if you are using FSK keying in RTTY, MMVARI has no control over your transmit
frequency. Your transmit frequency in FSK RTTY is fixed by the radio. Therefore, moving the
dark blue transmit indicator does not change your actual transmit frequency in FSK RTTY.
Likewise, the NET function is inoperative in FSK RTTY.
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BPSK - MBCS experiment (HF) - Possible speed selections: 31.25, 62.5, 125, 250
for contesting purposes, BPSK and bpsk are equivalent

bpsk - Standard BPSK (e.g. PSK31) - Possible speed selections: 31.25, 62.5, 125,
250
rtty-L - BAUDOT RTTY (LSB) - Possible speed selections: 45.45, 50, 56, 75, 100,
110, 150, 200
rtty-U - BAUDOT RTTY (USB) - Possible speed selections: 45.45, 50, 56, 75, 100,
110, 150, 200

You may choose either AFSK or FSK keying method for RTTY in the
Configurer under the Digital Modes tab

mfsk-L - MFSK (LSB) - Possible speed selections: 15.625, 31.25
mfsk-U - MFSK (USB) - Possible speed selections: 15.625, 31.25
qpsk-L - QPSK (LSB) - Possible speed selections: 31.25, 62.5, 125, 250
qpsk-U - QPSK (USB) (e.g. QPSK63)- Possible speed selections: 31.25, 62.5,
125, 250

Speed selection - Select the speed to use in bps by clicking on this button. The speed
to select is mode dependent as described above
Main Channel receive frequency - audio frequency

In RTTY, MMVARI displays the center frequency, not the mark frequency as
displayed in MMTTY

Main Channel transmit frequency - audio frequency
Main Channel S/N reading

 

The Waterfall
At the top of the waterfall offset frequency (radio (+/-) audio) labels and tick marks are
displayed
Receive channel markers

Top markers (tag cursors)
1,2,... - frequency receive channel 1,2,...
N - indicates a notch filter

The light blue colored marker (inverted triangle on the waterfall) indicates the main
RX frequency
The dark blue colored marker (waterfall) indicates the TX frequency if it is different
from the main RX frequency (only possible if NET is off)

Mouse key clicking
Left mouse key clicking - single clicking in the waterfall will change the main RX
frequency

Right mouse key clicking - the audio frequency at the point clicked on will be
shown. Also a menu will show:

Set notch on here - adds a new notch filter on the selected frequency
indicated by a N in a yellow area. Multiple notches can be set; you can clear
an individual notch by right-clicking on the N
Delete all notches - all set notches will be removed
Set TX Carrier on here - can be used to set the TX frequency (with NET off)
Turn Off Bandpass Filter - Turns the BPF off
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RX 1 (2,3) Freq Here - can be used to set the RX 1, 2, or 3 frequency here
(only if the # of MMVARI Channels is greater than 1)

 
The left vertical indicator shows the signal level meter (green) and the squelch level (yellow line).
Biy clicking on it the squelch level can be changed.

Receive channels below the waterfall
If you have chosen to use more than one MMVARI channel, below the waterfall the
additional receive channels will be shown. The number of additional channels below the
main waterfall is one less than the total number of MMVARI Channels set, i.e. there can
be up to three additional channels (up to four MMVARI channels in total - to display
more than four channels, see the Multi-Channel RX feature below)
Mode - Select the mode to use for this receive channel
Speed - Select the speed to use for this receive channel
Receive channel frequency
Receive channel S/N value
AFC - Turns AFC on or off for the selected channel. Selected (white) means AFC on
Squelch indicator - The squelch can be adjusted by dragging the line indicator to
where you want it and turning off the squelch by dragging it all the way left
Miniature waterfall display - shows within 500 hz of the signal that that channel is on.
You can click anyplace in this miniature waterfall or drag the indicator to where you want
it
Swap - Exchanges this receive window with the main receive window. While working one
station, you can dial the second station in via a second receive window and after you
finish the first contact just hit swap button and then call the other station. See below for
an alternative method of multi-channel receive

 

Menu at the Top
BPF - Used to enable/disable an internal audio Band Pass Filter. The BPF filter has
steep skirts and 80db of rejection outside the bandpass. However, because it is in the
sound card and not in the radio, it has no effect on unwanted signals inside the radio,
i.e. a strong unwanted signal inside the radio's IF filter bandpass can still trigger the
radio's AGC and cause gain blocking, even though the signal has been rejected in the
sound card by the BPF. You can only prevent this by selecting narrow filters in your
radio

Enable/Disable BPF - turns BPF on or off
Wide 1000 Hz, Middle 500 Hz, Narrow 250 Hz, Ultra Narrow 100 Hz, Custom -
filter bandwidth settings (grayed out when the BPF is disabled)

To set Custom width after enabling the BPF, left click in the waterfall where
you want the BPF bandpass to start. Drag your mouse with the left button
held down and release it where you want the BPF bandpass to end. The
waterfall display will immediately relect the chosen Bandpass. This makes it
simple to eliminate an offending station on the fly
The minimum width of the BPF that can be set is 100 Hz

The BPF can be turned off by selecting Disable BPF on the BPF menu or by right-
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clicking in the waterfall and selecting Turn off bandpass filter
The BPF settings are retained when you close and reopen the digital engine
window

ATC - Used to turn Automatic Timing Control (ATC) on or off. It is recommended to keep
ATC on all the time for better signal decoding

when RTTY is selected ATC is always off
in MFSK mode ATC is always on

FFT - FFT is Fast Fourier Transform, which is a method of extracting the spectrum out of
a waveform. That is the basic tool that gives the waterfall and spectrum scope displays

FFT Type - Select the FFT display method. Selections are: Spectrum, Waterfall,
Sync or Wave Input
FFT Width - Select the display width (frequency range). Selections are: 250 Hz,
500 Hz, 1000 Hz, 2000 Hz, 3000 Hz or User Defined. User Defined width is set in
the Digital Setup window
FFT Scale - Select the vertical scale to use. Selections are: 100 dB, 60 dB, Square
Amplitude
Waterfall AGC - Turn the waterfall AGC on or off
Align after Left Click - Automates the Align process. Any time a signal is clicked
on in the waterfall, an automatic Align operation is performed to re-center the audio
frequency on the Alignment Frequency you have selected in the Digital Setup
window

SHIFT - Shift selections. The choices are 170 Hz, 200 Hz, 23 Hz or User Defined
Only in RTTY-L, RTTY-U and GMSK

RTTY Demodulator - select either IIR or FFT decoder. Depending on conditions, one
may decode better than the other

Only in RTTY-L and RTTY-U

 

Multi-Channel Rx - This feature is only available when the # of MMVARI Channels
in the Digital Setup window under the MMVARI Setup tab is set to 1. It is an
alternative method of receiving multiple signals simultaneously with MMVARI

Enable (or Disable) Multi Channel RX - turns this feature on or off
When the Multi-Channel RX feature is turned on, there will be several
numbered tag cursors at the top of the waterfall, and a separate browser
window will open (see below). The number of channels is user-selectable
(from 2 to 24)
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Each line in the browser window shows text decoded under the
corresponding numbered cursor
There is only one RX pane in the Digital Interface window, which displays text
from the main RX signal under the light blue inverted triangle cursor
You can move the main RX cursor to the position of any of the numbered tag
cursors simply by clicking in the corresponding small text window
You can use this feature to keep track of several separate signals being
received. You can work each one in turn by clicking in the corresponding
numbered text window to move the main RX/TX frequency (with NET on) to
each numbered cursor position in turn

Set Number of RX Channels - you can select from 2 to 24 channels to display in
the browser window
Set AFC Search Level - Used to set the signal level (S/N ratio) used to determine
whether a signal is strong enough to activate the AFC and cause the RX frequency
to move to it (can be set from 1 to 20 dB)
Set AFC Search Range - Each extra RX channel has AFC (automatic frequency
control) which moves the cursor to keep it centered on a signal if the frequency
changes slightly. This menu item is used to set the frequency range over which
this feature operates (can be set from 100 to 500 Hz)
Set Spectrum Search Frequencies - Allows you to set the lower and upper limits
for the browser channels. The lower limit can be 250 Hz or higher, and the upper
limit can be 2700 Hz or lower

 
The Multi-Channel RX method allows you to keep track of more channels than the older # of
MMVARI Channels method that you set up from the Digital Setup window. The displayed "memory"
for each channel is less (only the size of the small scrolling text window, instead of one of the RX
panes in the main DI window). You cannot click directly on call signs in the small scrolling windows;
you have to first change the main RX window to the chosen signal and then click in the DI window.
The older method also allows you to change modes in the extra channels independently (i.e. to
receive signals in two different modes simultaneously). However, although this newer method is
less full-featured than the older method, you may find it easier to use, especially in a contest
situation. Try them both to see which you prefer. (For yet another way to do multiple receive in PSK
only, you can also try the PSK Browser in Fldigi).
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Browser window for Multi-Channel RX

Setup menu
Set On Top - check this if you want to ensure that the browser window is always on top
of other windows
Set AFC Width - set the frequency range for AFC in each browser channel
Set AFC Level - set the signal level that activates AFC

1.3. Macros

The macros for the Interface using MMVARI are different from the way they work with the TNC
. What ever you put in the macro will get transmitted. There is a macro keyword needed to
turn TX ON {TX} or TX OFF {RX}
There is no special abort macro needed for use with MMVARI just using the ESC key will stop
transmitting
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The TX and RX buttons are for the free form typing in the TX window
When MMVARI loads, it loads the last used settings when the Interface was closed

 

2. Setting Up the Digital Interface

The setup dialog is for both MMTTY and MMVARI, this means that some settings are only for
MMVARI, MMTTY or both. When selecting 'Setup | Settings' in the Digital Interface window a dialog
wil be shown which is both for MMTTY and MMVARI. Please check the setup information in the
Digital Setupchapter.

3. MMVARI Example: Make a PSK Transmission

We need to make room for the Digital Interface so for now minimize the Logger Telnet/Packet
window
Now select 'Window | Digital Interface' and the Digital Interface and the Waterfall/Spectrum
window will open. The Digital Interface dialog can be positioned and resized on your monitor
as desired
Left clicking on a call will grab the callsign. Right clicking on the RX and TX window will pop a
menu (S&P mode) or send the Exchange function key in Running mode
Pressing Insert will Grab the highlighted call and sends His call followed by the Exchange
button
Double clicking on a callsign in the callsign box from the Digital Interface sends that call to the
Entry window
A callsign is automatically highlighted if recognized by the program. For that to happen it
needs to have a space before and a space after the callsign. If the first thing on a new line in
the Digital Interface window is a valid callsign, it is not highlighted or added to the grab list

 

4. MMVARI - Other

The Radio Frequency display on the Waterfall and Spectrum display follows the active Radio
Frequency
The last PSK mode used is remembered, so the next time the last used mode is selected.
Getting (PSK) object errors during program start or starting PSK?
During transmit, callsigns are not grabbed from the receive window.

 

Digital - Fldigi for Sound Card Modes

In this Section...
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Digital - Fldigi for Sound Card Modes
1. The Fldigi interface
2. Download and Configure Fldigi

2.1. Download Fldigi
2.2. Fldigi Initial Configuration

3. The Fldigi Interface Window

1. The Fldigi interface

 
The Fldigi sound card interface is based on the fldigi code by Dave Freese, W1HKJ.

Fldigi supports a wide variety of digital modes, including not only AFSK RTTY and PSK, but also
other less common modes such as MFSK, MT63, Olivia, Throb, etc.

Fldigi does not support keying outputs on serial or parallel ports, as used by N1MM Logger for CW
and FSK keying. However, although it does not support transmitting in CW mode, Fldigi can be
used as a CW receive decoder within the Logger.

Fldigi is a stand alone application, so you can use it from outside N1MM Logger as well. Note that
the configurations for Fldigi stand-alone and within the Logger are separate, i.e. changes made to
the stand-alone configuration will not be applied to the configuration within the Logger, and vice
versa.

2. Download and Configure Fldigi

 

2.1. Download Fldigi

 

Download the current release of Fldigi from the W1HKJ website at http://www.w1hkj.com/  .
You can find a copy of the full installer for the current version of Fldigi at that website. This file
is a self-extracting executable, similar to the N1MM Logger installer. Download the installer file
to a temporary folder and then execute it. It is recommended that you install Fldigi in its own
program folder and not in the N1MM Logger program folder. By default, the installer will install
Fldigi to C:\Program Files\Fldigi-x.xx.xx\, where x.xx.xx is the Fldigi version number.

 

2.2. Fldigi Initial Configuration
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After Fldigi has been downloaded and installed, open the Configurer and set up the path to Fldigi
under the Digital Modes tab. After closing the Configurer, choose a contest in N1MM Logger that
supports digital modes, select the Logger's Window > Digital Interface menu item, and then in the
Digital Interface window, select the Interface > Fldigi menu item.

When you first open the Fldigi interface from the Logger, and also any time you install a new
version of Fldigi, you will be prompted to fill in some configuration information by the Fldigi
configuration wizard, as follows:

Operator information - You do not need to fill in any of this information
Audio devices - Under the Devices tab, check the PortAudio box and select the sound card
you are using for both Capture and Playback
Transceiver control - Select the XML-RPC tab, check the Use XML-RPC Program box, and
click on Initialize

If you are using hardware PTT controlled by the digital interface, select the Hardware
PTT tab, check the Use separate serial port PTT checkbox, select the appropriate
COM port in the Device: window, and check either Use RTS or Use DTR, depending on
which one your hardware setup uses. If the label on the Initialize button is red, click on
the button

 
The Fldigi configuration wizard does not automatically save these settings. After you have exited the
configuration wizard and the main Fldigi interface window has opened, you must save the
configuration settings using the Fldigi Configure > Save Config menu item. If you don't do this,
then every time you open the Fldigi window you will have to go through the configuration wizard
steps again.

3. The Fldigi Interface Window

 

 

Menu
File

Exit - closes the Fldigi window

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

312 of 680 2/2/2011 4:54 PM



Op Mode
CW - receive-only
PSK - select BPSK-31 for normal PSK31, BPSK-63 for PSK63, etc.
RTTY - select RTTY-45 for normal 45 baud AFSK RTTY
Other selections can be used for other modes - see the fldigi help for details

Configure
Waterfall - under the Display tab, you can select whether to show audio or RF
frequencies in the scale at the top of the waterfall, and whether to display
transmitted as well as received signals
Rig control - XML-RPC should have been selected during the initial configuration.
You can use the Hardware PTT tab to change the PTT settings for a separate
hardware PTT port
Sound card - you can select the sound card to be used by Fldigi under the
Devices tab
Modems - this is where you make configuration changes that apply to specific
modes only (e.g. PSK-specific changes, or RTTY-specific changes)
Save Config - use this to save the new configuration any time you make changes

View
PSK Browser - opens a browser window that can display up to 30 signals within
the waterfall simultaneously (PSK only). To configure this browser window, use
Fldigi's Configure > Modems > PSK > Viewer configuration window to set the
number of channels, the starting (lowest) audio frequency (channel separation is
100 Hz), and various other parameters

 
Most Fldigi menu items not mentioned above are either not used by N1MM Logger, or perform
advanced functions that are not needed for basic operation. See the fldigi help at the W1HKJ web
site for more details (there is a link to the Fldigi-Help page from the download page at
http://www.w1hkj.com/download.html ).

Note also that when the Fldigi engine is selected, additional buttons appear in the Logger's Digital
Interface window:

Align - for retuning the radio so that the desired signal is aligned on a pre-configured
frequency
Lock - to lock the transmit frequency at the present position in the waterfall while allowing the
receive frequency to vary (for operating split)
Rev - in sideband-sensitive modes like RTTY, reverses the tones

 

SO2V/SO2R Limitation
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Digital - External TNC Support

In this Section...

Digital - External TNC Support
1. The Digital Interface
2. Setting Up the TNC in the Configurer
3. Test Your External TNC
4. Additional Macros for the External TNC Interface
5. HAL DXP38 Setup

5.1. Hardware Setup
5.2. Software Setup in N1MM logger
5.3. Known Problems

6. HAL ST-8000 Setup (not supported)
7. KAM Setup
8. PK-232 Setup

8.1. Setting up the PK-232
9. SCS PTC Setup

The Digital Interface will not only work with MMTTY, MMVARI and external TNC's like the PK232,
HAL DXP38 but with ANY TNC.
This is because the commands for the TNC are not hard coded into the program. This has to be
done by the user of the program 

Information about the following external TNCs can be found below but as already stated ANY TNC
can be used with N1MM logger which uses serial communication.

1. The Digital Interface

The Digital Interface can be used with any external TNC.

There is a basic limitation in the Fldigi engine which can make it harder to use in dual-receiver
situations (SO2R and SO2V). Fldigi always receives in mono mode. If you are using a stereo
sound card to decode two receivers, with one receiver in the left channel and the other receiver
in the right channel, Fldigi will combine the two receivers in its waterfall. It doesn't matter
whether Fldigi is the interface engine in DI1 or DI2, it will see the audio from both receivers.

 

Therefore, if you want to use Fldigi with both receivers in a two-receiver setup, you will need to
use two separate sound cards for the two receivers. You will also need to install two copies of
Fldigi in two separate program folders in order to allow a different sound card to be configured
in each copy.
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Using a TNC will show an interface like the one above.

2. Setting Up the TNC in the Configurer

Start the N1MM Logger application1.
On the Logger Main Window select >Config >Configure Ports, Telnet Address, Other >Digital
Modes tab

2.

In Digital Setup
Choose Other for Interface1.
Set other parameters accordingly (Example settings: Com 4 ,9600 ,8 ,N ,1, RST-Xon)2.
Save the configuration < OK >3.

3.

Load the Digital Interface from the Window menu4.
Create your Abort macro (This should be in the upper left corner) by right clicking on it. This
will open up the RTTY setup area. Click on the same macro and enter what ever key
sequence you need to abort transmission and save the macro

5.

Example PK-232: {Ctrl-C}R{ENTER} Save the macro

You should be ready to copy RTTY make sure your interface is set to copy 45 baud and 170
shift. You can configure a macro key to change this or you can type the key sequence needed
in the transmit window and it will get sent to the TNC

1.

 
That should be it. You will need to add the CTRL keys that turn on and off the TNC
Example CQ macro for the PK-232: X{ENTER} CQ CQ CQ TEST DE {MYCALL} {MYCALL} K
{Ctrl-D}

3. Test Your External TNC

Test stand-alone
See the separate sections for the PK-232, KAM, HAL etc. If your TNC is not mentioned please
set it up like the other mentioned TNC's
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Make sure your radio and TNC work on your computers serial port by testing them with an existing
terminal program. Connect your TNC/Radio into your computers serial port. The Hyperterm terminal
program is included with Windows and works well. Make sure you note all COM port parameters.
You should be able to tune in a RTTY signal and print it using the Hyperterm program. The
Windows Hyperterm is geared toward modem communications and is not especially intuitive for
direct COM port use. As stated previously, you can use any number of terminal emulator programs.
For example, the Tera Term Pro 3.1.3 by Ayera Technologies is a small, open source, free terminal
emulator that is available for download.

The interface has been tested with the three mentioned TNC's below and works fine with them. Any
other TNC should also work as long as you place the right commands for that TNC in the macros.

4. Additional Macros for the External TNC Interface

The Digital Interface will accept all of the Macro keywords that can be used in the Packet window
and other places in the Logger and will also accept the following:

Ctrl+A Ctrl+B Ctrl+C Ctrl+D Ctrl+E Ctrl+F Ctrl+G

Ctrl+H Ctrl+I Ctrl+J Ctrl+K Ctrl+L Ctrl+M Ctrl+N

Ctrl+O Ctrl+P Ctrl+Q Ctrl+R Ctrl+S Ctrl+T Ctrl+U

Ctrl+V Ctrl+W Ctrl+X Ctrl+Y Ctrl+Z Esc Enter

 
Macro keywords can be used in any of the macro buttons or the Logger function keys..

The TX window will accept all control key commands except for the Esc key, this must be sent as a
Shift+Escape combination.

Remember that when to set up a macro key that is not a TNC command you will need to include the
sequence to key the TNC before it sends. If you click on the macro without the TNC transmitting,
your TNC will think it is a command being sent to it and not know how to process it.

TNC users have to enter in whatever CTRL characters are needed to turn on and off your specific
TNC.

To use the free form typing in the TX window you need to create a macro that will key your TNC and
another to Turn it off. Click the macro that starts transmitting and then click in the TX window.
Whatever you type will be sent outÃƒÂ¢Ã¢â€šÂ¬Ã‚Â¦ then click the macro to turn things off after you
are done.

5. HAL DXP38 Setup

By Brian, K3KO

The following instructions will get the HAL DXP38 TNC up and running for FSK in N1MMLogger. I
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admit to not trying AFSK but it should work. This implementation is not elegant but does work with
some 'features' of its own. There is a built-in tuning indicator accessible through macro toggles. The
implementation is very basic but is working, there are other programs around if you want all the
bells and whistles. Thanks go to N2AMG for making the program changes necessary to
accommodate HAL commands.

Since there is essentially only one way communication between N1MMlogger and the DXP38 in the
command mode, don't expect error checking or error detection. It is assumed that turning on the
DXP38 properly loads the internal software. No capability exists here to do such. No capability
exists to update the internal programs. This must be done with the HAL software. My unit uses the
latest update .LOD and .S28 files from the HAL website http://www.halcomm.com. It is not clear
that the updated files are needed here. However, the reason given for the update was to fix a PTT
error with another program. So if you are having problems with PTT activation, these updates may
be appropriate. Unless you alter the attached initialization macro, you must use LSB RTTY for FSK
or LSB for AFSK..

There are three distinct phases - Hardware setup, Software Setup, and Use. The last section
discusses two problems that have cropped up and solutions found.

5.1. Hardware Setup

It is recommended that one first get the DXP38 running with WF1B, HAL or a known 'tried and true'
software package first. Doing so eliminates the need to troubleshoot both hardware and software
when configuring N1MMLogger. Hardware setup:

Connect the PTT and FSK lines to the rig1.
Connect the COM port (1 for HAL software) to the TNC2.
Connect audio input to the DXP-383.
Connecting the power4.
Connecting AFSK output to the rig (AFSK only)5.
Consult the DXP-38 manuals for the details. The rig must be set FSK RTTY (LSB) or LSB for
AFSK

6.

 

5.2. Software Setup in N1MM logger

There are three parts in setting up N1MM logger to work with the HAL DSP38. Make sure the
version of N1MMLogger being used supports the DXP38 hexadecimal commands.

Port configuration - The DXP38 port should have checkmarks in digital and set. DTR/RTS should
be set to always on.

Digital configuration - On the digital configuration dialog
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Choose a free port and configure it for 9600 baud, N,8,1 and no handshaking
It works fine on the first port but was not tried yet on the second channel. Nor have I
tried using two channels
I have been able to get the DXP38 to run on the first port and MMTTY on the second
port

 
Macro Creation required to initialize and control the DXP38

These macros are the 24 box macros not the function keys
Important. This process is error prone. Go to the N1MM logger directory and create a
backup of the MDB file in use. If you don't, the results of an error in the macros could be
unpleasant. The program may give one a 'type mismatch' error which may not be
correctable without either a whole new logging file or somehow editing the .MDB file
(using Access) to remove the error. If one does cause this error to happen, just copy the
backup file to the original file name. It is a good idea to do the macro creation in steps
with backups along the way. N2AMG has some coding in place to help avoid the
unpleasantness

Command structure
The HAL DXP38 expects commands in the form of two hexadecimal bytes. The first byte
is hexadecimal 80 and the second is the hexadecimal command number. Some
commands require a second set of two bytes giving the value of a parameter being set.
These commands look like {H8084} on the macro page. The {} tell N1MM it is a function,
not text. The H triggers the routine which reads what follows as two hexadecimal, one
byte numbers and sends them to the DXP38. The first number is always 80. Note: Only
the numerals 0-9 and the letters A-F can be used to define the hexadecimal number.
Use of any other characters within {} will produce a type mismatch and unpredictable
operation. Any text character not in {} is considered text to be sent by the DXP38. As
such, it will put the TNC into the transmit mode. The TNC will not return to the receive
mode at the end of the macro unless a {RX} is present
Common errors: the use of ( >s instead of {, the letter O for a zero, lower case L for a 1

Macro programming
Right click on an empty macro box on the RTTY TNC screen. This will open the macro
editing screen which has to be edited. Make sure the commands are of the form {H80xx}.
Be very careful with the syntax. There must be four digits and a leading H. Save the
macro file and save the configuration. The example uses the macro 'Other 1' and saved
the file under 'Other 1.mc'
The HAL command set included in the DSP4100 TNC technical documentation at the
HAL website
The printout of the macro file below shows an example

The ESC macro under the TX, RX definition box and (it is no longer the first macro
box)
The INIZE macro is the initialization macro

Although shown on two lines in most editors, it is programmed as just a
series of commands in N1MM
The last command is a return to RX (in hexadecimal). This initialization macro
establishes the following TNC characteristics: FSK, BAUDOT, 45 baud,
normal FSK mark, normal tones, USOS on, force to letters, TX/RX polarity
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the same, diddles on, squelch level set to 15, PTT delay =200 ms for XMIT
and 100 ms for RX, transmit text echo and tuning indicator on

There are three levels of squelch control provided. The second word in the macro
contains a 80nn. The nn is the squelch level. Zero is the lowest and 99 is the
highest. You may have to tailor these to your particular radio. RXnorm and RXinv
permit inversion of received signals. Echo y (echo yes) and Echo n (echo no)
permit echoing of the transmitted characters as they are sent in the received
screen area
Fnar, Fmid, Fwide are the filter width selection macros (55Hz, 75Hz, 100Hz)
B45 sets the baud rate to 45 baud. If you want another rate change the 8000
command to 800x, where x =1, 2, 3, 4, 5 for 50, 57, 75, 100, 110 baud respectively
Tun on and Tun off control the tuning indicator. The tuning indicator is a freq offset
bar indicator with a center zero position. Turn the radio knob towards the bar until it
aligns with the center mark. This indicator currently has one problem. It can't be
used with call capture. The frequency offset data being sent back confuses the call
capture logic

Turn On using {H805D}
Turn Off using {H804D}

 
An Example Macro file (other 1.mc) is available for download from the N1MM website (Other
files)

First time startup

Start up N1MM logger first
After the program loads, make sure focus is on the TNC received text screen. Then turn
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on the DXP38. If the data link is OK , an @ will be printed on the screen. You will have
to create the macros the first time, save the configuration and save the macros to the file.
I saved them to the 'Other 1.mac'

Subsequent startups
Turn on the DXP38. Start N1MM logger. Click on the INIZ macro. One should see a text
rendition of the initialization process on the screen. See the picture above. If the function
keys have not been defined yet, do so. Almost without exception, end with an {RX}. The
call sign in the S&P mode might not have the {RX} command. Now use the program as
one would a CW or SSB contest. Call capture as well as the insert key work just like the
CW mode Note: The initialization macro puts the TNC and rig in the transmit mode. No
other macros do unless one embeds text characters, spaces or a {TX} command.

 

5.3. Known Problems

I have experienced some occasional problems on start-up and shutdown.

Startup - Sometimes the DXP38 and N1MM logger just don't want to communicate. The TNC won't
accept the initialization commands. The cure is to shut off the TNC and wait about 45 seconds.
Shutdown N1MM logger. Start up the TNC and wait until it has finished its internal initialization.
(LED indicators have stopped flashing). Restart N1MMLogger. This may be a problem I have with
the COM3 port here and you may never see it.

Shutdown - About half the time the DXP38 will go into the transmit mode when N1MMLogger is
shutdown. The cure is to turn off the DXP38. Hopefully a more graceful shutdown can be
developed.

6. HAL ST-8000 Setup (not supported)

The HAL ST-8000 TNC is not supported and will not work with N1MM Logger as the baud rate used
by the HAL is 45 baud and the serial port control in N1MM only will go as low as 110 baud...

7. KAM Setup

Launch Hyperterm and set its parameters to 9600 bps, 8 databits, no-parity, 1 stopbit and no
flow control
Connect the KAM to the port configured in Hyperterm
Turn on the KAM
When you see the message 'Press (*) to set Baud Rate, press the "*" button'
Then set your callsign as prompted
To place the unit into RTTY mode type "RTTY"
Also make sure the unit is set up for software handshaking XFLOW = ON
Once you are communicating with the KAM and have it in the RTTY mode, you can also tune
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in a RTTY signal and it will decode and print on the Hyperterm window
Now try to transmit by typing a Ctrl+C and a "T" on the keyboard followed by several
characters that you wish to transmit. To get back to receive, type a Ctrl+C and a "R"
If you have problems, consult your KAM manual
Now exit the Hyperterm program and start Logger

 
Below are sample RTTY settings for the KAM TNC

AUTOCR 0 AUTOLF ON AUTOSTRT OFF

BKONDEL ON CD SOFTWARE CRADD OFF

DIDDLE ON ECHO ON FILTER OFF

FSKINV OFF INVERT OFF LFSUP OFF

LOWTONES OFF MARK 2125HZ RBAUD 45

SHIFT 170 SPACE 2295HZ USOS ON

XFLOW ON XMITECHO ON

 
There are three parts in setting up N1MM logger to work with the KAM.

1. Port configuration

The KAM should have a checkmark in digital

2. Digital configuration

On the digital configuration dialog
Choose a free port and configure it for 9600 baud, N,8,1 and none

3. Macro Creation required to control the KAM

Set the TX macro to: {Ctrl-C}T
will go into transmit
Set the RX macro to: {Ctrl-C}E
return to receive after the message is completed
Set the ESC macro to: {Ctrl-C}R
this will immediately return the system to receive before sending any text
For example

CQ macro: {TX} CQ CQ CQ DE W3PP W3PP W3PP KKK {RX}

 

8. PK-232 Setup

Make sure the PK-232 autobaud is set and the unit is set to RTTY mode
Launch Hyperterm and set its parameters to 1200 baud, 8-data, no-parity, 2 stop bits, and no
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flow control
Connect the PK-232 to the port configured in Hyperterm
Turn on the PK-232
Type a few "*" characters so your PK-232 will autobaud to the 1200 baud rate
Now place the PK-232 in the RTTY mode by typing the command "BAUDOT". It should
respond OPMODE now BAUDOT
Turn the threshold pot full clockwise and make sure the LED is on
Also make sure the unit is set up for software handshaking XFLOW = ON
Once you are communicating with the PK-232 and have it in the BAUDOT mode, you can also
tune in a RTTY signal and it will decode and print on the Hyperterm window
Now try a transmit by typing a "X" on the keyboard followed by several characters that you
wish to transmit. To get back to receive, type a Ctrl+C and a "R"
If you have problems, consult your PK-232 manual
Now exit the Hyperterm program and start Logger

 

8.1. Setting up the PK-232

By John VK4WPX / VK4CEJ

Setting up the PK-232 for RTTY is very simple and straightforward.

First, open the 'Configurer' (On the main logging window click Config, Configure Ports, Telnet
addresses, Other)
Click the Hardware tab

Click in the box adjacent to the COM port that you have your PK-232 connected to in the
column labeled 'Digital'
See picture below, the example here shows the PK-232 on COM-2
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Next, click on the Digital Modes tab and set up the Digital Interface 1 parameters
The example in the picture below shows that the PK-232 is set for 9600 baud, no parity
and 8 data bits
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Setting up macros and the main logging window "F" keys for the PK-232 is also really very simple.

Modify any existing macros that came pre-configured by replacing every instance of ' {TX} '
with ' {Ctrl-C}Xmit{ENTER} '

I found that the command did not work every time unless it was followed by the {ENTER}
or, if the macro does not have {TX} or {RX} in it and you want it to start transmitting or go
to receive, add those commands and, replace every instance of {RX} with {Ctrl-D}

Example: F1 "CQ" macro would therefore be " {Ctrl-C}Xmit{ENTER}CQ CQ CQ DE * * *
K{Ctrl-D} "
Example: F5 macro "Hiscall" would be " {Ctrl-C}Xmit{ENTER}! "

Which would leave the rig in transmit mode so that you could type more info in the
transmit window
To return to receive, press Ctrl+D (hold down the Ctrl key and press D)

 

9. SCS PTC Setup

Take the PTC as you use it for other digimode programs e.g. ALPHA (by DH7RG), XPWIN (By
KF7XP), LOGGER (by K4CY)
Set the PTC to SERBAUD 19200 (not AUTO ! ) > switch the PTC OFF
Start N1MMLogger and go to 'Config | Configure Ports, Telnet Address, Other', Select the tab
'Digital Modes'. Set 'Digital Interface 1 TU Type' to 'CW/Other', set the used serial port to
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19200 Baud, N-8-1-none. Set the 'Digital Interface 2 TU Type' to 'None'. Save with 'OK'
Click on Windows and select Digital Interface
Be sure that the PTC is connected to the right serial port and switch it ON and the start info
will appear in the upper window finished by the prompt cmd: If you can't see anything check
serial port and settings
Click in the lower window, enter with the keyboard 'Escape+Shift bau 45 ENTER' the PTC will
switch to RTTY (look at the PTC mode display). Add 'Escape+Shift term 1 ENTER' to switch
the PTC to echo the transmitted signs in the upper window. Note : Escape without Shift will
switch the cursor to the main window
In the open Digital Interface select 'File | Settings' and select Tab: 'Macro Setup'. Select
behind 'Digital Macro Set' 'Other 1'. Now three buttons appear with TX, RX and ESC on it.
These buttons have to filled with the sequence to put the PTC in TX and RX and to get a
correct function for canceling the AUTO-CQ function or make a break with the ESC-key on the
keyboard

Digital Macro Set: Other 1
TX button: {Ctrl-Y} NB. in capital letters

Now the macro {TX} can be used to switch the TX ON
RX button: {Ctrl-Y} NB. in capital letters

Now the macro {RX} can be used to switch the TX OFF
ESC button: {ESC}CLR{ENTER}{Ctrl-D}{ENTER}

The macro will reset the PTC-2 to PACTOR, clear the TX buffer and switch the
PTC-2 back to RTTY

There are a maximum of 24 extra functionkeys. One of them may be configured to switch the
PTC-2 from the default state PACTOR to RTTY

Name button: RTTY
Contents button: {ESC}clear{ENTER}{ESC}bau 45{ENTER}{ESC}term 1{ENTER}

Every time you start the PTC-2 you may click on this key to start the RTTY-mode.
You need 'term 1' to get a delayed echo on the RX-window when your text is
transmitted

You may generate more macros with simple QSO texts using the installed N1MMLogger
macros as !, *, DATE, TIME etc
Don't forget to start a functionkey with {TX} and at the end place {RX} to switch back to receive
See for some macro examples at macros page

 

VHF and Up Contesting

In this Section...

VHF and Up Contesting
1. VHF Options
2. Gridsquare Key Assignments (VHF and up)

2.1. Call History Lookup
2.2. Updating the Call History File

3. VHF master.dta File
3.1. Transverter Support
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4. VHF Beacons
5. Example Contest Setup

5.1. Create (days) Before the Contest
6. Before Starting the Program
7. After Starting the Program

N1MM logger has some features which will be appreciated especially by VHF and up contesters.
The program supports bands up to the SHF bands 10, 24, 47, 76, 142 and 241 GHz

 

1. VHF Options

The frequency is shown in the Bandmap and in the Entrywindow. When the frequency is above 1
GHz the band will be shown in cm, not the exact frequency in the Entry window. When entering
QSOs it's easy this way to recognize the band in which you log.

2. Gridsquare Key Assignments (VHF and up)

Alt+equal (=) - Search entered info from both the Callsign field and the Gridsquare field in the
call history table
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The results will be shown in the Check window
Alt+minus (-) - Toggle through call history and entered grid squares (max 3) in the grid
square entry field

When no grids are found in the call history there is nothing to toggle

 

2.1. Call History Lookup

More information about this can be found in the Before the Contest chapter.

This feature is very useful in VHF contests. Lookup examples are lookups for names (Friends file in
RTTY contests), gridsquares for VHF contests, ages in All Asian DX contests etc. With the importing
and exporting options the call history table can be updated.

Call history lookup is enabled with the option >Config >Call History Lookup. If enabled, it will look
up in VHF contests: Grid Square (max 2) and Name.

2.2. Updating the Call History File

The program itself does have a function to export the log file to (update) the call history table under
>Tools >Update Call History with current log'. This function will fill the call history table with the
contents of the currently selected log.

Another method used which gives more control is the separate program called Thucydides by Carel,
PC5M. Check it out in the Links chapter chapter and the Third Party Software chapter..

3. VHF master.dta File

For HF there are several master.dta files which contain callsigns of active contesters. Select the
Master Callsign database link on the download page. There are separate files for RTTY and for VHF
and up contesting. A very nice tool to create a master.dta file has been written by Alex, VE3NEA.
This tool can be downloaded from his site (see the Links chapter) and is freeware! A text file with
callsigns is needed. An example master.dta file for VHF is available from the N1MM website in the
'Other Files' menu under 'Downloads'.

3.1. Transverter Support

N1MM logger has transverter support in the form that per band an offset frequency can be set.
Right click on the bandmap and select >Set transceiver fffset frequency. The offset value is saved
by the program so after a restart the offset is still there.
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Band (kHz) - enter the transmit frequency of the transverter
IF Freq (kHz) - the frequency used between the radio and the transverter

 
An offset can also be added to adjust the transverteror radio to the exact frequency (like when the
oscillator is a bit off).
See the 432000,12 example where a correction is being made of 120 Hz. Great to have to be right
on the packet cluster spots!

Bandup/Banddown

If you have a radio that has 160-2m, and you want to use bandup/banddown, you'll need to put
entries in for bands that you do not have transverters for, if there are gaps in bands that the
radio/transverters cover. You would really have to put a lot of transverters offsets in if you want the
frequencies to "wrap".

 

It does not work if your radio does not accept the calculated frequency. For example, set up
for Band: 144000 and IF freq: 28000 and you put in 146100 and your radio can't go to 30100,
you will get strange results
Remember to enter the frequency of the transceiver and not that of the transverter when going
into split mode (Alt+F7).

 

4. VHF Beacons

N1MM logger is capable to show beacons in the bandmaps for a defined period of time. Normally
every spot in the bandmaps will disappear after the 'Packet Spot Timeout' which is valid for every
spot in the bandmap. The same for beacons coming in as spots. So an extra import option has
been added for beacons with where the spot timeout can be set to a much higher value (like days
or even weeks).

If the next band is not defined as offset to a frequency that my radio can handle and
bandup/down is used, it goes to an HF frequency (without offset).

Next Offset Band
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Importing beacons and showing them in the bandmaps for the bands can be done by importing a
text file in a specific format. Enter the text BEACONS in the Entry window callsign field and a file
selection dialog will open where a .txt file (with beacons in the correct format) can be imported. An
example beacons text file can be found in the N1MM logger program directory (called Beacons.txt).
In the beacons text file lines with a # are remarks, the first line in the text is the timeout for all
beacons in hours. Every line with a beacon must contain callsign, frequency (in kHz) and grid
locator (4 or 6 digit). The frequency may be in either US (50000.25) or European (50000,25) format.
A comment per beacon is optional. Note the ; as separator (don't forget one or it won't import).
Below an example beacons.txt file.

# Hours to stay in bandmap (mostly > 24 or > 48)

60

# Call beacon;Frequency;Grid;Comments

OZ7IGY/B;144471,1;JO55WM;

PI7CIS/B;144416,2;JO22DC;Should always be heard

DL0PR/B;144486,3;JO44JH;Switches power!

GB3VHF/B;144430.4;JO01DH;QRG with a .

ON0VHF/B;144418,5;JO20;4 digit grid

A file with beacons in the correct format for Europe (Region I) can be found on the N1MM website
under 'Other Files' in the 'Download' menu.

 

5. Example Contest Setup

Additions are welcome!

5.1. Create (days) Before the Contest

 

New master.dta file

No need to add the NCDXF/IARU Beacon Network on 14.100, 18.110, 21.150, 24.930 and
28.200. They are already incorporated in the program and the beacon transmitting at that time
(when your PC clock is correct) will be shown in the Entry window statusbar when you are
listening on one of these frequencies.

The NCDXF/IARU Beacon Network
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Use tool from Alex, VE3NEA, see the Links chapter
Create 'N1MM logger.ini' to use during the contest

Setup all the program setting and place the windows as you like them during the contest
(on the computer to use)
Don't forget the tab 'Mode Control' in the Configurer.
After closing the program it has created a file called 'N1MM logger.ini 'with all the
settings
Copy 'N1MM logger.ini' (not .init) to ' VHFsettings.ini'.

Text file with contents Function keys for SSB/CW
As a start:

'File | Export | Export Function Keys to file... | SSB Function Keys'
Give a name like: VHFssbfunctionkeys.mc

'File | Export | Export Function Keys to file... | CWFunction Keys'

* Transverter support

As a start:
'File | Export | Export Function Keys to file... | SSB Function Keys'

Give a name like: VHFssbfunctionkeys.mc
'File | Export | Export Function Keys to file... | CWFunction Keys'

Give a name like: VHFcwfunctionkeys.mc
Update these text files if needed
Check possible macros in the Macros chapter

Packet/Telnet button text file
As a start: >File >Export >Export Packet/Telnet Buttons to file...'
Update this text file if needed
Give a name like: VHFpacketbuttons.txt
Check possible macros in the Macros chapter like {GRIDSQUARE}

Lookup database text file for the VHF contests to use
Create a text file with callsign, name, locators etc.
Give a name like: VHFlookup.txt
See info about CallHist file

SSB: Wav files for CQ, rst, exchange etc.
Create wav files for all operators
See {OPERATOR} macro in the Macros chapter

Download up to date country file (cty.dat)
mostly a country file is not used for VHF and up contesting but the program gives
information in the Info window about the logged callsign so download the latest version

Check if the selected contest is still ok, make some test QSOs
This should be done weeks before the contest!

....

 

6. Before Starting the Program

Copy the created master.dta file in the N1MM logger program directory
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Copy the wav files from all operators in the WAV directory
Turn off Windows sounds if using WAV files

Windows >Control Panel >Sounds - Scheme: No Sounds
Rename ' VHFsettings.ini'. to 'N1MM logger.ini' and copy it into the program directory

The program will start using the settings as set up days before the contest

 

7. After Starting the Program

Select/Check if correct database is used
>File >Open Log in Database, select VHF database'.

Import
This has to be done only once if every time the same database is used!
Each database can handle many contests and thousands of QSOs, don't use a
database for every contest!
Updated files (like the lookup file) have to be imported before every contest.

The function keys macros (SSB/CW)
>File >Import >Import Function Keys to file... >SSB Function Keys. Use file
created above (Example: VHFssbfunctionkeys.mc)
>File >Import >Import Function Keys to file... >CW Function Keys. Use file
created above (Example: VHFcwfunctionkeys.mc)

The packet/telnet buttons
>File >Import >Import Packet/Telnet Buttons from file... Use file created above
(Example: VHFpacketbuttons.txt)

Lookup file
>File >Import >Import Call History File. Use file created above (Example:
VHFlookup.txt)

Country file
>Tools >Import country list from downloaded file. Use file
downloaded/updated above

Check Station dialog (>Config >Change your Station Data)
The locator from this dialog is used for distance calculation so needs to be entered!

Check contest ( >File >Choose Which Contest to Log)
Check if entered information is correct.
Enter Sent Exchange (this is contest specific, see Setup Contests chapter)

Setup configuration (Rig control, PTT, CW)
Check Configurer >Mode Control tab

When using a transverter, enter offset for bandmap A and bandmap B
....

 
Have fun during the contest!
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Operating a Contest

 

Table of Contents:

1 Before the Contest
2 During the Contest
3 After the Contest

 

Before the Contest

In this Section...

Before the Contest
1. Start of the contest season

1.1. All Stations
1.2. Assisted or Multi-op Stations

2. Check the Contest Rules and if the Contest Program Uses Them Correctly
3. Update the Call History Lookup File
4. Importing and Exporting Message Function Keys
5. Getting Ready for CQWW (and other contests)
6. How to Record WAV Files for the Function Keys Used in SSB Contests

6.1. Storing Voice Files
6.2. Recording Letters and Numbers
6.3. Turn Off Windows Sounds When Using WAV Files

7. Making the Window Focus More Distinctive
8. Adding a New Font to Windows

1. Start of the contest season

With the start of the fall it is time to get ready for the big contests. Here are some suggested steps
for your station:

1.1. All Stations

Print out the key assignments help file and mark it up with a highlighter. Use one color for
things you know how to use, and another color for keys that you didn't realize were there but
are interesting.
Learn how to enter frequencies from the entry window. You can type 14022. If you are already
on a band, you can type offset from the bottom of the band or the last three digits of the
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frequency. On 80m examples are 22 for 3522 and 795 for 3795.
Learn how to set split. Use the callsign textbox if you have not already copied the call. e.g. On
40m, 214 ctl-enter will set your tx freq to 7214. Use Alt+F7 to set split when there is already a
call in the textbox. A recent change allows you to clear split by pressing Alt+F7 and pressing
enter with no frequency entered. Esc still leaves split alone.
On many radios, the up/down keys tune the radio or the rit depending on whether you are
running or S&P. You can adjust the step amount in the configurer.
Learn to use check partial. I find it is usually faster to make a good guess at the callsign and
let them correct you than to just say what you know. I usually ask if their call is correct.
On CW, use ESM. It's a skill that pays big rewards in believe it or not, reducing stress. Instead
of thinking all the time "what key next", the program does it for you. Also learn to use the =
key. It means, send the last message. Another good trick when you are tired.
Make sure you understand how the bandmap and callframe work even if you are not assisted.
As you work stations, they will be "spotted" in your local bandmap. This allows you to skip
over them during your next S&P trip through the band. This saves a lot of time. The call will
appear in grey in the callframe as the station gets within the user-definable tuning tolerance.
Grey means you worked them. Tune on.
Make sure you load the lasted wl_cyt.dat and check partial files prior to the contest. Note that
the wl_cty.dat has to be imported into the program. A step many forget.
During the contest, if you work a station that is not handled properly by the country file, just
put the correct prefix in front of it like (W8/N8SS), then log with Ctrl+Alt+Enter. You can put a
note to check it later. You don't want to take a lot of time to fool with it during the contest. The
other approach is to use Tools/Add call to country. To use this, you need to know the base
countries in cty.dat. A printed copy at the operating position is helpful in this.

 

1.2. Assisted or Multi-op Stations

You can use the available window to help determine band strategy. Bands with lots of
available spots are likely open well to where the spots are from.
Loud stations can jump from spot-to-spot and pick off many Qs. Be sure to confirm the
callsign. Spot quality has been deteriorating. You don't want to get penalized for a broken call.
Remove broken callsigns with Alt+D. If the call is in your callframe, Alt+D will delete it. Quick
and easy. Otherwise use the right-click option from the bandmap or available list.
During slow times, you may need to turn your antenna to "clean" a band of spotted stations.
Clicking on the beam heading column heading lets you sort the list so you can get them with
minimum rotor movement. Note that clicking all of the headings works. Click a second time to
reverse the sort. Default sort is descending on spotted time (last column - usually hidden.
Scroll over to see it.)
Be sure to adjust the spot timeout and the filtering based on time of day and conditions. If
times are slow, I allow more spots through. At peak times, I want last 20 min, North American
spots only.
Try "call stacking" mode. In multi-op, you can specify another computer as the "target for call
stacking". If both stations set this to each other (recommended) they can see what each other
types in their call textbox in the callframe. This *only* works if they are on a run frequency.
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The idea is that you have two ops with headphones listening to a run. If the secondary op
copies the callsign, the primary op can wipe his and just press enter (in ESM mode). Since
the correct call is in the callframe, it will be pulled into the call textbox and be sent as part of
the exchange. This mode has not been used a lot, so I would recommend some ambitious
souls try it out and let me know what needs changing. Also note that this function works
across the internet. Now there aren't many contests that allow this - IARU for HQ stations is
the only one I know of - but wouldn't it be an interesting kind of entry class? You could have
one big gun and lots of listening stations supporting it. If you do this across the internet with
stations exceeding the contest's separation limit, you must submit your log as a check log.
The internet mode is useful for practicing with your Multi-op partner without the necessity of
going to a single location.

 
73, Tom - N1MM

2. Check the Contest Rules and if the Contest Program Uses Them Correctly

But of course the program should keep up with all the rules for the contests it logs... but there is
just one problem, there are so many of them! And you know what?? If there is an obvious bug like
that found during the contest it is there for one, and only one, reason. YOU didn't test the software
before the contest! (no Tom, not just you, I'm pointing at all the users out there)

Remember, the N1MM logger is free, written by volunteers, tested as much as we can before it gets
out to users, but none of the relatively small group of writers and beta testers has time to try out
every contest, all the possible scenarios, and all the combinations of them. Look at the list of
contests supported, multiply by something like 1.5 for contests that have different rules 'in state' vs
'out of state' (or country, or continent, or whatever), then multiply by at least 4 or 5 for entry classes
with unique rules, then multiply by 3 or 4 again for the different types of multiplier lists, points to
assign, qso's that do count or don't count in each set of rules, and then multiply by a couple more
things... and you get LOTS of combinations. In the software profession the logger would be
considered virtually untestable for a single release, let alone for release after release adding new
features, changing contest modules to update for the latest rule changes, updating country lists,
county lists, list lists, and there isn't enough time in the year for anyone to even begin to test it all.

So, its up to YOU, the users, to test. Yes, YOU. YOU are the ones that know the rules, YOU are the
ones that will be depending on it working for a whole weekend... and if you add up all the YOU's
out there who are using the software every weekend it adds up to enough man power to do a
reasonable job of covering the critical parts of the program.

The key is, if you are planning to operate in a contest a couple weeks from now, lets say, cqww
ssb... Load the latest software NOW, create a dummy database, and sit down with your radio,
computer, cluster connection, keyers, and whatever else you use, and log a couple dozen contacts
as if you were running(fake them, type and hit function keys as fast as you can and see if it
responds reasonably quickly)... then log a few more in S&P mode, make sure your messages and
macros work as expected, make sure you can record and playback ssb messages on the fly, make
sure the multipliers you think should be counted are scored right, log some contacts that shouldn't
be multipliers or points and make sure they aren't. grab some spots, make some spots, make sure
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the spots show up in the right colors for the contest rules. Use the new feature to save your screen
layout so you can get it back later. Then create a Cabrillo file and make sure that looks ok... make
detailed notes of problems and put in bug reports well in advance. If everyone did that on some
evening, or rainy day, or some morning when you wake up and can't get back to sleep, we would
stand a chance of catching simple things like multipliers that aren't counted right BEFORE the
contest weekend.

So get out there and TEST!

David Robbins K1TTT

3. Update the Call History Lookup File

In some contests part of the exchange is known if the callsign is known. So it would be easy to have
this information shown (or already prefilled) if the callsign is entered. Lookup examples are names
(Friends file in RTTY contests), gridsquares for VHF contests, ages in All Asian DX contests etc. In
all cases the possibility to use this lookup function means changes in the contest class by the
programmer. A lookup is only done when the cursor is in the callsign field in the Entry window and
SPACE or TAB is pressed.

Update the Call History file or create a new one if the contest supports this and the exchange could
be/is known.

More information about Call History can be found in the Advanced Functions chapter.

4. Importing and Exporting Message Function Keys

The CW messages and SSB wav file messages are not contest-specific, but rather portable
between contests.

When you get the message keys set up for a particular contest do the following: >File >Export
>Export Function Keys to >File >CW Function Keys (for example). This saves the message key
setup as a Macro file. Name it after the contest. You can recall that set of function keys any time
you like by importing them: >File >Import >Import Function Keys from File >CW Function Keys (for
example) > (select file)

This way you can make and reuse different files for all the different contests. Just import the
message keys for the contest de jour.

5. Getting Ready for CQWW (and other contests)

Top contesters have a checklist of things to do prior to a major contest. Please consider adding
these logging program related items to your list:

Make a few dozen test contacts in the contest. Make several QSOs in 'running' mode and
several QSOs in S&P mode. Press the CQ function key to set yourself to 'running' mode. If it

1.
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does not, make sure the 'Configurer | Function Keys tab' matches your button setup
If you plan to use any of the following features, make sure they work as you expect:

Enter sends messages1.
Autocompletion2.
Multi-op3.
Send leading zeros4.
Send corrected call5.
Radio interface6.
Packet connection7.
Telnet connection8.

2.

Get the latest CTY.DAT and install & test it. The About window will tell you the version you are
using

3.

Get the latest MASTER.DTA and put it in your install directory. The Check window at startup
will tell you the version you are using

4.

Prepare your CW function keys, SSB wav files, or CQ/RTTY messages. Test them!5.
Make sure that RF does not get into your cabling6.
Make sure you have selected the correct options in the contest setup dialog. For CQWW your
exchange field should contain only your zone. Read the contest rules so you know how to
setup the contest, Function keys etc

7.

Run Cabrillo output and check for proper generation8.
Sync your time with an Internet time standard, if possible. I use a freeware program called
Dimension 4 and resync periodically (every hour?) during the contest

9.

Review "Key Assignments" in the help. Print it out or print out a keyboard template which can
be found on the N1MM website under 'Downloads', select in the 'Download' menu, 'Other
Files'.

10.

 
73, & GL in the contests

Tom Wagner - N1MM

6. How to Record WAV Files for the Function Keys Used in SSB Contests

By Tom, N1MM.

I use Cool Edit 96, but there are later versions1.
Record **all** of the messages on one wav file. Make sure you have a quiet room. Record
each message at least TWICE. Sound excited!

2.

Leave 5 seconds of empty space at the beginning of the recording3.
Record4.
Save the recording as "Raw CQ" or some such5.
Use Cool's noise reduction feature. Mark the blank part of the wav, and set the noise
reduction, then noise reduce the whole wav file

6.

Save the recording as "Noise reduced CQ"7.
Perform bass reduction, treble boost or whatever other transformations and save them as you
do them

8.

You can use compression, but I don't recommend it9.
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Split the wav file into the separate messages, saving the best of the two recorded10.

 
Recording ALL your messages in one recording and afterwards splitting them up using a WAV
editor will avoid the pops at the start and end of recording, as well as making it more likely that all
the messages will be recorded at the same volume level and sound the same.

Don't ask why you need Cool Edit. Just get it.

Another nice program is Audacity and this one is freeware. This program can scale the peak
amplitude of all the audio files to be the same. In order to set the audio level out of the computer, I
recorded 10 seconds of a 800 Hz tone. Scaled the amplitude (peak = mean) and assigned it to F7. I
call it cal.wav. I turn off the speech processor, and turn up the computer volume just until full
output is reached. Although not guaranteed, the peak amplitude of my audio files should now be in
the dynamic range of my transceiver. Afterwards I turn the processor on again.
P.S. OK then, I admit to sometimes turning the volume just 1 or 2 ticks higher to be on the safe
side......... - Thanks PA5DD

6.1. Storing Voice Files

 
Place the WAV files you have made in the \wav subdirectory of the N1MM Logger program directory.
Call the files whatever you wish. One way is to label them as:

   CQ      C:\Program Files\N1MM logger\WAV\cq.wav

   N1MM    C:\Program Files\N1MM logger\WAV\n1mm.wav

   Exch    C:\Program Files\N1MM logger\WAV\59.wav

6.2. Recording Letters and Numbers

 
The recording process for individual letters and numbers is the same, but these individual letter files
must be placed in the \letters subdirectory of the N1MM program directory. Do NOT put them in
\WAV\letters.
Examples:

letters\1.wav
letters\2.wav etc

? = letters\query.wav
/ = letters\stroke.wav

It is extraordinarily difficult to achieve fully natural voiced callsigns or serial numbers, because our
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inflection varies so much depending on whether a letter or number occurs at the beginning, in the
middle of, or at the end of a callsign or serial number. This is particularly true with serial numbers,
where being able to say the number 595 as "five hundred ninety five" instead of "five nine five" is a
big aid to intelligibility.

One option is to use voiced callsigns only while running, to save your voice and confirm the call of
the station you are answering, and not to use voiced serial numbers at all.

6.3. Turn Off Windows Sounds When Using WAV Files

Open >Windows >Control Panel
Double-click the Sounds folder
Click on the Sounds Tab
Select scheme: No Sounds

 

7. Making the Window Focus More Distinctive

By Pete, N4ZR

The standard Windows XP color scheme does not make the active window (among many)
distinctive enough for quick recognition during a contest. This can be an issue particularly in SO2R
operation. Fortunately, this can be fixed. You can do the same thing with Windows 98 as well, just
by right-clicking on the desktop and proceeding as outlined.

In Windows XP the specific process is as follows:

Open >Windows >Control Panel >Appearance and Themes
Click on Display
Click on the Appearance Tab
Under Windows and Buttons, select Windows Classic
Click the Advanced Button
Under Item, select the Active Title Bar and choose a color for it

I use dark red for the active window and gray for the inactive
Then select Active Window Border and choose a color for it

 
You will probably want to fool around for a while before you settle on what you like best. Once you
have done that, back out to the Themes tab under Display Properties. Click the Save As button and
name this theme and save it to your settings.

From now on, all you need to do to switch to your N1MM setup is to right-click somewhere on your
desktop, select Properties, and then choose your N1MM theme.

8. Adding a New Font to Windows
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Select Windows >Control Panel >Fonts folder
Select >File >Install New Font
In the Drives box, click the drive and select the folder that contains the fonts
Click the font you want to add. To select more than one font at a time, press and hold down
the Ctrl key while you click each font
Click to select the Copy Fonts To Fonts Folder check box (mostly already selected)
Click < OK >
Done!

 

During the Contest

In this Section...

During the Contest
1. The Scenario
2. Bugs Encountered During a Contest

1. The Scenario

During a contest you should know all the basic functions of the program like changing frequency,
band and mode. The program should have no secrets any more. Your only concern is making
QSOs, working multipliers, having a good strategy. The manual is lying next to you but you don't
need it, the key assignments (shortlist) has been printed and is hanging within visual range so
when you might forget you can take a peek.

You know there are no bugs in your version because you tested it, made test QSOs. You have
reported bugs long before the contest and of course these have been solved long before the
contest starts.

Long before the contest you have read the Key Assignments, Basic Functions, Setting up the
Program, Entry Window and the Quick Tour to have basic program information. So questions
have been asked and answered, the manual has been read several times.

You have made a clean database, recorded your WAV files and programmed your CW messages,
etc. weeks before the contest.

Nothing can happen to you, you have prepared!

 

2. Bugs Encountered During a Contest

When a bug was missed during testing and comes out during the contest please report it right after
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the contest or during the contest if it is a show stopper. Tom participates in many contests but he
also reads the mail during contests and can give hints or sometimes bring out a new version. In
addition to Tom there are many other hams available who can help solving problems, giving hints
etc.

Rather than writing down problems during the contest, try the following:

Use Alt+N to write a Note that will be attached as a comment to the QSO. For example, "This
call not in master.dta."

1.

At the end of the contest, use the menu option >View >Notes to see all the notes you have
made during the contest

2.

 

After the contest

When the contest is over we are not ready yet. The points have to be calculated and the log has to
be submitted.

In this Section...

After the contest
1. Entering QSOs After the Contest

1.1. Enter QSOs
1.2. Change Time/Date for a Single Hand-Entered QSO
1.3. Change TIme/Date for Multiple Hand-Entered QSOs

2. Change All QSOs Time/Dates by a Fixed Amount
3. How to Create Cabrillo Files
4. How to Print the Log
5. How to Get Statistics
6. Submitting E-mail Logs for ARRL/CQ Contests

6.1. ARRL Contest Robot
7. Printing QSL Cards
8. Importing a Contest Log into Your General Logging Program

1. Entering QSOs After the Contest

Made a paper log during (part of) the contest? The QSOs have to be entered after the contest. The
program has some nice features that will allow rapid QSO entry, and allow you to easily set the
date and time via interpolation. (Remember, exact QSO times are not critical for contest sponsors,
just within reason) This feature is most useful if you have a bunch of QSOs to enter. If you have one
or two QSOs on paper you might as well do it the old way...

1.1. Enter QSOs
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Suggested way to enter QSOs

Type frequency/band, hit Enter
Continue entering calls and exchange as long as they are on the same band (type as fast as
you can and don't worry about the times, they will be fixed later)
If the band changes, type new frequency/band, and finish typing calls on that band

 
Example:

   7000 Enter

   W1ABC 35 CT Enter

   W2XYZ 55 MA Enter

   14000 Enter

   W5JOE 42 TX Enter

   ...

1.2. Change Time/Date for a Single Hand-Entered QSO

Updating the timestamp from a qso can be done from within the Entry window using the callsign
field. Entries starting with "T" and four numeric digits will update the current row time in the log.
Example: T1234 will enter the time 12:34. When entering qso's after the contest, first enter the qso
information and enter the qso in the log. Then update the time using Txxxx and the tiem of the last
entered qso will be updated.

1.3. Change TIme/Date for Multiple Hand-Entered QSOs

To change time/date of a series of the hand-entered QSOs:

Put mouse over the first QSO you want to change the time/date and single click to highlight
the row
With mouse over log window, right click
Select >Set Start Interpolation Time Row
Enter desired start time, and hit < OK >
Put mouse over the last QSO you want to change the time/date and single click to highlight

Make a copy of your log, and only use the copy for this process! You cannot (automatically)
reverse the time interpolation process below. You have been warned!

Make a Copy of Your Log
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the row
With mouse over log window, right click
Select >Set Stop Interpolation Time Row
Enter desired stop time, and hit < OK >

 

2. Change All QSOs Time/Dates by a Fixed Amount

This will fix a log where all QSOs are off by a common amount of time

Put the mouse over the log window and right click
Select >Change All Contest Timestamps by a Fixed Amount
A dialog box will open, and enter offset time (+ or -) in minutes

 
The date will automatically adjust if the offset rolls a QSO into a different day. Time is entered in
minutes, and can be negative time to go backwards. (You might need a calculator to determine the
offset minutes if your date was off by many days, months, or years). For example, entering +1440
will shift a complete day forward; -2880 two days back.

3. How to Create Cabrillo Files

Cabrillo is used by all major contests.

Select >File >Export >Export Cabrillo to file...
This creates a Cabrillo file for contest log submission
Make sure that the Station information >Config >Change Your Station Data, and overall
contest information (>File >Choose Which Contest to Log ) is correct before creating this
file
It is also a good idea to >Tools >Rescore Current Contest before submitting
A Cabrillo file will be created named <yourcall>.LOG in the N1MM logger program
directory

 
In the Technical Information chapter there is additional information about files the program can

The utility will average out the time for each QSO in the group of QSOs you have selected.
Remember there is no "undo" feature, so make a copy of your log before using this utility. If
you have a large gap in time in your hand log, enter the first batch of QSOs, and do the
interpolation. Then enter the second group of QSOs and do a 2nd interpolation (by breaking up
the interpolation, you can better accommodate gaps in the log).

While you could easily recover from a mistake during the following adjustment by performing
another offset, it is advisable that you backup your log before doing any changes.

Changing QSO TIme and Date

Backup Your Log
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produce. (Cabrillo, summary sheet, log, ADIF etc.)

4. How to Print the Log

Well, there is no print function 'as such', and I don't think many of us print logs. Paper? Ouch! ;o)

Go to >File >Export, where you see a broad variety of choices. Make an ADIF file for importing in
another program, to import the contest QSOs in the general DXlog. It is possible to make a
summary sheet, save the file, open it in WordPad and then print it. CSV (comma separated value)
format is also an option.

5. How to Get Statistics

The program does have very nice statistics by itself. Also there is a external tool from I8NHJ. Some
alternatives are listed below:

Select >View >Statistics. Take your pick
Export to ADIF and import in a general DX log. Use the statistics from that program
Use the Cabrillo output format, needed by most (if not all) contest sponsors
Use the brilliant I8NHJ's tool (also free!) to analyze the log afterwards

More info about this tool is given in the Third Party Software chapter.

 

6. Submitting E-mail Logs for ARRL/CQ Contests

ARRL and CQ require Cabrillo log files for each contest.

The Cabrillo log file named: <yourcall>.LOG Example: N1MM.log
Select >File >Export >Export Cabrillo to file...

 
Submitting the files

Check the Cabrillo file with Notepad. Read the the first part (header) of the log file to check if
all is correct
Enter the appropriate e-mail address for this contest. See the ARRL and CQ Web sites

ARRL at http://www.arrl.org/contests/email.html
CQ at http://www.cqww.com

Enter the correct e-mail subject line:
ARRL: Contest, Yourcall, Class and Power

For example E-mail subject line: ARRL DX CW N1MM SOA HP
CQ: Callsign and the mode (SSB or CW)

For example E-mail subject line: N1MM CW
Attach the Cabrillo file named < yourcall >.* . DO NOT send as text but as attached files
Press < Send >
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You'll receive an automated reply from the contest email robot (answering computer),
acknowledging receipt of your log. Please save this message
Remember that logs received after the deadline will be considered check logs only!

 

6.1. ARRL Contest Robot

Log files to the ARRL have to be Cabrillo files and need to be sent as attachments (not as text)!

Below is a typical, automated response from the ARRL contest Robot.

Thank you for your participation in the contest and for submitting your log in Cabrillo format. While
the robot appears to be able to process your log, it appears to have discovered irregularities in your
log. These do not affect its ability to be processed but correcting these problems will help ensure
the entry is properly scored. These irregularities appear in a report at the bottom of this message.
You are encouraged to review and fix these irregularities. You may then re-send it to dxcw@arrl.org.
You may have to resubmit your log two or three times to get everything just right. Don't worry, the
robot replaces the previous file as long as the callsign remains the same. We want to make sure
that we have your information right! If you have any questions regarding this, please contact me at
n1nd@arrl.org or by phone at 860-594-0232.

Your tracking number is 3044.dxcw. Please save this receipt until verifying that your log appears on
the Logs Received web page at
http://www.arrl.org/contests/claimed/

Thanks for your cooperation.

73 Dan Henderson, N1ND
5
ARRL Contest Branch Manager

ARRL DX CONTEST LOG WARNING MESSAGE REPORT FROM THE ROBOT

CATEGORY-OVERLAY: N/A%%
Line 7 was discarded. The CATEGORY-OVERLAY: tag is not used in ARRL contests. You may
delete this line from your log.

Delete the line and send the log again. Now the log is accepted without warning messages.

7. Printing QSL Cards

N1MM logger doesn't have a QSL cards sent/received feature. Why? If every general logging
feature people want has to be implemented, the program would be neither a good contest program,
nor a good general logging program. It has been decided early that this was to be a contest
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program with a few general logging features. To print QSL cards use a dedicated QSL manager
(like BV) or use your daily logging program. Almost all logging programs who can print QSL card
can accept ADIF input.

8. Importing a Contest Log into Your General Logging Program

By Franki, ON5ZO

N1MMLogger can be used for DX-logging but this is not where it was written for. You are missing
some basic features of course, like award and country tracking and QSL'ing options. There is no
way around this than using a specific DX logger for DX, or at least to do the "bookkeeping"
afterwards. You can do this by exporting your N1MM log to ADIF and importing this file in the DX
logger.

What I mean is this: N1MMLogger provides the ADIF-export feature. This creates a simple and plain
ASCII file from your log-database. You can open and edit this file with any ASCII-editor, like the old
DOS "Edit", Windows' Notepad or WordPad. In this file, the different parts that define a "QSO"
(time, QRG, call, reports etc. etc.) are separated by field identifiers or tags that are defined in the
standard of the ADIF-format. Read all about it at: http://www.hosenose.com/adif/adif.html

You cannot simply use this file for DX logging, but you can import this file in any casual DX logging
program.

When I entered a contest, and I made -let's say- 300 QSOs, I export this file to an ADIF file. ADIF
specifies a field named "comment", so I put a comment like "QSO in ARRL DX CW 2002" in the first
QSO and save this. Then I have WordPad replace all the 299 empty "COMMENT" tags by
"<COMMENT>QSO in ARRL DX CW 2002", so each of these 300 QSOs gets this comment added.
When I import this file in my general DX-log containing a few thousand QSOs, these are marked
with the specific comment. This is what I mean with "interacting". Other feature is that, in that same
contest, the RST from the American stations, i.e. their state, is automatically filled in, in the "state"
field in DX4WIN.

I never log a rag chew QSO or a DXpedition with N1MMLogger, and I never enter a contest with my
DX-logging software. Yet all my contest contacts end up in my "general DX log", with a special note
indicating what contest it was.

Help

 

Table of Contents:

1 Help files and Manual
2 Tips and Tricks
3 Troubleshooting
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Help Files and Manual

 
This wiki-based manual is now maintained in real-time by volunteer authors who make changes to
this document as the program changes. If you are reading this on the web, you are guaranteed to
get the absolute latest version of the N1MM Logger manual.

However, you may need to access the N1MM Logger manual from a location without Internet
access; or you may prefer the material in a different format (Adobe PDF, Windows .CHM Help); or
you may require a non-English version of the manual.

To make your own off-line copies of the current English manual (either printed paper copies, or
electronic PDF / HTML copies), see the Off-line Copies of Wiki Documentschapter in the wiki
Users Guide.

 

N1MM Logger Tips and Tricks

This chapter gives some tips and tricks on using the program. All tips are from Tom, N1MM unless
otherwise mentioned. The tips are examples how you could use the program, not how you should
use it, that is up to you!

In this Section...

N1MM Logger Tips and Tricks
1. Bandmaps, Entry Windows and the Mysteries Thereof...
2. Bandmaps, What are They Good For...
3. N1MM Logger Contest Technique
4. Start of the Contest Season

4.1. Testing
4.2. Key Assignments
4.3. Enter Sends Messages (ESM) Mode
4.4. Dual Entry Windows
4.5. Configurer Options
4.6. Autocompletion Mode

5. Log Editing
6. Force to Log Whatever Heard
7. Country Not Found When Logging Contact (no mulitplier credit)
8. Having F1 NOT Always Send CQ
9. Silence the Function Keys
10. How I Recommend to S&P on a New Band
11. Setting Contest Goals
12. Problems During a Contest

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

346 of 680 2/2/2011 4:54 PM



13. Using Up/Down Arrows to Tune
14. CW Tips

14.1. CW Macro Tip
14.2. Contest Spacing for CW

15. Working Dupes
16. What Setting Should I Use for Packet Spot Timeout?
17. How Should I Really Use this Program if I am Single Operator Assisted (SOA)?
18. How to Find a Worked Station in the Log When I Missed Parts?
19. Databases versus Contests
20. How to Upgrade the Database to a Newer Version?
21. Deleting QSOs (especially important for Multi-User)
22. QSYing Wipes the Call & Spots QSO in Bandmap
23. Exchange Abbreviations
24. Too Many Calls on the Bandmap!
25. Gray Line Openings
26. QSO Confirmation
27. Serial Number Contest
28. Dead Radio at Startup
29. Read the Update Log
30. Packet/telnet Button Setup
31. Slow PC Syndrome
32. Move RX Frequency from the Keyboard
33. Recording QSOs

1. Bandmaps, Entry Windows and the Mysteries Thereof...

 
Two Entry Windows

Here is what you should be able to do:

Change keyboard focus with backslash \
Change keyboard and transmit focus with Ctrl+left/right arrow

 
With one vfo on one band, and another on the same or second band, you should be able to jump
from spot-to-spot using Ctrl+up/down arrow on the main vfo. With Ctrl+Shift+Up/Down arrow ,
you should be able to jump from spot to spot on the secondary vfo. If your radio has dual receive
(Orion, FT-1000 series), you should be able to listen to both VFOs at once. Alt+F12 swaps MAIN
and SUB receiver.

With the Orion and FT-1000 series, the way I envision this being used in S&P: You would find a
station on the main vfo, and wait for it. In dual receive, you would used Ctrl+Shift Up/Down arrow
to find another station that is ready to be worked. You would call whichever station is ready first.
This could be done on two bands (SOA), or on a single band (MM). If one has spotted a number of
calls locally (QSYing wipes the call & spots QSO in bandmap), one could use it on one or more
bands in SO.
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Bandmaps - Clicking on a spot on either bandmap will set that vfo to keyboard & transmit focus,
and put the call in the callframe. Double-clicking will put the call in the callsign field.

Please print and read the keyboard assignments help. Your will be rewarded with greater
enjoyment of the program. Trust me.

2. Bandmaps, What are They Good For...

The ONLY time they are to be used is for Search & Pounce AND the only thing they are good for is
to do a quick match up of a partial call you hear on the radio with what you are seeing go by in the
band map so you can keep moving instead of stopping to listen. That being said, the size of the
band map can be kept small and well zoomed so it only shows a narrow part of the band...

Now why you might ask?? I want to see multipliers that just got spotted at the bottom of the band
when I'm CQ-ing up at the top of the band, or I want to see multipliers on another band. THAT is
what the Available window is for! Learn to use it and it will serve you well in finding multipliers on
other bands. So shrink the band maps and enlarge the Available window and
be more efficient at both scanning the band yourself and grabbing spots. Now wait, what about if I
want to tune up the band to the next multiplier, shouldn't I have more band map shown so I can
click on the next one up the band??? NO, that is what Ctrl+Alt+Up Arrow/Ctrl+Alt+Down Arrow
are for, if you want to click on mults use the Available window list instead... sort it by frequency
if you must, but I prefer to go after the freshest spots first since they are most likely to still be there.
73, Dave K1TTT

3. N1MM Logger Contest Technique

I can't emphasize this enough. All the pretty bandmap stuff is not there to look nice. It's there to
help you make Q's. Here is how to do it...

When there are lots of spots in the bandmap, you can work lots of stations with S&P. Start
anywhere in the band. Press Ctrl+Up. Listen. Is he CLOSE to ready to be called? If yes, call him. If
not, press Ctrl+Up again. Repeat this until you work through all the available Q's. This way you
don't waste time listening to endless repeats when one station is working a weak one. I have made
a 90/hr rate doing this.

More tips: If a spot is dead, or not in a legal part of the band, use Alt+D to delete it. You won't have
to stop at it next time.

If you don't want to see spots for the wrong mode, right-click Allow spots for this contest's mode(s)
only in the packet window. Be careful using this one on 80 & 40.

Print the Key Assignments for how to jump between mults.

Variation: You are CQ'ing, but the rate is slow. Use the S&P technique to jump between spots. Then
quickly return to your CQ frequency with Alt+Q.

Unassisted S&P: DO NOT TURN OFF "Show non-workable spots". The only exception is for Sprint
contests, such as the NA Sprint, EU Sprint and AP Sprint, where stations change their frequency

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

348 of 680 2/2/2011 4:54 PM



after every QSO. Here is my recommendation. Tune up or down the band, listening and watching
the entry window for band edges, but also for calls that you have heard before or worked before in
the callframe. If the call is unworkable, speed up your tuning, and find the next station. When you
come to a station who is working someone else, type in his callsign. Work him if it is quick. If not,
tune on, and the guy's call will be spotted. Tune up for a short time, then return to his freq with
Ctrl+Up or Ctrl+Down. If he is ready, work him, if not repeat the process of trying to find another
station.

The bandmaps are not supposed to be nice & clean. They are supposed to show you where
stations can be worked. The bandmaps can be zoomed with the numeric +/- keys or by right-
clicking on the bandmap. It is important to know if a frequency is in use to save time listening to a
dupe or non-workable station.

The final, dirty little secret... What do you call a spot where there is no station? Your new CQ
frequency...

Rate is everything...

4. Start of the Contest Season

Approaching CQWW SSB means the start of the main part of the contest season. Enhancements to
the program will be curtailed during this part of the year to focus on eliminating any bugs or
performance problems.

4.1. Testing

Please start testing with your favorite fall/ winter contest in the autumn. Make a copy of ham.mdb
(or whatever you have called it), and use last year's contest as a test platform. Why?
Some problems only appear with larger logs. Find out performance issues. I relay on the users to
let me know about them.
Would you like a guide to testing? Check out the website (Download | Other Files and select
"TestPlan.wri". We would be interested in any improvements you would like to suggest for this form.

4.2. Key Assignments

Now is also a good time to review the Key Assignments. That is a good place to start to pique your
interest in what the program can do. The Key Assignments Shortlist is great to print and hang
beside the radio.

4.3. Enter Sends Messages (ESM) Mode

If you are planning to operate CW or RTTY, you MUST learn about ESM (Enter Sends Messages). It
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reduces fatigue and errors by sending the right message each time just by pressing Enter. It may
take you a while to understand and set up ESM, so don't leave this to the last minute. Believe me,
those that learn to use ESM, love it.

4.4. Dual Entry Windows

It would be a good idea to try those out, so you don't get frustrated during the contest. For your
reference:
\ backslash switches keyboard focus, Ctrl+left/right arrow changes keyboard & transmit focus.
Also, Ctrl+Fn, and Ctrl+Enter send on the radio that does NOT have focus.

4.5. Configurer Options

Finally, make sure you understand what settings you want for the following Configurer options:

SO2V/SO2R
Send corrected call
Send partial calls
Stop sending CQ when callsign changed
ESM only sends your call once in S&P, then ready to copy received exchange
Config/QSYing wipes the call & spots QSO in bandmap

 

4.6. Autocompletion Mode

Later in a contest, you hear a lot of stations that you have already worked, whether on this band or
another band.

If you check Autocompletion mode (Configurer | Other tab) the program will match the first
characters that you typed to previous callsigns. It will then pre-fill the callsign field with the rest of
the call. The portion of the call that you did not type will be highlighted, and you can remove it with
the delete key. However, if you press space, the call will be kept in its entirety.

This function is similar the technique used in Internet Explorer to "guess" which url you are typing.

Some like it, some don't. Try it with an existing log that has a large number of QSOs.

5. Log Editing

You should rarely/never have to use the edit window during a contest. To get back your last QSO,
press Ctrl+Q. To go back another QSO, use Ctrl+Q again. To go forward, use Ctrl+A. These keys
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ignore QSOs made by other stations when in Multi-User mode. It is also much better, because you
are using the same Entry window to edit that your fingers have gotten used to. To abandon edit of a
QSO, press Escape. The background color of the text panes changes while in "quick edit"

6. Force to Log Whatever Heard

Ctrl+Alt+Enter will force the program to log whatever it doesn't recognize in the exchange field. The
receive frequency is being reset to the transmit frequency.

7. Country Not Found When Logging Contact (no mulitplier credit)

 
1. The preferred way to handle this is to load the latest wl_cty.dat file prior to the contest

2. A second way to handle it is to force a particular call to a country with >Tools >Add Call to
Country

Note that this addition will be wiped out on the next reload of the country file

3. A third way to handle it is to add a note (Alt+N) to the QSO, and fix it later. >View > Notes will
help you find those QSOs with notes

8. Having F1 NOT Always Send CQ

Pressing F1 will send the F1 message This when F1 is defined as CQ-key in the Function keys tab
in Configurer. Pressing the CQ-key (i.e. F1) the place the program in Running mode but what if you
do not want to go to running mode and want to stay in S&P mode? Here is the trick. Use the {S&P}
macro in the F1 S&P key (13 th row). Easy as that.

9. Silence the Function Keys

If you want to 'silence' the function keys so they do not send anything and do not PTT the radio,
just put a single blank space in the Fkey contents of the button you want to silence. A space is a
real character, but not one that is transmitted, and the program knows not to switch the PTT in that
case.

10. How I Recommend to S&P on a New Band

 

Look at the available window. Are there any Mults to be had? (You should already know this,
since you just chose this band.)

1.

If there are mults to be worked, use Ctrl+Alt+Up/Down to jump to them. Look at the callsign
frame for the callsign. Use your ears to decide if that's the station and that they are near ready

2.
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to work you
Jump through all the mults until you have worked those that you can in a reasonable time.
You may need to repeat the search several times to get them all. Note that you don't want to
spend a lot of time waiting for them. Just keep going up and down the band and clean 'em
out

3.

Repeat the process with Q's that are available (Ctrl+up/down). When you find a dead
frequency, try a short cq. Maybe you can get a run going. Otherwise, clean out the QSOs

4.

Once you have worked all the spotted stations (assuming assisted), start manual S&P. Turn
on "QSYing wipes the call..." option. If a station is hard to work, put in his call and tune to the
next. The call will be spotted on your computer(s) only. You can use the technique in steps
1-4 to work him

5.

Spot non-workable stations if you are a good typist. It's nice to know where they are so you
don't waste time on them during the next sweep

6.

 

11. Setting Contest Goals

How do you get better at contesting? One way is to set goals for yourself.

The info window supports this by allowing you to set how many QSOs per hour you want to try to
accomplish. As you are contesting, the four rate panes will let you know if you are at less than 50%
of goal (red), between 50-100% of goal (yellow), or ahead of goal (green).

Note whatever goals you set for an hour will continue until the hour for the next goal is reached.

What if you want to beat last year's score?

The program supports that as well. Just open LAST year's log, and click the Import Goals button.
Choose the day (1 or 2) and press enter. You goals are now set to your hourly totals from last year.
Don't forget to start a new log for this year! The goals will be kept until you reset them explicitly or
until you LOAD A NEW DATABASE.

You don't want to have a different database for each (small) contest. This is a common
misconception.

12. Problems During a Contest

What do you do if you have problems during a contest?

Make sure you have a previous version of the logging program around that you have used
successfully in the past.

1.

Make sure you have tested the program ahead of time using the modes you plan to use
during the contest. Log a few sample QSOs. Check all the windows you plan to use. Connect
to packet or telnet if that is your plan. You might want to run through a test plan.

2.

If you find problems before the contest, please send the bugs in to be fixed as much before
the contest as possible

3.
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Check the update page on the N1MM website. We frequently fix problems during the
contest. The problems that we try to fix are either fatal ones, or low-risk ones. Nonessential
functions that present some risk to fix, are left until after the contest.

4.

 

13. Using Up/Down Arrows to Tune

The Up and Down arrow keys can be used to tune your radio. If you are in S&P, then just use them
to tune in the station you are trying to work. This is particularly good for packet spots.

If you are Running, you might try this technique. Set your radio up for split, and use the up/down
arrows as RIT.

The amount to be tuned up/down with each keypress is set in the Configurer >Other tab.

14. CW Tips

 

14.1. CW Macro Tip

Some calls have letter combinations where it's hard for to copy correctly. For example, 6Y2A is often
copied as BY2A. To help make your call easier to copy, Go to >Config >Change Packet/CW
/SSB/Digital Message Buttons >Change CW Buttons, and try changing the default F1 and/or F4
message where * is used for your call. In this example, 6Y2A changes F4 from * to >6<~Y2A.

Result: the 6 is sent 2 WPM slower compared to the rest of the call, and an additional half space is
added between the 6 and Y. Try other combinations of <, >, or ~ to make your call easier to copy.

14.2. Contest Spacing for CW

Select >Config >Change Ports, Telnet Address, Other >Function Keys >Use Contest Spacing for
CW. The box is default ON. This setting changes the spacing between words in your CW, where
"N1MM 599 5" is 3 words. Default is 6 bits for "contest spacing". When this box is not checked, 7
bits between words is used, which is "normal spacing".

15. Working Dupes

The default is to work them. The theory is that it's faster to work them than it is to argue, and you
might really not be in there log. If that is the case, and they submit a log, you'll lose points by not
working them.
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The "work dupes" option in the configurer is for ESM and running mode. All it does is determine
what is sent when a dupe calls you AND YOU PRESS ENTER.
When using Enter Send Message (ESM) mode the behavior is a follows:

In S&P using ESM, if you press Enter with a dupe call in the entry window nothing will happen
(intentional), but you can always work him by pressing F4 instead.
In Run using ESM with "Work Dupes" checked, when you press Enter you will send his call
sign and the exchange whether he is a dupe or not. If you want to send "QSO B4" you can
just press F6 instead.
If you don't have "Work Dupes" checked, then to work a dupe in Run mode you will have to
press F5 and then F2 to send his call sign and the exchange; pressing Enter will send the F6
message.

 
All that being said, you can work dupes in either situation (Run and S&P) by pressing the F-keys.

A goal of the program is to promote good operating. Working dupes while running is good
operating. That's why work dupes is the DEFAULT. It is an option because an argument was made
that in a long exchange contest like SS, you might not want to automatically work dupes.

What I suspect happened is that someone turned work dupes off while playing with the program.
This is a complicated program. Changing options that you don't know the meaning of can lead to a
lot of confusion. My advice is:

Get the program working with your equipment1.
Save the ini file2.
Play with the options3.
Discard that ini file and revert to the one from step 24.
Change any options you feel you truly understand and want changed5.
If an option doesn't seem to "do anything" — watch out! You might want to set it back to the
original setting

6.

 

16. What Setting Should I Use for Packet Spot Timeout?

For general DX-ing, 30 minutes is not too long.

For a contest, you might want to crank it down to 20 minutes, since there is more movement of
stations. Also, a lower timeout will mean fewer spots are managed by the program. This may help
performance for those with marginally performing machines.

For testing packet spot behavior when there are few spots, or for testing performance, a timeout
setting of 1000 minutes might be right.

17. How Should I Really Use this Program if I am Single Operator Assisted (SOA)?
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Try these techniques:

Connect to a telnet node. Do a sh/dx/100 to fill up the bandmap.
Pick the band with the most mults as shown in the Available window.
Go to that band and use Ctrl+Alt+Up arrow and Ctrl+Ctrl+Down arrow to work all the mults on
the band. Don't waste too much time on each one.
Go back through the band and use Ctrl+Up arrow and Ctrl+Down arrow to work all other
stations on the band. If you find that a frequency is dead, do you know what you call that?
You call it your new RUN frequency! Call CQ and get a run going.
When the run is over, go pick up any more mults or QSOs on this band.
Now, either move to another band and repeat, or try these techniques. Turn on "QSYing wipes
the call & spots QSO in bandmap" Tune up or down through the band, looking for stations
you haven't worked. Enter all or part of their calls, then tune off. The call will be "spotted" in
the bandmap. You can use Ctrl+Up/Down arrow to work them later. Again, what do we call a
dead frequency? That's right, it's a RUN frequency. ;-) (As you are doing this, if you can work
the station without waiting, of course you should work it.)
If you don't want to type a call, and you know you don't want to work the station, you can mark
the frequency busy with the Mark button (Alt+M).
As you are tuning, watch the bandmap. It will give you big hints as to whether you should
waste time listening to a station. If you start hearing "grumble grumble" 2 kHz away from the
frequency marked with Joe down the street's call, you know to speed right by.

 

18. How to Find a Worked Station in the Log When I Missed Parts?

There are three possibilities to find a worked call in the log. The results are shown in the bottom
part of the low window below the logged QSOs.

When entering the beginning of a callsign after 3 characters a worked station starting with
these three characters will be shown automatically.
When you have from N1MM only N?M this is also enough to show N1MM and every other
station that ends with N?M.
When you only have 1MM and missed the first part of the prefix you can place a * in front of
the characters you have. *1MM will show N1MM and every other station that starts with 1MM in
the callsign.

 
Combinations are also possible:

*1?M will show N1MM but also K1MR, J41YM etc.
*3? or *3* will show all worked callsign with a 3 in the callsign
*3*Z will show every station with a 3 followed by a Z somewhere in the callsign like K3ZO,
VA3UZ etc.

 
Using a * is called a "like" search in SQL. The problem is that a "like" search is very slow so on slow
computers this will take some time.
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In VHF contests use Alt+= (equal) and the program will search everything which matches the
content of the callsign and the gridsquare fields.

19. Databases versus Contests

There is a lot of confusion about how contests are stored in the logging program.
To clear this up, let's start with a couple of definitions:

Database - an Access 2000 format database file with a file extension of .mdb. Any number of
contests may be stored in a database.

Contest - a set of QSOs within the database. They are stored in rows in a table called DXLOG.
Each contest row has a ContestNr which ties it to a ContestInstance entry.

Much of the confusion comes from people thinking that they need to have only one contest in a
database. This is not the case. I have only one database that I log "official" QSOs in. (Of course I
have many test & backup databases.) Why? because the performance of the program is not very
sensitive to database size. I currently have about 14,000 QSOs in my database.
Now if you plan to go on a DXpedition and log 25,000 QSOs, I would recommend a separate
database for that. For most users, no.

Another thing. Did you ever notice the option"Copy (and compact) Database". This is one I bet you
never use, but should use. Deleted space in most databases is not recovered automatically, and
Access is no exception. If you delete a contest, or delete contacts (see tip on deleting contacts), you
will need to run this option to recover the space. Do you need to run it every day? No. Maybe once
every 6 months would do for most people, or before archiving a database.

The most important thing to remember about databases is to BACK THEM UP. Periodically copy
your database to a backup device, or zip it up and copy to a floppy. Even e-mailing it to work would
do! It is your entire record for all of your QSOs using the program. Don't lose it. Also, if you are
going to import data, or delete data, that is a good time to back up your database. If you don't have
the data anymore, no one can help you!

20. How to Upgrade the Database to a Newer Version?

The best way upgrade the database to the current version by opening it with a current version of the
program on the first machine. Then you can open it with the same version on the second machine,
and no database upgrades will need to be done.

Please do a backup first!

Now what do I mean by a "database upgrade"? From time to time, I add columns, indexes, data etc.
to the database. For each of those changes, I have the program query the database to see if the
change has already been made. If not, I make the change. To the user of the program, this is
automatic. All he will notice is that startup takes some additional time.

This works very well. Haven't had any complaints. Nevertheless, a database that is a year or two
since the last time it was opened will have quite a bit of updating to be done. Why not do it on a
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known, working machine?

21. Deleting QSOs (especially important for Multi-User)

This topic affects all users, but multi-user contesters the most.

As part of the multi-user support, I implemented a DELETEDQS contest. When a contact is
"deleted" with Alt+D or the Delete key, it is not really deleted. It is moved to the DELETEDQS
contest. Yes, you could go to DELETEDQS, and remove it, but that would not be wise. Why?
Because there is no reason to delete it, and there are good reasons not to. With it in DELETEDQS,
you can recover it by exporting it to an ADIF file, changing the ADIF file and importing it into the
original contest. That, however is not the overriding reason not to touch DELETEDQS. The main
reason is a Multi-User reason.

In multi-user, DELETEDQS is how I determine to "delete" a contact in the logs of other stations.
Since no contact is ever really deleted, I need only gather all the QSOs and DELETEDQS logged
by a station and add or update them in the other station's logs. This lets me avoid the danger of
deleting rows in a database. Therefore, DON'T MESS WITH DELETEDQS during the contest. Make
a backup after the contest of all the stations' logs. Then you can do anything you want, and I can
help you recover, since you have a backup. If you don't follow this advice, you will not be happy. 

Oh, but if it is a dupe, that's different, right? NO! Log dupes. Cabrillo doesn't care, the contest
sponsor doesn't care, and it doesn't hurt your score. It CAN help your score. Log those dupes, and
DON'T delete them.

22. QSYing Wipes the Call & Spots QSO in Bandmap

Have you ever noticed that the logging program will "spot" dupes in the bandmaps. That is, if you
type in the call of a dupe then tune away from it, the entry fields will be cleared (wiped) and the call
placed in the bandmap.

That feature is always active. There is a similar feature that you must turn on to use. It is called
"QSYing wipes the call & spots QSO in bandmap". It does the same thing as the dupe spotting, but
for other calls you enter. You must be in S&P mode for this to work.

This option is good for combing a band for stations to work during a contest. If a station you hear is
not finishing a qso, you can move on to find another. The program will spot the call in bold, and you
can use Ctrl+Up/Down to go back through and work the ones you skipped.

23. Exchange Abbreviations

What are exchange abbreviations?
Some contests require sections, counties or other entities for the exchange. These must be
LOGGED with standard abbreviations. The menu item >Config >Change Exchange Abbreviations
allows you to edit them.
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What if you don't like for example the standard ARRL abbreviations? Well, you can enter your own.
Let's say you'd like to enter CONN for CT. You can ADD CONN CT in the exchange abbreviation list
and if you enter CONN or CT, the program will LOG CT. Don't replace the abbreviations that are
already there. It's best to just add the ones you like. (I use the presence of certain abbreviations to
determine whether to reload some of the lists.)

24. Too Many Calls on the Bandmap!

What do you do if the calls are crowded together on the bandmap? You need to zoom in or out...

There are two ways to do it. On a traditional keyboard, using the numeric pad plus (+) and minus (-)
keys will zoom the current bandmap. The current bandmap is the one with the cyan frequency
display. If you want to do it with the mouse, hold the cursor over the bandmap you want to zoom,
then right click. Choose zoom in or zoom out.

It is also possible not to show "non workable contacts". This means that only the stations are shown
in the bandmaps which are valid QSOs in the contest and not have been worked before (all
normally gray contacts will disappear from the bandmaps).

25. Gray Line Openings

Watch for gray line openings when your sunrise or sunset match the other station's sunrise or
sunset. You must have entered your lat/long accurately (watch the +/-) in the Station dialog. Your
sunrise & sunset times can be found in Help/About.

Sunrise & sunset for a prefix or call can be found by typing it in the entry window, and looking at
the Info window. Note that the sunset & sunset times are for whatever central point in that country is
specified in the loaded country file (wl_cty.dat or cty.dat).

26. QSO Confirmation

Some contest rules state that the received exchange must be acknowledged for the QSO to count.
If a contest sponsor wants you to acknowledge (i.e. confirm) the exchange, they mean for you to
send "QSL", "TU", or "R" to indicate receipt.
This does not mean a resend from the report back to the station. A resend would provide
verification, not acknowledgment. Only under rare circumstances would you ever repeat the other
stations exchange.

27. Serial Number Contest

When waiting to work a station in a serial number contest, you sometimes log the number, then
increment it for each time you don't win in the pileup. Ctrl+U increments the received serial # by 1.

28. Dead Radio at Startup

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

358 of 680 2/2/2011 4:54 PM



If you fail to turn on your radio at startup, the program will refuse to log contacts. This feature is to
prevent a dead radio from causing you to log contacts on a wrong frequency. If the radio really is
dead, go to the configurer and remove it.

If you just forgot to turn on the radio, then turn it on. If the bandmaps do not show the frequency
after 10 sec or so, you can force the program to open the radio connection by opening the
configurer and pressing the "OK" button. Some people think you have to restart the program, but
that is slower than the configurer approach.

29. Read the Update Log

Every version of the program has a revised update log with it. This log is in the zip file, and can be
accessed with WordPad or from within the logging program (see the help menu). This is a good
source for determining what might have made some feature start or stop working. This is a
cooperative project. The more research you can help with on reporting bugs, the quicker Rick & I
can fix them.

Note that I occasionally change the description or credits on an item after another version has been
released. If you did not get credit for reporting a bug, let me know I'll update the log. The latest
version always contains the most up-to-date info, so there is no reason to save old ones.

30. Packet/telnet Button Setup

Here are the buttons I currently use for AR-Cluster nodes: I don't think these are necessarily
optimal, but they give you an idea of what is possible.
NE only means (near) New England only. (W1 & W2). The first column is the command, the second
column is the button label. & in the button label makes it an Alt hotkey.
Anyone want to post a similar list for other cluster software? (Please test them first.) Also, what
about screening out cw or ssb spots when in a single mode contest?
Note that the menu item >Tools >Clear All Spots will remove all spots from the bandmap. You might
decide that there was too many unreadable stations in the bandmap. You would set a filter (below),
then clear all spots. You could then use sh/dx/100 to refill the bandmap.

Button text Command

BYE BYE

CONN C K1TTT

DI/N DI/N

SH/DX SH/DX/30

USERS SH/U

WWV SH/WWV

Clear NE set/filters dxorigstate/off

Yes DX set/filters dxorigcty/off

NE only set/filters dxorigstate/pass ny,nj,ct,ri,ma,nh,vt,me
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No DX set/filters dxorigcty/pass k,ve, xe

No VHF set/filters vhf/reject

K1TTT {MYCALL}

 

31. Slow PC Syndrome

On some COMPAQ & Toshiba laptops with Win98, it has been seen that the PC can turn very slow
after a beep (eg. CW monitor) has been given. Pulling down menuÃƒâ€šÃ‚Â´s take forever, and the
PC clock operates about 10 times slower than usual. This situation persists even when the logger is
shut down, and until the next boot. The fix is simple just deactivate "Monitor via PC speaker" (Config
- Configure Ports - Function Keys) and boot the PC, and it will never happen again. You only need
to do this if you have noticed the behavior described above.

73 Uffe PA5DD

32. Move RX Frequency from the Keyboard

At a local club meeting last night we watched the FO0AAA video. I've seen a number of other
DXpedition videos before and they all show the operator reaching over after each or so QSOs and
moving the RX frequency. Given this is standard practice for DXpeditions, both SSB and CW, I
thought it would be a useful feature to have that function built into the logging program.

As it turns out, it's really there already in N1MM. If one sets the radio on SPLIT and TXs on the
second VFO, pressing either UP/DOWN ARROW moves the RX frequency up or down by the
amount set in CONFIG/CONFIG PORT, TELNET......./OTHER window. It also works well for regular
contesting. Put the radio on SPLIT SIMPLEX (A=B) and use the UP/DWN arrows instead of the RIT
for those off frequency callers when you're RUNNING.

Gerry VE6LB/VA6XDX

33. Recording QSOs

The program has the possibility to record all QSOs made. With this feature it is possible to listen
back to all QSOs made.

Select 'Record QSOs' under Config' to turn it on/off.
The 'normal' connection would be to have your microphone to the sound card 'microphone in'
and the radio audio out to the sound card 'line-in'. this way the microphone can be used to
record SSB messages on the fly and the line-in can be used to record QSOs or for RTTY
without having to rewire anything. Switching can be done automatically using the setup in the
Audio tab for SSB recording and playback, and also works for CW qso recording. Switching to
RTTY may need
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a manual operation on the windows volume control to select the input source for MMTTY.

Beware that when using the headphone output the level will change with the volume of the
radio so preferable use a fixed audio source from the radio. Also your transmitted audio level
will depend on the monitor level from the send audio/sidetone. There are some nice programs
which can set your audio levels and remember the settings the next time you need them. See
the Links chapter.
You probably want to record not only the station you work but also your own audio/sidetone.
'Monitor on' is needed on most radios.
A recording for a new qso will start as soon as the qso before has been logged, so a recording
will stop when a qso is logged and a new recording will begin.
There is a recording timer the Audio tab in the configurer.
Each qso will become a separate recording (wav file). The wav file is named: '<Callsign>
<Date> - <Time>.wav.' Example: "N1MM 10-26-03 - 22 47 45.wav"
The Wav files (recordings) are stored in a directory under the program directory named after
the selected contest. So when selecting CQWWCW the directory will be named CQWWCW.
E.g. C:\Program Files\N1MM Logger\CQWW\....
Wav files can be played from within the program by right clicking on the qso in the 'Log
Window' and selecting 'Play contact'. Pressing Escape stops playback of recorded contacts.
These Wav files can of course also be played outside the program with any other media player
on your computer which supports WAV files.
Recording uses about 1 GB per 24 hours (40-50 MB per hour) when 8 bits, 11025 Hz/sec is
used. There are programs which can compress these wav files to MP3 files but if this can be
done at the same time when giving CQ depends a lot on the computer used. A clunker will
surely not do it. There is of course the possibility to do this after the contest. Enough harddisk
space during the contest is necessary.
Recording is stopped when there is less than 40 MB space free on the current drive.
Test before using this feature. To get the recording levels all the same (received and
transmitted audio/cw) can be a bit tricky when not using a fixed audio level from the radio.

 

 

Troubleshooting

 
The object of this page is to suggest how to proceed when something goes wrong. If you take these
measures before posting a query on the reflector, you will greatly enhance your chances of getting
good, solid, usable advice the first time around.

1. Get Current

The Configurer lets you pick parameters that your sound card may not support... usually 16 bit,
11025 Hz/sec is safe for all cards.

Soundcard Settings in Configurer
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Make sure you are running a recent version - no more than one or two behind. This is absolutely
necessary because of the rapid evolution of the program, with typically 100 or more versions
released each year. If you aren't running a recent version, update and see if the problem goes away
- it could be something that was noticed and fixed while you were "away."

Every year, Tom (N1MM) publishes a new "Base Install" version of the program, which contains all
the files you will need to run the program. Subsequent updates contain only those files that have
changed, so simply downloading and installing the most recent version won't probably be enough
unless you have first downloaded and installed the Base Install on which it is based.

2. Try Simplifying Your Configuration

 
Problems with the program often arise as the result of changes inadvertently made to the overall
configuration of the program or corruption of the database you were using the last time the program
was open, so a first step is to eliminate those two possibilities.

First, rename your N1MM Logger.ini file so that the program will not recognize it - N1MM Logger.old
is good. Try to restart the program. If it starts, though in very simplified form (one Entry window,
etc.), then you know the problem was somewhere in your configuration, as stored in the .ini file.
Then you can add back your personal configuration choices, one at a time. Start with radio control
ports, then add PTT and CW options. Finally, set up your general options in the Configurer, and in
the various specialized sub-menus that you use.

If the program still won't run, then leave the simplified configuration in place and try renaming your
database(s) or moving them to another directory. It should then start up and create a new empty
database (at least, with no QSOs in it.). If it doesn't start up then, you should probably consider
yourself cursed, and take up a new hobby.

No, seriously, if the problem does seem to be in the database(s), there are a couple of options on
the File menu in the entry Window, including a link to a stand-alone Microsoft utility that you can
download to repair a corrupted database.

If it still won't start after all that, or if the function you're having trouble with still won't work, now and
only now try a reinstallation. A corrupted installation is rarely to blame for the problems people
have, but recently a lot of folks have had trouble because of missing program files. Typically, this is
caused by not installing version 10.0.0 before trying to install and run version 10.x.x Even if you
think you've done this correctly, it may be worth the few minutes necessary to reinstall.

If you feel you need to reinstall, take an extra minute and uninstall your current version from the
control panel. This is normally unnecessary, but recently there have been a case or two where the
uninstallation was necessary to fix persistent problems that did not respond to any normal

At the beginning of 2010, Tom published version 10.0.0. Because it involves some very
significant changes to the audio tab of the Configurer, it is very important that users update to
10.0.0 and from there to the latest update.

Important changes in Version 10
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troubleshooting methods.

3. Search the Manual - some tips

 
Now that the manual is on the website in wiki format here , we are working hard to keep it up to
date and to fix things that may have gotten broken along the way. You can help by letting us know
when you notice things that should be changed. Drop a note to n4zr@contesting.com or
k8ut@arrl.net unless you think that the subject would benefit from others' input, in which case, by
all means, use the reflector .

So, how best to use the manual for troubleshooting? We recommend using the search function on
the web page. This is still evolving, but you'll find the latest information on using it in this section of
the Website User Manual.

Once you've opened a page, though, you may discover that the topic you want is nowhere to be
seen. Don't despair, just hit Ctrl+F to open your browser's search routine, and enter your search
phrase there. This is necessary because some of the pages in the manual are very long, and your
search topic may not appear in the first screenful.

If the program is so badly broken that you can't do a Google search from there, just open the
manual  and you should see the search box in the upper right corner of the page. If you don't see
it, you are probably in full-screen mode. Just click the icon of a window with a small dot on it, which
will be at the far upper right corner of the page, and the search box will come back.

4. Looking for Help on the Reflector

 
OK, so you're really stuck. You have over 3,000 fellow users out there willing to help. You can make
it more likely to pay off quickly if you follow this checklist for information you provide in your first
message:

N1MM program version

For version 9 and before, the default installation location was in C:\Program Files\N1MM Logger.
Because this caused inconvenience for users of Vista and Windows 7, beginning with Version
10, the default location is C:\N1MM Logger.

 

If you are making a first-time installation of the Version 10 Base Install, the installer will
automatically choose this location. Thereafter, the update installer should point to the same
place. However, some experienced users have chosen to continue to install to Program Files,
and a few of them have reported that the update installer insists on pointing to C:\. As you can
imagine, putting the Base Install in one place and updates in another can cause all sorts of
problems. It's worth a double-check.

Where is the program installed?
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Operating system
Relevant interfacing information

For radio control, whether USB or hardware serial port, and what radio
For CW problems, indicate whether you are using serial, parallel or other interface
(Winkey, MicroHAM, etc.)
For voice message problems, what interface to the radio you're using

Symptoms
Include any error messages you received, and be sure to quote them in full

What you have already tried

 

N1MM Logger References

 

Table of contents:

1 Key Assignments Short List
2 Key Assignments
3 Interfacing
4 USB Interface Devices
5 Macros
6 Multi-User Support
7 Grayline program
8 SO2R
9 SO2V
10 Rotator Control
11 Supported Hardware
12 Supported Contests
13 Contest Setup Instructions
14 Supported Radios
15 Third Party Software
16 Frequently Asked Questions

 

Key Assignments Short List
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Running keys S&P Keys

F1 = CQ Shift+F1 = Call CQ and switch to run

; or insert = Send call and report Alt+U= Toggle S&P/Run. Set CQ-frequency for pass

' = Send TU message and enter in log Alt+Q = Return to CQ-frequency

Alt+R = Enable CQ repeat Ctrl+Up/Dn arrow = Grab next qso from bandmap

Ctrl+R = Set repeat time Ctrl+Alt+Up/Dn arrow = Grab next mult from bandmap

Esc = Stop sending, stop repeat -

General keys Radio control

Ctrl+O = Set operator call (or OPON in
Callsign field)

Alt+F10 = Swap VFOs

Ctrl+N = Add note to log Alt+Q = Return to CQ frequency

Ctrl+W or Alt+W = Wipe entry fields,
Release a reserved serial number

Alt+F8 = Return to last frequency

SPACE or TAB = Move between
logging fields

Ctrl+PgUp/PgDn = Up/Down a band

ENTER = Log it (see ESM mode) Type CW/USB/LSB/RTTY = Change mode Type
frequency in KHz = Change frequency or band

Ctrl+Q/A = Quick edit previous or next
call

Ctrl+S = Set radio into split Ctrl+Alt+S - Toggle split
mode

Ctrl+D = Delete last qso! Ctrl+Enter = Set split frequency

Alt+H = Show help Alt+F7 = Set split frequency or offset to specified
frequency

Alt+K = Edit message buttons Alt+' = Toggle between the wide and narrow filters

Ctrl+Alt+Enter = Log a not accepted
'invalid' qso

Alt+F12 - Copy frequency and mode to other radio/VFO
or swaps MAIN and SUB using the CAT radio command

- Backslash ( \ ) = Change Receive (RX) focus
(VFO/Radio)

DX Spots and Band Map ESM Mode

Mouse wheel = Zoom in/out bandmap Ctrl+M = Turn on/off

Keypad +/- = Zoom in/out bandmap Insert or ; = Send call and exchange

Alt+D = Remove spot Enter = Send TU and log it

Alt+P = Send spot Enter = Start CQ again...

Ctrl+P = Send spot with comment Alt+Enter = Log without sending anything

Ctrl+Tab = Toggle to/from packet
window

Multi-User Mode

Alt+O = Store contact in the Bandmap Alt+Z = Set pass frequency (broadcast to all
computers)
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CW SSB RTTY VHF

Page Up = speed
up

Ctrl+Shift+F1 =Record CQ Alt+G = Grab call
from stack

Alt+= = Search entered
info

Page Down =
speed down

Ctrl+Shift+F* =Record
F-key message

Alt+T = RX/TX toggle Alt+minus = Toggle
grids

= = send last Fkey
again

NB. Same keys again to
stop recording

Ctrl+Arrows =
Swaps DI

Ctrl+E = Send message
to stations

Ctrl+K = CW
window

- Ctrl+K = manual
window

Alt+Z = Set pass
frequency

Esc = Stop
sending

- Esc = Stop sending -

 

Key Assignments

In this Section...

Key Assignments
1. General Key Assignments
2. Active Radio/Bandmap Control Key Assignments

2.1. Jump to Spots
2.2. Jump to CQ Frequencies
2.3. Tune the Radio
2.4. Change Keyboard & Radio Focus
2.5. Other Nifty Tricks

3. Non-Active Radio/Bandmap Control Key Assignments
3.1. Jump to Spots
3.2. Tune the Radio

4. Logging Key Assignments
5. Callsign/Exchange Editing Features
6. Message Key Assignments
7. CW Key Assignments
8. Multipliers by Band window Key Assignments
9. Multi-User Key Assignments
10. 'Enter Sends Message' mode (ESM)
11. Packet/Telnet Key Assignments
12. Available Window Key Assignments
13. SO2R Key Assignments
14. RTTY Key Assignments
15. Gridsquare Key Assignments (VHF and up)
16. Rotator Key Assignments
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17. Window Key Assignments
18. Lookup Table Edit

1. General Key Assignments

 

Space - The spacebar will jump from field to field filling in defaults like the callsign from the
frame, 59/599, and information from previous contacts with this station. SPACE IS THE
PREFERRED TAB CHARACTER.
Tab - Jump to the next entry field in the Entry Window.
Shift+Tab - Jump to the previous entry field in the Entry Window.
Alt+H - Show this help file. Note that pressing Alt+H in any window will show the help specific
to that window.
Ctrl+Tab - Toggle between the Entry window and the Packet window.
Alt+F9 - toggle through all the antennas for that band. The selected antenna will show in the
status pane.
Alt+F4 - Quit the program. If two Entry windows (SO2R) the program will not exit. You are
being asked if you are sure.

 

2. Active Radio/Bandmap Control Key Assignments

2.1. Jump to Spots

 

 

Ctrl+Down Arrow - Get next spot higher in frequency.
Ctrl+Up Arrow - Get next spot lower in frequency.
Ctrl+Alt+Down Arrow - Get next spot higher in frequency that is a multiplier.
Ctrl+Alt+Up Arrow - Get next spot lower in frequency that is a multiplier.

 

2.2. Jump to CQ Frequencies

 

The keys below work from all main windows

If you are operating single mode, your mode won't change when jumping between spots.

Note

Note
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Alt+Q - Jumps to the last CQ frequency on this band (active bandmap) and will clear all
textboxes in the Entry Window.
Shift+Alt+Q - Jumps to the last CQ frequency on other band (non-active bandmap).
Ctrl+Alt+Q - Jumps to your last used CQ frequency on any band and tune active bandmap to
that frequency.
Shift+Alt+Up Arrow - Get next spot lower in frequency that is self-spotted.
Shift+Alt+Down Arrow - Get next spot higher in frequency that is self-spotted.

 

2.3. Tune the Radio

 

Ctrl+Page Up - Go up one band. WARC bands are being skipped while logging for a contest.
Ctrl+Page Down - Go down one band. WARC bands are being skipped while logging for a
contest.
Up Arrow - Tune radio down 100 Hz on SSB, 20 Hz on CW (adjustable in the configurer).

FT-1000MP, FT-890, FT-920, FT-990 and FT-1000 and all Kenwood radios
In S&P - pressing the up/down arrows will turn off RIT and tune your main VFO.
In Running mode - it will turn on your RIT and tune the RIT.

Down Arrow - Tune radio up 100 Hz on SSB, 20 Hz on CW (adjustable).
See Up Arrow information above

Alt+F7 - Set split frequency or offset from current frequency for the active radio. When hitting
Enter or click OK with nothing on the line split will be cleared. Press ESC or click Cancel to
exit. More information about working split can be found in the Basic Functions chapter.
Ctrl+Enter - Entering a frequency or offset in the callsign field and entered with Ctrl+Enter will
set a split frequency.
Alt+S - When your rig is in the split mode, Alt+S will reset the RX frequency back to your
transmit frequency, but the split mode is preserved. "Reset RX frequency when running split"
is associated with Alt+S. When invoked, the program will automatically do an Alt+S as you log
each QSO. Operates on VFO-A only!
Ctrl+S - Set radio to split operation, if not in split mode already.
Ctrl+Alt+S - Toggle Split mode on the radio. 'Split' will be shown in the Entry window.
Alt+F5 - Swap radio frequency, mode, and callsigns between VFOs (SO2V) or radios (SO2R).
In SO2R, the receive focus changes to the non-active radio.
Alt+F6 - Identical to Alt+F5 except the receive focus does not change.
Alt+F8 - Jump to your last frequency.
Alt+' (Alt+singlequote) - toggle between the wide and narrow filter for the selected mode
(SSB, CW and Digi modes).
Ctrl+Alt+D - Allows the SO2V user to enable CQ repeat, call CQ on VFOA, and tune the
sub-receiver (VFOB) between CQ's. Currently, this feature is only enabled for the K3, IC756,
IC756Pro, IC756Pro2, IC756Pro3, IC7800, and IC7600.

If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX Always On" to OFF
and leave the Sub RX ON
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If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual RX Always On" to OFF
and leave the Sub RX OFF
If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual RX Always On" to ON
and leave the Sub RX ON
If "Dual RX always on" is OFF and the Sub RX is OFF, turn both ON

2.4. Change Keyboard & Radio Focus

 

Ctrl+Left arrow - Move both TX and RX/Keyboard focus to VFO A or in SO2R to left radio
Ctrl+Right arrow - Move both TX and RX/Keyboard focus to VFO B or in SO2R to right radio
Alt+F10 - Swap between VFOs when using one radio (VFO A-B). On Icom 756 and 7800
toggle between Main and Sub frequencies.

Command is disabled during SO2R for Icom radios that lack a swap VFO CAT
command. This is because the program is unaware of Icom VFO B frequency in SO2R
mode.

Pause - Swap radios and match keyboard to radio.
Backslash ( \ ) - Move RX focus and launches a second Entry Window if only one Entry
window is open (not supported for SO1V).

SO2V - One radio - 2 VFOs - Moves RX focus between the 2 VFOs on the radio.
SO2R - Two radios - Moves RX focus between the 2 radios.

 

2.5. Other Nifty Tricks

 

Mouse wheel - Zoom in or out the bandmap which has KEYBOARD focus.
Numeric keypad + (plus) - Zoom in the bandmap which has KEYBOARD focus to show fewer
stations (less bandwidth).
Numeric keypad - (minus) - Zoom out the bandmap which has KEYBOARD focus to show
more stations (more bandwidth).
Ctrl+T - Turn on the radio and send continuous CW (tune). Ctrl+T again or the Escape key
ends the transmission.
Alt+F11 -Toggle the setting of the run box. Toggle to go into S&P or stay in Run mode when
the frequency is changed (DXpedition mode).
Alt+F12 - Most radios. use this command to copy frequency and mode to other radio/VFO.

A few radios use Alt+F12 for specific features and then mostly swaps MAIN and SUB
using the CAT radio command
FT-1000MP + FT1000D + Elecraft K3 + Icom IC-756 series, IC-781 ,IC-775 and
IC-7800 only

Dual Receive toggle. NB. Only turn Dual Receive on/off from the keyboard so it
stays in sync with the program.

TenTec Orion
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Toggle between Main/left Sub/Right and Active in both ears.
` (backquote or grave accent) - Toggle Stereo/Mono ( LPT pin 5). Disabled in SO1V mode.

Backquote (grave accent) can be found on US keyboard as the unshifted tilde ~
= (equal key) - Will send the last message key (F1-F12) again.

 

3. Non-Active Radio/Bandmap Control Key Assignments

3.1. Jump to Spots

 

Ctrl+Shift+Down Arrow - Get next spot higher in frequency and will skip over CQ-Frequency
when radios/VFOs are on the same band. Proper keystroke operation is radio dependent.
Disabled for SO1V.
Ctrl+Shift+Up Arrow - Get next spot lower in frequency and will skip over CQ-Frequency
when radios/VFOs are on the same band. Proper keystroke operation is radio dependent.
Disabled for SO1V.
Shift+Ctrl+Alt+Down Arrow - Get next spot higher in frequency that is a multiplier. If you are
operating single mode, your mode won't change when jumping between spots. Disabled for
SO1V.
Shift+Ctrl+Alt+Up Arrow - Get next spot lower in frequency that is a multiplier. If you are
operating single mode, your mode won't change when jumping between spots. Disabled for
SO1V.
Shift+Alt+Q - Jumps to your last CQ frequency on the inactive VFO/radio.

 

3.2. Tune the Radio

 

Ctrl+Shift+Page Up - Go up one band.
Ctrl+Shift+Page Down - Go down one band.
Shift + Numeric keypad + (plus) - Zoom in the inactive bandmap which not has KEYBOARD
focus to show fewer stations (less bandwidth).
Shift + Numeric keypad - (minus) - Zoom out the inactive bandmap which not has
KEYBOARD focus to show more stations (more bandwidth).

 

4. Logging Key Assignments
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Enter
Log contact, when 'Enter sends message' is off in config menu.
Sends message when 'Enter sends message' is on in config menu. The send messages
depend on the field values i.e. in which field the cursor is in the Entry Window. Check
the highlighted keys.

Space - Preferred character to move sequentially through Entry Window fields .
Jumps from callsign to Exchange field or vice versa.
Other fields' default values will be filled in
If there is a call on the callsign frame and if the callsign field is empty, the call from the
frame will be placed in the callsign textbox.

Alt+Enter - Send End of Contact message key and log the contact. In ESM it just logs the
contact (nothing sent).
Insert or ; - Sends His Call key followed by the Exchange key.
' - Send TU message and enter in log .
Alt+W or Ctrl+W (Alt+W = Ctrl+W)

Wipe Out Entry Fields, clear information about the current contact in this window
If all of the entry fields are blank, this restores the last wiped contact ("unwipe" function)
Serial number contests: Release a reserved serial number after it has been reserved

Ctrl+Shift+W - Wipe out other window's contact information.
Ctrl+Alt+Enter - Log a not accepted 'invalid' qso (invalid exchange etc.). It will prompt for a
comment. Use 'View | Notes' to correct later.

When no comment is entered "Forced QSO" will be added to the comment field.
Ctrl+Y - Edit last contact.
Ctrl+D - Delete the last contact.
Alt+O - Store contact in the bandmap.
Alt+M - Mark this frequency in the bandmap as being in use.
Alt+D - Removes the spot from the bandmap which is on the callsign frame or in the callsign
field in the Entry window when S&P or CQ-frequency when Running.
Alt+P - Spot the contact on the current Packet/Telnet connection.
Ctrl+F - Find the callsign entered in the callsign field in the log. Pressing Ctrl+F again will find
the next instance.
Ctrl+M - Enable/disable 'Enter sends message' mode.
Ctrl+N - Add a note/comment to your last or current contact.
Ctrl+Q - Quick Edit mode, go back one qso in the log. Enter logs and Escape discards the
changes made. No content checking!
Ctrl+A - Quick Edit mode, go forward one qso in the log. Enter logs and Escape discards the
changes made. No content checking!
Ctrl+U - Increase the number in the exchange field by 1.
Shift+Enter - This command is used for callsign stacking and only available in 'Multi-User
Mode'. It is described in the Advanced Functions section.
Alt+U - Toggles "Running' box". When running is checked, the behavior of Enter Sends
Messages mode changes appropriately. Additionally contacts are logged as being part of a
run.
Alt+K - Change the contents of the Packet/CW/SSB/Digital message buttons.
Alt+Y - Will "yank" the first call from the Check window in the Entry window callsign field.
Ctl+G - Cut number mode toggle.
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Ctrl+Shift+M - Set threshold for Auto-Send option.
Ctrl+Alt+G - to stack additional callsigns in all modes. Same as the macro {STACKANOTHER}

 

Key Send function key(s) Action(s)

Insert His Call Key & Exchange Key Send his call followed by the Exchange.

; His Call Key & Exchange Key Send His call followed by the Exchange.

Alt+Enter Log the contact.

' End of QSO Key & Log contact Send the End of QSO message and log the contact.

5. Callsign/Exchange Editing Features

 

Space Bar - Moves cursor to the position the last position the cursor was in prior to leaving the
Callsign or Exchange fields.
Tab - Move to the next field.
Shift+Tab - Move to the previous field.
Home - Moves cursor to beginning of the field it's in.
End - Moves cursor to end of the field it's in.
Question mark (?) - Sends a ?, and will cause the ? to be highlighted when you reenter the
field . E.g. N?MM will send what is typed, but automatically highlight the ? so you can replace
it. A double ?, as in DL?K?A will highlight all text in between and including the ? marks. The
first keystroke entered will replace all three characters.
Left/Right Arrow - Moves cursor to left or right one position within the field it's in.
Backspace - Delete character to the left.
Delete - Delete character to the right.
Shift+Home - Will highlight from the cursor insertion point to the home (beginning) of the
textbox.
Shift+End - Will highlight from the cursor insertion point to the end of the textbox.
Shift+arrow key - Will highlight as you press the keys. When you type the first character, it
will delete the highlighted character.

 

6. Message Key Assignments

 
The message send by the function keys F1 through F12 depends if you are in Running mode or in
Search and Pounce mode.
It all depends if the Running indicator in the Entry window is marked or not.

Below the function keys with their associated default messages, the function keys can be remapped
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to others on the Function Keys tab in the configurer.

Default Function Keys

F1 CQ key F2 Exchange key F3 End of QSO Key F4 My Call Key

F5 His Call Key F6 QSO B4 Key F7 - F8 Again Key

F9 - F10 - F11 - F12 -

 

Esc - Stop sending CW or wav. file.
Ctrl+R - Set CQ repeat time in seconds or milliseconds (Example: 1.8 or 1800)
Alt+R - Turn on repeat mode. Escape turns it off.
Ctrl+Shift+Fx - Record SSB message for the assigned function key. Pressing Ctrl+Shift+Fx
again stops the recording. Fx can be F1 to F12.
Ctrl+Alt+Fx - Record external DVK memory 1 to 4. Fx can be F1 to F4.

 

7. CW Key Assignments

 

PgUp/PgDn - Adjust CW speed Up/Down active radio using Primary CW Speed Step (Other
tab in Configurer).
Shift+PgUp/PgDn - Adjust CW speed Up/Down active radio/VFO using Secondary CW Speed
Step (Other tab in Configurer) in SO2R/SO2V mode.
Alt+PgUp/PgDn - Adjust CW speed Up/Down inactive radio/VFO using Secondary CW Speed
Step (Other tab in Configurer) in SO2R/SO2V mode.
Ctrl+K - This will open the CW window to send manual CW. Pressing Ctrl+K again will close
the window.

CW will continue to be send when closing the window and the CW message was not
finished sending.

Ctrl+Shift+R - Toggle CW Reverse/No Reverse.

 

8. Multipliers by Band window Key Assignments

 

Ctrl+J - Toggle through the Countries, Zones, Sections & Other windows (if the window is not
open, it will be opened)
Ctrl+Shift+J - Opens or closes the Multiplier-by-band window
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9. Multi-User Key Assignments

 

Ctrl+E - Talk, send a message to another station in the network.
Ctrl+O - Change operator callsign (Multi-user).
Alt+Z - Set pass frequency which is broadcasted to all connected computers.
Ctrl+Alt+M - Change the RUN/MULT status (only when Operator Category = Multi-One)

 

10. 'Enter Sends Message' mode (ESM)

 

Ctrl+M - Toggle 'Enter Sends Message' mode
Alt+Enter - Log without sending anything
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ESM Mode versus Run Mode Keys

Callsign field Exchange field In Run Enter sends
In S&P Enter

sends

Empty Empty CQ (F1) My Call (F4)

New Call (1st time) Empty or invalid His Call + Exch(F5
+ F2)

My Call (F4)

New Call (repeat) Empty or invalid Again? (F8) My Call (F4)

New Call Valid (before sending
exchange)

His Call + Exch(F5
+ F2)

Exchange (F2)

New Call Valid (after sending
exchange)

End QSO + Log(F3
+ Log It)

End QSO + Log(F3
+ Log It)

Duplicate Call Empty or invalid QSO B4 (F6) QSO B4 (F6)

Duplicate Call Valid (before sending
exchange)

QSO B4 (F6)
Exchange (F2)

Duplicate Call Valid (after sending
exchange)

End QSO + Log(F3
+ Log It)

End QSO + Log(F3
+ Log It)

Dupe (1st time) Work
Dupes checked

Empty or invalid His Call + Exch(F5
+ F2)

QSO B4 (F6)

Dupe (repeat) Work
Dupes checked

Empty or invalid Again? (F8) QSO B4 (F6)

Dupe - Work Dupes
checked

Valid (before sending
exchange)

His Call + Exch (F5
+ F2)

Exchange (F2)

Dupe - Work Dupes
checked

Valid (after sending
exchange)

End QSO + Log
(F3 + Log It)

End QSO + Log
(F3 + Log It)

11. Packet/Telnet Key Assignments

 

Ctrl+P - Spot the station entered in the callsign field as a spot to the active cluster connection,
either packet or telnet. You will be prompted for a comment. If no station is entered in the
callsign field, the last station worked this session will be spotted.
Left-click - Tune the active radio to the frequency of the spot.
Shift+Left-click - Tune the inactive radio to the frequency of the spot.
SH/DX - Entered in Entry window Callsign field will be passed through to active Packet
window for processing.

 

12. Available Window Key Assignments
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Left-click - Mostly tunes the active radio to the frequency of the spot. Behavior depends on
SO1V, SO2V or SO2R and .
Shift+Left-click - Mostly tunes the inactive radio to the frequency of the spot. Behavior
depends on SO1V, SO2V or SO2R.
Double click - Go to the frequency with the active VFO.

 

13. SO2R Key Assignments

 

Ctrl+Enter - Send next ESM state on alternate radio (assuming ESM turned on).
Ctrl+F1 to F12 - Send Fn message on alternate radio.
Ctrl+Left Arrow - In SO2R move both Transmit and Receive/Keyboard focus to left radio, or in
SO2V move both TX and RX/Keyboard focus to VFO A.
Ctrl+Right Arrow - In SO2R move both Transmit and Receive/Keyboard focus to right radio,
or in SO2V move both TX and RX/Keyboard focus to VFO B.
Pause - Move both TX and RX Keyboard focus to other radio (or other VFO in SO2V). If TX
and RX focus are split when you hit pause, TX focus will move to where the RX focus is.
Ctrl+B - Dueling CQ's will send CQ (without delay) alternately on each radio. If Dueling CQ's
is turned on, both radios become run radios. Dueling SSB and CW CQ's are supported too.
Grave accent, backquote, or unshifted tilde key (~) Toggle STEREO mode on/off, or toggle
Auto/PTT modes with modified DXD . Notes: On US keyboards, the key we are talking about is
the key just to the left of the number 1 key.
Ctrl+I - Toggle SO2R Mode (Soundcard). Toggle through the SO2R modes supported by the
program. Only operative in '$5SO2R' when N1MM logger controls the audio, not when using
an external SO2R controller.
Ctrl+PgUp/Down - When changing band using Ctrl+PgUp/Down will skip the other radio's
band.

THIS IS NOT A SUBSTITUTE FOR HARDWARE LOCKOUT!!
Ctrl+Shift+I - Toggle 'Advanced SO2R'. An advanced method of automated focus control. See
SO2R.
Ctrl+Shift+N - Set advanced SO2R delay time
Ctrl+Shift+K - FocusOther, Another method of automated focus control. Forces entry focus to
non-transmitting radio, with entry focus returning to the transmitting radio as soon as it reverts
to receive. See SO2R. Disabled in SO1V mode.
Ctrl+Shift+L - Toggle CTRLFx Macro. This macro allows the user to send on the other radio
(CW only).

 

14. RTTY Key Assignments
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Alt+T - Toggle TX - RX
Alt+G - Grab callsign
Ctrl+K - Toggle TX/RX, and displays the CW/Digital Keyboard window to send manual
information using the keyboard
Ctrl+Arrows - Swaps from one active DI to the other DI. DI1 will follow entry window 1. DI2 will
follow entry window 2
Esc - Stop sending

 

15. Gridsquare Key Assignments (VHF and up)

 

Alt+equal (=) - Search entered info from both the Callsign field and the Gridsquare field in the
call history table.

The results will be shown in the Check window.
Alt+minus (-) - Toggle through call history and entered grid squares (max 3) in the grid
square entry field.

When no grids are found in the call history there is nothing to toggle..

 

16. Rotator Key Assignments

 

Alt+J - Turn rotor to bearing for the callsign in the Entry window or to the callsign in the
callframe (when callsign field is empty).
Alt+L - Turn rotator to long path bearing for the callsign in the Entry window.
Ctrl+Alt+J - Stop turning the rotator when turning and no bearing in callsign field in Entry
window.

 

17. Window Key Assignments

 

Ctrl+Tab - Toggles between the Entry window and Packet window.
Ctrl+K - Display the CW/Digital Keyboard window to send manual information using the
keyboard.
Ctrl+L - Display the Log window (toggles between open and minimized).
Ctrl+J - Display the Multiplier window, Toggle through the Countries, Zones, Sections & Other
windows when open.
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18. Lookup Table Edit

 

Ctrl+D - to delete a row in the table or use the right click menu
Scroll Lock - the Scroll Lock key selects the current row for editing

 

Interfacing

In this Section...

Interfacing
1. General
2. Radio interfacing
3. Interfacing for CW Keying and PTT

3.1. Parallel (LPT) Port
3.2. Serial (COM) Port
3.3. Using a transistor
3.4. Using an opto-Isolator (opto-coupler)

4. Via USB port
5. Additional Parallel Port Interfacing
6. Band decoder output

6.1. Sample configs
6.2. Sample Config > Antenna for two stacked antennas

7. Bearing data
8. Sound card interfacing

8.1. Preferred method
8.2. Another possible soundcard interface.

9. Serial and Parallel port interfacing under Windows NT/2000/XP
9.1. Everything on one COM port
9.2. I need more serial ports
9.3. Renumber your serial ports

10. Hooking up a Footswitch
10.1. Parallel port
10.2. Serial port footswitch information (using the 9 pin connector numbers)

1. General

 
The program can interface with your radio using several ports from the computer. These ports are:

Serial port - With a serial port it is possible to send CW, key PTT or communicate with your
radio. Most computers nowadays have one Serial communication port with 9. Laptops mostly
have one serial port but sometimes no serial port at all. When there is no serial port (available)
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a USB to serial converter can be used.
Parallel port - With the parallel port it is possible to send CW and key PTT at the same time.
There is additional info available on the parallel port. With this additional info you can switch
antennas with the right interface connected. Also there is a pin that indicates which radio is
currently active.
USB port - The USB port can be used with a USB-to-serial converter. Not every USB-to-serial
converter can send CW. Also devices like the microHAM - microKEYER can be used but have
far more capabilities than just being a serial port converter. See the chapter Supported
Hardware for more information.
Sound card - The sound card is used to send sound (Wav) files to your radio for instance for
giving CQ and for sending and receiving when using RTTY with MMTTY. The sound card can
also be used to record all the QSOs you are making.

 
For CW the parallel and serial ports are assumed to have the default addresses shown in the list
below. These addresses can be changed in the configurer to match your Windows setup.

 
These addresses used in Windows can be checked in 'Control Panel > System > Device Manager >
Ports (COM & LPT) > (Choose a port) > Resources > Input Output Range'.

Nonstandard port addresses will not work for CW.

 

2. Radio interfacing

 

If you have one standard and one non-standard COM port, assign the non-standard to the
radio, and the standard port to CW.

Tip
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3. Interfacing for CW Keying and PTT

 

3.1. Parallel (LPT) Port

 
This is a typical simple interface

 
Parallel (LPT) port pinouts

Pin 1 - Strobe
Pin 16 - PTT output
Pin 17 - CW output
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Pin 18 - Ground

 

3.2. Serial (COM) Port

 

 

 

3.3. Using a transistor

 

 

Equivalents for the 2N2222 are 2N3904, BC547 or BC548.
NB. It isn't a bad idea to add a 1 kOhm resistor from base to ground, also adding a shunt
capacitor of 10 nF is highly recommended at the collector output to ground in order to prevent
RF feedback to base and subsequent blocking.

 

The CW and PTT lines for a radio must be on the same serial/parallel port. Example: When
COM4 is the CW Port and Radio 1 or Both is selected, PTT control for Radio 1 must also be on
COM4. USB-to-serial converters are supported, but USB-to-LPT (parallel) converters are not.

Note
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3.4. Using an opto-Isolator (opto-coupler)

 
Some users prefer to use an opto-isolator rather than a transistor, in order to provide more
protection for the serial port in the event of something going wrong downstream. In that case,
however, two special considerations may apply:

You may need to place a diode in series with the input of the opto-isolator, to protect it from
negative voltage swings on a standard serial port. Check the specifications of the opto-isolator
you use to determine whether this is necessary.

 

Some opto-isolators may not pull their output "low" enough (close enough to zero volts) to
switch PTT or CW on a given transceiver. In that case, appropriate "pull-down" measures
must be applied.

 

4. Via USB port

 
Not all computers have serial ports anymore or not enough to control transceivers, packet, serial
CW keying etc. In this case consider a USB to serial port adapter. Most of them do nicely control
the radio. The problem with these interfaces is doing CW and/or PTT (and 5 bit codes). Test before
or ask around if they work for radio control, CW or PTT control with your computer and radio! Also
look first if drivers for your operating system are available.

With N1MM CW will work with native serial ports and with USB-to-serial adapters. For perfect CW
not dependent on Windows processes the answer is Winkey by K1EL. CW transmitted as normal
ASCII characters via the serial port. A USB/serial adapter will work fine with K1EL, because it is
standard serial communications. Check the Winkey manual for more information.

In some cases PTT and CW keying may unexpectedly stop working when using a USB-to-serial
converter. Check this Windows setting:

Control Panel; System Icon,
Hardware Device Manager Tab or button.
Expand USB Serial Bus Controllers
Highlight each USB Root Hub
Double click for Properties settings, Power Management tab,
Remove the check mark from 'Allow the computer to turn off this device to save power'.

The box is checked by default in most cases.
Reboot the computer

 
A table giving evaluations by N1MM users of various USB-to-serial converters is in the References
Section. Another overview of serial- to-USB converters can be found at the RTTY contesting page

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

382 of 680 2/2/2011 4:54 PM



by AA5AU at: http://www.rttycontesting.com

5. Additional Parallel Port Interfacing

 
If the type of CW port chosen is LPT1, LPT2 or LPT3, and a hardware LPT port is used, additional
information will be present on the chosen parallel port. In configurer select for which Radio the
output has to be given on the selected port (Radio 1 or Radio 2). The BCD data on the LPT is that
of the current active radio/VFO. The band data is available on multiple LPT ports — Radio 1 on
LPT1, Radio 2 on LPT2 and so on. USB-to-LPT converters are not supported.

When DVK is selected, the Antenna selection via the LPT port is disabled.
The DVK pins and the antenna pins on the LPT port overlap.
Parallel port pin layout

LPT
pin

Description

1 Return for PTT and CW output. This pin has limited sink capability, so you may need to
buffer it

2 Band output (Least Significant Bit) set by Antenna tab in Configurer. This pin is also used
to stop the message sent on the hardware DVK.

3 NA-compatible TX focus. - Radio 1/2 Pin 3 will go to a logic LOW level (0V) when Radio 1
has TX focus and to a logic HIGH level (5V) when Radio 2 has TX focus. (NB. LPT pin 3
is the complement of Pin 14). Set ONLY if no hardware DVK output is selected (msg# 1).

4 NA-compatible RX focus. LPT Pin 4 will go to a logic LOW level when Radio 1 has RX
focus and to a logic HIGH level when Radio 2 has RX focus. Set ONLY if no hardware
DVK output is selected (msg# 2).

5 (Shift+singlequote) to toggle for Stereo mono. LPT Pin 5 will go to a logic LOW level for
mono audio and to a logic HIGH level for stereo audio. Set ONLY if no hardware DVK
output is selected (msg# 3).

6 Set ONLY if no hardware DVK output is selected (msg# 4).

7 Band output set by Antenna tab in Configurer

8 Band output set by Antenna tab in Configurer

9 Band output (Most Significant Bit) set by Antenna tab in Configurer

14 Radio select A/B (transmit focus) for DX Doubler compatibility. LPT Pin 14 will go to a
HIGH level when Radio 1 has TX focus and to a LOW level when Radio 2 has TX focus.
(NB. LPT pin 14 is the complement of Pin 3)

15 Footswitch input port

16 PTT output, high = transmit mode

17 CW output

18-25 Return for Band output
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6. Band decoder output

 
Pins 9, 8, 7 and 2 can be set using the Antenna tab in Configurer. The output on the pins will follow
the selected code which is being set up by the selected antenna.

 

6.1. Sample configs
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To replicate the default Top-Ten Devices behavior, you would need to set up the Antenna tab in
Configurer as shown above to the left|
It is possible to use more than one antenna per band with N1MM logger. With Alt+F9 it is possible
to toggle between these antennas.
NB. Don't forget to add a space after the comma when more than one band is specified (e.g., 7,
3.8, not 7,3.8)

6.2. Sample Config > Antenna for two stacked antennas

 

 
You will need to make appropriate provision with a diode matrix on the output of your band decoder
to select the appropriate antenna or antennas when a given code is sent from the program to the
decoder. For example, if your band decoder outputs positive voltage

7. Bearing data

 
Bearing data for rotator control is currently not available on the LPT port.
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8. Sound card interfacing

 

8.1. Preferred method

 
It is better to run the mic through the sound card all the time. That way your audio sounds
the same either recorded or live. It also lets you re-record cq's on the fly, something that is
really needed for 40m and 80m split cqing. Check out "#1 - Zero or Single Card, One radio, No
Sound Card SO2R " which can also be found with more examples in the SO2R section.

 
Select '1 - Single Card - One radio, No Sound Card SO2R' on the 'Audio' tab in the Configurer and
setup the top part of this dialog.
The sound is centered rather than set to a radio channel.

8.2. Another possible soundcard interface.

 
This is NOT the preferred method any more!
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A 8:1000 ohms transformer should be used when the sound card speaker output is used to
the radio microphone input.
A 600:600 ohms (1:1) transformer should be used when the line output from the sound card is
used to the radio microphone input.

 

9. Serial and Parallel port interfacing under Windows NT/2000/XP

 
Windows NT, Windows 2000, XP and their descendants require a special dll, DLPORTIO, which will
be installed by running: PORT95NT.EXE to use the parallel, serial and USB ports.
Windows 95, 98 (SE), ME don't need this special dll. In these operating systems N1MM logger can
access the parallel port direct without the need for an extra driver.

To install the NT/2000/XP capable dll, do the following:

Download PORT95NT.EXE. A link to this file can be found in the installation section.
The size is about 1,6 Mb.
To install, just run port95nt.exe

Select Next, Yes and typical where appropriate.
Yes to boot your PC
You are done.

You have to be the administrator of your machine when running port95nt.exe

 

9.1. Everything on one COM port
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By Uffe PA5DD.

Shared ports allow for example Radio control/PTT/PTT-interrupt/CW on just one COM port, which
might be all you have on your laptop. It requires that you make a serial splitter or a common
interface. There are some pitfalls though:

Radio control communication is without hardware handshake (as you are using the hardware
control pins for other purposes). This is not a problem as such, since hardware handshake is
not used by your radio. True at least for ICOM & YAESU.
Some interfaces wire RTS/CTS together to allow a PC set for hardware handshake to work
properly. This link must be removed for port sharing, as it will generate a permanent PTT
interrupt on the CTS pin. This will abort your messages as soon as you start them. Also DSR
should not be connected to anything.
In some radio control serial level converters the handshake signals are used as power supply.
This is not possible if both RTS & DTR are used for CW/Other. You will have to provide power
supply from somewhere else (I use the PS/2 mouse port). Note that in this case you only have
to split out GND TXD RXD for the radio control.

 

9.2. I need more serial ports

 
By Didier KO4BB

Interrupts are the limiting factor to more than a handful of serial (com) ports. There are 2 ways to
address that:

1) You want to use "standard" hardware using Windows "standard" com port model, and as long as
the software will let you select IO port and IRQ, and as long as you don't need parallel printer or
floppy (and as long as your video card does not use IRQs also), and if the program lets you share
IRQs (for instance, you don't need an IRQ for a serial port used to drive the PTT line), (that's a lot of
if's!!!) you can probably cram 4 to 6 com ports into a single PC. Note that you may still have
problems if you try to run high bit rate on all the ports at once (that should not be a problem with
radio control though). Please note that the "standard" PC setup (and Windows) supports 4 com
ports with only 2 IRQs. Those who have tried know that you don't want to run high bit rate on COM
1 and COM 3 at the same time because they share the same IRQ.

2a) You do away with standard hardware, and then you can use specialty boards that have 4, 8 or
even 16 ports. However, these boards use communication processors so they only need one IRQ
from the PC but your software needs to be aware of and be able to communicate with that
processor, either through custom software, or through a driver for your OS (Operating System i.e.
Windows), or both. That's what ISPs use to gang a bunch of modems to support more than a
couple phone lines/modems with each PC. While these may have high communication rate
capabilities (because the communications processor uses FIFOs, small memory buffers that store
incoming data until the PC is ready to take it), they also offer higher latency (response time) than a
native port, not ideal for CW, although with a fast PC, most users have been satisfied with this
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setup.

2b) USB adapters fall in the category of non-standard hardware, but because USB is now built into
the motherboard, the communication processor hardware is directly supported by the BIOS, and
the OS has the proper drivers, so that has quickly become a standard. However, the USB standard
was not designed to minimize latency, so a USB-serial adapter, while OK to talk to a radio via it's
serial port, is not ideal to do things such as CW using bit twiddling. That should be reserved to
native serial or parallel ports (motherboard or add-on card). USB adapters are probably a little
worse (with regard to latency and CW capability) than custom communication processors described
at 2a) because the USB adapters communicate with the PC through a serial link instead of being
directly connected to the processor bus, so the bit twiddling has to be done though a serial link,
which adds latency. In addition, since the USB port may be shared with other devices, accessing
these other devices while sending CW would be a bad thing.

Bottom Line: There are excellent USB combination interfaces now available that can control one or
more radios, key them with Winkey, and even provide soundcard facilities.

9.3. Renumber your serial ports

 
As you install new serial ports (serial or USB devices) Windows may arbitrarily assign COM port
numbers to them that are outside the COM 1-8 range of the N1MM Logger configuration menu.
Reassign the serial/USB port to a different number. Here's how:

1) Right click "My Computer"

2) Left click on "Manage"

3) Left click on "Device Manager"

4) Look in the right window and find + Ports (COM & LPT)

5) Left click on the Plus sign

6) Right click on the COM17 line

7) Left click on the "Properties" selection

8) Left click on the "Port Settings" tab

9) Left click on the "Advanced" button

10) Select the COM Port Number you want in the drop down menu

11) Click on "OK" a bunch of times to back all the way out

12) Your serial/USB port number will now appear as the number you chose
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If you have more than one COM port, you can change them all by selecting each one in turn and
going through this process.

73 de Bob - KÃ˜RC in MN

10. Hooking up a Footswitch

 
A footswitch can be hooked up to a serial and a parallel port. The footswitch program action is for
both LPT and COM ports on switch closure.

10.1. Parallel port

 
If pin 14 is not used to switch radios using an external SO2R box (for example, by using the Pause
key), then hooking up a footswitch to LPT1 can be done by connecting a 10k resistor from pin 14 to
pin 15. Pin 14 is normally +5V and provides pull-up voltage for pin 15.. Then connect a normally
open footswitch between pin 15 and pin 18 of LPT1. Closing the footswitch pulls pin 15 low and
performs the function selected in the configurer.

If pin 14 is being used for Radio A/Radio B control of an external SO2R box, a 5V supply with a 10k
series resistor can be used to provide the pull-up voltage for pin 15.

10.2. Serial port footswitch information (using the 9 pin connector numbers)

Connect a 10k resistor between pin 6 and pin 7. Set DTR, pin 4 to "Always On" and RTS, pin 7 to
"Always Off". Connect the footswitch between pins 4 and pin 6.
The program action will be on footswitch closure. The footswitch wires can not be referenced or
connected to ground.

User Evaluation of USB to Serial I/O Interface Devices for use with N1MM
Logger

 
First, a cautionary note, courtesy of Bob, W5OV:

This is a good reference, but potential users should not get a false sense of security because
someone else may have had success with a particular device. In other words, it's more than just the
hardware; the success rate is also closely tied to what operating system you have, what revision of
the driver you are installing for the device you are trying to use, and what other drivers you have
installed previously (which could have been for something you no longer use or no longer have
connected to the computer), and your computer's particular configuration in general.

Drivers: One key thing to never do is to allow Windows to tell you that it already has the driver for a
particular device - you should always install the driver that comes with your interface. Windows can
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misidentify these devices when you plug them in and Windows will let you fail by using the driver it
thinks is correct - and most often Windows is dead wrong.

Generally speaking, with XP you can use most any USB to serial device (Prolific or FTDI chipsets)
as long as you do not have a conflict. When it comes to Vista or Windows 7, FTDI seems to be the
only game in town for close to sure results (Editor's note - not all users agree with this
characterization. See the table below.)

Even with all of this, depending on what you have done with your computer previously, you may
have problems. And again, the point of all of this is that the problems may have nothing to do with
what hardware you are trying to use. It could be something left over by some earlier activity on your
computer. That said, most installations of these devices goes well right from the start. When they
do not, it can be very frustrating.

A further technical note, posted on the N1MM Logger reflector by Joe, W4TV, concerns an easy way
to tell whether a given adapter can handle 45.5 baud RTTY:

Windows serial drivers set the data rate (baud rate divisor) with 14 bits of a "double word." That

limits the max/min range of the driver/UART to 214:1 ... and any maximum rate higher than 512K
will preclude operation at 45.45 bps.

The lower rates are not a 100% guarantee of compatibility but the higher rate is a certain sign
that EXTFSK or AFSK will be required for RTTY.

Be sure to look at the numbered notes for each device - that's where you will find specific issues
discussed. Also, please remember that this table is based on N1MM user comments, and we have
no additional information. Please contact the evaluator for any further details.

Device Vendor Type Submitted by CAT CW/PTT RTTY Win Win

(Name or
model of
Device)

(Company
Name)

(E-mail Address)
(RS-232
rig
control)

(DTR/RTS
works)

(5 Bit
45
baud)

XP Vista

USB to RS232
with FTDI
Chipset (note
1)

? From UK USB
to
SIO

q.g.collier@btinternet.com Y Y ? Y

UC232A (note
2)

ATEN USB
to
SIO

paul@w8aef.com Y ? ? Y

USB to Serial
Cable (note 3)

Belkin USB
to
SIO

pgerhardt@hotmail.com ? ? ? ?

USB2-4COM-M
(note 4)

ByteRunner USB
to
SIO

dave.n3rd@verizon.net Y Y N Y
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Device Vendor Type Submitted by CAT CW/PTT RTTY Win Win

(Name or
model of
Device)

(Company
Name)

(E-mail Address)
(RS-232
rig
control)

(DTR/RTS
works)

(5 Bit
45
baud)

XP Vista

USB-COM-CBL
(note 5)

ByteRunner USB
to
SIO

wc0v10@embarqmail.com Y Y ? Y

Edgeport/4 - 4
RS-232 serial
DB-9 (note 6)

Digi
International

USB
to
SIO

yungthor@ca.rr.com Y Y Y? Y

USB-COM-PL
(note 7)

EasySync
Ltd.

USB
to
SIO

garyhess999@hotmail.com Y ? ? Y

2U 4S Hub
(note 8)

Entrega USB
to
SIO

n3tl@bellsouth.net ? ? ? ?

USB-RS232
Adapter (note
9)

HoseNose USB
to
SIO

cx6vm.jorge@adinet.com.uy Y ? ? Y

USB to 2 port
serial converter
(note 10)

IOgear 2 USB
to
SIO

lew@paceley.com Y ? ? Y

FT232BM (note
11)

PI
Manufacturing

USB
to
SIO

W1TR@ARRL.net Y ? ? Y

Gigaware 6-ft.
USB-A to
Serial Cable
(note 12)

Radio Shack USB
to
SIO

pgerhardt@hotmail.com Y ? ? Y

TU-S9 (note
13)

Trendnet USB
to
SIO

lew@paceley.com N ? ?

Keyspan
USA-19HS
(note 14)

Tripp Lite USB
to
SIO

rojomn@charter.net Y ? ? Y

USB Interface
Cable (note 15)

West
Mountain
Radio

USB
to
SIO

jeffnjr484@yahoo.com Y Y Y? ?

Edgeport /8 - 8
RS-232 serial
DB-9 (note 16)

Digi
International

USB
to
SIO

david_yahoo@levinecentral.com Y Y Y Y
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Device Vendor Type Submitted by CAT CW/PTT RTTY Win Win

(Name or
model of
Device)

(Company
Name)

(E-mail Address)
(RS-232
rig
control)

(DTR/RTS
works)

(5 Bit
45
baud)

XP Vista

Valley
Enterprises
CT-62 (note
17)

Valley
Enterprises

USB
to
SIO

N4JIK kd4lcr@gmail.com Y ? ? ?

 
Note 1: I have used these with both Vista and XP machines, both of which were able to find the
appropriate drivers. The applications in question were the N1MM and SD logging programs, and I
have also used the adapters with the original (pre USB) Winkey device, again with good results.
http://www.usbnow.co.uk/p48/USB_to_RS232_with_FTDI_Chipset_(1.8M_Cable)/product_info.html

. Note: W4TV says that no current FTDI device will do 45.5 baud RTTY without EXTFSK
because no current FTDI chipset will handle data below 300 baud.

Note 2: I have a pair of Aten and one Prolific PL-2303 USB to serial port adapters. Currently I am
using one of the Aten adapters with PL-2303 a driver.All adapters work fine on Vista64
http://www.aten.com/products/productItem.php?pcid=2005010513171002&
amp;psid=20070130144911002&amp;pid=2005022316346005&amp;layerid=subClass7

Note 3: No Joy. Driver by MFG CD-Rom was VERY difficult to install and also tried to find and use a
newer one from the mfg website w/o success. Got the lights to flash on the device like it was trying
but was not making the handshake and would time out the attempt to connect.
http://www.belkin.com/IWCatProductPage.process?Product_Id=281230

Note 4: Tested with Green Heron Everywhere software for control of their RT-20/21 rotator control
boxes. Uses the FTDI chip set. Dave N3RD

Note 5: Works fine with Vista and Win 7 64 bit. Be sure to avoid the Prolific chipset adapters. those
either don't work or crash the OS. http://www.byterunner.com/byterunner/product_name=USB-
COM-CBL/user-id=/password=/exchange=/exact_match=exact . I downloaded the Win 7 drivers. It
seems to be functioning OK. Tom - W4BQF

Note 6: I can get mine to work fine on XP Pro but wile it installs in Vista and is recognized it will not
set up serial ports without crashing the system. I use the Edgeport 4 port USB to serial and it works
fine for FSK and rig control of a 765. Geo N4UA http://www.digi.com/products/model.jsp?lid=EN&
amp;pgid=38&amp;pfid=25&amp;mtid=215&amp;amtid=215&amp;pm=Y

Note 7: I had trouble with my first adapter (Prolific). Then I ordered an FTDI device from EasySync
in the UK and it worked immediately. http://www.easysync.co.uk/

Note 8: It requires a power source which is unmarked I have no specs and need all the help I can
get (N3TL) www.entrega.com?
Note 9: This adapter can also be plugged directly into any rig that has a 9-pin female serial port for
interfacing, such as the Elecraft K3 or Yaesu FT-920. Compatible with 32 and 64-bit versions of:
Windows 7, Windows Vista, Windows 2003, and Windows XP. http://hosenose.com
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/interfaces.asp#USB-RS232

Note 10: Wasn't recognized by Vista. Purchased on Frys.com. Did work for Rig Control of
FT1000MP under N1MM/Vista32 with K1EL USB Winkeyer. http://www.iogear.com/product
/GUC2322/

Note 11: Vintage 2003, http://www.pimfg.com/product_detail.asp?part=UN8BE&amp;child=N&
amp;kwid2=2418 USB Devices&amp;keywordx=5744 USB Converter

Note 12: Worked fine with N1MM, http://www.radioshack.com/product
/index.jsp?productId=3120513#

Note 13: Did NOT Work for Rig Control of FT1000MP under N1MM/Vista32 or with K1ELUSB
Winkeyer. Prolific 2302 chipset. Purchased on Amazon.com. http://trendnet.com/products
/proddetail.asp?prod=150_TU-S9&amp;cat=49

Note 14: Get the Keyspan USB-19 or other Keyspan with same chip and your problems will all be
solved. It was not worth trying to avoid spending $28 with shipping to get two reliable devices.
Available at a very good price at Amazon and quick ship. http://www.tripplite.com/en/products
/model.cfm?txtSeriesID=518&amp;EID=13384&amp;txtModelID=3914

Note 15: I've used the adapter from West Mountain Radio with great success on PTT and RTTY and
it works for me. Web page states that FSK RTTY support requires MMTTY and EXTFSK software.
(W1TR)http://www.westmountainradio.com/Image/StoreConfigs/usb2serial.htm.  W4TV says that
based on study of the driver .inf file, he believes that this device may not function properly for radio
control.

Note 16: After installing MMTTY and N1MM on the new Win7 notebook, I plugged in the EdgePort/8
and crossed my fingers. Windows recognized the device was connected and then went to Windows
Update online and found the driver. It installed without issue and worked immediately with N1MM
and MMTTY. It has a small but nice program that easily allows you to adjust which COMx maps to
which of the physical ports on the device. I have the actual Com port selected in MMTTY's TX tab
and not EXTFSK.

Though I grabbed the /8 I would hope the /4 installs and works just as well, providing 4 serial
connections. I participated in the Mexico RTTY contest this past weekend and the rig control via 1
serial port to my Kenwood TS-2000 worked perfectly. The 2nd serial port is used for a RTTY
FSK/CW connection to the ACC2 port on the Kenwood TS-2000 and that worked perfectly as well. -
K2DSL

Note 17: Per N4JIK, the CT-62 cable from Valley Enterprises Intl. http://www.valley-ent.com  would
not work with the latest Prolific drivers from the company's website, but worked fine with a Yaesu
8x7 series radio and a driver downloaded from Valley's web site . See note 2 for another success
story using an adapter with the Prolific PL-2303 chipset. N4ZR spoke with Valley Enterprises, who
advised that they obtained the driver from G4HFQ , a CAT software writer and hardware vendor in
the UK.

Macros
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In this Section...

Macros
1. General Macros

1.1. {END} Macro Examples
2. CATHEX and CATASC Radio Hex Macro Commands
3. CATAHEX, CATIHEX, CATAASC, and CATIASC Macro Commands
4. Antenna and Rotor Control Macro Commands
5. CW Macros

5.1. CW Macro Examples
6. SSB Macros

6.1. SSB Macro Examples
7. SO2V/SO2R Macros
8. Multi-User Macros

8.1. {MESSAGE} Macro Examples
9. Digital (RTTY and PSK) Macros

9.1. RTTY and PSK Macro Examples
10. Packet/Telnet Macros

10.1. Packet Macro Examples

Macros are key words in a text to send which are being replaced when send. An example is the !
which will be replaced by the station entered in the callsign field. The macros can be used in
several places in the program.

Function key buttons (Entry window)
Packet buttons (Packet window)
RTTY programmable buttons (RTTY window)
PSK programmable buttons (PSK window)

 

 
Macros are executed as they are interpreted, i.e. the program replaces all the macros with their
values and then sends the cw. In the case of things like {log}, it logs the Q, then
sends the message. This is not a programming language, it's a substitution system.

When placing several macros under a function-key during the sending of it they will be substituted
with the contents of the macros.
Example: * will be replaced with your call, so when your call is PA1M a * will be substituted with 4
characters.
Calling a few times another function key with several substitutions in it could bring this up to several
100 characters per function key. To prevent infinite loops the length of the string after substitutions
may not exceed 1024 characters. After this length the program will stop substituting. 1024
characters is over 12 lines of text (from 80 characters).

Not every macro can be used in all the places mentioned above.

Macro use
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When exporting or importing a macro it can not be longer than 70 characters long and the caption
can not be longer than 9 characters wide.

1. General Macros

 
General macros can be used in all the places mentioned above.
Note that the table below is sortable alphabetically by the name of the macro, by clicking on the
up/down arrow icon just to the left of the "Result" heading.

Macro keyword Result

* Call from the Station info dialog, same as {MYCALL}

! Sends the callsign entered in the callsign field. The "!" substitution occurs
before most macro executions /substitutions. The F-Key and Digital
Interface macro substitutions ({F5} {DI5}) occur last.

@ To voice the current receive frequency. The frequency will be voiced to the
nearest 100 Hz dropping .0 if receiving on an even KHz frequency. This
capability can be used to avoid having to rerecord CQ messages on 40m
split. Example message: C:\Program Files\N1MM logger\wav\{operator}\CQ
Listening.wav@C:\Program Files\N1MM logger\wav\{operator}
\AndThisFreq.wav

{BEEP} Make a clicking sound from the PC speaker

{CALL} Call in callsign textbox or, if none, the last call logged. Note: This will send
the call as it was when the message STARTED. If you want to be able to
type the call and send the changes use ! (exclamation point). It does not
ever send the previous call, however.

{CHNAME} If a Call history file is loaded into the current database, and a callsign is
entered for which a name is present in the file, then this macro will send
that name. Call History lookup does not have to be activated for this to work.

{CLUSTER} Cluster callsign from Station info dialog. See examples

{Comment} Macro to add string following {Comment} to comment field of current or last
QSO

{END} This macro stores all macro text after the {END} macro string and executes
it after CW, SSB or DIGI messages are sent. One use of the {END} macro is
to send CAT commands to the radio(s) after a transmission ends. All QSO
message text placed after the {END} macro command is deleted

# Send next (or last) serial number

Macros may be in Upper, Lower or Mixed case. The maximum macro length is 255 characters.

Macro CaSe and Length
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{EXCH} Sent Exchange, either for the last QSO or for the current one, depending
on whether there's a callsign in the entry window or call-frame

{FORCELOG} Same effect as Ctrl+Alt+Enter, but does not ask for a note to be entered

{FORCELOGNOTE} As above but asks whether you want to enter a note.

{FREQ} Frequency from the contact in the Entry window

{GRID} Gridsquare from Station info dialog

{GRIDSQUARE} Gridsquare from grid textbox (contact in Entry window)

{GRIDBEARING} Bearing between own gridsquare and grid textbox (contact in Entry window)

{REVGRIDBEARING} Reverse bearing between own gridsquare and grid textbox (contact in Entry
window)

{KMGRIGDISTANCE} Distance in kilometer between own gridsquare and grid textbox (contact in
Entry window)

{LOG} CW:Logs the current contact. Same as ENTER in the Entry Window. Digital:
Put the {LOG} macro after the {RX} macro... The receive frequency is being
reset to the transmit frequency. Note: does not work in phone (SSB, FM etc)

{LASTCALL} Call of last station logged

{LASTEXCH} Exchange of last station logged. For ROPOCO and LZOPEN only. It does
NOT work for other contests!

{MYCALL} My Call from Station info dialog, same as *

{NAME} Sends the name as entered in the Entry window name field (Example:
TARA) or when no Entry window name field, searches the name in the call
history table

{NAMEANDSPACE} Sends the name as entered in the Entry window name field (Example:
TARA) or when no Entry window name field, searches the name in the call
history table and adds a space behind it

{OTHERFREQ} Is replaced by the frequency of the non-active radio. Used for passing
stations to other bands. Substitutes "R" for decimal on CW

{OTRSP XXXX} Used to send a command to an OTRSP (Open Two-Radio Switching
Protocol) device. XXXX can be any command known to the OTRSP device

{PGDN} Change frequency up equal to amount set under 'PgUp/PgDn Incr (kHz)' 'in
the Configurer under the 'Other tab'. For use after {END} macro like NA
Sprint

{PGUP} Change frequency down equal to amount set under 'PgUp/PgDn Incr (kHz)'
'in the Configurer under the 'Other tab'. For use after {END} macro like NA
Sprint

{PREVNR} Sends the QSO # of the last logged QSO

{LRMHZ} Frequency Left Radio/VFO-A in MHz. Example: 28 when on 28.1234 MHz

{RRMHZ} Frequency Right Radio/VFO-B in MHz. Example: 14 when on 14.1235 MHz
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{RUN} Sends the last logged callsign and then goes into Running mode

{S&P} Sends the last logged callsign and then goes into S&P mode

{STEREOOFF} The stereo bit on the LPT port will be set to OFF

{STEREOON} The stereo bit on the LPT port will be set to ON

{TIMESTAMP} Date and Time from the contact in the Entry window

{TX} CW/SSB: when sent in a function key will key ptt. Use Esc to turn off. This
is a manual PTT from the keyboard. RTTY: Check out the Digital macros
below. Note: This does not appear to work with some radio/interface
combinations.

{CLEARRIT} Reset the RIT to zero. Could be used in the macro that confirms the
contact, usually F3. Use the RIT when the station is calling and when
logged the RIT clears (using F3). Note: Will only work for radios that
support that function. Most ICOM radios do not. Your manual will tell you for
sure

{CTRL-A}...{CTRL-Z} Sends Ctrl+A character to TNC. All characters from the alphabet can be
used (A to Z). Not valid in MMTTY and PSK. See examples

{ENTER} Sends ENTER to TNC

{ENTERLF} Sends Return/Line Feed to the TNC. Try this if ENTER doesn't seem to
work

{ESC} Sends Escape character to TNC. Not valid in MMTTY and PSK. See
examples

{DATE} Short date in Windows format as set in Regional settings

{DATE1} Date in Nordlink-TF/WA8DED format (dd.mm.yy)- format: 26.02.99

{SENTRST} Sends the RST sent as entered in Entry window Snt field

{SENTRSTCUT} Sends the RST sent with the number 9 sent as the character N. Will send
57N or 5NN etc

{TIME} Time in Windows format as set in Regional settings

{TIME1} Time in Nordlink-TF/WA8DED format (hh:mm:ss)- format: 20:36:55

{TIME2} Short GMT time (hhmm)- format: 2036 Information how this macro works in
digital contests can be found at: Time2- How it works

{DAYTIME} Date in TAPR DayTime format - format: 0107162036

{DATEGMT} Date and GMT time - format: 16-jul-01 18:36:55

{TIMEGMT} GMT time - format: 18:36:55

{F1} - {F12} Sends text assigned to function keys F1 through F12

{SOCALLSTACK} This macro enables single operator callsign stacking. When in RUN mode,
this macro gives the operator the ability to stack and retrieve a single
callsign when multiple stations are calling. The stacked callsign does not
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need to be a full call and it can contain a "?". Single operator call stacking
can be used in SO1V/2V or SO2R mode, in both entry windows, and
with/without ESM. When in RUN mode, {SOCALLSTACK} will move a call or
partial call and place it in the callsign frame and bandmap. If a stacked call
exists on the call frame, the callsigns will be exchanged. If the callsign
contains a question mark ("?"), the cursor will highlight the question mark
when the text is popped off the stack. If the callsign does not contain a
question mark, the cursor is placed at the beginning of the callsign upon
return to the entry window. Using the existing command ALT+D, it is
possible to delete a stacked call from the bandmap and call frame without
popping it off the stack with when the callsign entry window is blank.
{SOCALLSTACK} will also pop the call off the stack if ESM replaced the
stacked call with the string CQ-Frequency. When this occurs, the stacked
call will be visible in the bandmap. {SOCALLSTACK} is not intended to be
used with the MM call stacking function. See also the macro
{STACKANOTHER}. Callsigns stacked by {SOCALLSTACK} can be popped
off the stack by pressing the space bar when the CQ-Literal is on the call
frame. More info and examples in the chapter: Advanced functions

{STACKANOTHER} Macro to stack additional callsigns in all modes. Also check the
keycombination CTRL+ALT+G More info and examples in the chapter:
Advanced functions

{LOGTHENPOP} RUN mode only. Intended for with the single operator call stacking feature.
It logs the current station sending corrections if enabled, pops the next call
off the stack, and updates ESM if enabled, to the correct step. The macro
can be used with or without ESM. The suggested macro key is:
{LOGTHENPOP} TU NW {F5}{F2}. In CW, if {LOGTHENPOP} can not pop a
call off the stack and the logged callsign was changed, send corrected call
if enabled and the TU message. More info and examples in the chapter:
Advanced functions. Example function key setup can be found in the
Chapter Function Keys (CW: example 3)

{ROVERQTH} Sends the Rover QTH. Check out the chapter Advanced Functions for more
information on Rover support

{VARYMSG1)
{VARYMSG2}

These macros allow the user to control how often a alternate form of a
function key message is sent instead of the primary form. Each can be used
once in a given Function Key set. The form of the macro is
{VARYMSGn&Primary Message&Alternate Message&How Often to Send
Alternate&}. Substitute the form of the message you want to send most
often for Primary Message. Then substitute the message you want to send
at intervals for Alternate Message. Finally, specify how often you want to
send the Alternate message in How Often to Send Alternate. 2 through 5
tells the program to send the Alternate Message every 2-5 times that
function key is sent. 0 sends the Primary Message all the time; 1 sends the
Alternate Message all the time. Examples: in the CQ Key definition (RUN
F1), {VARYMSG1 &CQ * *&CQ CQ * *&3&} will send a slightly longer CQ

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

399 of 680 2/2/2011 4:54 PM



Macro keyword Result

every three times. In the TU Key definition (RUN F3), {VARYMSG2 &TU&TU
*&4&} will send TU alone after a completed QSO, and send your call only
every 4th time. Any function key text before or after the {VARYMSGn} macro
string is preserved. So, RTTY users may place the {TX} {RX} macros before
and after the {VARYMSGn} macro string. The primary and alternate
{VARYMSGn} fields may contain other macros but the two {VARYMSGn}
macros may not be nested.

 
The TNC Interface does accept all of the macros above.

1.1. {END} Macro Examples

 
The {END} macro signals the program that the remaining {} commands are to be executed when the
program returns from sending the CW, SSB or DIGI messages (this may not yet work for digi). Here
is an example:

Macro: F1 {STEREOOFF}CQ TEST *{END}{STEREOON}

 
Whenever the F1 key is pressed, the stereo bit on the LPT port will be set to OFF. CQ will be sent
via the current mode, and after the message is complete, the stereo bit on the LPT port will be
turned back on. Thus, one can listen to just the second radio while the CQ is being sent, then listen
to both radios after it is finished.

 
So the rule is: All macros with side effects are executed before the message is sent, except for
those that appear after the {END} macro.

So where could this lead? Well, what if I created a radio control macro? That is, a macro where you
could define commands for your particular radio. The syntax would be something like {R1 cmd}.
"cmd" would be replaced with user settable, radio specific commands, like are used with the
bandwidth functions accessible from the bandmap. Using the Orion as an example, a macro could
be set up like this:

Macro: F1 {R1 *UM0}CQ TEST *{END}{R1 *UM85}
This would set radio 1's (an Orion) volume to zero at the beginning of a cq, then back to 85 at
the end of the cq. This is equivalent to turning off monitor just for CQ's. The possibilities are
pretty interesting (There would also be an {R2} macro for SO2R)

Only {} macros with side effects are used when they are placed after the {END} macro. For
example, if you put {MYCALL} or "5NN" after the {END} macro, they will be ignored. Why? Well
the message is over, there is nothing more to send

More to send after the {END} Macro?
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This could lead to controlling RX mute/unmute, monitor on/off, frequency QSY ala NA Sprint rule,
possibly letting keyboard entry and or transmit focus follow the moving VFO etc.

2. CATHEX and CATASC Radio Hex Macro Commands

Macro keyword Substituted by

{CAT1HEX
radio_hex_command(s)}

{CAT2HEX
radio_hex_command(s)}

These commands can be used to send commands to radio # 1 or
radio # 2 requiring hex data input. The macro name must be followed
by the radio hex data and closing terminator }. An example is shown
below. There must be two hex characters per byte including zero (
zero entered as 00). Spaces are allowed anywhere in the hex
command string to make entry and verification easier. You can not
place more than one CAT1HEX or CAT2HEX command in a macro
but the macro can contain one of each command. The exception to
this rule is when the {END} macro is used. More than one radio
command can be sent to the radio by placing a / character between
the radio commands. Spaces are allowed around the / character.
Multiple radio commands are broken into separate radio commands
and sent to the radio using internal command pacing. Depending on
the computer speed and the number of commands in the string, the
use of these macros may delay the operation of the program when
sending of CW or other program operation. There are no precautions
which prevent the use of these macros while the radio is transmitting.
If the user wants to switch an antenna port safely, use the
{ANTRX#TOGGLE} macros which contain a TX inhibit.
An example of an Icom command is: {CAT1HEX
FEFE66E01C0102FD / FEFE66E01C0102FD }

{CAT1ASC
radio_ASCII_command(s)}

{CAT2ASC
radio_ASCII_command(s)}

These commands can be used to send commands to radio # 1 or
radio # 2 requiring ASCII data input. The macro name must be
followed by the radio ASCII data and closing terminator }. An
example is shown below. All leading spaces before the radio
command portion begins are removed and not sent to the radio. All
other spaces in the command are sent to the radio. You can not
place more than one CAT1ASC or CAT2ASC command in a macro
but the macro can contain one of each command. The exception to
this rule is when the {END} macro is used. More than one radio
command can be sent to the radio by either placing a / character
between the radio commands or by concatenating them together.
Spaces before or after the / character are sent to the radio. Multiple
radio commands using the / separator are broken into individual radio
commands and sent to the radio using internal command pacing.
Non-ASCII characters may be included in the radio command string
by delimiting the two character hex value with < >. The leading < and
trailing > characters are not sent to the radio. Spaces are not allowed
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inside the < > characters. Depending on the computer speed and the
number of commands in the string, the use of these macros may
delay the operation of the program when sending of CW or other
program operation. There are no precautions which prevent the use
of these macros while the radio is transmitting. If the user wants to
switch an antenna port safely, use the {ANTRX#TOGGLE} macros
which contain a TX inhibit. Examples of several forms of this
command are: {CAT1ASC PB1;/PB2;} {CAT1ASC PB1;PB2;}
{CAT1ASC P<42>1;PB2;} FT2000 - Play message #1 would be:
{CAT1ASC PB01;} You may place a space between the macro name
and the radio CAT command to improve readability. All leading
spaces after the CAT1ASC macro command name are removed. If the
ASCII radio command contains characters that are macros (*, !, #),
these characters must be sent using the hex notation explained
above.
As an example, this macro contains a macro character {CAT1ASC
*UM0} and will not work correctly. The correct form using hex notation
would be {CAT1ASC <2A>UM0}

 

3. CATAHEX, CATIHEX, CATAASC, and CATIASC Macro Commands

Macro keyword Substituted by

Active radio
{CATA1HEX
radio_hex_command(s)}

{CATA2HEX
radio_hex_command(s)}

{CATA1ASC
radio_ASCII_command(s)}

{CATA2ASC
radio_ASCII_command(s)}

Inactive radio
{CATI1HEX
radio_hex_command(s)}

{CATI2HEX
radio_hex_command(s)}

These eight macros's provide flexibility to send ASCII or HEX
commands to either radio in SO2R mode (or VFO in SO2V) mode
based on Active or Inactive radio/VFO.

Radio specific commands were added for those SO2R users that do
not have identical radios. The new macros follow the same syntax
as the CAT1HEX and CAT1ASC macros.

The F-key macro text passes through a routine that removes CAT
macros for radio(s) that do not qualify based on Active/Inactive
radio(s). This allows one F-key string to be used for multiple
purposes.

An example of a Pro3 macro string that switches DualWatch and
the Rx antenna based on the radio activity is shown below.
{catA1hex fefe6ee0 12 00 00fd}{catI1hex fefe6ee0 12 00
01fd}{catA2hex fefe6ee0 07 c0 fd}{catI2hex fefe6ee0 07 c1 fd}
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{CATI1ASC
radio_ASCII_command(s)}

{CATI2ASC
radio_ASCII_command(s)}

{CATDELAY} This macro suspends the entire program operation to allow CAT
commands to be received and executed by the radio possibly
before a transmission begins. The need for this macro is dependent
on the computer speed, radio interface rate, and radio type. The
form of the CATDELAY macro is {CATDELAY N} where "N" is a user
programmable delay in 50ms increments. The value of N is
internally limited to 20 which would be a delay of 1 second

 

4. Antenna and Rotor Control Macro Commands

 

Macro keyword Substituted by

{ANTRX1TOGGLE}

{ANTRX2TOGGLE}

{ANTRX3TOGGLE}

{ANTRX4TOGGLE}

These macros can be used to switch between antenna ports and toggle the
receive antenna input on some radios when the program is not transmitting.
Some radio models have multiple inputs but lack the CI-V command to
control the port so the functionality of these macros is radio dependent.
When the {ANTRX#TOGGLE} macro is executed, the numbered antenna port
is selected. If the same antenna port macro executed again and the radio is
equipped, the receive antenna will be toggled on and off with each macro
execution. If the antenna port is switched to another port, the current setting
of the RX antenna is stored and used when this antenna is selected again. If
only one radio antenna port is used it is only necessary to assign that
{ANTRX#TOGGLE} macro to a F-key to toggle the RX antenna on/off quickly.

Supported radios: Yaesu FT950, FTDX9000, FT2000 Icom: IC746, IC746Pro,
IC756, IC756Pro, IC756Pro2, IC756Pro3, IC775, IC7700, IC7800 and Elecraft
K3, TenTec Orion, Kenwood TS2000

{TURNROTOR} Turn the rotor to the direction based on the calculated direction

{STOPROTOR} Stop turning the rotor. Note that per the manual some functions are not
supported for all rotor brands

 

5. CW Macros
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CW macros are only substituted when used in substitutions for CW buttons.

CW Program Control and Prosign Macros

Macro
keyword

Substituted by

< Increment CW speed with 2 wpm.
See examples

> Decrement CW speed with 2 wpm.
See examples

~ Send half space character. See
examples

[ SK prosign      . . . _ . _

] AS prosign      . _ . . .

+ AR prosign      . _ . _ .

= BT prosign      _ . . . _

* the ! Macro: To send the CW code for an
exclamation point, substitute a caret ^ in the
macro

Special Character Macros

Macro
keyword

Substituted
by

Macro
keyword

Substituted
by

! *^ . . _ _ . É . . _ . .

" . _ . . _ . Ü . . _ _

' . _ _ _ _ . Ä . _ . _

? . . _ _ . . Á . _ _ . _

/ _ . . _ . Ñ _ _ . _ _

: _ _ _ . . . Ö _ _ _ .

; _ . _ . _ . _ . _ _ . _

( _ . _ _ . $ . . . _ . . _

) _ . _ _ . _ @ . _ _ . _ .

, _ _ . . _ _ !

- _ . . . _ !

 

5.1. CW Macro Examples

 

Sent the call entered in the callsign field
Macro: !

Send his call. The callsign entered in the callsign entry field will be sent by the
program via the serial or parallel port

 

Some calls have letter combinations where it's hard for to copy correctly. E.g. 6Y2A is often
copied as BY2A. To help make your call easier to copy, Go to Config > Change Packet/CW
/SSB/Digital Message Buttons> Change CW Buttons, and try changing the default F1 and/or F4
message where * is used for your call. In this example, 6Y2A changes F4 from * to>6<~Y2A.
Result: the 6 is sent 2 WPM slower compared to the rest of the call, and an additional half
space is added between the 6 and Y. Try other combinations of <, >, or ~ to make your call
easier to copy.

Improving CW Readability
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Sent CQ with your call sent as a macro substitution
Macro: cq~test~de~*

The time between the words is a half space (~).
The * will be replaced with the callsign from the Station dialog {MYCALL}

 

Send part of exchange faster (report sent 6 wpm faster)
Macro: <<<5nn>>>{EXCH}

The report 5nn is sent 6 wpm faster than the exchange (<<< >>>).

6. SSB Macros

 
SSB macros are only substituted when used in substitutions for SSB buttons. SSB macros can be
concatenated using a comma.

SSB Macros

Macro
keyword

Substituted by

{OPERATOR} Specify wav files like: C:\Program Files\N1MM logger\wav\{OPERATOR}\cq.wav
Default to station callsign if not specified.
See examples

 

6.1. SSB Macro Examples

 

Send the call entered in the callsign field
Macro: !

Send his call. The callsign entered in the callsign entry field will be sent by the
soundcard. In the 'Letters' directory all the WAV files for the letters/numbers etc.
must be present. See here

Let each operator have his own WAV files
Macro: C:\Program Files\N1MM logger\wav\{OPERATOR}\cq.wav

You can specify WAV files like: C:\Program Files\N1MM logger\wav\{OPERATOR}
\cq.wav As you change operators in a multi user contest, the WAV files will change
as well. You will have to name them consistently. Note that the WAV directory
syntax indicates a subdirectory under install directory. You can also fully qualify
the file name, like: "C:\wavfiles\cq.wav"
If you really wanted to, you could have: C:\Program Files\N1MM logger\\wav
\{OPERATOR}CQ.wav and name them:

N1MMCQ.wav
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PA1MCQ.wav
Play exchange with operators voice: C:\Program Files\N1MM logger\wav
\{OPERATOR}\5905.wav
{OPERATOR} is a string substitution only implemented for SSB buttons

 

Hear a 'click' and not call the dupe (in S&P)
If you set up S&P F6 to issue the command {BEEP}, you will hear a "click" when you try
to work a dupe

 

7. SO2V/SO2R Macros

 
SO2V/SO2R macros are only substituted when SO2V or SO2R is selected.
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Single Op 2 VFO and Single Op 2 Radio Macros

Macro keyword Substituted by

{OTHERBAND} Sends the band of the other (inactive) VFO/radio (e.g. 80)

{OTHERMHZ} Sends the frequency of the other (inactive) VFO/radio in MHz (e.g. 3.5 and
3R5 in CW)

{OTHERFREQCUT} CW only. Sends last digits of the frequency of the other (inactive)
VFO/radio as cut numbers. Uses the cut number style selected in
Configurer

{JUMPRX} Change the RX focus to the other input window. If only one input window is
shown the second window will be opened

{WIPE} Wipe the focus window. If the entry boxes are all empty, restores the last
wiped contact ("unwipe")

{ADVSO2RON} Turn 'Advanced SO2R' on. See Chapter 'SO2R'

{ASVSO2ROFF} Turn 'Advanced SO2R' off. See Chapter 'SO2R'

{CTRLFX} CW only. Sends on the other radio. Thus a CW Button might look like: "tu
EXCH{CTRLF9}" where F9 on the other radio is set to send a CQ. It is
important to note that via hotkey Ctrl+Shift+L will turn this feature on or off.
When off the CTRLFn macro is ignored

{CONDJUMP} When RX and TX focus are split between two radios, and the user hits the
Enter key, TX focus is first moved to the radio with RX focus. The CW
message is sent. After the CW message has been completed, TX and RX
focus are both moved to the other radio. When RX and TX focus are not
split between radios, and the user hits the Enter key, the CW message is
sent. When the CW message has been completed, TX and RX focus
remain unchanged.
Typical usage in Sprint is: Run F3: TU {END} {CONDJUMP}

{QSYCQ} Allows QSYing to the last CQ frequency on the focus radio

 

8. Multi-User Macros

 
Multi-User macros are only substituted when in Multi-User mode.
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Macro
keyword

Substituted by

{MESSAGE} Send a message (via function key) to other connected stations over the network.
See examples

{PASS 0}
...

{PASS 15}

Pass frequency from station 0 (Master station) through station 15. The Pass
frequency is rounded to the nearest kHz

{PASS 1800}
...

{PASS 28000}

Insert pass frequency for first connected station found on that band. Valid values
are PASS 1800, 3500, 7000, 14000, 21000 and 28000

{PASSMSG
1}
...

{PASSMSG
15}

Pass last QSO information from station 0 (Master station) through station 15

 

8.1. {MESSAGE} Macro Examples

 
The {MESSAGE} macro sends a message (via a function key) to other connected stations over the
network. The info will be shown in big red letters in the Info window from the receiving station(s).
Place a number directly after the {MESSAGE} macro if you want to send the message to one
specific station. If you don't want to send to a specific station, but want to start your message with a
number put "- " in front of the message. Because "*" is used by macro substitution to indicate a
callsign, you cannot put a * a the beginning of a message to indicate that the message should be
sent to all stations. Since sending to all stations is the default behavior, this is not a problem. Just
don't start the message with a number if you want to send the message to all stations.

{MESSAGE} Macro Examples

Button text Macro

F8 Pass
station

{MESSAGE}2 {TIMEGMT} {PASS 1} {CALL} {GRIDSQUARE} {GRIDBEARING}deg.
{KMGRIDDISTANCE} km.
Message sent to station 2 with info about the station in the callsign field. This is a
macro which could be used in VHFREG1 where a station is sent from one band to
another

F8 Pass
station

{MESSAGE} {TIMEGMT} {PASS 1} {CALL} {GRIDSQUARE} {GRIDBEARING}deg.
{KMGRIDDISTANCE} km.
Message sent to all connected stations with info about the station in the callsign
field

F8 OK {MESSAGE}2 OK. Send OK to station 2

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

408 of 680 2/2/2011 4:54 PM



9. Digital (RTTY and PSK) Macros

 
The following substitutions will be made when sending function key.
In the Digital interface the macros below can be used but also all other macros shown under
general macros.
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{TX} Start transmission in the digital interfaces (needed to transmit!) Needed at
thebeginning of every Digital macro!

{RX} Switch to receive in the digital interfaces (needed to get back to receive).
Needed at the end of every Digital macro!

{CLRRX} Clear the RX window. This macro can be used either alone or after an {END}
macro.

{SCQ} Placed at end of TU macro, resume CQ

{GRAB} Grab first callsign from grab callsign window

{DELALL} Delete all entries from grab callsign window

{DELTOP} Delete Top Entry from grab callsign window

{DELSEL} Delete highlighted entry from grab callsign window

_ (Underscore) MMTTY only. Send an idle tone

^ Send the ! character (! sends the other station's call; use ^ to put a !
character in a message)

{FILE:xxxx} Send textfile located in N1MM Logger program directory. xxxxx is replaced
by the name of the text file and the text file needs to be in the logger
directory. The macro works any place in a macro string. If the text file only
contains one line it does not add CR to end of line. When the text file is multi
lined the CR from the last line will be removed so the following text will be
on the same line. Multiple {FILE:xxxx} macros are allowed in one macro
string

{LDIGFQ} Left Digital Interface Frequency

{RDIGFQ} Right Digital Interface Frequency

{PREVTIME} Send previously sent time (for ANARTS and BARTG alike contests)

{ALIGN} Move signal into bandpass range. Does the same as Align Buttons on Digital
Interfaces and the PSK Engine

{PROFILE0} MMTTY only. Reset to HAM default definitions for RTTY mark, space, width

{PROFILE1}
...

{PROFILE8}

MMTTY only. {PROFILE1} through {PROFILE8} in the function keys at the
start of a CQ or S&P macro will change MMTTY's profile. This way it is
possible to have one profile for CQing and another one for S&P or however
you want to set them up

{HXXXX} HAL DXP38 only. The DXP-38 commands are in the form of Hex that look
like $80 $EA. This macro substitution takes the text string in the form of
{HXXXX} or {H80EA} and converts this to the appropriate command that
should be sent to the TU. See the RTTY chapter for more HAL DXP38 info

{DI1}...{DI24} Send text assigned to the digital macro keys DI-1 to DI-24 on the Digital
Interface

{LOGTHENGRAB} Run Mode only. Log the current contact and grab the top callsign from the
Grab window of the DI. If the grab window is empty, logs the current contact
and then switches to the TU key message instead of continuing with the rest
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9.1. RTTY and PSK Macro Examples

 

Example Function Key Macros

Function Macro

Log the contact, grab a call from the Grab box and give an
exchange to the next station.
If the Grab box is empty, this macro will log the contact and just
send the TU message instead.

{TX}{ENTER} !
{LOGTHENGRAB} TU NW
{F5}{F2}{RX}

Log the contact, pull the next callsign from the call stack and
send the exchange to him (see Single Operator Call Stacking in
Advanced Functions).
If you want to stack another station that has called you, just
Alt-Click on the call in the RX window and it will be placed on the
call stack where you can get it with this macro.

{TX}{ENTER} !
{LOGTHENPOP} TU NW
{F5}{F2}{RX}

 

Example Macros for the PK-232 (Digital Interface window)

Button text Macro

Abort {CTRL-C}R{ENTER}TC{ENTER}

TX X{ENTER}

RX {CTRL-D}

Band Up RB U{ENTER}

RxReverse RXREV T{ENTER}

 

Use {TX} and {RX} together in your macros. Otherwise, {TX} alone in a macro will cause the
radio to remain in transmit until you press an RX button or the ESC key

It is best to add the command that your TNC uses to clear the transmit buffer to the end of your
Abort Macro. If not, the transmit buffer still holds the remaining characters that were left in the
sent string and will get sent the next time the TNC sends.

Always use {TX} and {RX} together

TNC - Clear Buffer After Abort
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Example Function Key Macros for the PK-232 (Entry window)

Mode Button text Macro

Running F1 CQ X{ENTER}CQ CQ CQ TEST DE {MYCALL} {MYCALL} K CQ{CTRL-D}

Running F2 Exch X{ENTER} ! UR 599 {EXCH} 599 {EXCH} BK{CTRL-D}

Running F3 Tnx/Qrz X{ENTER} ! TU GL DE {MYCALL} QRZ{CTRL-D}

S&P F1 {MYCALL} X{ENTER}! DE {MYCALL} {MYCALL}{CTRL-D}

S&P F2 Exch X{ENTER}! UR 599 {EXCH} 599 {EXCH} GL DE {MYCALL}{CTRL-D}

 

Example Macros for the KAM

Button text Macro

Abort {CTRL-C}R RTTY {ENTER}

TX {CTRL-C}T

RX {CTRL-C}E

 

Example Macros for the SCS PTC (Digital Interface window)

Button text Macro

Abort {ESC}CLR{ENTER}{CTRL-D}{ENTER}

TX/RX {CTRL-Y}

RX-Reverse {ESC}TR 1{ENTER}

RX-Norm {ESC}TR 0{ENTER}

45 Baud {ESC}BAU 45{ENTER}

75 Baud {ESC}BAU 75{ENTER}

Command mode {ESC}Q{ENTER}

- - - - - -

RTTY {ESC}Q{ENTER}BAU{ENTER}

PSK31 {ESC}Q{ENTER}PSKT{ENTER}

CW {ESC}Q{ENTER}CWT{ENTER}

AMTOR {ESC}Q{ENTER}AMTOR{ENTER}

PACTOR {ESC}Q{ENTER}PT{ENTER}

PACKET {ESC}Q{ENTER}PACKET{ENTER}
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Example Function Key Macros for the SCS PTC (Entry window)

Mode Button text Macro

Running F1 CQ {CTRL-Y}CQ TEST DE * * * k{ENTER}{CTRL-Y}

Running F2 Exch {CTRL-Y}! HI 599 {EXCH} {EXCH} K{CTRL-Y}

Running F3 CFM {CTRL-Y}! QSL TU DE * QRZ? K{CTRL-Y}

S&P F1 {MYCALL} {CTRL-Y}! DE * * K{CTRL-Y}

S&P F2 Exch {CTRL-Y}DE * TU 599 {EXCH} {EXCH} GL DE *{CTRL-Y}

 

Example Function Key Macros for MMTTY (Entry window)

Mode Button text Macro

Running F1 CQ {TX} CQ CQ CQ TEST DE {MYCALL} {MYCALL} K CQ {RX}

Running F2 Exch {TX} ! UR 599 {EXCH} 599 {EXCH} BK{RX}

Running F3 Tnx/Qrz {TX} ! TU GL DE {MYCALL} QRZ {RX}

S&P F1 {MYCALL} {TX} ! DE {MYCALL} {MYCALL}{RX}

S&P F2 Exch {TX} ! UR 599 {EXCH} 599 {EXCH} GL DE {MYCALL}{RX}

Send CQ
on new line

F1 CQ {TX}{ENTERLF} CQ DE {MYCALL}{RX}

 

10. Packet/Telnet Macros

 
Packet/Telnet macros are only substituted when used in the packet/telnet buttons.

Macros for use in packet/telnet buttons

Macro keyword Substituted by

{WAIT} Wait 5 seconds (fixed value)

 

Macros for use in 'Comment For All Spots' (in Telnet/Packet window).
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Macros for use in 'Comment For All Spots' (in Telnet/Packet window)

Macro keyword Substituted by

{GRIDSQUARE} Gridsquare from grid textbox in Entry window

{MODE} Mode used during contact in Entry window

{QTH} QTH from section/qth textbox in Entry window

{ZONE} Zone for state/province/section/oblast/other textbix in Entry window

 

10.1. Packet Macro Examples

 

Connect the local DXcluster using TAPR firmware
Macro: {CTRL-C}C {CLUSTER}{ENTER}
The above sentence is specified for a function key in the Packet Window

{CTRL-C} sends a Control-C character to the TNC which is placed in command
mode
{CLUSTER} will be substituted with the Packet Node Call from the Station
Information dialog. As example: PI8XXX
{ENTER} will be substituted with the Enter key

The result is that the TNC is placed in Command mode (with Ctrl+C) and C PI8XXX is
sent to the TNC because an Enter is sent after the command

 

Connect the Local DXcluster using TF/Nordlink firmware:
Macro: {ESC}C {CLUSTER}{ENTER}
The above sentence is specified for a function key in the Packet Window

{ESC} places an Escape character in the command line buffer. This is the same as
Shift+Escape when the cursor is on the command line from the Packet Window
{CLUSTER} will be substituted with the Packet Node Call from the Station
Information dialog. As example: PI8XXX
{ENTER} will be substituted with the Enter key

The result is that the TNC is placed in Command mode (with ESC) and C PI8XXX is sent
to the TNC because an Enter is sent after the command

 

This is an example where more commands are placed under one function key:
Macro: {ESC}I {MYCALL}{ENTER}{ESC}P 100{ENTER}{ESC}S1{ENTER}{ESC}C
{CLUSTER}{ENTER}
The above sentence is specified for a function key in the Packet Window

{ESC}I {MYCALL}{ENTER} Send my call to the TNC
{ESC}P 100{ENTER} Change the Persistence to 100
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{ESC}C {CLUSTER}{ENTER} Connect my local DXcluster
So one function key does it all!

 

This is an example using the {WAIT} macro:
Macro: {CTRL-M}{WAIT}C PE1M-7{WAIT}PA1M
In the substitutions you can include things like {CTRL-M}. The {WAIT} macro that waits 5
seconds.
Enter is sent automatically after each command. This may cause a problem with some
systems.

 

This example sends Ctrl+Z to the DX-cluster to send packet mail (end message)
When you have no way to send CTRL+Z to the packet TNC. Then set one of the packet
macros to {CTRL-Z} and that works just fine.
Example F12: {CTRL-Z}

 

Multi-User Support

In this Section...

Multi-User Support
1. Features
2. Configuration
3. Multi-User Tools Menu
4. Information

4.1. Rules
4.2. Displaying Rules

5. Macro keys
6. Features
7. Where to Place the Database Files
8. Other Info
9. Example Multi-User Setup

9.1. Before the Contest
9.2. During the Contest
9.3. After the Contest

10. Multi-user log synchronization
11. Multi-Multi Distributed - Multi-User via the Internet

It is possible to use N1MM logger in a multi-computer networking environment, supporting the multi-
operator contest categories. For this to work you need at least two networked computers, with a
maximum of 16. These computers need to have network interface cards or wireless interfaces. The
networking protocol used is TCP/IP. The network needs a so-called "Master" station. The "Master"
station is the one that sets the time, connects to packet/telnet, etc. The Master station is always
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station number 0, in the "Edit Station Computer Names" table.

1. Features

 

Maximum of 16 networked computers with one 'master' station (0-15)
Use of standard network interface cards (NIC's) and wireless interfaces
IP-addresses are used during configuring
Connected computers can be on the same subnet, or distributed across a wide area to any
internet-connected computer
Talk capability between networked stations
Automatic time synchronization
Pass frequency information between stations
DX Spots from Telnet or Packet

Distributed to all connected computers
The ability to send spotting commands from any station on the network

Error messages when a station can't be questioned/updated
The Info Window gives status information and extra options
The Config menu has a special Multi-User Tools menu
Auto resync when a station comes on-line

 

 

2. Configuration

 
Assume that the network is setup and working correctly, so every computer can ping each other.
There is no need to 'see' all the other computers in the 'Networking environment' (My Network
Places etc.), but it helps when sharing/copying/updating files outside of N1MM Logger. You must
be able to ping every computer from every other computer before proceeding with these
instructions. It is not important if the network uses CAT5, wireless, etc.
Networks connected using serial ports (older DOS programs) are not supported.

NEVER turn off the multi-user switch during a contest. This results in contacts being logged to
the wrong station while the multi-user switch is turned off. During testing, to simulate a network
failure, kill the ethernet connection.

When using the 10.x.x.x range and using Windows XP/SP2 the subnet mask 255.255.255.0, as
can be used with other Windows versions, could give a problem. Windows XP/SP2 doesn't like
this subnet mask, if that is the case use as subnet mask: 255.0.0.0. The 192.168 range of IP
addresses is recommended, with a subnet mask of 255.255.255.0

Turning Off Multi-User

Problems with IP address subnet n=masks
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Setup all the computers
Setup all the computers with their radio's as if they were being used stand-alone. Verify
that the radio can be controlled, PTT/CW/.Wav files are working etc.
All computers must use the same version of the program N1MM Logger

Only for the "Master" station
Packet/Telnet has to be working only on this computer
Set the computer clock to the correct time. Every computer will use this time!
This has to be station 0 in the "Edit Station Computer Names" table !

All other networked stations (not the "Master" station 0)
Select the Telnet window to have all DX cluster info shown (received from the master
station)

The Packet window will not give any info on a slave computer
Always use the Telnet window on the slaves, no matter if you use Packet or Telnet on the
master computer

Set up all the stations identically in the "Edit Station Computer Names" table before starting
Multi-User mode
Set up the computer numbers with their associated names on all computers. Your window will
be similar to this one. This is an example of a five computer network.

 

 

Go to >Config >Edit Station Computer Names
Stn # (0-15): Stn Name column - Enter the station number starting with 0 for the master
station. The computer name can optionally be entered after a "colon" : (e.g. 0:15m) The
computer name can be chosen independently from the Windows computer (NetBIOS)
name. The "Master" station MUST BE number 0 and the others must be numbered 1, 2,
3, etc., in order.

 

Computer IP Address column - Enter the computer IP-address or the computer name.
Your choice depends whether the computers are using DYNAMIC or STATIC IP
addresses. If you don't know which, it's safest to use the Computer Name when setting
up this window. If the computer uses DYNAMIC IP addresses, you should always use

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

417 of 680 2/2/2011 4:54 PM



the Computer Name. If the computer uses static IP addresses, you can use either the IP
address or the computer name. Most computers that interface to the internet are set for
Dynamic IP addresses. The use of Static IP addresses in an N1MM Logger network is
strongly recommended.

NOTE: In the above example, the 10-160m, 15m, and 80m station computers are
using STATIC IP addresses, and the 20m and 40m computers have DYNAMIC IP
addresses

To check or create your â€œcomputer name", go to: Windows > Control Panel >
System. In the Systems Properties window that opens, click on the Computer Name tab.
The computer name will appear there. To change the computer name, click on the
â€œChange" button in this window

NOTE: Verify the "WORKGROUP" name is the same on all workstations. Any
deviation in the workgroup name will prevent basic Windows communication
between the workstations (not needed for N1MM Logger but it is desirable for
copying files among the computers on the network).

To check the IP address of your workstation, look at the title bar of the "Edit Station
Computer Names" window. The IP address will be displayed there, as shown in the
graphic above. The following method allows you to check and change an IP address if
necessary. Go to: Windows > Control Panel > Network Connections > Right Click on the
connection that's used to access the internet and select Properties > In the new window,
go to the middle box with the slider and find the line with Internet Protocol (TCP/IP) and
double click on that line. In the new window on the â€œGeneral" tab, check or set your
IP address.

NOTE: Each workstation on the network must have a unique IP address
assignment.

If you do not use a local IP for your address, put an asterisk in the description for the
node, so that the program will know not to connect to that port
An error dialog will be shown when a station connects from an unexpected IP-address

All the computers should have the same settings in the "Edit Station Computer Names"
table, in the same order. Don't swap any entries!
A warning is shown if a blank entry has been added to the multi-computer station table. A
blank entry can cause computers to not be able to connect to each other

 

Start Multi-User mode
Go to >Config >Multi-User Mode.

Clicking on this selection will enable this option.

The setup information is kept in the database. The network configuration will apply to all
contest logs stored within the database. To save time, you can set up the contest & the
Multi-User configuration info on one computer including messages etc. and then copy the
database (*.mdb file) to all the other computers. Next, start Logger, select the database, and
select the contest. Enable Multi-User mode and all workstations should come online within a
minute or less.

Copying Setup Information
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3. Multi-User Tools Menu

 
Adding and deleting QSOs all works automatically. Also that the bandmaps are filled with spots
from the packet/telnet connection from the "Master" station. Below are some tools which you may
use.

Go to >Config >Multi-User Tools

Multi Call Stacking Options - Multiple options can be selected (one selection per set below)
Send Freq/mode to Call Stack Target Station Alt+I

 

Send Partner F-Keys to Stack Target VFOA/Radio 1
Send Partner F-Keys to Stack Target VFOB/Radio 2
Send Partner F-Keys to Stack Target - Disabled

 

Wipe Partner Call if Logged By Stack Target - Disabled
Wipe Partner Call if Logged By Stack Target - Enabled

 

Partner Logging - Disabled
Partner Logging - Enabled

 

Talk to another station Ctrl+E - Send a message to one or all stations. The text sent will
appear in big red letters in the messages part of the Info window from the receiving station.
Enter station number (0-15 or *) followed by a space followed by the text of the message. By
default the program places a * and behind that the band of the station who sends the
message.

Station Possible station numbers
* - Send the message to all stations. Or, omitting the number sends the message
to all connected stations
0 - Send a message to station 0 (Master station)
1 - Send a message to station 1
. . .

Multi-2 support: You need to identify which station is run1 and which is run 2. There is a large
blue number in the Info Window to remind you what you have set for that station. Set up Run
radio 2 in the Multi-User Tools menu as: Set station as Run 2. In the Configurer under Setup
Run radio 1 to use Port 1 and Run radio 2 to use Port 2 (so not both to Both, 1 or 2)

Number Your Multi-User Stations
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Force Time Sync Now - Force date and time synchronization with the "Master" computer.
This happens automatically at start up and every 5 minutes thereafter.

There are tools for resyncing your time with Internet time standards. A nice one used by
N1MM logger users is Dimension 4

Set your pass frequency Alt+Z - Send the frequency that you would like other stations to
send contacts to. The pass frequency will be sent to all your Multi-User computers currently
connected. If you just want stations sent to your CQ frequency, you do not need to set the
pass frequency. At the present time, the pass frequency is reset only after restarting the
program. If you put {PASS 3} in one of your CW or RTTY messages, the current pass (or CQ)
frequency for station #3 will be sent in the message. When sent in CW, the program will
automatically substitute 'R' for the decimal point. DO NOT enter 'R' in the pass frequency.

Enter 0 to reset your frequency.
The pass frequency is shown in the first bottom pane of the Entry window when entered
and in the info window .

 

Send Freq/Mode to Call Stack Target Station Alt+I - This command was originally put in for
WRTC-2006 competitors. It allows the partner station to remotely load VFO B on a target
station. NB Will only work when Multi-user mode is selected.
Log QSOs at all stations - Check this option to log all QSOs on all stations. Selected by
default. All other information (packet spots, pass frequencies) are still distributed to all
networked stations.
Show Connections - Show connection info from all the networked stations.

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

420 of 680 2/2/2011 4:54 PM



 

Status messages
Connected - a connection has been made with that station
Listening - listening for the master station, no connection made (yet)
Error - the Master station is not there (or not in Multi-User mode)

 

Reset Serial Numbers on all Stations - All QSO numbers on all attached stations will be set
to 0. This is an option when the contest starts to have all attached computers start with 0 even
when there are 'practice' QSOs in the log

 

Resync Logs by Date - Allows a computer to gather all differing QSOs from other computers
in the network for a 48 hour period

Enter the start date for the resync (48 hour contests). The date and time shown defaults
to the time of the first contact in this computers log. If there is no log, then it defaults to
the date of the contest from the log selection dialog.
The contests to resync have to be the same (all computers should have selected the
same contest. Example: CQWWSSB).
Resync only pulls QSOs from other computers to the computer where the resync is
requested. The resync is not bi-directional. It does not push QSOs to other stations. This
way it does not load down the other computers as much.
When resyncing old logs you should just have to put in the correct starting point. The
contacts must be logged with the correct station number (which is in the database). I.e.
Station 0 will only send QSOs that are recorded for station 0. Station 1 will only send
QSOs that are recorded for station 1
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Resync Last n Hours - Allows a computer to gather all differing QSOs from other computers
for a period. The period is set in hours. For more info about resync see 'Resync Logs by Date'
Rescore last n Hours - Rescore the last N hours for the current contest. It may be run at any
time but is rather slow

 

Trace Multi-User Messages - Check this option to trace the Multi-User messages send and
received by the station to a trace file (*.TRC). A file name can be entered. This option is
normally only used for error/bug tracking
Force Other Station to Stop Transmitting When I Transmit - Option to force other station to
stop sending

In M/2 and Multi-Single it stops other stations with the same run1/2 selection
Block my Tx Only if Other Stn Transmitting on Same Band&Mode (Multi-One) - This
option permits a second (mult) TRX to transmit simultaneously on another band. If this option
is not checked, the second TRX is locked out on all bands, not just the same band&mode (for
multi-one stations - check the contest rules!)
Don't automatically change to S&P mode - This option disables automatic change to S&P
when QSY. Useful when there is more than one radio on the same band.
Set station as Run 2 - Set this station as the Run 2 station (when in M/2)
Don't work non-mults - Do not allow this computer to log non-multipliers. Also giving CQ on
this computer/radio is not allowed when selected
Show Computer Name _ IP Address Info - Shows computer name and IP address info by
running the program 'IPCONFIG /ALL'

 

4. Information

 
The picture below shows the bottom part of the Info Window where multi-user information is
displayed. Right clicking on the green/red icons will show a menu. See the Info Window for more
information.

 

Connection status:
Green - Connected
Red - Not connected, but the other computer is being actively polled. Initially, when a
computer is unable to reach another computer in the N1MM Logger network, the
connection "ball" in the Info Window will turn red polling for the unreachable computer
will continue for 3 minutes. . Users may experience delays or stuttering in this state.
After 3 minutes, the polling will be automatically suspended, and the connection "ball"
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will turn blue. Since polling has been suspended, there will be no performance impact
on users. When the unreachable computer comes back on-line, the computers will
automatically reconnect, and the connection "ball" will turn green.
Blue - Not connected, but the other computer is not being polled. When the other
computer becomes reachable, the connection will be automatically reestablished. Users
will not experience delays or stuttering in this state.
Light red - Connection in progress or connection lost, the program will try to solve this
situation. This is a transient state.

Station name
Pass frequency - clicking the pass frequency will send a message to the selected station. If
the selected station is your own computer then the left VFO frequency will be changed to the
current pass frequency.
Is he running or S&P
Who is the operator
Rate information
Run/pass frequency

 

4.1. Rules

 
The following 'smart' rules for run/pass frequency are implemented.

Running
I'm on & running

If the running check box is checked, always send to run frequency

 

Not running
I have a run frequency, but I'm chasing a multiplier

The run frequency holds for 1 min, then gets zeroed
I'm not running, and I have a pass frequency way up the band

The user will have to specify the pass frequency
Don't pass, my pass frequency is no good

I guess it is the operators responsibility to zero the pass frequency
Maybe a timer to remind if no QSOs on pass frequency for n minutes? (not yet
implemented)

Don't pass, my CQ frequency is no good
Timer with no CQ's or QSOs on run frequency for 1 min? (not yet implemented)

 

4.2. Displaying Rules
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Running - Show the run frequency

Not running - Show the pass frequency if non-zero, if no pass frequency then show last CQ
frequency if non-zero.

5. Macro keys

 
Macro key substitution is supported by most programmable buttons in the program. For Multi-User
mode there are a few specific macros which can be found on the Macros Chapter.

6. Features

 

Call stacking - Call stacking between computers, enter a callsign on a remote computers
'stack'

To indicate which station you want to stack for, right click on it's "cue-ball" in the info
window, and select the option "Target for call stacking"
A maximum of one callsign can be stacked. If the stack is empty another one may be
stacked

Prohibit transmitting
If another station is sending (single operator or multi-one) don't allow sending if another
station is sending
If another station is sending (multi-two or multi-multi) don't allow sending on same band
See also the option in the Multi-User tools under Config: Force Other Station to Stop
Transmitting When I Transmit

7. Where to Place the Database Files

 
Do not share the log on a server, place it locally on the hard disk of each station.

Sharing logs on a server will MOSTLY not work. Mostly is not good enough. You will think you
are ok, but are not. I do not check for Multi-User temporary errors. The program was NOT
designed nor tested for this
Having the log on every PC provides redundancy, which is important in an RF-filled
environment
It will not perform as well. Local access is almost always faster.

 
There is no harm in using a server to aid in copying files. The mdb files are simply files. They may
be moved around. It is best to close the program before moving them, as with any program writing
to an open file.

8. Other Info
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Deleting QSOs made by another station in a Multi-User situation is not allowed, a warning
message is shown. QSO's must be deleted on the station that made the QSO.
Station 0 sends all incoming spots to every station so the bandmaps are being filled. Use the
Telnet window (not the Packet window) on the other computers in the network. If you send a
message to the packet cluster from any station in the network it will be sent out to
packet/telnet via computer 0. The received answer from the packet cluster will be send out on
the network to all stations
The program can't be shutdown while initializing Multi-User otherwise unpredictable situations
could occur
You will be prompted for the operator call if it has not been entered (with Ctrl+O). A periodic
warning message will be shown if no operator has been specified
The CQ/pass frequencies will be requested at startup
When going through the possible contests you will see a "contest" DELETEDQS. This is not a
contest but deleted QSOs will be moved here by the program, this is especially for Multi-User
support
Connection status is shown at the bottom of the info window
A connection is checked every 10 seconds
All connections are stopped/started when the database, the contest or the connection list is
changed
Also Non-master stations are allowed to close telnet/packet ports
Time synchronization is only shown on the master station
If you Mark or Store spots on a local machine, they will be Marked or Stored on all other
machines
The station name prefixes telnet/packet commands that are displayed. The prefix is not sent to
the cluster. Example: 20M sh/dx
When a connection drops out it will try to reconnect every 30 seconds
Ctrl+Alt+M changes the station status. For Multi-single, ctrl-alt-M changes toggles the station
between Run and Mult status. For multi-2, ctrl-alt-M toggles the station between Run1 and
Run2 status. This station status will be shown on the Cabrillo output.
In the multi-multi category the Cabrillo output will show the station number. In the multi-single
category, the Cabrillo output will show whether the QSO was made by the Run or Mult
station. In the mult-2 category, the Cabrillo output will show whether the QSO was made by
the Run1 or Run2 station.
Any station that is harmonically related with the frequency will be colored red in the Info
window
For single operator and multi-one, the operator callsign will be colored red when transmitting
Group edits are not allowed in the Log window while in Multi-User mode
If a station has selected 'Config | Multi-User tools | Don't work non-mults' , CQing on that
station is not allowed
Only the master station will auto-reconnect to packet/telnet when enabled

 

9. Example Multi-User Setup
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The example below uses file sharing and Netbios lookup for computer (you can see them in the
Networking environment). This is not necessary for N1MM logger to work in Multi-User. When the
computers can be 'pinged' from both sides this is enough to work. All lines with a * are not
necessary to work but are nice to have for other purposes like updating of files etc. This does not
mean that the action mentioned should not be done. It can also be done via other media (CD /
diskettes). In that case the Windows network is not used, as the N1MM network is using the TCP/IP
stack only.

9.1. Before the Contest

 
Master computer

Enable File sharing for Windows networks (*)
Enable "sharing" on master hard disk (*)
Have all installation files ready on master (*)
Set Master IP address according to Station Computer Names list (see below)

This could include a restart and a request for the Windows CD
Note previous IP setting for restoration after contest

Note master Windows computer (NetBIOS) name & workgroup (*)
Start N1MM Logger
Select a new empty database (e.g. PACC2003.MDB) on master
Start a new log for the contest (e.g. PACC) (check manual)
Configure Function keys (SSB/CW/Packet)
Edit Station Computer Names according to plan. For example:

Stn#:Stn Name Computer IP Address
0:master 192.168.10.10
1:160M 192.168.10.1
2:80M 192.168.10.2

Load the relevant country file (e.g. CTY-PACC.DAT) (Tools menu)
Select the Master.dta file to use ('File | Choose Which Contest to Log')
Establish DX cluster communications on the master computer (Packet or Telnet)
Setup or disable internal firewall

 
Non-master computers

Install Network card& TCP/IP when not already done
Setup or disable internal firewall
Enable File sharing for Windows networks (*)
Set IP address according to Station Computer Names list

Windows 98/ME: might include a restart& Windows CD
Note previous IP setting for restoration after contest

Find master on the Windows network (*)
Use Search Computers in Network Neighborhood/Places using the masters Windows
computer (NetBIOS) name)
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Install/Update N1MM Logger
Copy from master via network (*)

Copy database (eg.PACC2003.MDB) from master on this computer
Copy from master via network (*)

Copy WAV directory from master on this computer
Copy from master via network (*)

 
All computers

Start N1MM Logger
Import windows settings
Open database (e.g. PACC2003.MDB) ('File menu) | Select: PACC log')
Set Multi-User on
Setup configuration (Rig control, PTT, CW)
Turn off Windows sounds if using WAV files

Control Panel - Sounds - Scheme: No Sounds

 
Always

Make sure you are running the same version of the program on all computers
Make sure you are using the same contest on all computers
Make sure that all computers have the same time zone and daylight savings offset
Preferable, see if all computers have the same regional settings for numbers, dates, currency,
etc
Preferable, see if all computers have the same short and long date and time formats

 

9.2. During the Contest

 

Check master time setting regularly
Use Internet time server if possible so it is done automatically

Observe network status, and reconnect/resync if necessary on all computers
Note that a resync only imports QSOs to the computer you import from! The computer
where the import comes from is not being updated with the log from computer where
you import to. Stated another way, a workstation will always "pull" QSOs from another
workstation log, it never "pushes" QSOs out.

 

9.3. After the Contest
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Make sure all used computers are connected
Do a resync on all computers
Check QSOs/multiplier status on all computers & compare
Copy & compact database (e.g. PACC2003.MDB) to backup directory
Restore IP settings & Windows sounds scheme on borrowed PCs

10. Multi-user log synchronization

 
Log synchronization is something you should run very infrequently. Each station has its own copy
of the log, so syncing them is only necessary to keep track of mults. They will get out of sync when
one of the stations goes off line. Generally, you should only need to resync the last hour, if you
were disconnected for less time than that. If a new station comes on line, then one of the stations
should email him their database, and he can resync the log when he gets it, for the few minutes he
missed. Where it would take a long time is when a station was off for many hours, and you want to
preserve any contacts that may be in his log, but not in the others.

11. Multi-Multi Distributed - Multi-User via the Internet

 
It is possible to setup some or all of the other stations outside your LAN on the internet. A use for
that might be for one station away from the contest station to connect the contest station, and spot
stations on a band privately so that only his operators could see them. This was done in years past
with spotting nets, and then packet nets. It is not done so much today. Much more than this would
violate the spirit, if not the letter of the rules.

There are some caveats when trying this. You need more than basic computer knowledge for this.
You need to know about IP-addresses, firewall's, routers, port settings, NAT etc.

You need to know your computer (external) IP-address. When directly connected to the web this
can be obtained using the program ipconfig.exe (NT, 2000, XP) or winipcfg.exe (98, ME). This
command 'Ipconfig' should be entered in a DOS window to see the output. When your computer is
in a LAN your connection to the internet will probably be made via a router. All computers will use
internal IP-addresses, the router uses the external IP-address. This link will give your (external)
ip-address in both cases: http://megawx.aws.com/support/faq/software/ip.asp

When a Multi-User connection is not working anymore check the IP-addresses. This address
changes from time-to time (when using dynamic IP addresses - DHCP). Mostly after a reboot from
the PC when directly connected or a reboot from your router when in a lan.

The router should be setup to route incoming traffic to your PC IP-address. No port transformation
should be done. Instructions for this will not be given in detail. With the many different kind of
routers this can not be done. Remember, this is a specialist job!

The used incoming port is equal to 12070 + Station Nr (0-15) to allow port forwarding in routers.
12070 is used for the first PC in the list, 12071 for the second etc.

Firewall - Open port 12070 + Station Nr (0-15) for incoming traffic.
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Router - You probably should use NAT to route incoming traffic on port 12070 + Station Nr (0-15) to
your PC IP-address.

>Config >Edit Station Computer Names

Computers using N1MM logger in the local network need to use the local IP address,
computers outside the local network need to use the external ip-address from the external
network. The router on the external network should use port forwarding to the correct
computer using N1MM logger
Example setup:

The address 192.168.1.11 is the local IP-address at my end (PA1M)
The first two entries are two instances of N1MM logger on two different PC's from Tom
(N1MM)
Example 'Port redirection table' in the router used at PA1M, the given names differ per
router brand:

Service name : N1MM (does not matter)
Protocol: TCP
Public Port: 12072
12072 = 12070 + 2, my local pc which needs to be connected from the 'outside'
Private IP: 192.168.1.11
Private Port: 12072
Active: Yes

NB the IP-address given in this example is not the IP-address used by Tom, N1MM
anymore 

 
The latencies when we tested were in the 100 mSec range.

 
Example at PA1M

0:N1MM 64.252.138.65

1:PA1M 192.168.0.1

The list of IP addresses needs to be different on each machine. Make sure the remote machine
has its external IP address, and the local machine(s) has its internal address

IP Addresses
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Example at N1MM

0:N1MM 192.168.0.1

1:PA1M 63.133.11.55

Is this ethical?

A good legal use for this within today's rules would be for remote spotting stations that could check
for your station needs before stacking a spot for you. This could give guys stuck at home without
much of a station some way to contribute to a multi-op.

The purpose of this is to support IARU HQ stations, and to perhaps inspire a new entry class, such
as the CQWW "Extreme" category. I think it would add a lot to the experience of smaller stations to
be able to participate in a Multi-Multi-Distributed effort and get some of the comraderie that comes
with Multi-Multi operation.

It is a neat idea to have the 10m station in OA, 15m in 6W, 160m in TF etc.

Do we need a new category like Multi-Multi Distributed?

Most rules have provisions that the stations need to be on the same property, and be connected by
wires, or be separated by no more the 500m? Some exceptions are HQ (headquarters) stations in
the IARU contest, and the "Extreme" category in the CQWW contest.
text?

Grayline program

 
A Grayline program comes with the N1MM logger software package. It is included in the N1MM full
installation program. You may install the Grayline program at any time, during initial installation or
later. N1MM logger does not need to be running to use it, or even installed, but you may start the
program from the Window menu in the N1MM Logger Entry Window.
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1. Right Click Menu Selections

 

Grayline contrast
A dialog will open the Sunset and Darkness can be adjusted. A test button is available to
check the settings.

Show my Location - Will show a red dot on your location.
The location as set in the N1MM Logger main program is used (Config | Change Your
Station data| Latitude & Longitude).

Show Meridian Lines - Show the meridian lines on the Grayline map.
Sun

Show Sun - Select or de-select showing the current position of the sun on the Grayline
map.
Small sun - Show a small sun.
Medium Sun - Show a medium sun.
Large Sun - Show a large sun.

Twilight terminator- the width of the gray line in degrees.
Civil terminator - 6Ãƒâ€šÃ‚Âº
Nautical terminator - 12Ãƒâ€šÃ‚Âº
Astronomical terminator - 18Ãƒâ€šÃ‚Âº

 

 

SO2R

The Grayline program was not written by the N1MM team, and they have no ability to implement
enhancements or bug fixes.

 
One frequent issue reported by users has to do with the Grayline window "disappearing" from
the screen. This appears to happen because something corrupts the Grayline program's ".ini"
file (actually named QTH.txt and located in the Grayline folder of the N1MM program directory).

If you encounter this problem, there are two ways to fix it.

1. Right-click on the icon in the task bar, and select "Move" (if "Move" is greyed out, first select
"Restore", then "Move"). Tap one of the arrow keys on the keyboard (this is important but not
obvious). Move your mouse around until the window appears on screen. Left click to freeze the
window where you want it.

or

2. open QTH.txt in Notepad and delete the first two lines. The next time the Grayline program is
started, the window will reappear at the default location, and you can then adjust its position
and size to meet your needs.

Note
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In this Section...

SO2R
1. SO2R Basics
2. Intuitive User Interface
3. Supported features
4. Entry Windows
5. Typical SO2R Entry Windows
6. The SO2R dots (LEDs)

6.1. Dot/LED colors used:
7. Key Assignments (unique to SO2R)

7.1. Entry Window Features
7.2. Bandmap features
7.3. Using SO2R Key Assignments

8. Mouse Assignments
9. SO2R menu (under Config)
10. Software Setup

10.1. LPT keying
10.2. Winkey and WinkeyUSB keying

11. SO2R Radio Support
12. Using External SO2R controllers

12.1. LPT Keying with external SO2R controllers using LPT port:
12.2. Using Winkey and WinkeyUSB

13. SO2R Using the DX Doubler
13.1. Internal DXD Jumpers
13.2. DXD & STEREO Feature

14. Sound Card options
14.1. Sound Card Option #1: Zero or Single Card, One radio, No Sound Card
SO2R
14.2. Sound Card Option #2: Single Card - Two radio, No Sound Card SO2R
14.3. Sound Card Option #3: Single Card - Two radio, Sound Card SO2R, CW
Only
14.4. Sound Card Option #4: Dual Cards - Two radio, Sound Card SO2R

15. LPT port basic SO2R controller design
15.1. Basic SO2R LPT port - Receive Interface
15.2. Basic SO2R LPT port - Transmit Interface

16. Advanced SO2R
16.1. Advanced SO2R Theory of Operation
16.2. Advanced SO2R Controls and Macros

17. Focus on Other Radio (FocusOther)
18. SO2R and MMTTY

18.1. SO2R RTTY with 1 sound card
19. Example screen layouts

1. SO2R Basics

Single Operator 2 Radio (aka SO2R) is an operating technique that when done properly, can add
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many extra QSOs and multipliers to your log. This is accomplished by increasing your efficiency
during slow times. For example, when you are CQing on one radio, but getting few answers.
Efficiency is increased by listening on a 2nd radio while you are transmitting on the 1st radio. On
the 2nd radio you are scanning the bands for needed QSOs and multipliers. If you find a new
station to work on the 2nd radio, you leave it staged on the 2nd Entry Window until you get a free
moment to work this station. Even adding a few QSOs an hour will greatly boost your score.

The philosophy for SO2R development is to allow any two radios to be used; they do not have to be
identical. In its most simple form, two transceivers feed two separate antennas on two different
bands. With sufficient attention to antenna separation and filtering, it is possible to do this without
interference from a transmitting radio to a receiving radio. Many serious SO2R operators use
identical radios to reduce the confusion factor, but having identical radios isn't necessary.

The receiver on one band is used to locate new contacts during the time that the transmitter on the
other band is active. This can mean that you tune the 2nd radio while N1MM Logger sends CQ on
the 1st radio. The most critical requirement for SO2R is automated transmission — if you have to
speak into a microphone or squeeze a paddle while you tune the receiver you will not make the
most of the second radio. It's easy to reach a level of mental fatigue while operating SO2R that
results in an overall score reduction rather than helping your score.

If your radio is not supported by N1MM Logger, or it's an older radio with no computer interface, the
radio can still be used, but you just don't get many of the advantages automated radio control
offered by N1MM Logger.

N1MM Logger also supports "Single Operator 2 VFOs", or SO2V. If your radio simply has 2 VFOs,
VFO A/B will be assigned to each of the two Entry Windows. If you have a radio with a sub-receiver,
each of the receivers gets assigned to each of the Entry Windows. When developing the specs, we
actually felt SO2V would be more widely used than SO2R.When operating SO2V (and SO2R), you
also need to change your LPT or Winkey keying from Radio 1 (default) to BOTH. Otherwise, you will
not get any keying on VFO B or Radio 2.

A maximum of two radios are supported with N1MM Logger.

N1MM Logger's SO2V interface is essentially identical to the SO2R interface, but with SO2V you are
using a single radio. Two windows can be displayed in SO2V, one for VFO A & B. SO2V makes
better use of the 2nd receiver now present in most high-end radios. With the 2nd receiver, you can
be tuning the band while you are listening for a response to your CQ. Since you cannot listen on
the sub-receiver while transmitting, SO2V is not as efficient as SO2R.

For the new SO2R operator, we have 3 words for you: practice, practice, practice! SO2R is definitely
a learned skill that takes time to learn, and even longer to master.

2. Intuitive User Interface

 
As you will quickly see, N1MM Logger's SO2R implementation is more intuitive than most other
SO2R implementations:

Entry Windows can be arranged to reflect equipment layout
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Entry Windows can be used for any function (not dedicated functions like others)
You always know what each VFO or radio is going to send next (when in ESM mode)
Visual cues identifying transmit focus, Run vs. S&P, and more!

 

3. Supported features

 
N1MM Logger supports all of the features you would expect from any world-class SO2R software. In
addition, there are a lot of unique features:

Two Entry windows are displayed that are fully interchangeable in functionality (windows are
not dedicated to a specific task)
Running and S&P modes are maintained for each SO2R Entry window, such that the 2
windows can be used for

Running / S&P
S&P / Running
S&P / S&P
Running / Running

Entry windows can be arranged on screen as desired: typically left/right, or top/bottom, to
represent physical station layout
Each Entry Window has a frequency readout in the top pane
'LEDs' identify which radio has focus. The sending radio has a red LED indicating TX Focus, a
green LED identifies the radio that has RX and Keyboard focus (combined)
Background colors of the entry field change color depending on whether that radio is running
or S&P: white = run; canary = S&P
Ability to change frequency of inactive radio from the active radio. Use the / before entering
the frequency in the callsign field to enter frequency for other radio/VFO
Supports Enter Sends Messages Mode (ESM) on both windows
Typing a call in inactive radio Entry window does not abort sending on the active radio
Hitting Escape stops sending on either VFO or radio, but does not change keyboard focus
Changing transmit focus (for any function) stops sending before switching and sending on
alternate radio
Ctrl+function keys and Ctrl+Enter sends messages on alternate radio (Concept is Ctrl =
Alternate radio control)
"Hotkey's" for specific tasks and sending on alternate radio
All Key Assignments work on both radios (unless otherwise specified)
Supports Top Ten DX Doubler, WX0B Station Master, Microham MK2R, YCCC SO2R, and
other SO2R controllers.
Support SO2R without interfaced radios.
Dueling CQ's will send CQ alternately on each radio (Ctrl+B)

If dueling CQ's is enabled, and CQ sent then both radios become Run radios
Ctrl+F1 or Ctrl+Enter will not start Dueling CQ
Dueling SSB and CW CQ's (different modes in each Entry window) are supported
When you disable Dueling CQs, the pre-existing SO2R options are restored

A SO2R software radio lockout for is implemented
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CQ-repeat is terminated when a message is sent on the other radio
The macro {JUMPRX} changes the receive focus to the other input window
Supports 2 radios - No support for 3 or more radios
Support SO2R with zero, one or two sound cards (5$ SO2R)
When changing band using Ctrl+PgUp/Down key will skip the other radio's band

THIS IS NOT A SUBSTITUTE FOR HARDWARE LOCKOUT!!
The sent CW will echo in the status bar of the Entry Window (only when in SO2R)
During VOX operation, in "$5 SO2R" operation the TX audio should will track the TX focus all
the time

 
There is currently no support for two networked computers for SO2R.

4. Entry Windows

 
Entry windows can be placed anywhere on the screen. Typically people will position them similar to
their equipment layout i.e. if the radios are positioned left/right, the windows are arranged reflect
that. For those who stack their equipment top/bottom, you can position the screens so they logically
mirror that radio setup too.

Screen real estate is in short supply. To minimize screen real estate, you can shrink the Entry
Windows compared to the default layout. Below is an example of the default Entry Window and a
minimized version. Also the use of two monitors more screen real estate.

 

To launch the 2nd Entry Window, hit the \ button.

5. Typical SO2R Entry Windows

 
Most people who are comfortable with N1MM Logger tend to use the reduced size Entry Windows in
the examples below. All of the vital information an operator needs is displayed in the smaller
window. Most SO2R operators get the most efficiency while CQing on 1 radio, and S&Ping on the
other. The Entry Window examples below reflect a typical setup: The left VFO (A) is now assigned
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to running, and the right VFO (B) is assigned to S&P.

All of the features that are available to the single radio operator also work in SO2R/SO2V. For
example, when tuning the band with the S&P VFO, spots that are in the bandmap are automatically
inserted into each call frame (above the callsign in the entry window) when you tune across the
frequency of the spot. Hitting the space bar will pull the callsign from the call frame into the callsign
field. If a station calls you on the run radio, toggling back and forth between Entry Windows with the
\ key or Ctrl Left/Right arrows will maintain the all of the information in each Entry Window until the
respective stations are logged, wiped clean via Alt+W or Ctrl+W, or you QSY and the callsign is
entered into the bandmap (if "QSYing wipes the call && spots QSO in bandmap" is implemented).

6. The SO2R dots (LEDs)

On the Entry Window a green and/or a red dot (LED) will be shown. The LEDs are visual aids that
help you easily identify what is happening on each radio. This is part of N1MM's continuing
philosophy of letting the operator easily know what's happening at any give time.

The green LED indicates that the VFO or radio has receive/entry focus and the red LED indicates
that VFO has transmit (TX) focus. In addition, the red TX LED changes between dark red (not
transmitting) and bright red (VFO/radio is transmitting). Inside the LED are letters which identify
different states (see below). It is important to note, though, that when a function key is used to send
a message or perform another function, the radio or VFO that has the RX/entry focus

6.1. Dot/LED colors used:

Green dot/LED - This VFO/Radio has receive (RX) and entry focus. RX and entry focus are always
together.

Inside the green dot the Ru/SP (Run/S&P) designators are shown. Ru means the radio or
VFO is in running mode, and SP means it is in S&P mode

when clicking on the green dot it toggles between running mode (Ru) and Search &
Pounce mode (SP)

RX/keyboard focus can be toggled between the VFOs/radios by
using a mouse to click on a free space in one of the two Entry windows
pressing the \ key (backslash)

To move both Transmit and Receive focus
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pressing Ctrl+Left-Arrow / Ctrl+Right-Arrow will move both foci to the left and right
radios. Pressing Pause

 
Red dot/LED - This VFO/Radio has transmit (TX) focus. This means that the radio or VFO either is
transmitting or was the last to transmit. When the other window has entry focus and you press a
function key to send a stored message, the transmit focus shifts to that radio as soon as the
function key is executed.

Transmit (TX) focus can be changed between the VFOs/radios by pressing the Alt+F10 key
Pressing Pause or Ctrl+Left-Arrow / Ctrl+Right-Arrow will move both foci to the left or right
radios
When transmitting the TX focus can not be changed
Inside the red dot the R (Repeat) designator is shown when Repeat mode (for CQing) is active
Inside the red dot the D (Dueling CQ) designator is shown when Dueling CQ is active

 

7. Key Assignments (unique to SO2R)

7.1. Entry Window Features

Backslash ( \ ) - Launches a second Entry Window if only one Entry window is open
One radio - Moves RX focus between the 2 VFOs on the radio
Two radios - Moves RX focus between the 2 radios

Ctrl+Enter - Send next ESM state on alternate radio (assuming ESM turned on)
Ctrl+F1 to F8 - Send Fn message on alternate radio
Ctrl+Left Arrow - In SO2R move both Transmit and Receive/Keyboard focus to left radio, or in
SO2V move both TX and RX/Keyboard focus to VFO A
Ctrl+Right Arrow - In SO2R move both Transmit and Receive/Keyboard focus to right radio,
or in SO2V move both TX and RX/Keyboard focus to VFO B
Pause - Move both TX and RX Keyboard focus to other radio (or other VFO in SO2V). If TX
and RX focus are split when you hit pause, TX focus will move to where the RX focus is
Alt+F5 - Swap radio frequency, mode, and callsigns between VFOs (SO2V) or radios (SO2R).
In SO2R, the receive focus changes to the non-active radio
Alt+F6 - Identical to Alt+F5 except the receive focus does not change
Ctrl+B - Dueling CQ's will send CQ alternately on each radio. If Dueling CQ's is turned on,
both radios become run radios. A delay can be inserted between each CQ by setting the "Set
Dueling CQ Repeat Time" under the SO2R menu. Dueling SSB and CW CQ's are supported
too.
__Backquote (grave accent or unshifted tilde key (~) - Toggle STEREO mode on/off, or toggle

The Focus Other and Ctrl+Fx settings, whether controlled through keyboard shortcuts or
through the SO2R sub-menu of the Configurer, are "sticky" - that is they are remembered the
next time the program is opened. This can surprise you if you don't remember having set them.

"Sticky" options
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Auto/PTT modes with modified DXD . Notes: On US keyboards, the key we are talking about is
the key just to the left of the number 1 key.
Ctrl+I - Toggle through the SO2R modes supported by the program and your sound card
configuration (see below). Only operative in '$5SO2R' when N1MM logger controls the audio,
not when using an external SO2R controller
Ctrl+PgUp/Down - When changing band using Ctrl+PgUp/Down will skip the other radio's
band

THIS IS NOT A SUBSTITUTE FOR HARDWARE LOCKOUT!
Ctrl+Shift+I - toggle 'Advanced SO2R'

With Advanced SO2R on, focus will be set to sending radio's entry window when a
message completes. The exception is if there is a call or partial call entered in the
non-sending radio's entry window.
Or simply put, if you tune your S&P radio, and you aren't working someone on either
radio (like calling CQ), the entry focus will go automatically to the S&P radio so you can
tune aggressively without having to worry about getting the entry focus in the right place
before you enter a callsign to work

Ctrl+Shift+N - Adjustable delay for Advanced SO2R.
The user can keep focus on the run radio after sending has stopped, or turn it over to
the S&P radio beforehand by this adjustable time parameter. Typically the CQ Repeat
time is set to something like 3 sec and the Adjustable Delay to perhaps 2 seconds. It has
been suggested that, at the beginning of a contest, this parameter be set high (LOT of
callers on run) and toward the end of the contest it be dropped- all doable via
Ctrl+Shift+N

Ctrl+Shift+K - FocusOther, Another method of focus control (Focus on Other Radio),
preferred by many contesters over "Advanced SO2R". When FocusOther is active, the RX
focus is automatically shifted between the "Run" radio and the "S&P" radio, depending on
whether the Run radio is transmitting. When the Run radio is transmitting, RX focus is shifted
to the S&P radio. When the Run radio stops transmitting, RX focus shifts back to the Run
radio, unless an unworked callsign has been entered in the S&P entry window. This allows a
callsign to be entered in the S&P radio Entry Window while CQ is being sent on the Run
radio.

FocusOther is mutually exclusive from Advanced SO2R and does not use adjustable
time on the Run radio.

Ctrl+Shift+L - This enables/disables the use of {CTRLFx} in function key macros. {CTRLFx} is
a convenient way to automatically send a function key on the alternate radio. For example, by
programming your S&P F4 key to "* {CTRLF1}", your call will be sent on the S&P radio,
immediately followed by your CQ message on the Run radio.

 

7.2. Bandmap features

Shift+Click on frequency (SO2R only) - Jump to that frequency on the inactive radio, without
changing TX or RX focus. This allows you to be active and sending on one radio and change
the frequency on the other radio without making it the active radio.
Shift+Click on bandmap callsign (SO2R only) - Send the frequency to the inactive radio
and place the callsign on the other radio's callsign frame, without making it the active radio.
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7.3. Using SO2R Key Assignments

Backslash ( \ ) - Once you have launched your second Entry Window, the \ key will likely be your
most widely used key in SO2R. The \ key will move RX focus between Entry Window A & B (often
referred to as Radio 1 & Radio 2 respectively). When using the \ key to control RX focus, you really
don't have to worry where TX focus is. By using the \ key to control only RX focus, when you hit a
Fn key or Enter (using ESM), the TX focus will move to where the RX focus is, and send the
corresponding message.

Example: You are CQing on Radio 1, and S&Ping on Radio 2. Both RX and TX focus start off in
your Run Entry Window (Radio 1 in this example). You are S&Ping on Radio 2, and you hear
someone on the S&P radio you want to look up in your Check Window. Hit the \ key to move RX
focus to the S&P Entry Window. You type in the call, and you need it, and are just waiting for a
good time to send your call. If no one is answering your CQ on the Run Radio, just hit the Enter
Key (assuming you are using ESM), and the TX focus will move from the Run Radio to the S&P
radio (Radio 2), and send your callsign (actually the first ESM message in the S&P sequence). If
the station comes back to you, then hit Enter again to send your exchange, and you just completed
a S&P QSO. Now move the RX focus with the \ key to the Run radio, or just leave it in the S&P
Entry Window if S&P is more productive.

Now let's assume in the middle of the S&P QSO, someone answers your CQ on Radio 1. Your
exchange just happens to be sending on the S&P radio. To copy the call on the Run Radio (while
your exchange is being sent on the S&P radio), hit the \ key to move RX focus to the Run Radio,
and type his call in the Run Entry Window. Assuming your exchange is finished sending on Radio
2, just hit Enter again, and the TX focus will move back to the Run Radio, and the program will
send his call and your exchange on the Run Radio. You now have QSOs going on both radios! Just
move RX focus as needed to send/copy on what ever radio you need. This is easier said, than done
during a contest !

 
Ctrl+Enter, or Ctrl+Fn - Using these commands will send the corresponding message on the
alternate radio; with the alternate radio defined as the radio that does not have RX focus. Using
Ctrl+Fn (or Ctrl+Enter) will only move the TX focus to send the message - RX focus will stay in it's
current location. Once the message is sent, TX focus will remain on the alternate radio. This is done
by design.

The most common scenario would be if you are CQing on Radio 1, but you are not getting callers.
You hit the \ key to copy a callsign on the S&P radio. Without moving the RX focus from the S&P
radio, at some point you will probably want to send another CQ on the Run Radio. You do this by

In the above examples, you never have to control where TX focus is, since TX focus always
moves automatically to where the RX focus is when Fn or Enter (ESM) is used. This should be
your standard operating mode, as you only need to worry about using a single key to do most of
your navigation between the two Entry Windows.

Tracking TX Focus
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hitting Ctrl+F1 or Ctrl+Enter. You will also likely use these commands if you have a QSO in
progress at the same time on both the Run and S&P radio. The easiest way to send a message at
the right time on the other radio is to use these commands, and leave RX focus where it is.
Alternatively, you can program function keys with the {CTRLFx} macro to send messages to the
other radio.

Pause Key - If both TX and RX focus are in the same Entry Window, hitting Pause will move both
TX and RX focus to the other radio. If TX and RX focus are split between the Entry Windows, the
pause key will move TX focus to where RX focus is. Mostly you will use this key in order to get your
foci back in sync.

Ctrl+Right Arrow and Ctrl+Left Arrow - These commands will force both TX and RX focus to the
right or left radio.

Ctrl+B - Enable Dueling CQ's.

{CTRLFn} macro - This macro allows the user to send on the other radio.

Make sure that "Toggle {CTRLFx}" macro is checked on in the Configurer SO2R submenu (or
use Ctrl-Shift-L to enable/disable the use of {CTRLFx} macros. When disabled, the {CTRLFx}
macro is ignored
Thus, a CW Button might look like: "tu EXCH{CTRLF9}" Where F9 on the other radio is set to
send a CQ.
Example: If your entry focus is on the S&P radio and you manually press Ctrl+F1, the
program will send F1 on the OTHER radio. That's all the {CTRLFx} macro does. For a simple
test, modify your S&P F4 key to read *{CTRLF1}. Now, when you press that key, the program
sends your call on the S&P radio and then sends the contents of F1 on the Run radio. In a
practical situation, you would probably not want to send a full-length CQ while trying to work
someone on the S&P radio, because that will nearly always require you to interrupt it before it
is done. So the idea of {CTRLFx} is that you can stash a short CQ (like "N4ZR test"} in, for
example, Run F12. Then make S&P F4 read "* {CTRLF12}. Now when you press F4 on the
S&P radio, it will send your call, and immediately switch to the Run radio and send F12, that
very short CQ. Should help hold your frequency.
Another way to use this: Make your S&P F2 read, for example, 5NN14{CTRLF1}. Then when
you press F2 or Enter to send your exchange and/or log the S&P QSO, the program will
automatically begin a CQ on the Run radio as soon as that is done

 

8. Mouse Assignments

Left mouse and Right mouse buttons_
On an empty space in one of the two Entry windows, these mouse buttons change the
Receive focus to that radio/VFO

 

9. SO2R menu (under Config)

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

440 of 680 2/2/2011 4:54 PM



SO2R
Dueling CQ's Ctrl+B - will send CQ alternately on each radio
Set Dueling CQ Repeat Time
Advanced SO2R
Advanced SO2R Delay Time
Focus on Other Radio - A method of focus control, preferred by many contesters over
"Advanced SO2R". When FocusOther is active, the RX focus is automatically shifted
between the "Run" radio and the "S&P" radio, depending on whether the Run radio is
transmitting. When the Run radio is transmitting, RX focus is shifted to the S&P radio.
When the Run radio stops transmitting, RX focus shifts back to the Run radio, unless an
unworked callsign has been entered in the S&P entry window. This allows a callsign to
be entered in the S&P radio Entry Window while CQ is being sent on the Run radio.
FocusOther Always Swap - Used in conjunction with Focus on Other Radio. When
FocusOther Always Swap is enabled, RX focus will always shift back to the Run radio
when the Run radio stops transmitting.
Toggle CTRLFx Macro - This enables/disables the use of {CTRLFx} in function key
macros.
TX Lockout - Select a lockout item (Digital modes only)

Multi-TX - This is the default setting. Start CQ on radio A, Start CQ on radio B,
both are active. (no lockout)
First one wins - Start CQ on radio A, pause, Start CQ on radio B. The radio B CQ
is ignored since radio A is already active, so if you press a F-key for the second
radio while radio1 is transmitting, the radio B F-key is ignored
Last one wins - Start CQ on radio A (CQ starts), pause, Start CQ on radio B. The
CQ on radio A will aborted and the CQ on radio B will start so if you press a F-key
for the second radio while radio A is transmitting, the radio A transmission is
interrupted and radio B transmits
Toggle SO2R mode Ctrl+I - Toggle between the possible SO2R modes supported
by the program. The SO2R mode is shown in the Entry window statusbar.

Note: Ctrl+I is only operative in '$5 SO2R' mode when N1MM logger controls
the audio, not when using an external SO2R controller.

SO2R mode: Manual - Audio is switched when moving focus between
windows
SO2R mode: Auto

Run radio = TX -you hear S&P audio in both ears
Run radio = RX - left ear = left audio, right ear = right audio

SO2R mode: One-Rig Auto - Always listen to the audio of the
non-TX-ing rig. This means that as soon as the running rig goes into
TX, you hear the S&P audio, which goes back to the run radio's audio
in both ears as soon as the CQ message is played

 

10. Software Setup

Setting up SO2R and SO2V starts in the Config menu:
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Config > "Configure Ports, Telnet Address, Other" > Hardware Tab

 

Then if SO2R:

Set up radios
Set up keying if necessary (LPT or Winkey)
Click SO2R button
Configure left/right radio in pop up box
(when you click on SO2R button)
Click OK
Launch N1MM Logger, set up contest etc.
If 2nd Entry Window is not shown, hit the \
key (backslash key)
SO2R - 1 computer radio + 1 manual radio
(so two radios)
SO2V - 1 computer radio with 2 VFOs and
no manual radio (so one radio)

Then if SO2V:

Set up radio
Set up keying if necessary (LPT or Winkey)
Click SO2V button
Click OK to close Config window
Launch N1MM Logger, set up contest etc.
If 2nd Entry Window is not shown, hit the \
key (backlash key)

 

Selected
Mode

Radios Attached Choices Selection

SO2R none SO2R - Left Manual, Right Manual Automatically
selected

SO2R 1
(Kenwood)

sO2R - Left Manual, Right Kenwood
Com1
SO2R - Left Kenwood Com1, Right
Manual

Select one

SO2R 2
(Kenwood &

FT847)

SO2R - Left Kenwood Com 1, Right
FT847 Com 2
SO2R - Left FT847 Com1, Right
Kenwood Com 2

Select one

SO2V 1
(Kenwood)

SO2V - Kenwood Automatically
selected

 

10.1. LPT keying

When operating SO2V, and using LPT port keying, the Radio Nr in the LPT port configuration must
be set to Both.

When operating SO2R, and using a single LPT port for keying, the Radio Nr in the LPT port
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configuration must be set to Both. This configuration will require an external box to switch the
keying line between the two radios. The external box can be controlled using LPT pin 14.

When operating SO2R and using a separate LPT port for each radio, the Radio Nr in the LPT port
configuration must be set to (Radio) 1, and 2.

10.2. Winkey and WinkeyUSB keying

 
When operating SO2R, and using Winkey, the Radio Nr in the Winkey COM port configuration must
be set to Both.

When operating SO2R, and using a single Winkey port for keying, the Radio Nr in the Winkey COM
port configuration must be set to Both. This configuration will require an external box to switch the
keying line between the two radios. The external box can be controlled using LPT pin 14.

When operating SO2R and using Winkey's "2nd CW Output", the Radio Nr in the Winkey COM port
configuration must be set to Both.

11. SO2R Radio Support

 
All supported radios will work with SO2R. N1MM Logger will allow you to use any combination of
computer controlled and non-computer controlled radios. If you use a radio that is not supported or
has no radio control, do not set up a radio COM port. You only set up that information when you
have a computer controlled radio.

12. Using External SO2R controllers

N1MM Logger is compatible with most hardware SO2R controllers using the LPT port (legacy) such
as the Top Ten Devices "DX Doubler", the Array Solutions (aka WX0B) "SO2R Master". These
products will automatically control keying, PTT and audio lines to each radio. New products like the
microHAM MK2R can be fully controlled via USB or via an LPT port (legacy). The EZmaster from
Ham Radio Solutions.is only supported using the LPT port and not the USB port.

Hooking up these controllers will require a straight-through DB-25 cable from your LPT port of your
computer to the input DB-25 connector on these products. For hooking up the rest of the keying
and audio lines for these products, consult their respective manuals. All products use the same
pin-outs on the LPT port.

DX Doubler and SO2R Master have two basic settings for software: "CT/TR/Writelog" and "NA". NA
uses slightly different controls. To use N1MM Logger with these external devices, just configure the
external controller for "CT/TR/Writelog".

To get N1MM Logger to correctly key and control these devices, you need to set up your keying as
follows:
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12.1. LPT Keying with external SO2R controllers using LPT port:

Config >Configure Ports, Telnet Address, Other >Hardware tab
Check LPT keying box - check only one LPT box
Click on the corresponding "Set" button for the LPT port
Click on "Radio Nr" drop down box and select "Both"
Click on OK to set configuration

 

 

12.2. Using Winkey and WinkeyUSB

The original WinKey, uses a RS-232 COM port, and is not a USB device. WinKey has an internal
pin 3 output, which is normally CW for 1 radio, and an internal pin 5 which is normally PTT for a
single radio. Under N1MM Logger software control, pin 3 can set for Radio 1 CW output and Pin 5
can be set for Radio 2 CW output. The serial port assigned to the WinKey device should have the
"Hardware" tab "Set" and WinKey checked and Radio Nr set to 'Both'. Then go to the "WinKey" tab
and set Pin 5 function to "2nd CW"

The "K" output on the WinKey board goes to Radio 1 CW and the "P" output goes to Radio 2 CW.
N1MM Logger takes care of all the switching provided you activate the proper radio.

The WinkeyUSB (sometimes called "Winkey 2") has separate CW and PTT outputs for each radio.
The 2nd radio CW is enabled from the Winkey tab "Use 2nd Output".

13. SO2R Using the DX Doubler

 

13.1. Internal DXD Jumpers

Internal DX Doubler Jumpers

Operating
Mode

Jumper
1

Jumper
2

Jumper
3

Normal 1-2 4-5 8-9

Stereo 1-2 5-6 8-9

 

There were a couple of errors on the DX-doubler PC board. Go to: http://www.qth.com/topten
/appnotes.htm to see the DX Doubler modifications.

Modifying the DX Doubler
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The Normal Mode is the CT/TR/WriteLog settings in the manual. N1MM uses the same convention
as CT/TR/WriteLog, but the DXD manual does not reflect this.

13.2. DXD & STEREO Feature

 
The STEREO mode is for use with the Top Ten Devices DX Doubler. It will probably work with other
SO2R controllers which use pin 5 on the LPT port to switch audio between radios.

The Stereo Mode was fashioned after the NA Stereo feature, i.e. use a keyboard command to toggle
from the run station's audio in both ears, to one radio in the left ear and other radio in the right ear.
The Stereo feature toggles pin 5 alternately high and low on the LPT port.

To use the STEREO feature with the DX Doubler, the DXD should be configured for CT/TR/Writelog
with the exception of JUMPER 2. Move JUMPER 2 from PINS 4-5 to PINS 5-6. This puts the control
signal from LPT-pin 5 into the logic in the DXD. Now, with the DXD AUDIO control switch set to
"Auto", the unshifted tilde (variously called the backquote, grave accent or simply the ` key) will
toggle the STEREO mode on and off.

 
Stereo "ON" will split the audio: Radio-A/left ear, Radio-B/right ear. Stereo "OFF" means full audio
from the RUN radio in both ears.

` (backquote or unshifted tilde)
Toggle

DXD Audio
Mode

Run Radio S&P Radio

"NA" mode OFF AUTO Both Ears
(TX focus on RUN

radio)

Both Ears
(TX focus on S&P

radio)

"NA" mode ON AUTO Left Ear Right Ear

Auto/PTT OFF PTT Left Ear Right Ear

Auto/PTT ON PTT Both Ears
(TX focus on RUN

radio)

Both Ears
(TX focus on S&P

radio)

 
N1MM further refined the STEREO feature by building the following macros so you can automate
the process: {STEREOON} {END} {STEREOOFF}
These macros are included in the function keys (Message Buttons) to switch the audio
automatically according to the operator's preference. (refer to Macros Definitions, section 36.1.1) If
Stereo Macros are used, you can momentarily toggle the Stereo state if needed. Once a Fn
message is sent that includes a macro, the Stereo feature will go back to its programmed state.

With the DXD Audio switch in PTT mode, the stereo capability is disabled and the DXD operates
normally in the PTT mode.

Enabling DXD's Stereo Feature
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Example for F1 - CQ Message Button : {STEREOON} CQ TEST * * TEST {END} {STEREOOFF}

 

14. Sound Card options

Option
#

Radios
Play
WAV
Files

Record
new
SSB

messages

Mute
mic

What is
Recorded

Switch
Headphones

Special
CD/Aux
Cable

Required

Comments

1 1 Yes Yes Yes Two
channels

heard

No No Normal one-radio
setup

2 2 Yes Yes Yes One channel
for each

radio

No No External
switching
required for
SO2R

3 2 Yes Yes Yes One channel
for each

radio

CW/Digi
Only

Yes External
switching
required for SSB
SO2R

4 2 Yes Yes Yes Two
channels

heard

All modes Yes $5 SO2R

 

Two sound card SO2R or $5 SO2R is a cheap way to get into SO2R. The only extra device needed
to your computer is an extra $5 soundcard and some cables to the radios. Serious competitors
should probably use a hardware device that can insure lockout.

14.1. Sound Card Option #1: Zero or Single Card, One radio, No Sound Card SO2R

One radio and one sound card to play wav files and record new messages and mute the
microphone when playing wav files.
Select '1 - Single Card - One radio, No Sound Card SO2R' on the 'Audio' tab and setup the top part
of this dialog.
The sound is centered rather than set to a radio channel.
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14.2. Sound Card Option #2: Single Card - Two radio, No Sound Card SO2R

Not SO2R but two radios and one sound card to play wav files and record both radios.
Select '2 - Single Card - Two radio, No Sound Card SO2R' on the 'Audio' tab and setup the top part
of this dialog.

 

14.3. Sound Card Option #3: Single Card - Two radio, Sound Card SO2R, CW Only
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In order to use SO2R with one sound card, CW only, you'll need to define your radios as SO2R in
the Hardware tab and select '3 - Single Card - Two radio, Sound Card SO2R, CW Only' on the
'Audio' tab. Setup the top and bottom parts of this dialog.

 
SO2R with one sound card. The drawback here is that no switching of the phones is done.
Note that you will have to wire a cable to the cd or aux input of a sound card in order to make use of
this feature.
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This is an example how to set up the configurer. Note that the top part should not matter. For #3,
we are interested in the bottom frame.

 
This picture shows the mixer for my sound card (windows default mixer). The mute buttons and the
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balance sliders will change while CQing, then back after the message is over.

14.4. Sound Card Option #4: Dual Cards - Two radio, Sound Card SO2R

Kudos to David, K1TTT for coding all the interfaces necessary to allow SO2R with two cheap sound
cards. Check the pictures below and see how easy it all is. K1TTT also designed the switching rules
and wiring.
Note that you will have to wire a cable to the cd or aux input of a sound card in order to make use of
this feature.
In order to use SO2R with two sound cards, you'll need to define your radios as SO2R in the
Hardware tab and select '4 - Dual Cards - Two radio, Sound Card SO2R' on the 'Audio' tab. Setup
the top and bottom parts of this dialog.

 
CW - Yes, it will work for CW as well. The CW is not shown since you already have solutions for
that. You can use separate serial, parallel or USB ports to separate the CW. You can use radio or
Serial/Parallel/USB port PTT to two rigs. If you want to, you can use pin 14 and a relay to switch,
but that is not necessary. The headphones work the same for either mode.

RTTY - We have not discussed the implications for RTTY yet.
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Mode
INPUT

Keyboard
Focus

INPUT
CQ

Playing

INPUT
Dual

OUTPUT
SndCard

Left
Input

OUTPUT
SndCard

Right
Input

OUTPUT
Radio
Left
Dual

OUTPUT
Radio
Right
Dual

OUTPUT
Audio
Left
Ear

OUTPUT
Audio
Right
Ear

Auto Left None Off Left Right Off Off L-main R-main

- Left Left Off/R-on? Mute Center Off Off/Note
1

R-main R-main/sub?

- Left Right Off/L-on? Center Mute Off/Note
1

Off L-main L-main/sub?

- Right None Off Left Right Off Off L-main R-main

- Right Left Off/R-on? Mute Center Off Off/Note
1

R-main R-main/sub?

- Right Right Off/L-on? Center Mute Off/Note
1

Off L-main L-main/sub?

One rig
auto

Left None Don't
care

Center Mute NC NC L-main L-main/sub?

- Left Left Don't
care

Mute Center NC NC R-main R-main/sub?

- Left Right Don't
care

Center Mute NC NC L-main L-main/sub?

- Right None Don't
care

Mute Center NC NC R-main R-main/sub?

- Right Left Don't
care

Mute Center NC NC R-main R-main/sub?

- Right Right Don't
care

Center Mute NC NC L-main L-main/sub?

Manual Left Don't
care

Don't
care

Center Mute NC NC L-main L-main/sub?

- Left Don't
care

Don't
care

Center Mute NC NC L-main L-main/sub?

- Left Don't
care

Don't
care

Center Mute NC NC L-main L-main/sub?

- Right Don't
care

Don't
care

Mute Center NC NC R-main R-main/sub?

- Right Don't
care

Don't
care

Mute Center NC NC R-main R-main/sub?

- Right Don't
care

Don't
care

Mute Center NC NC R-main R-main/sub?
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NC - no change, whatever user has set

Note 1 - could use dual on non-CQ-ing radio while cq is playing on the other one, but would have to
switch off when cq stops to get back to just main for full stereo. This would mean having some way
to save the dual setting for the non-cq radio and switching it on/off for each cq. Maybe useful for
times when doing dueling cq on combinations like 20 and 40m where you wanted to listen on both
vfo's on 40m. This is the case I would probably prohibit and always force dual off on both radios for
full auto. Or if dual was on prohibit full auto and force one rig auto instead.

15. LPT port basic SO2R controller design

A basic SO2R controller design ... it's about as simple as there is but it works well with N1MM (or
Writelog) in LPT mode. I decided to add support for CW from the LPT - the PTT relay can be
replaced with a SPDT relay if CW is taken from two COM ports or WinKey USB is used (better).
Joe, W4TV - 5/30/2009 - Revision 1.0

15.1. Basic SO2R LPT port - Receive Interface

 
SO2R LPT Receive interface

15.2. Basic SO2R LPT port - Transmit Interface

 
SO2R LPT Transmit interface
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16. Advanced SO2R

Advanced SO2R is a powerful feature intended for SO2R operators and is totally unique to N1MM.
It can be used as an alternative to the FocusOther feature. The feature automatically moves RX
focus to where it logically should be for the SO2R operator. The two main scenarios Advanced
SO2R addresses for SO2R are:

Tuning the S&P radio will grab RX focus (i.e. when you are looking for mults) When the Run Radio
finishes sending a CQ, RX focus moves back to the Run Radio.
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Advanced SO2R Rules for Moving RX Focus

SO2R Rule Operating Implications

Advanced Rule
#1

Tuning either VFO/Radio will result in the RX focus moving to that VFO/Radio
if, and only if, both entry windows have empty call fields

Advanced Rule
#2

RX focus is moved to the Run/TX radio when it finishes sending CQ (or Fn)
message, UNLESS there is text entered in the S&P Entry Window

Focus
Anti-Bounce

(FaB)

After CQ (or Fn) has been sent on the Run Radio and RX focus has moved to
that radio, don't let tuning of S&P radio grab RX focus until 1000 ms has
passed

 

16.1. Advanced SO2R Theory of Operation

Advanced SO2R will only move RX focus if there's no callsign (or partial callsigns) in either Entry
Window. If there's a callsign (or partial callsign) in either Entry Window, it's assumed that the SO2R
operator will want to control where RX focus should be.

Basic Scenario: If you are CQing on VFO/Radio A, and S&Ping on VFO/Radio B, as you tune the
S&P radio, Advanced SO2R assumes the SO2R op will want RX focus on the S&P radio so he can
type in a callsign to see if it's needed. At the end of a CQ on the Run radio, if there is no callsign in
the S&P window, RX focus is moved back to the Run Radio in anticipation of someone answering
your CQ. If no one calls on the Run Radio, and you continue to QSY on the S&P Radio, the RX
focus will automatically move back to the S&P radio again after a 1000 ms delay (learn more about
the 1000 ms delay in the Focus anti-Bounce paragraph below).

As you S&P during a CQ (or any sent Fn message) on the Run Radio, and you type a callsign into
the S&P Entry window, at the end of a Run CQ (or Fn), RX focus will stay on the S&P radio. It's
assumed if you have a callsign in (any) Entry window, that you will want RX focus to stay where it is
to finish that QSO.

If someone answers your CQ on the Run radio, and there's a callsign in the S&P window, it's up to
you to decide who you will work, and where RX focus should be: do you finish working the S&P
QSO, or move RX focus to the Run Radio to work the new caller? If you want to answer the
response to your CQ, use the \ to move RX focus from the S&P Radio to the Run Radio. Otherwise
leave RX focus on the S&P radio so you can finish working the S&P QSO and then hit \ to get back
to the Run radio (this can be automated by inserting the {JUMPRX} macro if desired).

Let's say that someone just answered your CQ on the Run radio (of course Advanced SO2R has
already moved RX focus there from the S&P radio) and you have entered a callsign in the Run
Entry Window. As you tune the S&P radio while you are working the guy on the Run Radio, RX
focus will stay on the Run Entry Window. It's assumed that you will not want RX focus moved to the
S&P radio during the middle of a Run QSO. After you log the Run QSO, and you continue to tune
the S&P radio, RX focus will again move to the S&P radio if there's nothing in the Run Entry
Window.
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Focus anti-Bounce (FaB): was created for the serious SO2R op who's got both right and left audio
listening to the S&P radio while transmitting on the Run Radio. Let's say you are CQing on the Run
Radio, and tuning on the S&P radio. Many SO2R ops will not be listening to the Run radio CQ
sidetone, and will only be listening to the S&P radio. If you are still tuning the S&P radio when the
CQ just finished, FaB will keep RX focus on the Run radio for 1000 ms. This brief delay will let you
stop tuning the S&P radio, so RX focus stays on the Run Radio. If FaB wasn't there, and you didn't
realize that the CQ was over, RX focus would bounce to the Run Radio at the end of a CQ, and
then bounce back to the S&P radio since you are still QSYing. Thus if someone answered your CQ,
you would often type that callsign in the S&P radio/entry window!

16.2. Advanced SO2R Controls and Macros

SO2R Macro Operating Implications

ON/OFF Macro You can turn on/off Advanced SO2R by using macros in CW/SSB key
buttons: {ADVSO2RON} {ADVSO2ROFF}

ON/OFF Shortcut Turn on/off Advanced SO2R with Ctrl+Shift+I

RX Focus Control
(Override)

The backslash key (\) will always move RX focus to the "opposite"
vfo/radio and stays there until another action/state
takes RX focus control (in case RX focus ends up where you don't
want it)

Focus Anti-Bounce
(see above)

Advanced SO2R now has an adjustable delay (called Focus
Anti-bounce) set via CTRL+SHIFT+N

 
RULE: Tuning either VFO/Radio will result in the RX focus moving to that VFO/Radio if, and only if,
both entry windows' call fields are blank.
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Radio
A...

Callsign
Field

Exchange
Field Is:

Radio
B...

Callsign
Field

Exchange
Field Is: Focus Does:

Tuning
VFO

Focus moves to VFOx

Tuning
VFO

Focus moves to VFOx

Filled Tune VFO
B

Focus stays where it was
(VFO A)

Filled Tune VFO
A

Focus stays where it was
(VFO A)

Tune VFO
A

Filled Focus stays where it was
(VFO 

Tune VFO Filled Focus stays where it was
(VFO 

 

17. Focus on Other Radio (FocusOther)

18. SO2R and MMTTY

Instructions for setting up 2 copies of MMTTY for use in SO2R.

Install MMTTY into 2 separate directories.
Create 2 separate directories that MMTTY will reside in. This allows you to save 2
different profiles

Change into each of the directories and load MMTTY.
Click Options/Setup MMTTY Once loaded select the Misc Tab .
Change the device ID to one of the soundcard numbers (not -1)

Select the sound card you are using 0,1,2,3 don't select -1
In the second copy of MMTTY you will do the above and choose your second soundcard #

Select the sound card you are using 0,1,2,3 don't select -1.
Close MMTTY - This will save your info in the MMTTY profiles.
Load N1MM and select Configure.
In the Hardware Tab Set your ports that you will use to Digital.
In the Digital Tab Select both Interfaces to Show MMTTY as the interface.
In the Digital Tab set the path to each copy of MMTTY.
Close and save the config window.
Now when you load the Digital Interface you will see a menu selection to load the second
Interface.

One thing to keep in mind.. The 2nd port you have marked for digital will be the PTT port
for the second digital window.
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18.1. SO2R RTTY with 1 sound card

One sound card can do 2 channels of RTTY decode. Just set MMTTY instances to the same card
but one to left the other to right channel. MMTTY seems to transmit the same AFSK audio to both
channels but that's ok cause the SO2R box only routes PTT to one of the radios at a time. A special
stereo Y cable has to be made so one radio goes to the left channel and the other to the right
channel.

If the above works depends a lot on the used soundcard/chip. In other instances MMTTY does not
seem to like addressing Left/Right separately. In that case only one (the first) digital interface will
receive anything and you are out of luck....

19. Example screen layouts

Below two screen shots for SO2R. Notice the window symmetry for left and right VFO, as well as
left and right band map. Essential information that is used by both radios was placed in the center:
Check Window and Log Window. Of course other operators may have different preferences
regarding window layout - but the most intuitive is to have the window layout reflect the equipment
configuration.

 
The screen above was taken by K2KW from a 17" screen.

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

457 of 680 2/2/2011 4:54 PM



 
The screen shot above was taken by F6IRF and gives an example of a SO2R screen for RTTY.

 

SO2V

In this Section...

SO2V
1. Advanced SO2V for radios with separate sub-receivers
2. Approximating the capability with radios that do not have a sub-receiver

A number of N1MM users are interested in using the advanced VFO and/or subreceiver capabilities
of modern transceivers to improve their scores by approximating SO2R techniques, but with a single
radio. This has led to the definition of an operating mode called SO2V (Single Operator Two VFOs).
This section will deal with the features of N1MM Logger that are designed for use in this mode.

1. Advanced SO2V for radios with separate sub-receivers
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The following writeup was provided by John, K3CT, who has been responsible for many recent
SO2V improvements. In the near future, the editors intend to provide introductory information and
place it in context.

Version 10.3.6 introduced a new feature for SO2V operators that are using radio control with the
following radios: IC-756/Pro/Pro2/Pro3,
IC-7600, IC7800, Orion/2, and K3.
In a later version after 11.01.04, the following radios have been added: FT1000/D/MP/MKV
/MPSteppIr
Other radios with sub-receivers (currently FTdx9000, FTdx5000, FT2000) will be added as time and
availability of testers permits.

 
In SO2V mode, the \ key changes the RX focus to the Sub receiver and enables the Sub audio if
necessary (Orion). To use this feature
set the CQ repeat time a little longer than normal and start a repeating CQ using VFOA (Main). If
nobody answers, press the \ key to enable the Sub receiver and tune the band. Pressing \ again
will change the RX focus back to VFOA and turn off the Sub if Config > Dual Rx Always On is not
checked. With Icom radios that only have one VFO knob,pressing the \ key also changes the knob
association to the Sub VFO.

If you do not find someone to call before the CQ timer expires, the program will call CQ again on
VFOA. If you type a character into the
VFOB (Sub) Entry window or press a function key, it will cancel the repeating CQ running on
VFOA.

The TX focus will automatically shift to the proper VFO prior to transmitting when you call someone.
Some radios switch faster because they require fewer configuration commands. If you call someone
with the VFOB (Sub) Entry window and decide that the CQ repeat needs to start again on VFOA,
press CTRL+CQ-Key. The program default for the CQ-key is F1 and this is set in Configurer >
Function Keys tab.

If someone answers your CQ while the RX focus is on VFOB (Sub), press the \ key to change the
RX focus prior to entering the callsign.

In the case of the K3 transceiver, there is special functionality associated with the Ctrl+Alt+D and
Grave accent keystrokes. See the K3 section under Supported Radios.

2. Approximating the capability with radios that do not have a sub-receiver

 
Again, from K3CT: I tried to implement this same SO2V functionality for all VFOA/B radios even if
the radio does not have a sub-receiver.

You may find the CTRL+Shift+Up/Dn command useful. It programs VFOB with the next spot Up or
Dn in the Bandmap. When you have time to listen or call the station, press the PAUSE (or
Ctrl+RightArrow) key. To return to your Run frequency, press the PAUSE (or LeftArrow) key, it won't
change your RUN frequency. Instead, the program will let you know that split is necessary with a
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status message at the bottom of the Entry window.

See the Supported Radio section of the manual for radio specific information regarding general and
SO2V operation.

N1MM Rotator Control

In this Section...

N1MM Rotator Control
1. Rotor Control Basics

1.1. File Menu Selections
1.2. Button and Mouse Assignments
1.3. Using N1MM Rotor Stand-Alone
1.4. Using N1MM Rotor with the Main N1MM Logger Program
1.5. N1MM rotor running on another computer
1.6. Turning a Stack
1.7. Run time error: 126

2. Using external hardware or software

Rotator control by N1MM logger is supported using

External software
N1MM rotor (comes with N1MM logger)
LP rotor (freeware by Larry Phipps - N8LP)

External hardware
ARSWIN by EA4TX

 
The rotor can be controlled in several different ways:

Entry window:
by entering a beam heading in the callsign field and press Alt+J. The rotor will turn to
the entered beam heading

Example:234 Alt+J will turn the rotor to 234 degrees
The number must be numeric, >= 0 and <= 360

using the menu items in the Tools menu
Turn Rotor Alt+J - Turn rotor to bearing for the callsign in the Entry window
Stop Rotor Ctrl+Alt+J - Stop turning the rotor when turning and no bearing in
callsign field in Entry window

using the short cut keys below:
Alt+J - Turn rotor to bearing for the callsign in the Entry window or to the callsign
in the callframe (when callsign field is empty)
Alt+L - Turn rotor to long path bearing for the callsign in the Entry window
Ctrl+Alt+J - Stop turning the rotor when turning and no bearing in callsign field in
Entry window

Bandmap window: by right clicking on a spot and select: 'Turn Rotor'
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Available Mult's and Q's window: by right clicking on a spot and select: 'Turn Rotor'

 
Some remarks

If there is a call of less than three characters in the callsign field in the Entry window nothing
will happen.
The status bar will show the bearing it will turn to. Example: Turning Rotor to 123Ãƒâ€šÃ‚Â°
Normally the rotor will turn to the country bearing after a callsign is entered. This info comes
from the country file and mostly is the center of the country. In grid square contests however
that is mostly not practical so when a grid is entered the rotor will turn to the calculated
bearing between the own grid and entered grid square.

 

1. Rotor Control Basics

N1MM rotor has the ability to control up to 16 rotors per station, and to control rotors connected to
other computers on your LAN. N1MM rotor leverages the Antenna tab to define what rotors are
controlled when you are on a band. N1MM rotor can even rotate a stack with one command. N1MM
rotor is an external program which can be used from within N1MM logger or as a stand-alone
program.

Supported rotor types

DCU1 - No Stop button supported.
M2 Orion - Speed shown to bottom right of
status bar.
Prosistel
AlfaSpid
Yaesu
RC2800P-A
Rotor-EZ
AlfaSpid ROT2
Prosistel C

All rotors except the DCU1 support position
reporting.

Upper pane: The upper pane shows the selected rotor under Tools (as entered in the Setup under
Tools) and behind the @ the current rotor position.

Menu bar: Shows the File, Tools and Help menus.

The big digits indicate the current rotor position. When an antenna offset has been entered this will
be shown in small digits to the right of the current rotor position.
More to the right a visual indication where the rotor is pointing.
The line in the circle can be dragged to turn the rotor for rotors that support position reporting.
The textbox is an entry field where to enter the bearing the rotor has to be turned to.
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Pressing the Turn button will turn the rotor to the entered position and the Stop button will stop
turning the rotor at the current position.
A reverse offset will be shown as (R) .

Status bar: Shows the speed when reported by the rotor.

The program will be brought to top when turning (unless minimized)

1.1. File Menu Selections

 

File
Always on Top - Select to have the program always on top
Exit - Exit the program

Tools
Setup Rotors - a dialog named 'Rotor Setup' will be displayed as shown below
Set Current Antenna Offset

The offset is entered on the antennas tab of the configurer, or can be entered for
the selected rotor. This offset is added to the rotor position to determine the
antenna position. This is useful for antennas that are mounted at 90 degrees for
pattern interference reasons, or for antennas that have simply turned some in the
wind over the winter

Set Current Antenna Bidirectionality
Bidirectional is for dipoles, or SteppIr's where the user wants to reverse the
antenna rather than turn it more than 180 degrees

Calibrate Rotor - Calbrate the rotor. Only when supported by the rotor like the M2 Orion
Prosistel C Config

A dialog will open where you can set the rotorstop to North or South and the delay
of the characters

Set rotation limits
This feature is for owners of rotors with brakes that jam. You may enter a number
which will restrict how close the rotor will be turned to 0 or 360 degrees. If you
enter 10, the limits will be 10 to 350 degrees. Note that this can only be set for all
rotors handled by an instance of the program. It didn't seem worth adding it to the
antenna tab

A new line for every setup rotor will be shown
Each line represents a rotor as entered in the Setup under Tools

Help
Help - Show the help file for this window
About - Gives the version of the N1MM rotor program

 

1.2. Button and Mouse Assignments
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Manual entry field - Type a heading and press Enter or the Turn button to turn the rotor. The
entered number is in degrees.

Maximum: 450 and minimum 0. An error message will appear when entered otherwise
when pressing the Turn button.

Turn - Click to turn rotor to heading in textbox. Pressing Enter will also turn the rotor.
Stop Alt+S - Press to stop rotor turning. Pressing Alt+S or Escape will also stop turning the
rotor.

This button is only shown when the rotors supports this feature.
F1 - F10 - Pressing the F-keys mapped to the bearing buttons will turn the rotor to the
position as shown on the button. Right click to set the heading value.

 

Bearing buttons (F1 - F10)
Left mouse button click

Pressing one of the bearing buttons will turn the rotor to the position as shown on
the button.
The F-keys F1 through F10 are mapped to the 10 bearing buttons.

Right mouse button click
Set Button to Current Position

The heading as entered in the manual entry field will be used to set the
position.

Set Button to a Specific Heading
A dialog will appear and a frequency can be entered which will used to set
the position.

 
Only rotors that report position will be able to show the current position (also when rotating).

1.3. Using N1MM Rotor Stand-Alone

Go into the N1MM program directory with Windows Explorer and find 'N1MMRotor.exe'. This is the
N1MM rotor program. A shortcut on the desktop would be an easy way to start the program. All
features mentioned above can be used.

1.4. Using N1MM Rotor with the Main N1MM Logger Program

Start by clicking setup in N1MM rotor and setting up your rotor at the right serial port by mapping
the serial port to the main program.
N1MM logger will turn the rotor by sending UDP packets to the N1MM rotor program. The rotor
selected will turn.
Both in the Configurer and in the Rotor Setup the Rotor Start Port /Starting UDP port# have to be
the same.

To start N1MM rotor automatically from within N1MM logger you have to select in N1MM logger 'Start
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N1MM Rotor Program' in the Antennas tab of the Configurer.
The default UDP port is set to 12040 and can be changed atthe same Antennas tab in the
Configurer (Starting UDP Port for Rotor Program).
In N1MM rotor set up the same UDP port under the menu itme 'Setup' in the Tools menu.

NB. As the rotor program can be on another computer this has to be set in both programs
separately and identical.

One rotor setup - This will be the way most users use the program, as they only have one rotor.
When you don't have antenna selections specified in the Antennas tab of the Configurer then just
send the command to the selected rotor.

Multiple rotor setup - When more rotors have to be turned by the program then there is a need to
map a rotor to an antenna (or antennas)

Setup the antenna selections in the Configurer; Tab: Antennas
Create a mapping between the 16 possible antennas and the 16 possible com ports for the
selected IP-address of the rotor control.

 
N1MM Rotor Setup Dialog

 
N1MM logger setup dialog for Antennas in >Config >Configure Ports, Telenet Address, Other
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>Antennas tab

 
I.e. you relate a com port to a particular antenna. If you specify more than one com port, you will
turn both.

1.5. N1MM rotor running on another computer

Let's assume that N1MM rotor, the rotor control program is on a separate computer which has IP
address 192.168.1.14, and your computer running N1MM logger is 192.168.1.10.

Make sure N1MM Rotor is running on the computer that has the rotor connected to it.
Network the computers together.
Put this in your N1MM Logger.ini file:

ExternalBroadcast
DestinationIPs=127.0.0.1 192.168.n.m

ExternalBroadcast should already be there. If not, add it.
192.169.n.m should be your ip address for the machine that has the rotor control box
connected to it. You can specify m as 255 to broadcast to all computers with 192.169.n
as the high order octets. Do not substitute 255 for any octet other than the low order one
(m).

Do not start the rotor program as it does not work on the computer which does not have the
rotor connected directly.
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Control the rotor by menus in the Tools menu. You put the direction or a callsign in the call
textbox and press Alt+J

 

1.6. Turning a Stack

In the example picture above at the right the stack is on Com3 and Com4 and are turned at the
same time when turning antenna 4 (stack).
Enter 3,4 and the heading selected will be sent to the rotor program and it will tell the rotors (of
whatever type) on com3 and com4 to turn to that azimuth. If you want to control a single antenna,
you will have to switch to that single antenna using the antenna toggle in the main program, press
ALT+j and then toggle to the set of antennas that you want.

1.7. Run time error: 126

Run time error 126 could be caused by a firewall that doesn't like a UDP message sent to 127.0.0.1
to notify the rotor program of what window is active. If you ever want to use the rotor program and
without getting this error, you will need to figure out what program is causing this interference. First
check your firewall. If that is not it, one user found that a program called "Port Explorer" was the
cause. When that was closed, the problem went away.

2. Using external hardware or software

Rotor control is supported directly by software from:

ARSWIN by EA4TX
LP rotor (freeware by Larry Phipps - N8LP)

See the links section for urls.

Start your ARSWIN or LP-Rotor software before pressing Alt+J, Alt+L or Ctrl+Alt+L.

Supported Hardware

In this Section...

Supported Hardware
1. Windows and External USB Peripherals
2. Green Heron Engineering Inc. - GH Everyware (rotator control)
3. Ham Radio Solutions - EZmaster
4. K1EL - Winkey
5. microHAM - microKEYER

5.1. Tentec ORION + "Mute mic on supported radios"
5.2. ICOM CI-v Intterfaces + Transceive on/off Features
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5.3. N1MM can't read the RX frequency (shows as 0) - frequency shown fine in
microHam router without N1MM logger
5.4. Truncation of Messages (When Using Winkey Keyer)

6. microHAM - MK2R/MK2R+
6.1. USB-only SO2R Support
6.2. Suggested Port Setup by Joe, W4TV
6.3. On-the-Fly Recording from within N1MM Logger

7. RigExpert
8. Top Ten Devices - Automatic Band Decoder and DX Doubler

8.1. Hardware Update: 'Both Ears on the Inactive Radio' versus 'Both Ears on
the Active (or Run) Radio' from the Keyboard

9. West Mountain Radio - RIGblaster
9.1. CW and Digital Setup RIGblaster Plus
9.2. SSB Setup RIGblaster Plus

10. Transverters
11. Unsupported Hardware

11.1. CW Decoders
11.2. W5XD MultiKeyer

12. Other Hardware Information
12.1. USB Soundcards
12.2. Other Soundcards
12.3. External versus Internal Soundcards
12.4. Going Back from Serial Port Numbers Greater Than Number 8

1. Windows and External USB Peripherals

One word of caution about external (USB) sound cards ... and other USB peripherals.

Windows can only address the "USB root hub" ... they are directly connected to the internal PCI
bus. Windows will process data from all "Root Hubs" in a machine in parallel. However, all of the
"child" devices are like leaves on a tree, each leaf which "grows" from the same "root" receives a
time slot (generally 16 msec) in turn. If you have too many "leaves" on one root, the delay can
become excessive and result in communications failures (time outs) with the controlling software
(logger).

This can be particularly problematical with some software that polls every 50 to 100 msec and will
timeout if a response has not been received before the next poll interval. USB can easily handle the
aggregate throughput (it will do something like 240 mb/sec) but the delays can be a problem if the
software writer does not account for them.

Be particularly aware of this issue if you use external hubs and add many devices - particularly
devices like memory sticks and "thumb drives."

73' Joe Subich, W4TV

For much more information about specific USB to serial adapters and similar hardware, see
USB Interface Devices.
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2. Green Heron Engineering Inc. - GH Everyware (rotator control)

N1MM logger can send bearing information direct to the Green Heron GH Everyware software.
N1MM logger must be configured to send rotor information over the network (using UDP packets).
This can be done by editing the N1MM Logger.ini file. Information regarding this is given in the
supplied documentation with the Green Heron software, which is bundled with Everyware Remote
and Base hardware and not sold separately.

Please refer to the Everyware documentation for further details.

3. Ham Radio Solutions - EZmaster

EZ Master is an LPT port and USB Device that interfaces your PC with several devices in your
shack like radios, antennas, filters switching, microphone, headphones etc. Including PHONE, CW,
RTTY, DIGITAL Mode interface and internal DVK, CW Keyer and SO2R switching.

More information can be found on the Ham Radio Solutions website .

4. K1EL - Winkey

Winkey is an external keyer chip designed by K1EL and G3WGV, which combines full electronic
keyer features with a serial interface to a computer. Winkey is intended to interface with compatible
Windows software and produce CW from ASCII characters sent to it, avoiding CW timing problems
caused by multitasking.

N1MM Logger was one of the first Windows logging program to support Winkey, and it has become
a favorite CW solution for N1MM Logger users. Serial or parallel port keying may work fine,
particularly with faster computers, but using Winkey can enable you to get by with a slower
machine or run other programs in conjunction with N1Mm Logger, while keeping your CW perfect.
Stand-alone keyers are available, and the Winkey keyer chip is also used in multi-function
interfaces such as Ham Radio Solutions EZMaster, RigExpert, and several microHAM interfaces.

More information can be found on K1EL's website .

A full explanation of setting up N1MM Logger to work with Winkey is found in the Configurer section
of the N1MM Logger Manual .

5. microHAM - microKEYER

 
The authoritative source for information on configuring N1MM Logger to work with various microHAM
products is the microHAM web site  which offers a variety of "Example Configurations". These
configurations are also accessible through the Help menu of the microHAM Router software, under
"Document Download."
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5.1. Tentec ORION + "Mute mic on supported radios"

In the Configuration dialogs (Other tab) make sure that "Mute mic on supported radios" is *NOT*
checked. If that is checked, N1MM mutes the microphone and turns on the AUX input during DVK
operation. By design the microKEYER routes DVK audio to the microphone input.

5.2. ICOM CI-v Intterfaces + Transceive on/off Features

How to connect microHAM devices to N1MM logger and for example a SteppIR antenna which
needs Transceive ON to know the radio frequency while N1MM logger likes to see Transceive OFF.

connect all of the CI-V devices in parallel (tip to tip, ground to ground)
turn off Transceive in the Icom rig
turn ON "polling" in microHAM Router
turn OFF "polling" in microHAM Band Decoder

 
The microKEYER (Router) will poll only when the logging software is not (for example, Router will
poll even though N1MM logger does not). The Router polls will keep data flowing on the CI-V bus to
allow the SteppIR and other similar hardware to stay "in sync."

The microHAM Band Decoder will provide antenna switching (including support for multiple
antennas per band with the appropriate external switch) according to your normal programming ,
provide drive for bandpass filters (several brands) and can do "format conversion" which will allow a
Yaesu (Quadra, FL-7000) or Icom (IC-2KL, IC-4KL, IC-PW1) solid state amplifier to work with any
other (supported Yaesu, Kenwood, Icom, or TenTec) radio.

The same capability exists with non-Icom radios.

5.3. N1MM can't read the RX frequency (shows as 0) - frequency shown fine in
microHam router without N1MM logger

N1MM polls for slightly different data than Router (VFO A and VFO B vs. "Current operating
frequency") so Router "times out."

Open Router | Control | Set and uncheck "Disable router queries" .

5.4. Truncation of Messages (When Using Winkey Keyer)

Symptom: Sends all the macro CW messages except the last letter and then goes back to receive.
The solution is to add a space or the | character (the shifted \ character) at the end of the macro
message. The | character is about 1/3 of a space.

6. microHAM - MK2R/MK2R+
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To set up MK2R+ with N1MM using LPT control see: http://www.microham.com/Downloads
/MK2R_N1MM_Setup.pdf
For a set-up using only USB see "USB-only SO2R.pdf" by N4ZR in the N1MM Logger area on
Yahoo (http://groups.yahoo.com/group/N1MMLogger).

 
Q. When I load N1MM logger the message shows: "Winkey v2 detected, Only Winkey v4 and higher
are supported in N1MM."
A. That's a Winkey initialization error of some kind which shows when the MK2R+ is not switched on
when N1MM logger is started.

Q. How many serial ports are needed by MK2R to fully work
A. In any case, one only needs five ports for a fully functioning system with N1MM (Radio 1, Radio
2, PTT 1, PTT2, and WinKey). Any other functions (Packet, rotor control, etc.) do not need
to be in the "first eight." MMTTY/Digital Interface will share a port with PTT (and CW if you are not
using WinKey) ... and MMVARI or MMTTY in AFSK mode does not require a port at all. Even if/when
the SO2R control signals get mapped to serial handshake lines or the software adds support for the
microHAM control protocol (on a virtual port) one additional port will not push most systems "over
the line" - although the ability to start the block of eight other than at COM1 would provide a bit of
insurance.

73, Joe, W4TV

An example setup

microHAM Router

VOICE Audio Switching for both radios: CmCmCm

FT1000MP, Proset Plus plugged to front mic jack.

N1MM Logger (6.10.9 or higher)

Configurer >Audio tab
2 - Single Card - Two Radio, No sound card SO2R
Select Device = USB Voice CODEC
Select Input Line = Microphone
Select Line to Mute = Microhone
Recording bits = 16
Sampling rate = 22050

 
Ctrl+Shift+Fx to record, Fx to playback.

6.1. USB-only SO2R Support

With USB-only SO2R support using the the MicroHam SO2R protocol, an LPT port to command
various SO2R functions with the MK2R/MK2R+ is no longer needed.

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

470 of 680 2/2/2011 4:54 PM



Designate a virtual COM port as your MK2R control port in N1MM logger. To do this, check the
CW/Other box for the port, click on 'Set', and check the MK2R box on the port details dialog. Then
go to the SO2R tab on the MicroHam Router, select Microham SO2R protocol with the "radio
button", and identify the COM port in the drop-down list just below. Finally, if you want to use
program-derived band data, on the ACC tab change the Radio 1 and Radio 2 options to "SO2R
protocol controlled". If you want to control band decoders for two radios, you may need to wire up a
new cable to get Radio 1 data from pins 6-9 on the ACC connector, and Radio 2 data from pins
10-13.

Record-on-the fly within the program is supported using USB-only.

6.2. Suggested Port Setup by Joe, W4TV

"The MK2R/MK2R+ operates very well with six total ports (I will use A - F to avoid particular
numbers):

MK2R/MK2R+ with 6 Total Ports

Port Connected Device

COM
A

WinKey (it is best to assign WinKey to the "lowest" port to avoid loss of CW if another
port is activated for CW)

COM
B

Radio #1 (PTT and Footswitch is optional on this port)

COM
C

Radio #2 (PTT and Footswitch is optional on this port)

COM
D

Digital #1 FSK and PTT for Radio #1 (assign Radio 1)

COM
E

Digital #2 FSK and PTT for Radio #2 (assign Radio 2)

COM
F

MK2R (protocol port)

 
A user who does not choose to do FSK (uses AFSK only) can survive with FOUR virtual ports as
PTT can be enabled on each of the radio ports - even with radios that normally expect "handshake"
- as the MK2R does the handshaking and frees both RTS/DTR lines for control functions."

The COM D and COM E PTT settings (or the optional radio port PTTs) are necessary if you wish to
use the built-in N1MM Logger "DVK" with PTT (rather than VOX). This does not mean that you have
to designate COM 5 and 6 on the Ports tab as PTT - instead you can just make sure the PTT box is
checked on your two FSK ports in Router. If you wish to use the MK2R's built-in DVK instead, you
will need to check the "DVK" box on the port you are using for the MK2R.

6.3. On-the-Fly Recording from within N1MM Logger
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In order to make on-the-fly recording with Ctrl+Shift+Fx work with N1MM and the MK2R+, there are
a couple of unusual requirements:

if using the MK2R SO2R protocol (USB-only), you need to use MM 7.10.9 or later
If your computer uses the Realtek or Soundmax chips for its on-boardsound, then you will
need temporarily to set the default sound device inWindows to be the USB Voice CODEC, and
be sure to turn off all Windowssounds for the duration. There's a glitch in the
Realtek/Soundmax drivers that doesn't let mic audio get through to the wav file from the
MK2R+unless you do this.

 

7. RigExpert

When installing drivers for RigExpert Std or Plus, it creates 4 virtual COM Ports on your computer
along with USB Audio Codec (for its internal sound card).
Click on "Show Serial Ports" (ListRE program which comes with RigExpert software) and write down
COM port numbers for CAT and PTT/CW for future reference.
Then run your N1MM. (Make sure you are not running other logging programs at the same time to
avoid port conflict).
Go to Configure and click on Configure Ports, Telnet Address, Other. Click on Hardware. You will
see a selection of COM port from COM 1 to COM 8. Select the proper COM port number for CAT
(the one you memorized before), select your radio model and in Details select the proper
parameters for your radio (baud rate, etc.). Then select proper COM port number for CW/PTT
(check CW/PTT) and in the details set DTR to CW and RTS to PTT. If you are using RigExpert Plus,
then you may also set a separate COM port for Winkey.
If you want to use RigExpert as your Sound card (for SSB messages or RTTY) you may go to Audio
(under the same Configurer menu) and select USB Audio Codec as you Sound Device.
Please keep in mind that N1MM only accepts COM port number from 1 to 8. So if upon RigExpert
installation you were given higher COM port number, then you should go to Windows Device
Manager and change it.
Also, don't forget that you can not run two programs that using USB Interface, at the same time.
If you have older RigExpert - SD or 2.2, you still may use it with N1MM, just need to install
additional driver (REAUDIO).

When RigExpert SD is used with N1MM for Voice Keying, in the Configurer's Audio select
"RigExpert" as a Device. Then configure the Recorded wav file path in the "Files".
The older RigExpert models,need to have REAUDIO installed. For newer RigExpert models
REAUDIO is not needed "USB Audio Codec" in the "Select Device" menu should be seleceted.

8. Top Ten Devices - Automatic Band Decoder and DX Doubler

 
To replicate the default Top Ten Devices behavior, you would need to set up Configurer >Antenna
tab as shown in the Interfacing section.

8.1. Hardware Update: 'Both Ears on the Inactive Radio' versus 'Both Ears on the
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Active (or Run) Radio' from the Keyboard

 
I wanted to go one better and mimic the "PTT" operation of the DXD, which puts both ears on the
INactive radio for aggressive S&P, but still be able to put both ears on the Active (or Run) radio from
the keyboard, to help pick up weak answers to my CQs while HC8N is blasting on the S&P radio at
S9 +40. You can do this manually by switching the DXD audio mode switch from PTT to Auto, but
I'd rather keep my hands on the keyboard.

After corresponding with George, W2VJN and Dave, N3RD, of Top Ten, and entirely thanks to them,
I have it working. I also owe a vote of thanks to Terry, N4TZ/9, whose article in September/October
NCJ describes modifying the DXD to do the same trick, but with a footswitch, and got us all
thinking.

First, put the DXD jumpers (2) in their CT/Writelog/TR/MM position. This has the effect of isolating
pin 5 of the LPT port. Then put a 2N2222 open collector switch between pin 5 and the Auto terminal
of S3 on the DXD (that's the audio mode switch). Specifically, pin 5 drives the base of the transistor
through a 1K resistor connected to the high side of R22, just like the basic CW keying interface.
The emitter is grounded to the ground side of R22, and the collector is wired to the switch side of
R29. I mounted the transistor next to R22 with double-sided tape. Ugly but effective. That's all there
is to it.

 
73, Pete N4ZR

9. West Mountain Radio - RIGblaster

 

9.1. CW and Digital Setup RIGblaster Plus

Inside the RIGblaster Plus set the following jumpers on the P5 jumper block: D9 and D12,
corresponding to RTS on PTT and DTR on KEY. Switch the port on which the RIGblaster is set from
DIGITAL to OTHER. In N1MM's configuration use DTR (pin 4) set to CW and RTS (Pin 7) set to PTT.
Using this configuration, everything works properly generating CW from N1MM and furthermore,
this combination will allow the other soundcard related things to work (MMTTY, SSTV, PSK, Voice
Key Express, etc). (by David, K1TTT)

 

When using the DX Doubler on a port other than LPT1 check out the proper addresses.

When your radio in CW stays in key down position try setting DTR to CW

DX Doubler on port other than LPT1

CW key down problem and RIGblaster Pro
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9.2. SSB Setup RIGblaster Plus

Serial port setup (configurer)
Com2 (any com port will do)
DTR: Always OFF
RTS: PTT

On the RIGblaster itself
Set the Tx/Auto switch to Auto.

Sound Volume Level
Use your soundcards volume control

With it set up this way, it correctly mutes the microphone while transmitting a wav file and the VOX
works when not transmitting a wav file.

10. Transverters

N1MM logger has transverter support in the form that per bandmap an offset frequency can be set.
Right click menu bandmap and select Set transceiver offset frequency. Enter the transceiver offset
frequency in kHz (minus is allowed). Example: 116000 when using a transverter from 28 MHz to 144
MHz (144000 - 28000 = 116000). The same for other bands (up or down). This can be set per
bandmap so when using two transceivers with transverters they can each be on a different band.
The offset is saved by the program so after a restart the offset is still there.

11. Unsupported Hardware

 

11.1. CW Decoders

No CW decoder is built in nor any external CW decoder is supported.

11.2. W5XD MultiKeyer

The W5XD MultiKeyer is not supported and there are no plans to do so. SO2R support is provided
by sound cards and Winkey or by other external hardware using serial and parallel ports.
Winkey kits can be purchased very cheap and the logging program can do SO2R switching for CW
with a single sound card. See the SO2R chapter. Scroll way down, and look for the picture of the #3
SO2R CW configuration. Two sound cards are needed for full SSB SO2R (#4 SO2R).

12. Other Hardware Information

All by Joe Subich, W4TV

12.1. USB Soundcards
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The manuals for the soundcards below (in alphabetic order) indicate they have independent
microphone and stereo line inputs.

Audigy 2NX External
Creative SoundBlaster MP3+
Turtle Beach "Audio Advantage Roadie"

 
The "low price option" below does not have an on-line manual but the specs on the web site show
separate mic and line jacks.

Byterunner UA-580
appears to be the recommendation for those who need an external sound card (laptop,
etc.).

 

12.2. Other Soundcards

SoundBlaster Live 24 External
The one issue with the Live 24 External is that you cannot use the mic and line inputs at
the same time (connecting the mic will disconnect the line). It will work fine for internal
DVK in N1MM but you cannot "record QSOs" and use DVK at the same time if you loop
the microphone through the Live! 24 External.

 

12.3. External versus Internal Soundcards

There are claims that External USB soundcards work substantially better (and should be used) then
internal soundcards (on sigital signals).

Joe, W4TV: The claimed "advantage" comes from flawed tests which fail to properly set the input
level to each sound device to take maximum advantage of its dynamic range.

Except for the very worst sound cards or exceptionally noisy systems, internal sound cards have at
least 60 dB of usable dynamic range (the better 16 bit cards have 80 dB of dynamic range and 24
bit cards with high level inputs can have dynamic ranges that approach 100 dB). If the audio from
the transceiver is such that the receiver noise floor (no antenna) is six to ten dB above the noise
floor of the sound card, the software DSP (MMTTY, etc.) will be able to operate at its full capacity.
Receiver AGC, etc. will limit the receiver output to a level well below the input capacity of the
soundcard. Most receivers will not vary more than 30 to 40 dB from quiet band to S9 +40 dB receive
signals. Soundcard performance is not a matter of internal vs. external. It is a matter of careful
attention to setting the proper level to allow the soundcard to function properly.

12.4. Going Back from Serial Port Numbers Greater Than Number 8
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When using USB-serial converters some of them start up with serial ports numbering beyond 8.
When this happens it is possible to change the serial port number to something less than Com 8.
Go to Communications Port Properties, Port Settings Tab, then click on Advanced. There is a
pull-down in the Advanced window that allows the setting of the port number. If all ports COM1 -
COM8 are used then find out what devices
are using them and reconfigure or uninstall those devices to free up the ports. Windows will
"reserve" COM ports for devices that are disconnected so it will take some detective work.

Supported Contests

In this Section...

Supported Contests
1. General Contest Logging (all modes)
2. Supported HF CW and SSB Contests
3. QSO Parties (CW/SSB)

3.1. United States
3.2. Canada

4. Supported VHF CW/SSB Contests
5. Supported RTTY/PSK Contests
6. My Contest Isn't Here. What Can I Do?
7. User Defined Contests

7.1. The UDC Editor
7.2. Editing Tips
7.3. Running a User-Defined Contest
7.4. The UDC File

7.4.1. File Format with Explanations

1. General Contest Logging (all modes)

 

Contest
Log Type
& Setup
Link

Remarks

DX (General
log)

DX log Sent RST, Received RST fields, Name and Comment field

DXPEDITION DXpedition Only has Sent and Received RST fields

DXSERIAL DXSERIAL Sent and received RST, Nr fields and a Comment field for Generic
Serial number contests. Default multipliers and points.

DXSATELLIT DX satellite Only three fields: Call, Grid and Satellite

VHFDX VHFDX Sent RST, Received RST fields, Grid and Comment field
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Contest
Log Type
& Setup
Link

Remarks

VHFSERIAL VHFSERIAL Sent and received RST, Nr fields and Grid fields. For generic VHF
serial number contests. Comments possible.

 

2. Supported HF CW and SSB Contests

All contests are supported 'both' sides unless specifically mentioned.

Contest Name and Website
Link

Setup Link Remarks

9A CW contest 9ACW CW only; 3rd full weekend
in December

AGCW Happy New Year AGCW Happy New Year

All Asian DX contest CW / SSB ALLASIASSB
ALLASIACW

CW - Third Saturday of June
(48 hours)
SSB - First Saturday of
September (48 hours)

Asian Pacific Sprint APSCW
APSSSB

In Spring, Summer, Fall (2
hours)

ARCI QRP Contests ARCI This contest supports 7
ARCI QRP contests

ARI International DX Contest ARIDX Per version 4.0.63

ARRL 10 Meter contest ARRL10M

ARRL 160 Meter contest ARRL160M

ARRL Field Day contest FD See ARRL Field Day Setup
instructions.

ARRL International DX contest
CW /Phone

ARRLDXCW
ARRLDXSSB

ARRL November Sweep Stakes
CW / SSB

SSCW
SSSSB

ARRL Rookie Roundup RRSSB
RRRTTY
RRCW

SSB in April, RTTY in
August, CW in December
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Contest Name and Website
Link

Setup Link Remarks

Asia-Pacific Sprint Contest CW /
SSB

APSCW

Baltic contest BALTIC Every year the next to last
weekend in May - one week
before WPX CW Contest

BFRR CW/SSB Championship BFRRCW/BFRRSSB For Belarus stations only

Black Sea Cup International BSCI First full weekend in
February

CIS DX contest CISDXCW
CISDXSSB

Commonwealth of
Independent States

CNCW Spanish contest CNCW Local Spanish CW contest

CQ-M International DX contest CQM Second weekend of May.

CQ World-Wide 160 Meter DX
Contest - CW / Phone

CQ160CW
CQ160SSB

CQ World Wide DX contest -
CW / SSB

CQWWCW
CQWWSSB

CW - Last full weekend of
November (48 hours)
SSB - Last full weekend of
October (48 hours)

CQ World Wide WPX contest -
CW / Phone

CQWPXCW
CQWPXSSB

CQSA SSB Contest CQSASSB Second full weekend in
October

Cup of the Russian Federation -
SSB

RFCCW
RFCSSB

Internal Russian contest in
January

Cup of the Russian Federation -
CW

RFCCW
RFCSSB

Internal Russian contest in
January - see also RTTY
version below

CWops Mini-CWT Test CWOPS Second Wednesday of each
month

DARC 10 meter contest DARC10M 2nd full weekend in January

DARC Weihnachtswettbewerb -
XMAS contest

XMAS December 26

European Sprint EUSCW
EUSSSB

In April and October, both
modes, 4 hours

DIG contest - CW / Phone DIGCW
DIGSSB

SSB: Second weekend in
March
CW: Second weekend in
April
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Contest Name and Website
Link

Setup Link Remarks

Also for short contests in
June and October

Elecraft QSO Party EQSO Despite the name, handled
as a separate contest

EU HF Championship EUHFC First Saturday in August
(12:00 - 23:59 UTC)

FOC Marathon FOCCW First full weekend in
February

Gagarin Cup GCUP April; CW, HF plus satellites

GACW WWSA CW DX contest GACW Second weekend in June.
CW only

HA DX contest HADX 3rd full weekend in January

Helvetia Contest HELVETIA

High Speed CW Contest -HSC
CW

HSCCW

Holyland contest HOLYLAND

IARU HF Contest IARU

ARU Region 1 Field Day FDREG1 Varying rules for Belgium,
Germany, United Kingdom
(SSB and CW),
Netherlands, Switzerland,
Ireland (only CW), Italy,
Slovenia (S5) and Russia
(UA, UA2, UA9)

http://www.rsgbiota.orgIRSGB
IOTA - Islands On The Air
Contest

IOTA

International Naval Contest NAVAL

JA-domestic JADOMESTIC Generic support for
Japanese domestic contests

JIDX Contest JIDXCW
JIDXSSB

CW: 2nd full weekend of
April
PH: 2nd full weekend of
November
Sat. 0700 UTC - Sun. 1300
UTC

JT DX Contest JTDX Third weekend in November,
CW or SSB (pick one)
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Contest Name and Website
Link

Setup Link Remarks

King of Spain contest KINGEACW
KINGEASSB

LOTW LOTWCW
LOTWSSB

LZ DX contest LZDX The weekend before the last
full weekend of November
(weekend before CQWW
CW)

LZ Open and LZ Sprint contests LZOPEN For all three contests. LZ
Open and both sprint
contests (40/80 meter)

Manchester Mineira All America CWJFMM South and North American
CW only contest by CWJF

Michigan QRP Contest ARCI This contest supports 4
Michigan QRP contests.
Select ARCI contest (same
rules)

NA Sprint - CW / SSB SPRINTCW
SPRINTSSB

CW: First Sunday in
February
SSB: Sunday of first full
weekend in February
CW: Sunday following first
Monday in September
SSB: Second Sunday
following first Monday in
September

NS Sprint and Sprint Ladder SPRINTNS
SPRINTLADD

Weekly, CW only, identical
except for dupe rules, which
may change on short notice;
SPRINTLADD allows no
in-band dupes, while
NSSPRINT allows dupes
with one intervening QSO.

Minitest CW Test MINITESTCW CW:Almost every
Wednesday 1800-1900Z

North American QSO Parties -
CW / SSB

NAQPCW
NAQPSSB

CW: Second full weekend in
January. First full weekend
in August
SSB: Third full weekend in
January. Third full weekend
in August
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Contest Name and Website
Link

Setup Link Remarks

NRAU-Baltic contest NRAUCW
NRAUSSB

2nd full weekend in January

Oceania contest CW / SSB OCEANIA CW/SSB SSB: First weekend in
October
CW: Second weekend in
October

OK-OM DX contest OKOMDX Second full weekend in
November

PA-beker CW / SSB contest PABEKERCW
PABEKERSSB

Second full weekend in
November
Local Dutch CW and SSB
contest

PACC contest PACC First full weekend of
February

Portugal Day Contest PORTUGAL Second Saturday of June

QCWA QSO Party QCWAQSO Despite the name, treated
as a separate contest

QSO parties (US and Canada) QSOPARTY See next chapter/section

RAC Canada Day, Contest RAC
Canada Winter Contest

RAC Both contests have the
same rules

RAEM Contest E.T.Krenkel contest) RAEM Fourth full
weekend of
December

REF DX contest REFCW
REFSSB

CW: last weekend of
January
SSB: last weekend of
February

RF Championship RFCHAMP For English text select on
top "Translate to English"

RSGB 160 Meter CW contests RSGB160CW CW only. In February and
November

RSGB 21/28 MHz contest RSGB2128

RSGB 80 Meter Club
Championship

RSGB80MCC

RSGB Affiliated Societies Team
Contests 

RSGBAFS-C
RSGBAFS-S

RSGB Club Calls contest RSGBCLUB

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

481 of 680 2/2/2011 4:54 PM



Contest Name and Website
Link

Setup Link Remarks

RSGB Commonwealth Contest RSGBBERU British Commonwealth
stations only

RSGB National Field Day, RSGB
SSB Field Day

FDREG1 According rules for Belgium,
Germany, United Kingdom
(SSB and CW),
Netherlands, Switzerland,
Ireland (only CW), Slovenia
(S5) and Russia (UA, UA2,
UA9).

RSGB Low Power Field Day RSGBLP

RSGB ROPOCO ROPOCO Internal RSGB contest

Russian District Award Contest RDAC

Russian DX RUSSIANDX

Russian Radiosport Team
Championship

RRTC
RRTCT

Third Saturday in July

Russian YL/OM contest RUSYLOM in Russian

SAC SACCW
SACSSB

SYLRA contest SYLRA

Spanish Towns contest CME

SP DX contest SPDX First full weekend of April
(15:00-15:00 GMT)

Stew Perry Topband Distance
Challenge

STEWPERRY Last full weekend of
December

TRC DX Contest Contest Setup
Instructions

UA1DZ Memorial Cup DZCUP For English text select on
top "Translate to English"

UBA DX Contest CW/SSB UBACW
UBASSB

SSB: last weekend of
January
CW: last weekend of
February

UBA ON contest UBAON Last Sunday September: 6
m Phone/CW
First Sunday October: HF -
80 m SSB
Second Sunday October:
HF - 80 m CW
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Contest Name and Website
Link

Setup Link Remarks

Third Sunday October: 2 m
Phone/CW

UBA Low Band Winter Contest UBAWINTER 160, 80 and 40 meters

UBA Spring UBASPRING Second Sunday March: HF -
80m CW
Third Sunday March:
VHF-6m Phone/CW
Fourth Sunday March:
VHF-2m Phone/CW
First Sunday April: HF - 80m
SSB

Ukrainian Championship UKRCHCW
UKRCHSSB

Ukrainian DX contest UKRAINDX First full weekend of
November

UK DX Contest - CW/SSB UKDXCW
UKDXSSB

UN DX contest UNDX Open Kazakhstan
Championship

WAEDC-Contest WAECW
WAESSB

The starter for the new
Contest season.

Worked All Germany contest WAG October, third full weekend

World Wide Peace Messenger
Contest

WWPMC 1200UTC Saturday to 1200
UTC Sunday, every first
weekend of February

World Radiosport Team
Championship

WRTC for on-site participants in
World Radiosport Team
Championship held every 4
years - others use IARU

YO DX HF contest YOHFDX Last weekend in August

YU DX Contest YUDX Third full weekend in April

Independence of Venezuela
Contest

YV First full weekend in July

 

3. QSO Parties (CW/SSB)

The QSO parties listed below are supported by NM1MM Logger.
Select: QSOPARTY and select the correct state in the dropdown box which will appear.
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The QSO parties use a configuration file named 'QSOparty.sec' with the used sections per QSO
party.
See the Contest Setup Instructions for more information on QSO parties in general and some
specifics. There are some scoring anomalies with (some of) the QSO parties.

3.1. United States

 

State and Website Link Setup Link

Alabama - AL

Alaska - AK

Arkansas - AR

Arizona - AZ

California - CA

Colorado - CO

Connecticut - CT

Delaware - DE

Florida - FL Contest Setup Instructions

Georgia - GA

Hawaii - HI

Idaho - ID

Indiana - IN four QSO Parties, one weekend

Illinois - IL

Iowa - IA

Kansas - KS

Kentucky - KY

Louisiana - LA

MARAC - county hunters Contest Setup Instructions

Maryland DC - MD

Michigan - MI

Minnesota - MN

Missouri - MO

Montana - MT

Nebraska - NE

New England - NEWE four QSO Parties, one weekend
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State and Website Link Setup Link

New Mexico - NM

New Hampshire - NH

New Jersey - NJ

New York - NY

North Carolina - NC

North Dakota - ND

Nevada - NV

Ohio - OH

Oklahoma - OK

Oregon - OR

Pennsylvania - PA Contest Setup Instructions

South Carolina - SC

South Dakota - SD

Tennessee - TN

Texas - TX

Vermont - VT

Virginia - VA

Wisconsin - WI

Washington Salmon Run - WA

West Virginia - WV

Zeroland - ZQP four QSO Parties, one weekend

7th Call Area - 7QP four QSO Parties, one weekend

IN7QPNE For users that are "out-of-state" for the IN, NEWE,
ZQP, or 7QP QSO parties. Log all contests in one log
and send the same cabrillo file to all sponsors.

3.2. Canada

Province and Website Link Setup Link

British Columbia - BC BC

Maritime QSO Party MCC First running June 2011

Ontario ON qsop
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4. Supported VHF CW/SSB Contests

 

Contest Name and Website Link
Log Type
& Setup Link

Remarks

ARRL January VHF Sweepstakes ARRLVHFJAN January

ARRL June VHF QSO Party ARRLVHFJUN June

ARRL August UHF Contest K3TUF August

ARRL September VHF QSO Party ARRLVHFSEP September

IARU Region 1 50 MHz contest VHFREG1 Only 50 MHz - June

IARU Region 1 144 MHz
September

VHFREG1 Only 144 MHz - September

IARU Region 1 UHF/Microwaves
October

VHFREG1 UHF and Microwaves - October

Other Region 1 VHF and up
contests

VHFREG1 VHF and up - March, May, July

Marconi CW contest 144 MHz / 50
MHz

VHFREG1

NRAU Activity Contest VHFNAC

REF Departments contest 50 MHz DDFM50 Only 50 MHz

VHF/UHF Helvetia 26 contest VHFHELV26 Swiss VHF and up contest

VHF HG OB contest VHFHGOB Hungarian VHF contest

VHF UA1DZ Cup VHFDZCUP Russian VHF contest

VRZA - Nederlandse Locator
Contest

REGIOVHF WANLC - Dutch contest, every month NB
selecteer: REGIOVHF

UKSMG sporadic-E competition UKSMG

5. Supported RTTY/PSK Contests

All contests are supported 'both' sides unless specifically mentioned.

Contest Name and Website
Link

Log Type
& Setup Link

Remarks

ANARTS WW RTTY contest ANARTSRTTY Replaced by DCRG Long Distance Contest

Anatolian RTTY contest ANATOLRTTY Third full weekend in May

ARRL RTTY Roundup ARRLRTTY First full weekend of January (not on January 1)
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Contest Name and Website
Link

Log Type
& Setup Link

Remarks

BARTG Spring RTTY contest BARTGSRTTY Third full weekend in March

BARTG RTTY Sprint contest BARTGRTTYS End of January

BARTG Sprint75 contest BARTGRTTYS 75 baud RTTY. April, September (4 hours each)

CQ World Wide DX - RTTY CQWWRTTY Last full weekend of September (48 hours)

CQ World Wide WPX - RTTY CQWPXRTTY Second full weekend of February

CIS DX RTTY contest CISDXRTTY QPSK63 in 2009/2010. Third full weekend of
September

Cup of the Russian Federation
RTTY

RUCUPRTTY For Russians only. Second weekend of
September

DCRG Long Distance RTTY DLDCRTTY Second full weekend of June

DL-DX RTTY contest DLDXRTTY First full weekend of July

DMC RTTY DMCRTTY Third full weekend of July

EA PSK31 contest EAPSK Second full weekend of March

EA RTTY contest EARTTY First full weekend of April

EPC PSK World Wide DX EPCWWDX PSK63. First weekend in February

EPC RU DX Contest EPCRUDX March BPSK63

EPC PSK63 QSO party EPCPSK63QP PSK63. Third full weekend of November

EU PSK DX contest EUPSKDX PSK63. Third full weekend of May

JARTS WW RTTY contest JARTSWWRTY Third full weekend in October

JT RTTY DX Contest JTDXRTTY Second full weekend in January

LOTW RTTY contest LOTWRTTY

Makrothen RTTY contest MAKRORTTY Second full weekend in October

NA Sprint - RTTY SPRINTRTTY Sunday of second full weekend in March.
Sunday of second full weekend in October

North American QSO Parties
(NAQP) - RTTY

NAQPRTTY Last full weekend in February. Third full
weekend in August

OK DX RTTY contest OKDXRTTY Third full weekend in December

Quick PSK63 contest SARTGRTTY PSK63. Uses SARTG rules. First Saturday of
September

Russian PSK DX Contest RUSDXPSK PSK63. Fourth full weekend of August

Russian DX RTTY contest RUSDXRTTY RTTY. First Saturday of September

SARTG New Year RTTY SARTGNYRTY January 1st

SARTG WW RTTY contest SARTGRTTY Third weekend in August

SCC RTTY Championship SCCRTTY Last full weekend in August
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Contest Name and Website
Link

Log Type
& Setup Link

Remarks

SP DX RTTY contest SPDXRTTY 4th full weekend of April

TARA Grid Dip contest TARAGRID RTTY and PSK. First Saturday of August

TARA PSK Rumble TARAPSK PSK31. First Saturday of October

TARA RTTY Melee TARARTTY RTTY. First Saturday of December

Ukrainian RTTY Championship UKRCHRTTY For Ukrainian stations only. Third weekend of
April

Ukrainian DX RTTY contest UKRAINRTTY First full weekend of November

Ukraine Open RTTY
Championship

UKRTTYOPEN First full weekend of March

Ukraine DX DIGI contest UKRAINDIGI RTTY 75 baud, PSK63. Fourth full weekend of
June

UK DX Contest - RTTY UKDXRTTY Second full weekend of July

Volta RTTY contest VOLTARTTY Second full weekend in May

WAEDC RTTY contest WAERTTY Second full weekend in November

XE RTTY contest XERTTY First full weekend of February

6. My Contest Isn't Here. What Can I Do?

 
If the contest is not currently supported by the program there are four options:

Use the 'User Defined Contest' capability introduced in version 10.3.4 to create a new contest
template.

This capability is still under development and may undergo further change. See the
section below.

Find another contest with a similar exchange and similar rules. If the only difference is in the
scoring, you can run the contest and create the Cabrillo file, then edit the Cabrillo file to
change the contest name. You can either score the contest manually after the contest, or
enter a claimed score of zero and let the contest sponsor calculate the multipliers and points
Use a 'general' contest like DXSERIAL, DX, etc. Run the contest and do the log creation after
the contest using Notepad or a similar text editor. When Cabrillo is the log requested, create
the Cabrillo log and update the header. The contest sponsor will calculate the multipliers and
points. This is the easy way to go for many small, mostly local, contests
Request that the contest become one of the supported contests

Whenever someone requests support for a particular contest, it would be good to have
an indication of the number of entries the contest received during the previous year's
running. This is not to suggest that there is a threshold below which contests will not be
supported, but that knowing this is helpful in prioritizing for the people who do the work.
In the past we have had requests to support contests that had fewer than 10 entries the
previous year
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Since the programmers do not have unlimited time to respond to last-minute requests,
set yourself a target date (for example, a minimum of three months prior to the next
running of the contest) to allow time for programming and proper testing
It is part of the nature of the N1MM Logger project that users, and particularly those
users requesting support for a particular contest, are the people who are relied upon to
test and be sure the contest module does what it is supposed to do. It is particularly
important to test far enough in advance of the running of a contest so that any problems
can be identified and fixed. Users will do well to check each contest as it is coming up,
to make sure that any rule changes are reported to the programmers in time for changes
to be made.

 
If you identify bugs or propose contest-specific features during the running of a contest, don't
expect an immediate response. Contest-specific things are on a calendar to be addressed before
the next running. Of course, defects in Cabrillo output are an exception, since they need to be fixed
in time for score submission and can be done in the weeks after the contest.

7. User Defined Contests

 
Enabling users of a contest logger to define their own contests has always been a very difficult
thing to do. With the proliferation of contests, often with (ahem) innovative rules, it has gotten
harder in recent years. Normally, it requires someone with knowledge of the programming language
to create a contest "module", and even then the rules may defy incorporation.

In an effort to help with this problem, Nick, NA3M has written a very clever User Defined Contest
(UDC) Editor, which is found in a new folder in the N1MM Logger program file, beginning with
Version 10.3.4. The same description of how to use this editor is found both here and in a Help file,
also in that folder, which contains information in different languages selectable from the UDC File
Editor. The Help file can be opened from the UDC File Editor by clicking its HELP button or by
double-clicking a specific contest parameter line. Notepad will automatically start and display the
Help file. Resize windows so you can see both the UDC editor window and the Notepad window at
the same time. Double-clicking on a parameter is particularly useful because Notepad then
goes directly to that parameter in the Help file. The first time you call for help during an editing
session, you will be asked to select the language. This selection stays in memory until you close
the editor. If the wrong language was selected, you will have to close and restart the UDC Editor.

If you have developed and thoroughly tested a UDC for a particular contest, please share it with
other users by uploading it to the UDC folder in the Files Section of the N1MMLogger group on
Yahoo

Limitations
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7.1. The UDC Editor

 
The UDC Editor is quite simple. When you open the Editor, you will first be asked to select a User
Defined Contest file. You'll note that these files all have the extension ".udc"), and are stored in the
UserDefinedContests sub-folder in the N1MM Logger folder.

 
When you open an existing contest file, you will be warned to do a "Save As..." unless you intend to
edit the file you have opened. This is because any changes are saved immediately to the file you
have opened. You have to be careful not to damage the existing User Defined Contest file that you
are going to use as a starting point for your new contest file.

Here is an example of a contest created by a user during testing, as viewed in the UDC Editor.

While the UDC Editor gives a user extensive options for adapting N1MM Logger to the rules of
many contests, it cannot provide the same control that a programmer has, or that may be
required to fully implement them. For example, a contest defined with the UDC Editor can only
give a fixed number of points per QSO. Many contests (WPX is a good example) are more
complicated. Also, in many contests the rules are different for contestants from one area than
for those from another - a good example is QSO parties with different rules for in-state and out
of state participants. In those cases, it may make sense to create two UDC contests, for use by
in-area and out-of-area contestants .
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To change a contest parameter, click once on it. You'll note that the parameter and its value appear
in the gray pane to the right. Change the value in the Value field. Click on Set Value for Key to save
it. This will save it in the file immediately. That is why the Editor does not have a Save button. When
you are done editing a contest just exit, and your contest file will have all changes saved.

Once the new (or modified) .udc file is ready to test, save it one last time into the "N1MM
logger/UserDefinedContests" folder and start N1MM Logger. Go to File > New Contest in Database,
and you should be able to see your new contest in the list of available contests. Test it to make sure
everything works as you planned. If there is something wrong, you can edit the .udc file even while
it is loaded in N1MM Logger. To test any changes, just go to the Entry Window of N1MM Logger,
click on the File menu, and reload the contest from the drop-down list of recent contests.

If you want to help with this project and add one more language - simply add your translation to an
empty Language...section in the USC help file and send the file to na3m@arrl.net, Please use
UNICODE encoding when saving the file.

 

7.2. Editing Tips
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The UDC Editor will not allow you to delete parameter names but you can erase or omit the value in
the gray pane, in which case the default value will be used (these are marked with * in the list of
values for each parameter). You should only use values mentioned below. At the moment, there is
no check for correctness of the value supplied for a parameter. The wrong value may cause
unpredictable N1MM Logger behavior, such as display of warning messages with the name of the
wrong parameter.

By default, the UDC editor does not show "empty" parameters, for which N1MM Logger will be
using default values. You can see the full list of parameters by clicking on the "Show Default" check
box, and edit them by assigning a non-default value. Do not attempt to remove "empty" parameters
- they may be needed in case this file is later used as a template for another contest.

Keep your .udc files in the "N1MM logger/UserDefinedContests" folder. If you define a UDC and
store it in the database, but subsequently remove its .udc file from the folder, then the next time you
try to open that contest, a warning message will be displayed and the contest will not work.

 

7.3. Running a User-Defined Contest

 
User-defined contests appear in the drop-down list of contests in the Select Contest dialog, just like
those programmed at the factory.

7.4. The UDC File

 
Note: it is not recommended to use any language other then English for contest parameters. Take a
look at the sample UDC files using a text editor, if you want to understand the file format, but we
recommend you use the UDC Editor to edit or create a new file.

7.4.1. File Format with Explanations

 
This is the full list of parameters that can be set with the UDC Editor (asterisks are default values).
Over time, new parameters will continue to be added. For example, new parameters
"CabrilloVersion =", "BonusPoints2 =" and "DoNotCountMeAsMult =", which were added in Version
10.11.0, can be added to the end of existing .udc files with any text editor like NotePad.

One of the nice things about the UDC Editor is that you can't do much damage if you mess up.
The only thing you are editing is the .udc file, and if it doesn't work and you can't fix it, you can
always just delete it from the UDC folder and start over.

Don't worry about messing up
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[Author] section

/AuthorName/ = your name
Put your name here. Users should know who will be able to help them with this contest file.

/Callsign/= your callsign

/Email/= your email address

[File] section

/Revision/ = 1.0.0 It is recommended to increment this number every time you change the .udc file.

/LastUpdate/ = 12/30/09
Will be automatically filled with current date if you create new file (using Save File As...) or edit
current file.

/Description/ = Short description of the contest type (one line).

[Contest] section

/Name/ =SAMPLETEST
10 characters maximum, capital letters only (if not it will be changed to all capitals), no spaces
allowed. Example: ARRLDXCW
This name will show up in the Contest Selection window and a new folder with this name will be
created if recording is enabled.

 
/DisplayName/ = SAMPLE USER TEST
Spaces allowed Example: ARRL DX CW

/CabrilloName/ = SAMPLE-USER-TEST
Free to choose, no spaces allowed, but dashes OK Example: ARRL-DX-CW Maximum of 15
characters.
This name will be used in the Cabrillo file, and typically is specified by the contest organizer - be
sure to check.

/CabrilloVersion/ = 2.0*
When set to 3.0 the log file will be saved using version 3.0 of Cabrillo format. Also new fields will
show up in the contest configuration window. Any other value or no value will turn on (the default)
version 2.0

RTTY contests need to have RTTY somewhere in the Name (e.g., BARTGRTTYS), and the
same goes for VHF contests (all those currently defined have VHF at the beginning of their
Name, so it probably makes sense to continue to follow this convention). This is required
because the program uses the presence of these markers to set parameters that are unique to
these types of contests.

Labeling RTTY and VHF contests
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/Mode/ = CW (the default value)
Valid modes are: CW* SSB BOTH RTTY

/DupeType/ = 2
1 = All bands 2* = Each band (common) 3 = Each band & Mode 4= no check

 
Dupe Type defines what combination of band, mode and callsign constitute a duplicate call-sign.
1 = All bands Stations may be worked only once, regardless of band
2 = Each band (common) Stations may be worked once on every band (mode independent)
3 = Each band & mode Stations may be worked once on every band/mode combination (e.g 20CW,
20SSB, 20RTTY)
4 = no check Stations may be worked multiple times per band/mode and mode

Also used in MultByBand window to show modes (when 2 or 3) in Section window.

 
/Multiplier1Name/ = N/A*
See list below

/Multiplier2Name/ = N/A
See list below (mostly N/A if only one multiplier type is used)

/Multiplier3Name/ = N/A
See list below (mostly N/A if only one or two mult types are used)

Value Explanation

CountryPrefix Each country is a multiplier Example: DL, PA etc (uses WL_CTY.DAT)

WPXprefix Each Prefix is a multiplier (WPX rules)

Sect Each Section is a multiplier (Used for contests with multipliers such as ARRL
sections, provinces, or oblasts. A .sec file must be loaded with the button "Import
Section File" in the Contest Selection window. The /MultWindowType/ below should
match the name of .sec file)

ZN Each CQ Zone is a multiplier (max. 40)

MiscText Each misc.

Continent Each continent is a multiplier

GridSquare Each Grid Square is a multiplier

Comment Each Comment is a multiplier

N/A* There is NO multiplier (mostly only IsMultiplier2 and/or IsMultiplier3)

 
/Period/ = 2
1 2* How many days is the contest (not used at the moment)
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/PointsPerContact/ = 1*

any integer - default value for every contact (Points per QSO); several parameters in one line: OH,
5, SM, 5, SameContinent, 2, OtherContinent, 3 (NOTE: country prefixes should match those that
are in wl_cty.dat file and be the first in this line if used);
SSB, 2, CW, 3 - 2 points for SSB and 3 points for CW QSO;
160m, 5, 80m, 4, 40m, 3 - 5 points for QSO on 160m, 4 on 80m and so on;

Allowed bands: 160m, 80m, 40m, 20m, 15m, 10m, 6m, 4m, 2m, 1.25m, 70cm, 33cm, 23cm, 13cm,
9cm. The values for this parameter can be mixed, but if
the QSO meets two or more settings then priority will be: band, mode (CW/SSB), Continent,
Country.

/ShowMyCountryStations/ = True
True* Yes show My Country stations in the bandmap (normal)
False No don't show them in the bandmap

/ShowWarcBands/ = False
True Yes show the WARC bands (only for general logging (DX)
False* No don't show them (all contests)

/ZoneType/ = CQ
CQ* CQ type zones should be shown (for most contests)
IARU IARU type zones should be shown

/MultWindowType/ = Section

Value Explanation

State US states

StateProvince US states and Canadian Provinces are both valid entries

Province Canadian Provinces (or 13P)

Section* ARRL sections (or 48S14P, 48SDC14P, 49S8P, 50S8P, 50S10P, 50S13P,
50S13PCY0, 50S14P, 50SDC14P, 50SDC10P, 71SEC13WB, 50SDC13P,
50S13RAC, 50S9P, 50S11P, 50SNOLAB)

Province Netherlands Provinces (for PACC Contest)

DOK DOK letters letters: A to Z except Q for WAG contest

UBA ON contest

RFC GRIDs RFC contest

Oblast Russian oblasts

AnyName Prepare AnyName.sec file with the list of sections (look at any *.sec file for an
example)

 
/CQZoneMultContest/ = False
True Contest uses CQ zones as a second multiplier e.g. CQWW
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False* CQ Zones not used

/NumMults/ = 1
0 for Field Day or other contest with no multiplier
1* for most contests
2 for CQWW (i.e. Country and Zone)

/BonusPoints2/ = 5, BonusPoints.txt

This allows using the file with large number of Callsigns that should give bonus points.
Parameter format: BonusPoints2 = 5, BonusPoints.txt (points, file name); File name can be any
name like *.txt but the file has to be in the main logger folder ...\N1MM Logger\. Every callsign in the
file should have comma at the end:

<file starts>Call1, Call2, Call3, ..., LastCall,<file ends>

or

<file starts>
Call1,
Call2,
Call3,
...
LastCall,
<file ends>

Parameter BonusPoints2 extends BonusPoints but has higher priority, in other words if the callsign
will be found in BonusPoints string and also in the
file BonusPoints.txt then bonus point assigned for BonuPoints2 will be used. NOTE: do not try to
put too many callsigns into BonusPoints.txt file because this may cause some delays in logging the
contact.

/MultSqlString/ = Country, Band (example only)
There are 5 possible combinations:
1. MultSqlString = Country (new country will be counted as multiplier, same country later on any
other band will not)
2. MultSqlString = Country, Band (new country on each band will be counted as multiplier)
3. MultSqlString = Section (new section will be counted as multiplier, same section later on any
other band will not)
4. MultSqlString = Section, Band (new section on each band will be counted as multiplier)
5. MultSqlString = N/A* (no multipliers)

/MultSqlString2/ = N/A
Country (, Band) or Section (, Band) or N/A, i.e. no multipliers. See details above.

/MultSqlString3/ = N/A
Country (, Band) or Section (, Band) or N/A, i.e. no multipliers. See details above.

/QsoErrorString/ = Any (This defines what the program expects in the exchange field; if, for
example, you specify Numeric and your entry contains a letter, then you'll be warned and the QSO
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will not be logged unless you use Ctrl+Alt+Enter to force it)
Numeric - only numbers allowed (like serial number) 12 characters max
Any* - both numbers and letters allowed (12 characters max)
Grid - Grid Square Text, 4 or 6 characters

/LogInfo/ = SentReport, 500, SentNR, 500, ReceiveReport, 500, NR, 500, Points, 500 (adjust the
field names and default column widths for the Log Window by adding/deleting relevant name and
spacing, delimited by commas. Only the names listed below are allowed. Note that the "width"
value is specified in very tiny increments.

Possible field names: SentReport, SentNR, ReceiveReport, NR, IsMultiplier1, IsMultiplier2,
CountryPrefix, GridSquare, Exchange1, MiscText, Points, opname, Comment

 
/FrameText/ = SntRpt SntNR RcvRpt NR
These are the names displayed on top of each field of Entry Window, except for the callsign. Adjust
the field names and spacing for the frame text by adding/deleting spaces in this line. Any names
allowed, but your choices will affect the minimum possible width of the Entry Window.

/EntryWindowInfo/ = SNTText, 500, SntNrText, 700, RCVText, 500, Exchange1Text, 500 (adjust the
field names and default column widths for the Log Window by adding/deleting relevant name and
spacing, delimited by commas (only names below are allowed)
SNTText, SntNrText, RCVText, RcvNrText, GridSquareText, Exchange1Text, CommentText, NameText

Following is a list of Possible EntryWindow Items, followed by the width normally used and the
maximum length (in characters:

Name Width
Max.
Length

Comment

SNTText 450 10 Sent exchange field

RCVText 450 15 Received exchange field (default 59 or 599)

NameText 855 20 Name field, only letters allowed

CommentText 1695 60 Comment field, space allowed so SPACE as tab does not work
here!!

SntNrText 625 5 Sent following number field, autonumber by program

RcvNrText 625 5 Received following number field, only numbers are allowed!!

Exchange1Text 615 12 Exchange field, both numbers and letters allowed.

GridSquareText 600 6 textbox for Grid squares

They are called Twips. By default, all Visual Basic movement, sizing, and graphical-drawing
statements use a unit of one twip. A twip is 1/20 of a printerÃ¢â‚¬â„¢s point (1,440 twips equal
one inch, and 567 twips equal one centimeter). These measurements designate the size an
object will be when printed. Actual physical distances on the screen vary according to the
monitor size. Aren't you glad you asked?

What are those tiny increments?
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Name Width
Max.
Length

Comment

MiscText 600 15 Misc textbox

 
/DefaultContestExchange/ = 001*
this will show up in the contest selection window for editting. It may have two parts like this: "001
Prov", "001 NA123". If the first part is 001 the logger wil generate serial number for every QSO and
the second part will be send with the number unchanged (button F2)

/CabrilloFormat/ = 99
1*= standard (use 0 if Cabrillo is not supported)
2 = NAQP format
3 = NASPRINT format
4 = SS (SweepStakes)
5 = RFC contest
99 = handcoded, uses CabrilloString (see below)

/CabrilloString/ = SNT, 4, SentNR, 4, CallSign, 13, RCV, 4, RcvNr, 4, Comment, 40
Format: value1 name, value1 width, value2 name, value2 width, ...
Will work with: SNT, SentNr, CallSign, RCV, RcvNr, Comment, GridSquare, Exchange1, Name,
SentExchPart1, SentExchPart2

/IsWorkable/ = ExceptMyCountry
Any*, MyCountryOnly, ExceptMyCountry, list of countries (prefixes) separated by comma: UA2,
UA1, UA0.
In the last case, make sure you are using correct prefixes

/SpecialInstructions/ =Special Instructions...
Any text terminated by CR/LF
This message will show up after Cabrillo file was generated - use it for a reminder. Leave it empty if
not needed.

/DupeSqlString/ = 0
Select clause that will uniquely identify a dupe: 0*- turns it off, 1 - use Section, 2 - use whatever is
in ExchangeText
This is needed for QSO parties where you can have mobile stations in different counties

/StartOfContest/ = 7, 1.5 (example only, no default)
First number - day of week (Sunday=1, Monday=2,....., Saturday=7)
Second number - offset in hours (1.5 = 1 hour and 30 minutes) relative to GMT(e.g., if the contest
starts at 00.00 GMT the offset should be 0. This will be used to calculate OFF times.

/EndOfContest/ = 1, 1.5 (example only, no default)
Same format as for StartOfContest. This will be used to calculate OFF times

/IsMultPer/ = 2
NoMults = 0*, OncePerBand = 1, Oncepermode = 2, OncePerBandAndMode = 3, OncePerContest
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= 4

/MinimumOffTime/ = 30*
Min. Off time in minutes

/UsesWAECountries/ = False*
Answer whether this contest uses countries with '*' in cty.dat (e.g. for CQWW it should be True)

/SetSentTimeForContact/ = False*
Used to set Sent Time in contests that require it. See CBARGT for use

/ScoreSummaryMultNames/ = "Mult"
Used to set Mult Headings in Score Summary Window

/WebAddress/ = http://www.srr.ru/CONTEST/cup_raem_engl_08.php
web address for the contest rules

/GenericPrintString/ = SNT, 4, SentNr, 0, CallSign, 15, RCV, 4, RcvNr, 0, Comment, 12
Format: value1 name, value1 width, value2 name, value2 width, ...
Will work with: SNT, SentNr, CallSign, RCV, RcvNr, Comment, GridSquare, Exchange1, Name,
Points, SentExchPart1, SentExchPart2. This will configure Generic file that can be used instead of
Cabrillo

/GenericPrintStringHeader/ = Date Time Freq Mode MyCall RST Snt Call RST Rcvd Comment
Adjust the names and number of spaces here according to the values in GenericPrintString (above)

/MultiplierBands/ =2
1*= All HF Contest Bands
2 = All HF Bands
3 = All HF Contest Bands plus 6 meters and 2 meters
4 = All VHF Bands

/ResetMultsEverySession/ = 0*

When MultipleSessions is used, this parameter will allow multipliers reset in the beginning of every
new time session if set to 1.

/DigitalModeSqlString/ = False*
Used to merge RTTY and PSK into one digital contest mode

/MultipleSessions/ =
*Leave it empty if the contest time is not broken into sessions
0000/30 - starting at 00:00 UTC, sessions = 30 minutes
0000/60 - starting at 00:00 UTC, sessions = 60 minutes
0000/200 - starting at 00:00 UTC, sessions = 2.00 hours
It is OK to use 0000 for contest start time if it starts in the beginning of any other hour and sessions
are < or = 60 minutes. Dupes will be allowed when new session starts and the Multipliers window
will be cleared when the first contact is made logged in the new session.

/DoNotCountMeAsMult/ = False
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True Do not count Multiplier1 for my Country, Section
or WPX prefix (depends on what was set as MultSqlString)
False* Count Multiplier1 for my Country, Section or WPX
prefix.

/DoNotCountMeAsMult2/ = False
True Do not count Multiplier2 for my Country, Section or WPX prefix (depends on what was set as
MultSqlString2)
False* Count Multiplier2 for my Country, Section or WPX prefix.

/DoNotCountMeAsMult3/ = False
True Do not count Multiplier3 for my Country, Section or WPX prefix (depends on what was set as
MultSqlString3)
False* Count Multiplier3 for my Country, Section or WPX prefix.

These parameters simply block counting your Country, Section or WPX prefix as a multiplier.
NOTE: they will not be removed from the Multipliers window.

 

Contest Setup Instructions

 

In this Section...

Contest Setup Instructions
1. General
2. General contest logging

2.1. DX log
2.2. DXpedition
2.3. DXSERIAL
2.4. DX satellite
2.5. VHFDX
2.6. VHFSERIAL

3. Deleted QSOs
4. HF CW/SSB contests

4.1. 9A CW contest
4.2. AGCW
4.3. All Asian CW / SSB
4.4. Asia Pacific Sprint CW / SSB
4.5. ARCI QRP Contests & Michigan QRP Contest
4.6. ARI International DX Contest
4.7. ARRL 10 Meter contest
4.8. ARRL 160 Meter contest
4.9. ARRL Field Day contest
4.10. ARRL International DX contest CW / SSB
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4.11. ARRL November Sweep Stakes CW / SSB
4.11.1. Entering Exchanges

4.11.1.1. Correcting what you copied
4.12. ARRL Rookie Roundup
4.13. Asia Pacific Sprint Contest CW / SSB
4.14. Baltic contest
4.15. Black Sea Cup International
4.16. CNCW Spanish contest
4.17. CQ M International DX contest
4.18. CQSA SSB Contest
4.19. CQ 160 Meter DX contest CW / SSB
4.20. CQ World Wide DX contest CW / SSB
4.21. CQ World Wide WPX contest CW / SSB
4.22. CIS contest - CW / SSB
4.23. Cup of the Russian federation RFC contest CW / SSB
4.24. CWops Mini CWT
4.25. DARC 10 meter contest
4.26. DARC Weihnachtswettbewerb XMAS contest
4.27. DIG contest CW / Phone
4.28. Elecraft QSO Party
4.29. European Sprint CW/ SSB
4.30. EU HF Championship
4.31. Field Day Region 1
4.32. FOC marathon
4.33. GACW WWSA CW DX contest
4.34. Gagarin Cup
4.35. HA DX Contest
4.36. Helvetia Contest
4.37. High Speed CW Contest
4.38. Holyland Contest
4.39. IARU Radiosporting contest HF
4.40. IOTA Islands On The Air Contest
4.41. International Naval Contest
4.42. JA domestic contests
4.43. JIDX contest
4.44. JT DX Contest
4.45. King of Spain Contest
4.46. Logbook of the World Contest CW / SSB
4.47. LZ DX Contest
4.48. LZ Open and LZ Sprint Contests
4.49. Manchester Mineira Contest
4.50. Michigan QRP Contest
4.51. MiniTest CW Test
4.52. NA Sprint CW / SSB
4.53. NSSprint and Sprint Ladder
4.54. NAQP North American QSO Parties CW / SSB
4.55. NRAU Baltic Contest
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4.56. Oceania Contest
4.57. OK OM DX contest
4.58. PA beker contest
4.59. PACC contest
4.60. Portugal Day Contest
4.61. QCWA QSO Party
4.62. RAC Canada Day Contest / RAC Canada Winter Contest
4.63. RAEM CW contest
4.64. REF contest CW / SSB
4.65. RF Championship
4.66. RSGB 160 Meter CW Contests
4.67. RSGB 21/28 MHz contest
4.68. RSGB 80 Meter Club Championship
4.69. RSGB Affiliated Societies Team Contests AFS
4.70. RSGB Club Calls contest
4.71. RSGB Commonwealth contest
4.72. RSGB SSB Field Day & RSGB National Field Day
4.73. RSGB Low Power Field Day
4.74. RSGB ROPOCO
4.75. Russian District Award contest
4.76. Russian DX contest
4.77. Russian Radiosport Team Championship
4.78. Russian YL/OM contest
4.79. SAC contest CW / SSB
4.80. Spanish Towns contest
4.81. SPDX contest
4.82. Stew Perry Topband Distance Challenge
4.83. Scandinavian Young Ladies Radio Association SYLRA
4.84. UA1DZ Memorial Cup
4.85. UBA contest CW / SSB
4.86. UBA ON contest
4.87. UBA Spring
4.88. UBA Low Band Winter
4.89. Ukrainian Championship
4.90. Ukrainian DX contest
4.91. UK DX contest CW / SSB
4.92. UN DX Contest
4.93. Independence of Venezuela Contest
4.94. WAEDC contest CW / SSB
4.95. WAG contest
4.96. World Wide Peace Messenger Contest
4.97. WRTC contest
4.98. YO HF DX contest

5. QSO Parties
5.1. Same weekend: 7QP, Indiana QSO Party, New England QSO Party, and
Zeroland QSO Party
5.2. FL QSO party
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5.3. PA QSO party
5.4. MARAC QSO Party
5.5. Updating and importing the QSO party sections

6. VHF and Up contests
6.1. ARRL January VHF Sweepstakes
6.2. ARRL June VHF QSO Party
6.3. ARRL September VHF QSO Party
6.4. IARU Region 1 contesting - 50 MHz, VHF, UHF/Microwaves
6.5. Marconi CW contest
6.6. NAC Activity Contest
6.7. REF Departments contest 50 Mhz
6.8. VHF/UHF Helvetia 26 contest
6.9. VHF HG OB contest
6.10. VHF UA1DZ Cup
6.11. VRZA - Nederlandse Locator Contest - WANLC
6.12. YU DX Contest
6.13. UKSMG sporadic-E competition

7. Digital contests - RTTY/PSK31
7.1. ANARTS WW RTTY contest
7.2. ANATOLIAN RTTY contest
7.3. ARRL RTTY Roundup
7.4. BARTG Spring RTTY contest
7.5. BARTG RTTY Sprint contest
7.6. CQ World Wide DX contest - RTTY
7.7. CQ World Wide WPX contest - RTTY
7.8. CIS contest - RTTY
7.9. DCRG Long Distance RTTY contest
7.10. DL DX RTTY contest
7.11. DMC RTTY contest
7.12. EA PSK31 contest
7.13. EA RTTY contest
7.14. EPC PSK63 QSO party
7.15. EPC PSK World Wide DX contest
7.16. EU PSK DX contest
7.17. JARTS WW RTTY contest
7.18. JT RTTY DX Contest
7.19. Makrothen RTTY Contest
7.20. Logbook of the World Contest - RTTY/Digital
7.21. NA Sprint RTTY
7.22. North American QSO Parties RTTY - NAQP
7.23. OK DX RTTY Contest
7.24. Quick PSK63 Contest
7.25. Russian PSK DX Contest
7.26. Russian DX RTTY contest
7.27. Russian Cup RTTY contest
7.28. SARTG New Year RTTY Contest
7.29. SARTG WW RTTY Contest
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7.30. SCC RTTY Championship
7.31. SP DX RTTY contest
7.32. TARA Grid Dip contest
7.33. TARA PSK Rumble
7.34. TARA RTTY Melee
7.35. Ukraine Open RTTY Contest
7.36. Ukrainian RTTY contest
7.37. UR DX DIGI Contest
7.38. UK DX contest RTTY
7.39. VOLTA RTTY Contest
7.40. WAEDC contest
7.41. XE RTTY Contest

1. General

When a contest has a specific mode (SSB, CW or RTTY) then the Mode Category is automatically
changed to that mode. So when you select CQWWSSB for the CQ World Wide SSB contest the
Mode Category will be set by the program to SSB. You can change this but that will give wrong
Cabrillo output and maybe even erroneous behavior of the program, so don't!!
If the selected contest doesn't have a specific mode the program will set the Mode Category to
MIXED.
Also the radio will be set on all bands to the mode set. The frequency though is not being changed
to the CW/SSB/RTTY section of the band.

This is a contest program but for general logging you can use DX as the selected contest if you
want. Dupes are allowed and an exchange is not necessary.
To import a contest into your regular logging program use ADIF export (and ADIF import in your
general logging program).

When going through the possible contests you will see a "contest" DELETEDQS.
This is not a contest but deleted QSOs will be put in here by the program, this is especially for
multi-user support. Deleted QSOs in this contest can be exported.

The maximum receive number is 99999 (for serial number contests). Check out info about the serial
number server in the chapter Advanced Functions .

2. General contest logging

 

2.1. DX log

Always read the instructions from the contest committee prior to the contest. Then you know
how to set up the program, what exchange to give and what to expect in return, which hours to
operate etc.

Read the Contest Instructions!
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Window: Select Log type

Log Type: DX
Mode Category: MIXED If you want to have the possibility of making SSB and CW contacts

 
For general or DX logging.

Entered QSOs in General log (or DX log) don't need to have an exchange
Dupes are shown by the word Dupe! but the qso can be logged

2.2. DXpedition

Window: Select Log type

Log Type: DXPEDITION
Mode Category: MIXED If you want to have the capability of logging SSB and CW contacts

 
For DXpedition logging

Entered QSOs in the DXPEDITION log don't need to have an exchange
Dupes are shown by the word Dupe! but the QSO can be logged

2.3. DXSERIAL

Window: Select Log type

Log Type: DX SERIAL
Mode Category: MIXED If you want to have the possibility of making SSB and CW contacts.

 
For general Serial Number contest logging

Entered QSOs in DXSERIAL don't need to have an comment
Dupes are shown by the word Dupe! but the QSO can be logged
'Standard' points calculation; 1 point per qso, DXCC countries are counted

All other kind of multiplier and point calculations have to be done by hand
This for all not supported serial number contests

2.4. DX satellite

Window: Select Log type

Log Type: DXSATELLIT
Mode Category: MIXED If you want the capability of logging SSB and CW contacts

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

505 of 680 2/2/2011 4:54 PM



 
For Satellite logging.

Entered QSOs in the DXSATELLIT log don't have an exchange and don't need to have a grid
When a grid is entered it needs to be 4 or 6 characters long
Dupes are shown by the word Dupe! but the QSO can be logged

 

2.5. VHFDX

Window: Select Log type

Log Type: VHFDX
Mode Category: MIXED If you want to log both SSB and CW contacts

 
For VHF and up logging.

Entered QSOs in VHFDX don't need to have a grid
When a grid is entered it needs to be 4 or 6 characters long
Dupes are shown by the word Dupe! but the qso can be logged
Bearing info is shown in the log window and saved in the Misc field
Distance info is shown in km in the log window and saved in the Points field

 

2.6. VHFSERIAL

Window: Select Log type

Log Type: VHFSERIAL
Mode Category: MIXED If you want to log both SSB and CW contacts

 
Comments needs to be added using Ctrl+N. There is no room left in the Entry Window to add a
separate field for it. Comments will be shown in the log window and added to the Cabrillo and
generic output reports

For VHF and up logging

Entered QSOs in VHFSERIAL don't need to have a grid
When a grid is entered it needs to be 4 or 6 characters long
Dupes are shown by the word Dupe! but the QSO can be logged
Bearing info is shown in the log window and saved in the Misc field
Distance info is shown in km in the log window and saved in the Points field
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3. Deleted QSOs

DELETEDQS "contest"

QSOs which are deleted from other logs using 'Edit Contact' are moved to this 'contest'.
This is especially important for multi-user support. The moved QSOs can be exported.

4. HF CW/SSB contests

 

4.1. 9A CW contest

The 9A (Croatian) CW contest is a CW only contest.

Window: Select Log type
Log Type: 9ACW
Mode Category: CW
Sent Exchange: 001

 

4.2. AGCW

CW-only, on New Year's Day

Window: Select Log Type
Log Type: AGCW
Mode Category:CW
Sent Exchange: 001

 

4.3. All Asian CW / SSB

The All Asian contest can be used by Asian stations and DX stations.

Window: Select Log type
CW

Log Type: ALLASIACW
Sent Exchange:Your age Example: 34

XYL and YL stations may give 00
SSB

Log Type: ALLASIASSB
Sent Exchange:Your age Example: 34
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XYL and YL stations may give 00

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are an Asian station or a non-Asian station.

4.4. Asia Pacific Sprint CW / SSB

The Asia-Pacific Sprint contest can be used by Asia-Pacific stations and DX stations.

Window: Select Log type
CW

Log Type: APSCW
Sent Exchange:001

SSB
Log Type: APSSSB
Sent Exchange:001

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are an Asia-Pacific station or a DX station.

4.5. ARCI QRP Contests & Michigan QRP Contest

The ARCI contest supports 7 ARCI QRP Contests. The Michigan QRP Contest almost has the same
rules. Several other QRP contests use the same exchange type, although the scoring may be
different.

Window: Select Log type
Log Type: ARCI
Mode Category:

CW
for Spring QSO party ; HootOwl Sprint ; Summer Homebrew Sprint ; Fall Qso
Party ; Holiday Spirits ; Michigan QRP Contest

SSB
for Winter Fireside

MIXED
for Topband Sprint

Sent Exchange:
First Part

State abbreviation for USA stations. Example: CT
Province abbreviation for VE stations. Example: ONT
Country abbreviation for non US or VE stations. Example: DL

Second Part
ARCI number for ARCI members
Send power for non-ARCI members
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Log Window: Mult = DXCC Mult2 = Section (State or Province) Example: CT
Power is recognized being a non numeric number. Example: 100W is power, 100 is a member
number
There is a check on provinces and states, no check on countries. The program will give a
proposal for the country prefix if non VE or K
No calculations made for power multi or Bonus Points, this has to be done by the operator
after the contest on the summary sheets
Select CW, SSB or MIXED as 'mode Category 'to have the multiplier window work correct
It is allowed by the program that stations work each other in the contests in both modes even
when only CW or SSB is allowed according the rules. I assume the operator knows the rules...

 

4.6. ARI International DX Contest

The ARI International DX contest can be configured for Italian stations and DX stations.

Window: Select Log type
Log Type: ARIDX
Sent Exchange:

001 for non-Italian stations
Your Province for Italian stations

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are an Italian station or a DX station.

4.7. ARRL 10 Meter contest

The ARRL 10M contest can be used by K/VE stations and DX stations.

Window: Select Log type
Log Type: ARRL10M
Sent Exchange:

Your state/province - for K/VE stations Example: NY
001 - for DX stations (non K/VE)

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a DX station or a W, KH6, KL7, VE station.

All non-28 MHz spots are marked as unworkable.

4.8. ARRL 160 Meter contest
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The ARRL 160M contest can be used by K/VE stations and DX stations.

Window: Select Log type
Log Type: ARRL160 (not ARRL160M if shown)
Mode Category: CW
Sent Exchange:

ARRL/RAC section - for ARRL/RAC stations Example: VI
<nothing> - DX stations don't need to enter anything here (non K/VE), DX stations
only send a report, no further exchange.

 
The callsign in the Station Information dialog (>Config >Change Your Station Data >Call)
determines if you are a DX station or an ARRL/RAC station.
The ARRL/RAC stations can be found at http://www.arrl.org/contests/sections.abv.html

The contest module accepts for /MM and /AM stations as ITU zones: R1, R2 or R3.

All non-160 meter spots are marked as unworkable.

4.9. ARRL Field Day contest

The ARRL Field Day contest can only be used by US (K, KL and KH) & Canada stations (i.e. there
are more FD contests outside the US & Canada which are not supported).

Window: Select Log type
Log Type: FD
Sent Exchange:

Your Class Your section

 
Here is word from Dan Henderson from the ARRL contest branch on using Cabrillo for your log
submission.

Field Day is not included in the Cabrillo format. It has no way to mark/indicate power sources, GOTA
station callsigns, bonus points, NTS traffic messages, etc. Also, Field Day only requires Dupe
Sheets, not full logs. It is perfectly acceptable to include the Cabrillo log in lieu of the Dupe Sheets,
but Field Day must have a completely filled out Summary sheet that includes all necessary
information. This can be done with a "reasonable facsimile" electronically. However, since "proofs of
bonus" (i.e. copies of letters to newspapers, visitor logs, photos, etc) are abundantly provided, most
people find it easier to do Field Day via the regular mail - and use a combined system of
part-electronic added to the paper summaries. Anything received electronically for Field Day will be
receipted but we may have to manually follow up if we can't get the basic required information from
the email.

73' Dan Henderson, N1ND

Here are some logging tips from Jim, VE7FO
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Q: I always have a problem with the FD GOTA log. Besides just logging the QSO, I also need to ID
the operator, the operators age and the GOTA coach. This has always been difficult to reconstruct
after the fact. Any body else seen this?

A: Just give the GOTA coach the following responsibilities: When a new op comes on have him hit
CTRL-O and enter his call or name followed by his a space and his age. This gets 2 of the vital
pieces of info into the log. Require the coach to keep a log of his on and off times at the GOTA
position; or you could add the coach's call at the end of the CTRL-O stuff too. You'll have to
increase the width of the operator column in the log.

4.10. ARRL International DX contest CW / SSB

Window: Select Log type
CW

Log Type:ARRLDXCW
Mode Category: CW
Sent Exchange: Your state/province - for K/VE stations Example: NY
Sent Exchange: Power - for DX stations (non K/VE) Example: 200

SSB
Log Type:ARRLDXSSB
Mode Category: SSB

 

Sent Exchange: Your state/province - for K/VE stations Example: NY
Sent Exchange: Power - for DX stations (non K/VE) Example: 200

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a DX stations or a W/VE station.&&&
The default power for DX stations is:

100 Watts - Default
200 Watts - For the following countries: UA, UA2, UA9, UK, UN, UR, R1FJ, R1MV
400 Watts - For the following countries: G, GM, GI, GD, GM, GM/s, GW
500 Watts - For the following countries: I, IS, IT9

 
Give 'Space' when the cursor is in the callsign field to have the 'Power' field filled with the default
power. The default power will only be entered when the Power filed is empty. If you type another
power level, it will replace the default power that the program put in there.

Some stations give K or KW for 1000 watts. You don't have to enter 1000, just type K. The log
checking software from the contest committee will understand.

Call History for DX stations: When Call History is selected and a file is imported with US callsigns
and States, the bandmap will be checked against the log and the callhistory and colored for mults
when needed. So incoming spots will be colored when they are a qso, dupe or mult and found in
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the log or callhistory.

4.11. ARRL November Sweep Stakes CW / SSB

Window: Select Log type
CW

Log Type: SSCW
Mode Category: CW
Sent Exchange: Precedence Year first licensed ARRL/RAC section Example: B 70
EMA (and in this order!)

F5 key: !
F2 key: Right click on the CW message buttons and change F2 to: # B 70
EMA.

If you have separate run & S&P buttons, you may have to do it twice.

SSB
Log Type: SSSSB
Mode Category: SSB
Sent Exchange: Precedence Year first licensed ARRL/RAC section Example: B 70
EMA (and in this order!)

F5 key: !
F2 key: Normally, you can plan on voicing callsigns and serial numbers and
then pressing F2 for the rest of a pre-recorded exchange message,
beginning with your precedence. with practice, this sounds very smooth.

 

 

4.11.1. Entering Exchanges

 
Entering the exchange in Sweepstakes is different than for any other contest because SS uses a

Sweepstakes is unlike other serial number contests in that it does not require you to enter "001"
in the Sent Exchange. In fact, you must not do that. Instead, use the # macro in F2 on CW, and
nothing about the serial number in the Sent Exchange.

 

We do not recommend using voicing of serial numbers in SSB contests, because experience
has shown that serial numbers enunciated as "one two three one", no matter how skillfully
recorded, are never as easily understood as "one thousand two hundred thirty one." If you want
to explore voicing of serial numbers or callsigns, click here.

Don't put a serial number in your Sent Exchange
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five part exchange (call, nr, prec, ck, section). After you enter the call and move to the Exchange
window (either by ESM or by pressing the Space Bar) you will enter all five in one window, and the
program will do its best to interpret what you enter

If you use a Call History file in Sweepstakes (don't forget to check Call History Lookup on the Config
menu), when you enter a callsign that is in the file, it will pre-fill the Check (CK) and Section (SEC)
for you and position the cursor one space behind the pre-filled information. All you need to do,
then, is type the Serial Number and Precedence as you copy them. They look like they are in the
wrong order, but look above the Exchange textbox for the line of small black type. You'll see it in the
correct order, as it will be entered in your log.

You do not need to type the call again unless you had it wrong the first time, in which case you'll
see the program magically correct it (again in the small black type. If the program thinks there may
be a problem, it tries to signal that by changing the type color to blue, so be aware of that. If
something is screwed up, we recommend backspacing to the point where the exchange (or part of
one) looks right again, and then re-entering the information. You should never have to wipe, or
highlight and hit Delete.

There are a couple of important rules. You must always enter the Serial Number and Precedence
as a single element - e.g. "23B" not "23 B". This helps the program tell a check from a serial
number. Otherwise, you should put a space between elements, although you may copy Check and
Section together. It is probably a good habit to get into, because when you need to correct
something you have copied (see below) you'll need to do this.

Example of playing WAV files using ESM.

Put a single space in the message column of the F5 line of the SSB function key table.

Speak the callsign of the station you're working and press Enter. Your exchange.wav file should be
something like "Bravo, N1MM, Check 61 Connecticut"

4.11.1.1. Correcting what you copied

 
This is where N1MM Logger gives you a real advantage in Sweepstakes. The basic idea is that you
never have to tab or space back to the Callsign field, or to space back in the Exchange field, to
make corrections. The basic rule is simply to type your correction at the end of the Exchange string
you have already copied. This includes callsigns.

There are a couple of constraints, which we hope to get rid of, but probably not before SS SSB.
Here are easy rules you can apply to help with proper parsing:

When you are correcting a Callsign in the Exchange field - make sure you set it off with
spaces.

 

However, the best way to enter other data, whether initially or as corrections, is in what N2IC
(our resident SS champion and guru) christened "couplets". If you need to enter or correct a
Serial Number, enter it with the Precedence, without a space between - e.g "99B", not "99B".
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Similarly, enter the Check and Section as another "couplet" - e.g., "54WV", not "54 WV". If
you do this, we don't think you will be able to make the parser get it wrong.

 
Give it a try before you get into the heat of battle, and see if you can break it. If you can, please let
us know.

4.12. ARRL Rookie Roundup

Rookies (operators licensed 3 years or less) work everyone; non-rookies work only rookies. Rookie
status is determined by the 2-digit licensing year as entered in the Sent Exchange field of the
Contest Setup Window (reached by File > New Log in Database or Open Log in Database). BOB 08
WV in the Sent Exchange field tells the program Bob's a rookie; BOB 54 WV tells it he's not.

You do not need any special suffix on rookie calls (do not use /ROK. This is a rule change since the
first running). Rookies are encouraged to call "CQ Rookie Roundup" on phone and "CQ RR" on CW
and digital modes. Non-rookies should call "CQ Rookies" on phone and "CQ R" on CW or digital
modes. A sample CW function key definition (macro) file is here . The macros are set for Rookies,
non-rookies will need to change the CQ RR to CQ R.

Log the exchange in order — name, 2-digit year, and state. Check the space immediately above the
exchange field, where the program will indicate how it has "parsed" the exchange, and correct if
necessary. 4-digit years should not be sent or logged - it will only cause confusion

Score summaries are due within 72 hours of the end of the contest - 2359 Wednesday evening
UTC, or 1859 EST. Use the score form on the ARRL website . ARRL says logs are not required or
accepted.

Window: Contest Setup
Make sure that you have entered your 2-digit licensing year in the Sent Exchange
field.

Select Log Type
Log Type: RRSSB, RRRTTY, RRCW (pick the appropriate one)
Sent Exchange: Name, two-digit check (year first licensed), and State or Canadian
Province, Mexican call area (XE1-4), or DC (examples: PETE 54 WV, BOB 67 XE1,
MARY 09 NU, ANN 10 DX

 

4.13. Asia Pacific Sprint Contest CW / SSB

Window: Select Log type
CW

Log Type: APSCW
Mode Category: CW (spring and fall)
Sent Exchange: 001

SSB
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Log Type: APSSSB
Mode Category: SSB (summer)
Sent Exchange: 001

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a DX stations or an Asia-Pacific station.

4.14. Baltic contest

The Baltic contest can be configured for stations from the Baltic countries (ES, YL, LY) and DX
stations.

Window: Select Log type
Log Type: BALTIC
Sent Exchange: 001

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a DX station or a Baltic station.

4.15. Black Sea Cup International

 

Window: Select Log type
Log Type: BSCI
Mode Category: MIXED
Sent Exchange: ITU Zone

HQ stations: IARU society abbreviation
BSCC members: membership number, e.g. BS17

 

4.16. CNCW Spanish contest

The CNCW contest (EA CW NATIONAL CONTEST) is only for Spanish stations operating inside the
national territory.

Window: Select Log type
Log Type: CNCW
Mode Category: CW
Sent Exchange: Spanish Province letters Example: SG
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4.17. CQ M International DX contest

Window: Select Log type
Log Type: CQM
Mode Category: Select what category you enter (SSB, CW or Mixed)
Sent Exchange: 001

4.18. CQSA SSB Contest

This contest uses the Cabrillo 3.0 log file format so be careful to check the Contest Setup
Window (File > Open Contest) to make sure you have filled in appropriate entry class, etc.

 

4.19. CQ 160 Meter DX contest CW / SSB

 

Window: Select Log type
CW

Log Type: CQ160CW
Mode Category: CW

SSB
Log Type: CQ160SSB
Mode Category: SSB
Sent Exchange:

Your state/province - for K/VE stations Example: NY
Your country abbreviation - for DX stations (non K/VE)

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a DX stations or a W/VE station.

All non-160 meter spots are marked as unworkable. Spots are marked with state from call history
lookup as mults (if needed) in Bandmap and Available windows.

4.20. CQ World Wide DX contest CW / SSB

Window: Select Log type
CW

Log Type: CQWWCW
Mode Category: CW
Sent Exchange: Your zone Example: 14

SSB
Log Type: CQWWSSB
Mode Category: SSB
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Sent Exchange: Your zone Example: 14
The default zone values for US (K,N,W,A) stations are

Zone 3 - If number in callsign is 6 or 7
Zone 4 - If number in callsign is 5 or 8 or 9 or 0
Zone 5 - If number in callsign is 1 or 2 or 3 or 4

The default zone values for Canadian (VE) stations are
Zone 1 - If callsign starts with: VY1
Zone 2 - If callsign starts with: VE2, VO2
Zone 3 - If callsign starts with: VE7, VC7
Zone 4 - If callsign starts with: VE3, VE4, VE5, VE6, VA3
Zone 5 - If callsign starts with: VO1, VE1, XJ1, VY2

Give 'Space' when the cursor is in the 'Callsign' field to have the 'Zone' field filled with the
default value
The default zone will be selected, so that if you type another zone, it will replace the numbers
that the program put in there
For US users, Ctrl+Up/Ctrl+Dn doesn't stop at US stations
US spots are not grayed out for Canadian users
Don't show and count own countries as workable in the Bandmaps and the Available window
A new zone will be shown in red in the Entry window
Band changes

The allowed band changes are 8 for all CQ Contests
The band change counter is reset to 0 on first contact after the top of the hour

The program will look up the zone if the call has been changed, provided no zone was typed
by the user

4.21. CQ World Wide WPX contest CW / SSB

Window: Select Log type
CW

Log Type: CQWPXCW
Mode Category: CW
Sent Exchange: 001 i.e Serial number Example: 001

SSB
Log Type: CQWPXSSB
Mode Category: SSB
Sent Exchange: 001 i.e Serialnumber Example: 001

Leading zeros are being forced on sent & received serial numbers
Multi-Single and Multi-Two entries have a single set of serial numbers across all bands; per
the rules, in multi-single a single sequence of serial numbers is generated regardless of band.
Band changes (per hour)

The allowed band changes are 8 for all CQ Contests
The band change counter is reset to 0 on first contact after the top of the hour

 

4.22. CIS contest - CW / SSB
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The Commonwealth of Independent States Contest where everybody can work everybody for QSO
and multiplier credit.

Window: Select Log type
Log Type:

CW: CISCW
SSB: CISSSB

Sent Exchange:
CIS stations: CIS area code Example for Moscow City: RU11
Non-CIS stations: 001

 

4.23. Cup of the Russian federation RFC contest CW / SSB

The RFC Contest is an internal Russian contest only between Russian stations.

Window: Select Log type
Log Type:

CW: RFCCW
SSB: RFCSSB

Sent Exchange:Grid Example: 115

 

4.24. CWops Mini CWT

Monthly mini-contests

Window: Select Log type
Log Type: CWOPS
Mode Category: CW
Sent Exchange:

Name and membership no. (members)
Name and state/province/country (non-members)

 

4.25. DARC 10 meter contest

Window: Select Log type
Log Type: DARC10M
Mode Category: MIXED or CW (depends on the entry class)
Sent Exchange:

DL stations:DOK Example: A12
non DL stations: empty
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Call history lookup for DOK's is supported. Make a text file with Call and DOK and import this in the
program. See the chapter Before the Contest for information how to use Call History and how to
create the text file. During the contest "Call History Lookup" has to be enabled under the Config
menu. When a station (which is in the Callhistory lookup table) is entered, pressing SPACE when
the cursor is in the callsign field will enter the DOK in the section field.

The contest manager from the DARC 10 meter contest approved and will accept the files made by
N1MM logger and likes to receive:

File How to make... Exported

Log file >File >Export >Export to File (Generic) >Generic File Output
sorted by time

[callsign].txt

Summary
sheet

>File >Export >Print Score Summary to File [callsign].sum

 

Send the "Generic File Output sorted by time" as a txt-File named with your call like
DL8WAA.TXT
Don't forget your used own call, category and if you are a DL station: own sent DOK. This can
be put in the Email or sent in the Cabrillo file.

 

4.26. DARC Weihnachtswettbewerb XMAS contest

The DARC Weihnachtswettbewerb is a contest on December 26 from 08.30-10.59 UTC between any
station on 40 and 80 meters.
The DARC contest manager for the Xmas contest accepts the standard generic file as log together
with the summary sheet..

Window: Select Log type
Log Type: XMAS
Mode Category: MIXED
Sent Exchange:

DL stations:Serial number + DOK Example: 001 A12
Non-DL stations: Serial number Example: 001

 
During the contest info about suspicious DOK's are shown in the info bar and written to the Notes
filed.&&&
After the contest check >View >Notes for the following situations:

"DL station non DARC member" - no DOK is given (DL station who is not a DARC member)
"DL station with DOK length 1" - DOK length is only one
"DOK with only numbers" - no letters in DOK
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4.27. DIG contest CW / Phone

Window: Select Log type
Log Type:

CW: DIGCW
SSB: DIGSSB
Sent Exchange: anything as it is not being used (DIG members could enter their
DIG number here)

 

4.28. Elecraft QSO Party

 

Window: Select Log type
Log Type: EQSO
Mode Category: Mixed
Exchange: State/Province/Country, Rig code + Rig serial number, or Power (non-elecraft
rigs)

e.g. K3 serial #1234 would send 31234

 

4.29. European Sprint CW/ SSB

Window: Select Log type
CW

Log Type: EUSCW
Mode Category: CW
Sent Exchange: Serialnumber & Operator name Example: 001 Tom

SSB
Log Type: EUSSSB
Mode Category: SSB
Sent Exchange: Serialnumber & Operator name Example: 001 Tom

 
Example: The Exchange key (F2) can look like this: de * # {Exch} where "#" is current QSO Number
and "{Exch}" is the Operator name.

4.30. EU HF Championship

Window: Select Log type
Log Type: EUHFC
Sent Exchange: Last two digits of the year of operator's first official amateur radio license
Example: 82 (for 1982)
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4.31. Field Day Region 1

The Region I field day contest can be configured for Region 1 stations and DX stations. Supported
are the rules for stations in Belgium, Germany, United Kingdom (**), Netherlands, Switzerland,
Ireland (only CW), Italy, Slovenia (S5) and Russia (UA, UA2, UA9).

Window: Select Log type
Log Type: FDREG1
Sent Exchange: 001

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call)
determines if you are a Region 1 supported station or not and if you are /P etc. or not..

N1MM Logger checks whether the callsign used is a portable or a fixed station by checking the
callsign in the Station dialog under config! So using a /P, /M etc there could make a difference in
scoring!

United Kingdom: The ModeCategory selects the CW or the SSB version of the contest. The rules
between the CW and the SSB version are very different.

4.32. FOC marathon

Window: Select Log type
Log Type: FOCCW
Sent Exchange:membership number

 
The calculation of bonus points for working the same station on 5 (10 additional points) or on 6
bands (an extra 5 points) is not supported by the program.

Martin/OK1RR and John/G3WGV have posted contest routines to rescore the contest from a
Cabrillo file to a fully correct (including the 5/6 band bonuses).

4.33. GACW WWSA CW DX contest

The GACW WWSA CW DX contest can used by South American stations and DX stations.

Window: Select Log type
Log Type: GACW
Mode Category: CW
Sent Exchange: Your zone Example: 14

The rules are almost equal to the CQWW contests.
Default zones for US (K,N,W,A) and Canadian (VE) stations apply
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The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a SA station or a DX station.

4.34. Gagarin Cup

Window: Select Log Type
Log Type: GCUP
Mode Category: CW
Sent Exchange: Your ITU zone (not CQ zone e.g., 8 rather than 5 for eastern USA)

4.35. HA DX Contest

The Hungarian DX Contest can be configured for HA stations and DX stations.

Window: Select Log type
Log Type: HADX
Sent Exchange:

non-HA stations: 001
HA stations

HADXC members: HADXC membership number Example: 101
Other HA stations: two letters county code. Example: GY

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a HA station or a DX station.

4.36. Helvetia Contest

The Helvetia Contest can be configured for HB stations and DX stations.

Window: Select Log type
Log Type: HELVETIA
Sent Exchange:

001 for non-HB stations
001 Your Canton Example: ZH for HB-station

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a DX station or a HB station.

4.37. High Speed CW Contest

The HSC CW contest can be configured for members and non-members.
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Window: Select Log type
Log Type: HSCCW
Mode Category: CW
Sent Exchange:

Non-members: NM
Members: HSC-Membershipnumber

 

4.38. Holyland Contest

The Holyland Contest can be configured for 4X stations and DX stations.

Window: Select Log type
Log Type: HOLYLAND
Sent Exchange:

001 for non-4X stations
Your Area Example: E15RH

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a DX station or a 4X station.

4.39. IARU Radiosporting contest HF

Window: Select Log type
Log Type: IARU
Mode Category: CW or SSB or MIXED
Sent Exchange: IARU member society abbreviation for IARU member society HQ
stations and IARU International Secretariat club station

AC for IARU Administrative Council
"R1," "R2," and "R3" for the three IARU regional Executive committees
ITU zone for all other stations Example: 27

 
The zone is prefilled while typing the callsign to allow multipliers to be shown while typing the
callsign.

Call history lookup for HQ multipliers is supported. Correct format is: W1AW,,,,ARRL,,,

4.40. IOTA Islands On The Air Contest

Window: Select Log type
Log Type: IOTA
Sent Exchange:001 NA123 (default exchange)

Where the own IOTA reference has to be in the form XXYYY where XX = letters
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and YYY = numbers.

 
NB. The syntax for an IOTA reference has to be in the form XXYYY where XX = letters and YYY =
numbers. Example: 001 EU001 and not 001 EUTT1 or 001 EU1

If not the program can not determine the own IOTA reference and give correct points!

The received IOTA reference does not need the dash (-) when logged. Example: Enter EU123
in the IOTA field not EU-123. The Cabrillo output will automatically have the - added
The IOTA has many multipliers and therefor the program will only show worked IOTA
references and add a new IOTA reference when a new multiplier is worked. In the Multiplier
window, choose the tab "Sect"
When only an IOTA reference is entered the color of the IOTA reference and the color of the
Available buttons for new island are updated, even if no callsign specified

4.41. International Naval Contest

 

Window: Select Log type
Log Type: NAVAL
Sent Exchange:

Club+Membership number for Naval Club member, e.g. PN007
001 for non-Naval Club member

 
2009 contest rules: are here .

2010 dates: 8 / 9 May - CW and SSB, 15/16 May - PSK and RTTY;

 

4.42. JA domestic contests

This is a general contest class for Japanese domestic contests and only for use by JA stations.

Window: Select Log type
Log Type: JAdomestic
Sent Exchange: Section + class Example: 25M or 10L

 
General rules:

Japanese stations may only work Japanese stations
Example exchange numbers in ALL JA contest with assuming as follows.

I am in Osaka with 100W output and another party is in Tokyo with 10W.' send:59925M
receive:59910L
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I am in Okinawa with 1KW output and another party is in Sapporo in JA8 with 50W.
send:59947H receive:599106M

Dupe and multiplier examples
20 mtr JE1CKA 10H SSB 1 point + multiplier
20 mtr JE1CKA 10H CW 0 points dupe, no multiplier
20 mtr JE1CKA 10H SSB 0 points dupe, no multiplier

Same station should counts for 1 point only once on each band regardless of mode.
The multiplier counts once on each band regardless of mode.
When the SentExchange does not end on H, L, M or P then there is no Powercode check.

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a JA station.

4.43. JIDX contest

This JIDX contest contest can be configured for Japanese stations and DX stations.

Window: Select Log type
CW

Log Type: JIDXCW
Mode Category: CW
Sent Exchange:

non-JA stations: CQ Zone number Example: 14 (01 to 40)
JA stations: Your Prefecture Example: 34 (01 to 50)

SSB
Log Type: JIDXSSB
Mode Category: SSB
Sent Exchange:

non-JA stations: CQ Zone number Example: 14 (01 to 40)
JA stations: Your Prefecture Example: 34 (01 to 50)

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a JA or a DX station.

4.44. JT DX Contest

Window: Select Log Type
Log Type: JTDX
Mode Category: CW or SSB, select one only
Sent Exchange: CQ Zone (e.g., 5, 14, 23, etc.)

 

4.45. King of Spain Contest

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

525 of 680 2/2/2011 4:54 PM



The King of Spain contest can be configured for EA stations and DX stations.

Window: Select Log type
CW

Log Type: KINGEACW
Mode Category: CW
Sent Exchange:

non-EA stations: 001
EA stations:Your Province Example: AV

SSB
Log Type: KINGEASSB
Mode Category: SSB
Sent Exchange:

non-EA stations: 001
EA stations:Your Province Example: AV

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a DX station or a EA station.

4.46. Logbook of the World Contest CW / SSB

Window: Select Log type
Log Type:

CW: LOTWCW for the Digital part of the contest (LOTWRTTY)
SSB: LOTWSSB

Sent Exchange:
For North American stations: State/Province abbreviation Example: CT
For non North American stations: Countryprefix

 

4.47. LZ DX Contest

The LZDX contest can be configured for LZ stations and DX stations.

Window: Select Log type
Log Type: LZDX
Sent Exchange:

non-LZ stations: ITU zone
LZ stations:Your District abbreviation Example: BU

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a DX station or a LZ station.
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4.48. LZ Open and LZ Sprint Contests

Supports all three versions of the contest (LZ Open contest, LZ Open 40 meter Sprint contest and
LZ Open 80 meter Sprint contest)

Window: Select Log type
Log Type: LZOPEN
Sent Exchange: 001
Select LZOPEN contest. The Sent Exchange in the "contest selection window" is 001 or
#.
Your F2 exchange message should be: {EXCH}{LASTEXCH} or #{LASTEXCH}
Since it is required, the program will always send leading zeros for this contest.
Unchecking the leading zeros box in Configurer will have no effect
When a callsign is in the Entry Window, the Info Window displays the time since you last
worked the station
If you have a radio interface enabled, the bandmap colors of the callsigns will update
when you can work the station again for points

Set the Bandmap Packet Spot Timeout greater than 30 minutes
Do not enter received cut letters into the exchange box. They will not be converted to
numbers
Read the contest rules
Submit the contest results with the Cabrillo output

 
The 30 minute time period is computed per the organizers instructions. That is to ignore the
seconds of the logged QSO when computing the 30 minute interval. The 30 minute interval is
computed from the last QSO on the current band so it is not recommended to log a contact that will
not produce any points.

LZ Open and LZ Sprint contests display the sent exchange on the Entry Window status line. This
addition expects that the {LASTEXCH} macro is used as required by these contests.

4.49. Manchester Mineira Contest

The 'Manchester Mineira Contest by CWJF is the major CW contest in South America. Only South
American stations are allowed to work each other.

Window: Select Log type
Log Type: CWJFMM
Mode Category: CW
Sent Exchange: M, YL, QRP or Space (not empty)

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a South American station.

4.50. Michigan QRP Contest
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See the ARCI contest which uses almost the same rules.

Supported are: January CW Contest ; Memorial Day CW Sprint ; July 4th CW Sprint ; Labor Day
CW Sprint

4.51. MiniTest CW Test

Almost every week on Wednesday at 18 GMT and lasts only one hour. It has 6 time periods
(10 minute each). Band: 3520 - 3570 kHz, mode: CW, exchange: RST+serial.
Every QSO gives 1 point, multiplier: the number of unique calls during this hour of the contest.
Classes: 1- club station, 2 - SO, A- power > 100 W, B - power <= 100 W, 3 - SWL. The results can
be submitted at 19.00 GMT on 3720 KHz (SSB) or on 3541 KHz (CW).
The submitted information (QSO number, multiplier, class) will look like this: "125 36 A". The results
are published here:
http://www.minitest.narod.ru/2009/2009.htm

 

4.52. NA Sprint CW / SSB

Window: Select Log type
Log Type:

CW: SPRINTCW
SSB: SPRINTSSB

Sent Exchange: 001 Tom CT
Serial number, your name and your location (state, province or country) Example:
PA1M DE N1MM 123 TOM CT K

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a North American station or a non-North American station.

Example function keys can be found in the Example Function Keys chapter
Check out the Macros chapter. Great for Sprint are the macros {PGUP} and {PGDN}.

By Tom - W4BQF: Open config - Confiigure Ports.... - Other. Under the 'Other' tab, look
at the right-most column, where you will see "CW Up/Down Arrow" and "PgUp/PgDown".
These can be configured to QSY. Configure the Up/Down Arrow keys to QSY, say 2 kHz
each time you press your keyboard up or down arrow keys. Configure PgUp/Down to
QSY 'x' kHz, and then use {PGUP} or {PGDN} as a macro assigned to any of the
function keys. Example: F10 Freq UP, {PGDN} {run} F11 Freq DN, {PGUP}{run}
In my case "PgUp/Down" will move my frequency 5.5 kHz and the "CW UP/Down Arrow"
keys set to QSY 1.5 kHz. A little tricky because {PGDN} actually moves you UP in
frequency, but it works very well.

 

N1MM Logger Sprint Survival Tips - Version 1.5, by N2IC
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I thought I would share what I have learned about customizing N1MM Logger for
this contest.

I'm not going to try to explain how to operate the Sprint - for this, there is
an excellent writeup at:

http://n6tr.jzap.com/sprint.html

What I will do is describe how to get the most out of N1MM Logger in the Sprint.
My operation is SO2R, and my configuration is optimized for that mode. However,
I'm sure you SO1R guys will pick up a few tricks from what I have done for SO2R.

The most important thing is to get your options, windows and function keys set
up correctly before the Sprint starts.

The Options...

Start up N1MM Logger using version 10.9.2 or later, and create a new SPRINTCW
contest.

I assume that your radio(s) are interfaced to N1MM Logger, so that N1MM Logger will automatically
track the frequency of each radio. If you do not have interfaced radios, this configuration and
function key assignment will not work correctly for the Sprint.

In the Config menu, select the following options:
- Enter sends message (ESM)

- QSYing wipes the call & spots QSO in bandmap

- Do not run on CQ frequency

- Show non-workable spots

- SO2R->Toggle CTRLFx Macro

The "Toggle CTRLFx Macro" can also be toggled using Ctrl+Shift+L. This is handy
if you need to turn off {CTRLFx} during the contest.

The Windows...

These are the only windows I have on my screen:

- Entry Window (one for each radio)

- Visible Dupesheet (one for each radio)

- Info

- Log

- Score Summary
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They all fit nicely on my small monitor. My screen layout is shown at
http://www.kkn.net/~n2ic/sprint.bmp .

The Visible Dupesheet is really nice once you get used to it. To see if a
station is a dupe, you just scan the dupesheet with your eyes, rather than
frantically type a call into the Entry Window.

Open a Bandmap window. Right
click and select "Packet Spot Timeout". Change the packet spot timeout to 1
minute. That's right....1 minute. Hit OK. Now close the Bandmap window. Don't
reopen it. It is of no value in Sprint, but it is important to change the packet
spot timeout value to 1 minute. (Side note: This option should really be called
"Bandmap Timeout" not "Packet Spot Timeout". It controls how long calls stay on
the bandmap and the appearance of calls in the "on deck" frame of the Entry
Window. We're obviously not using packet in the Sprint.)

Notice that I do NOT have the "Available Mults & Q's" nor the Bandmap windows open.

Function Keys ....

Here are my function key definitions. I'll explain a few that aren't obvious.

F1 CQ,cq na cq na * na

F2 Exch,* # steve nm

F3 TU,{CLEARRIT}t{END}{CONDJUMP}{STOPTX}

F4 {MYCALL},*

F5 Call,!

F6 QSO B4,qso b4 *

F7 Other Short,~{CTRLF10}

F8 Other Long,~{CTRLF11}

F9 GoS&&P,{S&P}

F10,cq na * * na {RUN}

F11 Long CQ,cq na cq na * * na {RUN}

F12,~{STOPTX}{CTRLF4}

F1 S&&P CQ,cq na cq na * na

F2 S&&P Exch,! # steve nm * {RUN}

F3 S&&P tu,tu
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F4 S&&P,*

F5 S&&P his call,!

F6 S&&P,-

F7 S&&P Other Short,~{CTRLF10}

F8 S&&P Other Long,~{CTRLF11}

F9 GoRun,{RUN}

F10,cq na * * na {RUN}

F11 Long CQ,cq na cq na * * na {RUN}

F12,~{STOPTX}{CTRLF4}

 
-------

Important note: All function keys that start with {CTRLFx} or {STOPTX}, such as F7 above,
must have a leading half-space character (~).

With the Run F3 key, my "thank you" message is sent. When you QSY, you will
automatically be changed to S&P mode. Do not include the {S&P} macro here - it
will cause the last station worked to get "stuck" in the on-call frame of the
Entry Window.

With the S&P F2 key, as soon as I send my exchange, it immediate switches to Run
mode.

I can also force myself into Run and S&P modes with the F9 key.

The F7 and F8 keys send CQ's on the "other" radio. This is very useful when the
other station is sending his exchange, and you are going to lose the frequency
(i.e. it will become "his" frequency). You can send a CQ on the other radio,
while he is sending his exchange. Then, when he finishes sending his exchange
and you need to send your "thank you" message to finish the QSO, all you have to
do is hit Enter, which will stop the CQ on the other radio, and send your Run F3
message on the active radio. After the "thank you" message is sent, the {CONDJUMP} macro in the
Run F3 message will move your entry focus to the "other" radio, so that you will be ready to copy a
new caller on the radio you were CQing on.

When I'm CQing on the active radio, but simultaneously doing S&P on the other
radio, and hear a new station, I can hit the F12 key. This will stop the CQ, and send my call on
the other radio. Notice that there is a half-space (~) before the F12 {STOPTX} macro.
Yes, you need this half-space - don't leave it out, or this feature won't work. To make this work even
smoother, use AutoHotKey to create this script:

NumpadEnter::F12
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With this script, you can use the Enter key on the far right side of the keyboard instead of
hunting for the F12 key.

One thing you need to do is keep an eye on where your transmit and receive focus
is (the red and green dots on the Entry Window). When you're doing SO2R in the
Sprint, there will be times where your focus is not where you might expect it,
or want it. Always be ready with the \ and Pause keys to jump between radios.
Yes, this takes lots of practice, and you will make mistakes. The Thursday night
NCCC Sprints are good practice for this.

NA Sprint CW by Kenny, K2KW

North American Sprint CW is just a few hours away, and thought I would take a moment to help
others get their CW messages ready. Your messages may differ slightly from mine, but I just
wanted to highlight what's happening on the F2 and F3 messages which are the key setup items
for Sprint. The F2 exchange is set up to give you the correct sequence for this contest using ESM,
and the exchange sequence varies based on if you are Calling CQ, or you answered someone while
S&P. F3 is used to confirm the message, and change your state from S&P to Running, or Running
to S&P. The {RUN} and S&P} macros are inserted at the end of the F3 message, and will
automatically change your state, and thus exchange sequence.

I have also changed the Up/Down Arrow to move 1.5 kHz, giving you an "instant QSY" per the
rules. You may choose to use a wider QSY increment, but the goal was to offer you an idea for
QSYing so you can abide by the rules.

If you are not aware of the uniqueness of the Sprint exchange and QSY rule, check out:
http://n6tr.jzap.com/sprint.html and http://www.ncjweb.com/sprintrules.php

73 and CU in the contest,

Set the Exchange:
>File >Choose Which Contest to Log >Sent Exchange

# yourname yourstate
Example: # KEN CA

Set QSY distance:
In the >Config >Configurer >Other window, change the CW Up/Down Arrow Incr = 1.5

That gives me an instant QSY somewhat greater than the minimum QSY required
after you leave a frequency. Any value over 1 kHz is recommended

 

4.53. NSSprint and Sprint Ladder

Window: Contest Setup

These contests are identical except for the dupe rule that is incorporated

Log Type:
SPRINTLADD. SPRINTNS
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Sent Exchange: 001 Tom CT
Serial number, your name and your location (state, province or country) Example: PA1M
DE N1MM 123 TOM CT K

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a North American station or a non-North American station.

See NA Sprint above for more information (rules for the NS Sprint and Sprint Ladder are derived
from but slightly different NA Sprint, so be advised!).

4.54. NAQP North American QSO Parties CW / SSB

Window: Select Log type
CW

Log Type: NAQPCW
Operator Category: SINGLE-OP or MULTI-TWO

For Multi-Two see the extra info below!
Mode Category: CW
Sent Exchange:

For North American stations - Operator name and station location (state,
province, or country) Example: Tom CT
For non-North American stations - Operator name only Example: Thomas

SSB
Log Type: NAQPSSB
Operator Category: SINGLE-OP or MULTI-TWO

For Multi-Two see the extra info below!
Mode Category: SSB
Sent Exchange:

For North American stations - Operator name and station location (state,
province, or country) Example: Tom CT
For non-North American stations - Operator name only Example: Thomas

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a North American station or a non-North American station.

MULTI-TWO operating: When changing operator you have to use Ctrl+O to set the NAME (not Call)
of the operator. This name set with Ctrl+O will be used in the Cabrillo file. So from the Sent
Exchange only the state is being used but the name is needed. (Example: Tom CT). The macro
{OPERATOR} can be used to automatically switch WAV files (in SSB), for more info see the Macro
section.

4.55. NRAU Baltic Contest

This contest is only for stations from the following countries: ES, JW, JX, LA, LY, OH, OH0, OX, OY,
OZ, SM, TF, and YL
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Window: Select Log type
Log Type:

CW: NRAUCW
SSB: NRAUSSB

Sent Exchange: Section Example: AA

 
When a station is logged the following checks are made:

Is the logged station from a valid country ( ES, JW, JX, LA, LY, OH, OH0, OX, OY, OZ, SM,
TF, and YL)
Is the entered section a valid section (from NRAU.sec)
A warning is given when a qso is made an another band than 7 or 3,5 MHz. A note is made
with the logged qso.

 

4.56. Oceania Contest

Supported are the CW and SSB version of the contest

Window: Select Log type
Log Type:

CW: OCEANIACW
SSB: OCEANIASSB

Sent Exchange: 001

 
Note: The rules have special instructions for not complete portable callsigns so a prefix can not be
deduced normally. Adding numbers like the rules state is not supported and should be done by
editing the log file (afterwards). Example: N8BJQ/PA would be PA but is not a valid prefix and
should become PA0 (add the zero).

4.57. OK OM DX contest

The OK-OM DX contest can be configured for OK/OM stations and DX stations.

Window: Select Log type
Log Type: OKOMDX
Mode Category: CW (it is a CW only contest)
Sent Exchange:

Non-OK/OM stations: 001
OK/OM stations: district abbreviation Example: BPZ

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are an OK/OM station or a DX station.
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4.58. PA beker contest

The PA-beker contest is a local Dutch contest on 40 and 80 meters. The text below is in Dutch.

Window: Select Log type
Log Type:

CW: PABEKERCW
SSB: PABEKERSSB

Sent Exchange:
QSL regio Voorbeeld: 27 (en niet R27)

 

QSL regio ingeven en invoeren zonder R dus 27 en geen R27
Log, Entry en Score summary geven de juiste scores.
De multiplier window (Ctrl+J) geeft onder 'Sect' de gewerkte QSL regios alleen daar wordt de
eigen regio wel getoond indien gewerkt.
Er zit geen beperking op banden (dus let op dat je op 40 en 80 meter logt).
In te zenden log bestanden:

 

File How to Make... Exported

Log file >File >Export >Export to File (Generic) [callsign].txt

Summary sheet >File >Export >Print Score Summary to File [callsign].sum

4.59. PACC contest

The PACC contest can be configured for PA stations and DX stations.

Window: Select Log type
Log Type: PACC
Sent Exchange:

001 for non-PA stations
Your province Example for PA-stations: DR

 
PA stations have to import an adapted CTY.DAT file for the PACC contest so the right multipliers will
be used. In the 'Entry window' go to 'Tools', and select 'Import country list from downloaded file'.
This adapted country file can be downloaded from the N1MM website, under 'Downloads', select in
the menu: 'Other Files'. Don't forget importing the original CTY.DAT file again when entering other
after the PACC contests.

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a DX station or a PA station.
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The PACC contest committee approved and will accept the files made by N1MM logger and likes to
receive:

File How to Make... Exported

Log file >File >Export >Export to File (Generic) [callsign].txt

Summary sheet >File >Export >Print Score Summary to File [callsign].sum

 
Note icon PA stations: Vergeet niet op het summarysheet te vermelden de klasse waarin je mee
doet en de afdeling voor het afdelingsklassement!
Note icon PA stations kunnen tijdens de PACC contest op 160 meter gelijktijdig meedoen aan de
RSGB 1.8 MHz CW contest in de avonduren. N1MM acepeteert na het volgnummer ook de
districtscode. Voorbeeld: 599 123AA (NB, geen spatie tussen het ontvangen volgnummer en de
district code)

4.60. Portugal Day Contest

The Portugal Day contest can be used for Portuguese stations (CT, CT3 or CU) and DX stations.

Window: Select Log type
Log Type: PORTUGAL
Exchange:

District or Autonome Region for Portuguese stations
001 for DX stations (serialnumber)

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a Portuguese station or DX.

4.61. QCWA QSO Party

 

Window: Select Log type
Log Type: QCWAQSO
Mode Category: Mixed
Exchange: Year licensed, Name, Chapter (or state/province/country)

 

4.62. RAC Canada Day Contest / RAC Canada Winter Contest

With the same set of rules both contests are supported. These RAC contests can be used for VE
stations and DX stations.
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Window: Select Log type
Log Type: RAC
Exchange:

Province or territory for stations in Canada
001 for VE0 stations and stations outside Canada (serialnumber)

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are from Canada, VE0 or outside Canada.

4.63. RAEM CW contest

The RAEM Contest is CW only and has no multipliers, only points. These points are calculated
based on QSO points and distance between the stations (based on exchanged coordinates). Extra
points are added for polar stations. Extra bonus points for RAEM memorial stations are not added
because the call RAEM has no number is will not be accepted by the program. Use RAEM99 or so
and update the log and score (300 additional points) after the contest. 10 band changes per hour
are permitted, and a band change counter is activated when this contest is selected.

Window: Select Log type
Log Type: RAEM
Mode Category: CW (it is a CW only contest)
Sent Exchange: 001 & Coordinates Example: 001 53N6O

The own coordinates is the second token in Sent Exchange without spaces (one
'word')

 
Coordinate rules: These rules apply for the 'Sent Exchange' and also when entering a coordinate in
the Entry Window.

Own coordinates: Second token in Sent Exchange without spaces (one 'word')
First part is the Longitude with at the end N or S Example: 53N
Second part is the Latitude with at the end W or O (not E) Example: 6O
As a total this makes: 53N6O

 
Log and rescore: To generate the log use the Generic log file and the Score summary. Always
rescore and check the log. If a qso has 1 point then the Received exchange is not correct. If there
are QSOs who have gotten 2 points then your Sent Exchange is not correct. Update your Sent
Exchange in the contest setup and rescore. Check again.

Call History: The call history can be used but... the coordinates have to be entered in the Name
field of the Call History table. This is the only field which is capable of handling all different
coordinates 1N2W but also 67N169O

4.64. REF contest CW / SSB
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The REFContest can be configured for stations in REF countries and DX stations.

Window: Select Log type
Log Type:

CW: REFCW
SSB: REFSSB

Sent Exchange:
For DX stations: 001
For stations in REF countries - Department (F and TK) or Prefix (all other REF
countries)

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a DX station or a station in a REF country.

4.65. RF Championship

The RF Championship is a contest for stations of the Russian Federation only.

Window: Select Log type
Log Type: RFCHAMP
Mode Category: Select mode used in contest (CW, SSB)
Sent Exchange: 001

 
Please add the zone to sent in the Function keys. The points are calculated based on your callsign
and the callsign received.

4.66. RSGB 160 Meter CW Contests

The RSGB 1.8MHz CW Contests can be configured for RSGB stations and DX stations.

Window: Select Log type
Log Type: RSGB160CW
Mode Category: CW (it is a CW only contest)
Sent Exchange:

For DX stations: 001
For stations in the UK - 001 & District Example: 001 ZE

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are in the UK or not.

Serial numbers must be logged from UK stations.
There is no check by the program if a serial number is entered for non-UK stations. This because
there are often several other EU contests going on at the same time and an entrant in those may
not sent a serial number just an area code like DR (PACC) or a French department like 78. If a non
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UK station sends a serial number it must be logged in the received serial nr field, if it sends a code
like DR is must be logged in the districts field.

4.67. RSGB 21/28 MHz contest

The RSGB 21/28 MHz CW Contests can be configured for RSGB stations and DX stations

Window: Select Log type
Log Type: RSGB2128
Sent Exchange: 001

 

4.68. RSGB 80 Meter Club Championship

The RSGB 80 Meter Club Championship can be configured for RSGB stations and DX stations

Window: Select Log type
Log Type: RSGB80MCC
Sent Exchange: 001

 

4.69. RSGB Affiliated Societies Team Contests AFS

The RSGB Affiliated Societies Team Contests can be configured for RSGB stations and DX stations

Window: Select Log type
Log Type:

CW: RSGBAFS-C
SSB: RSGBAFS-S

Sent Exchange: 001

 

4.70. RSGB Club Calls contest

The RSGB Club Calls contest can be configured for RSGB stations and DX stations

Window: Select Log type
Log Type: RSGBCLUB
Sent Exchange: 001

 

4.71. RSGB Commonwealth contest
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Window: Select Log type
Log Type: RSGBBERU
Exchange: 001 (HQ stations enter 001 HQ in this box)

 
This contest is for British Commonwealth stations only. The callsign in the Station Information dialog
(Config >Change Your Station Data >Call) determines whether you are in the Commonwealth or
not.

There are no multipliers in this contest. Contacts with Commonwealth stations outside your own
Commonwealth Call Area (CCA) are worth 5 points; contacts within your own call area or with
non-Commonwealth stations are worth zero points. There are bonus points for the first 3 contacts
on each band in each CCA (25 points instead of 5 points). HQ stations send HQ after the serial
number in the exchange (enter HQ in the HQ block in the entry window when you work one of
these), and are also worth 25 points. You can work one HQ station plus 3 bonus stations in each
CCA on each band for 25 points each; any additional contacts in that CCA are worth 5 points. You
can work the HQ station in your own call area for bonus points. HQ stations can work all CCAs
including their own.

Bonus stations (first three contacts in a CCA and HQ stations) are shown in red in the Entry
window; other Commonwealth stations are in blue. Non-Commonwealth stations and stations in
your own CCA are shown in grey (including the HQ station in your CCA until the HQ box in the
Entry window is filled in). If you wish to work and log a zero-point QSO, use Ctrl+Alt+Enter to
force-log the contact.

To have the Multiplier window show only Commonwealth Call Areas, go to the Files > Additional
Support Files on this web site and download file cty-BERU-20100315.dat into your N1MM Logger
program folder, then use the Logger's Tools > Import country list from downloaded file menu item to
import this list into the database. You will have to close and reopen the Multiplier window for this
change to take effect. The Multiplier window only shows whether one station has been worked in
that CCA; to see whether a station would score bonus points on other bands, see the next
paragraph. Remember to reload the normal wl_cty.dat file into the database after the contest
is over and your log has been exported!

If you have the Available Mults and Qs window and the Check window both open, the Check
window's title bar will indicate the QSO and Bonus status of stations on all bands as they are
entered in the Entry window. For example, MUL: 160 80 10 Q: 40 would indicate that the station in
the Entry window would be a bonus station (25 points - first three QSOs in a CCA) on 80m and
10m, a new QSO (5 points) on 40m, and it has already been worked on 20m and 15m. The
Available window does not need to be visible, i.e. it can be hidden behind another window, but the
Check window title bar must be visible to make use of this feature.

Call History Lookup should be turned off in this contest to prevent state/section information for other
contests from prefilling the HQ box.

HQ stations are recorded in the "Sect" column in the log. Call areas are recorded in the "Exch"
column. In the Score Summary window, the "Cty" column indicates the number of bonus-point
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QSOs (first three QSOs in a CCA), and the "Sec" column indicates the number of HQ stations
worked.

 

4.72. RSGB SSB Field Day & RSGB National Field Day

The Region I field day contest can be configured for RSGB and DX stations.

Window: Select Log type
Log Type: FDREG1 <----
Mode Category: The ModeCategory selects the CW or the SSB version of the contest.
The rules between the CW and the SSB version are very different..

CW for the CW Field day contest
SSB for the SSB Field day contest

Sent Exchange: 001

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a RSGB station or not and if you are /P etc. or not..

N1MM Logger checks whether the callsign used is a portable or a fixed station by checking the
callsign in the Station dialog under config ! So using a /P, /M etc there could make a difference in
scoring!

4.73. RSGB Low Power Field Day

The RSGB Low Power Field Day can be configured for RSGB stations and DX stations

Window: Select Log type
Log Type: RSGBLP
Mode Category: CW (it is a CW only contest)
Sent Exchange: 001 Power Example: 001 2W5

 

4.74. RSGB ROPOCO

The RSGB ROPOCO is an internal RSGB contest and only available for G ,GD ,GI ,GJ ,GM ,GU
and GW stations.

Window: Select Log type
Log Type: ROPOCO

Note: The old RSGBJUBILE log type that was formerly used for this contest has been
discontinued as of Logger version 10.3.0 - use RSGBBERU instead.

Contest Type
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Mode Category: CW (it is a CW only contest)
Sent Exchange: Your postcode (taken from station info)

 
NB. Use the macro {LASTEXCH} to sent the postcode from the previous qso. Example F2 key:
<<<5nn>>>{LASTEXCH}

4.75. Russian District Award contest

The Russian District Award contest can be configured for Russian stations and DX stations.

Window: Select Log type
Log Type: RDAC
Sent Exchange:

Non-Russian stations: 001
Russian stations: District code by RDA list (for example TB02)

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a Russian station or a DX station.

4.76. Russian DX contest

The Russian DX contest can be configured for Russian stations and DX stations.

Window: Select Log type
Log Type: RUSSIANDX
Sent Exchange:

Non-Russian stations: 001
Russian stations: Your oblast code (two letters)

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a Russian station or a DX station.
Example: Default RU1A would have SP, in the call hisotry RU1A could be added so it will give the
corerct exception LO.
When a station is found in Call history it will use the section/oblast from it. IIf not found in Call
history it will use the default oblast.

Example Call history

RA1AR,,,, LO

RU1A,,,,LO

RU6FA,,,,KM
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Log submission notes:

'CATEGORY-OVERLAY'. In the RDXC you can submit one log and have it scored as two single
band entries. Like operating 10m during day time and 160m at night. Now, this is particular to this
contest and you need to submit your log like this:

CATEGORY-OVERLAY: operator-cat band-cat power-cat mode-cat The category overlay of the log
submission when appropriate. In RDXC, two single band entries are allowed from one participant. In
this case, one entry must be listed under CATEGORY tag, the other one under CATEGORY-
OVERLAY, such as:

CATEGORY: SINGLE-OP 80M HIGH MIXED
CATEGORY-OVERLAY: SINGLE-OP 15M HIGH MIXED

 

4.77. Russian Radiosport Team Championship

Window: Select Log type
Log Type:

RRTCT (invited teams)
RRTC (everyone else)

Sent Exchange:
three-letter code (teams)
ITU zone (others)

 

4.78. Russian YL/OM contest

Window: Select Log type
Log Type: RUSYLOM
Sent Exchange:

73 for male stations (OM)
88 for female stations (YL)

 
YL stations (female) may only work OM stations (male) and vice versa.

4.79. SAC contest CW / SSB

The Scandinavian Activity Contest can be configured for Scandinavian stations and DX stations.

Window: Select Log type
CW

Log Type: SACCW
Sent Exchange: 001
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SSB
Log Type: SACSSB
Sent Exchange: 001

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a Scandinavian station or a DX station.

4.80. Spanish Towns contest

The Spanish Towns contest can be configured for EA stations and DX stations.

Window: Select Log type
Log Type: CME
Mode Category: SSB
Sent Exchange:

non-EA stations: 001
EA stations: Your INE code Example: 18145

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a DX station or a EA station.

4.81. SPDX contest

The SPDX contest can be configured for Polish stations and DX stations.

Window: Select Log type
Log Type: SPDX
Sent Exchange:

001 for non-SP stations
Your province Example: B for Lubuskie

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a Polish station or a DX station.

4.82. Stew Perry Topband Distance Challenge

The Stew Perry contest is CW only.

Window: Select Log type
Log Type: STEWPERRY
Power category:

HIGH when > 100 Watt
LOW when 10 - 100 Watt
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QRP when less than 10 Watt
Sent Exchange:

Your four character grid Example: JO33

 
The point calculation in the log is multiplied by a power multiplier for each qso point value. This
factor depends on the selected Power category chosen. HIGH is multiplied by a factor 1, LOW by a
factor 2 and QRP by a factor 4.

4.83. Scandinavian Young Ladies Radio Association SYLRA

Window: Select Log Type
Log Type:SYLRA
Mode: Mixed+Dig
Sent Exchange: 88 for YLs, 73 for OMs

 

4.84. UA1DZ Memorial Cup

The UA1DZ Memorial Cup can be used by St.-Petersburg and Leningrad region stations and DX
stations.

Window: Select Log type
Log Type: DZCUP
Mode Category: Select mode used (CW, Mixed, SSB)
Sent Exchange:

For non-St.-Petersburg and Leningrad region stations: 001
For St.-Petersburg and Leningrad region stations: RDA (administrative area)

 

4.85. UBA contest CW / SSB

The UBA DX Contest can be configured for ON stations and DX stations.

Window: Select Log type
Log Type:

CW: UBACW
SSB: UBASSB

Mode Category: CW
Sent Exchange:

For non-ON stations:001
For ON stations: 001 + Your province Example: 001 OV
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The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are an ON station or a DX station.

Log submitting for non Belgian stations:

Before submitting your log look at the page from Franki, ON5ZO at http://users.pandora.be/on5zo
/n1mmlogger.htm

The information tells in English, Dutch and French how to update the category in the Cabrillo file so
you are placed in the right category.
The UBA contest manager approved and will accept the Cabrillo output made by N1MMLogger.

IMPORTANT NOTE quoted from the rules as found on the UBA website, regarding log submission:

Log submission info from UBA: The UBA likes to receive a Cabrillo file

Special Setup for Belgian participants:

How to include your province abbreviation in the Cabrillo output?
This MUST be done for both SSB and CW contests! Go to Config > Change your Station Data >
State field: fill in the abbreviation for your province (OV, VB etc). It is VERY IMPORTANT to do this,
as it will determine what you have sent in the log (Cabrillo output), and it is needed by the UBA
Contest Team. The official abbreviation (2 letters) for the Belgian Provinces is to be found on the
UBA site, under the rules for HF contests.
Non-Belgian participants can leave this field 'as is', it is only used for Belgian contesters.

How to send your province abbreviation after the serial number in CW?
When you have selected to begin a new log for the UBA DX CW contest, you must change the F2
button message to send your province.
This is done like this; go to: Config > Change Packet /CW/SSB/Digital Message buttons > Change
CW buttons In the right column, second row, there is:<<<5nn>>>{EXCH} This means the
incrementing serial number. Now you have to add your province abbreviation, preceded by a slash
(/). It should look like this: <<<5nn >>>{EXCH}/OV or <<<5nn >>>{EXCH}/AN

WARNING: Never change the '001' as the Sent Exchange value in the Select Log Type window, as
the software will no longer send serial numbers!!!

4.86. UBA ON contest

The UBA ON Contests (4 in total) can be configured for ON stations and DX stations.

Window: Select Log type
Log Type: UBAON
Mode Category: Select mode used (CW, Mixed, SSB)
Sent Exchange:

For non-ON stations:001
For ON stations - Serial + Your UBA gewest Example: 001 AAA
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The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are an ON station or a DX station.

4.87. UBA Spring

The UBA Spring contest (4 in total) can be configured for ON stations and DX stations.

Window: Select Log type
Log Type: UBASPRING
Mode Category: Select mode used (CW, Mixed, SSB)
Sent Exchange:

For non-ON stations: 001
For ON stations - Serial + Your UBA gewest Example: 001 AAA

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are an ON station or a DX station.

4.88. UBA Low Band Winter

The UBA Low Band Winter contest (4 in total) can be configured for ON stations and DX stations.

Window: Select Log type
Log Type: UBAWINTER
Mode Category: Select mode used (CW, Mixed, SSB)
Sent Exchange:

For non-ON stations:001
For ON stations - Your UBA gewest Example: AAA

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are an ON station or a DX station.

4.89. Ukrainian Championship

The Ukrainian Championship is run on CW, SSB and RTTY.(for Ukrainian stations only)

Window: Select Log Type
Log Type: UKRCHCW, UKRCHSSB, UKRCHRTTY
Sent Exchange: two-letter district designator, plus serial number - e.g., KV 001

 

4.90. Ukrainian DX contest

The Ukrainian DX contest can be configured for Ukrainian stations and non-Ukrainian stations.
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Window: Select Log type
Log Type: UKRAINDX
Mode Category: MIXED
Sent Exchange:

Oblast for Ukrainian stations Example: CH
001 for non-Ukrainian stations

 
Note: Countries are counted per band for SSB, CW and RTTY, because RTTY is in a separate
contest module they won't be counted correct when a station makes next to SSB and CW also
RTTY q's or the other way around...

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are an Ukrainian station or a non-Ukrainian station.

4.91. UK DX contest CW / SSB

The UK DX contest can be configured for UK stations and non-UK stations.

Window: Select Log type
Log Type:

CW: UKDXCW
SSB: UKDXSSB

Sent Exchange:
Area code for UK stations Example: BS
001 for non-UK stations

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are an UK station or a non-UK station.

4.92. UN DX Contest

Kazakhstan Open Championship

Window: Select log type
Log Type: UNDX
Mode Category: Mixed
Sent Exchange:

District code for Kazakhstan stations Example: L17
001 for non-Kazakhstan stations

 

4.93. Independence of Venezuela Contest
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Window: Select Log type
Log Type: YV
Sent Exchange: 001

 
The YV call areas are shown in the Multiplier window, choose the tab "Sect".

4.94. WAEDC contest CW / SSB

The WAEDC Contest can be configured for European stations and non-European stations.

Window: Select Log type
Log Type:

CW: WAECW
SSB: WAESSB

Sent Exchange: 001

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a European station or a non-European station.

This contest has QTC Traffic: A QTC contains time, call sign and serial number of the reported
QSO. Example: "1307/DA1AA/431" means that DA1AA was worked at 1307 UTC and sent serial
number 431
The QTC Status bar shows the number of QTC Exchanged with current callsign / Number left to
send to that callsign / Total number of QTC left to be sent.

WAE DX CW / SSB by Franki, ON5ZO

1. Introduction

The main character of Worked All Europe (WAE), sponsored by the DARC is that Europe works
non-Europe ('DX'), and stations outside of Europe work all countries on the WAE-list. So far, this is
not an unusual contest. However, WAE has something no other contest has, that you'll either love
or hate, being 'QTC'. What is a QTC? Well, the WAE rules give the following definition: A QTC is the
report of a contest QSO back to a European station.
Let's clear this up a bit. A QTC is a piece of traffic that can only be sent from outside EU ('DX') to
EU ('WAE'). DX stations can offer to send them, EU stations will beg to get them. Why? Simply
because for both sides each QTC is added to the QSO total. If N1MM makes a QSO with ON5ZO,
then they both get 1 point for the QSO. If they decide to exchange 10 QTCs during this QSO, they
both have 11 points, being 1 QSO + 10 QTCs. If after the contest, ON5ZO made 300 QSOs, during
which he got 500 QTCs, the total score will be 800, to be multiplied with the amount of multipliers.
Hence the popularity of the QTCs.

Now, what does a QTC look like? It has three main parts, being time, call and serial. When
exchanging QSOs, the DX station will send the QSOs that are already in his log. He will transmit
the three parts of the QSO that make up the QTC. Suppose that N1MM logged ON5ZO at
0123UTC, and ON5ZO gave '012' as his serial to N1MM. Later on in the contest, N1MM runs into
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9A7P, who asks for a QTC. N1MM kindly willing to transmit a QTC, sends the following to 9A7P:
0123 ON5ZO 012 So, in other words, N1MM says to 9A7P that at 0123UTC, he logged ON5ZO who
gave him 012. So the serial in the QTC is the number given by the EU station to the DX station in
their earlier QSO!

The rules say that a DX station can only send 10 QTCs to a EU station, and it is forbidden for the
DX to send a QTC featuring a previous QSO with the same EU station he is currently giving QTCs
to. No worries, the software takes care of that. Furthermore, each QSO can only be sent once as a
QTC, so a DX station can never have more QTCs sent than QSOs logged. A EU station however,
can have much more QTCs than QSOs, as each QSO can raise up to 10 QTCs. A DX station can
choose to send 10 QTCs at once during a QSO, or if he has, let's say 100 QSOs in the log, of
which 95 have already been sent once as a QTC, he can send 5 QTCs. The EU station can ask for
another 5 QTCs later on in the contest, after another QSO on another band - or on the same band!
More on this later.
The maximum of 10 QTCs can be reached with only 1 QSO, or with 5 QSOs on (5 bands), with
each time 2 QTCs. You see, everything is possible. You don't even need to make a QSO to get
QTCs. Suppose that early in the contest, ON5ZO is running, and N1MM calls on 20m. They have a
regular QSO and exchange serial numbers. ON5ZO asks 'QTC?' but N1MM does want to make
some QSOs first and wait to send QTCs towards the end of the contest. 40 hours later, N1MM is
running on 20m and ON5ZO comes across, ON5ZO sees that N1MM is a dupe because they
QSO'd in the beginning of the contests. However, they did't exchange QTCs, so ON5ZO asks
'QTC? de ON5ZO'. N1MM sees that they have worked but indeed: there were no QTCs exchanged
in the first hours of the contests, and N1MM is now eager to send all his QSOs as QTCs. N1MM
says 'QTC OK' and they exchange QTCs, but no serial number for the QSO - because there is no
QSO anymore, only the exchange of QTCs.

But there is more. A series of QTC is to be numbered. The sending station (DX) will initiate the
series of QTCs with a number like 'QTC xx/yy'. This means that the DX stations is sending QTCs for
the xx'th time, and this will be a series containing yy QTCs. Suppose N1MM sends 'QTC 45/8', this
means that it's the 45th time he's sending a series of QTCs, and this particular series will contain 8
QTCs.

Now that we know what a QTC is, what it looks like and why it is sent, let's look at a real situation
using the software. If you start a new contest using the WAE-module, it looks like a normal contest.
You set it up with the usual parameters, like Power, Category etc. Don't forget to fill in '001' for the
exchange!
When this is done, you'll see that you have both entry windows. You can use these like you
normally would, both in run mode and in S&P.

2. WAE from EU-side

This is what a WAE-QSO could look like including some QTCs, with ON5ZO running:

CQ TEST ON5ZO

N1MM

N1MM 5NN 012
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R 5NN 48

QTC?

R QTC 12/5 QRV?

QRV

0123 PA1M 12

R

0124 G4BUO 03

R

0124 F6BEE 56

R

0125 DL6RAI 89

R

0126 9A7P 102

R TU

How does it work? After entering the normal QSO, where both stations exchange serial numbers,
ON5ZO goes into QTC mode by pressing Ctrl+Z. This triggers the program to send the 'QTC?'
message to ask N1MM if he wants to give QTCs. At the same time, you'll notice that the entry
window changes a bit, and the cursor will be blinking the 'N/N' window. N1MM answers and gives
the 'N/N' part, so ON5ZO logs '12/5'. Hitting spacebar moves to the next window, and you'll send
'QRV' (with your paddle, for the time being), so the DX knows you're ready to copy the QTCs. Each
time you copy a part of the QTC and want to move to the next field, you press the spacebar. When
you have a complete QTC, i.e. time/call/serial, you hit Enter and the program sends a confirming
'R', so the DX knows you got it OK and he can start transmitting the next QTC. If the series of QTCs
is copied and you're done with this calling station, you press F3, which is the Thank You message,
the program will send this TU message and close the QTC-mode, returning to normal QSO mode.
Remark: Sometimes DX stations don't repeat the two digits representing the hour in the time part of
the QTC. They just type the minutes, because the hour is the same for a bunch of QSOs that were
logged in a short time span. When copying QTCs at 36WPM or faster, you don't have the time to
think things over so you just type what you copy. If you hear that after two numbers, the next
character is a letter, you press space and begin typing the callsign. The software will automatically
add the two digits of the hour.

In S&P mode, the same keystroke, Ctrl+Z, activates QTC-mode here. There is little or no difference
in the procedure. Only advice is to try everything well BEFORE the contest and report bugs ASAP!
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3. WAE from DX-side

From the other side of the contest, the 'DX' side, the main keystroke to activate QTC-mode is also
Ctrl+Z. You will then have a pop-up window, asking you how many QTCs you want to send to the
EU-station. Hitting Enter will send the 'QTC xx/yy' message, the 'yy' part being the number of QTCs
you agreed to send in the pop-up message. Once the EU-station has accepted this message, hit
Enter again to send and log the first QTC. For each new QTC, hit Enter once more.

The second most important keystroke is Alt+Enter. This will repeat the last QTC sent, or if you're
still in the 'N/N' stage, it'll resend this information. It will occur more than once that a EU station
does not copy the first time you transmit, due to QRM, 'cockpit errors' or simply because you send
too fast! So Alt+Enter will repeat the last part sent, should the EU station ask 'AGN' or something
similar.

On the bottom of the Entry window, you will see a message, indicating how many QTCs have
already been sent to a given station.

WAEDC Keyboard Assignments

Ctrl+Z - activate QTC-mode and sends: QTC? and log QSOs if nr is greater than 0.

Alt+Enter - resend last QTC or it will resend QTC n/n if that was the last message sent.

Alt+W - when used in a QTC leaves the sender's call and N/N so only wipes the 3 parts of the QTC

= (equal sign) - resend sent QTC info

Step-by-Step instructions

After you make a contact, first log the contact
If you want to send QTCs use Ctrl+Z, the log window will change to QTC mode
You get a screen asking how many QTCs you want to send. Enter a number of just hit Enter
and the QTC count will go away.

At the bottom of the logging area the QTC number will be indicated, i.e. 12/10, meaning
the 12 QTC series and 10 QTCs

After you hit Enter again the first QTC will show up with the time call and number
After the station acknowledges the QTC hit Enter and the next QTC will show up

Continue this until all QTCs have been sent
Then do Ctrl+Z to return to normal logging

 
Other info

If only two digits of time are entered the program adds the first two hour digits from prior QTC
The status line in the Entry window shows the total QTC Sent and Received from the station
being worked
The number of the QTC in the series sent is shown. Example: 5 from 10
When reediting a QTC the program will go back to QSO mode after editing
When in QTC mode the letters "QTC" will be shown in big red letters where normally the dupe
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label goes
Want to know how many QSOs and QTCs you have by band?

Try View/Statistics. Then use either Band by Exchange1 or Exchange1 by Band

 

4.95. WAG contest

The WAG contest is for German stations and non German stations.

Window: Select Log type
Log Type: WAG
Sent Exchange:

non-DL stations: 001
DL stations:

DARC member:DOK (example: V11)
non-DARC member:001

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a German station or a non-German station.

Non DL stations may only give a number.
DL stations give a DOK (DARC members) or a number (non DARC members)
For stations not giving an exchange put 000 in the exchange field

- minimal DOK length is 2
- 0 is allowed to be entered

Note: When updating a DOK in the log window you have to update not only the Exchange but also
the Section by hand....only when the qso is in the Entry window the program strips the Section (V)
from the Exchange (V11) automatically.

4.96. World Wide Peace Messenger Contest

The Peace Messenger Contest can be configured for Peace Messenger Contest stations and non
Peace Messengerstations

Window: Select Log type
Log Type: WWPMC
Mode Category: CW, SSB or Mixed
Sent Exchange PMC station: 001 PMC abbreviation Example: 001 ABI
Sent Exchange non PMC station: 001 NON Example: 001 NON

 

4.97. WRTC contest
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The World Radiosport Team Championship (WRTC) contest is fully supported for use by on-site
participant teams

Window: Select Log type
Log Type: WRTC
Sent Exchange: 001 i.e Serialnumber Example: 001

 
The WRTC follows the rules for the WPX contest (please check above) with some additional WRTC
specific changes below.

Check Partial is disabled from master.dta for this contest only.
Displaying "Unique" is disabled in the Check Partial window for this contest only.

 

4.98. YO HF DX contest

The YO HF DX contest can be used by Romanian stations and non Romanian stations.

Window: Select Log type
Log Type: YOHFDX
Sent Exchange:

non-YO stations: 001
YO stations: Romanian county abbreviation (two letters) Example: AR

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a Romanian station or a non-Romanian station.

5. QSO Parties

The program supports many US and Canadian QSO parties. Depending on the complexity of the
rules, there may be minor scoring anomalies.

It is very important for proper operation of the program in QSO parties that the program
"know" whether you are an in-area (state or province) or out-of-area participant. All QSO
parties require different program operation and scoring rules for in-area and out-of-area
participants.

 
The program determines which you are from the ARRL Section that you have entered in the Station
Data dialog (under the Config menu). When creating a new log for a QSO party, a message box will
inform you whether the program thinks you are an in-state, or out-of-state participant, based on
your ARRL section, so that you can correct things if anything is wrong.

Non-US/VE stations should enter "DX" in the ARRL SECTION field. If you enter an ARRL section
with a non-US/VE callsign, you will be warned to correct your Station Data before continuing.
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Window: Select Log type
Log Type: QSOPARTY

After selecting QSO Party, a list box shows up in the right-hand part of the contest
selection dialog box, with buttons below it for importing and editing the section list.
Click on the down arrow to choose the QSO Party you want (example image shows
Hawaii HI) . When in doubt, do the import, to make sure you pick up any changes
in the official abbreviations since the last running.
Example: The entry in the list of QSO Parties for the New England QSO Party is
"NEWE" ("NE" is for the Nebraska QSO Party). Most of the entries in this list are
states or provinces, except for the NEWE (New England) and MAQP (Mid-Atlantic)
entries.

 

 

Mode Category: MIXED
Sent Exchange:

The exchange depends on the QSO party. Most use county for in-area participants
and state for those out of the area. Some use serial numbers as well.
Inside the selected State/Province - See contest instructions
Outside the selected State/Province - See contest instructions
if you need to send a serial number, enter 001 and the abbreviation for your
location in the Sent Exchange field, to automatically increment the serial number
for each QSO.

 

QSO Party Bonus Station Support - A few state QSO parties have "bonus stations", which you
can work for extra point credit. When the state party has bonus station(s), the program will
display the bonus station callsign list on program start and upon exiting the contest dialog.

 

This list of bonus stations can be modified by the user by entering the command BONUS + Enter in
the Entry Window callsign box.This will pop up a window where you can enter a revised list.
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Each callsign, and each variation (CALL, CALL/M, CALL/CTY) must be on the list in order to get
credit for the bonus station(s).

Note: The program does not store bonus station callsign changes, so if there are changes, you will
need to re-enter the complete list each time you re-start the program or change logs to that QSO
party. You can't simply enter the changes.

To view the QSO's logged, enter the bonus station callsign in the Entry window and look at the
lower portion of the Log window. To view the number of bonus stations counted in the score, export
the Score Summary to a file.

 

Rover Support - N1MM Logger supports Rover and Mobile operations for QSO parties. Check
the chapter Advanced Functions for the details.

 

County Line Stations - Some QSO parties allow operation from county boundaries, giving
multiplier credit for both counties. When working these county line stations, you will need to
log one QSO for each county. Entering all counties in one QSO will not work. It is easy to do
this in S&P mode, if you have enabled the Show Non-workable Spots option. Log the first
QSO, and station just worked will appear in grey (as a potential dupe) in the call-frame above
the Callsign. Press Space to repopulate the Entry window with the previous callsign and
exchange, change the county exchange (backspace is not needed), log the contact. When in
RUN mode, the callsign needs to be typed.

 

Simple Call History Procedure - The steps for generating a Call History file from a previous
QSO party are as follows:

Using program version 10.9.5 or newer, open last years QSO party contest log.
Click Tools, Clear Call History then Update with Current Log
Click File, Export Call History and export the data into a file.
Open the new QSO party contest log for the current year. Associating the saved call
history file with this state party is possible using the Associated Files tab. Alternately,
click on File, Import Call History after the contest is open.
Click on Config and place a checkmark in front of Call History Lookup.

 

The call history data is stored in the database. If you open a different contest and have
Call History Lookup enabled, the program will use this data. So uncheck this option after
the contest. Users can combine exported call history files from several years. The
recommended editor is NotePad. Some editors place non-ACSII characters in the file

You can help keep N1MM Logger up to date for your favorite QSO Party by notifying the N1MM
team of and changes in scoring, bonus stations, etc. Just post the changes in the N1MM
Reflector, or send a Feature Request. Obviously, earlier is better.

Help Keep Your Favorite QSO Party up to Date
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and this will cause import issues. Place the oldest contest at the top of the merged file.
The import routine will merge the data and deal with duplicate entries. You can look at
the result by exporting the call history and viewing it with NotePad.

 

5.1. Same weekend: 7QP, Indiana QSO Party, New England QSO Party, and Zeroland
QSO Party

Four QSO parties - the 7QP (7th Call Area QSO Party), Indiana QSO Party, New England QSO
Party, and the Zeroland QSO Party - are all on the same weekend. Since 2010, the program
software allows users to log stations active in all four QSO parties and automatically determine the
state multiplier from the received exchange (other contest county exchange). Log the exact
exchange that is receive and send the same cabrillo output to all four contest sponsors. If you are
an "in-state" user of one of these QSO parties, select the appropriate state party option in the QSO
party contest selector. If you are "out-of-state" for all contests this weekend, select the IN7QPNE
option in the dropdown state selector. The instructions are the same, log the exchange that you
receive and send the same cabrillo file without editing to all four sponsors. All sponsors re-calculate
the score of all submissions.

5.2. FL QSO party

Florida multiplier work around.
Florida stations get a FL state multiplier for their first Florida QSO. Florida stations get no multipliers
for Florida counties but get QSO point for Florida QSOs. To get the right multiplier change the
exchange of the first Florida QSO to FLA, it forces the FL multiplier credit.

5.3. PA QSO party

For in-state stations, the first EPA and WPA county worked will count both the county and the
section multiplier in the score. Likewise, the first DXCC station worked counts as the single DX
multiplier. See the information in the general section above for working bonus stations and county
line stations. It it not necessary to include a Dupe Sheet with the contest submission when N1MM
Logger is used for the PA QSO Party logging.

5.4. MARAC QSO Party

Since this QSO party uses all 3077 US counties as multipliers, N1MM Logger uses a 6-character
naming convention - enter a standard postal 2-letter abbreviation for the state and a four-letter
abbreviation for the county. See the MARAC web site  for a list of the valid county abbreviations for
your state. While N1MM Logger will recognize some "aliases" and substitutes the standard
abbreviation in your log , it is good practice in all county-based QSO parties to send the recognized
form of abbreviation for that particular event.
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5.5. Updating and importing the QSO party sections

Always try first on a test database.
The 'QSOparty.sec' file located in the program directory has listed all the sections per QSO
party.
Importing is done automatically at the start of the program when the database has no QSO
party section information (checked at startup).
If the 'QSOparty.sec' file has been changed (updated) after automatically been imported by
the program it has to be imported into the database manually so the made changes are
imported.
The load process deletes all the counties for a state before loading them.
The maximum length for a section is 5 characters.

 
How it works

If you want abbreviations for counties e.g. Tolland = TOLL then, Edit the Sections list, and
TOLLAND in the abbreviation, and TOLL in the key. When you log Tolland, the program will
substitute TOLL.

Test the change

Open a TEST database
Create a new QSOPARTY contest
Choose Import (See image above)
Specify the location where you saved the attached file and "QSOparty.sec"
Import need only be done once (after an update/change).
You should now see 20+ states/provinces in the combo box.
Choose one and test....

 

6. VHF and Up contests

In VHF and up contest it is the norm to give accurate signal reports. Use the Tab to go from the
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callsign filed to the signal report fields. You will note that it highlights the strength to allow quick
modification of that.

 

6.1. ARRL January VHF Sweepstakes

 

Window: Select Log type
Log Type: ARRLVHFJAN
Sent Exchange: Your four character grid Example: JO33

 
Exchange of signal report is optional. Foreign stations work W/VE amateurs only.

Stations can be logged more than once from a different grid without being a dupe (for Rover
stations).

Dupe check on first 4 characters of grid.

The score for Rover stations is not being calculated by the program!

6.2. ARRL June VHF QSO Party

Window: Select Log type
Log Type: ARRLVHFJUN
Sent Exchange: Your four character grid Example: JO33

 
Exchange of signal report is optional. Foreign stations work W/VE amateurs only.

Stations can be logged more than once from a different grid without being a dupe (for Rover
stations).

Dupe check on first 4 characters of grid.

The score for Rover stations is not being calculated by the program!

6.3. ARRL September VHF QSO Party

Window: Select Log type

When a is grid entered but no call, all QSOs with that grid will show in the lower part of log
window

Feature
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Log Type: ARRLVHFSEP
Sent Exchange: Your four character grid Example: JO33

 
Exchange of signal report is optional. Foreign stations work W/VE amateurs only.

Stations can be logged more than once from a different grid without being a dupe (for Rover
stations).

Dupe check on first 4 characters of grid.

The score for Rover stations is not being calculated by the program!

6.4. IARU Region 1 contesting - 50 MHz, VHF, UHF/Microwaves

Region 1 contesting uses a serial number and gridsquare as exchange. The points per qso is the
calculated distance between your sent gridsquare and the received gridsquare.

Station Information ('Config | Change Your Station data')
Grid Square: <gridsquare> Example: JO33fd

This grid square is used in calculating the distance between the stations (and is
part of the exchange)

Window: Select Log type ('File | Choose Which Contest to Log')
Log Type: VHFREG1
Sent Exchange: 001 <gridsquare>

Example: 001 JO33fd
The sent exchange is not used by this specific contest otherwise the use in the
macros for the function keys.

 
This contest type has the possibility to use the CallHist table in which information can be stored
which can be easy to have during a qso like name and gridsquares used in previous contests. This
specific contest type uses the Name, Locator1 and Locator2 fields from the CallHist table. Entering
any information in this table is not necessary for the contest module to work but can be very handy.
For this to work information has to be imported in the Call History table ('File | Import | Import Call
History'), also this feature has to be enabled to work ('Config | Call History Lookup').

When a callsign is entered and the SPACE or TAB key is pressed the program will check next
to the normal things like dupe check the following:

Check the log if the callsign is known and if already worked the gridsquare is entered
from the log in the Entry Window grid square exchange field.
If not found in the log file it will check the CallHist table. If the callsign is found it will
place the content from Locator1 in the Entry Window grid square exchange field. The
callsign is 'normalized' before searching in the CallHist table which means that /P, /A, /2
etc. will be removed before searching. Information in the CallHist table should be in its
normalized form.

Information from the CallHist table i.e. Locator1, Locator2 and the name field will be shown
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below the function keys.
Normally this feature is not turned on (it gives a very short delay while searching the table), to
turn it on select:'Config | Call History Lookup'
Note: Any information already typed in the grid square exchange will not be overwritten by the
log file or CallHist table search. So first entering a grid square and afterwards a callsign is
possible without overwriting the already entered grid square information. A callsign already
worked will be shown in the bottom pane of the log window and marked with the dupe
message. If the station is not worked before and is present in the CallHist table, this
information will always be shown below the function keys.
More information about importing information in the CallHist table can be found in chapter
VHF and Up contesting. A zip file with an import file for the 'Call history' lookup function and a
ready master file with known calls can be downloaded from the N1MM website, select 'Other
Files' under 'Downloads'. Don't forget to turn on the lookup function under 'Config | Call
History Lookup'
More information about VHF related contesting and features can be found in chapter VHF and
Up contesting

 
A QSO can not be entered when

The serial number is missing
Warning: "Missing Serial Number!"

The grid length is not 6
Warning: - "6 character grid required!"

The grid format is not correct.
Warning: - "Wrong format grid. Format = AA##AA"

 
These checks will (only) be done: when trying to log the qso (mostly by pressing Enter)

How VHFREG1 looks for a known grid square

Look in the log if the station has been worked before (on any band)
If found show the grid and calculate distance and bearing

If not found look for the call sign in the 'call history' table including any /P /3 etc when
applicable.

If found show the grid and calculate distance and bearing
If not found look for the call sign in the 'call history' table with the /P /3 etc removed
(normalized callsign)

If found show the grid and calculate distance and bearing
If not found add the 'big grid' from the country when known by VHFREG1

If found show 'big grid' (no calculations done)
If not show nothing in grid square field

The check will (only) be done: When space is pressed and the cursor is in Callsign field

 
Bearing and distance calculations

When space is pressed and the cursor is in Callsign field
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When trying to log the qso (mostly by pressing Enter)
The grid square length has to be 4 or 6 digits.
Bearing info is shown in the log window and saved in the Misc field.
Distance info is shown in km in the log window and saved in the Points field.
Use Rescore to have the bearing and distance (re)calculated.

 
Check Grid with country

When a grid is entered the program will check if the 'big grid' is a possible grid for the entered
callsign.

Example: A Dutch station is always in JO.
When the callsign is entered with /MM the check will not be done.
The check will (only) be done:

When space is pressed and the cursor is in Callsign field
When trying to log the qso (mostly by pressing Enter)

 
Add 'big grid' to 4 digit grid (if last 4 digits entered)

When a 4 digit grid is entered the program checks if these are the last four characters from a
6 digit grid. If so it will add the 'big grid' from the country (for a Dutch station it will add JO).
The check will (only) be done:

When space is pressed and the cursor is in Callsign field
When trying to log the qso (mostly by pressing Enter)

 
Add 'big grid' when no grid is found (from log or 'call history' table)

When a station is entered in the callsign pressing SPACE will search the 'call history' table. When
the entered callsign is not found the program will try to add the 'big grid' who belongs to that
country. If more grids are possible it uses the grid which occupies the most space in the country (IO
in England) or is the easiest workable grid from Western Europe (JP for Norway, most south grid.
The Netherlands will always give JO because this is the only grid possible for PA.

The check will (only) be done:
When space is pressed and the cursor is in Callsign field

 
For DL stations: The German contest manager hat informiert dass er die Logeinsendungen von
N1MM gerne akzeptiert. Wie immer akzeptiert er den postalischen Versand des Logs, jedoch auch
Email ist möglich, lediglich müssen die Daten druckfähig sein.
Vorab also einige Hinweis:

Jedes Log muß mit dem Generic-File-Output als TXT-Format sortiert nach Zeit abgespeichert
werden und als Bezeichnung "CALLBAND.TXT" lauten. Also DH5HV2m.txt zum Beispiel für
einen Contest unter DH5HV auf 2m.

1.

Bei der Einsendung mehrerer Bänder sollte man diesbezüglich den Generic-File erstellen mit
"sorted by Band" und dann mit einem Editor kurz bearbeiten, sodass man als Beispiel eine

2.
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2m-Datei, eine 70cm-Datei, eine 23cm-Datei, etc. hat. Auch hier natürlich dann DH5HV2m.txt
und DH5HV70cm.txt und DH5HV23cm.txt erstellen bzw. benennen.
Und wie bisher auch üblich wird für jedes Band ein seperates Deckblatt benötigt, was nur
komplett ausgefüllt gewertet werden kann. Man findet dies unter http://www.darc.de/referate
/ukw-funksport/index.html  ganz unten als PDF- oder DOC-File.

3.

 

6.5. Marconi CW contest

The Marconi CW contest is CW only. For settings see the VHF Region 1 contest.

Window: Select Log type
Select: Log Type: VHFREG1

 

6.6. NAC Activity Contest

As there is no serial number needed in the NAC contest exchange serial numbers are not shown
and not added to the EDI output (opposed to VHFREG1).
In the EDI output the scoring, bonus and multipliers are calculated. The grid locator from the station
information is used in the calculations. Also the antennas, heights etc. are taken from this dialog.
For more settings and possibilities see the VHF Region 1 contest.

Window: Select Log type
Select: Log Type: VHFNAC
Sent Exchange: Nothing specific needed but the 6 digit grid would be fine to used it in
the Sent Exchange macros.

 

6.7. REF Departments contest 50 Mhz

Window: Select Log type
Log Type: DDFM50
Sent Exchange: Serial Number + Your four character grid Example: 001 JO33

 

6.8. VHF/UHF Helvetia 26 contest

Window: Select Log type
Log Type: VHFHELV26
Sent Exchange: 001
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Local Swiss VHF/UHF and up contest. Uses almost the same rules as VHFREG1 but with an added
field for Swiss stations for exchanging Cantons which are also multipliers for the contest All features
mentioned above for VHFREG1 can be used in this contest. Use in the Multiplier sheet the Sect tab
to view the worked Cantons (select VHF and auto).

6.9. VHF HG OB contest

Window: Select Log type
Log Type: VHFHGOB
Sent Exchange: 001

 
Local Hungarian VHF contest. Uses almost the same rules as VHFREG1 but dupes per mode CW
or FM/SSB (station may be worked twice per band). All features mentioned above for VHFREG1
can be used in this contest.

6.10. VHF UA1DZ Cup

Window: Select Log type
Log Type: VHDZCUP
Sent Exchange: 001 gridsquare Example: 001 KO94BD

 
Russian VHF contest. Exchange is RST + serial number + grid square.

6.11. VRZA - Nederlandse Locator Contest - WANLC

Window: Select Log type
Log Type: REGIOVHF (is dus nu de WANLC contest)
Sent Exchange: 001

 
Only for Dutch stations.

Noot: Deze contest kent een aantal mogelijkheden om extra multipliers te halen middels een soort
'Rover' stations. Dit wordt niet ondersteund door het programma en deze stations worden een
DUPE! Ofwel: De multipliers en punten voor /M en /P stations gewerkt voor een tweede keer
worden NIET door het programma automatisch bepaald. Deze dupes dus WEL loggen en achteraf
de score en multiplier aanpassen op 'generic log' en de 'summery sheet'.

Cabrillo output wordt ondersteund (File, Export, Cabrillo).

Voor stations in de secties B en J (Single Operator / Mixed mode)
- Selecteer SINGLE-OP-ASSISTED (onder File, Choose Which Contest to Log, Operator Category)
voor een doorlopende nummering over de banden heen!
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6.12. YU DX Contest

Window: Select Log Type
Log Type: YUDX
Sent Exchange: your ITU zone. (remember also to put RST in your exchange messages)

 

6.13. UKSMG sporadic-E competition

Window: Select Log type
Log Type: UKSMG
Sent Exchange: Your four character grid Example: JO33

 
Only the 6 meter band is shown in the Multiplier window.
A 4 digit grid is required and 6 digit grid is allowed to enter.

7. Digital contests - RTTY/PSK31

 
When doing RTTY and PSK contests always check the Mode tab in Configurer for correct settings!

{TIME2} - how it works

The time will be set if

You have a call sign in the Entry Window
The contents of the database field that holds the time is empty for that callsign, and one of
the following conditions is met:

 

F2 is pressed or sent
Insert is pressed and the code that is run from the insert key sends the contents of the F2
macro
{TIME2} is contained in the macro string that is sent

 
If you do not have a call in the Entry Window or the database field is not empty, the {TIME2} macro
will be replaced by the Last Sent Time. So if you have not sent the time and you are trying the
macro out you will see 0000 printed on the screen. But if 0512 was the last time sent then that is
what the {TIME2} macro will send. {TIME2} stays locked until the contact is logged or the callsign
wiped.

7.1. ANARTS WW RTTY contest
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The last running of this contest was in June 2009. It has been replaced by the DCRG Long
Distance contest (DLDCRTTY).

Window: Select Log Type
Log Type: ANARTSRTTY
Sent Exchange: Zone Example: 14

 

7.2. ANATOLIAN RTTY contest

Window: Select Log Type
Log Type: ANATOLRTTY
Sent Exchange: 001

 

7.3. ARRL RTTY Roundup

The ARRL RTTY Roundup can be used by K/VE stations and DX stations.

Window: Select Log Type
Log Type: ARRLRTTY
Sent Exchange:

Your state/province - for K/VE stations Example: NY
001 - for DX stations (non K/VE)

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a DX stations or a W/VE station.

NB. US stations who work US "/MM" stations are also allowed to log serial numbers.

7.4. BARTG Spring RTTY contest

Window: Select Log type
Log Type: BARTGSRTTY
Sent Exchange in the Contest setup:001

 
The actual sent exchange includes a signal report, serial number and the UTC time. Program this
into your Exchange messages using the {TIME2} macro, e.g.: {TX} 599 {EXCH} {TIME2} {RX}, or
{TX} 599 # {TIME2} {RX}.

Needed W,VE,JA,VK call area mults in bandmap and available window are highlighted.
Added EXPERT to list of overlay categories choices. The EXPERT overlay category must be
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selected for the 5 minute band change counter to not be active for SINGLE-OP

7.5. BARTG RTTY Sprint contest

Window: Select Log type
Log Type: BARTGRTTYS
Sent Exchange:001

 
Be careful not to confuse this contest with the BARTG Spring RTTY contest.

Note that there is no signal report in the sent exchange, just a serial number.

Needed W,VE,JA,VK call area mults in bandmap and available window are highlighted.
Added EXPERT to list of overlay categories choices. The EXPERT overlay category must be
selected for the 5 minute band change counter to not be active for SINGLE-OP.

This contest type is also used for the BARTG 75 baud sprints in April and September. For
information on setting up MMTTY and N1MM Logger for 75 baud RTTY, see the section on Using
MMTTY for 75 baud RTTY in the manual's Digital modes chapter.

7.6. CQ World Wide DX contest - RTTY

Window: Select Log type
Log Type: CQWWRTTY
Mode Category: RTTY
Sent Exchange:

North American/Canadian stations - Your zone plus the STATE or AREA Example:
05 NY

NB For cabrillo log submission the order must be: Zone first, then state (or
province).

with no leading spaces, and ONLY ONE space between the zone and the state.

Other stations - Your zone Example: 14

 
The default zone values for US (A,K,N,W) stations are

Zone 3 - If number in callsign is 6 or 7
Zone 4 - If number in callsign is 5 or 8 or 9 or 0
Zone 5 - If number in callsign is 1 or 2 or 3 or 4

 
The default zone values for Canadian (VE) stations are

Zone 1 - If callsign starts with: VY1
Zone 2 - If callsign starts with: VE2, VO2
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Zone 3 - If callsign starts with: VE7, VC7
Zone 4 - If callsign starts with: VE3, VE4, VE5, VE6, VA3
Zone 5 - If callsign starts with: VO1, VE1, XJ1, VY2

 
The default section values for Canadian (VE) stations are

VE - If callsign starts with: VE1, VE2, VE3, VE4, VE5, VE6, VE7, VE8, VO1, VO2,VY

 

Give 'Space' when the cursor is in the 'Callsign' field to have the 'Zone' field filled with the
default value.
The default zone will be selected, so that if you type another zone, it will replace the numbers
that the program put in there.
Abbreviations for Canadian regions are allowed
When typing the section and the entered section is new it will be shown in RED. The Available
window will also show if a section multiplier is needed on other bands
When pressing Space and the entered callsign is not US or VE, the cursor will skip the
state/section field.
When submitting your log to the contest robot make sure you have in the Sent Exchange the
correct order: Zone first, then state (or province).

 
Cabrillo output
The Cabrillo file must be in the order zone, state because that's how the official Cabrillo template for
CQ WW RTTY is defined. However, this has *nothing* to do with how you operate during the
contest, it only applies to the post-contest log submission. During the contest, you can send in
either order; all the rules say is you must send both. A lot of people seem to send zone, state.

However, the order state, zone is easier for people using N1MM because that's the order in the
entry window. It's also easier for people using software that calculates the zone from the state (like
N1MM logger does).

So: put zone, state in the contest setup dialog to ensure your Cabrillo file is OK, but you can please
yourself about the order in your exchange macros; state, zone (e.g. 599 ON ON 04-04) will make it
easier for fellow N1MM users, so it's the recommended order on this reflector!

7.7. CQ World Wide WPX contest - RTTY

Window: Select Log type
Log Type: CQWPXRTTY
Mode Category: RTTY
Sent Exchange: Serialnumber Example: 001

 
Leading zeros are being forced on sent & received serial numbers.

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

568 of 680 2/2/2011 4:54 PM



7.8. CIS contest - RTTY

The Commonwealth of Independent States Contest where everybody can work everybody for QSO
and multiplier credit.

Window: Select Log type
Log Type: CISDXRTTY
Sent Exchange:

CIS stations: CIS area code Example for Moscow City: RU11
Non-CIS stations: 001

 

7.9. DCRG Long Distance RTTY contest

 
This contest has replaced the ANARTS RTTY contest.

Window: Select Log type
Log Type: DLDCRTTY
Mode Category: RTTY
Sent Exchange: Zone Example: 14

 
The actual sent exchange includes a signal report, the UTC time and your CQ zone. Program this
into your Exchange messages using the {TIME2} macro, e.g.: {TX} 599 {TIME2} {EXCH} {RX}.

 

7.10. DL DX RTTY contest

Window: Select Log type
Log Type: DLDXRTTY
Mode Category: RTTY
Sent Exchange: 001

 
Note that PSK31 and/or PSK63 may also be used in this contest.

 

7.11. DMC RTTY contest

Window: Select Log type
Log Type: DMCRTTY
Mode Category: RTTY
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Sent Exchange: 001

 

7.12. EA PSK31 contest

Window: Select Log type
Log Type: EAPSK
Mode Category: PSK
Sent Exchange:

For Spanish stations - Province Example: AL
For non-Spanish stations - Serialnumber Example: 0001

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a Spanish station or a non-Spanish station.

7.13. EA RTTY contest

Window: Select Log type
Log Type: EARTTY
Mode Category: RTTY
Sent Exchange:

For Spanish stations - Province Example: AL
For non-Spanish stations - Serialnumber Example: 0001

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a Spanish station or a non-Spanish station.

7.14. EPC PSK63 QSO party

Window: Select Log type1.

 

Log Type: EPCPSK63QP
Sent Exchange:

EPC member stations: EPC membership number Example: EPC0001
Non-EPC member stations: 001

 

7.15. EPC PSK World Wide DX contest

Window: Select Log type1.
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Log Type: EPCWWDX
Sent Exchange:

EPC member stations: EPC membership number Example: EPC0001
Non-EPC member stations:

 

7.16. EU PSK DX contest

Window: Select Log type
Log Type: EUPSKDX
Sent Exchange: 001

 

7.17. JARTS WW RTTY contest

Window: Select Log type
Log Type: JARTSWWRTY
Sent Exchange:Your age Example: 34

XYL and YL stations may give 00
Multi-operator stations must send 99 as a operator age.

 

7.18. JT RTTY DX Contest

Window: Select Log Type
Log Type: JTDXRTTY
Mode Category: RTTY
Sent Exchange: CQ Zone (e.g., 5, 14, 23, etc.)

 

7.19. Makrothen RTTY Contest

Window: Select Log type
Log Type: MAKRORTTY
Mode Category: RTTY
Sent Exchange: 4 digit grid Example: JO33
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7.20. Logbook of the World Contest - RTTY/Digital

Window: Select Log type
Log Type:

LOTWRTTY
Sent Exchange:

For North American stations: State/Province abbreviation Example: CT
For non North American stations: Countryprefix

 

7.21. NA Sprint RTTY

Window: Select Log type
Log Type: SPRINTRTTY
Mode Category: RTTY
Sent Exchange: 001 Tom CT

Serial number, your name and your location (state, province or country) Example:
PA1M DE N1MM 123 TOM CT K

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a North American station or a non-North American station.

 

7.22. North American QSO Parties RTTY - NAQP

Window: Select Log type
Log Type: NAQPRTTY
Operator Category: SINGLE-OP or MULTI-TWO

For Multi-Two see the extra info below!
Mode Category: RTTY
Sent Exchange:

For North American stations - Operator name and station location (state, province,
or country) Example: Tom CT
For non-North American stations - Operator name only Example: Thomas

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a North American station or a non-North American station.

MULTI-TWO operating: When changing operator you have to use Ctrl+O to set the NAME (not
Call) of the operator. This name set with Ctrl+O will be used in the Cabrillo file. So from the Sent
Exchange only the state is being used but the name is needed. (Example: Tom CT). The macro
{OPERATOR} can be used to automatically switch WAV files (in SSB), for more info see the Macro
section.
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7.23. OK DX RTTY Contest

Window: Select Log type
Log Type: OKDXRTTY
Mode Category: RTTY
Sent Exchange: CQ zone

 

7.24. Quick PSK63 Contest

The contest uses the same rules as the SARTG WW RTTY contest so select that contest
(SARTGRTTY).
After the contest the Cabrillo output has to be updated (take SARTG WW out and replace with
Quick PSK63)

7.25. Russian PSK DX Contest

 

Window: Select Log type
Log Type: RUSDXPSK
Mode Category: PSK
Exchange:

Russian EPC members: EPC membership number, e.g. EPCRU0262
Others: Grid square, e.g. KO95

 

7.26. Russian DX RTTY contest

 

Window: Select Log type
Log Type: RUSDXRTTY
Mode Category: RTTY
Sent Exchange:

Non-Russian stations: WAZ zone Example: 14 for Western Europe
Russian stations: Your oblast code (two letters)

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a Russian station or a DX station.

7.27. Russian Cup RTTY contest
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Window: Select Log type
Log Type: RUCUPRTTY
Mode Category: RTTY
Sent Exchange: 001

 
This contest is for Russians only.

7.28. SARTG New Year RTTY Contest

Window: Select Log type
Log Type: SARTGNYRTY
Mode Category: RTTY
Sent Exchange: 001 + name + "Happy New Year" in your native language

 

7.29. SARTG WW RTTY Contest

Window: Select Log type
Log Type: SARTGRTTY
Mode Category: RTTY
Sent Exchange: 001

 

7.30. SCC RTTY Championship

Window: Select Log type
Log Type: SCCRTTY
Mode Category: RTTY
Sent Exchange: four-digit number of the year the amateur radio license was FIRST
officially issued (e.g. 1983) to the operator.

 
The score Summary window only shows your total score and the number of mults you have worked
per band. There is no breakdown by points. In SCC there is one extra column of mults but that had
to be there as the way things are setup to calculate the first multiplier (different years). Thus the
name of the second mult is "N/A" . The only way to do a breakdown on points is to go thru your log
and manually do it.

7.31. SP DX RTTY contest
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Window: Select Log type
Log Type: SPDXRTTY
Mode Category: RTTY
Sent Exchange:

001 for non-SP stations
Your province Example: B for Lubuskie

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a Polish station or a DX station.

7.32. TARA Grid Dip contest

Window: Select Log type
Log Type: TARAGRID
Mode Category: RTTY or PSK
Sent Exchange: name + 4 digit grid locator Example: Tom FN12

 

7.33. TARA PSK Rumble

Window: Select Log type
Log Type: TARAPSK
Mode Category: PSK
Sent Exchange: Name and Location Example: Tom CT

 

7.34. TARA RTTY Melee

Window: Select Log type
Log Type: TARARTTY
Mode Category: RTTY
Sent Exchange:

State for USA stations Example: CT
Province for Canadian stations Example: NB
001 for all other stations (serial number)

 

7.35. Ukraine Open RTTY Contest
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Window: Select Log type
Log Type: UKRRTTYOPEN
Mode Category: RTTY
Exchange: 2-letter province code + 3-digit serial number

 

7.36. Ukrainian RTTY contest

The Ukrainian DX contest can be configured for Ukrainian stations and non-Ukrainian stations.
Window: Select Log type

Log Type: UKRAINRTTY
Mode Category: RTTY
Sent Exchange:

Oblast for Ukrainian stations Example: CH
001 for non-Ukrainian stations

 

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are an Ukrainian station or a non-Ukrainian station.

7.37. UR DX DIGI Contest

 
75 baud RTTY and PSK63 modes

Window: Select Log type
Log Type: UKRAINDIGI
Sent Exchange:

Oblast for Ukrainian stations Example: CH
001 for non-Ukrainian stations

 

7.38. UK DX contest RTTY

 
The UK DX contest can be configured for UK stations and non-UK stations.

Countries are counted per band for SSB, CW and RTTY, because RTTY is in a separate contest
module they won't be counted correct when a station makes next to SSB and CW also RTTY q's
or the other way around.

Country Count
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Window: Select Log type
Log Type: UKDXRTTY
Sent Exchange:

Area code for UK stations Example: BS
001 for non-UK stations

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are an UK station or a non-UK station.

7.39. VOLTA RTTY Contest

Window: Select Log type
Log Type: VOLTARTTY
Mode Category: RTTY
Sent Exchange: QSO number + Your CQ Zone. Example: 001 15

 
The four Band Multiplier count for this contest is displayed on info window.

7.40. WAEDC contest

The WAEDC Contest can be configured for European stations and non-European stations.

Window: Select Log type
Log Type: WAERTTY
Sent Exchange: 001

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are an European station or a non-European station.

Making QSOs in WAE RTTY by Rich, VE3KI.

To start with, a QSO in WAE is just like a QSO in CQ WPX or SARTG, and I would suggest using
the same function-key set.

In CW and SSB WAE, QTCs can only be sent from non-EU to EU, but in RTTY there are many
more possibilities. QTCs can be sent in either direction between any two continents (not with a
station in the same continent). This makes WAE RTTY quite a bit more complex that WAE CW.

First, let's suppose you are CQing. If you have a good run going you probably will not want to break
your rhythm for QTCs. As long as there are people waiting to work you when you CQ, you are
probably best off just adding to your QSO count.

However, if your rate drops off, you might want to pick up your score with some QTCs. First, let's
look at the case where you do not have many unsent QTCs to send (that's previous QSOs that you
have not already sent as QTCs). In this case, if you work someone who has a good clear signal and
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you have not yet exchanged QTCs with him, you may want to receive some. You can see how many
QTCs you have exchanged with him and how many unsent QTCs are remaining in your log near
the bottom of the entry window while the cursor is in the exchange (Nr) field.

Start by asking him if he has any QTCs for you ("QSL TNX. ANY QTCS FOR ME?"). If he says yes,
press Ctrl+Z once. That gets you to the RQTC window for receiving QTCs (it's in the right half of the
digital interface window). After you tell him you are ready with RX Ready, he will send you a
message whose first line is something like "QTC: 22/10 QTC: 22/10". The first number is the group
number (the 22nd group he has sent), the second is the number of QTCs in the group (maximum
10, and especially in RTTY it is most efficient to sent only large groups). If you click on this in the
RX window, it should transfer to the RQTC window.

The heart of his message will be a set of 10 QTCs. Each QTC contains three elements: the time,
the call sign, and the serial number. Each time you receive a QTC, left-click on it and the entire
QTC should transfer into the corresponding panes in the RQTC window. You can also enter or edit
elements by hand, or you can right-click on a single element and then left-click in the box where
you want it to go. After you have received all 10 QTCs, it may help to click on the green bar at the
left of the RX window so you can freeze the RX window, scroll back and complete or fix any missing
or garbled elements. Remember to click on the yellow bar when you are done so you can receive
again.

There are buttons in the RQTC window for asking for repeats for individual QTCs or for the whole
series. Once you have them all, press Save QTC which will send an acknowledgement message to
him and log the QTCs, and then you can start CQing again.

Suppose instead that you do have a bunch of unsent QTCs ready to go. Then what you may want
to do at the end of a QSO with a station with a good clear signal (if you have trouble copying
someone's signal, you will not want to try QTCs with him) is to ask if he wants to receive QTCs
("QSL TNX. DO YOU WANT QTCS?"). If he says yes, press Ctrl+Z twice to get to the SQTC
window. The buttons in this window should be self-explanatory; the main one is Send All, but if he
asks for a repeat of #3, 7 and 9 you can resend them by pressing Snd #3, Snd #7 and Snd #9.
Once he acknowledges them all, press Save QTC and go back to CQing.

If you get into the wrong QTC window by mistake, you can either press Cancel or just keep
pressing Ctrl+Z until you get back to the normal digital interface receive window.

S&Ping works the same, except usually it is better to let the running station decide if he wants to do
QTCs or not, depending on how well his run is going. If he wants to send QTCs to you, you can
either reply "SRI QRU" (not quite right, but he will get the message) or you can press Ctrl+Z once
to get the RQTC window and press the RX Ready button to tell him you are ready, then receive
QTCs the same as described above.

If he asks you whether you have QTCs for him, you have three options: press Ctrl+Z twice and
press the R U QRV button to give him the cue to get ready; send "SRI QRU"; or send a message
telling him you don't have any but are willing to receive some ("SRI QRU. ANY QTCS FOR ME?").

Most of the QTC messages are sent by buttons in the SQTC and RQTC windows. You can program
the messages in these buttons from the Setup -> Settings menu in the digital interface window,
under the third tab ("WAE RTTY Configuration").
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There are a few additional messages you will want to program into the buttons at the bottom of the
digital interface window, such as:
{TX} QSL TNX. GOT ANY QTCS FOR ME? {RX}
{TX} QSL TNX. DO YOU WANT QTCS? {RX}
{TX} SRI QRU {RX}
{TX} SRI QRU. ANY QTCS FOR ME? {RX}

You may think of more - that's OK, there are up to 24 message buttons in the digital interface
window. I often find myself changing them on the fly during a contest. You can get to the
programming window by right-clicking on the button you want to change. Hope that helps.

73, Rich VE3IAY

NB. The QTC window for the RTTY contest is in the Digital Interface window. During the QTC
send/receive process for WAE RTTY you should not be looking at the Entry window.

The first time you press Ctrl+Z the Receive QTC window opens up in the right side of the Digital
Interface. Down the right side you will see buttons labeled RX Ready, All AGN, AGN #1, AGN #2,
..., AGN #10, and across the bottom are Cancel, Save QTC and Clear buttons.

If you want to send QTCs instead of receiving them, just press Ctrl+Z again and the Send QTC
window takes the place of the Receive QTC window. The top two buttons change to R U QRV and
Send All, and the rest stay the same. The data windows are automatically filled from your log.

If you have used up your QTC quota with the station whose call sign is in the entry window,
pressing Ctrl+Z the first time leaves you in QSO mode and does not open the QTC window. If you
have not used up your quota with him but you do not have any QTCs ready to be sent, then
pressing Ctrl+Z the first time displays the Receive QTCs window, and pressing it the second time
returns you directly to QSO mode.

QTC Lines on the frame are broken up into separate boxes. This was done to allow error
checking of any data that is input by hand and clicking on data in RX window.
If you click on data or enter data in the QTC windows if the routines detect bad data it will flag
that data in red. So when you are receiving QTCs and you get one that is garbled, Click on it
anyway and it will get placed into the QTC area. The boxes for that QTC will turn red.
Upon completion of the sending QTC's all you have to do is look at the QTC window and it will
tell you by the red colors what QTC you need to RX again. You press the AGN # button and it
sends your message out. At the same time your message is going out the QTC line is cleared.
Now when the station sends the repeat of the QTC you requested and you click on it and it
will then be placed into that blank line that was just cleared.
When saving QTC if any of the data still hasn't been corrected it will send the received ok
message but if there is an error in the Time or the Callsign the program will let you save the
QTC and not care about it. But if there is an error in the serial number (If it contains anything
besides a number) it will not let you save it. The reason for this is in the program the serial
number needs to be a certain type of variable(numeric) and if it is not a numeric variable it will
not save it. So the flow of it if there is an error in the serial section and you press save is:

A. Sends the confirm string you have setup
B. Tells you on the entry window there is a Format error
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C. Waits for you to fix it.
D. So now you would have to scroll back to see what was sent of take out the extra letter your finger
hit then hit save.
By doing it this way you are not slowing down the other station.....

The program will not save info into the log until the bad data is fixed. Once fixed just click save
again and it will save the data without sending the received message. A warning message is
given in the Entry window status bar.
To select whole lines of received QTC just place the cursor over the line and left click.
To select individual QTC sections place the cursor over the item you want to select and right
click on it. After the data is selected place the cursor over the text box you want the data to go
into and left click it will be placed into it.
When pressing Ctrl+Z to switch modes the program will display the total QTC sent and
received from the station being worked. When the QTC frame opens on the DI only the
Needed amount of QTC boxes will be enabled. Example(if I have worked UT5XXX and
received 5 QTCs from him, the next time I work him and I open up the Receive QTC frame
only 5 QTC lines will be enabled to reach maximum QTC amount .
When pressing Ctrl+Z to switch modes if you have reached the MAX amount of QTC the QTC
frame will close and give a warning message in Entry windows status bar.
When left clicking on a Received QTC line will split data on " ","/","-" separators if the routines
can't split the data it will not copy the data over. You will have to click each item separate or
hand type it in.
Selecting of individual QTC items can be done by right clicking on item. Left clicking on the
box where the data to be placed places text.
Ctrl+Z cycles through QSO, receive QTC and send QTC modes. After you enter a callsign in
the entry window pressing Ctrl+Z will cycle through the RQCT and SQTC modes. If you are
receiving QTC press Ctrl+Z once and as the QTC appears in the digital window just click on it
one time and it will transfer over to the QTC entry window. To send a QTC press Ctrl+Z one
more time and it will show you all the QTCs you have available to send.
The status line in the Info window shows the total QTC Sent and Received from the station
being worked.
Upon entering a callsign in the entry window and pressing the spacebar. The number of total
QTC's exchanged with that callsign and the Total of all unsent QTC is displayed on the entry
window so you should be able to keep track easier of what your QTC numbers are.
If you work a station that is on your same continent and try to send them QTC or try to receive
QTC from them the program will tell you you can not do that. Press enter and move on......
On the WAE Tab located in the settings area will allow you to set the maximum number of
QTC you want to send. Whatever this setting is set to is the number that will send unless you
do not have that many QTC to send. This defaults to 10.
An error message is displayed when the serial number is blank when logging a contact
The total unsent QTC's is displayed along with # of QTC's exchanged with current callsign on
the Entry window
Continent is checked when sending and receiving QTC's
Default number of QTC to send can be entered on the Tab WAE RTTY configuration under
Settings in the menu from the DI interface.
The number of QTC sent and total QTC available ois shown in the Entry window upon
Entering Callsign
Hover mode if disabled if the QTC window is open
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The number of CR's between QTC's sent is configurable (Setup QTC)
Placing a QTC into the QTC window is possible by clicking in line of QTC boxes where you
want QTC to be placed into.
When tuning in the bandmap the Entry Window will show the QTC status of the tuned
callsign.
A warning message is shown when a recieved number is not entered

 
For more information look at WAEDC for SSB/CW. However, there are 2 fundamental differences
between the RTTY and the SSB/CW version of the contest:

1. Everyone can work everyone, so DX can work DX and EU can work EU
2. Everyone can both send and receive QTCs, however they can only be exchanged between
stations in a different continent

How do I know how much QTC I can receive from a station or how do I know the number to
send to them?

The program will do all this for you in a number of ways...

The first number that is displayed on the entry window by the QTCs title is the total number of
QTC's you have exchanged with that station. If it says 8 then you can either receive or send 2
more
When you press Ctrl+Z to switch to RQTC mode the program already knows how many QTC
you can receive and will only enable that many entry points on the QTC frame
When you press Ctrl+Z to switch to SQTC mode the program will either set the maximum
number you want to send or however many QTC's you are still allowed to send to that station.
(Whichever is smaller)

 

7.41. XE RTTY Contest

Window: Select Log type
Log Type: XERTTY
Mode Category: RTTY
Sent Exchange:

Mexico: State. Example: AGS
Non-Mexico: 001

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call )
determines if you are a Mexican station or a non-Mexican station.

Supported Radios

In this Section...
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Supported Radios
1. General Information
2. Manual mode
3. Digital Information
4. Alinco
5. Elecraft

5.1. K2
5.2. K3

6. FlexRadio
7. Icom

7.1. General Icom information
7.2. IC-271 / IC-471 / IC-1271
7.3. IC-275A/E/H using address 10 hex and 9600 bps.
7.4. IC-375 / IC-575 (all versions)
7.5. IC-475A/E/H using address 14 hex and 9600 bps.
7.6. IC-703 using address 68 hex and 19200 bps.
7.7. IC-706 using address 48 hex and 19200 bps.
7.8. IC-706MKII using address 4E hex and 19200 bps.
7.9. IC-706MKIIG using address 58 hex and 19200 bps.
7.10. IC-718 using address 5E hex and 19200 bps.
7.11. IC-725 using address 28 hex and 9600 bps.
7.12. IC-728 using address 38 hex and 9600 bps.
7.13. IC-729 using address 3A hex and 9600 bps.
7.14. IC-735 using address 04 hex and 9600 bps.
7.15. IC-736 using address 40 hex and 9600 bps.
7.16. IC-737/737A using address 3C hex and 9600 bps.
7.17. IC-738 using address 44 hex and 9600 bps.
7.18. IC-746 using address 56 hex and 19200 bps.
7.19. IC-746 PRO using address 66 hex and 19200 bps.
7.20. IC-751/751A using address 1C hex and 9600 bps
7.21. IC-756 using address 50 hex and 19200 bps.
7.22. IC-756 PRO using address 5C hex and 19200 bps.
7.23. IC-756 PRO II using address 64 hex and 19200 bps.
7.24. IC-756 PRO III using address 6E hex and 19200 bps.
7.25. IC-761 using address 1E hex and 9600 bps
7.26. IC-765 using address 2C hex and 9600 bps.
7.27. IC-775/775DSP using address 46 hex and 19200 bps.
7.28. IC-781 using address 26 hex and 9600 bps.
7.29. IC-910H using address 60 hex and select the correct baud rate.
7.30. IC-1275A/E using address 18 hex and 9600 bps.
7.31. IC-7000 using address 70 hex and 19200 bps.
7.32. IC-7200 using address 76 hex and 19200 bps.
7.33. IC-7400 (identical to the IC-746 Pro)
7.34. IC-7600 using address 7A hex and 19200 bps
7.35. IC-7700 using address 74 hex and 19200 bps.
7.36. IC-7800 using address 6A hex and 9600 bps.

8. Kenwood
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8.1. General Kenwood information
8.2. TS-480
8.3. TS-570
8.4. TS-590
8.5. TS-850
8.6. TS-870
8.7. TS-950sdx
8.8. TS-50, TS-140, TS-440, TS-680,TS-711,TS-790,TS-811,TS-940
8.9. TS-2000
8.10. N1MM logger loses communication with the radio (TS-850, TS-950 etc.)

9. TenTec
9.1. General TenTec information
9.2. ARGONAUT V
9.3. JUPITER
9.4. OMNI-VI
9.5. OMNI-VII
9.6. Orion

10. Yaesu
10.1. General Yaesu information
10.2. FT-80C
10.3. FT-100(D)
10.4. FT-736
10.5. FT-450
10.6. FT-747GX
10.7. FT-757
10.8. FT-757GXII
10.9. FT-817
10.10. FT-840
10.11. FT-847
10.12. FT-857
10.13. FT-890
10.14. FT-897
10.15. FT-900
10.16. FT-920
10.17. FT-950
10.18. FT-990
10.19. FT-1000(D)
10.20. FT-1000MP (Mark-V)(Field) (Not for use with SteppIR antenna
controller)
10.21. FT-1000MPSteppIR
10.22. FT-1000 series, FT-990 and FT-920 Setting filters
10.23. FT-2000
10.24. FTDX-5000
10.25. FTDX-9000

Note: Known settings for specific transceivers, as well as program features that they do not support
are mentioned below as far as we know them. Please advise us of any corrections or needed
changes.
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1. General Information

 

When using a home-brew self-powered interface set the handshaking to:
DTR - Always On
RTS - Always On
Like when using ICOM clone cables

All radios: Band change is not allowed while transmitting
All radios: Timeout for all radios is default set to 10 seconds (user settable).

Some radios require initialization commands for configuration. These are sent to the
radio when the program starts. Users should have the radio and interface powered prior
to starting the program so this can occur. If the radio needs to be power cycled after the
program has initialized, right click in the Bandmap and select Reset Radio to perform
this initialization again
A warning message will be displayed when no response received from the radio and the
radio will be changed to a manual radio by the program.
To get the radio working again select in the right-click menu from the bandmap "Reset
radios"
When the radio control gives a warning 10 seconds after you start the logger, then you
never had radio control at all, and you should check your hardware, and serial port
settings. Consult the manual from your radio and also read below.Some radios require
initialization commands for configuration. These are sent to the radio when the program
starts. Users should have the radio and interface powered prior to starting the program
so this can occur. If the radio needs to be power cycled after the program has initialized,
right click in the Bandmap and select Reset Radio to perform this initialization again

Polling of radios while sending CW is supported for all radio except for FT-1000.
It may appear that the Up Arrow, Down Arrow, Page Up or Page Down are not working when
incrementing or decrementing the current frequency with these keys.

The VFO frequency will not change if the incremented/decremented amount is smaller
than the frequency deltas supported by your rig. This is not always well documented by
the manufacturer. Icom 751 rigs for example do support 10 Hz steps but only show 100
Hz steps on the display.
The keys mentioned above have to be set higher than the minimum step size supported
by the radio.
It's easy to test if it is the keys are working. Check the frequency while pressing the keys
mentioned above. If the frequency moves nothing has to be changed.
The default increment/decrement for CW is 10 Hz. If this doesn't work, try changing it to
100 Hz, under the Configurer, Other tab.
This only applies to the keys that increment/decrement the current frequency.

Kenwood, Orion, Icom, FT-1000MP - Code has been added that requires new band changes
to be received twice from the radio before changing band. This change is to improve the
reliability of frequencies displayed/used.

NB: This will make band changes made from the radio twice as slow to appear as band
changes made from the program.

Memory mode - most modern radios (100mp, TS2000) have a kind of memory mode. In this
mode the radio will normally not function with the program. Use VFO mode instead.
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When SO1V mode is selected, VFOB is not defined for receiving. The user should close the
second Bandmap and Entry window.

 

2. Manual mode

In manual mode no radio is selected and attached to the program. If possible always connect a
radio using the CAT interface or serial port. Older radios (or very new not supported radios) can still
be used with the program by selecting Manual but many functions in the program will not work as
easy as they could or will not work at all. When a radio is not configured, it is the user's
responsibility to make sure the mode and band are correct when logging contacts. When no radios
are selected in Configurer, the program will attempt to set the initial operating mode and frequency
in single mode contests when the program starts or a new contest is opened. The program uses
information from the contest selection and the mode tab settings in Configurer.

3. Digital Information

 
Below information by Rick, N2AMG and John, K3CT regarding supported Digital configurations by
N1MM logger.
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Radio Modes Corresponding to N1MM Logger Digital Mode Designations
Column Headings = Mode names used in N1MM Logger

Radio RTTY RTTY-R AFSK AFSK-R PSK PSK-R

FT990/1000/1000MP RTTY-L RTTY-U PKT-LSB (4)

FT100 Dig(3)

FT950/2000
/5000/9000

FSK(RTTY-LSB) FSK-R(RTTY-USB) PKT-LSB PKT-USB

FT450 RTTY-L RTTY-U User-L User-U

FT817/857/897 Dig(3)

FT920 Data-LSB(2) Data-USB(2)

IC7600/7700/7800 RTTY RTTY-R LSB-D1 USB-D1 PSK PSK-R

IC746Pro/756ProII
/756ProIII/7200

RTTY RTTY-R LSB-D USB-D

Other Icom RTTY RTTY-R

Orion/OmniVI
/OmniVII

FSK

K2 RTTY RTTY-R

K3 FSK D FSK D-R AFSK A AFSK
A-R

DATA
A

DATA
A-R

TS2000 FSK (1)

Kenwood FSK FSK-R

TS440 AFSK

 
(1) = radio menu selection

(2) = FSK/AFSK selected by a rear panel switch

(3) = Radio menu programmable for RTTY, RTTY-R, PKT-L, PKT-U

(4) = FT990/1000/1000MP selection does not support PKT-USB

If your radio does not have an entry under AFSK or PSK, use LSB or USB (e.g. Argonaut/Jupiter
/FT840/847/890/900/757GXII). If there is an entry under AFSK-R but not under PSK, try using
AFSK-R for PSK31 and other digital modes.

4. Alinco

 

DX-77 - supportedl
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5. Elecraft

 

Elecraft USB-serial converter issues and N1MM logger
Situation: Setting up Elecraft K3 to work with N1MM logger and simply key CW with DTR
line of CAT port.
Results: CAT works fine, but every time I try to send CW there appears an error window
"CommPortDev_OnComm 4 - 2147417856"

N1MM is totally blocked and has to be killed using task manager.
Solution: The Elecraft USB-serial converter uses a Profilic chip, and the (Win2K) Profilic
driver doesn't work correct for CAT and DTR-CW-keying using the same port.

A USB-serial converter using a FTDI-chip and the FTDI drive is working fine, CAT
ok, fast CW keying, ESC immediatly interrupts message ...
All ufb now :- Tnx Thomas DK3DUA

5.1. K2

Uses Kenwood-style commands but has its own radio selection. Only the KY command
which is Elecraft specific is not supported.
Use default Kenwood parameters but sometimes one (1) stopbit only works (contrary to
the K2 KPA100 manual saying that 2 stop bits should also work).
N1MM Logger does not support the K2 "virtual keying" feature using commands sent to
the K2 serial port.
Setting the "Wide" and "Narrow" filter codes.

Remember to set the filter codes for both VFOs. Get the appropriate N1MM Logger
screen menu prompt by left clicking when your cursor is over the active VFO
window.
Substitute this code for the complete Kenwood "FL" code that comes up by
default: K22;FW99991;K0; (no spaces, all caps, include the ";"'s) This will set the
filter to "FL1" on the K2. If you put this code in the SSB "Wide" section for the filter
code, it will give you FL1 for SSB - if you put this in the CW "Wide" section, it will
give you FL1 for CW. Remember that the actual bandwidth of the filter will depend
on how you have set FL1 on your K2. The same is true when you substitute this
string for the "Narrow" settings. If you want a filter other than FL1 in either mode,
just change the "1" after the 9999 to the number of the filter you want to invoke ie:
1,2,3 or 4. As an example, K22;FW99993;K0; placed in the code section for CW
"Narrow" would invoke FL3 when the switch is set to "Narrow" and you are on CW.
Briefly, "K22" tells the K2 that this is an "extended command mode" - the ";" tells
the K2 that this command is finished - the "FW" tells the K2 that this is a command
to set the filter width - the 9999 number is ignored in the string but is necessary to
include (it can be any set of four numbers between 0 and 9999 - I just picked 9999)
- the "1" is the number of the filter to invoke (1 - 4) - the "K0" (that is "K" zero) tells
the K2 to go back to the "normal command mode."
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Use the same technique to set the RTTY filters as well. Have fun es 73, Don N4HH
Please check out the feature which works great with the K2 and TS850 etc that don't
have RIT clear IF you are Running (doesn't work for S&P). Put the rig into split, and use
VFO B as your "RIT". Then go into Config, and turn on "Reset RX Freq when Running
Split". Using VFO B for RIT, tune in a caller off freq, work him, and at the end of the
QSO VFO B will be set to VFO A freq. Neat feature, and specifically designed for this
situation.

5.2. K3

When using program version 10.3.6 or newer, the radio firmware must be version 3.46 or
newer for proper operation.

 

Radio control issues have been reported when running other K3 utility software in
conjunction with N1MM Logger. Please test with only N1MM Logger running before
reporting a radio control issue.

 

A single receiver K3 can be used in SO1V or SO2R mode. A dual receiver K3 can be
used in all program modes, including SO2V
ALT+F12 toggles Sub on and off. It is identical to pressing the SUB radio button. To
leave SUB on all the time, select Configurer>Dual RX always on

If you have selected Diversity mode on the radio, toggling Sub off and on via
Alt+F12 will turn Diversity mode off
Logger preserves diversity reception on the K3 unless RX Focus changes to vfoB
at which time the subrx will switch to vfoB

K3 Subrx ON/OFF control by Logger
Independent of the state of Dual RX Always On:

changing RX Focus to vfoB turns the subrx ON
Ctrl+Shift+Up/Dn does not change the state of the subrx
Alt+F12 toggles subrx ON/OFF if RX Focus is on vfoA (action disabled if RX
Focus on vfoB)

Dual RX Always On checked:
clicking any vfo bandmap/avail. window spot or Ctrl+Up/Dn turns the subrx
ON
changing RX Focus turns the subrx ON
if dual rx always on was unchecked and the user checks it, subrx is turned
ON

Dual RX Always On unchecked:
If the TX & RX Focus is on VFOB and the RX Focus changes to VFOA ( \
keystroke), the subrx stays ON
If the TX & RX Focus is initially on VFOB and then RX & TX Focus is on
VFOA (PAUSE, CTRL+Left or vfoA Bandmap/Available window spot click ),
the subrx is turned OFF
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if dual rx always on was checked and the user unchecks it, subrx is turned
OFF

Ctrl+Alt+D command action:
If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX Always On" to
OFF and leave the Sub RX ON
If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual RX Always On" to
OFF and leave the Sub RX OFF
If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual RX Always On" to
ON and leave the Sub RX ON
If "Dual RX always on" is OFF and the Sub RX is OFF, turn both ON

Stereo (grave accent) command action:
If the subrx is OFF - check "Dual RX always on" and turn the subrx ON
If the subrx is ON - uncheck "Dual RX always on" and turn the subrx OFF unless
RX Focus is on vfoB

Digital radio modes FSK D, AFSK A and DATA A are supported
FSK D, AFSK A and DATA A are displayed in N1MM as RTTY, AFSK and PSK
respectively
PSK D is not supported by N1MM
Adjust audio levels in AFSK A and DATA A to give 4-5 bars on the K3's ALC meter.
This allows the K3's firmware ALC to control power without clipping peaks and
causing IMD. In PSK31 and other digital modes requiring high linearity, keep the
requested power setting below 60 watts (AFSK RTTY can be safely used at 100
watts)

RIT control - When in RUN mode, the Up/Dn arrow keys change the RIT frequency (if
the K3's RIT is turned on). When in S&P mode the radio frequency is changed
Using the program as a voice keyer with a K3 on SSB:

Option 1
Connect your microphone to the mic input of the sound card and the Line
Out of the sound card to the Line In on the back of the K3
Set soundcard program to drive Line In
Select LINE IN with MENU:MIC SEL
Command Tx (or PTT or...) and adjust the MIC GAIN (which is now LINE IN
gain) for proper audio level

Option 2
Connect microphone to desired microphone connection on the K3
Select MIC with MENU:MIC SEL
PTT and set Mic Gain
Connect sound card as described under Option 1
Now, if you set MIC+LINE ON then both audio sources will drive the K3. The
MIC GAIN control will control the MIC GAIN only. LINE IN GAIN must be set
when LINE IN is the selected source via MENU:MIC SEL

The K3 can accept PTT switching from several sources, including: a keying circuit from a
serial or parallel port to the K3's PTT IN; PTT from a Winkey; RTS (pin 7) on the radio
control port; or using "Radio PTT via command"

Do NOT use multiple methods of PTT control in parallel; in some cases doing so
can leave the K3 stuck in transmit at the end of function-key messages. In
particular, do NOT check "Radio PTT via command" if you are using RTS on the
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radio control port, or any other hardware PTT connection, to control PTT. Using
"Radio PTT via command" together with hardware PTT control can cause the K3 to
get hung up in transmit, so don't do it!
Procedure for configuring RTS on the radio control port: Start with the K3's
CONFIG:PTT-KEY set to OFF-OFF; configure N1MM to control PTT from RTS on
the radio control port (Port setup); set the K3's CONFIG:PTT-KEY to RTS-OFF
Warning: leaving RTS set to Always on with the K3's CONFIG:PTT-KEY set to
RTS-OFF or RTS-DTR will cause the K3 to be permanently in transmit

The K3 accepts CW keying on DTR (pin 4) of the same COM port you're using to control
the K3. This method can be used when other methods (e.g. Winkey or a keying circuit
on a separate COM or LPT port) are not available

CW and radio control on the same COM port do NOT work in SO2R mode
CW on DTR does NOT work with some USB-to-serial adapters (e.g. Prolific
chipset)
CW on DTR may be missing some capabilities and may have other undesired side
effects - use at your own risk
Procedure: Start with the K3's CONFIG:PTT-KEY set to OFF-OFF; check the
CW/Other box beside the radio control port in the Configurer and configure N1MM
to use DTR for CW on that port; set the K3's CONFIG:PTT-KEY to OFF-DTR
Warning: leaving DTR set to Always on with the K3's CONFIG:PTT-KEY set to
OFF-DTR or RTS-DTR will cause a permanent "key-down" condition

 

6. FlexRadio

 

SDR-1000 and SDR-5000A (using Kenwood settings)
By: Rob AB7CF
Some setup details are not really needed but are included for completeness. One thing I
notice different is in PowerSDR Cat setup I use ID as: "PowerSDR" though it shouldn't
make a difference. Probably the most common Vcom mistake is a failure to click Update
Driver and following the procedure after making a change in Vcom configuration..
Example: using VCom configurator using ports 4-5 defines and VAC
Check your VCom configurator to make sure you have a check box in the COM4 - COM5
pair and you have clicked Save Configuration. MAKE SURE you click the Update Driver
and follow the instructions. Close VCom configurator. Click on Window's Start Button,
Click on ControlPanel, Click System, Click on the Hardware Tab, Click on Device
manager.
In Device manager make sure there ISN'T a yellow question mark on the entry labeled
"Multi-port serial adapters." If there is no yellow question mark your Vcom virtual cable
should be working properly. If there is an yellow question mark there is a problem with
your Vcom installation which needs attention. Assuming no problem, Close
ControlPanel.
Now check PowerSDR. Open PowerSDR Setup and click on the CAT Control tab. In CAT
Control make sure Enable CAT is checked. Under PTT make sure Port 4 is selected and
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RTS and DTR are unchecked. Select ID as: PowerSDR. Click Apply. Close PowerSDR
Setup.
Now check N1MM. Click Config. Select "Configure Ports, Telnet Address,Other" Under
Com-5 select Kenwood. Make sure CW/PTT is unchecked. Now click Set. In the popup
box the settings should be: Speed 4800, Parity: N DataBits: 8, Stop Bits: 1 DTR (pin 4) =
Handshake. RTS (pin 7) =Handshake, 1 selected in Radio/VFO. Leave the "Radio PTT
via command" check box UNCHECKED. Check the "Allow external interrupts" check box.
Click Okay (twice) to back out.
Now you should be communicating with your SDR. Check that clicking a new frequency
in the Panadapter changes frequency in N1MM. With the focus in N1MM check that the
keyboard up and down arrows change the PowerSDR frequency.

 

7. Icom

 

7.1. General Icom information

*

Almost every Icom rig requires an ICOM CT-17 CI-V interface or compatible. If your Icom
radio has a USB computer interface (IC-7200, IC-7600, etc), install the latest driver for
the virtual COM port and audio codec.
Icom rigs use software handshaking. That means they do not use DTR and RTS.
However, interfaces that get their power from the RS232 port require you to set DTR
and/or RTS to "Always On" to supply power to the interface. Check your interface
manual to see how DTR and RTS must be set.
Set N1MM Logger and the rig to:

Address - see specific rig information below
Baud Rate - 9600 or 19200 (see specific rig maximum rates below)
Data Bits - 8 bits
Parity - None
Stop Bits - 1 bit

On your rig, set:
"CI-V Transceive" to OFF - this is very important. If CI-V is set incorrectly the
Bandmaps will not update as the VFO is turned. If the VFO is turned continously,
the program may produce a stack overflow and halt.
"CI-V with 731/735" to OFF. On some rigs this is referred to "4 or 5 Byte Data" or
"Frequency Data Length". You want your rig to use 5 data bytes for the frequency.
A few rigs noted below do not have this option.

Due to the limited Icom radio control, the user needs to control the radio from the
keyboard. This means that the user can not press these buttons on the radio: SPLIT,
DUALWATCH, CHANGE, VFO/MEMO, A=B, A<>B, or MAIN/SUB. Icom radios only report
the VFO frequency of the active VFO. Because of this, the program will select each VFO
to read the frequency at initialization.
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To set and clear split use ALT+F7 or one of the other keyboard commands. Split will be
correctly set/cleared when clicking in the Bandmap or Available windows. To select
VFOB (SO2V mode only), use the PAUSE or CTRL+Right/Left Arrow keys. In SO2V
mode, the VFO is also selected with a Right or Left click on the band buttons in the
Available window.
Frequencies > 2 GHz are ignored and not sent to the radio.
To do CW with an ICOM radio a cable is needed between the radio and the serial or
parallel port with an appropriate interface.

The CI-V cable or serial cable to the radio alone is not enough to do CW but
needed to have radio support (frequency, mode readout/settings etc.).

The ALT+F10 swap VFO frequency command is disabled during SO2R for Icom radios
that lack a swap VFO CAT command. This is because the program is unaware of Icom
VFO B frequency in SO2R mode.

 

The models below are supported:

7.2. IC-271 / IC-471 / IC-1271

Select IC-706 and set the radio address to hex 48 or program the default radio
address in the program setup window. Please report on program functionality.
There are several limitations caused by the lack of several CI-V commands. VFO
select and split commands are not supported. This will prevent the program from
controlling the radio split and reading or programming VFOB frequency. SO2V
mode should not be attempted and VFOB's Bandmap and Entry windows can be
closed.

7.3. IC-275A/E/H using address 10 hex and 9600 bps.

The CI-V command set lacks split ON/OFF commands. This prevents the program
from controlling the radio split.

7.4. IC-375 / IC-575 (all versions)

Select IC-706 and set the radio address to hex 48 or program the default radio
address in the program setup window. Please report on program functionality.
The CI-V command set lacks split ON/OFF commands. This prevents the program
from controlling the radio split.

7.5. IC-475A/E/H using address 14 hex and 9600 bps.

The CI-V command set lacks split ON/OFF commands. This prevents the program
from controlling the radio split.
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7.6. IC-703 using address 68 hex and 19200 bps.

7.7. IC-706 using address 48 hex and 19200 bps.

7.8. IC-706MKII using address 4E hex and 19200 bps.

7.9. IC-706MKIIG using address 58 hex and 19200 bps.

7.10. IC-718 using address 5E hex and 19200 bps.

Set N1MM Logger to 19200 bps and the radio to "AT" (AuTo).

7.11. IC-725 using address 28 hex and 9600 bps.

7.12. IC-728 using address 38 hex and 9600 bps.

7.13. IC-729 using address 3A hex and 9600 bps.

7.14. IC-735 using address 04 hex and 9600 bps.

The CI-V command set lacks split ON/OFF commands. This prevents the program
from controlling the radio split.
When the IC-735 is used with factory settings (1200 baud, transceive ON), the
bandmap response of N1MM is extremely slow. Jumpers J22 located on the
PL-unit board (upper side under PA unit) allow baud-rate, address and CI-V
transceive to be changed. But.. the jumpers are not labeled and not in the order as
stated in the Service manual. In fact transceive ON/OFF is the last one (front panel
toward you, tarting from left) this one should be removed to turn transceive OFF.
The 2 first ones set the baud-rate (move the second one to the first position to
switch from 1200 to 9600 baud) the 3 remaining ones are the CI-V address -
default 04; is with last the last one of this group of 3 - ON.

 
Jumper J22 settings for 9600 baud, transceive OFF and default address 04 - from left to right with
front panel toward you...

1 2 3 4 5 6

ON OFF OFF OFF ON OFF

Baud rate Baud Rate Address Address Address CI-V transceive

These settings make the 735 operable with N1MM (trx IC735 / baud rate 9600 / 8 data bits / no
parity / 1 stop bit). DTR and/or RTS are not used by the Icom CI-V (no handshake) so does not
matter. However, they should be turned to "always ON" if using an interface powered though those
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pins. Alternatively, they can be used for CW and PTT, for example if you are limited by the number
of COM-ports on your machine. 73' Patrick F6IRF

 

7.15. IC-736 using address 40 hex and 9600 bps.

7.16. IC-737/737A using address 3C hex and 9600 bps.

The CI-V command set lacks split ON/OFF commands. This prevents the program
from controlling the radio split.

7.17. IC-738 using address 44 hex and 9600 bps.

7.18. IC-746 using address 56 hex and 19200 bps.

VFO-B is a virtual VFO as long it isn't activated. The scale is not controlled by the
VFO-B of the transceiver. It becomes an active VFO when it is activated. The
IC-746 is switched to VFO-B and set to the frequency shown in the VFO-B
bandmap.

7.19. IC-746 PRO using address 66 hex and 19200 bps.

USB-D / LSB-D digital modes supported.

7.20. IC-751/751A using address 1C hex and 9600 bps

There are several limitations caused by the lack of some CI-V commands. VFO
select and split commands are not supported. This will prevent the program from
controlling the radio split and reading or programming VFOB frequency. SO2V
mode should not be attempted and VFOB's Bandmap and Entry windows can be
closed.

To communicate with the radio, the baud rate, CI-V Transceive, and number of bytes of frequency
data must be set correctly. This is set via a DIP switch on the Icom UX-14 interface board. Using the
DIP switch S1 location in the beginning of the manual (page 11 has the DIP switch positions
reversed) set S1 to the following:
1-------------6
On - Off - Off - Off - Off - On
This will set the baud rate to 9600, the length of the frequency information to 5 bytes, and turn CI-V
Transceive OFF.
If the radio contains the Piexx UX-14 CI-V board, set the DIP switches per the Piexx manual for the
same configuration
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7.21. IC-756 using address 50 hex and 19200 bps.

Please see also Key Assignments (Alt+F12) and the setting 'Dual Rx always on' in
the Config menu.

7.22. IC-756 PRO using address 5C hex and 19200 bps.

Please see also Key Assignments (Alt+F12) and the setting 'Dual Rx always on' in
the Config menu.

7.23. IC-756 PRO II using address 64 hex and 19200 bps.

Please see also Key Assignments (Alt+F12) and the setting 'Dual Rx always on' in
the Config menu.
USB-D / LSB-D digital modes supported.

7.24. IC-756 PRO III using address 6E hex and 19200 bps.

Please see also Key Assignments (Alt+F12) and the setting 'Dual Rx always on' in
the Config menu.
USB-D / LSB-D digital modes supported.

7.25. IC-761 using address 1E hex and 9600 bps

There are several limitations caused by the lack of some CI-V commands. VFO
select and split commands are not supported. This will prevent the program from
controlling the radio split and reading or programming VFOB frequency. SO2V
mode should not be attempted and VFOB's Bandmap and Entry windows can be
closed.

To communicate with the radio, the baud rate, CI-V Transceive, and number of bytes of frequency
data must be set correctly. This is set via a DIP switch inside the radio. Set the baud rate to 9600,
the length of the frequency information to 5 bytes, and turn CI-V Transceive OFF.
The manual lacks the details but it is suspected that DIP S1 should be set to the following:
1-------------6
On - Off - Off - Off - Off - On
If the radio contains the Piexx UX-14 CI-V board, set the DIP switches per the Piexx manual for the
same configuration.

7.26. IC-765 using address 2C hex and 9600 bps.

7.27. IC-775/775DSP using address 46 hex and 19200 bps.
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Please see also Key Assignments (Alt+F12) and the setting 'Dual Rx always on' in
the Config menu.

7.28. IC-781 using address 26 hex and 9600 bps.

Please see also Key Assignments (Alt+F12) and the setting 'Dual Rx always on' in
the Config menu.

7.29. IC-910H using address 60 hex and select the correct baud rate.

The ALT+F12 radio specific command swaps MAIN and SUB using the CAT radio
command.

The ALT+F10 command swaps the VFOA/B frequency and mode only in SO1V and SO2V program
modes.

7.30. IC-1275A/E using address 18 hex and 9600 bps.

The CI-V command set lacks split ON/OFF commands. This prevents the program
from controlling the radio split.

7.31. IC-7000 using address 70 hex and 19200 bps.

7.32. IC-7200 using address 76 hex and 19200 bps.

Radio control via USB with Icom driver or CI-V interface.
The IC-7200 USB codec is supported. IC-7200 users can use the USB cable with
the Icom drivers for radio control, AFSK RTTY, PSK, voice message playback, and
recording QSOs. IC-7200 users can not record messages on the fly. In CW, only
the received portion of the QSO is recorded. This is a radio limitation.
Detailed instructions for setting up USB communications with this radio may be
found in the File Gallery.

7.33. IC-7400 (identical to the IC-746 Pro)

Select the IC-746 PRO as radio

7.34. IC-7600 using address 7A hex and 19200 bps

Radio control via USB with Icom driver or CI-V interface.
USB-D / LSB-D digital modes supported.
The IC-7600 audio codec is supported. IC-7600 users with the Icom drivers can use
the USB cable for radio control, AFSK RTTY, PSK, recording voice messages on
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the fly, voice message playback, and recording QSOs. In CW, only the received
portion of the QSO is recorded. This is a radio limitation.
Detailed instructions for setting up USB communications with these radios may be
found in the File Gallery.

7.35. IC-7700 using address 74 hex and 19200 bps.

USB-D / LSB-D digital modes supported.

7.36. IC-7800 using address 6A hex and 9600 bps.

Please see also Key Assignments (Alt+F12) and the setting 'Dual Rx always on' in
the Config menu.
USB-D / LSB-D digital modes supported.

 

8. Kenwood

 

8.1. General Kenwood information

All models are supported
Newer models connect directly via a serial port cable.
Older models need the Kenwood IF-10 and/or the IF-232C interface (or
compatible). Please check the radio's manual.

Almost any of the earlier generation Kenwood radios need some sort of level
conversion, and at least some also come without the necessary chip set.
Radios like the TS-940S, TS-440S, TS-811, TS-711 need both a chip and a
level converter.
PIEXX (www.piexx.com) makes a combined level converter and chip set
replacement for the TS-940, as well as a complete replacement
microprocessor for the TS-930 to provide communications.

Hardware handshaking is mostly being used. This means that DTR= Always on or
handshake and RTS = Always on or handshake.

Unless you make up a special loop back cable for it so you can use DTR and RTS
for CW and PTT.

The stock Kenwood interfaces (IF-232 for the older -x40 and -x50 series transceivers)
and a bare RS-232 cable for the more recent TS-480/570/870/2000 require handshake.
Except for the TS-570. the solution is to install a jumper between CTS/RTS pins at the
RS-232 input of the Kenwood interface (in the case of the -40 and -50 transceivers) or
transceiver (TS-480/870/2000). The TS-570 can lock-up if RTS is connected to CTS and
requires RTS=always high to be reliable.
Using the jumper ("fake handshake") will free RTS for PTT in addition to DTR for CW.
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The alternative to "fake hand- shake" is to set RTS=Always On and use DTR for PTT or
CW as necessary (DTR is not connected in the radio/interface).
RX/TX information from the radio is ignored while sending is in progress to avoid glitches
in sending.
Kenwood uses by default:

Speed: 4800 Baud; Parity: N ;Databits: 8; Stopbits: 2 (!) and "handshaking" which
means RTS and DTR should be set to "Handshake".
When setting split both VFOs are forced in the same mode.

The models below are supported:
Kenwood

Probably the choice to use for all modern Kenwood radios. Other possible
selections are Kenwood-Slow or TS-2000

8.2. TS-480

Select: Kenwood. Note that handshaking options may vary - check your
manual
"PTT via radio command" is not supported when using "AFSK" via the
data jack. TS-480 owners have two options:

Use hardware PTT (RTS) from the digital port connected to pin 3
(DTR) of the DATA port for digital PTT. Configure MMTTY and/or
MMVARI interfaces to activate DTR for PTT.
Use the microphone input for AFSK/PSK. This will allow the use
of "PTT via radio command".

8.3. TS-570

Select: Kenwood
When using the ACC2 port on the back, you must send both the audio
signal and the PTT signal to the ACC jack.
You can't use the normal PTT connection from the MIC jack if you are
inputting audio into the ACC jack.
SO2V: 9600,N,8,1,handshake,handshake,radio/VFO=1

8.4. TS-590

Select: Kenwood
Follow the Owners Manual for port speed, parity, number of databits,
and stopbits

8.5. TS-850

Select: Kenwood
Turn off AI on init

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

598 of 680 2/2/2011 4:54 PM



Speed: 4800 Baud; Parity: N ;Databits: 8; Stopbits: 2 (!)
Check out the possible communications issue below with this radio.

8.6. TS-870

Reportedly works well; further information on setup would be welcome

8.7. TS-950sdx

Select: Kenwood
Some (older) TS-950sdx radios drop power when polled by a logging
program. It's pretty obvious on either CW or SSB.

The problem is not the program but the ROM firmware chip. The
big one one the digital board of the 950sdx.
Just replace the chip, the problem should go away. Costs about
$27.00 - and very easy to install (about 10 minutes)
Order a battery if you haven't replaced it already - it's right next to
the chip on the same board....
Speed: 4800 Baud; Parity: N ;Databits: 8; Stopbits: 2 (!)
Check out the possible communications issue below with this
radio.

 

8.8. TS-50, TS-140, TS-440, TS-680,TS-711,TS-790,TS-811,TS-940

To avoid Kenwood EPROM issues with these radios, select Kenwood-Slow rather than LKenwood.

8.9. TS-2000

Select: TS-2000 - There is a separate radio entry for TS-2000 to allow control of RX
antenna input.

Uses default 9600 Baud; Parity: N ;Databits: 8; and 1 stopbits. DTR=
Handshake and RTS = Handshake
When using 4800 baud, 2 stopbits must be used!
With menu item 56 the speed can be changed.
Also works for frequencies above 100 MHz
Do not use the radio function called "auto-mode". This function automatically
changes the radio mode.

This overrules the (fixed) radio mode set by N1MM logger under the
mode tab in Configurer.
NB.This could give AFSK RTTY (LSB) problems when changing
between the higher (USB) and lower (LSB) bands.

Do not use the radio in memory mode, use VFO mode. The program will not
function when in memory mode with the program.
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8.10. N1MM logger loses communication with the radio (TS-850, TS-950 etc.)

The problem is based in the radio's microprocessor. Some older Kenwood radio are not capable of
communicating with the computer while the tuning knob is being turned. If you turn the knob
smoothly and continuously, no matter how slowly, the radio will not be able to receive or respond to
polls and the link will time out. Try using Kenwood-Slow as selected Radio. if this does not help
please try to increase the 'transceiver timeout time' (right-click menu in the bandmap) in N1MM
Logger, for example to 120 seconds. You can also try tuning the radio in bursts instead of smoothly,
i.e. stop turning the tuning knob every few seconds to let the link catch up.

9. TenTec

9.1. General TenTec information

The models below are supported, other models are not supported.

9.2. ARGONAUT V

9.3. JUPITER

Uses 1 stopbit and DTR and RTS 'Always on'. Do NOT check the CW check box
on the port setup screen for this com port.

9.4. OMNI-VI

On the Omni VI+ the "Cde" item under menu 2 should be set to "off". Otherwise
there will be collisions between the data sent from the rig when N1MM polls for

data and the data that is being continuously sent by the radio which will cause erratic behavior.

9.5. OMNI-VII

The Omni-VII does not support antenna switching in "radio" mode. It is only
possible in "remote" mode. So owners of the Omni-VII can not use the antenna
switch macros.
Alt+F10 (exchange VFO) and CW-Reverse operation supported
The Omni-VII can not receive on VFOB.

9.6. Orion

Uses default 56000 Baud and 1 stopbit and hardware handshaking.
Firmware version 1.363 or greater needed.
Note that the Orion does not support PTT on CW via computer command. This

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

600 of 680 2/2/2011 4:54 PM



does work on SSB, but on CW, you need to set a parallel or serial port to assert
PTT for that radio. Then use a cable from that adapter to pin three (PTT) of the aux
port on the Orion. This is the black RCA Phono connector on the aux cable. By use
of a Y connector, you can parallel your footswitch and this CW PTT cable.
When using PTT and CW lines off a serial or parallel port. Be sure to go into the
Orion CW menu and set "PTT in CW as" to the value "Mox".
Defaults bandwidths: CW: 300/800; SSB: 2000/2800; RTTY 250/400
CW on main receiver is LCW.
Supports Digital Voice Keying (DVK) via the AUX port. Audio should be fed to the
AUX port and NOT the microphone.

When no DVK is specified the front microphone gain will normally set to 0
Microkeyer users: check out the Supported Hardware chapter regarding
muting of the ORION microphone audio input.

When a DVK is specified for that radio the microphone gain will not change
(mostly fed to the front microphone).

When up/down pressed, turn on RIT if in S&P, turn off RIT if in running mode.
Clear RIT by setting to 1 Hz not 0. Avoids turning off RIT.
Narrow SSB bandwidth set to 1990 Hz to force the use of 2.4 kHz filter in auto
mode.
RIT can be changed using the up/down keys if RIT on. Note that you must turn on
RIT from within the program!
Swap VFOs using Alt+F10. This will replace the contents of memories 199 and 200
Example Setup FSK/CW/SSB

In FSK or SSB mode the program uses the PTT input to key the rig.
In CW mode the program uses the PTT as the CW key.

Digital setup and MMTTY.
N1MM Config / Config Ports / Hardware Tab.

Set the CW menu choice for the interface com port to DTR
(Pin 4).

MMTTY Setup / Setup MMTTY / TX Tab / Radio command button.
Checked the PTT button under DTR/RTS.

Interface information
LINE OUT (74) is fixed level output (RCA connector)

Should be fed to LINE IN on the soundcard.
Yellow phono plug on Pin 4 of the AUX I/O cable assembly
NB this is a combined output for both receivers, use the AUX I/O port
for separated outputs (pin 4 and 6)

AUX I/O port (80): AUX IN (pin 1) for transmit audio from the soundcard
Should be fed to LINE OUT on the Soundcard.
The AUX gain can be set under the SSB menu
Set the AUX gain to 65 and use the computer audio setting to drive the
rig to 100 watts for RTTY.

AUX port: PTT (pin 3)
A transistor switch is needed from a serial or parallel port.

Works fine for digital modes but also for recording and the voice keyer.
Switch between MIKE and AUX via the menu.
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This is a summary of the SO2V features for the Orion.

ALT+F12 toggles Sub audio On and Off. To leave SUB audio selected all the time, select
Configurer>Dual RX always on

If you are using Diversity mode on the radio, toggling Sub off and on via Alt+F12
will turn Diversity mode off
Logger preserves diversity reception unless RX Focus changes to vfoB at which
time the subrx will switch to vfoB

Subrx ON/OFF control by Logger
Independent of the state of Dual RX Always On:

changing RX Focus to vfoB turns the subrx ON
Ctrl+Shift+Up/Dn does not change the state of the subrx
Alt+F12 toggles subrx ON/OFF if RX Focus is on vfoA (action disabled if RX
Focus on vfoB)

Dual RX Always On checked:
clicking any vfo bandmap/avail. window spot or Ctrl+Up/Dn turns the subrx
ON
changing RX Focus turns the subrx ON
if dual rx always on was unchecked and the user checks it, subrx is turned
ON

Dual RX Always On unchecked:
If the TX & RX Focus is on VFOB and the RX Focus changes to VFOA ( \
keystroke), the subrx stays ON
If the TX & RX Focus is initially on VFOB and then RX & TX Focus is on
VFOA (PAUSE, CTRL+Left or vfoA Bandmap/Available window spot click ),
the subrx is turned OFF
if dual rx always on was checked and the user unchecks it, subrx is turned
OFF

Ctrl+Alt+D command action:
If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX Always On" to
OFF and leave the Sub RX ON
If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual RX Always On" to
OFF and leave the Sub RX OFF
If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual RX Always On" to
ON and leave the Sub RX ON
If "Dual RX always on" is OFF and the Sub RX is OFF, turn both ON

Stereo (grave accent) command action:
If the subrx is OFF - check "Dual RX always on" and turn the subrx ON
If the subrx is ON - uncheck "Dual RX always on" and turn the subrx OFF unless
RX Focus is on vfoB

10. Yaesu

10.1. General Yaesu information

The models below are supported, other models are not supported.
Required interfaces
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Newer models connect directly via a serial port cable.
Older models need the Yaesu FIF-232C CAT interface (or compatible).

Software handshaking is being used for all models.
Yaesu uses by default:

Speed: 4800 Baud Parity: N Databits: 8 Stopbits: 2

10.2. FT-80C

It has been reported that this radio will not transmit key CW or MIC audio while it is
sending the radio polling data to the computer. The radio polling string is fixed by
the radio firmware and it requires over 800ms to send the data to the computer at
4800 baud. This radio should only be used without radio control. This operation
just isn't practical for contesting.

 

10.3. FT-100(D)

The FT-100D has an internal jumper for either CAT/TUNER or LINEAR. This should
be set for CAT/TUNER.
Configure the radio as FT-100, 4800, N, 8, 2, Handshake, Tx=1, DTR=Always on or
off, RTS=Always on or off.
Needs a standard FT-100 CAT cable (CT-62).

10.4. FT-736

Not supported and probably never will be. It seems that once the radio is
controlled by CAT it can't be controlled by hand anymore.

10.5. FT-450

When using a 3 wire cable (TX, RX and ground) set CAT RTS=disable on radio
(default is enable). This cable does not have DTR or RTS connected. The radio
settings CAT TOT should be set to 1000 and CAT RATE must match the program
configuration. A three wire cable should also work with USB serial adapters.

10.6. FT-747GX

It has been reported that this radio will not transmit key CW or MIC audio while it is
sending the radio polling data to the computer. The radio polling string is fixed by
the radio firmware and it requires over 800ms to send the data to the computer at
4800 baud. This radio should only be used without radio control. This operation
just isn't practical for contesting.
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10.7. FT-757

Select FT-757GXII as radio and disable the radio communications timeout via the
bandmap menu option (set it to 0).
The FT-757GX does NOT send anything to the computer and the radio mode can
not be set by the program so the radio control functionality will be limited.

10.8. FT-757GXII

Supported

10.9. FT-817

19200, N, 8, 1, Handshake, Handshake. FT-817 CI-V Baud "Hi". When using a
USB/Serial adapter set DTR to 'Always on' and RTS 'Always off'.
Bandwidth button in the bandmap is not supported (and not shown).
There are some limitations in the available CAT Codes provided by Yaesu with the
FT-817, FT-857 and FT-897.

The best way to understand what is possible is to take few minutes and
review the available CAT Commands on page 72 (FT-817) 62 (FT-897) 115
(FT-857) of your operating manual.
VFO A/B : It is only possible to switch from one VFO to the other but there is
no way to know by the program if the radio is on VFO A or VFO B.
Narrow CW Filter : There is no CAT Command to set Filters on the radios.

10.10. FT-840

Supported

10.11. FT-847

Split Operation does not work, because it is not supported via the CAT-connection.
So it has to be done manually by the operator.
RIT and XIT in the bandmaps are not working, because this is not supported by
the FT-847.
Also working for frequencies above 100 MHz.
CW-R mode supported.

10.12. FT-857

The FT-857 and FT-897 computer control lacks the ability to select VFOs which
makes it difficult for N1MM Logger to function as well as other radios.
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10.13. FT-890

Supported

10.14. FT-897

Supported
Bandwidth button in the bandmap is not supported (and not shown).
The FT-857 and FT-897 computer control lacks the ability to select VFOs which
makes it difficult for N1MM Logger to function as well as other radios.

10.15. FT-900

Supported

10.16. FT-920

PTT via CAT supported.
For filter settings see below.

10.17. FT-950

When using a 3 wire cable (TX, RX and ground) set CAT RTS=disable on radio
(default is enable). This cable does not have DTR or RTS connected. The radio
settings CAT TOT should be set to 1000 and CAT RATE must match the program
configuration. A three wire cable should also work with USB serial adapters.

10.18. FT-990

FT-990 and early FT-1000 had a design problem in the CAT interface. It used an
open emitter transistor on the serial out line. That worked fine for TTL HIGH (+5 V)
but some TTL to RS232 interfaces did not have enough load to cause the output to
go low ... the interface would "float" in the undefined logic state between .3 and 3.5
volts. The solution is to add a 1.5K Ohm resistor from "serial out" to ground. When
using the ARRL handbook design the 1.5k resistor needs to be added between pin
1 of the 7417 (which is pin 2 of the DIN) to ground.
For filter settings see below.

10.19. FT-1000(D)

Cat control will not work with FT-1000D internal software version lower than
v6....most older ft1000d's have version v5.8... you need an update!
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Older versions do have a CAT control problem. Check out the infromation with the
FT-990 (above).
If the bandmap/frequency is not updating, the radio probably is in Mem/Tune
mode. Deselect using the VFO/MEM switch.

The program forces the radio at startup from Mem/Tune mode in VFO mode
to avoid this problem.
For filter settings see below

ALT+F12 toggles Sub on and off. It is identical to pressing the SUB radio button. To
leave SUB on all the time, select Configurer>Dual RX always on
Subrx ON/OFF control by Logger (SO2V mode)

Independent of the state of Dual RX Always On:
Changing RX Focus to VFOB turns the subrx ON
Alt+F12 toggles subrx ON/OFF if RX Focus is on VFOA (action disabled if RX
Focus on VFOB)

Dual RX Always On Checked:
Clicking any vfo bandmap/avail. window spot or Ctrl+Up/Dn turns the subrx
ON
Changing RX Focus turns the subrx ON
If dual rx always on was unchecked and the user checks it, subrx is turned
ON

Dual RX Always On Unchecked:
If the TX & RX Focus is on VFOB and the RX Focus changes to VFOA ( \
keystroke), the subrx stays ON
If the TX & RX Focus is initially on VFOB and then RX & TX Focus is on
VFOA (PAUSE, CTRL+Left or VFOA Bandmap/Available window spot click ),
the subrx is turned OFF
If dual rx always on was checked and the user unchecks it, subrx is turned
OFF

Ctrl+Alt+D command action:
If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX Always On" to
OFF and leave the Sub RX ON
If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual RX Always On" to
OFF and leave the Sub RX OFF
If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual RX Always On" to
ON and leave the Sub RX ON
If "Dual RX always on" is OFF and the Sub RX is OFF, turn both ON

Stereo (grave accent) command action (on non-US keyboards the key is mapped to
another key):

If the subrx is OFF - check "Dual RX always on" and turn the subrx ON
If the subrx is ON - uncheck "Dual RX always on" and turn the subrx OFF unless
RX Focus is on VFOB

10.20. FT-1000MP (Mark-V)(Field) (Not for use with SteppIR antenna controller)

The program can't send CW via the MP's serial cable. See the help for how to
build a CW interface
If the bandmap/frequency is not updating, the radio probably is in Mem/Tune
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mode. Deselect using the VFO/MEM switch.
The program forces the radio at startup from Mem/Tune mode in VFO mode
to avoid this problem.
The indicator should show VFO.

Use a straight serial cable
4800,N,8,2 and DTR and RTS set to "Always Off"
A big issue with the FT-1000MP is that you cannot set the radio to split with VFO-B
as the RX. Well, you can, but you cannot control whether you are listening dual, or
just VFO-B from the computer. You can detect it, but not set it. The user will have
to press the main RX button to turn off the main receiver when split from VFO-B.
Note that Alt+F10 will swap VFO A & B frequencies. That is very useful in this
case.
Optimum configuration for those who wish to operate AFSK and/or PSK. There will
be an 85 Hz display offset between RTTY and PSK but that is minor.
PKT is LSB with the frequency display shifted by 2.125 KHz (or other user defined
offset at menu 6-4). It also selects audio input from the PACKET jack on the rear of
the radio, disables the processor and mutes the microphone. Finally, it offsets the
filters so the narrow filters are properly placed (centered as specified in menu 6-5).
Using QMB memories

When doing a QMB RCLl press M>A until it transfers the QMB frequency to
the VFO. After this it should work as normal, but you lose the original
frequency that was in VFO-A.

For filter settings see below
ALT+F12 toggles Sub on and off. It is identical to pressing the SUB radio button. To
leave SUB on all the time, select Configurer>Dual RX always on
Subrx ON/OFF control by Logger (SO2V mode)

Independent of the state of Dual RX Always On:
Changing RX Focus to VFOB turns the subrx ON
Alt+F12 toggles subrx ON/OFF if RX Focus is on VFOA (action disabled if RX
Focus on VFOB)

Dual RX Always On Checked:
Clicking any vfo bandmap/avail. window spot or Ctrl+Up/Dn turns the subrx
ON
Changing RX Focus turns the subrx ON
If dual rx always on was unchecked and the user checks it, subrx is turned
ON

Dual RX Always On Unchecked:
If the TX & RX Focus is on VFOB and the RX Focus changes to VFOA ( \
keystroke), the subrx stays ON
If the TX & RX Focus is initially on VFOB and then RX & TX Focus is on
VFOA (PAUSE, CTRL+Left or VFOA Bandmap/Available window spot click ),
the subrx is turned OFF
If dual rx always on was checked and the user unchecks it, subrx is turned
OFF

Ctrl+Alt+D command action:
If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX Always On" to
OFF and leave the Sub RX ON
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If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual RX Always On" to
OFF and leave the Sub RX OFF
If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual RX Always On" to
ON and leave the Sub RX ON
If "Dual RX always on" is OFF and the Sub RX is OFF, turn both ON

Stereo (grave accent) command action (on non-US keyboards the key is mapped to
another key):

If the subrx is OFF - check "Dual RX always on" and turn the subrx ON
If the subrx is ON - uncheck "Dual RX always on" and turn the subrx OFF unless
RX Focus is on VFOB

10.21. FT-1000MPSteppIR

Select this FT1000mp when using a SteppIR antenna.
This selection is optimized for the combination of an FT1000MP and the SteppIR
antenna. It sends radio commands one at a time, paced with the command delay.
Otherwise, it is identical to the FT-1000MP

10.22. FT-1000 series, FT-990 and FT-920 Setting filters

 
Simply right-click on the bandmap and you will get a menu which includes "Set transceiver filter
codes" ... there are six submenus: CW Wide, CW Narrow, SSB Wide, SSB Narrow, Digi Wide and
Digi Narrow. In my case the commands for SO2V are:

The settings below will work for the FT-1000, FT-1000D, the FT-1000MP, the
FT-1000MP/MKV and the FT-1000MP/MKV Field (or any combination of two
FT-1000 "family" of rigs in SO2R).

 

BandWidth VFO-A
(main)

VFO-B (sub) Filter Remarks

2.4 kHz 0 0 0 0 140 0 0 0 128
140

SSB Wide or Digi Wide —

2.0 KHz 0 0 0 1 140 0 0 0 129
140

SSB Narrow or Digi
Narrow

will use 2.4 kHz on
VFO-B

500 Hz 0 0 0 2 140 0 0 0 130
140

CW Wide or Digi Wide —

250 Hz 0 0 0 3 140 0 0 0 131
140

CW Narrow or Digi Narrow will use 500 Hz on VFO-B

6.0 KHz
(thru)

0 0 0 4 140 0 0 0 132
140

— --
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The VFO-B (sub) only supports bandwidths of 6.0 KHz, 2.4 KHz and 500 Hz.
For SO2R (two rigs) configure the two bandmaps the same.
Some notes:

"Duplicates default filter settings" is appropriate to the FT-1000 MK/V and
Field only. The FT-1000/D/MP permit more flexible filter selection.
The FT-920 does not support 2.0 KHz and 250 Hz filters ... it might make
more sense to revise CW and Digi settings for 2.4/500 Hz (0 0 0 0 140 and 0
0 0 2 140) filters.
Even though the FT-920 lacks the second receiver, the FT-920 permits
selecting different bandwidths for each VFO. The CAT commands are the
same as those for the second receiver in the "1000" series: 0 0 0 130 140
selects 500 Hz and 0 0 0 128 140 selects 2.4 KHz.
The FT-990 commands are the same as those for VFO A in the "1000" series
of radios.

10.23. FT-2000

Defaults to: 4800 baud, 8 bits, no parity, 2 stop bits. Set DTR to always off and
RTS to Always on. If this does not work, try to set DTR to Always On.
When using a 3 wire cable (TX, RX and ground) set CAT RTS=disable on radio
(default is enable). This cable does not have DTR or RTS connected. The radio
settings CAT TOT should be set to 1000 and CAT RATE must match the program
configuration. A three wire cable should also work with USB serial adapters.

10.24. FTDX-5000

When using a 3 wire cable (TX, RX and ground) set CAT RTS=disable on radio
(default is enable). This cable does not have DTR or RTS connected. The radio
settings CAT TOT should be set to 1000 and CAT RATE must match the program
configuration. A three wire cable should also work with USB serial adapters.

10.25. FTDX-9000

When using a 3 wire cable (TX, RX and ground) set CAT RTS=disable on radio
(default is enable). This cable does not have DTR or RTS connected. The radio
settings CAT TOT should be set to 1000 and CAT RATE must match the program
configuration. A three wire cable should also work with USB serial adapters.

 
Other brands

No other brands are supported yet.
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Third Party Software

In this Section...

Third Party Software
1. Integration with other programs
2. Athena (by Carel, PC5M)
3. Thucydides (by Carel, PC5M)
4. AB_Switcher (for SO2R without using an LPT-port)
5. I8NHJ web interface
6. AutoHotkey
7. AR Cluster User

All programs below are freeware programs !

1. Integration with other programs

For future releases N1MM logger will use the UDP interface a lot for loose integration of other
applications. It offers an easy way for other programs to send data to and receive data from the
logging program. What is nice about it is that the two participants need not be on the same
computer, they only need to be on the same LAN.

The software does automatically upload scores with the N1MM logger, or can be used manually if
you log with anything else.

2. Athena (by Carel, PC5M)

Athena provides the following features:

Display of real-time contest statistics
Graphs will show hourly rate, cumulative totals and goal
Graphs selectable for number of QSO's and multipliers, points or score
Graphs per operator and band
All band numerical statistics with indication on how many minutes/qso's a new multiplier will
be "worth"
Goal data can be imported from previous (n1mmlogger) contests and is text file based
Goals can easy manipulated to fit into current contest view

 
Athena was developed to provide a (near) real-time insight in how the contest is progressing; How
many qso's, multipliers have been worked and what the current score is. This data is presented per
band and/or as a total view for all bands. Operator specific data can be shown to see how your
operators are doing individually. In addition goal data can be added to the band graphics to get a
feeling how thing are going. This goal can be imported from previous contest or build up from
scratch. Goal data can be easily saved and read back as requested. Due to the fact that the current
goal implementation of n1mmlogger is rudimentary the goal data of n1mmlogger is not used.
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Athena will only read data from n1mmlogger and will not make any alteration to any n1mmlogger
file, including the precious database file (.mdb). Statistics will be calculated on the fly and stored in
between. Only the created goal data will be stored on the file system in a XML file format. Athena
user setting (a.o. last contest, or if operator data is enabled) will be stored per (windows) user in the
user data application directory.

 

3. Thucydides (by Carel, PC5M)

Always would like to update the history file with real contest QSOs ? Have an optimized history file
for every contest? Alkl that is possible with Thucydides by Carel, PC5M.

Thucydides is a separate program developed to connect to N1MM Logger and history files. With this
manager it is possible to update a current history file with the information gathered during logging
contest qsoÃƒÂ¢Ã¢â€šÂ¬Ã¢â€žÂ¢s. History file can be used to verify and fill in automatically
specific information when logging new contacts (gridsquare, state, CK, etc).

The user can build up a separate (ms-access) database with imported history information from
actual logged QSOs (with n1mm logger) and/or other history text files. Exporting the information to
a dedicated history.txt file for a specific contest. Users can manipulate in great extend the behavior
of the program (which fields to import or which fields to export) by updating a normal Excel
configuration file.
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Thucydides provides the following features:

Creation of contest specific and optimized history files
Updating history files with logging information
Database views of selected contest and history file
Supported contests are all contests supported by N1MM Logger

 
Please check the manual how to use the program. Check out the the N1MM website using the url in
the Links chapter.

4. AB_Switcher (for SO2R without using an LPT-port)

AB_Switcher is a program to allow radio a/b switching on a comport without the use of a parallel
port on the host computer. Basically this program monitors that sound card mixer output levels and
switchs the DTR on the chosen comport to reflect the current radio TX focus.

The program supports switching of the Receive Focus as well as the Transmit focus. This works
under N1MM when in the $5S02R mode. A second com port is used to output on DTR and RTS the
necessary data to switch external S02R box's that support Receive Focus switching.

It also can monitor a second sound card and output on a second comport information about the
state of the RX focus. (Left/Right/Split). It does the by watching the sound card mute controls for
the selected inputs. AB Switcher Version 2 can provide any combination of the three SO2R control
signals. If only two of the three signals are needed, AB Switcher requires only a single "serial port"
and can use a port above COM8.

With Dan's driver, it is now possible to effectively use the microHAM MK2R/MK2R+ SO2R
controllers with N1MM Logger and a "USB Only" computer. The SW Synth and CD Audio inputs on
the second codec (USB Audio CODEC) in MK2R+ can be used as the Left/Right audio sources for
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"$5 SO2R" without effecting any of the other options making USB Audio CODEC an ideal "target"
for $5 SO2R.

Check out the the N1MM website using the url in the Links chapter.

NB. It is hoped that AB_Switcher will be an interim solution until the various contest programs make
the SO2R control signals (TX Focus, RX Focus and Stereo) as options for the serial port DTR and
RTS lines. 73, Joe, W4TV

5. I8NHJ web interface

I8NHJ has created a very nice web Interface to the N1MM Logger Database. This interface gives
statistics about the contest, worked stations and much all in real time when needed. See the file
WebInterface_Howto.txt in the zip file for installation instructions. Tested on Windows NT/W2K/XP.
You'll need MS Office and MS Access 2000. MS Office is not needed to run N1MM Logger only
needed for the web interface!

From the HowTo.txt file and additional info from Max, I8NHJ

This program was designed to allow an easy, powerful and versatile interface to the log generated
by the N1MM Logger during a contest or DXpedition. It is distributed AS IS, under the GNU license
terms. It can be freely used and distributed but please leave in place the references to me (I8NHJ)
and to the programmer (AGO) who helped in developing the code. Version 1.0, November 2002

The Web Interface is written using in-deep ASP techniques and it needs a full-asp support. This
means that some investigation should be made to find a good ASP support for other platforms than
Microsoft. Here we strongly use Linux but so far we still haven't found any working support for ASP
and, moreover, this kind of solution could become too complex for the average user.

To get the full functionality from the tool, the Microsoft Office package must be installed on the
Server side. Ms Access is not really needed but some graphical features are performed by
components from Excel and Word.

To generate the graphics you need MS Office on the server side. If you haven't it, the Web Interface
runs anyway but you will not get charts. NB.

Below an explanation from Franki, ON5ZO

Max I8NHJ has made an interface to go with the N1MMLogger software and it's database (*.mdb
files).

Max kindly offered this tool to us, the N1MM Logger users. You can download the program from the
N1MM logger web site  under 'Downloads', select in the menu: 'Other Files'. The file name is
'webinterface1-x.zip'. This is not a program that can run on its own. In fact, it is some kind of web
site/web page (without getting into details). This requires that you run a web server on your own
Windows PC at home. There are several possibilities:

1. You know all about servers and ASP, and have an ASP capable server running. You're on your
own, you're smarter than I am...

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

613 of 680 2/2/2011 4:54 PM



2. You are running Windows 2000 / NT / XP Pro > there's this thing called IIS that you need to
install by inserting the CD, and run Windows Setup > Add components (The names may vary
according to what Windows version you are using).

3. Win XP Home: too bad, IIS does not come with the 'light' version, so either you

Mess with XP Home, some did with success, others like me without any luck go to:
http://www.15seconds.com/issue/020118.htm
install a FREE non-Microsoft server and add ASP support. (See information below from Dave,
G3VGR)

4. You run Windows 98 (and maybe this is good for Windows 95 too, did not test this): go to:
http://coveryourasp.com/PWS.asp . Follow steps 1 to 7 (included)

When you finished option 1 or 2 or 3 or 4 successfully, and the server (IIS or PWS) is up and
running, follow Max his guidelines in the ZIP-file.

73' Franki

Below some additional information from Dave, G3VGR

I've just successfully implemented the I8NHJ interface, using the freeware Abyss Web Server from
http://www.aprelium.com/ .
ASP support needs to be added using the freeware ActiveHTML software from seliSoft.
http://www.selisoft.com/en/ahtml/
The Aprelium web site gives a blow-by-blow account on how to add this support
http://www.aprelium.com/abyssws/asp.html

I only started using Logger today, so have only used a very small test log to verify all this.

73, Dave

Below some additional information from Uffe, PA5DD

I recently re-installed my whole system to Windows 2000 (same goes for XP etc.). It all works fine
until I want to use the I8NHJ Web interface when the Logger has the same .mdb database file
open. Then access is refused. Reason is that the Logger opens the database file "exclusively". This
is a question of access rights. After installation of the Web interface, Internet user access rights has
to be awarded to the directory where the Web interface is, as well as the Logger directory. To see
how, use the link: http://www.aspemporium.com/aspemporium/tutorials/permdenied.asp

The Web server should have default.asp in its Default Document list. Alternatively you could
address the page directly: http://localhost/logger/default.asp

73 Uffe PA5DD

Personal Web server

If you have Windows 95 installed on your computer, you can install the Microsoft Personal Web
Server from the Windows NT 4.0 Option Pack. You can download the Option Pack from the
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Microsoft Web site. Microsoft Personal Web Server can also be found in the "Add-on\pws" directory
on the Win98SE install CD (at least on this Win98SE upgrade CD, US version).

Below some additional PWS information from Frans, PA5CA

I installed the PWS software for win98se, please note to install (over write) one of the dll files before
executing the install. It took me some time before I got the ASP statistics to work, now I'm quit
happy. I used the following links...

http://support.microsoft.com:80/support/kb/articles/Q246/0/81.ASP

http://support.microsoft.com/default.aspx?scid=fh;NL;w98

73' Frans PA5CA

6. AutoHotkey

AutoHotkey can create hotkeys for keyboard, joystick, and mouse. Remap keys and buttons on your
keyboard,joystick, and mouse and has many more features. Virtually any key, button, or
combination can become a hotkey.

Once you have AutoHotkey installed, you create a script file in notepad, name it with an .ahk
extension, and double-click it. Windows knows that you want to run AHK, so an AHK logo for the
script appears in the system tray, and stays there until you actually exit from it. You can edit the
script, read the help file, and reload the script from right-clicks on that logo. One thing it took me a
while to figure out is that each time you edit the script you need to reload it - also through the
right-click on the logo.

 

Model for N1MM Logger for any use of one key to send a multi-key combination:
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Script Description

#UseHook

SetNumlockState,
AlwaysOn

Num Lock always on

Numpad7::Send !{F9} Numeric key 7 - toggle antennas for a band

Numpad8::Send ^+i Numeric key 8 - toggle Advanced SO2R

Numpad4::Send ^b Numeric key 4 - toggle dueling CQs

Numpad9::Send !r Numeric key 9 - toggle repeat CQs

Numpad5::Send ^{F1} Numeric key 5 - send CQ on radio that does not have entry focus

Numpad6::Send !w Numeric key 6 - wipe

Numpad0::Send {ESC}\`` Numeric key 0 - return from S&P to work station calling on run
radio

Numpad1::Send \`` Numeric key 1 - go back to S&P on opposite radio

Return

 
Example AutoHotkey implementation for grabbing multipliers to VFO A and B:

Script Description

#UseHook

SetNumlockState, AlwaysOn Num Lock always on

Numpad7::Send ^!{Up} Numeric key 7 - VFO A Go to next multiplier up the bandmap

Numpad1::Send ^!{Down} Numeric key 1 - VFO A Go to next multiplier down the bandmap

Numpad9::Send ^+!{Up} Numeric key 9 - VFO B Go to next multiplier up the bandmap

Numpad3::Send ^+!{Down} Numeric key 3 - VFO B Go to next multiplier down the bandmap

Return

 
Example AutoHotkey implementation to send CW using a hotkey:

Script Description

Numpad1::Send ^k
testing?^k

Send a CW message from a designated hotkey (Numeric key 1 in
the example).
You'll see the Ctrl+K keyboard window appear and quickly
disappear,
but now the CW continues to be sent until it is done (unless you hit
ESC to interrupt it)
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A program which can do the same or maybe even more is 'AutoIt' version 3. Check out theLinks
chapter for both urls.

Or use the wheel of the wheelmouse.
WheelUp::Send {Up}
WheelDown::Send {Down}

7. AR Cluster User

AR Cluster User by Lee, VE7CC is a full featured Telnet and TNC program for use with AR Cluster
or DX Spider Nodes.
It has telnet and RS-232 outputs for logging and contest programs like N1MM logger. Runs under
Windows 95 to Windows XP and can auto reconnect and automatically gets missed spots. It can be
used with telnet and TNC's.
The program can receive spots both in connected and unconnected modes, this means it also
recognizes spots when NOT connected to any packet node, just monitoring the RF channel where
other users are receiving spots is good enough.

Setting up AR User with N1MM logger

Settings AR cluster
Connect to your packet node with AR User
Go to onfiguration - Ports/Logger Program
Check "Telnet" Logging Program Connection, Apply for both the Node Connection and
the Logging Program Connection

Open N1MM Logger
Go to Config - Change Telnet Cluster List

If there isn't already an entry, add AR User
Use 127.0.0.1:7300 if AR User and N1MM are on the same computer

Check the website how to achieve this when using more computers

Open the Telnet Window and connect to AR User
You should see spots flow into N1MM Logger from AR User

 
Check out the the AR Cluster User website using the url in the Links chapter.

Frequently Asked Questions

 
Access the Frequently Asked Questions by selecting Frequently Asked Questions (FAQs)

N1MM Logger Appendices

Table of contents:
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1 Example Function Keys
2 Call Checking
3 Links
4 DX Clusters
5 Customizing the DXCC list
6 Technical Information
7 UDP broadcasts
8 Off Topic, but nice to know

 

Example Function Keys

In this Section...

Example Function Keys
1. SSB

1.1. WPX SSB example
2. CW

2.1. CW program default
2.2. Sprint CW examples

2.2.1. Example 1
2.2.2. Example 2
2.2.3. Example 3
2.2.4. Example 4

3. RTTY
3.1. General RTTY example
3.2. Example RTTY where the time is part of the exchange (like ANARTS).

There may not be any 'holes' in the function keys lines with skipped function keys. ALL
preceding Function keys must at least have a line in the table. Example: You'd like to have a
different S&P F3 key than the Run F3 key. First you have to add the 12 Run lines in the table,
after that the S&P lines for F1 + F2 +F3 which you liked to change for S&P. So at least 15 lines
in total have to be in the function key table (12 run + 3 S&P).

The text F1 (etc.) in the left column is only text and has no intelligence/meaning for the
program. You could remove it and change it to any text you like, which will show on the
Function key in the Entry window. The order of lines determines what the key will do. Examples:
line 5 is Run F5 , line 11 is Run F11, line 17 is S&P F5 (17-12=5) etc.

Note 1

Note 2

Note 3

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

618 of 680 2/2/2011 4:54 PM



 

1. SSB

 
The .wav files can be anywhere on your computer as long as the filename in the FKey setup
includes the path. If in the wav folder, than it should read C:\Program Files\N1MM logger\wav
\filename. If in another, for example ARRL DX, it would read arrldx\filename.

1.1. WPX SSB example

 
Here is an excerpt from my macro list that I used in WPX SSB with ESM. Note again that the first 12
lines are for Run mode, and the last 12 for S&P. I was voicing both serial numbers and the other
station's callsign. Note also that I used a brief pause.wav file (finite length but no sound) to get a
pause between his call and the serial number.

This is tricky because it requires mixing macros and WAV filenames. Pay close attention to the
details - there are no doubt other syntaxes that work, but I know this does, with no spaces, commas
or other punctuation in the right column.

Button Caption WAV File

F1 CQ C:\Program Files\N1MM logger\wav\cq general.wav

F2 Exch C:\Program Files\N1MM logger\wav\59.wav#

F3 TU C:\Program Files\N1MM logger\wav\tnx.wav

F4 {MYCALL} C:\Program Files\N1MM logger\wav\mycall.wav

F5 His Call !C:\Program Files\N1MM logger\wav\pause.wav

F6 Rpt Exch C:\Program Files\N1MM logger\wav\number.wav#

F7

When you load a function key definition file into the current database, that table of definitions,
including any changes that you make during the current session, is saved in the database. That
means that if you restart the program and, for instance, start a new contest log, you will
discover that the program still uses the function key definitions set for the previous contest.

 

Each N1MM Logger database has single, separate tables for CW, SSB and RTTY function key
definitions. Once these have been created or loaded from a file (File > Import > Import function
keys from file), they remain until replaced. The correct way to manage this is to specify a file for
each relevant mode (on the Associated Files tab of the Contest Setup dialog) when you set up a
new contest, so that the right function key definitions will be loaded. If you don't specify a file, or
clear the Associated Files notation, the most recent set of definitions stored in the database will
come up each time you open or reopen the log.
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F8

F9

F10

F11

F12

F1 C:\Program Files\N1MM logger\wav\mycall.wav

F2 Exch

F3 TU

F4{MYCALL}

F5 His Call

F6 Rpt Exch

F7

F8

F9

F10

F11

F12

 

2. CW

 

2.1. CW program default

 
Below are the default function keys as set up in the program. The F3 to F12 keys under S&P are
not filled in. If you press these keys in S&P mode, the Run mode S&P messages will be sent.

Button caption CW message

F1 CQ cq~test~de~*

F2 {Exch} <<<5nn >>>{EXCH}

F3 TU TU de *

F4 {MYCALL} *

F5 His Call !

F6 QSO B4 QSO B4 de *

F7 ? ?
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F8 Agn Agn

F9

F10

F11

F12

F1 {MYCALL} *

F2 5NN {EXCH} <<<<5nn>>>>{EXCH}

F3

F4

F5

F6

F7

F8

F9

F10

F11

F12

 

2.2. Sprint CW examples

2.2.1. Example 1

 
This Function key set is based on a set posted by Kenny, K2KW

Button caption CW message

F1 CQ * * <<<NA>>>

F2 Exch * {EXCH}

F3 TU EE{S&P}

F4 {MYCALL} *
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F5 His Call !

F6 QSO B4 B4 E E

F7 ? ?

F8 Agn AGN

F9

F10

F11

F12

F1 CQ **<<<NA>>>

F2 Exch ! {EXCH} *

F3 TU EE{RUN}

F4{MYCALL} *

F5 His Call !

F6 QSO B4 B4 E E

F7 ? ?

F8 Agn AGN

F9

F10

F11

F12

 
Running Message Notes

For F2, there is a space before the *; E.G. "<space> * {EXCH}"
For F3, "EE" is there to confirm the QSO. You could easily use "TU".
After the "EE" is sent on the F3 message, the {S&P} macro puts you into the S&P mode. Then
just hit your UP/DOWN arrow to QSY.
Personally I have F6 programmed as {EXCH} to send a repeat on the exchange

 
S&P Message Notes

Note the difference in the sequence for the F2 message compared to the Running F2
message
For the F3 message, the {RUN} macro puts you in the running mode, ready to work a tail
ender and send him the correct QSO sequence
Personally I have F6 programmed as {EXCH} to send a repeat on the exchange
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2.2.2. Example 2

 
This function key set is based on one posted by Pete, N4ZR and modified by Rich, VE3KI.

Button caption CW message

F1CQ * * NA{CLEARRIT}

F2 Exch * {EXCH}

F3 TU E~E {CLEARRIT}

F4 {MYCALL} *

F5 His Call !

F6 QSO B4 B4 *

F7 Rpt Exch {EXCH}

F8 ? ?

F9

F10

F11

F12

F1 CQ * * NA{CLEARRIT}

F2 Exch ! {EXCH} * {RUN}

F3 NR #

F4 {MYCALL} *

F5 His Call !

F6 Name PETE

F7 State WV

F8 ? ?

F9

F10

F11

F12

 
Note two things about this set:

1. The {RUN} macro is in S&P F2, not F3. This worked great for me - when I pressed Enter to send
the S&P exchange, the exchange was sent, the QSO was logged, and the mode changed to {RUN}
with the cursor in the call sign box. Therefore I did not have to press F3 to get from S&P to Run.
The main problem with this is that if anyone asks for a repeat of the serial number, the Run keys
are already active, so you have to either remember how to get the serial number from the S&P set
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(Shift+F3), or else just use the paddle, which is what I did.

2. There is no {S&P} macro in this set. At the end of a Run QSO, you switch to S&P mode by just
QSYing. This also worked OK for me; since you are going to have to QSY anyway, there seems to
be no real need to force a change to S&P mode. I also had the "QSYing wipes the call & spots
QSO in bandmap" option selected, which may have helped ensure that the cursor was in the right
place after QSYing by wiping the entry window. Of course I did not actually have the band map
open, and I just ignored any call signs that showed up in the frame in the entry window.

It would be a nice touch if the final Enter in Run mode would not only log the QSO, send the
acknowledgment (E E or R) and switch to S&P, but also QSY the radio by 1.5 kHz; but as far as I
am aware there is no {QSY:+1.5} macro to do this. I think you have to either turn the radio dial or
press the up/down arrow or PgUp/PgDn key (depending on what increments you have these keys
set for). I just turned the dial. Next time, if I remember, I will set PgUp and PgDn to 1.5 kHz and try
to use them more.

73, Rich VE3KI

2.2.3. Example 3

 
This function key set is an example how to use the Single Operator Call Stacking macros in CW.
Posted by John, K3CT.

Button Caption CW Message (sic)

F9 Stack {SOCALLSTACK}

F10 Log Pop {LOGTHENPOP} TU NW {F5}{F2}

F11

F12 Wipe {WIPE}

 
DX4Win uses F12 for Wipe so I use the same key for casual operating and contesting.
Colored stickers with a message on the key tops helps me find the important keys.

2.2.4. Example 4

 
Customizing N1MM Logger for the North American CW Sprint by Steve, N2IC

I'm not going to try to explain how to operate the Sprint - for this, there is an excellent writeup at:
http://n6tr.jzap.com/sprint.html
What I will do is describe how to get the most out of N1MM Logger in the Sprint. My operation is
SO2R, and my configuration is optimized for that mode. However,I'm sure you SO1R guys will pick
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up a few tricks from what I have done for SO2R.The most important thing is to get your options,
windows and function keys setup correctly before the Sprint starts.

The Options...

Start up N1MM Logger using version 8.9.0 or later, and create a new SPRINTCW contest.

In the Config menu, select the following options:

Enter sends message (ESM)
QSYing wipes the call & spots QSO in bandmap
Do not run on CQ frequency
Show non-workable spots

 
The Windows...these are the only windows I have on my screen and all fit nicely on my small
monitor

Entry Window (one for each radio)
Visible Dupesheet (one for each radio)
Info
Log
Score Summary
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The Visible Dupesheet is really nice once you get used to it. To see if a station is a dupe, you just
scan the dupesheet with your eyes, rather than frantically type a call into the Entry Window.
Notice that I do NOT have the "Available Mults & Q's" nor the Bandmap windows open.

Now, I'm about to temporarily contradict myself. Open a Bandmap window. Right click and select
"Packet Spot Timeout". Change the packet spot timeout to 1 minute. That's right....1 minute. Hit OK.
Now close the Bandmap window. Don't reopen it. It is of no value in Sprint, but it is important to
change the packet spot timeout value to 1 minute. (Side note: This option should really be called
"Bandmap Timeout" not "Packet Spot Timeout". It controls how long calls stay on the bandmap and
the appearance of calls in the "on deck" frame of the Entry Window. We're obviously not using
packet in the Sprint.)

Function Keys ....

Here are my function key definitions. I'll explain a few that aren't obvious.

Button caption CW Message

F1 CQ cq na cq na * na

F2 Exch * # steve nm

F3 TU {CLEARRIT}T{S&P}
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F4 (MYCALL} *

F5 His Call !

F6 QSO B4 QSO B4 *

F7 Other Short {CTRLF10}

F8 Other Long {CTRLF11}

F9 Go S&&P {S&P}

F10 CQ CQ NA * * NA

F11 Long CQ CQ NA CQ NA * * NA

F12 STOP {STOPTX}{CTRLF4}

F1 S&&P CQ CQ NA CQ NA * NA

F2 S&&P Exch ! # STEVE NM {RUN}

F3 S&&P TU TU

F4 S&&P{MYCALL} *

F5 S&&P His Call !

F6 S&&P Name -

F7 S&&P Other Short {CTRLF10}

F8 S&&P Other Long {CTRLF11}

F9 Go Run {RUN}

F10 CQ CQ NA * * NA

F11 Long CQ CQ NA CQ NA * * NA

F12 STOP {STOPTX}{CTRLF4}

 

With the CQ F3 key, my "thank you" message is sent, and it immediately switches to S&P mode.
With the S&P F2 key, as soon as I send my exchange, it immediate switches to Run mode.
I can also force myself into Run and S&P modes with the F9 key.

The F7 and F8 keys send CQ's on the "other" radio. This is very useful when the other station is
sending his exchange, and you are going to lose the frequency (i.e. it will become "his" frequency).
You can send a CQ on the other radio, while he is sending his exchange. Then, when he finishes
sending his exchange and you need to send your "thank you" message to finish the QSO, all you
have to do is hit Enter, which will stop the CQ on the other radio, and send your CQ F3 message on
the active radio. However, you had better be ready to copy a new caller on the "other" radio. You
also need to be sharp with the Pause key to jump between the two radios when this happens.

The F12 keys are used in conjunction with this AutoHotKey script: NumpadEnter::F12
When I'm CQing on the active radio, but simultaneously doing S&P on the other radio, and hear a
new station, I can just hit the enter key on the far right side of the keyboard (no fumbling . This
will stop the CQ, and send my call on the other radio. Notice that there is a space before the F12
{STOPTX} macro. Yes, you need this space - don't leave it out, or this feature won't work.
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One thing you need to do is keep an eye on where your transmit and receive focus is (the red and
green dots on the Entry Window). When you're doing SO2R in the Sprint, there will be times where
your focus is not where you might expect it, or want it. Always be ready with the \ and Pause keys to
jump between radios. Yes, this takes lots of practice, and you will make mistakes. The Thursday
night Sprints are good practice for this.

73 and see you in the Sprint !
Steve, N2IC

3. RTTY

 

3.1. General RTTY example

 
The way the keys below are designed, they will work in many RTTY contests without any changes.
Whether these particular ones suit your situation will depend on your antennas, your power, QTH,
etc.; but maybe these will give you some ideas to work with.

Button Caption Message sent

F1 CQ {TX} CQ TEST DE * * CQ {RX}

F2 EXCH 599{EXCH} ! BK {RX}

F3 TU {TX}{ENTERLF} ! TU DE * QRZ? {RX}

F4 {MYCALL} {TX} DE * K {RX}

F5 His Call{TX}{ENTERLF}

F6 QSO B4 {TX} B4 DE * CQ {RX}

F7 Rpt Exch {TX} {EXCH} {EXCH} {EXCH} {EXCH} K {RX}

F8 {TX} AGN AGN DE * K {RX}

F9

F10

F11

F12

F1 CQ {TX} CQ TEST DE * * CQ {RX}

F2 EXCH {TX}{ENTERLF} DE * TU 599 {EXCH} {EXCH} BK {RX}

F3 TU {TX} ! TU {RX}

F4 Call Him {TX} DE * * * K {RX}

F5 1x1 {TX} ! DE * K {RX}

F6 0x1 {TX} DE * K {RX}

F4 Call Him {TX} DE * * * K {RX}
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F5 1x1 {TX} ! DE * K {RX}

F6 0x1 {TX} DE * K {RX}

F7 Rpt Exch {TX} {EXCH} {EXCH} {EXCH} {EXCH} {EXCH} BK {RX}

F8 Agn {TX} AGN AGN de * K {RX}

F9

F10

F11

F12

 

When using the above keys it is assumed that ESM is on. The Run mode keys F5, F6 and F7 are
not very useful when you are S&Ping, this is why I put those keys to better use by programming
them differently from the Run mode keys.
Note also that you can use up to 24 additional buttons (mouse only, no keyboard access) on the
digital interface window. For example, you can set up 0x1, 0x2, 0x3 and 0x4 calls, single, double
and triple exchanges, separate requests for his zone and state and repeats for your zone only and
for your state only, and so on.

73, Rich VE3KI

3.2. Example RTTY where the time is part of the exchange (like ANARTS).

 
In the following table only the keys that are different from the general example above are shown

Button Caption Text sent

RUN and S&P

F2 Exch {TX}599 {TIME2} {TIME2} {EXCH} ! KN {RX}

F7 Rpt Exch {TX} 599 {TIME2} {TIME2} {TIME2} {EXCH} {EXCH} K{RX}

 
73, Rich VE3KI

 

Call Checking

 

In this Section...

Call Checking
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1. Updating the pattern file
2. The Pattern File
3. Components
4. Examples
5. What are we trying to match?

Dave Robbins, K1TTT's call checking code has been implemented in the program. When a callsign
is entered it is checked against a pattern file to see if the callsign entered is a possible callsign. A
warning will be given when this is not true. The messages appears in the check window.

This feature can really help our UBN rates if we get good rules!

 

 

1. Updating the pattern file

Unfortunately many countries have changed their callsign assignment process over the last years
and many will change the coming years. Because of this the rules may not be valid. The rules are in
the callsign.pat file in the program directory. The rules need constant updating, so if you have any
rules or find broken rules for your country, please post them.

Note the following:

Lines that start with ! are comments and are ignored by the program
Lines alternate, first there is a text message that would be displayed for the user and should

Note that the call checking function only works for HF (no WARC) and CW/SSB and only when
nothing is found in the CHECK window. So not for RTTY etc. and not on VHF and up!

Do not assume that if the program gives a warning that the callsign is not possible and has to
be removed from the log. Some of these rules could already be outdated due to countries
changing callsign sequences or issuing special contest calls.

Only for HF

Warning
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basically state what the problem is
After the text message is a cryptic line that is the machine readable part of the rule

 
When reviewing the rules please look mostly at the text messages, these should give you a basic
explanation of what the rule is. When you send updates please give a short description of what the
rule is, similar to the text messages already in. Write longer explanations if needed to explain all the
nuances of a particular callsign rule. If you can't make up the code part for the particular callsign
scheme just send it in and we will help. If a rule in the file now is no longer valid please include
both lines from the file in your message and an explanation or example of why it is no longer a bad
call pattern.

At present the rule file is limited to 200 rules, but can easily be expanded.

 

2. The Pattern File

A rule 'pattern' describes a bad callsign character by character. As long as the call matches the
pattern the procedure continues. If the pattern runs out before the end of the callsign then the rest
is assumed to match. If the callsign runs out of characters first then it doesn't match and the call is
passes as good.

3. Components

The components that make up a 'rule' are:

Single characters:

Single characters Match single characters

A match the letter 'A'

1 match the number '1'

etc.

 

Please do not to make up rules just for yourself. This is a golden opportunity to give back to the
group with your knowledge of your home country's call sign standards.

Share your knowledge
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Repetition flags
These must be followed by
a character type specifier

To make up phrases like

: Match one N match any character (A-Z, 0-9) :D match one of any digit

+ Match one or more A match any letter(A-Z) +A match one of any digit

* Match zero or more D match any digit (0-9) *N match zero or more letters or digits

- Optional match -D optionally match one digit

 

Groups of characters to match Which can make up phrases like

[ ] match [ABCDFXZ] match a,b,c,f,x, or z

! match any characters not in list [!ABC] match anything other than a,b, or c

- match a range of characters [!A-R] match anything other than letters a to r

 
More info is given below like checking bands and modes.

4. Examples

The following are some simple examples of patterns and what they match or don't match.

Pattern Pattern matches Pattern doesn't match

:A:D A1 Z0 Q8 AA 19 1A

+A:D A1 AA1 ABC1 AA 19 1A

*A:D 1 19 A1 AA1 ABC1 AA 1A

F:D F1 F2 F9 A1 Z0 1A

[ABC]B:D AB1 CB1 BB9 AC1 DB9 CZ0

[!ABC]B:D ZB1 DB9 QB0 AC1 AB1 CB1 BB9 CZ0

 

5. What are we trying to match?

First, what do we do with a match?? Well, if a callsign matches one of the patterns a message
appears in the check window. Therefore we make up rules that specify what a 'bad' call is, like:

Calls that start with 3 letters1.
Calls with first letter B with prefix other than BT, BV, BY, BZ2.
French calls with a 1 or 6 that don't have 3 letter suffix3.
East German calls that don't end in A to O (East Germany does not exist anymore but is still4.
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in as a nice matching example)

 
Then we try to make a pattern that will match only calls fitting that rule.

Unfortunately some countries have made the job a bit harder by restricting certain types of calls to
certain bands and modes. I.E. the HJ prefix is only used on CW or 40m and 80m SSB. So we need
some way to specify rules for those calls. So what I do is append the band and mode information to
the end of the callsign before it goes through the pattern matcher. What it looks like then is this:
"BY1AA=4S" where the '=' is added at the end of the call, followed by the band number (1=160m,
2=80m, ... 6=10m) and the mode (S=SSB, C=CW, O=Other modes). Now we can make rules that
apply to specific bands and not have another mechanism to remember. This also helps us by
marking the end of the call with the '=' sign, so now we can sort out calls that have to have specific
lengths.

This means the following combinations can be made to specify bands and modes:

=3C match a '3' (40meters) followed by "C" for CW, call would be bad on 40m CW

=4 match just a '4' for 20m either mode, call would be bad on 20m any mode

=:DS match any band, but only for SSB, call would be bad on SSB on any band

Which for our rule that is valid only on CW or 40/80 SSB means that it is bad on any other band or
on SSB so we could do: =[1456]S which means the call is bad on 160, 20, 15, or 10m SSB.

Also, before a call is sent through the pattern matcher any portable part of the call is removed. This
way a /QRP, /A, /MM, /CT3 etc. does not affect the checking of the basic callsign.

Now, back to some of the cases mentioned earlier and how to make up rules for them.

1. Calls that start with 3 letters

This is fairly easy, all we need is a rule that will 'match' if the first 3 characters are letters. Since the
:A phrase says to match any one letter we can use
that to get the rule: :A:A:A. Notice, that since we are only worried about the first 3 characters of the
call we don't have to go past that in the rule. This
makes use of the property that says if the rule runs out before the callsign does the rest is assumed
to match.

2. Call with first letter B with prefix other than BT, BV, BY, BZ

This is a bit harder, but at least we only have to deal with the first 2 characters of the call. First, we
only want this to apply to calls that start with a 'B'. Then if the second character is not one of the
group 'TVYZ' we want it to 'match'. So we get the rule: B[!TVYZ]. This is the same as above, if we
match the 'B', and then the next character is not one of the set "TVYZ" we don't care what the rest
of the call might be.

3. French calls with a 1 or 6 that don't have 3 character suffix
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Now this is a real test of the capability of the rules and how well you understand them. First we
need calls that start with 'F', followed by a '1' or '6'. Then we need to match one or two character
suffixes to reject suffixes that are too short. For this we will use one of the 'optional' matches for the
second letter of the suffix to get: F[16]:A-A=

Note how we have the ":A-A" which will match one letter, then optionally another letter. We can not
use "+A" in this case because that would also match 3 letters. Then the '=' will anchor the end of
the rule so that if there was a third letter in suffix it would not match the '=' and the call would pass
as good. Unfortunately the French also use other prefixes like FB, FD, FE, FF that follow the same
rule. But this can not be combined be cause of other calls that also start with F and don't
necessarily have 3 letter suffixes. Calls like FR, FS, FJ, FC, FT may not fit the 3 letter rule. This
means we need a second rule to finish this problem to specify the other French prefixes we want to
check for 3 letter suffixes. To cover this we get the rule: F[BDEF]16:A-A=. Which will match French
2 letter prefixes followed by a '1' or '6' with only 1 or 2 letter suffixes.

4. East German calls that don't end in A to O

Now here is the killer. Fortunately all these calls have been replaced, but it is still a good example
and will probably be very similar to some of the Russian rules for suffixes. First we want to match
calls that start with 'Y', followed by a digit from 2 to 9, followed by another digit from 0 to 9, then
there could be one, two, or in rare cases three letter suffix that must end with a letter in the range of
'A' to 'O'. With all this in mind we get the rules:

Y[2-9]:D[!A-O]= for single letter suffix

Y[2-9]:D:A[!A-O]= for 2 letter suffix

Y[2-9]:D:A:A[!A-O]= for rare 3 letter suffix

Again we ended up with multiple rules, in this case because if we had used a '+A' or '*A' it would
have also matched the last letter that we wanted to check specifically.

Now if you look in the file CALLSIGN.PAT you will see all the rules that I have come up with. Each
rule also has a line giving the explanation for it. This explanation is shown as a messages in the
check window. You will note that some of them are not hard rules, only that the call is rarely used.

Now you should all be experts at making rules for bad callsigns. When you come up with a new
pattern you can test it by entering the callsign in the callsign field.

It is possible to come up with rules that you can't get to in the file. For instance a call like
"HI500ABC" would always be rejected by the "CALL TOO LONG" rule near the top of the file, so if
you tried to come up with a specific rule saying that HI500 calls only have 2 letter suffixes you would
not get to it unless you put it before the rule for maximum callsign length.

Some of the 'Generic' rules will reject calls that may be good. The special calls using extra long
numbers, like the "HI500ABC" above may very well be a legal call. But since these should be
relatively few, especially during a contest, I feel it is better to have them shown in the check window
and let the operator determine if they are correct than to try to come up with rules that may only be
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used once.

Links

In this Section...

Links
1. N1MM Links

1.1. N1MM Free Contest Logger Home Page
1.2. N1MM logger General discussion group
1.3. N1MM logger Digital discussion group
1.4. Download
1.5. N1MM video display by N6NC

2. Support file links
2.1. HF Country files (by Jim Reisert, AD1C)
2.2. Super Check Partial Database Files for HF contests
2.3. Super Check Partial Database Files for VHF and up contests (North
America only)
2.4. Real time scoring
2.5. Thucydides ÃƒÂ¢Ã¢â€šÂ¬Ãiâ€œA history manager for N1MM
loggerÃƒÂ¢Ã¢â€šÂ¬Ã‚Â  by Carel, PC5M
2.6. Athena ÃƒÂ¢Ã¢â€šÂ¬Ãiâ€œDisplay real-time contest
statisticsÃƒÂ¢Ã¢â€šÂ¬Ã‚Â  by Carel, PC5M
2.7. MakeHistory by Howard, N4AF
2.8. AB_Switcher by Dan, WR0DK

3. Rotator interfacing links
3.1. Antenna Rotator System ( ARS ) by EA4TX
3.2. LP-Rotor by Larry Phipps - N8LP

4. Hardware links
4.1. Ham Radio Solutions
4.2. K1EL
4.3. microHAM
4.4. Top Ten Devices, Inc.
4.5. Interfacing links

5. Software links
5.1. MM Software Page (freeware)

5.1.1. MMTTY
5.1.2. MMVARI

5.2. Fldigi Software Page (freeware)
5.3. Port I/O Driver (freeware)
5.4. Master.dta Editor (freeware)
5.5. Dimension 4 (freeware)
5.6. AboutTime (freeware)
5.7. Cool Edit (shareware)
5.8. Audacity (freeware)
5.9. QuickMix (freeware)
5.10. Sound Mixer (freeware from PA1ARE)
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5.11. Audiograbber (freeware)
5.12. AutoHotKey (freeware)
5.13. AutoIt version 3 (freeware)
5.14. KeyTweak (freeware)
5.15. AR Cluster User (freeware from Lee, VE7CC)
5.16. TelMgr (freeware from LU7DID)
5.17. Telnet interface (freeware from IZ4AFW)
5.18. CBS (freeware from K5KA)
5.19. SH5 (freeware from UA4WLI)

6. Contest Calendar links
6.1. ARRL Contest Calendar Page
6.2. SM3CER Contesting service
6.3. VK4DX Contest Calendar
6.4. WA7BNM Contest Calendar Main Page

7. RTTY links
7.1. RTTY contesting (by Don AA5AU)
7.2. World RTTY Contest Scene (by DJ3NG)
7.3. RTTY.com
7.4. Jim's Gazette

1. N1MM Links

 

1.1. N1MM Free Contest Logger Home Page

http://pages.cthome.net/n1mm

An overview with all the latest information on the program
View and download Help files / Manuals (many languages)
Report bugs and request features
Testimonials
more

 

1.2. N1MM logger General discussion group

http://groups.yahoo.com/group/N1MMLogger

http://groups.yahoo.com/group/N1MMLogger/join

This group discusses features, bugs, and ideas for the N1MM Free Contest Logger regarding
general program issues including CW and SSB contests.

Do you have questions/remarks
Here you want to go
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To discuss the general program issues you have to join first:

 

1.3. N1MM logger Digital discussion group

http://groups.yahoo.com/group/n1mmlogger-Digital

http://groups.yahoo.com/group/n1mmlogger-Digital/join

This group discusses features, bugs, and ideas for the N1MM Free Contest Logger regarding
Digital modes issues including digital mode contests.

Do you have questions/remarks
Here you want to go.

To discuss the digital program issues you have to join first:

 

1.4. Download

http://pages.cthome.net/n1mm/html/English/Installation.htm

Program (base install) - N1MM-FullInstaller.exe
Includes Serial, parallel and USB port support for 32 bit Operating Systems -
PORT95NT.EXE

Program Updates - N1MM-NewexeVx.x.xxx.exe
Other files - Country files, Master Callsign database
Windows Help file - N1MMLoggerHelp.chm
Manual in PDF format - N1MMLogger.pdf
RTTY engine - MMTTY

 

1.5. N1MM video display by N6NC

Download from site 1: (all files approx 5 MB)

Part 1: http://www.pi4dec.nl/n1mm/video/N1MM%20Video%20Part%201.wmv
Part 2: http://www.pi4dec.nl/n1mm/video/N1MM%20Video%20Part%201.wmv
Part 3: http://www.pi4dec.nl/n1mm/video/N1MM%20Video%20Part%201.wmv
Part 4: http://www.pi4dec.nl/n1mm/video/N1MM%20Video%20Part%201.wmv

or

Download from site 2: (all files approx 5 MB)

Part 1: http://www.pa6z.nl/DOWNLOADS/N1MM_Video_Part_1.wmv
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Part 2: http://www.pa6z.nl/DOWNLOADS/N1MM_Video_Part_2.wmv
Part 3: http://www.pa6z.nl/DOWNLOADS/N1MM_Video_Part_3.wmv
Part 4: http://www.pa6z.nl/DOWNLOADS/N1MM_Video_Part_4.wmv

 

Explanation of screens
Part 1 - Screen configuration, Using two monitors
Part 2 - Packet/telnet window, Available Mults and Q's window, Bandmaps
Part 3 - (first part) Multiplier window, Info window

Demonstration N1MM logger in contest operation
Part 3 - (second part) Action window (VFO A/B), Enter frequency, ESM mode, Mult
hunting with Available Mults and Q's display
Part 4- Bandmaps and Mult hunting, VFO B action window, Packet/Telnet window and
functions

2. Support file links

 

2.1. HF Country files (by Jim Reisert, AD1C)

http://www.country-files.com/cty/

Country files which can be imported in the program (cty.dat or wl_cty.dat). The better choice is
wl_cty.dat
Import this country file by selecting 'Import country list from downloaded file' in the 'Tools'
menu.
Look for install information on: Customizing the DXCC list

 

2.2. Super Check Partial Database Files for HF contests

http://www.supercheckpartial.com

Several types of Check Partial Database files (also called Master files) are created before each
major contest:

Master.dta - for international contests (all calls)
masterdx.dta - for DX contests (non US/VE calls)
masterusve.dta - For US/VE contests with W/VE calls
masterss.dta - for ARRL sweepstakes contests

Copy these files in the program directory and select the one to use in the tab 'Associated
Files' under 'File | Open Log in Database' dialog'.
The calls in these database master files appear in the Check window after entering at least
two letters of the callsign field.
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2.3. Super Check Partial Database Files for VHF and up contests (North America only)

http://www.qsl.net/k1tr/master.htm

The calls in this database master.dta file appear in the Check window after entering at least
two letters of the callsign field. Copy this file in the program directory and select it in the tab
'Associated Files' under 'File | Open Log in Database' dialog'.

 

2.4. Real time scoring

K1TTT upload software: http://www.k1ttt.net/software/realtimescore.zip

K1TTT upload software source code: http://www.hornucopia.com/xml4contestresults.html

Upload software to upload your score by Dave, K1TTT
Works automatically with N1MM logger

The source code for this software is free
Efforts to standardize real time score reporting can be found at:

Standardize real time score reporting info: http://www.hornucopia.com/xml4contestresults.html

2.5. Thucydides ÃƒÂ¢Ã¢â€šÂ¬Ãnâ€œA history manager for N1MM
loggerÃƒÂ¢Ã¢â€šÂ¬Ã‚Â  by Carel, PC5M

http://www.xs4all.nl/%7Ekvgog/projects/thucydides.html

A great tool to create import files from previous contest logs for the N1MM logger Call History
function.
More info about this program in the chapter 'Third Party Software'

 

2.6. Athena ÃƒÂ¢Ã¢â€šÂ¬Ãnâ€œDisplay real-time contest statisticsÃƒÂ¢Ã¢â€šÂ¬Ã‚Â 
by Carel, PC5M

http://www.xs4all.nl/%7Ekvgog/projects/athena.html

Athena was developed to provide a (near) real-time insight in how the contest is progressing;
How many qso's, multipliers have been worked and what the current score is. This data is
presented per band and/or as a total view for all band
More info about this program in the chapter 'Third Party Software'
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2.7. MakeHistory by Howard, N4AF

http://www.pi4dec.nl/n1mm/files/makehistory.zip

Makehistory may be used to generate callhistory.txt files for import, this should only be necessary
where the Cabrillo logs are from legacy logging programs and have not been imported into N1MM.
The program handles not only Cabrillo logs but other ascii logs as well. If the log has already been
imported into N1MM use Thucydides.

 

2.8. AB_Switcher by Dan, WR0DK

http://wr0dk.home.comcast.net/abswitcher.html

AB_Switcher is a program to allow radio a/b switching on a comport without the use of a parallel
port on the host computer. Basically this program monitors that sound card mixer output levels and
switchs the DTR on the chosen comport to reflect the current radio TX focus.

3. Rotator interfacing links

Rotator control supported by N1MM logger.

3.1. Antenna Rotator System ( ARS ) by EA4TX

http://www.ea4tx.com/inde.htm

ARS universal antenna rotor interface by EA4TX

 

3.2. LP-Rotor by Larry Phipps - N8LP

http://www.telepostinc.com/LP-Rotor-Html/

Standalone freeware rotator control program for use with Microsoft Windows.
Designed to be used with the Hy-Gain DCU-1 or RotorEZ interfaces for Hy-Gain rotators, or
the RotorCard interface for Yaesu rotators.

4. Hardware links

Hardware supported by N1MM logger.
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4.1. Ham Radio Solutions

http://www.hamradiosolutions.com/

EZmaster
WinKey serial keyer
Band decoder
SO1R & SO2R controller

 

4.2. K1EL

http://www.k1el.com

WinKey serial keyer

 

4.3. microHAM

http://www.microham.com/

Band decoder (serial and parallel)
USB Micro keyer using the WinKey keyer from K1EL
SO2R boxes
and much more

 

4.4. Top Ten Devices, Inc.

http://www.qth.com/topten/

Band decoder
DX Doubler SO2R controller

 

4.5. Interfacing links

Sound card interfacing http://www.qsl.net/wm2u/interface.html
Simple CW, RTTY interfaces http://users.skynet.be/ON4AOI/keyer.shtml

5. Software links
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5.1. MM Software Page (freeware)

5.1.1. MMTTY

http://mmhamsoft.amateur-radio.ca/

The MMTTY software used in N1MM Logger can be found at this website

http://groups.yahoo.com/group/MMTTY

Internet group for MMTTY

 

5.1.2. MMVARI

http://mmhamsoft.amateur-radio.ca/

The MMVARI software engine is automatically installed as part of the N1MM Logger installation
You can download and install a stand-alone copy of MMVARI from this website

 

5.2. Fldigi Software Page (freeware)

http://www.w1hkj.com/

The Fldigi software used in N1MM Logger can be found at this website

http://groups.yahoo.com/group/win-fldigi/

Internet group for Fldigi

 

5.3. Port I/O Driver (freeware)

http://www.driverlinx.com/DownLoad/DlPortIO.htm

Simple user mode DLL and NT kernel driver to allow direct hardware I/O access. Used by the
program (Port95NT.exe)
Freeware from Scientific Software Tools, Inc
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5.4. Master.dta Editor (freeware)

http://www.netvampire.com/ham/

View and edit the Master Callsign Database file used in many contesting programs, import
and export callsigns, auto-download announced DX operations. Great program by Alex,
VE3NEA.

 

5.5. Dimension 4 (freeware)

http://www.thinkman.com/dimension4

Time synchronization tool for re synchronizing your computer time with Internet time
standards. This program is successfully used by many N1MM logger users.
Doesn't work direct under Windows XP, a fix can be found in the FAQ.

 

5.6. AboutTime (freeware)

http://www.arachnoid.com/abouttime/

Time synchronization tool for re synchronizing your computer time with Internet time
standards. This program is successfully used by many N1MM logger users.
Doesn't work direct under Windows XP, a fix can be found in the FAQ.

 

5.7. Cool Edit (shareware)

http://www.syntrillium.com/

Record, clean up, mix, master, and export to MP3 and other formats with this audio editor.
Many, many features.

 

5.8. Audacity (freeware)

http://audacity.sourceforge.net/

Audacity is a free audio editor. You can record sounds, play sounds, import and export WAV,
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AIFF, and MP3 files, and more. Use it to edit your sounds using Cut, Copy and Paste (with
unlimited Undo), mix tracks together, or apply effects to your recordings
Easy to record an entire contest. Sset the sample rate to 8000 and let it rip!

 

5.9. QuickMix (freeware)

http://www.msaxon.com/quickmix/

QuickMix is a simple applet that allows you to store all or part of the current state of your
audio mixer in a settings file, and to restore the mixer to that state whenever you want.
Just set the different settings including mute etc. before saving the setting and give the
setting a name *.qmx

 

5.10. Sound Mixer (freeware from PA1ARE)

http://www.qsl.net/pa1are/software.html

Mixer is a program to set and restore the settings of the soundcard.
You can use it in two different ways... First you can use in the windows mode, where you have
a visible mixer. You can store and retrieve the soundcard settings suitable for a certain
application. If you use Mixer in a batch file just specify the label of the settings you want to
restore.... Mixer will start (invisible) set the appropriate settings and then exits.

 

5.11. Audiograbber (freeware)

http://www.audiograbber.com-us.net/

Program which can record (among many other things) whatever the soundcard is playing in a
variety of formats including MP3 at various bit rates.

 

Tips from Patrick, F6IRF
Schedule 1 hour files to start at 00:00 and end at 00:59:55
Files are named, according to day/time.
MP3 11 kbps quality is more than enough for SSB, CW and RTTY

about 3MB/hour mono, or 6MB/hour stereo,for SO2R.
If you have "Fraunhofer" codec on you PC, just use this one, it's the best for
non-musical applications.

 

http://n1mmtw61.semdxa.org/tiki-print_multi_pages.php?printstructures...

644 of 680 2/2/2011 4:54 PM



5.12. AutoHotKey (freeware)

http://www.autohotkey.com/

Autohotkey can create hotkeys for keyboard, joystick, and mouse. Remap keys and buttons
on your keyboard,joystick, and mouse and has many more features.

 
Virtually any key, button, or combination can become a hotkey.

Example script in the 'Third Party Software' chapter
Almost AutoIt version 2 compatible

 

5.13. AutoIt version 3 (freeware)

http://www.autoitscript.com/autoit3/

Autohotkey can create hotkeys for keyboard, joystick, and mouse. Remap keys and buttons
on your keyboard,joystick, and mouse and has many more features.

 
Virtually any key, button, or combination can become a hotkey.

5.14. KeyTweak (freeware)

http://webpages.charter.net/krumsick/

Free keyboard remapper

 

5.15. AR Cluster User (freeware from Lee, VE7CC)

http://www.bcdxc.org/ve7cc/default.htm

This program looks useful to those who want more control over the spots appearing in the
logging program. It can run on your local machine, or on another machine. You connect to it
via port 7300 from a logging program.
It is specifically for AR-Cluster, but I would guess it works to a lesser degree with other cluster
software.

 

5.16. TelMgr (freeware from LU7DID)
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http://www.qsl.net/lu7did/

Interface between telnet client (N1MM logger) and AGWPE (packet via soundcard).

 

5.17. Telnet interface (freeware from IZ4AFW)

http://www.qsl.net/iz4afw

Interface between telnet client (N1MM logger) and AGWPE (packet via soundcard).

 

5.18. CBS (freeware from K5KA)

http://www.kkn.net/~k5tr/software/Cbs.exe

Post-contest statistics program.
This program creates qso statistics from a Cabrillo input file.
It is really great for breaking out QSOs by hour.

 

5.19. SH5 (freeware from UA4WLI)

http://www.tr4w.com/sh5

Post-contest statistics program using Cabrillo input files.
Revealing of potential mistakes in reception of callsigns.
Search of partial calls.
Many, many more features

6. Contest Calendar links

 

6.1. ARRL Contest Calendar Page

http://www.arrl.org/contests/

6.2. SM3CER Contesting service

SM3CER Contest Service
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6.3. VK4DX Contest Calendar

http://www.vk4dx.net/

6.4. WA7BNM Contest Calendar Main Page

http://www.hornucopia.com/contestcal/

7. RTTY links

 

7.1. RTTY contesting (by Don AA5AU)

http://www.rttycontesting.com/

Also by Don AA5AU, a VERY good RTTY Primer on using MMTTY and understanding how RTTY
works

http://aa5au.com/gettingstarted/rtty_start_intro.htm

7.2. World RTTY Contest Scene (by DJ3NG)

http://www.rtty-contest-scene.com/

7.3. RTTY.com

http://www.rtty.com/

7.4. Jim's Gazette

http://www.n2hos.com/digital/

DX Clusters

In this Section...

DX Clusters
1. Overview
2. Commands

2.1. SH/DX command set
3. Filter and other examples/features
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3.1. AR-cluster
3.2. CLX
3.3. DXSpider

4. Links
5. Commands

5.1. SH/DX command set
6. Filter and other examples/features

6.1. AR-cluster
6.2. CLX
6.3. DXSpider

7. Links

There are several types of DX clusters used during contests. Most of them have the same type of
commands (SH/DX style by the original from AK1A).Below a summary of the most used DX cluster
types with some sample commands how to use the DX cluster. For more information read the Help
from the cluster you are using.

There are several types of DX clusters used during contests. Most of them have the same type of
commands (SH/DX style by the original from AK1A).Below a summary of the most used DX cluster
types with some sample commands how to use the DX cluster. For more information read the Help
from the cluster you are using.

1. Overview
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Cluster AR-Cluster CLX DXnet DXSpider Wincluster Clusse PacketCluster(tm)

By (author) AB5K DJ0ZY
and
DL6RAI

F5MZN G1TLH KH2D OH7LZB AK1A

Operating
System

Windows
32 bits

Linux Linux,
Dos
Windows

Linux
Windows

Windows
32 bits

Dos Dos

Command
Set

SH/DX SH/DX SH/DX SH/DX SH/DX Own SH/DX

Version
used
for overview

5.04 4.3b9 1.51 2.3.8 1.0 not found

Still
supported

Yes Yes Yes Yes Yes No No

Freeware $$$ Freeware Freeware Freeware $$ Freeware $$

Multilingual ? ? Yes Yes No Yes ?

Website Website Website Website Website Website Website No

Help file Web Web not
found

Web
help
PDF
help
from
FRC

not found not
found

not found

Help on DX
spots

Web Web not
found

Web not found not
found

not found

Help on
Filters

Web Web pg1

Web pg2

not
found

Web
help
PDF
help
by
W3BG

not found not
found

not found

Command
Reference

Web Web not
found

Web not found not
found

not found

2. Commands
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Action AR-Cluster CLX DXnet DXSpider Wincluster Clusse

General
command set

SH/DX SH/DX SH/DX SH/DX SH/DX List

Show users SH/USERS SH/USERS SH/USERS SH/USERS SH/USERS

Show WWV SH/WWV SH/WWV SH/WWV SH/WWV SH/WWV

Configuration
network

SHow/Conf

Show Filters show/filters show/filters SHow/Filter show/filter

Set Filter set/filter [..] set/filter 5

Reset Specific
Filter

set/nofilter 1 clear/spots
1

Reset All Filters set/nofilter set/nofilter SET/NOFilter clear/spots
all

Set number of
lines to 0

SET/PAGE
0

Show DX Spot
Origination
Filters

SHOW/DXDEDX

Enable DX Spot
Origination Filter

SET/DXDEDX

Disable DX Spot
Origination Filter

SET/NODXDEDX

Show other
languages

Set other
language

-

Search the help
database

apropos

 

2.1. SH/DX command set

SET/FILTER
SHow/Filter
SET/NOFilter
SET/DX_announcements
SET/NODx_announcements
SET/Announcements
SET/NOAnnouncements
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SET/nodx - You do not get spots from the cluster but you can send them out on the network
(i.e for SO unassisted stations)

 

3. Filter and other examples/features

Setting band/mode type filters are not recommended as they will often block split frequency
operations on the low bands.

Filter examples AR-Cluster and DX-spider by the Yankee Clipper Contest Club (YCCC).

3.1. AR-cluster

For full details see: http://www.ab5k.net/ArcDocs/UserManual/ArcFilters.htm

You only want stateside generated spots and announces? Use: set/filter k/pass

set/filter k,ve/pass - You will only see DX spots from spotters in the United States (K) and Canada
(VE).

set/filter dxbm/reject vhf,uhf - VHF and UHF spots will be suppressed.

Remove all filters with: set/nofilter

Examine your settings with: show/filters

3.2. CLX

For full details see: http://clx.muc.de/user/english/html/userman.html

SET/FILTER <nr1,nr2,..,nrX>

This command lets you set reject filters as defined by your sysop. You first should look up which
filters are defined at your CLX node. This is the default list:

Filter Meaning

-------------

1 VHF 144.000 MHz and up

2 HF 30.000 MHz and down

3 TOP 1.800-2.000 MHz
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4 all the CW band segments

5 all the SSB band segments

6 all the RTTY band segments

7 all the WARC bands

-------------

Your sysop may or may not have defined further filters. You can find out by using the
SHOW/FILTERS command. After you have decided which filters you would like to switch in, you use
the command as follows: SET/FILTER 4,6

This turns on the CW and RTTY filters, so will leave you only with SSB spots. To further narrow the
filter settings, you can add more filters: SET/FILTER 1,3

The setting is now 1,3,4 and 6 which eliminates all spots except SSB spots on the HF bands from
80 to 10 meters, including the WARC bands.

SET/DXDEDX and SET/NODXDEDX

This command is used to turn off so-called Internet spots. DX spots originating from specific WAZ
zones are not forwarded to you when you have issued a SET/NODXDEDX command. This flag is
saved in your user record so you will only have to specify it once to turn these (for you) annoying
messages of. The default is to send all DX spots.For example, your sysop could have defined
zones 03, 04, 05 and 25 as DX zones. If you then turn on the NO-DX-de-DX filter, you will never
again receive any spots from these areas although other users probably will.

To look up, which zones were being defined as DX zones, use the command SHOW/DXDEDX.
When you have previously disabled DX spots from other continents with SET/NODXDEDX, you can
re-enable them with _SET/DXDEDX__.

SET/DX_ANNOUNCE and SET/NODX_ANNOUNCE

This command turns the reception of DX spots on or off. This could, for example be used if you
were reading a lengthy message and did not want DX spots in between the lines. This command is
permanent, it will enable or disable the sending of DX spots. To enable the sending of DX-spots use
SET/DX_ANNOUNCE

SET/LOGIN_ANNOUNCE

Set to see user logins and logouts locally. For each login or logout, a message is sent to you from
the system. On a busy node this will generate a lot of traffic.

Login at 1929Z: DL6RAI

Logout at 1930Z: DK2OY
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3.3. DXSpider

For full details see: http://www.dxcluster.org/main/usermanual.html  or download it as PDF file
(from FRC) at: http://www.gofrc.org/pdf/dxspider.pdf

A great PDF file on User Configurable Spot Filters in DXSpider by Jim Samuels - W3BG can be
found at: http://www.gofrc.org/pdf/Filter Primer.pdf

SET/USSTATE is a feature where the US STATE is automatically added before or behind the time
field. The information is taken from the FCC database.

The basic format for a spot filter is:

accept/spots <pattern>

reject/spots <pattern>

As you can see, there are fundamentally two broad classes of filter... accept & reject. A different
way of looking at them is:

accept - bandpass filter, as in, "Pass these spots to me"

reject - bandreject filters, as in, "I don't want to see spots like this"

The <pattern> has many, many different combinations. For now, I'm going to address just two
classes... "by" and "call". "By" means that the spot is "by someone" as in a spot "by k1xx" or "by a
VE" or "by someone in Maine"

The exact syntax is:

by_zone - spotter in the CQ Zones, 1-40

by_dxcc - spotter is a W or VE or F or G

by_state - spotter is in ME, CT, RI, NH

Remember, spots "by" means callsign of the station doing the spotting, the spotter.

"Call" on the other hand refers to the call, zone, state of station being spotted, the spottee. The
syntax here is:

call_zone - the spottee's zone

call_dxcc - the spottee's country

call_state - the spottee's state

Now, on to some simple examples.
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accept/spots by_dxcc w,ve - spots only by W & VE stations

accept/spots by_zone 5 - spots only by stations in Zone 5

accept/spots by_state me - spots only by stations in Maine...slow weekend

reject/spots call_dxcc G - I don't want to see G stations spotted

reject/spots call_zone 14 - No spots of stations in Zone 14

reject/spots call_state md - Please, no more spots of Maryland stations

With the following command I only get spots with "RTTY" in the comment field. This is nice during
RTTY contests.

accept/spot 0 info rtty - Only show spots with "RTTY" in the comment field

If you want to get rid of a filter, use: clear/spots all

Spot filters remain on a DXSpider node until you clear them out. No need to re-enter the same filter
each time you log in.

Just a couple words about frequency. You can combine frequency on the same line as an
accept/reject filter. For example:

accept/spots by_dxcc w,ve and on 10m - only 10 meter spots by W & VEs

reject/spots call_zone 25 and on 160m - I don't want more spots of JAs on 160 meters

4. Links

DX PacketCluster WebNet http://www.dxcluster.info/

Webclusters and other useful information http://hamgallery.com/clusters/

OH2AQ WebCluster (DX-Summit) http://oh2aq.kolumbus.com/dxs/

5. Commands
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Action AR-Cluster CLX DXnet DXSpider Wincluster Clusse

General
command set

SH/DX SH/DX SH/DX SH/DX SH/DX List

Show users SH/USERS SH/USERS SH/USERS SH/USERS SH/USERS

Show WWV SH/WWV SH/WWV SH/WWV SH/WWV SH/WWV

Configuration
network

SHow/Conf

Show Filters show/filters show/filters SHow/Filter show/filter

Set Filter set/filter [..] set/filter 5

Reset Specific
Filter

set/nofilter 1 clear/spots
1

Reset All Filters set/nofilter set/nofilter SET/NOFilter clear/spots
all

Set number of
lines to 0

SET/PAGE
0

Show DX Spot
Origination
Filters

SHOW/DXDEDX

Enable DX Spot
Origination Filter

SET/DXDEDX

Disable DX Spot
Origination Filter

SET/NODXDEDX

Show other
languages

Set other
language

-

Search the help
database

apropos

 

5.1. SH/DX command set

SET/FILTER
SHow/Filter
SET/NOFilter
SET/DX_announcements
SET/NODx_announcements
SET/Announcements
SET/NOAnnouncements
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SET/nodx - You do not get spots from the cluster but you can send them out on the network
(i.e for SO unassisted stations)

 

6. Filter and other examples/features

Setting band/mode type filters are not recommended as they will often block split frequency
operations on the low bands.

Filter examples AR-Cluster and DX-spider by the Yankee Clipper Contest Club (YCCC).

6.1. AR-cluster

For full details see: http://www.ab5k.net/ArcDocs/UserManual/ArcFilters.htm

You only want stateside generated spots and announces? Use: set/filter k/pass

set/filter k,ve/pass - You will only see DX spots from spotters in the United States (K) and Canada
(VE).

set/filter dxbm/reject vhf,uhf - VHF and UHF spots will be suppressed.

Remove all filters with: set/nofilter

Examine your settings with: show/filters

6.2. CLX

For full details see: http://clx.muc.de/user/english/html/userman.html

SET/FILTER <nr1,nr2,..,nrX>

This command lets you set reject filters as defined by your sysop. You first should look up which
filters are defined at your CLX node. This is the default list:

Filter Meaning

-------------

1 VHF 144.000 MHz and up

2 HF 30.000 MHz and down

3 TOP 1.800-2.000 MHz
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4 all the CW band segments

5 all the SSB band segments

6 all the RTTY band segments

7 all the WARC bands

-------------

Your sysop may or may not have defined further filters. You can find out by using the
SHOW/FILTERS command. After you have decided which filters you would like to switch in, you use
the command as follows: SET/FILTER 4,6

This turns on the CW and RTTY filters, so will leave you only with SSB spots. To further narrow the
filter settings, you can add more filters: SET/FILTER 1,3

The setting is now 1,3,4 and 6 which eliminates all spots except SSB spots on the HF bands from
80 to 10 meters, including the WARC bands.

SET/DXDEDX and SET/NODXDEDX

This command is used to turn off so-called Internet spots. DX spots originating from specific WAZ
zones are not forwarded to you when you have issued a SET/NODXDEDX command. This flag is
saved in your user record so you will only have to specify it once to turn these (for you) annoying
messages of. The default is to send all DX spots.For example, your sysop could have defined
zones 03, 04, 05 and 25 as DX zones. If you then turn on the NO-DX-de-DX filter, you will never
again receive any spots from these areas although other users probably will.

To look up, which zones were being defined as DX zones, use the command SHOW/DXDEDX.
When you have previously disabled DX spots from other continents with SET/NODXDEDX, you can
re-enable them with _SET/DXDEDX__.

SET/DX_ANNOUNCE and SET/NODX_ANNOUNCE

This command turns the reception of DX spots on or off. This could, for example be used if you
were reading a lengthy message and did not want DX spots in between the lines. This command is
permanent, it will enable or disable the sending of DX spots. To enable the sending of DX-spots use
SET/DX_ANNOUNCE

SET/LOGIN_ANNOUNCE

Set to see user logins and logouts locally. For each login or logout, a message is sent to you from
the system. On a busy node this will generate a lot of traffic.

Login at 1929Z: DL6RAI

Logout at 1930Z: DK2OY
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6.3. DXSpider

For full details see: http://www.dxcluster.org/main/usermanual.html  or download it as PDF file
(from FRC) at: http://www.gofrc.org/pdf/dxspider.pdf

A great PDF file on User Configurable Spot Filters in DXSpider by Jim Samuels - W3BG can be
found at: http://www.gofrc.org/pdf/Filter Primer.pdf

SET/USSTATE is a feature where the US STATE is automatically added before or behind the time
field. The information is taken from the FCC database.

The basic format for a spot filter is:

accept/spots <pattern>

reject/spots <pattern>

As you can see, there are fundamentally two broad classes of filter... accept & reject. A different
way of looking at them is:

accept - bandpass filter, as in, "Pass these spots to me"

reject - bandreject filters, as in, "I don't want to see spots like this"

The <pattern> has many, many different combinations. For now, I'm going to address just two
classes... "by" and "call". "By" means that the spot is "by someone" as in a spot "by k1xx" or "by a
VE" or "by someone in Maine"

The exact syntax is:

by_zone - spotter in the CQ Zones, 1-40

by_dxcc - spotter is a W or VE or F or G

by_state - spotter is in ME, CT, RI, NH

Remember, spots "by" means callsign of the station doing the spotting, the spotter.

"Call" on the other hand refers to the call, zone, state of station being spotted, the spottee. The
syntax here is:

call_zone - the spottee's zone

call_dxcc - the spottee's country

call_state - the spottee's state

Now, on to some simple examples.
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accept/spots by_dxcc w,ve - spots only by W & VE stations

accept/spots by_zone 5 - spots only by stations in Zone 5

accept/spots by_state me - spots only by stations in Maine...slow weekend

reject/spots call_dxcc G - I don't want to see G stations spotted

reject/spots call_zone 14 - No spots of stations in Zone 14

reject/spots call_state md - Please, no more spots of Maryland stations

With the following command I only get spots with "RTTY" in the comment field. This is nice during
RTTY contests.

accept/spot 0 info rtty - Only show spots with "RTTY" in the comment field

If you want to get rid of a filter, use: clear/spots all

Spot filters remain on a DXSpider node until you clear them out. No need to re-enter the same filter
each time you log in.

Just a couple words about frequency. You can combine frequency on the same line as an
accept/reject filter. For example:

accept/spots by_dxcc w,ve and on 10m - only 10 meter spots by W & VEs

reject/spots call_zone 25 and on 160m - I don't want more spots of JAs on 160 meters

7. Links

DX PacketCluster WebNet http://www.dxcluster.info/

Webclusters and other useful information http://hamgallery.com/clusters/

OH2AQ WebCluster (DX-Summit) http://oh2aq.kolumbus.com/dxs/

Customizing the DXCC List

In this Section...

Customizing the DXCC List
1. Updating the country file - CTY.DAT
2. Writelog country file

1. Updating the country file - CTY.DAT
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The program uses a country file from which it takes all the information like the country name, CQ
zone, ITU zone, continent, latitude and longitude etc. This file mostly called CTY.DAT is not directly
used by the program but has to be read into the currently used database. The program will retrieve
all information from the database (not from the cty.dat file). When importing the country file the
program will ask for the file to import. this way several cty.dat files could be used for different
contests.

 
When entering a callsign the left pane of the Entry Window will give Prefix, country name, CQ zone
and continent. The Info Window will also give this information and additional calculated information
like beam heading, distance, sunset and sunrise.

A number of high profile stations who are not in their own call area, have this built into the country
file. The file will populate the correct zone, even though it looks out of place. An example is K2KW
who we would expect in zone 5 but lives in California and is entered in the CTY.DAT file living in
zone 3.
How to update the country file.

Download the update using the menu item 'Download latest country file (wl_cty.dat)(Internet)'
from the Tools menu.
This item will open your web browser to the web page where to download the latest wl_cty.dat
file (Select the correct one..).
After downloading the new country file it has to be imported in the program by selecting 'Tools
| Import country list from downloaded file'.

 
CTY.DAT file format
The format from CTY.DAT is as follows:

Column Length Description

1 26 Country name terminated by a colon character.

27 5 CQ zone terminated by a colon character.

32 5 ITU zone terminated by a colon character.

37 5 2-letter continent abbreviation terminated by a colon character.

42 9 Latitude in degrees, + for North terminated by a colon character.

51 9 Longitude in degrees, + for West terminated by a colon character.

61 9 Local time offset from GMT terminated by a colon character.

69 6 Primary DXCC Prefix terminated by a colon character.

The information that follows should rarely, if ever, be needed. Jim Reisert, AD1C, is very
punctual in releasing new versions of the various country files, particularly before each major
contest.

Note
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next
line(s)

List of prefixes assigned to that country, each one separated by a comma and
terminated by a semicolon.

 

 

Alias DXCC prefixes (including the primary one) follow on consecutive lines, separated by ",". If
there is more than one line, subsequent lines begin with the "&" continuation character. A ";"
terminates the last prefix in the list.

If the country spans multiple zones, then the prefix may be followed by a CQWW zone number in
parenthesis, and it may also be followed by an ITU zone number in square brackets, or both, but
the CQ zone number in parenthesis must precede the ITU zone number in square brackets.

The following special characters can be applied to an alias prefix:
(#) Override CQ zone where # is the zone number
# Override ITU zone where # is the zone number

 

2. Writelog country file

 
N1MM logger can also use the country file WL_CTY.DAT from WriteLog which has extra CQWW
zone information for several countries including: Canada, Australia, and China. Because each of
these countries is allocated a multitude of prefixes, but the CQWW zone is determined by the call
area regardless of prefix, a very large number of entries would be necessary to spell out all the
combinations. Instead, WL_CTY.DAT contains special "macro" commands that indicate how the
CQWW zones are determined for that country. See the example below. See the update
instructions.

Importing the wl_cty.dat file as country file is preferred over the 'normal' cty.dat file because of the
extra information it contains.
Other info

* You can override the continent, zone etc. on a prefix-by-prefix basis.
* Primary prefixes preceded by an * are only valid for the CQWW and WAE contests. The logging
program will ignore these lines otherwise. When updating the country file please don't remove the *.
* The logging program doesn't handle prefixes such as FR5ZQ/J correctly. Listing FR/J as a prefix
for Juan de Nova in the country file doesn't work unless a station signs "FR/J" as his callsign. If you
work one of these islands, you'll have to add the callsign of the worked station to the country file
manually before it is counted as the right country.
* When updating the CTY.DAT file use a text editor, not a word processor. Notepad is fine, watch
out for WordPad etc., always save as a text file!

The fields are aligned in columns and spaced out for readability only. It is the ":" at the end of
each field that acts as a delimiter for that field.
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* After updating the CTY.DAT file it has to be reloaded. Reload the file via Tools/Import country list
from downloaded file.
* After a Reload the prefixes are imported into the database which you are using. When changing to
another database you have to do a reload again to be sure that you use the most recent country file
for that database (or the one you want).
* When a database is copied, also the country list in it will be copied. So if the country file was
updated in the original file after a copy you don't have to import the country list again.

Note on KG4 stations: When a KG4 callsign is a 2x2 callsign it is assumed to be Guantanamo
otherwise it is K (2x1 or 2x3). When the exact callsign appears in the loaded cty.dat the associated
country will be used (K or KG4 are then not automatically assumed).
Examples

Netherlands: an easy example with nothing special. The program will assign all calls starting with
PA, PB, PC, etc. to the country Netherlands in CQ zone 14, ITU zone 27 and EU as continent. PA
will be the the prefix shown in the multiplier window.
Netherlands: 14: 27: EU: 52.40: -4.90: -1.0: PA:
PA,PB,PC,PD,PE,PF,PG,PH,PI;

Greenland: Normally only stations with OX are counted as Greenland. The callsign XP1AB has
been added which normally belongs to Denmark (OZ). XP1AB will be valid as Greenland with
standard Greenland parameters i.e. zones, continent etc.
Greenland: 40: 05: NA: 62.50: 45.00: 3.0: OX:
OX,XP1AB;

African Italy: This is an example where a * is added before the primary prefix which means that the
country only counts in CQ-sponsored contests.
African Italy: 33: 37: AF: 35.40: -12.50: -1.0: *IG9:
IG9,IH9,IQ9L,IZ9;

Other nice examples with zone changes on calls are VE and UA9, see the CTY.DAT file in the
program directory.

Writelog macro example.
The macro starts with # and ends with the next ; It means that for all the prefixes in China the zones
are determined by the call area and first letter of the suffix.
China: 24: 44: AS: 40.00: -116.40: -8.0: BY:

BY: BY3G(23),BY3H(23),BY3I(23),BY3J(23),BY3K(23),BY3L(23),1.

BY9A(23),BY9B(23),BY9C(23),BY9D(23),BY9E(23),BY9F(23),BY9G(23),
BY9H(23),BY9I(23),BY9J(23),BY9K(23),BY9L(23),BY9T(23),BY9U(23),
BY9V(23),BY9W(23),BY9X(23),BY9Y(23),BY9Z(23),BY0(23);
3H,3I,3J,3K,3L,3M,3N,3O,3P,3Q,3R,3S,3T,3U,BG,BT,BW,BY,BZ,XS;

Technical Information
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In this Section...

Technical Information
1. Directory structure
2. Where is the program information stored?
3. The Access database
4. The "N1MM logger.ini" file

4.1. Functions
4.2. Window Section

5. Program files
6. Database files
7. Files created on your command:
8. RTTY files
9. PSK and other modes
10. PSKCore files (all obsolete)
11. ADIF fields
12. Callsign checking in the Digital Interface
13. Routers and Firewalls

13.1. Adding N1MM to the Windows firewall

N1MM logger is a contest program written in Microsoft Visual Basic which uses a Microsoft Access
2000 database for storing information. Writing and retrieving data to and from the database is done
with SQL (Structured Query Language).
Running the program needs no more programs or files than supplied in the installation package
and the program update (NewExeVx.x.x).

Do you need all the information given below to use the program? NO

 
Note: Normally there is no need to access the database or ini files.
Don't make changes if you are not very sure what you are doing. Second and last warning!

When you are interested in the structure of the database you need to have installed Microsoft
Access 2000 or the Access 2000 viewer or more recent versions.

Note: When changing data always make a backup from the database (and preferably the whole
N1MM logger directory).

We recommend not to change any data in the database or any other files unless you are very
sure what you are doing. It is possible to change the behavior of the program and get erroneous
results. If you have changed the contents of the database and the program behaves strange go
back to the original (unaltered) version of the database.

 
No support will be given to users who change the database structure or contents. The same
goes for changing other files used by the program.

You are on your own!

Warning
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Why is this information given?

Accessing information direct in the database sometimes gives possibilities not directly supported by
the program.

Examples:

You want to have reports which are not standard in the program. With some knowledge of
SQL and Access it is possible to generate your own.
Changing information in the database can sometimes be done much easier this way than
within the N1MM logger program.

 

N.B. It is not possible to add a contest to the program this way.
Contests and it's rules etc. are in the main program file (N1MM logger.exe) and are not stored in the
database or any other files!

1. Directory structure

 
The default directory where the program is installed is in the 'Program Files' directory on the first
hard disk (C:). Below this directory two directories are (or can be) made to support Digital Voice
Keying (DVK).

C:\Program Files\N1MM
Logger

Program file directory

C:\Program Files\N1MM
Logger\Wav

Directory to store all wav files used in the SSB function keys. You
have to make these yourself.

 

2. Where is the program information stored?

 
There are several places where program information is stored.

The Access database file
After a first install called HAM.MDB
You can rename it or add your own databases from within the program.
General contest information

After changing QSO information always do a rescore! Multiplier information and QSO points will
be updated after a rescore so any changes made direct in the database will be lost. Change
multiplier and QSO points in the (Cabrillo) output files. The program updates the database and
not the other way around.

Note
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Contests information
Station information
QSOs made in the contests
Packet spots
(Function) key information
Country information
Etc.

N1MM logger.ini file
Program settings from the configuration screens , these settings overrule the settings in
'Default Settings.ini'
Window settings (screen setup)

Default Settings.txt
Default settings file used by the program

Configuration files
Setting up your external TNC
MMTTY specific files

Other files
Wav files for CQ etc.
Exported Cabrillo, ADIF, generic log and summary sheet files
Section files used for specific contests (*.sec)

 

3. The Access database

 
A database has tables with in it the data.

Table Contents

Antennas Antenna information
('Config

Configure Ports, Telnet Address,
Others

Tab:
Antennas')

BandModeFrequency Radio (vfo) number, frequency and mode information used when changing
band.

CallHist Table used for 'Call History Lookup' function.

Contest All the available contests in the program

ContestInstance The contests which are shown in the contest dialog

CTYDAT Country information like 'master' prefix, name, CQ and IARU zone, latitude,
longitude etc.

DXLOG QSOs from all the contests in the table ContestInstance

Lookup (Function) keys, States, Provinces etc

PacketSpots Packet spots for all the bands. Spots from this table are shown on the
bandmaps

PacketSpotsTest Test packet spots (for program development)
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Prefixes Prefixes recognized by the program with default country prefix

SectionsWorked Information to show the section multipliers in the Multipliers window

Settings Settings used by the program

Station Station information i.e. call, name, address etc.

ValidCalls Not used any more (empty)

 

4. The "N1MM logger.ini" file

 
Everything in the "N1MM logger.ini" file should be settable through the program's User Interface.
Defaults are in the file "Default Settings.txt" . An item will not appear in the "N1MM logger.ini" file if
its value is the same as in the 'Default Settings.txt' file. Both files can be found in the program
directory.

The "N1MM logger.ini" file is organized by function (top of file) and windows (bottom of file).
The function section's attributes can be deleted, and defaults will be used by the program.
The window section contains position and other window information. Generally these values
should not be changed unless a window disappears.
Try to keep the file in this order, it will make things easier to find during discussions on the
user group.
To comment out a value in the file precede it with a semicolon (;)
Removing the 'N1MM logger.ini' file will use the defaults in 'Default Settings.txt', the 'N1MM
logger.ini' file will be recreated.

 

4.1. Functions

 
Functions are the name for labels within square brackets that are inserted in an .ini file to make for
easy readability. When manually editing an .ini file, it is good practice to put your new lines under
the appropriate function heading.

Possible functions are:

[Com1] [Com2] [Com3] [Com4] [Com5] [Com6] [Com7]

[Com8] [Lpt1] [Lpt2] [Lpt3] [MutiplierWindow] [SO2R/V] [Files]

[Digital1] [Digital2] [MMTTY] [Function
Keys]

[Other] [Winkey] [Mode
Control]

[Antennas] [SO2R/V
Setup]

[Available] [Packet] [Configurer] [ConfigurerDialog]
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[CW
Window]

[Digital
Interface]

[Digital Interface
Setup]

[DigitalIO2] [EditContact] [EditLookupTable]

 
Examples

[Packet]

Packet Tab=1 - Telnet window is selected, if removed the Packet tab is selected.

[Configurer]

Database Name=C:\Program Files\N1MM Logger\PI4GN-Maart-2004.mdb Selected database

Contest Type=VHFREG1 Selected contest in the selected database

Contest NR=1 Selected contest number in the selected database

Recent Contest 1=VHFREG1:6-3-2004:C:\Program Files\N1MM Logger\PI4GN-Maart-2004.mdb
Most recent opened contest

4.2. Window Section

 
Possible windows are:

EntryWindow EntryWindow2 GraphicalBandMap 1 GraphicalBandMap 2

InfoWindow Log LogTypeSelectionDialog MultsByBand

PacketWindow PSKEngine ScoreSummary StationDialog

SuperCheckPartial AvailableMultsAndQs BandMap

 
Examples

[EntryWindow]

Top=3825

Left=2985

Height=3330

Width=5370

[PacketWindow]

WindowState=0 Window is open (default) or closed (0), the Entry window can not be closed

Top=9000
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Left=3270

Height=2550

Width=12105

Telnet Port=K1TTT.NET The selected telnet cluster from the list. Specific for this section.

[BandMap]

CW Wide - 1=*RMF400CW Narrow - 1=*RMF250

[InfoWindow]

WWVMessagesVisible=False ''WWV messages are not shown in the Info window
Configuration files''

After installation the files below are stored in the N1MM logger program directory.

5. Program files

 
Never delete these (program) files!

arrow.bmp - arrow icon used in the bandmaps (non active bandmap)
ClearRegistry.bat - used to clear the contents of the registry used by the program (obsolete
since version 4, can be deleted from the directory).
cty.dat - the default country file name used when the menu item 'Tools /Import country list
from downloaded file' is selected.
CW IF.exe - this is the Active X component which generates the CW.
cyanarrow.bmp - arrow icon used in the bandmaps (active bandmap).
Default Settings.txt - the default settings for the program, differences are in N1MM Logger.ini.
dirswap.BAT - rename wav file directory (example).
empty.wav - file used to stop sending a wav file.
led_Red.bmp - icon used when a message is shown which needs attention.
master.dta - file used by the Check window with calls from many contesters.
N1MMLoggerHelp.chm - windows help file (shown when pressing Alt+H).
N1MM Logger.exe - the N1MM logger contest program.
N1MM logger.ini - configuration file for functions and windows. Be careful when editing.
N1MM logger.ini.init - configuration file from the NewExe file. Will be renamed to N1MM
Logger.ini if not found.
N1MMlogger.pdf - the manual which is shown when selecting 'Help / Manual'.
N1mmWave.ocx - ocx used for recording and playing wav files.
reddot.gif - icon used when a warning message is shown in the Entry window pane.
RevisionHistory.htm - N1MM Logger Revision History overview.
*.sec - text files used for different contest (example: SAC.sec, REF.sec etc).
style.css - style sheet ued in the file 'RevisionHistory.htm'.
ST6UNST.LOG - file used by Windows when removing this program from your hard disk.
Suncalcs.dll - dll used by the program.
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Update Log.wri - overview from the last program changes and updates. (obsolete, can be
deleted from the directory).
Upgrade.bat - file to register CW IF.exe to Windows (normally automatically done by the
program).
*.init - files used during installing which can be deleted but we recommend to leave them in.

 

6. Database files

 

ham.mdb - default database file (don't delete).
new.mdb - default database file used when a new database is created by the user (don't
delete).
*. MDB - database files made when selecting 'File / New Database'.

Deleting this file means losing all the contest QSOs in it. It's good practice to make a new file every
(major) contest and name it after the contest. Example: PACC2002.MDB

7. Files created on your command:

 

<YOURCALL>.ADI - ADIF file made by the program when selecting 'File / Export / Export ADIF
to file...'
<YOURCALL>.LOG - Cabrillo file made by the program when selecting 'File / Export / Export
Cabrillo to file...'
<YOURCALL>.SUM - Summary Sheet made by the program when selecting 'File / Export /
Print Score Summary to File'
<YOURCALL>.TXT - Log file made by the program when selecting 'File / Export / Export to
File (Generic)...'
*.MC - Exported Function key files.
*.TXT - Exported other files (example: Packet/Telnet buttons)

 

8. RTTY files

 
MMTTY files are not in the program installation package and should be downloaded separately
when needed.

MMTTY.exe - the MMTTY program
MMTTY.ini - MMTTY configuration file
MMTTY.* - other files used by the MMTTY program
XMMT.ocx - needed file for MMTTY.exe
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Settings.txt - example file for the AEA PK-232 external controller
UserPara.ini - MMTTY program settings

 

9. PSK and other modes

 
The MMVARI engine is used for most digital modes which is included in the N1MM installer. There is
no need to download the MMVARI package for use with N1MM logger.

MMVARI.ocx - the MMVARI engine
Varicode.tbl - table used by the MMVARI engine

 

10. PSKCore files (all obsolete)

 
All PSKCore files below are obsolete and not required for use with N1MM logger anymore.

PSKCore.dll (obsolete, can be deleted from the directory)
XMMT.ocx (obsolete, can be deleted from the directory)
PSK63.dll (obsolete, can be deleted from the directory)
WINPSKX.dll (obsolete, can be deleted from the directory)
PSK.pal - color setting file for the WINPSK dll (obsolete, can be deleted from the directory)
WINPSKX.oca - WINPSK support file (obsolete, can be deleted from the directory)

 

11. ADIF fields

 
N1MM logger complies with the latest ADIF standard. However in the N1MM logger database there
is more information stored then we can export (and import) using ADIF. That is why a few N1MM
logger specific tags have been added so when exporting an ADIF file and importing it again all
information from the DXLOG table will be available. A rescore will update the fields not imported
and to get the score and multipliers shown correct on the screen.

APP_N1MM_EXCHANGE1 - content of the Exchange1 field from the table DXLOG table.
APP_N1MM_POINTS - content of the Points field from the table DXLOG table.
APP_N1MM_RADIO_NR - content of the RadioNr field from the table DXLOG table.
APP_N1MM_MISCTEXT - content of the MiscText field from the table DXLOG table.
APP_N1MM_CONTINENT - content of the Continent field from the table DXLOG table.
APP_N1MM_CONTACTTYPE - content of the ContactType field from the DXLOG table.
APP_N1MM_RUN1RUN2:1 - content of the Run field from the DXLOG table.is the Run1/Run2 tag.
1 means radio 1 was the Run radio, 2 means radio 2 was the Run radio.
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12. Callsign checking in the Digital Interface

 
Below describes how callsign checking is done in the Digital Interface windows.

It first checks to see if the callsign is of the right length (More than 2 less than 11). It then checks to
see if someplace in the first 6 characters there is a number. 3rd it checks to see if there are no
invalid characters in it. Then if it all that passes it goes through the Busted Call Checker. If the
Busted Call Checker returns an Error message then the call is invalid. Anything else from the
Busted Call Checker makes it a valid call.

As text comes into the Receive screen of the Digital Interface it gets printed to the window and
placed in a temp buffer. When a space or a CR or LF is encountered the program will send the text
in the temp buffer to the check callsign routines. Iif it comes back as a valid callsign it is sent to
another routine that looks back thru the last 25 characters of the Receive screen and colors them
accordingly. At the time the space is encountered the temp holding buffer is cleared and things get
sent there all over again. The whole process above takes just over a millisecond to complete.

Unlike other software DE before the call is not required,it looks for space mostly after callsign.

Take a look at this sequence it explains how it picks up callsigns in the RX window:

A QWSCFGTWA5TTT WA5TTT UR 599 XXXXXXXXXX

The program sees the space between the TTT and the WA so it looks into its previous holding
buffer which contains "QWSCFGTWA5TTT" that string does not equal a valid callsign even though
there is one in it. So because it encountered the space the buffer is cleared and the next string
starts being placed into it. When it hits the third space it goes back and checks the buffer again this
time it finds WA5TTT and it says it is a valid call. The program now looks back 25 characters and
any time it finds WA5TTT it will color it accordingly and also place it in the grab window.

As for the clicking on callsigns it follows the same rule except there is a routine that looks to see the
characters that are under the mouse. If it is a valid call then it gets sent through the routines to
place it in the entry window. There is a ltrs/figs line of text that shows the actual text that is being
converted. This will give you an idea of what text is getting selected etc.

Problems will happen if the rules change in various countries and the rules in the Busted Call
Checker can't keep up with the country changes so you get callsigns that do not come out of it OK.
The main reason to add the Busted Call Checker routines in there is to cut down on a lot of garbage
that would be getting colored that passed all of the check routines but were not really callsigns

13. Routers and Firewalls

A router provides your principal defense against the wild, wooly Internet. Everyone who connects to
a broadband Internet service should only do so through a router.

A software firewall (like the Windows XP firewall, Zone Alarm, etc.) provides protection from the
other computers behind your router. It's probably okay to turn off the Windows Firewall in a contest
station.
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Routers provide an important function called network address translation (NAT). If you look at your
computer's IP address and see 192.168.x.y (or 10.x.y.z), then you're golden. The 192.168.x.y (and
10.x.y.z) address ranges are defined as local only and cannot be routeable across the Internet. If
your PC has one of these addresses, it's as if you're behind a telephone switchboard and do not
have a direct dial number. That's a good defense.

Software firewalls protect you from other computers behind your router. So if you take your laptop
around with you and use various wireless networks, you absolutely need a software firewall. The
other computers at Starbucks may be full of viruses, and you need a software firewall to protect you
from them. Also, if you have a computer in your house that may be used for some less-than-safe
surfing, you should have a software firewall. Kids may have permitted access for online gaming,
peer-to-peer file sharing, or may have downloaded software that has spyware, etc. Protect your PC
by running a software firewall. Finally, if you have a wireless network, make sure you control who
access it. If your neighbor can access your network and has a bunch of malware on his machine,
your machines could get infected, too.

Robert K5PI.

13.1. Adding N1MM to the Windows firewall

 
When you do not want to turn off the Windows Firewall you can leave your windows firewall on
even though you are behind a router. Add N1MM to your exceptions list and better yet add the local
subnet (usually 192.168.1.0 (255.255.255.0)) to the port exceptions.

 

External UDP Broadcasts

In this Section...

External UDP Broadcasts
1. Main program

1.1. IsBroadcastAppInfo=True
1.2. IsBroadcastContact=True
1.3. IsBroadcastRadio=True

2. Programs using the N1MM Logger Broadcasts

External broadcasts can be used by third party software to get info from N1MM Logger about a
contest in progress to generate, for example, reports, or have an up-to-date web site. UDP
broadcasts stay in the same network (same subnet) and cannot be broadcast directly over the
internet.

There are additional UDP broadcasts built into N1MM Logger, but they not very useful for general
users. Examples include broadcasts to the N1MM rotor program and the real-time score reporting
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application.

1. Main program

For external UDP broadcasts there are some lines that need to be added manually to the N1MM
Logger.ini file. This has to be done with an external text editor, such as Notepad or Wordpad (there
is no UI for this option). Do not use a word processing program, such as Microsoft Word.
When the section [ExternalBroadcast] is not there is has to be added. An example is:

[ExternalBroadcast]

DestinationIPs=127.0.0.1 192.168.1.56

DestinationPort=12060

IsBroadcastAppInfo=True

IsBroadcastContact=True

IsBroadcastRadio=True

 

Setting Comment

DestinationIPs= Start with IP address 127.0.0.1 (the pc you are running on) and add
other PC's IP-addresses (space delimited). You can send to multiple
IP addresses in the subnet by specifying 255 for the last octet. E.g.
192.168.1.255 will send to all computers that are in the 192.168.1
subnet. Do not specify 255 in the higher order octets, or you will risk
broadcasting to the internet. While eventually the packets will be
discarded by the internet, it will not endear you to your ISP.

DestinationPort= The UDP port to use. Defaults to 12060

IsBroadcastAppInfo=True Broadcast Application Info. Defaults to False

IsBroadcastContact=True Broadcast Contact Info. Defaults to False

IsBroadcastRadio=True Broadcast Radio Info. Defaults to False

 
The dots in the example UDP broadcasts are TAB characters.

1.1. IsBroadcastAppInfo=True

This code is broadcast on the DestinationPort (default: 12060) when IsBroadcastAppInfo=True in
the section ExternalBroadcast from the file N1MM logger.ini at the moment that the Select Contest
dialog is closed with OK (and a contest will be loaded and shown on screen).
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Example UDP broadcast

l version="1 .0"?>

.C:\Program Files\N1MM logger\contests-2007.MDB

.71

.CQWWSSB

 

1.2. IsBroadcastContact=True

This code is broadcast when IsBroadcastContact=True in the section [ExternalBroadcast] from the
file N1MM logger.ini at the moment a qso is logged.
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Example UDP broadcast

l version="1.0"?>

.CQWWSSB

.71

.22-6-2008 7:04:00

.PA1M

.14

.1420100

.1420100

.PA1M

.USB

.K1TTT

.K

.K1

.PA1M

.

.59

.233

.59

.0

.

.

..

.

.

.

.

.

.14

.5

.

.0

.1

.0

.0
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1.3. IsBroadcastRadio=True

This code is broadcast when IsBroadcastRadio=True in the section [ExternalBroadcast] from the
file N1MM logger.ini at the moment that the frequencyof the radio changes. The RadioNr in the XML
ouput is the Radio number when in SO2R or the VFO number when in SO1V or SO2V.

Example UDP broadcast

l version="1.0"?>

.2< /RadioNr>

.2120000

.2120000

.CW

.PA1M

.False

 

2. Programs using the N1MM Logger Broadcasts

As an example the following program uses the N1MM logger UDP broadcasts.

Freeware software from LA0FA to place N1MM Logger QSO's direct into DXkeeper at:
http://www.la0fa.com/show_article.asp?Article_ID=48

ADIF info at: http://www.dxlabsuite.com/ADIF.htm

Off Topic, But Nice to Know

In this Section...

Off Topic, But Nice to Know
1. Working Dupes or Not?
2. Types of Operating

2.1. Running
2.2. Search and Pounce
2.3. The 'New' Packet Assisted S&P Mode

3. A QSO Speedup Tip (How is Your Typing Speed?)
4. GMT is GMT, or Not?
5. USA and Canada Daylight Savings Time Changes
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6. Which Monitor to Choose

This chapter gives general information about contesting coming from discussions on the N1MM
logger reflector. Should this be placed in a help/manual for a contest program? We don't know but
as the title says: Off topic, but nice to know. We thank the authors for their approval so we could
add this to the help/manual.

1. Working Dupes or Not?

In paper log days you used to get penalized for too many dupes that weren't marked as such in the
log. I don't know of any contest that has ever penalized you for working too many dupes as long as
you marked them in your log and didn't try to claim points for them.

Its kind of ironic that the Cabrillo log format has no way to mark dupes, the sponsor's log
processing software automatically rescores all the logs so you don't have to worry about even
recognizing dupes or worrying about not claiming points for them.

On your specific question. You log by2a but 6y2a properly logs on5zo... 6y2a would get credit
because the log checking software would properly match up the one-off call by2a with their log
entry of on5zo. If there really is a by2a and they send in a log you would lose credit for a confirmed
not-in-log. If there is no such callsign as by2a issued you would lose credit and penalty and lose
the multiplier (assuming you didn't work any other by) as a bad call. If there is a by2a but they
didn't send in a log you might get to keep the credit if the log checking software and manual
checkers don't recognize the busted call.

Lets take it one step further. Say you really screwed up and logged by2et so the log checking
software can't figure out that it was really 6y2a that you worked... now 6y2a loses qso credit and
penalties for being not in the on5zo log. You may or may not lose credit as above based on the
by2et log and callsign status.... now, later on you hear 6y2a and call them again. If they recognize
you are a dupe and come back 'qso b4' and refuse to work you, THEY LOSE! They will never get
credit for on5zo and will lose the penalty points. If instead they ignore the dupe and work you again
the original not-in-log doesn't matter as they are now in your log and everyone gets credit... so NOT
logging the dupe is bad.

The same holds for other combinations of them busting your call, or both of you busting each other,
etc. It is always better to just log the dupe and move on. There is actually less of a chance you will
get penalized if you work the dupe than if you don't.

David Robbins, K1TTT

e-mail: k1ttt@arrl.net

web: http://www.k1ttt.net

2. Types of Operating

2.1. Running
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- In this mode you normally only want to only see new multipliers so the Check spot window serves
well. You can set the filters to only see new multipliers so you can easily go grab them and get right
back to your run frequency.

2.2. Search and Pounce

- The traditional S&P mode. In this mode you dial up the band checking each signal you hear. In
this mode the bandmaps work well as they can help you quickly identify each station you hear and
determine their status as a new QSO or multiplier or dupe.

2.3. The 'New' Packet Assisted S&P Mode

- In this mode you start at one end of the band and quickly go from spot to spot and work all the
new stuff on a band. With today's high spotting rates you often find that almost every station you
would hear doing the traditional S&P is already in the band map so for an operator in a hurry to
work out a band and move on this could be very useful. Also for an operator working a 2nd VFO
while still running, or running SO2R to tune one band while CQing on another one this could be
useful as you typically have less time to spend figuring out who someone is and would rather have
a screen full of new stuff than a screen full of dupes to tune through.

David Robbins, K1TTT

3. A QSO Speedup Tip (How is Your Typing Speed?)

Being raised as a contester using CT, I was taught this trick (drill exercises on PED CT trainer, tnx
to my contesting elmer ON5YR). By pressing "Insert" to send RST (CT uses "insert" to send
call+RST).

I type the prefix, copy suffix in head, start sending RST while typing the suffix.

Saves a lot of time and the calling station does not have to wait that extra split second, as soon as
his TRX goes from TX to RX, he hears me coming back to him already.

So although I use ESM a lot, whenever I use this trick I still press "Insert", works FB!

Try it, it works FB in combination with ESM.

73 es CU in contest!

Franki ON5ZO

NB. N1MM logger can be set up to send call+rst when pressing 'Insert'.

4. GMT is GMT, or Not?

Not quite. Some of Bill Gates' boys didn't know the difference between Greenwich Mean Time and
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the local time in Greenwich, England. In some versions of Windows, one of the choices for time
zone is labeled (GMT) Greenwich Mean Time : Dublin, Edinburgh, Lisbon, London, but
unfortunately, despite what the time zone list says this setting is NOT repeat NOT Greenwich Mean
Time; it's local time in Greenwich (and Dublin, Edinburgh, Lisbon and London), which in the
summer is daylight savings time, i.e. GMT + 1:00 .

There's an often published workaround. If you absolutely gotta put your computer on GMT because
you're tired of resetting some old DOS software that doesn't know any better, you can set the
computer for (GMT) Casablanca, Monrovia. Those places never go on daylight savings time, so their
local time really is the same as GMT all year round, not like Greenwich.

But you know what? If you're using Windows software like N1MM Logger, it's a lot easier to set your
computer to your own local time zone and let the operating system take care of all that time zone
and daylight savings time stuff automagically.

73, Rich VE3IAY

5. USA and Canada Daylight Savings Time Changes

In 2007, the US & Canada changed when daylight time starts and ends. If you reside in one of
these countries and have your computer display local time, you need to do one of the following:

Windows XP: Install the latest Windows XP updates close to the date of the change (second
weekend of March). It should be handled automatically.

Older versions of Windows:

Option 1: Read this article in this link and change your machine to reflect the time changes:
http://support.microsoft.com/kb/914387
Option 2: Set your time zone and time to Casablanca, which is GMT without risk of
summer/daylight time. If your OS has the option to choose daylight time, leave it unchecked.
Option 3: Leave your local time alone (i.e. wrong). If your time zone is currently set correctly,
your machine is effectively running on GMT/Universal Coordinated time. If you don't touch it,
the local time displayed will be wrong but the time recorded in the logging program will be
correct.

 

6. Which Monitor to Choose

I have also been evaluating choices for more screen real estate. A couple of pointers that may be of
interest.

Once you get into the bifocal stage of life, pixel size ends up being as important as screen
resolution, if not more-so. You will find that most 17" and 19" monitors are at 1280 by 1024
resolution. The difference between 17" and 19" is not more real estate but the size of the pixels.
Both 17" and 19" monitors will show the same number of pixels, but with the smaller pixels on the
17" monitor, you may end up having to increase font sizes to make the text readable, so you end up
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with less effective screen real estate. I recommend 19" over 17" monitors for this reason.

As far as economics is concerned, the wide angle format monitors appear to generally be the best
bang for your buck. But keep in mind that a widescreen 19" monitor which is 1680 by 1050
resolution will have smaller pixels than a 19 inch 1280 * 1024 resolution monitor. If you are
considering a widescreen monitor, make sure your video card can drive it. The video card in my
almost two year old Dell box can't!

Prices start to go up rapidly once you get into 1600 * 1200 resolution, which becomes available in
the 20" and 21" sizes. At this size and bigger, there are also wide screen versions. Again, make
sure the resolution is supported by your video card.

Another thing to consider is whether or not you are going to be using an analog or digital interface. I
find that driving a 1280 * 1024 monitor in analog mode gives very fine lines and makes text difficult
to read. Using the same monitor with a digital interface usually gives better results. Microsoft's
ClearType software also helps somewhat in this regard.

To summarize, for our application, you want to look for displays with big (0.27mm) pixels. For me,
that narrows the choices down to the following, in order of increasing cost/pixel for monitors:

Two 19" 1280 * 1024 monitors

One 20" or 21" 1600 * 1200 monitor

One large 22" and up widescreen monitor

Gerald Boutin, VE6WA
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